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CHAPTER 1

Introduzione

This document is the original user guide of the described software QGIS. The software and hardware described
in this document are in most cases registered trademarks and are therefore subject to legal requirements. QGIS is
subject to the GNU General Public License. Find more information on the QGIS homepage, http://www.qgis.org.

I dettagli, i dati, i risultati ecc. presenti in questo documento sono stati scritti e verificati al meglio delle conoscenze
e della responsabilità degli autori e degli editori. Ciononostante, possono essere presenti errori nei contenuti.

Pertanto, nessun dato è soggetto ad alcun obbligo o garanzia. Gli autori, i redattori e gli editori non si assumono
alcun obbligo o responsabilità per malfunzionamenti e possibili conseguenze. Tutti gli utenti sono pertanto invitati
a segnalare eventuali errori.

This document has been typeset with reStructuredText. It is available as reST source code via github and online
as HTML and PDF via http://www.qgis.org/en/docs/. Translated versions of this document can be downloaded in
several formats via the documentation area of the QGIS project as well. For more information about contributing
to this document and about translating it, please visit http://qgis.org/en/site/getinvolved/index.html.

Collegamenti presenti in questo documento

Questo documento contiene collegamenti interni ed esterni. Cliccando su un collegamento interno puoi spostarti
all’interno del manuale, mentre cliccando su un collegamento esterno si aprirà un indirizzo internet. in formato
PDF i collegamenti interni ed esterni sono mostrati in colore blu e sono gestiti dal browser del sistema operativo.
In formato HTML, il browser gestisce e mostra entrambi allo stesso modo.

Autori e redattori delle guide per l’utente, l’installazione e la programmazione:

L’elenco delle persone che hanno contribuito a scrivere, rivedere e tradurre la guida ufficiale è disponibile al
seguente link at Hanno contribuito.

Copyright (c) 2004 - 2016 QGIS Development Team

Internet: http://www.qgis.org

Licenza di questo documento

È garantito il permesso di copiare, distribuire e/o modificare questo documento in base ai termini della GNU
Free Documentation License, Versione 1.3 o ogni versione successiva pubblicata dalla Free Software Foundation;
senza alcuna sezione non modificabile, senza testo di copertina e retro-copertina. Una copia della licenza è inclusa
nell’appendice
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CHAPTER 2

Premessa

Benvenuti nel meraviglioso mondo dei Sistemi Informativi Geografici (GIS)!

QGIS è un sistema informativo geografico open source. Il progetto è nato a maggio del 2002 ed è stato confermato
come progetto su SourceForge a giugno dello stesso anno. Abbiamo lavorato sodo per creare un software GIS
(che normalmente è software proprietario e molto costoso) facilmente installabile e utilizzabile da tutti. QGIS
attualmente funziona sulla maggior parte delle piattaforme Unix, Windows e OS X. QGIS viene sviluppato usando
gli strumenti software Qt (https://www.qt.io) e il linguaggio C++. Questo significa che QGIS ha un’interfaccia
utente (GUI) snella, piacevole e facile da usare.

QGIS punta a essere un GIS facilmente utilizzabile da chiunque, fornendo tutte le funzioni e caratteristiche prin-
cipali. QGIS ha raggiunto l’obiettivo di essere utilizzato da molti utenti per soddisfare le esigenze quotidiane
di visualizzazione di dati georiferiti. QGIS supporta ora moltissimi formati raster e vettoriali, con supporti ad
ulteriori formati che sono aggiunti utilizzando plugin esterni.

QGIS è rilasciato sotto la GNU General Public License (GPL). Sviluppare QGIS con questa licenza significa che
puoi ispezionare e modificare il codice sorgente e garantisce che tu, nostro utente, avrai sempre accesso a un
programma GIS libero che potrai liberamente modificare. Insieme alla copia di QGIS dovresti aver ricevuto anche
una copia completa del testo della licenza che puoi trovare anche nell’Appendice di questo manuale GNU General
Public License.

Suggerimento: Documentazione aggiornata
The latest version of this document can always be found in the documentation area of the QGIS website at
http://www.qgis.org/en/docs/.
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CHAPTER 3

Convenzioni

Questa sezione descrive le convenzioni e gli stili che verranno usati in questo manuale.

3.1 Convenzioni per l’interfaccia grafica

Le convenzioni stilistiche per l’interfaccia grafica hanno lo scopo di imitarne l’effettivo aspetto. In generale,
lo stile presentato nel manuale fa riferimento a ciò che compare nell’interfaccia grafica e non ai messaggi che
compaiono se il cursore del mouse si ferma sopra un pulsante.

• Opzioni di menu: Layer → Aggiungi raster oppure Impostazioni → Barre degli strumenti → Digitaliz-
zazione

• Strumenti: Aggiungi raster

• Button : [Save as Default]

• Titolo finestra di dialogo: Proprieta layer

• Scheda (tab): Generale

• Casella di controllo: Visualizzatore

• Pulsante di scelta: Postgis SRID EPSG ID

• Seleziona un numero:

• Seleziona una stringa:

• Browse for a file:

• Seleziona un colore:

• Cursore:

• Inserimento testo:

L’ombreggiatura caratterizza un componente dell’interfaccia grafica che è cliccabile.

3.2 Convenzioni per il Testo o la Tastiera

Questo manuale include anche convenzioni stilistiche relative al testo, a comandi da tastiera e a parti di codice
che identificano costrutti diversi come classi o metodi. Questi stili non corrispondono all’attuale aspetto di nessun
testo o codice presente in QGIS.

• Hyperlinks: http://qgis.org

• Combinazioni di tasti: Ctrl+B significa premere il tasto B mentre si tiene premuto il tasto Ctrl.
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• Nome di un file: lakes.shp

• Nome di una classe: NewLayer

• Metodo: classFactory

• Server: myhost.de

• Inserimento di testo nel terminale: qgis --help

I frammenti di codice sono identificati con un carattere a spaziatura fissa:

PROJCS["NAD_1927_Albers",
GEOGCS["GCS_North_American_1927",

3.3 Istruzioni specifiche per un sistema operativo

Sequenze GUI e piccole quantità di testo possono essere formattate in linea: Click File QGIS → Esci
per chiudere QGIS. Ciò indica che su piattaforme Linux, Unix e Windows, è necessario prima fare clic sul menu
File, quindi su Esci, mentre su piattaforme macOS, è necessario prima fare clic sul menu QGIS, quindi su Esci.

I testi di grandi dimensioni possono venire formattati come elenco:

• fai questo

• fai quello

• O fai questo

o come paragrafi:

Fai questo e questo e questo. Quindi fai questo e questo, e questo.

Fai questo. Poi fai questo e questo e questo , e ancora e ancora e ancora, e ancora e ancora e ancora, e ancora e
ancora.

Le schermate riportate nella guida sono state create su diversi sistemi operativi, indicati da apposite icone alla fine
della didascalia.
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CHAPTER 4

Caratteristiche

QGIS offers many common GIS functionalities provided by core features and plugins. A short summary of six
general categories of features and plugins is presented below, followed by first insights into the integrated Python
console.

4.1 Visualizzazione dati

You can view and overlay vector and raster data in different formats and projections without conversion to an
internal or common format. Supported formats include:

• Spatially-enabled tables and views using PostGIS, SpatiaLite and MS SQL Spatial, Oracle Spatial, vector
formats supported by the installed OGR library, including ESRI shapefiles, MapInfo, SDTS, GML and
many more. See section Lavorare con i vettori.

• Raster e immagini supportati dalla libreria GDAL (Geospatial Data Abstraction Library), come GeoTIFF,
ERDAS IMG, ArcInfo ASCII GRID, JPEG, PNG e molti altri ancora, vedi la sezione Lavorare con i dati
raster.

• Raster e vettori GRASS dai relativi database (location/mapset), vedi la sezione Integrazione con GRASS
GIS.

• Dati spaziali accessibili da Web Services OGC, come (WMS, WMTS, WCS, WFS, WFS-T, ...), vedi sezione
Lavorare con i dati OGC.

4.2 Esplorare dati e comporre mappe

Puoi creare delle mappe ed esplorare i dati spaziali con un’interfaccia grafica molto facile da usare. L’interfaccia
grafica ti mette a disposizione molti strumenti, fra cui:

• QGIS Browser

• Riproiezione al volo

• DB Manager

• Map composer

• Pannello vista generale

• Segnalibri spaziali

• Note testuali

• Funzioni di identificazione/selezione

• Modifica/visualizzazione/ricerca degli attributi

• Data-defined feature labelling
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• Simbologia definita dall’utente per vettori e raster

• Creazione atlante

• North arrow scale bar and copyright label for maps

• Supporto per il salvataggio e il ripristino di progetti

4.3 Creazione, modifica, gestione ed esportazione dati

Puoi creare, modificare, gestire ed esportare i vettori e i raster in molti formati. Ecco un elenco di alcune caratter-
istiche principali di QGIS:

• Strumenti per la digitalizzazione per i formati OGR e per i vettori GRASS

• Ability to create and edit shapefiles and GRASS vector layers

• Plugin georeferenziatore per geocodificare le immagini

• GPS tools to import and export GPX format, and convert other GPS formats to GPX or down/upload directly
to a GPS unit (On Linux, usb: has been added to list of GPS devices.)

• Supporto per la visualizzazione e la modifica di dati OpenStreetMap

• Ability to create spatial database tables from shapefiles with DB Manager plugin

• Gestione delle tabelle di database spaziali migliorata

• Strumenti per gestire le tabelle degli attributi di un vettore

• Salvataggio di schermate come immagini georiferite

• DXF-Export strumento con avanzate capacità di esportare stili e plugins in grado di attivare funzioni tipo
CAD.

4.4 Analisi dei dati

You can perform spatial data analysis on spatial databases and other OGR- supported formats. QGIS currently
offers vector analysis, sampling, geoprocessing, geometry and database management tools. You can also use
the integrated GRASS tools, which include the complete GRASS functionality of more than 400 modules. (See
section Integrazione con GRASS GIS.) Or, you can work with the Processing Plugin, which provides a power-
ful geospatial analysis framework to call native and third-party algorithms from QGIS, such as GDAL, SAGA,
GRASS and more. (See section Introduzione.)

4.5 Pubblicazione di mappe su internet

QGIS può essere utilizzato come client WMS, WMTS, WMS-C e WFS-T e come server WMS, WFS o WCS (vedi
sezione Lavorare con i dati OGC). Inoltre puoi esportare e pubblicare i tuoi dati in internet usando un webserver
con installato UMN MapServer o GeoServer.

4.6 Estendi le funzionalità di QGIS attraverso i plugin

Puoi adattare QGIS ai tuoi scopi grazie all’architettura estensibile dei plugin. QGIS fornisce librerie che possono
essere usate per la creazione di plugin. Ma puoi anche creare le tue nuove applicazioni con C++ o python!
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4.6.1 Plugin nativi

I plugin nativi includono:

1. Coordinate Capture (Capture mouse coordinates in different CRSs)

2. DB Manager (Exchange, edit and view layers and tables from/to databases; execute SQL queries)

3. Dxf2Shp Converter (Convert DXF files to shapefiles)

4. eVIS (Visualize events)

5. GDALTools (Integrate GDAL Tools into QGIS)

6. Georeferencer GDAL (Add projection information to rasters using GDAL)

7. GPS Tools (Load and import GPS data)

8. GRASS (Integrate GRASS GIS)

9. Heatmap (Generate raster heatmaps from point data)

10. Interpolation Plugin (Interpolate based on vertices of a vector layer)

11. Metasearch Catalogue Client

12. Offline Editing (Allow offline editing and synchronizing with databases)

13. Oracle Spatial GeoRaster

14. Processing (formerly SEXTANTE)

15. Raster Terrain Analysis (Analyze raster-based terrain)

16. Road Graph Plugin (Analyze a shortest-path network)

17. Spatial Query Plugin

18. Topology Checker (Find topological errors in vector layers)

19. Zonal Statistics Plugin (Calculate count, sum, and mean of a raster for each polygon of a vector layer)

4.6.2 Plugin esterni in python

QGIS offre un crescente numero di plugin python esterni creati dalla comunità. Questi plugin sono presenti
all’interno del repository ufficiale dei plugin e possono essere facilmente installati usando l’installatore dei plugin
python (vedi sezione La finestra di dialogo Plugins).

4.7 Console python

For scripting, it is possible to take advantage of an integrated Python console, which can be opened from menu:
Plugins → Python Console. The console opens as a non-modal utility window. For interaction with the QGIS en-
vironment, there is the qgis.utils.iface variable, which is an instance of QgsInterface. This interface
allows access to the map canvas, menus, toolbars and other parts of the QGIS application. You can create a script,
then drag and drop it into the QGIS window and it will be executed automatically.

For further information about working with the Python console and programming QGIS plugins and applications,
please refer to PyQGIS-Developer-Cookbook.
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4.8 Problemi noti

4.8.1 Limitazione numero di file aperti

Se stai aprendo un grande progetto di QGIS e sei sicuro che tutti i layer sono validi, ma qualche layer viene
segnalato come corrotto, probabilmente ti stai scontrando con questo problema. Linux (e probabilmente anche
altri sistemi operativi) hanno un limite di file aperti per ogni processo. I limiti delle risorse e per ogni processo
vengono automaticamente ereditati. Il comando ulimit, preinstallato nella console dei comandi, cambia i limiti
solo per il processo attuale; il nuovo limite viene ereditato da ogni altro processo.

Puoi vedere tutti gli ulimit attuali digitando:

$ ulimit -aS

Poi vedere l’attuale numero permesso di les aperti per ogni processo con questo comando da console:

$ ulimit -Sn

Per cambiare i limiti di una sessione esistente, potresti usare qualcosa del genere:

$ ulimit -Sn #number_of_allowed_open_files
$ ulimit -Sn
$ qgis

Risolverlo per sempre

Sulla maggior parte dei sistemi Linux, i limiti alle risorse sono impostati al momento del login tramite
il modulo pam_limits in funzione delle impostazioni contenute in /etc/security/limits.conf o
/etc/security/limits.d/*.conf. Dovresti modificare questi file sei hai i permessi di amministratore
(anche tramite sudo), ma dovrai effettuare di nuovo il login prima che i cambiamento siano effettivi.

Maggiori informazioni:

http://www.cyberciti.biz/faq/linux-increase-the-maximum-number-of-open-files/ http://linuxaria.com/article/open-
files-in-linux?lang=en
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CHAPTER 5

Novità in QGIS 2.18

Questa versione contiene nuove funzionalità ed amplia l’interfaccia di programmazione delle precedenti versioni.
Consigliamo quindi di usare questa versione al posto di quelle precedenti.

This release includes hundreds of bug fixes and many new features and enhancements over QGIS
2.14 that will be described in this manual. You may also review the visual changelogs at
http://qgis.org/en/site/forusers/visualchangelogs.html.
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CHAPTER 6

Come Iniziare

This chapter gives a quick overview of installing QGIS, some sample data from the QGIS web page, and running
a first and simple session visualizing raster and vector layers.

6.1 Installation

Installation of QGIS is very simple. Standard installer packages are available for MS Windows and macOS. For
many flavors of GNU/Linux, binary packages (rpm and deb) or software repositories are provided to add to your in-
stallation manager. Get the latest information on binary packages at the QGIS website at http://download.qgis.org.

6.1.1 Installation from source

If you need to build QGIS from source, please refer to the installation instructions. They are dis-
tributed with the QGIS source code in a file called INSTALL. You can also find them online at
http://htmlpreview.github.io/?https://raw.github.com/qgis/QGIS/master/doc/INSTALL.html. If you want to build
a particular release, you should replace master by the release branch (commonly in the release-X_Y form)
in the above-mentioned link because instructions may differ.

6.1.2 Installation on external media

QGIS allows you to define a --configpath option that overrides the default path for user configuration (e.g.,
~/.qgis2 under Linux) and forces QSettings to use this directory, too. This allows you to, for instance, carry
a QGIS installation on a flash drive together with all plugins and settings. See section Impostazioni di sistema for
additional information.

6.1.3 Sample Data

The user guide contains examples based on the QGIS sample dataset.

The Windows installer has an option to download the QGIS sample dataset. If checked, the data will be down-
loaded to your My Documents folder and placed in a folder called GIS Database. You may use Windows
Explorer to move this folder to any convenient location. If you did not select the checkbox to install the sample
dataset during the initial QGIS installation, you may do one of the following:

• Usare dati GIS che hai già;

• Download sample data from http://qgis.org/downloads/data/qgis_sample_data.zip

• Disinstallare QGIS e reinstallarlo selezionando l’opzione per lo scaricamento dei dati (opzione consigliata
solo se le soluzioni precedenti non sono riuscite)
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For GNU/Linux and macOS, there are not yet dataset installation packages available as rpm, deb
or dmg. To use the sample dataset, download the file qgis_sample_data as a ZIP archive from
http://qgis.org/downloads/data/ and unzip the archive on your system.

The Alaska dataset includes all GIS data that are used for examples and screenshots in the user guide; it also
includes a small GRASS database. The projection for the QGIS sample dataset is Alaska Albers Equal Area with
units feet. The EPSG code is 2964.

PROJCS["Albers Equal Area",
GEOGCS["NAD27",
DATUM["North_American_Datum_1927",
SPHEROID["Clarke 1866",6378206.4,294.978698213898,
AUTHORITY["EPSG","7008"]],
TOWGS84[-3,142,183,0,0,0,0],
AUTHORITY["EPSG","6267"]],
PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],
UNIT["degree",0.0174532925199433,
AUTHORITY["EPSG","9108"]],
AUTHORITY["EPSG","4267"]],
PROJECTION["Albers_Conic_Equal_Area"],
PARAMETER["standard_parallel_1",55],
PARAMETER["standard_parallel_2",65],
PARAMETER["latitude_of_center",50],
PARAMETER["longitude_of_center",-154],
PARAMETER["false_easting",0],
PARAMETER["false_northing",0],
UNIT["us_survey_feet",0.3048006096012192]]

If you intend to use QGIS as a graphical front end for GRASS, you can find a selection of sample locations (e.g.,
Spearfish or South Dakota) at the official GRASS GIS website, http://grass.osgeo.org/download/sample-data/.

6.2 Launching QGIS

6.2.1 Starting and Stopping QGIS

Starting QGIS is done as you usually do for any other application on your platform. It means that you can launch
QGIS by:

• typing qgis at a command prompt, assuming that QGIS is added to your PATH or you’re in its installation
folder

• using the Applications menu if using a precompiled binary, the Start menu or the Dock

• doppio clic sull’icona nella tua cartella Applicazioni o sul collegamento sul desktop

• double clicking an existing QGIS project (.qgs) file. Note that this will also open the project

To stop QGIS, click:

• l’opzione del menu Progetto → Esci da QGIS o usa la scorciatoia Ctrl+Q

• QGIS → Quit QGIS, o usa la scorciatoia Cmd+Q

• or use the red cross at the right top corner of the main interface of the application.

6.2.2 Command Line Options

In previous section you learned how to start QGIS. You will see that QGIS also provides further command line
options.
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QGIS supports a number of options when started from the command line. To get a list of the options, enter qgis
--help on the command line. The usage statement for QGIS is:

qgis --help

Returns:

QGIS - 2.16.1-Nødebo ’Nødebo’ (8545b3b)
QGIS is a user friendly Open Source Geographic Information System.
Usage: /usr/bin/qgis.bin [OPTION] [FILE]
OPTION:

[--snapshot filename] emit snapshot of loaded datasets to given file
[--width width] width of snapshot to emit
[--height height] height of snapshot to emit
[--lang language] use language for interface text
[--project projectfile] load the given QGIS project
[--extent xmin,ymin,xmax,ymax] set initial map extent
[--nologo] hide splash screen
[--noversioncheck] don’t check for new version of QGIS at startup
[--noplugins] don’t restore plugins on startup
[--nocustomization] don’t apply GUI customization
[--customizationfile] use the given ini file as GUI customization
[--optionspath path] use the given QSettings path
[--configpath path] use the given path for all user configuration
[--authdbdirectory path] use the given directory for authentication database
[--code path] run the given python file on load
[--defaultui] start by resetting user ui settings to default
[--dxf-export filename.dxf] emit dxf output of loaded datasets to given file
[--dxf-extent xmin,ymin,xmax,ymax] set extent to export to dxf
[--dxf-symbology-mode none|symbollayer|feature] symbology mode for dxf output
[--dxf-scale-denom scale] scale for dxf output
[--dxf-encoding encoding] encoding to use for dxf output
[--dxf-preset visiblity-preset] layer visibility preset to use for dxf output
[--help] this text
[--] treat all following arguments as FILEs

FILE:
Files specified on the command line can include rasters,
vectors, and QGIS project files (.qgs):
1. Rasters - supported formats include GeoTiff, DEM

and others supported by GDAL
2. Vectors - supported formats include ESRI Shapefiles

and others supported by OGR and PostgreSQL layers using
the PostGIS extension

Suggerimento: Example Using command line arguments
You can start QGIS by specifying one or more data files on the command line. For example, assuming you are
in the qgis_sample_data directory, you could start QGIS with a vector layer and a raster file set to load on
startup using the following command: qgis ./raster/landcover.img ./gml/lakes.gml

Command line option --snapshot

This option allows you to create a snapshot in PNG format from the current view. This comes in handy when you
have a lot of projects and want to generate snapshots from your data.

Currently, it generates a PNG file with 800x600 pixels. This can be adjusted using the --width and --height
command line arguments. A filename can be added after --snapshot.

Command line option --lang

Based on your locale, QGIS selects the correct localization. If you would like to change your language, you can
specify a language code. For example, qgis --lang it starts QGIS in Italian localization.

Command line option --project
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Starting QGIS with an existing project file is also possible. Just add the command line option --project
followed by your project name and QGIS will open with all layers in the given file loaded.

Command line option --extent

To start with a specific map extent use this option. You need to add the bounding box of your extent in the
following order separated by a comma:

--extent xmin,ymin,xmax,ymax

Command line option --nologo

This command line argument hides the splash screen when you start QGIS.

command line option --noversioncheck

Don’t check for new version of QGIS at startup.

Command line option --noplugins

If you have trouble at start-up with plugins, you can avoid loading them at start-up with this option. They will still
be available from the Plugins Manager afterwards. Command line option --customizationfile

Using this command line argument, you can define a GUI customization file, that will be used at startup.

Command line option --nocustomization

Using this command line argument, existing GUI customization will not be applied at startup.

Command line option --optionspath

You can have multiple configurations and decide which one to use when starting QGIS with this option.
See Opzioni dell’interfaccia grafica (GUI) to confirm where the operating system saves the settings files.
Presently, there is no way to specify a file to write settings to; therefore, you can create a copy of the orig-
inal settings file and rename it. The option specifies path to directory with settings. For example, to use
/path/to/config/QGIS/QGIS2.ini settings file, use option:

--optionspath /path/to/config/

Command line option --configpath

This option is similar to the one above, but furthermore overrides the default path for user configuration
(~/.qgis2) and forces QSettings to use this directory, too. This allows users to, for instance, carry a QGIS
installation on a flash drive together with all plugins and settings.

Command line option --authdbdirectory

Again, this option is similar to the one above but define the path to the directory where the authentication database
will be stored.

Command line option --code

This option can be used to run a given python file directly after QGIS has started.

For example, when you have a python file named load_alaska.py with following content:

from qgis.utils import iface
raster_file = "/home/gisadmin/Documents/qgis_sample_data/raster/landcover.img"
layer_name = "Alaska"
iface.addRasterLayer(raster_file, layer_name)

Assuming you are in the directory where the file load_alaska.py is located, you can start QGIS, load the
raster file landcover.img and give the layer the name ‘Alaska’ using the following command: qgis --code
load_alaska.py

Command line options --dxf-*
These options can be used to export QGIS project into a DXF file. Several options are available:

• –dxf-export: the DXF filename into which to export the layers;
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• –dxf-extent: the extent of the final DXF file;

• –dxf-symbology-mode: several values can be used here: none (no symbology), symbollayer (Symbol layer
symbology), feature (feature symbology);

• –dxf-scale-deno: the scale denominator of the symbology;

• –dxf-encoding: the file encoding;

• –dxf-preset: choose a visibility preset. These presets are defined in the layer tree, see Pannello dei Layer.

6.3 Sample Session: Load raster and vector layers

Now that you have QGIS installed and a sample dataset available, we would like to demonstrate a short and simple
QGIS sample session. We will visualize a raster and a vector layer. We will use:

• the landcover raster layer i.e., qgis_sample_data/raster/landcover.img

• and the lakes vector layer i.e., qgis_sample_data/gml/lakes.gml.

1. Start QGIS as seen in Starting and Stopping QGIS

2. Click on the Add Raster Layer icon.

3. Browse to the folder qgis_sample_data/raster/, select the ERDAS IMG file landcover.img
and click [Open].

4. If the file is not listed, check if the Files of type combo box at the bottom of the dialog is set on the
right type, in this case Erdas Imagine Images (*.img *.IMG).

5. Now click on the Add Vector Layer icon.

6. File should be selected as Source Type in the new Add vector layer dialog. Now click [Browse] to select
the vector layer.

7. Browse to the folder qgis_sample_data/gml/, select Geography Markup Language [GML]
[OGR] (*.gml *.GML) from the Filter combo box, then select the GML file lakes.gml and
click [Open]. In the Add vector layer dialog, click [OK]. The Coordinate Reference System Selector dialog
opens with NAD27 / Alaska Alberts selected, click [OK].

8. Zoom in a bit to your favourite area with some lakes.

9. Fai doppio click sul vettore lakes nella legenda per aprire la finestra di dialogo Proprietà.

10. Click on the Style tab and select a blue as fill color.

11. Click on the Labels tab and select Show labels for this layer in the drop-down menu to enable labeling.
Then from the Label with list, choose the NAMES field as the field containing labels.

12. To improve readability of labels, you can add a white buffer around them by clicking Buffer in the list on

the left, checking Draw text buffer and choosing 3 as buffer size.

13. Click [Apply]. Check if the result looks good, and finally click [OK].

You can see how easy it is to visualize raster and vector layers in QGIS. Let’s move on to the sections that follow
to learn more about the available functionality, features and settings, and how to use them.

6.4 Projects

The state of your QGIS session is considered a project. QGIS works on one project at a time. Settings are
considered as being either per-project or as a default for new projects (see section Opzioni dell’interfaccia grafica

(GUI)). QGIS can save the state of your workspace into a project file using the menu options Project → Save
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or Project → Save As.... If the loaded project file on disk was meanwhile changed, by default, QGIS will ask

you if you want to overwrite the changes into the project file. This behavior is set by checking Prompt to save
project and data source changes when required under Settings → Options → General menu .

Load saved projects into a QGIS session using Project → Open..., Project → New from template or Project
→ Open Recent →.

At startup, a list of screenshot with the name and path of each of the most recent projects (up to ten) is shown
instead of a white and empty map canvas. This is a handy and quicker way to remember what a project was about
and double-click a row opens the selected project. If you’re willing to create a new project, just add new layers
and the list disappears.

If you wish to clear your session and start fresh, choose Project → New. Either of these menu options will
prompt you to save the existing project if changes have been made since it was opened or last saved.

The kinds of information saved in a project file include:

• Layer aggiunti

• Quali layer sono interrogabili

• Proprietà dei layers, inclusi i simboli e gli stili associati

• Proiezione usata per la mappa

• Ultima estensione della mappa

• Print Composers

• Print Composer elements with settings

• Print Composer atlas settings

• Settaggi dei parametri di digitalizzazione

• Relazioni tra tabelle

• Macro di progetto

• Stili predefiniti per il Progetto

• Settaggi dei Plugin

• Settaggi dei servizi OWS attivati nel Progetto

• Query memorizzate nel DB Manager

The project file is saved in XML format, so it is possible to edit the file outside QGIS if you know what you are
doing. The file format has been updated several times compared with earlier QGIS versions. Project files from
older QGIS versions may not work properly any more. To be made aware of this, in the General tab under Settings

→ Options you should tick Warn when opening a project file saved with an older version of QGIS.

Whenever you save a project in QGIS a backup of the project file is made with the extension .qgs~.

6.5 Output

There are several ways to generate output from your QGIS session. We have discussed one already in section
Projects, saving as a project file. Here is a sampling of other ways to produce output files:

• Menu option Project → Save as Image... opens a file dialog where you select the name, path and type
of image (PNG, JPG and many other formats). A world file with extension PNGW or JPGW saved in the
same folder georeferences the image.
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• Menu option Project → DXF Export... opens a dialog where you can define the ‘Symbology mode’, the
‘Symbology scale’ and vector layers you want to export to DXF. Through the ‘Symbology mode’ symbols
from the original QGIS Symbology can be exported with high fidelity.

• Menu option Project → New Print Composer... opens a dialog where you can layout and print the
current map canvas (see section Print Composer).
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CHAPTER 7

QGIS GUI

When QGIS starts, you are presented with the GUI as shown in the figure (the numbers 1 through 5 in yellow
circles are discussed below).

Figure 7.1: QGIS GUI con i dati di esempio Alaska

Nota: L’aspetto delle finestre (barra del titolo, ecc.) potrà apparire diverso a seconda del sistema operativo e
dell’ambiente desktop.

La QGIS GUI è divisa in 5 aree:

1. Barra dei Menu

2. Barre degli strumenti

3. Pannelli

4. Mappa

5. Barra di Stato

These five components of the QGIS interface are described in more detail in the following sections. Two more
sections present keyboard shortcuts and context help.
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7.1 Barra dei Menu

The menu bar provides access to various QGIS features using a standard hierarchical menu. The top-level menus
and a summary of some of the menu options are listed below, together with the associated icons as they appear on
the toolbar, and keyboard shortcuts. The shortcuts presented in this section are the defaults; however, keyboard
shortcuts can also be configured manually using the Configure shortcuts dialog, opened from Settings → Configure
Shortcuts....

Although most menu options have a corresponding tool and vice-versa, the menus are not organized exactly like
the toolbars. The toolbar containing the tool is listed after each menu option as a checkbox entry. Some menu
options only appear if the corresponding plugin is loaded. For more information about tools and toolbars, see
section Barre degli strumenti.

Nota: QGIS is a cross-platform application meaning that though it provides you with the same tools, they may be
placed in different menus according to the operating system specification. The lists below show the most common
location and precise when there is a variation.

7.1.1 Progetto

Voce di Menu Scorciatoia Riferimento Barra degli Strumenti

Nuovo Ctrl+N see Projects Progetto

Open Ctrl+O see Projects Progetto
Nuovo da modello → see Projects
Apri Recenti → see Projects

Salva Ctrl+S see Projects Progetto

Salva come... Ctrl+Shift+S see Projects Progetto

Save as Image... see Output
DXF Export... see Output
DWG/DXF Import...

Project Properties... Ctrl+Shift+P see Projects

New Print Composer Ctrl+P see Print Composer Progetto

Composer manager... see Print Composer Progetto
Print Composers → see Print Composer

Esci da QGIS Ctrl+Q

In macOS, il comando Exit QGIS corrisponde a QGIS → Esci da QGIS (Cmd+Q).
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7.1.2 Modifica

Voce di Menu Scorciatoia Riferimento Barra degli
Strumenti

Annulla Ctrl+Z see Digitalizzazione avanzata Digitalizzazione
avanzata

Ripristina Ctrl+Shift+Zsee Digitalizzazione avanzata Digitalizzazione
avanzata

Taglia geometrie Ctrl+X see Modifica di un layer esistente Digitalizzazione

Copia geometrie Ctrl+C see Modifica di un layer esistente Digitalizzazione

Incolla geometrie Ctrl+V see Modifica di un layer esistente Digitalizzazione
Paste features as → see Lavorare con la tabella degli

attributi

Add Feature Ctrl+. see Modifica di un layer esistente Digitalizzazione

Aggiungi geometria circolare see Modifica di un layer esistente Digitalizzazione

Aggiungi geometria circolare
tramite raggio

see Modifica di un layer esistente Digitalizzazione

Muovi geomertria(e) see Modifica di un layer esistente Digitalizzazione

Elimina selezionato see Modifica di un layer esistente Digitalizzazione

Modifica attributi delle
geometrie selezionate

see Modifica dei valori nella
tabella degli attributi

Digitalizzazione

Ruota geometria(e) see Digitalizzazione avanzata Digitalizzazione
avanzata

Semplifica geometria see Digitalizzazione avanzata Digitalizzazione
avanzata

Aggiungi buco see Digitalizzazione avanzata Digitalizzazione
avanzata

Aggiungi parte see Digitalizzazione avanzata Digitalizzazione
avanzata

Riempi buco see Digitalizzazione avanzata Digitalizzazione
avanzata

Elimina buco see Digitalizzazione avanzata Digitalizzazione
avanzata

Elimina parte see Digitalizzazione avanzata Digitalizzazione
avanzata

Modifica geometrie see Digitalizzazione avanzata Digitalizzazione
avanzata

Curva di offset see Digitalizzazione avanzata Digitalizzazione
avanzata

Dividi geometrie see Digitalizzazione avanzata Digitalizzazione
avanzata

Dividi parti see Digitalizzazione avanzata Digitalizzazione
avanzata

Unisci geometrie selezionate see Digitalizzazione avanzata Digitalizzazione
avanzata

Merge Attr. of Selected
Features

see Digitalizzazione avanzata Digitalizzazione
avanzata

Node Tool see Modifica di un layer esistente Digitalizzazione

Ruota i simboli per i punti see Digitalizzazione avanzata Digitalizzazione
avanzata

Offset simboli punti see Digitalizzazione avanzata Digitalizzazione
avanzata
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After activating Toggle editing mode for a layer, you will enable the Add Feature icon in the Edit menu
depending on the layer type (point, line or polygon).

7.1.3 Edit (extra)

Voce di Menu Scorciatoia Riferimento Barra degli Strumenti

Add Feature see Modifica di un layer esistente Digitalizzazione

Add Feature see Modifica di un layer esistente Digitalizzazione

Add Feature see Modifica di un layer esistente Digitalizzazione

7.1.4 Mappa

Voce di Menu Scorciatoia Riferimento Barra degli
Strumenti

Sposta mappa see Zoom e Pan Navigazione mappa

Sposta la mappa sulla
selezione

Navigazione mappa

Ingrandisci Ctrl+Alt++ see Zoom e Pan Navigazione mappa

Rimpicciolisci Ctrl+Alt+- see Zoom e Pan Navigazione mappa
Seleziona → see Selezionare geometrie Attributi

Informazione elementi Ctrl+Shift+I see Identify Features Attributi
Misura → see Misurazioni Attributi

Sintesi delle statistiche see Pannello Statistiche Attributi

Zoom completo Ctrl+Shift+F Navigazione mappa

Zoom sul layer Navigazione mappa

Zoom alla selezione Ctrl+J Navigazione mappa

Ultimo zoom Navigazione mappa

Zoom successivo Navigazione mappa

Zoom To Native Resolution Navigazione mappa
Proprietà → see Decorazioni
Modalità anteprima →

Map Tips see Scheda Suggerimenti Attributi

Nuovo segnalibro... Ctrl+B see Segnalibri geospaziali Attributi

Mostra segnalibri Ctrl+Shift+B see Segnalibri geospaziali Attributi

Aggiorna F5 Navigazione mappa
Pannelli → see Pannelli e Barre degli

strumenti
Barre degli strumenti → see Pannelli e Barre degli

strumenti
Attiva la modalità a schermo
intero

F11

Under Linux KDE, Panels →, Toolbars → and Toggle Full Screen Mode are rather placed in Settings menu.

Preview mode → is not available under macOS.
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7.1.5 Layer

Voce di Menu Scorciatoia Riferimento Barra degli
Strumenti

Crea Layer → see Creating new vector layers Manage Layers
Aggiungi Layer → see Esplorare i formati dati e i

campi
Manage Layers

Includi Layers e Gruppi... see Progetti nidificati
Aggiungi da un file di definizione
del layer...

Copy style see Salvare e condividere le
proprietà di un layer

Paste style see Salvare e condividere le
proprietà di un layer

Apri tabella attributi F6 see Lavorare con la tabella degli
attributi

Attributi

Attiva modifiche see Modifica di un layer esistente Digitalizzazione

Salva modifiche vettore see Modifica di un layer esistente Digitalizzazione

Modifiche in uso → see Modifica di un layer esistente Digitalizzazione
Save As... see Creating new layers from an

existing layer
Save As Layer Definition File...

Elimina Layer/Gruppo Ctrl+D

Duplica Layer(s)
Definisci la scala di visibilità
del/dei Layer(s)
Imposta SR del/dei Layer(s) Ctrl+Shift+C
Imposta SR del Progetto dal
Layer
Proprietà... see Proprietà dei vettori
Filtra... Ctrl+F see Costruttore di interrogazioni

Etichettatura see Proprietà etichette

Add to Overview Ctrl+Shift+O Manage Layers

Add All To Overview

Remove All From Overview

Mostra tutti i layers Ctrl+Shift+U Manage Layers

Nascondi tutti i layers Ctrl+Shift+H Manage Layers

Show selected Layers

Hide selected Layers
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7.1.6 Impostazioni

Voce di Menu Scorcia-
toia

Riferimento Barra degli
Strumenti

Custom
CRS...

see Sistemi di riferimento personalizzati

Style
Manager...

see Gestore di stile

Configure
shortcuts...

see Tasti di scelta rapida

Customization...
see Personalizzazione

Opzioni... see Opzioni dell’interfaccia grafica (GUI)
Opzioni di
aggancio...

see Impostare la Tolleranza dello Snapping e il raggio di
ricerca degli elementi

Under Linux KDE, you’ll find more tools in Settings menu such as Project Properties, Panels →, Toolbars
→ and Toggle Full Screen Mode.

7.1.7 Plugins

Voce di Menu Scorciatoia Riferimento Barra degli Strumenti

Gestire e installare Plugins... see La finestra di dialogo Plugins
Python Console Ctrl+Alt+P

Quando si avvia QGIS per la prima volta non tutti i plugin di base verranno caricati.

7.1.8 Vettore

Voce di Menu Scorciatoia Riferimento Barra degli Strumenti
OpenStreetMap → see Importare vettori OpenStreetMap

Analysis Tools → see Menu Vettore

Research Tools → see Menu Vettore

Geoprocessing Tools → see Menu Vettore

Geometry Tools → see Menu Vettore

Data Management Tools → see Menu Vettore

When starting QGIS for the first time not all core plugins are loaded. Many of the above-mentioned sub-menus
require the core plugin Processing to be activated.

7.1. Barra dei Menu 27



QGIS User Guide, Release 2.18

7.1.9 Raster

Voce di Menu Scorciatoia Riferimento Barra degli Strumenti
Raster calculator... see Calcolatore raster
Alinea Raster... see Allineamento Raster

Analysis → see Plugin GDALTools

Projection → see Plugin GDALTools

Conversion → see Plugin GDALTools

Miscellaneous → see Plugin GDALTools

Extraction → see Plugin GDALTools

When starting QGIS for the first time not all core plugins are loaded. Many of the above-mentioned sub-menus
require the core plugin Processing to be activated.

7.1.10 Database

Voce di Menu Scorciatoia Riferimento Barra degli Strumenti
Database → see Plugin DB Manager Database

Quando si avvia QGIS per la prima volta non tutti i plugin di base verranno caricati.

7.1.11 Web

Voce di Menu Scorciatoia Riferimento Barra degli Strumenti
Metasearch see Client Catalogo MetaSearch Web

Quando si avvia QGIS per la prima volta non tutti i plugin di base verranno caricati.

7.1.12 Processing

Voce di Menu Scorciatoia Riferimento Barra degli Strumenti

Toolbox see The toolbox

Modellatore grafico... see Modellatore grafico

History and log... see Il gestore della cronologia di Processing

Options... see Configuring the processing framework

Results viewer... see Configurazione di applicazioni esterne

Commander Ctrl+Alt+M see La riga di comando

Quando si avvia QGIS per la prima volta non tutti i plugin di base verranno caricati.
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7.1.13 Guida

Voce di Menu Scorciatoia Riferimento Barra degli Strumenti

Contenuti della Guida F1 Guida

What’s This? Shift+F1 Guida
Documentazione sulle API
Segnala un problema
Serve supporto commerciale?

Home Page di QGIS Ctrl+H

Check QGIS Version

About

QGIS Sponsors

7.1.14 QGIS

Questo menu è disponibile solo in macOS e contiene alcuni comandi relativi a tale sistema operativo.

Voce di Menu Scorciatoia Riferimento
Preferenze
Aiuto su QGIS
Nascondi QGIS
Mostra tutto
Nascondi gli altri
Esci da QGIS Cmd+Q

Preferenze e About QGIS sono comandi equivalenti a Impostazioni → Opzioni e Aiuto → About. Esci da QGIS
corresponde a Progetto → Esci da QGIS negli altri sistemi.

7.2 Pannelli e Barre degli strumenti

From the View menu (or Settings), you can switch on and off QGIS widgets (Panels →) or toolbars (Toolbars
→). You can (de)activate any of them by right-clicking the menu bar or a toolbar and choose the item you want.
Each panel or toolbar can be moved and placed wherever you feel comfortable within QGIS interface. The list
can also be extended with the activation of Core or external plugins.

7.2.1 Barre degli strumenti

The toolbar provides access to most of the same functions as the menus, plus additional tools for interacting with
the map. Each toolbar item has pop-up help available. Hold your mouse over the item and a short description of
the tool’s purpose will be displayed.

Puoi spostare a piacimento ogni barra in funzione delle tue esigenze. Inoltre puoi disattivare ogni barra cliccando
con il tasto destro sulla barra degli strumenti disattivando la voce relativa nel menu.

Suggerimento: Ripristinare le barre degli strumenti
Se hai disattivato accidentalmente una barra strumenti, puoi ripristinarla dalla voce di menu Visualizza → Barre

degli strumenti → (o Impostazioni → Barre degli strumenti →). Se una barra degli strumenti per qualsi-
asi ragione scompare dall’interfaccia di QGIS puoi effettuare il ripristino come descritto in ripristinare la GUI
iniziale.
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Figure 7.2: Il menu Barra degli strumenti

7.2.2 Pannelli

Besides toolbars, QGIS provides by default many panels to work with. Panels are special widgets that you can
interact with (selecting options, checking boxes, filling values...) in order to perform a more complex task.

Di seguito la lista dei pannelli di default previsti in QGIS:

• il Pannello dei Layer

• the Browser Panel

• Il Pannello Digitalizzazione Avanzata

• Il Il Pannello Segnalibri geospaziali

• Il Pannello informazioni GPS

• Il Pannello scala delle mattonelle

• Il Pannello informazione elementi

• Il Pannello Digitalizzazione avanzata

• Il Pannello ordine Layer

• il Pannello Stile Layer

• il Pannello Statistiche

• il QGIS Overview Panel

• il Pannello Messaggi di Log

• il Pannello Annulla/Ripristina

• l’ Ambiente di Processing di QGIS
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Figure 7.3: Il menu Pannelli

7.3 Mappa

Chiamata anche Rappresentazione della Mappa, questa è il “fine aziendale” di QGIS – le mappe vengono
visualizzate in questa area. La mappa visualizzata in questa finestra dipenderà dai layer vettoriali e raster che hai
scelto di caricare.

When you add a layer (see e.g. Accedere ai dati), QGIS automatically looks for its Coordinate Reference System
(CRS) and zooms to its extent if you work in a blank QGIS project. The layer’s CRS is then applied to the project.
If there are already layers in the project, and in the case the new layer has the same CRS as the project, its features
falling in the current map canvas extent will be visualized. If the new layer is in a different CRS from the project’s,
you must Enable on-the-fly CRS transformation from the Project → Project Properties → CRS (see Definire la
trasformazione del SR al volo (OTF)). The added layer should now be visible if data are available in the current
view extent.

The map view can be panned, shifting the focus of the map display to another region, and it can be zoomed in and
out. Various other operations can be performed on the map as described in the Barre degli strumenti description.
The map view and the legend are tightly bound to each other — the maps in view reflect changes you make in the
legend area.

Suggerimento: ZOOM IN E ZOOM OUT CON LA ROTELLA DEL MOUSE
Per le operazioni di zoom puoi anche utilizzare la rotella del mouse. Posizionando il puntatore del mouse nell’area
di visualizzazione delle mappe aumenterai lo zoom girando la rotella verso lo schermo, lo ridurrai girandola nel
verso contrario. La posizione del puntatore costituisce il centro per l’ingrandimento. Puoi regolare il comporta-
mento della funzione di zoom con la rotella del mouse nella scheda Strumenti mappa del menu Impostazioni →
Opzioni .

Suggerimento: MUOVERE LA MAPPA CON I TASTI FRECCIA E LA BARRA SPAZIATRICE
You can use the arrow keys to pan the map. Place the mouse cursor inside the map area and click on the right
arrow key to pan east, left arrow key to pan west, up arrow key to pan north and down arrow key to pan south. You
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can also pan the map using the space bar or the click on mouse wheel: just move the mouse while holding down
space bar or click on mouse wheel.

7.4 Barra di Stato

The status bar provides you with general information about the map view, and actions processed or available and
offers you tools to manage the map view.

On the left side of the status bar, you can get a summary of actions you’ve done (such as selecting features in
a layer, removing layer) or a long description of the tool you are hovering over (not available for all tools). On
startup, the bar status also informs you about availability of new or upgradeable plugins (if checked in Plugin
Manager settings).

In case of lengthy operations, such as gathering of statistics in raster layers or rendering several layers in map
view, a progress bar is displayed in the status bar to show the current progress of the action.

The Coordinate option shows the current position of the mouse, following it while moving across the map
view. You can set the unit (and precision) to use in the project properties, General tab. Click on the small button

at the left of the textbox to toggle between the Coordinate option and the Extents option that displays in map
units, the coordinates of the current lower leftmost and upper rightmost points of the map view, as you pan and
zoom in and out.

Next to the coordinate display you will find the Scale display. It shows the scale of the map view. If you zoom in
or out, QGIS shows you the current scale. There is a scale selector, which allows you to choose among predefined
and custom scales to assign to the map view.

On the right side of the scale display you can define a current magnification level for your map view. This allows
to zoom in to a map without altering the map scale, making it easier to accurately tweak the positions of labels
and symbols. The magnification level is expressed as a percentage. If the Magnifier has a level of 100%, then
the current map is not magnified. Additionally, a default magnification value can be defined within Settings →
Options → Rendering → Rendering behaviour, which is very useful for high resolution screen to avoid too small
symbols.

A destra della scala puoi definire la rotazione corrente in gradi in senso orario della mappa.

On the right side of the status bar, there is a small checkbox which can be used to temporarily prevent layers being
rendered to the map view (see section Visualizzazione).

To the right of the render functions, you find the Current CRS: icon with the EPSG code of the current project
CRS. Clicking on this lets you Enable ‘on the fly’ CRS transformation properties for the current project and apply
another CRS to the map view.

Finally, the Messages button opens the Log Messages Panel which informs you on underlying process (QGIS
startup, plugins loading, processing tools...)

Suggerimento: Calcolare la scala corretta della mappa
When you start QGIS, the default CRS is WGS 84 (epsg 4326) and units are degrees. This means that QGIS
will interpret any coordinate in your layer as specified in degrees. To get correct scale values, you can either
manually change this setting, e.g. to meters, in the General tab under Project → Project Properties, or you can

use the Current CRS: icon seen above. In the latter case, the units are set to what the project projection specifies
(e.g., +units=us-ft).

Da notare che la scelta del sistema SR di partenza può essere fatta in Impostazioni → Opzioni → SR.
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CHAPTER 8

Strumenti generali

8.1 Guide contestuali

When you need help on a specific topic, you can access context help via the [Help] button available in most
dialogs — please note that third-party plugins can point to dedicated web pages.

8.2 Pannelli

QGIS provides by default many panels to work with. Some of these panels are described below while others may
be found in different parts of the document. A complete list of default panels provided by QGIS is available at
Pannelli.

8.2.1 Pannello dei Layer

The layers Panel lists all the layers in the project and helps you manage their visibility. A layer can be selected
and dragged up or down in the legend to change the Z-ordering. Z-ordering means that layers listed nearer the top
of the legend are drawn over layers listed lower down in the legend.

Nota: Questo comportamento di default può essere cambiato tramite il pannello Layer Order.

In cima al Pannello dei Layer, una barra degli strumenti ti permette di:

• Open the layer styling dock: toggle the layer styling panel on and off.

• Aggiungi gruppo

• Manage Visibility: control visibility of layers and preset layers combination.

• Filtra la legenda in base al contenuto della mappa: solo i layers che ricadono nell’area in visualizzazione vengono
elencati in modo completo, gli altri restano ma hanno simbologia nulla, in questo modo viene evidenziato
quali sono i layer di interesse nella zona visualizzata.

• Filter Legend by Expression: helps you apply an expression to remove from the selected layer tree styles that
have no feature satisfying the condition. This can be used for example to highlight features that are within
a given area/feature of another layer. From the drop-down list, you can edit and clear the expression set.

• Espandi tutti or Racchiudi tutti layers e gruppi nel layers panel.

• and Remove Layer/Group currently selected.
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Figure 8.1: Barra degli strumenti nel Layers Panel

Nota: Tools to manage the layers panel are also available to layout the map and legend items of the print composer

Preset the layers visibility

The button allows you to add Presets views in the legend. Presets are a way to save and easily restore a
combination of layers with their current style. To add a preset view, just set visible the layers you want, with their
desired symbology, and click on button. Choose Add Preset... from the drop-down menu and give a name to
the preset. The added preset is listed at the bottom of the drop-down menu and is recalled by clicking on it.

The Replace Preset → option helps you overwrite a preset content with the current map view while the Remove
Current Preset button deletes the active preset.

All the added presets are also present in the map composer in order to allow you to create a map layout based on
your specific views (see Proprietà principali).

Panoramica del menu di scelta rapida del Layers Panel

At the bottom of the toolbar, the main component of the Layers panel is the frame listing vector or raster layers
added to the project and, those layers can be organized in groups. Depending on the item selected in the panel, a
right-click shows a dedicated set of options presented below.
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Opzione Vettore Layer Raster Gruppo

Zoom to Layer/Group

Show in Overview

Zoom to Native Resolution (100%)

Stretch Using Current Extent

Remove

Duplicate

Set Layer Scale Visibility

Zoom to Visible Scale

Set Layer/Group CRS

Set Project CRS from Layer

Stili →
Copy Style

Paste Style

Open Attribute Table

Toggle Editing

Modifiche in uso → (in Edit mode)

Save As...

Save As Layer Definition File...

Filter...

Show Feature Count

Properties

Move to Top-level

Rename

Group Selected

Set Group WMS Data

Mutually Exclusive Group

Add Group

Tabella: Menu contestuali degli oggetti nel Layers Panel

Per i layers vettoriali GRASS, Attiva modifiche non è disponibile. Vedere la sezione Digitalizzare e modificare
layer vettoriali GRASS per informazioni su modifiche dei layers vettoriali GRASS.

Interact with Groups and layers

I layers presenti nella finestra della legenda possono essere organizzati in gruppi. Ciò può essere fatto in due modi:

1. Premi l’icona per aggiungere un nuovo gruppo. Digita un nome per il gruppo e premi Enter. Ora
clicca su un layer esistente e trascinalo nel gruppo.

2. Select some layers, right click in the legend window and choose Group Selected. The selected layers will
automatically be placed in a new group.

To bring a layer out of a group, you can drag it out, or right click on it and choose Move to top-level; the layer is
placed at the same level than the group it was inside. Groups can also be nested inside other groups.
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Puoi usare la casella di controllo di un gruppo per mostrare/nascondere tutti i layer del gruppo con un singolo
click.

Enabling the Mutually Exclusive Group option you can make a group have only one layer visible at the same
time. Whenever a layer within the group is set visible the others will be toggled not visible.

It is possible to select more than one layer or group at the same time by holding down the Ctrl key while selecting
the layers with the left mouse button. You can then move all selected layers to a new group at the same time.

You may also delete more than one layer or group at once by selecting several items with the Ctrl key and
pressing Ctrl+D afterwards. This way, all selected layers or groups will be removed from the layers list.

Modificare lo stile dei layer vettoriali

From the Layers panel, you have shortcuts to easily and quickly edit the layer rendering. Right-click on a vector
layer and select Styles → in the list in order to:

• see the currently applied styles to the layer. In case you defined many styles for the layer, you can switch
from one to another and have your layer rendering automatically updated in the map canvas.

• copiare lo stile corrente o, se applicabile, incollare uno stile copiato da un altro layer

• rename the current style, add a new one (which is actually a copy of the current one) or delete the current
style (when multiple styles available).

Nota: The previous options are also available for raster layer.

Whether the features in the vector layer have all the same unique symbol or they are classified (in that case, the
layer is displayed in a tree structure with each class as sub-item), the following options are available at layer level
or class level:

• a Edit Symbol... button to open the Selettore Simbolo dialog and update any property (symbol, size, color...)
of the layer or feature symbol. Double-clicking on a feature does also open the Symbol Selector dialog.

• a Scelta colore widget with a Color Wheel from which you can click a color and have it automatically
update the symbol fill color. For convenience, Recent colors are available at the bottom of the color wheel.

• a Show All Items and Hide All Items to toggle on or off the visibility of all the classes of features.
This avoids (un)checking items one by one.

Suggerimento: Condividere rapidamente lo stile di un layer
From the context menu, copy the style of a layer and paste it to a group or a selection of layers: the style is applied
to all the layers that are of the same type (vector vs raster) as the original layer and, in case of vector, have the
same geometry type (point, line or polygon).

8.2.2 Working with the Legend independent layer order

There is a panel that allows you to define an independent drawing order for the layers panel. You can activate
it in the menu Settings → Panels → Layer Order Panel. This feature allows you to, for instance, order your
layers in order of importance, but still display them in the correct order (see figure_layer_order; you can notice
that the airports features are displayed over the alaska polygon despite their layers placement in the Layers

panel). Unchecking the Control rendering order box underneath the list of layers will cause a revert to default
behavior.

8.2.3 Pannello Stile Layer

This panel is somehow a shortcut to some of the features of the layer properties dialog. It indeed offers you a quick
and handy way to define the rendering and the behavior of a layer, and to visualize its effects without opening the
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Figure 8.2: Define a legend independent layer order

layer properties dialog.

Besides avoiding you dealing with the modal and blocking dialog of the layer properties, it also avoids you
cluttering the screen with features dialogs given that it embeds most of them (color selector, effects properties,
rule edit, label substitution...): e.g., clicking color buttons inside the layer style panel causes the color selector
dialog to be opened inside the layer style panel itself rather than as a separate dialog.

Dall’elenco a discesa dei layers presenti nel Layers Panel, selezionare un elemento e:

• set its symbology, transparency, and histogram in case of raster layer. These options are the same available
in Proprietà raster

• set its symbology, and labels. These options are the same available in Proprietà dei vettori

• manage the associated style(s) as described in Gestione stili personalizzati

• follow the whole history of changes you applied to the layer style in the current project; you can therefore
cancel or restore to any state by selecting it in the list and hit [Apply] button.

Another powerful feature of this panel is the Live update checkbox. Tick it and your changes are automatically
rendered in the map canvas as you go on. You no longer need to hit the [Apply] button.

Suggerimento: Add custom tabs to the Layer Styling panel
Using PyQGIS, you can set new tabs to manage layer properties in the Layer Styling Panel. See
https://nathanw.net/2016/06/29/qgis-style-dock-part-2-plugin-panels/ for an example.

8.2.4 Pannello Statistiche

This panel can show some statistics on a specific vector layers. The panel allows users to choose:

• the vector layer;

• the column or the expression;
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Figure 8.3: Defining a layer symbology from the layer styling panel
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• filter statistics to selected features;

• refresh the informations;

• the statistics information to display with the bottom right button.

Statistic information available are (depending on the field’s type):

Statistiche Stringa Intero Numero reale Data

Conteggio

Conteggio Distinti

Conteggio Mancanti

Somma

Media

Deviazione Standard

Deviazione Standard su un Campione

Valore Minimo

Valore Massimo

Intervallo

Minoranza

Maggioranza

Varietà

Primo Quartile

Terzo Quartile

Scarto interquartile

Lunghezza Minima

Lunghezza Massima

Tabella: Statistiche disponibili per ciascun tipo di campo

8.2.5 QGIS Overview Panel

In QGIS, you can use an overview panel that provides a full extent view of layers added to it. Within the view is
a rectangle showing the current map extent. This allows you to quickly determine which area of the map you are
currently viewing. Note that labels are not rendered to the map overview even if the layers in the map overview
have been set up for labelling. If you click and drag the red rectangle in the overview that shows your current
extent, the main map view will update accordingly.

8.2.6 Pannello Messaggi di Log

When loading or processing some operations, you can track and follow messages that appear in different tabs

using the Log Messages Panel. It can be activated using the most right icon in the bottom status bar.

8.2.7 Pannello Annulla/Ripristina

For each layer being edited, this panel shows the list of actions done, allowing to quickly undo a set of actions by
simply selecting the action listed above. More details at Undo and Redo edits.

8.2. Pannelli 39



QGIS User Guide, Release 2.18

Figure 8.4: Mostrare statistiche su un campo
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8.3 Visualizzazione

In modo predefinito, QGIS visualizza tutti i layer visibili ogni volta che la mappa viene aggiornata. La mappa
viene aggiornata ogni volta che:

• Adding a layer

• Panning or zooming

• Resizing the QGIS window

• Changing the visibility of a layer or layers

QGIS consente di controllare il processo di visualizzazione in diversi modi.

8.3.1 Visualizzazione in funzione della scala

Scale-dependent rendering allows you to specify the minimum and maximum scales at which a layer (raster or
vector) will be visible. To set scale-dependent rendering, open the Properties dialog by double-clicking on the

layer in the legend. On the General tab, tick the Scale dependent visibility checkbox and enter the Minimum
(exclusive) and Maximum (inclusive) scale values.

You can also activate the scale dependent visibility on a layer from the Layers panel. Right-click on the layer and
in the context menu, select Set Layer Scale Visibility.

The Set to current canvas scale button helps you use the current map canvas scale as boundary of the range visibility.

Nota: When a layer is not rendered in the map canvas due to the map scale out of its visibility scale range, the
layer is greyed in the Layers panel and a new option Zoom to Visible Scale appears in the layer context menu.
Select it and the map is zoomed to the layer’s nearest visibility scale.

8.3.2 Controllare la visualizzazione della mappa

Puoi controllare la visualizzazione della mappa in molti modi diversi, come descritto di seguito.

Sospensione della visualizzazione

To suspend rendering, click the Render checkbox in the lower right corner of the status bar. When the
Render checkbox is not checked, QGIS does not redraw the canvas in response to any of the events described in
section Visualizzazione. Examples of when you might want to suspend rendering include:

• Adding many layers and symbolizing them prior to drawing

• Adding one or more large layers and setting scale dependency before drawing

• Adding one or more large layers and zooming to a specific view before drawing

• Any combination of the above

Se la casella di controllo Aggiorna è spuntata, la visualizzazione e l’aggiornamento della mappa saranno
immediati.

Controllare la visibilità dei layer quando sono caricati

You can set an option to always load new layers without drawing them. This means the layer will be added to
the map, but its visibility checkbox in the legend will be unchecked by default. To set this option, choose menu

option Settings → Options and click on the Rendering tab. Uncheck the By default new layers added to the
map should be displayed checkbox. Any layer subsequently added to the map will be off (invisible) by default.
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Fermare la visualizzazione

To stop the map drawing, press the ESC key. This will halt the refresh of the map canvas and leave the map
partially drawn. It may take a bit of time between pressing ESC and the time the map drawing is halted.

Nota: Attualmente non si può interrompere la visualizzazione in corso: questa opzione è stata disabilitata nella
porta Qt4 a causa di diversi problemi dell’interfaccia utente (UI).

Modificare la qualità della visualizzazione

QGIS ha una opzione per modificare la qualità della restituzione nella visualizzazione della mappa. Nel menu

Impostazioni → Opzioni, click sulla scheda Visualizzazione e seleziona o deseleziona Rendi le linee meno
irregolari a spese delle prestazioni.

Velocizzare la visualizzazione

Ci sono alcune opzioni che ti permettono di velocizzare la visualizzazione. Apri la finestra di dialogo di QGIS
Impostazioni → Opzioni, vai alla scheda Visualizzazione e seleziona o deseleziona le seguenti caselle di controllo:

• Use render caching where possible to speed up redraws

• Visualizza i layers in parallelo usando più processori della CPU e poi imposta Numero massimo di
processori da utilizzare.

• La costruzione della mappa avviene in background su un’immagine separata e ad ogni Intervallo di
aggiornamento della mappa, il contenuto di questa immagine (fuori schermo) verrà utilizzato per aggiornare
la rappresentazione della visualizzazione sullo schermo. Tuttavia, se la costruzione termina più velocemente
di questa durata, la visualizzazione avverrà immediatamente.

• With Enable Feature simplification by default for newly added layers, you simplify features’ geometry
(less nodes) and as a result, they quickly display. Be aware that you can also face rendering inconsistencies.

8.4 Salvare e condividere le proprietà di un layer

8.4.1 Gestione stili personalizzati

When a vector layer is added to map canvas, QGIS uses by default a random symbol/color to render its features.
You can however set a default symbol in Project → Project Properties → Default styles that will be applied to
each newly added layer according to its geometry type.

But, most of the time, you’d prefer to have a custom and more complex style that can be applied automatically or
manually (with less efforts) to the layers. You can achieve this goal using the Style combobox at the bottom of the
Layer Properties dialog. This combobox provides you with functions to create, load and manage styles.

A style stores any information set in the layer properties dialog to render or interact with the features (including
symbology, labeling, action, diagram... settings) for vector layer, or the pixels (band or color rendering, trans-
parency, pyramids, histogram ...) for raster.

By default, the style applied to a loaded layer is named default. Once you have got the ideal and appropriate

rendering for your layer, you can save it by clicking the Style combobox and choose:

• Rename Current: The active style gets renamed and updated with the current options

• Aggiungi......: Viene creato un nuovo stile utilizzando le opzioni correnti. Per impostazione predefinita,
verrà salvato nel file di progetto QGIS. Vedere in seguito come salvare lo stile in un altro file o in un
database
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Figure 8.5: Opzioni di gestione dello stile in un vettore

• Remove: delete unwanted style, in case you have more than one style defined for the layer.

At the bottom of the Style drop-down list, you see the styles set for the layer and the active one is checked.

Note that each time you validate the layer properties dialog, the active style is updated with the changes you’ve
done.

You can create as many styles as you wish for a layer but only one can be active at a time. Combined to layer
visibility preset, this offers a quick and powerful way to manage complex projects with few layers (no need to
duplicate any layer in the map legend).

Suggerimento: Gestire gli stili dal menu contestuale del layer
Right-click on the layer in Layers Panel to add, rename or remove layer style.

8.4.2 Storing Style in a File or a Database

While created styles from the Style combobox are by default saved inside the project and can be copied and pasted
from layer to layer in the project, it’s also possible to save them outside the project so that they can be loaded in
another project.

Save in plain text file

Cliccando Stile → Salva stile, puoi salvare lo stile come:

• QGIS file di stile del layer (.qml)

• or SLD file (.sld), only available for vector layers.

Used on file based format layers (.shp, .tab...), Save as Default generates a .qml file along the layer (with
the same name). SLDs can be exported from any type of renderer – single symbol, categorized, graduated or
rule-based – but when importing an SLD, either a single symbol or rule-based renderer is created. That means that
categorized or graduated styles are converted to rule-based. If you want to preserve those renderers, you have to
stick to the QML format. On the other hand, it can be very handy sometimes to have this easy way of converting
styles to rule-based.
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Salvare in un database

Vector layer style can also be stored in a database if the layer datasource is a database provider. Supported
formats are PostGIS, GeoPackage, SpatiaLite, MSSQL and Oracle. The layer style is saved inside a table (named
layer_styles) of the database. Click on Save Style → Save in database item then fill in the dialog to define a
style name, add a description, a .ui file if applicable and check if the style should be the default style.

You can save several styles for a single table in the database. However each table can have only one default
style. Default style can be saved in the layer database or in the QGIS local database, a SQLite database in the
~/.qgis2/ directory (where QGIS stores its local settings).

Figure 8.6: Salvare lo stile nella finestra di dialogo database

Suggerimento: Condivisione di file di stile tra database
Puoi salvare il tuo stile in un database solo se il layer proviene da tale database. Non puoi combinare database (ad
esempio layer in Oracle e stile in MSSQL). Usa invece un file di testo normale se vuoi che lo stile sia condiviso
tra i database.

Nota: You may encounter issues to restore the layer_styles table from a PostgreSQL database backup.
Follow Stili di default dei layer QGIS e backup del database to fix that.

Carica lo stile

When loading a layer in QGIS, if a default style already exists for this layer, QGIS loads the layer with this style.
Also Style → Restore Default looks for and loads that file when pressed, replacing current style of the layer.

The Style → Load Style helps you apply any saved style to a layer. While plain text file style (.sld or .qml) can
be applied to any layer whatever its format is, loading styles stored in database is only possible if the layer is from
the same database or the style is stored in the QGIS local database.

The Load Style from Database dialog displays a list of related styles to the layer found in the database and all the
other styles saved in it, with name and description.

Suggerimento: Condividere rapidamente uno stile di layer all’interno del progetto
You can also share layer style within a project without importing a file or database style: right-click on the layer
in the Layers Panel and, from the Styles combobox , copy the style of a layer and paste it to a group or a selection
of layers: the style is applied to all the layers that are of the same type (vector vs raster) as the original layer and,
in case of vector, have the same geometry type (point, line or polygon).
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8.5 Scelta colore

The select color dialog will appear whenever you push the icon to choose a color. The
features of this dialog depends on the state of the Use native color chooser dialogs parameter checkbox in Settings
→ Options → General menu. When checked, the color dialog used is the one of the OS being used. Otherwise,
QGIS custom color chooser is used.

Suggerimento: Dynamically change the color with the live-updating option
Check the Use live-updating color chooser dialogs option in the Settings → Options → General menu to have the
color applied to your items as soon as you pick it in the color chooser dialog.

The custom color chooser dialog has four different tabs which allow you to select colors by color ramp,
color wheel, color swatches or color picker (not available under ).

Whatever method you use, the selected color is always described through color sliders for HSV (Hue, Saturation,
Value) and RGB (Red, Green, Blue) values. The color is also identifiable as a HTML notation. Finally, there is an
opacity slider to set transparency level.

Modifying a color is as simple as clicking in the color wheel or ramp or in any of the color parameters sliders. You
can adjust such parameters with the spinbox beside or, handy, scrolling the mouse wheel over the corresponding
slider. You can also typeset the color html notation.

The dialog also provides a visual comparison between the current (applied to widget) and the new (being selected)
colors. Thanks to drag-and-drop, any of these colors can be saved in a slot for an easy access.

Figure 8.7: Scheda selezione scala dei colori

With color ramp or color wheel tab, you can browse to all possible color combinations and apply it to the item.

In the color swatches tab, you can choose from a preselected list of color palettes:

• Recent colors,

• Standard colors, a user-defined list of colors set under Settings → Options → Colors menu

• or Project colors, a user-defined list of colors set under Project → Project Properties → Default Styles.
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The latest palettes can be modified thanks to the and buttons at the bottom of the frame. The ... button
nearby the palette combobox also offers several options to:

• copia, incolla, importa o esporta colori

• create, import or remove color palettes. Check the Show in Color Buttons option to add the custom palette
to the color selector widget (see figure_color_selector).

Figure 8.8: Color selector switcher tab

Another option is to use the color picker which allows you to sample a color from under your mouse pointer at
any part of QGIS or even from another application by pressing the space bar. Please note that the color picker is
OS dependent and is currently not supported by macOS.

Suggerimento: Modifica veloce del colore

Click the drop-down arrow at the right of the color box button to display a widget for a quick
color selection, either in the color wheel or from existing color palettes. You can also use it to copy or paste a
color.

8.6 Metodi di fusione

QGIS offers different options for special rendering effects with these tools that you may previously only know
from graphics programs. Blending modes can be applied on layers, on features but also on print composer items:

• Normale: Questa è la modalità di fusione predefinita che usa il canale alpha del pixel più in alto fondendolo
con quello sotto. I colori non sono quindi mescolati.

• Schiarisci: Questo seleziona il valore massimo di ogni componente dal basso verso l’alto. Fai attenzione
che Il risultato può apparire frastagliato e duro.

• Screen: Light pixels from the source are painted over the destination, while dark pixels are not. This mode
is most useful for mixing the texture of one item with another item (e.g., you can use a hillshade to texture
another layer).

• Dodge: Dodge will brighten and saturate underlying pixels based on the lightness of the top pixel. So,
brighter top pixels cause the saturation and brightness of the underlying pixels to increase. This works best
if the top pixels aren’t too bright; otherwise the effect is too extreme.

46 Chapter 8. Strumenti generali



QGIS User Guide, Release 2.18

Figure 8.9: Menu di scelta veloce del colore
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• Addition: This blend mode simply adds pixel values of one item with the other. In case of values above
one (in the case of RGB), white is displayed. This mode is suitable for highlighting features.

• Darken: This creates a resultant pixel that retains the smallest components of the foreground and back-
ground pixels. Like lighten, the results tend to be jagged and harsh.

• Multiply: Here, the numbers for each pixel of the top item are multiplied with the corresponding pixels for
the bottom item. The results are darker pictures.

• Burn: Darker colors in the top item cause the underlying items to darken. Burn can be used to tweak and
colorise underlying layers.

• Overlay: This mode combines the multiply and screen blending modes. In the resulting picture, light parts
become lighter and dark parts become darker.

• Soft light: This is very similar to overlay, but instead of using multiply/screen it uses color burn/dodge.
This is supposed to emulate shining a soft light onto an image.

• Luce intensa: Questa modalità è simile alla modalità sovrapponi. Proietta una luce molto intensa su tutta
l’immagine.

• Difference: Difference subtracts the top pixel from the bottom pixel, or the other way around, to always get
a positive value. Blending with black produces no change, as the difference with all colors is zero.

• Subtract: This blend mode simply subtracts pixel values of one item from the other. In case of negative
values, black is displayed.

8.7 Zoom e Pan

QGIS fornisce strumenti per fare zoom e per spostarti alla tua area di interesse

Apart from using the pan and zoom-in / zoom-out icons on the toolbar with the mouse, navigating can also
be done with the mouse wheel, spacebar and the arrow keys. A Zoom factor can be set under the Settings →
Options → Map tools menu to define the scale behavior while zooming.

8.7.1 Con la rotella del mouse

You can press the mouse wheel to pan inside of the main window (on macOS, you may need to hold cmd key).
You can roll the mouse wheel to zoom in and out on the map; the mouse cursor position will be the center of the
zoomed area of interest. Holding down Ctrl while rolling the mouse wheel results in a finer zoom.

8.7.2 Con i tasti freccia

Panning the map is possible with the arrow keys. Place the mouse cursor inside the map area, and click on the
right arrow key to pan east, left arrow key to pan west, up arrow key to pan north, and down arrow key to pan
south.

You can also use the space bar to temporarily cause mouse movements to pan the map. The PgUp and PgDown
keys on your keyboard will cause the map display to zoom in or out following the zoom factor set. Pressing Ctrl
+ or Ctrl - also performs an immediate zoom in/out on the map canvas.

When certain map tools are active (Identify, Measure...), you can perform a zoom by holding down Shift and
dragging a rectangle on the map to zoom to that area. This is enabled for the map tools which are not selection
tools (since they use Shift for adding to selection) nor edit tools.
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8.8 Misurazioni

8.8.1 Informazioni generali

QGIS effettua misure delle geometrie vettoriali in quattro modi:

• the interactive measurement tools ,

• measuring in the Field Calculator,

• derived measures in the Identify Features tool,

• and a vector analysis tool: Vector → Geometry Tools → Export/Add Geometry Columns

La misurazione opera nei sistemi di coordinate proiettate piane (ad esempio UTM) e con coordinate geografiche.
I primi tre metodi di misura si comportano nello stesso modo con riferimento ai settaggi globali di proiezione.

• If “on the fly” CRS transformation (see Definire la trasformazione del SR al volo (OTF)) is enabled, the
default measurement metric is - different from most other GIS - ellipsoidal, using the ellipsoid defined in
File → Project properties → General. This is true both when geographic and projected coordinate systems
are defined for the project.

• If you want to calculate the projected / planimetric area or distance using cartesian maths, the measure-
ment ellipsoid has to be set to “None / Planimetric” (File → Project properties → CRS). However, with a
geographic (= unprojected) CRS defined for the data and project, area and distance measurement will be
ellipsoidal.

• If “on the fly” CRS transformation is disabled, the measurement metric is planimetric when the project co-
ordinate system is projected and ellipsoidal when the project coordinate system is unprojected / geographic.

However, neither the identify tool nor the field calculator will transform your data to the project CRS before
measuring. If you want to achieve this, you have to use the vector analysis tool: Vector → Geometry Tools →
Export/Add Geometry Columns. Here, measurement is by default planimetric except if you choose the ellipsoidal
measure.

8.8.2 Measure length, areas and angles interactive

Click the icon in the Attribute toolbar to begin measurements. The downward arrow near the icon helps you

switch to the convenient tool to measure length, area or angle. The default unit used in the dialog is
the one set in Project → Project Properties → General menu.

Nota: Configurazione dello strumento di misura
While measuring length or area, clicking the Configuration button at the bottom of the widget helps you define
in menu Settings → Options → Map Tools the rubberband color, the precision of the measurements and the unit
behavior. You can also choose your preferred measurement or angle units but keep in mind that those values are
superseded in the current project by options made in Project → Project Properties → General menu.

Tutti gli strumenti di misurazione utilizzano le impostazioni di aggancio dal modulo di digitalizzazione (vedi la
sezione Impostare la Tolleranza dello Snapping e il raggio di ricerca degli elementi). Quindi, se vuoi misurare
esattamente lungo una geometria lineare o una geometria poligonale devi prima definire la tolleranza di aggancio
e poi selezionare il vettore. In questo modo, quando vengono usati gli strumenti di misura, ogni click del mouse
(all’interno della tolleranza definita) si aggancerà a quel punto del layer.

By default, Measure Line: QGIS measures real distances between given points according to a defined ellipsoid.
The tool then allows you to click points on the map. Each segment length, as well as the total, shows up in the
measure window. To stop measuring, click your right mouse button.
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Note that you can use the drop-down list near the total to interactively change the measurement units while mea-
suring. This unit is kept for the widget until a new or another project is opened.

The Info section in the dialog explains how calculations are made according to CRS settings available.

Figure 8.10: Misurare Distanza

Measure Area: Areas can also be measured. In the measure window, the accumulated area size appears. Right-
click to stop drawing. The Info section is also available as well as the ability to switch between different area
units.

Figure 8.11: Misurare Area

Measure Angle: You can also measure angles. The cursor becomes cross-shaped. Click to draw the first segment
of the angle you wish to measure, then move the cursor to draw the desired angle. The measure is displayed in a
pop-up dialog.

Figure 8.12: Misurare Angolo

8.9 Selezionare geometrie

QGIS provides several tools to select features in the map canvas. Selection tools are available in View → Select
menu or in the Attributes toolbar.

Nota: Gli strumenti di selezione funzionano con il layer correntemente attivo.

8.9.1 Selecting manually in the map canvas

To select one or several features with the mouse, you can use one of the following tools:
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• Seleziona geometrie con un rettangolo o con un singolo click

• Seleziona geometrie con un Poligono

• Seleziona geometrie a mano libera

• Seleziona geometrie con un cerchio

Nota: Except the Select Features by Polygon tool, these manual selection tools allow you to select feature(s) in the
map canvas with a single click.

While using the Select Feature(s) tool, holding Shift or Ctrl toggles whether feature is selected (ie either
adds to the current selection or remove from it).

For the other tools, different behaviors can be performed holding:

• Shift: aggiunge geometrie alla selezione corrente

• Ctrl: sottrae geometrie dalla selezione corrente

• Ctrl + Shift: intersect with current selection, ie only keep overlapping features from the current se-
lection

• Alt: select features that are totally within the selection shape. Combined to Shift or Ctrl keys, you can
add or substract features to/from the current selection.

8.9.2 Selezione automatica

The other selection tools, also available from the Attribute table, perform a selection based on feature’s attribute or
its selection state (note that attribute table and map canvas show the same information, so if you select one feature
in attribute table, it will be selected in map canvas also):

• Select By Expression... allows user to select features using expression dialog.

• Seleziona geometrie per valore... o premi F3

• Deselect Features from All Layers or press Ctrl+Shift+A to deselect all selected features in all layers.

• Select All Features or press Ctrl+A to select all features in the current layer.

• Invert Feature Selection to invert the selection in the current layer.

For example, if you want to find regions that are boroughs from regions.shp of the QGIS sample data, you

can use the Select features using an Expression icon. Then, you open the Fields and Values menu and choose the field
that you want to query. Double-click the field ‘TYPE_2’ and also click [Load all unique values] in the right
panel. From the list, choose and double-click ‘Borough’. In the Expression field, then you’d write the following
query:

"TYPE_2" = ’Borough’

From the expression builder dialog, you can also use the Function list → Recent (Selection) to make a selection
that you used before. The dialog remembers the last 20 used expressions. See Espressioni chapter for more
information and some example.

Suggerimento: Salva la selezione in un nuovo file
Users can save selected features into a New Temporary Scratch Layer or a New Vector Layer using Edit →
Copy Features and Edit → Paste Features as in the wanted format.
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8.9.3 Seleziona geometrie per valore

This selection tool opens the layer’s feature form allowing the user to choose, for each field, which value to look
for, if the search should be case sensitive, and the operation that should be used.

Figure 8.13: Filtro/Selezione geometrie tramite finestra di dialogo

Alongside each field, there is a drop-down list with the operation options to control the search behaviour. The
common options are:

• Exclude Field - The field will not be used for searching

• Uguale a (=)

• Not equal to

• Senza valore (null)

• INon è senza valore (not null)

For numeric and datetime fields, the additional options are:

• Maggiore di (>)

• Minore di (<)

• Greater than or equal to (>=)

• Less than or equal to (<=)

• Compreso fra (inclusivo)

• Is not between (inclusive)

For text fields, the additional options are:

• Contiene

• Non contiene

For the text options above, it is also possible to use the Case sensitive option.

After setting all search options, you can use the Select features button to select the matching features. The drop-
down options are:

• Seleziona elementi

• Aggiungi alla selezione attuale

• Filtra la selezione attuale

• Rimuovi dalla selezione attuale

You can also clean all search options using the Reset form button.
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8.10 Impostazione Sovrascrittura definita dai dati

Beside many options in the vector layer properties dialog or settings in the print composer, you can find a
Data defined override icon. Thanks to expressions based on layer attributes or item settings, prebuild or custom functions
and variables, this tool allows you to set dynamic value for the concerned parameter. When enabled, the value
returned by this widget is applied to the parameter regardless its normal value (checkbox, textbox, slider...).

Clicking the Data defined override icon shows following entries:

• Description... that indicates if the option is enabled, which input is expected, the valid input type and the
current definition. Hovering over the widget also pops up these information;

• Field type: an entry to select from the layer’s fields that match the valid input type;

• an entry to list the Variable available;

• Edit... button to create or edit the expression to use;

• Paste and Copy buttons;

• Cancella per rimuovere l’impostazione.

Parameters that can be used with data-defined tools are:

• Style and symbols parameters

• Labels parameters

• Composer parameters

Suggerimento: Use right-click to (de)activate the data overriding

You can enable or disable a configured data-defined override button by simply clicking the widget with the mouse
right button.

Nota: When the data-defined override option is setup correctly the icon is yellow or ; if it is broken, the
icon is red or .

8.11 Identify Features

Lo strumento Informazione elementi ti permette di interagire con la mappa e ottenere informazioni sulle caratter-
istiche delle geometrie in una finestra pop-up. Per avere informazione sulle geometrie usa:

• View → Identify Features menu,

• or press Ctrl + Shift + I (or Cmd + Shift + I),

• or click the Identify Features icon on the Attributes toolbar.

8.11.1 Usare lo strumento Informazione geometrie

QGIS offers two ways to identify features with the Identify Features tool:

• left click will identify features according to the mode set in the Identify Results panel

• right click will fetch all the snapped features from all the visible layers. This will open a context menu,
allowing the user to choose more precisely the features to identify.
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Suggerimento: Filtra i layers su cui effettuare una query con lo strumento Identifica geometrie

Uncheck the Identifiable column in Project → (or Settings →), Project Properties → Identify layers menu in

front of a layer to avoid it being queried when using the Identify Features in a mode other than Current Layer.
This is a handy way to return features from only layers that are of interest for you.

If you click on feature(s), the Identify Results dialog will list information about the clicked feature(s). The default
view is a tree view where the first item is the name of the layer and its children are its identified feature(s). Each
feature is described by the name of a field along with its value. This field is the one set in Layer Properties →
Display. Then follows all the other information about the feature.

8.11.2 Feature informations

The Identify Results dialog can be customized to display custom fields, but by default it will display three kinds
of information:

• Azioni: le azioni possono essere aggiunte alle finestre delle identificazione delle geometrie. Le azioni
si visualizzano facendo click sull’etichetta azione. Per impostazione predefinita, viene aggiunta una sola
azione, vale a dire Modulo vista geometrica per effettuare modifiche. Puoi definire più azioni
nella finestra di dialogo delle proprietà del layer (vedi Proprietà Azioni).

• Derived: This information is calculated or derived from other information. This includes:

– general information about the feature and its geometry: feature id, length or perimeter and area in map
units depending on its geometry, the count of spatial parts and the number of the clicked part in case
of multi-geometry, the count of vertices in the feature and the number of the closest one to the point
clicked

– coordinates information: the X and Y (and Z/M if available) coordinate values of the clicked point,
the feature closest vertex and its first and last vertices. In case you click on a curved line using the info
tool, QGIS will also display the radius of that section in the panel result.

• Attributi dei dati: questo è l’elenco dei campi e dei valori degli attributi per la geometria su cui è stato
fatto click.

Nota: Links in feature’s attributes are clickable from the Identify Results panel and will open in your default web
browser.

Figure 8.14: Finestra di dialogo Informazioni risultati
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8.11.3 La finestra di dialogo Informazioni risultati

At the top of the window, you have seven icons:

• Espandi albero

• Collassa albero

• Default behavior to define whether next identified features information should be collapsed or expanded

• View the feature form

• Cancella risultati

• Copia geometrie selezionate negli appunti

• Stampa il responso HTML selezionato

At the bottom of the window, you have the Mode and View comboboxes. With the Mode combobox you can define
from which layers features should be identified:

• Current layer : only features from the selected layer are identified. The layer may not be visible in the
canvas.

• Top down, stop at first: for only features from the upper visible layer.

• Top down: for all features from the visible layers. The results are shown in the panel.

• and Layer selection: opens a context menu where the user selects the layer to identify features from.
Operates like a right-click. Only the chosen features will be shown in the result panel.

Nota: Identify tool configuration
You can configure the identify feature in Project → Project Properties in the Identify layers tab. The table allows
user to select layer(s) that can be used by this tool to identify features (column Identifiable). You can also put this
layer in read-only mode with the checkbox in the last column.

La Visualizzazione può essere impostata a Albero, Tabella o Grafica. Le visualizzazioni ‘Tabella’ e ‘Grafica’
possono essere impostate solo per i layers raster.

The identify tool allows you to Auto open a form. If checked, each time a single feature is identified QGIS will
open a form showing its attributes. This is a handy way to quickly edit a feature’s attributes.

Puoi trovare altre opzioni nel menu contestuale dell’elemento identificato. Per esempio, dal menu contestuale
puoi:

• Visualizzare modulo geometria

• Zoomare alla geometria

• Copiare elementi: copiare tutti gli elementi e gli attributi della geometria

• Toggle feature selection: Adds identified feature to selection

• Copiare un valore di un attributo: copiare solo il valore dell’attributo identificato

• Copia attributi geometria: copia gli attributi della geometria

• Cancellare risultati: verranno cancellati i risultati nella finestra

• Cancellare evidenziati: verranno cancellate le geometrie evidenziate sulla mappa

• Evidenziare tutto

• Evidenziare vettore

• Attivare un vettore: scegliere un vettore che deve essere attivato
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• Proprietà del vettore: aprire la finestra delle proprietà del vettore

• Espandi tutto

• Racchiudi tutto

8.12 Note testuali

The Text Annotation tool in the attribute toolbar provides the possibility to place formatted text in a balloon on the
QGIS map canvas. Use the Text Annotation tool and click into the map canvas.

Figure 8.15: Finestra di dialogo Note testuali

Double clicking on the item opens a dialog with various options. There is the text editor to enter the formatted text
and other item settings. For instance, there is the choice of having the item placed on a map position (displayed
by a marker symbol) or to have the item on a screen position (not related to the map). The item can be moved by
map position (by dragging the map marker) or by moving only the balloon. The icons are part of the GIS theme,
and they are used by default in the other themes, too.

The Move Annotation tool allows you to move the annotation on the map canvas.

8.12.1 Html annotations

The Html Annotation tools in the attribute toolbar provides the possibility to place the content of an html file in a
balloon on the QGIS map canvas. Using the Html Annotation tool, click into the map canvas and add the path to
the html file into the dialog.

8.12.2 SVG annotations

The SVG Annotation tool in the attribute toolbar provides the possibility to place an SVG symbol in a balloon on
the QGIS map canvas. Using the SVG Annotation tool, click into the map canvas and add the path to the SVG file
into the dialog.
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8.12.3 Form annotations

Additionally, you can also create your own annotation forms. The Form Annotation tool is useful to display
attributes of a vector layer in a customized Qt Designer form (see figure_custom_annotation). This is similar
to the designer forms for the Identify features tool, but displayed in an annotation item. Also see this video
https://youtu.be/0pDBuSbQ02o?t=2m25s from Tim Sutton for more information.

Figure 8.16: Customized qt designer annotation form

Nota: If you press Ctrl+T while an Annotation tool is active (move annotation, text annotation, form annota-
tion), the visibility states of the items are inverted.

8.13 Segnalibri geospaziali

I segnalibri geospaziali ti permettono di memorizzare una posizione geografica alla quale potrai ritornare in un
secondo momento. Per impostazione predefinita, i segnalibri vengono salvati sul computer, il che significa che
sono disponibili per qualsiasi progetto attivato su tale computer. Se desideri memorizzare il segnalibro nel file di
progetto (.qgs) puoi fare ciò selezionando la casella di controllo Nel Progetto.

8.13.1 Creazione di un segnalibro

Per creare un segnalibro:

1. Usa lo zoom o muovi la mappa all’estensione d’interesse.

2. Select the menu option View → New Bookmark or press Ctrl-B. The Spatial Bookmark panel opens with
the newly created bookmark.

3. Inserisci un nome descrittivo per il segnalibro (fino a 255 caratteri).

4. Seleziona il campo Progetto se desideri salvare il segnalibro nel file di progetto.

5. Premere Invio per aggiungere il segnalibro o fare clic altrove.

Nota che puoi avere più di un segnalibro con lo stesso nome.
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8.13.2 Uso e gestione dei segnalibri

To use or manage bookmarks, select the menu option View → Show Bookmarks. The Spatial Bookmarks panel
allows you to:

• Zoom a un Segnalibro: seleziona il segnalibro desiderato e poi fai click su Zoom a un Segnalibro. Puoi fare
lo zoom su un segnalibro anche facendo doppio click su di esso.

• Cancellare un Segnalibro: seleziona il segnalibro e fai click su Elimina segnalibro. Conferma la tua scelta.

• Import or Export a bookmark: To share or transfer your bookmarks between computers you can use the
Import/Export Bookmarks pull down menu in the Spatial Bookmarks dialog. All the bookmarks are trans-
ferred.

8.14 Progetti nidificati

Sometimes, you’d like to keep in different projects a bunch of layers with the same style. You can either create a
default style for these layers or embed them from another project to save you tons of work.

Layers e gruppi nidificati da un progetto esistente presenta alcuni vantaggi rispetto alla gestione dello stile:

• all types of layers (vector or raster, local or online...) can be added

• fetching groups and layers, you can keep the same tree structure of the “background” layers in your different
projects

• While the embedded layers are editable, you can’t change their properties such as symbology, labels, forms,
default values, actions... This ensures homogeneity throughout the projects

• modify the items in the original project and changes are propagated to all the other projects.

If you want to embed content from other project files into your project, select Layer → Embed Layers and Groups
and:

1. Press to look for a project; you can see the content of the project (see figure_embed_dialog).

2. Press Ctrl ( or Cmd) and click on the layers and groups you wish to retrieve.

3. Press [OK]. The selected layers and groups are embedded in the Layer panel and can be visualized in the
map canvas now. Names of embedded items appear in italic to distinguish them from regular layers and
groups.

Figure 8.17: Selezionare layers e gruppi nidificati

Like any other layer, an embedded layer can be removed from the project by right-click on the layer and choose
Remove.

Suggerimento: Cambiare la visualizzazione di un layer nidificato
It’s not possible to change rendering of an embedded layer, unless you make the changes in the original project
file. However, right-click on a layer and select Duplicate creates a layer which is fully-featured and not dependent
to the original project. You can then safely remove the linked layer.
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8.15 Decorazioni

The Decorations of QGIS include the Grid, the Copyright Label, the North Arrow and the Scale Bar. They are
used to ‘decorate’ the map by adding cartographic elements.

8.15.1 Reticolo

Reticolo ti permette di aggiungere un reticolo e le coordinata alla mappa.

Figure 8.18: Finestra di dialogo Reticolo

1. Select from menu View → Decorations → Grid. The dialog starts (see figure_decorations_grid).

2. Activate the Enable grid checkbox and set grid definitions according to the layers loaded in the map
canvas.

3. Activate the Draw annotations checkbox and set annotation definitions according to the layers loaded
in the map canvas.

4. Click [Apply] to verify that it looks as expected or [OK] if you’re satisfied.

8.15.2 Etichetta Copyright

Copyright label adds a copyright label using the text you prefer to the map.

1. Select from menu View → Decorations → Copyright Label. The dialog starts (see fig-
ure_decorations_copyright).

2. Make sure the Enable Copyright Label checkbox is checked.

3. Enter the text you want to place on the map. You can use HTML as shown in the example.

4. Scegli il posizionamento dell’etichetta nel menu a tendina Posizione .

5. You can refine the placement of the item by setting a Horizontal and/or Vertical Marging from (Canvas)
Edge. These values can be a distance in Millimeter or Pixels or set as Percentage of the width or height of
the map canvas.

6. You can change the color to apply.

7. Click [Apply] to verify that it looks as expected or [OK] if you’re satisfied.
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Figure 8.19: La finestra di dialogo Copyright

In the example above, which is the default, QGIS places a copyright symbol followed by the date in the lower
right-hand corner of the map canvas.

8.15.3 Freccia Nord

North Arrow places a simple north arrow on the map canvas. Currently, there is only one style available. You can
adjust the angle of the arrow or let QGIS set the direction automatically. If you choose to let QGIS determine the
direction, it makes its best guess as to how the arrow should be oriented. For placement of the arrow, you have
four options, corresponding to the four corners of the map canvas. You can refine the placement of the arrow by
setting a Horizontal and/or Vertical Marging from (Canvas) Edge. These values can be a distance in Millimeter
or Pixels or set as Percentage of the width or height of the map canvas.

Figure 8.20: La finestra di dialogo Freccia Nord

8.15.4 Barra di Scala

Barra di scala aggiunge una semplice barra di scala alla mappa. Puoi controllare il posizionamento, lo stile, il
colore e le dimensioni di etichettatura della barra.

QGIS only supports displaying the scale in the same units as your map frame. So if the units of your layers are in
meters, you can’t create a scale bar in feet. Likewise, if you are using decimal degrees, you can’t create a scale
bar to display distance in meters.

Per aggiungere una barra di scala:
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Figure 8.21: La finestra di dialogo Barra di Scala

1. Select from menu View → Decorations → Scale Bar. The dialog starts (see figure_decorations_scale).

2. Make sure the Enable scale bar checkbox is checked.

3. Choose the style from the Scale bar style combo box.

4. Select the color for the bar Color of bar or use the default black color.

5. Set the Size of bar .

6. Optionally, check Automatically snap to round number on resize to display values easy-to-read.

7. Choose the placement from the Placement combo box.

8. You can refine the placement of the item by setting a Horizontal and/or Vertical Marging from (Canvas)
Edge. These values can be a distance in Millimeter or Pixels or set as Percentage of the width or height of
the map canvas.

9. Click [Apply] to verify that it looks as expected or [OK] if you’re satisfied.

Suggerimento: Settings of Decorations
When you save a .qgs project, any changes you have made to Grid, North Arrow, Scale Bar and Copyright will
be saved in the project and restored the next time you load the project.

8.16 Autenticazione

QGIS has facility to store/retrieve authentication credentials in a secure manner. Users can securely save cre-
dentials into authentication configurations, which are stored in a portable database, can be applied to server or
database connections, and safely referenced by their ID tokens in project or settings files. For more information
see Authentication System.

Una password master deve essere impostata durante l’inizializzazione del sistema di autenticazione e del relativo
database portatile.

8.17 Variables

In QGIS, you can use variables to store useful recurrent values (e.g. the project’s title, or the user’s full name) that
can be used in expressions. Variables can be defined at the application’s global level, project level, layer level,
composition level, and composer’s item level. Just like CSS cascading rules, variables can be overwritten - e.g., a
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project level variable will overwrite any application’s global level variables set with the same name. You can use
these variables to build text strings or other custom expressions using the @ character before the variable name.
For example in composer creating a label with this content:

This map was made using QGIS [% @qgis_version %]. The project file for this
map is: [% @project_path %]

Visualizzerà l’etichetta in questo modo:

This map was made using QGIS 2.14. The project file for this map is:
/gis/qgis-user-conference-2015.qgs

Oltre alle variabili di sola lettura preimpostate, puoi definire tue variabili personalizzate per ciascuno dei layers
sopra menzionati. Puoi gestire:

• global variables from the Settings → Options menu;

• project’s variables from Project properties (see Proprietà progetto);

• vector layer’s variables from the Layer Properties dialog (see Proprietà dei vettori);

• composition’s variables from the Composition panel in the Print composer (see Composition Panel);

• and composer item’s variables from the Item properties panel in the Print composer (see Composer Items
Common Options).

To differentiate from editable variables, read-only variable’s names and values are emphasized in italic. On the
other hand, higher level variables overwritten by lower level ones are strike through.

Figure 8.22: Variables editor at the project’s level

Nota: You can read more about variables and find some examples in Nyall Dawson’s Exploring variables in
QGIS 2.12, part 1, part 2 and part 3 blog posts.
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CHAPTER 9

Configurazione QGIS

QGIS is highly configurable through the Settings menu. Choose between Options, Project Properties and Cus-
tomization.

Nota: QGIS follows desktop guidelines for the location of options and project properties item. Consequently
related to the OS you are using, location of some of items described below could be in the Project or the Settings
menu.

9.1 Opzioni dell’interfaccia grafica (GUI)

Alcune opzioni di base per QGIS possono essere impostate nella finestra di dialogo Opzioni. Seleziona
l’opzione del menu Impostazioni → Opzioni. Puoi modificare le opzioni in accordo alle tue necessità. Al-
cune delle modifiche potrebbero richiedere il riavvio di QGIS prima di diventare effettive.

Le schede in cui puoi personalizzare le tue opzioni sono descritte di seguito.

9.1.1 Impostazioni generali

Applicazione

• Select the Style (QGIS restart required) and choose between ‘Oxygen’, ‘Windows’, ‘Motif’, ‘CDE’,
‘Plastique’ and ‘Cleanlooks’.

• Define the Icon theme . It can be ‘default’ or ‘Night Mapping’.

• Define the Icon size .

• Define the Font and its Size. The font can be Qt default or a user-defined one.

• Change the Timeout for timed messages or dialogs .

• Hide splash screen at startup

• Show tips at startup

• Check QGIS version at startup to keep you informed if a newer version is released

• QGIS-styled group boxes

• Use native color chooser dialogs (see Scelta colore)

• Use live-updating color chooser dialogs (see Scelta colore)

• Canvas rotation support (restart required)
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File di progetto

• Open project on launch (choose between ‘New’, ‘Most recent’, ‘Welcome Page’, and ‘Specific’).

When choosing ‘Specific’ use the to define the project to use by default. The ‘Welcome Page’ displays
a list of recent projects with screenshot.

• Crea un nuovo progetto dal progetto predefinito. Puoi scegliere Definisce il progetto attuale come
predefinito oppure Ripristina il predefinito. Sfoglia fra i tuoi file e specifica la cartella in cui sono presenti

i progetti da usare come modello. Se hai spuntato la casella di controllo Crea un nuovo progetto dal
progetto predefinito e hai salvato un progetto nella cartella dei modelli, comparirà la nuova voce Progetto
→ Nuovo da modello.

• Prompt to save project and data source changes when required

• Chiedi conferma quando si vuole rimuovere un layer

• Warn when opening a project file saved with an older version of QGIS

• Enable macros . This option was created to handle macros that are written to perform an action on
project events. You can choose between ‘Never’, ‘Ask’, ‘For this session only’ and ‘Always (not recom-
mended)’.

9.1.2 Impostazioni di sistema

Percorsi SVG

Aggiungi o Rimuovi Percorso(i) dove cercare i simboli SVG (Scalable Vector Graphic). Questi file SVG sono
quindi disponibili per simboleggiare le geometrie o decorare la tua composizione della mappa.

Percorsi verso i plugin

Add or Remove Path(s) to search for additional C++ plugin libraries

QSettings

Ripristina l’interfaccia utente alle impostazioni predefinite (riavvio richiesto) ti aiuta se hai fatto qualche person-
alizzazione.

Ambiente

Il gruppo Ambiente mostra le variabili di ambiente e permette anche di configurarle (vedi fig-
ure_environment_variables). Questa opzione è particolarmente utile per piattaforme stile Mac, dove le appli-
cazioni GUI non ereditano necessariamente l’ambiente shell dell’utente. È utile anche per impostare/visualizzare
le variabili di ambiente usate da strumenti esterni, gestiti da Processing come, SAGA e GRASS. Infine è utile
anche per abilitare gli output del debug per specifiche sezione del codice sorgente.

• Use custom variables (restart required - include separators). You can [Add] and [Remove] variables.
Already-defined environment variables are displayed in Current environment variables, and it’s possible to

filter them by activating Show only QGIS-specific variables.

9.1.3 Impostazioni sorgenti dati

Attributi delle geometrie e tabelle

• Apri la tabella degli attributi in una finestra agganciata

• Copia elementi come ‘Testo normale, nessuna geometria’, ‘Testo normale, geometria WKT’, o ‘GeoJSON’
quando si incollano le geometrie in altre applicazioni.
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Figure 9.1: Variabili ambiente di sistema in QGIS

• Comportamento della tabella di attributi : imposta il filtro sulla tabella degli attributi all’apertura.
Sono presenti tre possibilità: ‘Mostra tutti gli elementi’, ‘Mostra gli elementi selezionati’ e ‘Mostra gli
elementi visibili nella mappa’.

• Vista predefinita: definisce la modalità di visualizzazione della tabella degli attributi ad ogni apertura. Può
essere ‘Ricorda l’ultima vista’, ‘Vista tabella’ o ‘Vista modulo’.

• Cache riga attributi tabella . La cache permette di salvare le ultime N righe degli attributi caricate:
in questo modo il lavoro con la tabella degli attributi risulterà essere molto più veloce. La cache verrà
cancellata alla chiusura della tabella degli attributi.

• Mostra i valori NULL come. Puoi definire un attributo con cui verranno visualizzati i valori NULL (nessun
valore).

Suggerimento: Migliorare l’apertura della tabella degli attributi con grandi quantità di dati
Quando si lavora con layers con una grande quantità di record, l’apertura della tabella degli attributi potrebbe
essere lenta nel mostrare tutte le righe. L’impostazione del Comportamento della tabella di attributi su Mostra gli
elementi visibili nella mappa richiede l’elenco solo per le geometrie visibili nella mappa corrente, consentendo
un rapido caricamento dei dati.

Nota che i dati con questa modalità della tabella degli attributi saranno sempre legati all’area di visualizzazione,
il che significa che selezionando Mostra tutte gli elementi all’interno di tale tabella non verranno visualizzate
nuove geometrie. Puoi comunque aggiornare il set di geometrie visualizzate cambiando l’estensione della mappa
e selezionando l’opzione Mostra gli elementi visibili nella mappa nella tabella degli attributi.

Trattamento delle sorgenti dati

• Ricerca elementi validi nella finestra del browser . Puoi scegliere fra ‘Controlla estensione’ e ‘Con-
trolla il contenuto del le’.
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• Scan for contents of compressed files (.zip) in browser dock . ‘No’, ‘Basic scan’ and ‘Full scan’ are
possible.

• Richiedi i sublayer raster al caricamento. Alcuni raster supportano i sublayer, chiamati subdataset in
GDAL. Un esempio sono i file netCDF: se sono presenti diverse variabili netCDF, GDAL riconosce ogni
variabile come un subdataset. L’opzione permette di gestire i sublayer quando uno di questi viene aperto.
Puoi scegliere fra:

– ‘Sempre’: chiede sempre (se sono presenti sublayer)

– ‘Se necessario’: chiede se il layer non ha bande, ma ha sublayer

– ‘Mai’: non chiede mai e non carica niente

– ‘Carica tutto’: non chiede, ma carica tutti i sublayer

• Ignora la dichiarazione di codifica per lo shapele. Se lo shapele ha informazioni sulla sua codifica,
queste verranno ignorate.

• Aggiungi layer PostGIS con un doppio click e seleziona modalità estesa

• Aggiungi layer Oracle con un doppio click e seleziona modalità estesa

• Esegui le espressioni sul server se possibile

Percorsi nascosti al Browser

This widget lists all the folder you chose to hide from the Browser panel. Removing a folder from the list will
make it available in the Browser panel.

9.1.4 Impostazioni di visualizzazione

Figure 9.2: Scheda Visualizzazione della finestra di dialogo Proprietà progetto

66 Chapter 9. Configurazione QGIS



QGIS User Guide, Release 2.18

Opzioni di visualizzazione

• By default new layers added to the map should be displayed

• Usa il caching del disegno quando possibile per velocizzare la visualizzazione

• Visualizza i layyer in parallelo usando più processori della CPU

• Numero massimo di processori

• Intervallo dio aggiornamento della mappa (predefinito a 250 ms)

• Abilita semplificazione delle geometrie per i nuovi layer aggiunti

• Semplifica dal lato provider se possibile

• Algoritmo di semplificazione: Questa opzione esegue una semplificazione locale “on-the-fly” sulle geome-
trie e accelera la visualizzazione della stessa. Non modifica la geometria originaria. Questo è importante
quando hai espressioni che si riferiscono alla geometria (ad esempio il calcolo dell’area) assicurando che
questi calcoli vengano eseguiti sulla geometria originale, non su quella semplificata. A tale scopo, QGIS
fornisce tre algoritmi: ‘Distance’ (predefinito), ‘SnapToGrid’ e ‘Visvalingam’.

• Semplifica dal lato fornitore se possibile: le geometrie sono semplificate dal fornitore (PostGIS, Oracle
...) e diversamente dalla semplificazione sul lato locale, i calcoli basati sulla geometria potrebbero essere
compromessi

• Scala massima alla quale il layer dovrebbe essere semplificato

• Magnification level (see the magnifier)

Nota: Oltre all’impostazione globale, la semplificazione delle geometrie può essere impostata per qualsiasi layer
specifico dal menu :Proprietà vettore –> Visualizzazione.

Impostazioni di visualizzazione

• Rendi le linee meno irregolari a spese delle prestazioni

Segmentazione curva

• Tolleranza di segmentazione: questa impostazione controlla il modo in cui gli archi di cerchio sono visu-
alizzati. Il più piccolo massimo angolo (tra i due vertici consecutivi e il centro della curva, in gradi) o
la differenza massima (distanza tra il segmento dei due vertici e la linea della curva, in unità di mappa), i
segmenti più dritti verranno utilizzati durante la visualizzazione.

• Tolerance type: it can be ‘Maximum angle’ or ‘Maximum distance’

Raster

• Con Selezione banda RGB puoi scegliere il numero di bande rosse, verdi e blu.

Miglioramento contrasto

• Single band gray . A single band gray can have ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip
to MinMax’ and also ‘Clip to MinMax’.

• Multi band color (byte/band) . Options are ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip to
MinMax’ and ‘Clip to MinMax’.

• Multi band color (>byte/band) . Options are ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip to
MinMax’ and ‘Clip to MinMax’.

• Limits (minimum/maximum) . Options are ‘Cumulative pixel count cut’, ‘Minimum/Maximum’,
‘Mean +/- standard deviation’.

• Limiti di taglio del conteggio cumulativo pixel
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• Moltiplicatore deviazione standard

Debugging

• Map canvas refresh

9.1.5 Impostazioni colori

This menu allows you to add some custom color that you can find in each color dialog window of the renderers.
You will see a set of predefined colors in the tab: you can delete or edit all of them. Moreover you can add the
color you want and perform some copy and paste operations. Finally you can export the color set as a gpl file or
import them.

9.1.6 Impostazioni Mappa e Legenda

Default map appearance (overridden by project properties)

• Define a Selection color and a Background color.

Layer legend

• Azione doppio click in legenda . Puoi scegliere fra ‘Apri proprietà layer’ oppure ‘Apri tabella degli
attributi’ facendo doppio click sul layer.

• The following Legend item styles are possible:

– Capitalise layer names

– Bold layer names

– Bold group names

– Display classification attribute names

– Create raster icons (may be slow)

– you can also set the WMS getLegendGraphic Resolution

9.1.7 Impostazioni strumenti Mappa

Questa scheda ti permette di scegliere alcune opzioni sul comportamento di Informazioni elementi.

• Search radius for identifying and displaying map tips is a tolerance distance within which the identify tool
will depict results as long as you click within this tolerance.

• Colore di evidenziazione ti permette di scegliere con quale colore saranno evidenziate le geometrie identifi-
cate.

• Buffer determina una distanza di buffer da visualizzare dal contorno dell’evidenziazione di identificazione.

• Larghezza minima determina di quale spessore deve essere il contorno di un oggetto evidenziato.

Strumenti di misura

• Colore elastico

• Posizioni decimali

• Mantieni le unità di base per non convertire automaticamente numeri grandi (ad esempio, metri a
chilometri)

• Unità preferite per le distanze (‘Metri’, ‘Chilometri’, ‘Piedi’, ‘Iarde’, ‘Miglia’, ‘Miglia Nautiche’,
‘Gradi’ or ‘Unità Mappa’ )
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• Preferred area units (‘Square meters’, ‘Square kilometers’, ‘Square feet’, ‘Square yards’, ‘Square miles’,
‘Hectares’, ‘Acres’, ‘Square nautical miles’, ‘Square degrees” or ‘Map Units’)

• Unità preferite per gli angoli (‘Gradi’, ‘Radianti’, ‘Gon/gradianti’, ‘Minuti di arco’, ‘Secondi di arco’ o
‘Rotazioni/rivoluzioni’)

Spostamento e zoom

• Definire un Fattore di zoom per strumenti di zoom o rotella del mouse

Scale preimpostate

Qui trovi una lista di scale predefinite. Con i pulsanti e puoi aggiungere o rimuovere le scale personali.
Puoi anche importare o esportare le scale da/a un file .XML. Nota che puoi ancora avere la possibilità di rimuovere
le tue modifiche e ripristinare l’elenco predefinito.

9.1.8 Composer Settings

Opzioni predefinite del compositore

You can define the Default font used within the print composer.

Reticolo

• Scegli lo Stile reticolo (‘Pieno’, ‘Punti’, ‘Croci’)

• Scegli il Colore del reticolo

Opzioni predefinite delle guide e del reticolo

• Specifica la Spaziatura reticolo

• Define the Grid offset for x and y

• Definire la Tolleranza di aggancio

Composer Paths

• Define Path(s) to search for extra print templates: a list of folders with custom composer templates to use
while creating new one.

9.1.9 Impostazioni digitalizzazione

Questa scheda ti aiuta a configurare le impostazioni generali quando sei in modifica layer vettoriale (attributi e
geometria).

Creazione di geometrie

• Suppress attribute form pop-up after feature creation

• Reuse last entered attribute values

• Verifica le geometrie. Modificare linee/poligoni con molti nodi può portare a una visualizzazione molto
lenta. Questo succede perché le procedura di verifica delle geometrie in QGIS richiede molto tempo. Per
velocizzare la visualizzazione è possibile selezionare GEOS (a partire da GEOS 3.3) oppure disattivare del
tutto la verifica. La verifica effettuata da GEOS è molto più rapida, ma ha lo svantaggio di comunicare
solamente il primo problema geometrico riscontrato.

Elastico

• Define Rubberband Line width, Line color and Fill color

• Don’t update rubberband during node editing

Snapping
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• Open snapping options in a dock window (QGIS restart required)

• Define Default snap mode (‘To vertex’, ‘To segment’, ‘To vertex and segment’, ‘Off’)

• Imposta la Tolleranza di aggancio predefinita in unità di mappa o pixel

• Imposta il Raggio di ricerca per le modifiche dei vertici in unità di mappa o in pixel

Indicatori di vertice

• Utilizza indicatori solo per le geometrie selezionate

• Definisci vertice Stile simbolo (‘Croce’ (predefinito), ‘Cerchio semi trasparente’ o ‘Nessuno’)

• Specifica le Dimensioni indicatore

Strumento per la curva di offset

Le 3 opzioni successive si riferiscono allo strumento Curva di offset in Digitalizzazione avanzata. Attraverso i
vari settaggi è possibile influenzare la forma della linea di offset. Queste opzioni sono possibili a partire da GEOS
3.3.

• Stile unione: ‘Tondo’, ‘Seghettato’ o ‘Smussato’

• Segmenti di quadrante

• Limite di smusso

9.1.10 Impostazioni GDAL

GDAL è una libreria di scambio dati per file raster. In questa scheda puoi Modifica le opzioni di creazione e
Modifica le opzioni per le piramidi dei formati raster. Puoi definire quale driver GDAL deve essere utilizzato per
un formato raster, poiché in alcuni casi è disponibile più di un driver GDAL.

9.1.11 Impostazioni SR

Default CRS for new projects

• Don’t enable ‘on the fly’ reprojection

• Automatically enable ‘on the fly’ reprojection if layers have different CRS

• Enable ‘on the fly’ reprojection by default

• Select a CRS and Always start new projects with this CRS

SR per i nuovi layer

Questa sezione permette di specificare il comportamento di QGIS quando viene creato un nuovo layer oppure
quando viene caricato un layer privo di SR.

• Richiedi SR

• Usa il SR del progetto

• Use default CRS

Trasformazioni datum predefinite

• Ask for datum transformation when no default is defined

• With the ‘on-the-fly’ CRS transformation enabled and the above option checked, adding layers of different
CRS opens the Select datum transformations dialog. This offers you to select the most appropriate trans-
formation settings. Validating this dialog with the ‘Remember selection’ option checked populates the table
under CRS → Default datum transformations with information about ‘Source CRS’ and ‘Destination CRS’
as well as ‘Source datum transform’ and ‘Destination datum transform’. From now, QGIS automatically
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uses the selected datum transformation for further transformation between these two CRSs until you
remove it from the list.

You can use the button to add a datum transformation if you know its parameters (source and destination
ellipsoids and the numbers from the transformation table). You then need to manually enter each setting.

Nota: For more information on how QGIS handles layers projection, please read the dedicated section at Lavorare
con le proiezioni.

9.1.12 Locale Settings

• Override system locale and Locale to use instead

• Information about active system locale

9.1.13 Impostazioni di autenticazione

Nella scheda Autenticazione puoi impostare le configurazioni di autenticazione e gestire i certificati PKI. Vedi
Authentication System per maggiori dettagli.

9.1.14 Network Tab

Generale

• Indirizzo di ricerca WMS (Quello predefinito è http://geopole.org/wms/search?search=%1&type=rss)

• Imposta il Timeout per le richieste di rete (ms) - il valore predefinito è 60000

• Definire Periodo di scadenza predefinito per capabilities WMS (ore) - l’impostazione predefinita è 24

• Imposta il Periodo di scadenza predefinito per piastrelle WMSC/WMTS (ore) - valore standard è 24

• Definire Numero massimo di tentativi in caso di errore nella richiesta della mattonella o della geometria

• Definisci l’Utente-Agente

Impostazioni della cache

Define the Directory and a Size for the cache.

• Use proxy for web access and define ‘Host’, ‘Port’, ‘User’, and ‘Password’.

• Set the Proxy type according to your needs.

– Default Proxy: Proxy is determined based on the application proxy set using

– Socks5Proxy: Proxy generico per ogni tipo di connessione. Supporta TCP, UDP, associazione a una
porta (connessione in entrata) e autenticazione.

– HttpProxy: Realizzato usando il comando “CONNECT”, supporta solamente connessioni TCP in us-
cita; supporta l’autenticatione.

– HttpCachingProxy: Realizzato usando normali comandi HTTP, è utile solamente nel contesto di richi-
este HTTP.

– FtpCachingProxy: Realizzato usando un proxy FTP, è utile solamente nel contesto di richieste FTP.

È possibile escludere alcuni URL aggiungendo il testo nella sezione dedicata (vedi Figure_Network_Tab).

If you need more detailed information about the different proxy settings, please refer to the manual of the under-
lying QT library documentation at http://doc.qt.io/qt-4.8/qnetworkproxy.html#ProxyType-enum
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Figure 9.3: Impostazione proxy in QGIS
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Suggerimento: UTILIZZO DEI PROXY
L’utilizzo dei proxy a volte può essere complicato. È utile procedere con ‘tentativo e errore’ con i suddetti tipi di
proxy, per verificare se hanno successo nel tuo caso.

9.1.15 Impostazioni variabili

La scheda Variabili elenca tutte le variabili disponibili a livello globale.

Permette inoltre all’utente di gestire variabili di livello globale. Fai clic sul pulsante per aggiungere una nuova
variabile personalizzata a livello globale. Allo stesso modo, selezionare una variabile personalizzata a livello

globale dall’elenco e fare clic su pulsante per rimuoverla.

Maggiori informazioni sulle variabili nella sezione Variables.

9.1.16 Impostazioni avanzate

A seconda del sistema operativo, tutte le impostazioni relative a QGIS (interfaccia utente, strumenti, provider di
dati, valori predefiniti, opzioni plug-in ...) vengono salvate:

• in un file di testo: $HOME/.config/QGIS/QGIS2.conf

• nel file che elenca le proprietà: $HOME/Library/Preferences/org.qgis.qgis.plist

• nel registro in: HKEY\CURRENT_USER\Software\QGIS\qgis

La scheda Avanzato ti offre in un unico posto, indipendentemente dal tuo sistema operativo, strumenti per gestire
queste impostazioni attraverso Impostazioni avanzate Editor. Dopo averti avvisato di fare attenzione, il widget
viene popolato con un albero di tutte le impostazioni di QGIS, che è possibile modificare direttamente.

Avvertimento: Evita di utilizzare ciecamente le impostazioni della scheda Avanzate
Fai attenzione quando modifichi gli elementi in questa finestra di dialogo dato che le modifiche vengono
applicate automaticamente. Fare cambiamenti senza consapevolezza può coorompere l’installazione di QGIS
in vari modi.

9.2 Proprietà progetto

In the properties window for the project under Project → Project Properties (or Settings → Project Proper-
ties), you can set project-specific options.

The project-specific options overwrite their equivalent in the options described above.

• In the General tab, the general settings let you:

– dai un titolo al progetto accanto al percorso del file di progetto

– scegliere il colore da usare per le geometrie quando vengono selezionate

– scegliere il colore di sfondo: il colore da usare per l’area della mappa

– scegli se il percorso dei layer nel progetto deve essere salvato come assoluto (completo) o come relativo
al percorso del file di progetto. Puoi preferire il percorso relativo quando sia i layers che i file di
progetto possono essere spostati o condivisi o se si accede al progetto da computer su piattaforme
diverse.

– scegli di evitare artefatti quando il progetto viene reso come tessere mappa. Nota che il controllo con
questa opzione può comportare un peggioramento delle prestazioni.
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Calculating areas and distances is a common need in GIS. However, these values are really tied to the
underlying projection settings. The Measurements frame lets you control these parameters. You can indeed
choose:

– the ellipsoid to use: it can be an existing one, a custom one (you’ll need to set values of the semi-major
and semi-minor axis) or None/Planimetric.

– le unità di misura per le distanze per la lunghezza e il perimetro e le unità di misura per le aree. Queste
impostazioni, i cui valori preimpostati sono nelle opzioni QGIS ma che poi sostituisci per il progetto
corrente, vengono utilizzate in:

* Barra di aggiornamento del campo della tabella degli attributi

* Calcoli del calcolatore di campo

* Identifica la lunghezza, il perimetro e i valori dell’area derivati dallo strumento

* Unità predefinita mostrata nella finestra di dialogo delle misure

The Coordinate display allows you to choose and customize the format of units to use to display the mouse
coordinate in the status bar and the derived coordinates shown via the identify tool.

Finally, you can define a project scale list, which overrides the global predefined scales.

Figure 9.4: Scheda Generale della finestra di dialogo Proprietà progetto

• The CRS tab enables you to choose the Coordinate Reference System for this project, and to enable on-
the-fly re-projection of raster and vector layers when displaying layers from a different CRS. For more
information on projection’s handling in QGIS, please read Lavorare con le proiezioni section.

• With the Identify layers tab, you set (or disable) which layers will respond to the identify tool. By default,
layers are set queryable.
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You can also set whether a layer should appear as read-only, meaning that it can not be edited by the
user, regardless of the data provider’s capabilities. Although this is a weak protection, it remains a quick
and handy configuration to avoid end-users modifying data when working with file-based layers.

• The Default Styles tab lets you control how new layers will be drawn when they do not have an existing
.qml style defined. You can also set the default transparency level for new layers and whether symbols
should have random colors assigned to them. There is also an additional section where you can define
specific colors for the running project. You can find the added colors in the drop down menu of the color
dialog window present in each renderer.

• The tab OWS Server allows you to configure your project in order to publish it online. Here you can
define information about the QGIS Server WMS and WFS capabilities, extent and CRS restrictions. More
information available in section Prepare a project to serve and subsequent.

• La scheda Macro è usata per modificare le macro Python per i progetti. Attualmente sono disponibili solo
tre macro: openProject (), saveProject () e closeProject ().

Figure 9.5: Impostazioni delle macro in QGIS

• La scheda Relations è usata per definire le relazioni 1: n. Le relazioni sono definite nella finestra di di-
alogo delle proprietà del progetto. Una volta che le relazioni esistono per un layer, un nuovo elemento
dell’interfaccia utente nella vista modulo (ad es. quando si identifica una geometria e si apre il suo mod-
ulo) elencherà le entità correlate. Questo fornisce un modo efficace per esprimere per es. lo storico delle
ispezioni su una lunghezza del gasdotto o del segmento stradale. Puoi trovare ulteriori informazioni sul
supporto delle relazioni 1: n nella Sezione Creare una relazione uno a molti o molti a molti.

• Nella scheda Sorgenti dati puoi:

– Evaluate default values on provider side: When adding new features in a PostGreSQL table, fields
with default value constraint are evaluated and populated at the form opening, and not at the commit
moment. This means that instead of an expression like nextval(’serial’), the field in the Add
Feature form will display expected value (e.g., 25).

– Automatically create transaction groups where possible: When this mode is turned on, all (post-
gres) layers from the same database are synchronised in their edit state, i.e. when one layer is put into
edit state, all are, when one layer is committed or one layer is rolled back, so are the others. Also,
instead of buffering edit changes locally, they are directly sent to a transaction in the database which
gets committed when the user clicks save layer. Note that you can (de)activate this option only if no
layer is being edited in the project.

• La scheda Variabili elenca tutte le variabili disponibili a livello di progetto (che include tutte le variabili
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globali). Inoltre, consente anche all’utente di gestire variabili a livello di progetto. Fai clic sul pulsante
per aggiungere una nuova variabile personalizzata a livello di progetto. Allo stesso modo, selezionare una

variabile a livello di progetto personalizzata dall’elenco e fare clic sul pulsante pulsante per rimuoverlo.
Maggiori informazioni sull’utilizzo delle variabili nella sezione Strumenti generali Variables.

9.3 Personalizzazione

La finestra di dialogo di personalizzazione consente di (de) attivare quasi tutti gli elementi dell’interfaccia utente di
QGIS. Questo può essere molto utile se vuoi fornire ai tuoi utenti finali una versione “leggera” di QGIS, contenente
solo le icone, i menu o i pannelli di cui hanno bisogno.

Nota: Prima che le modifiche trovino applicazione, è necessario riavviare QGIS.

Figure 9.6: Finestra di dialogo Personalizzazione

Spuntando la casella di controllo Abilita personalizzazione è il primo passo verso la personalizzazione di
QGIS. Ciò abilita la barra degli strumenti e il pannello dei widget da cui è possibile deselezionare e quindi dis-
abilitare alcuni elementi della GUI.

Gli elementi configurabili possono essere:

• un Menu o alcuni dei suoi sotto-menu da Barra dei Menu

• un intero Panello (vedi Pannelli e Barre degli strumenti)

• la Barra di stato descritta in label_statusbar o qualcuno dei suoi strumenti

• una Barra degli strumenti: per intero o per alcune sue icone

• o alcuni widget di qualsiasi finestra di dialogo in QGIS: etichette, pulsanti, caselle combinate...

Con Passa ai widget per la cattura nell’applicazione principale, puoi fare clic su un strumento dell’interfaccia di QGIS che
vuoi nascondere e QGIS deseleziona automaticamente la voce corrispondente nella finestra di dialogo Personaliz-
zazione.

Once you setup your configuration, click [Apply] or [Ok] to validate your changes. This configuration becomes
the one used by default by QGIS at the next startup.

Le modifiche possono essere salvate in un file .ini usando il pulsante Salva su file. Questo è un modo pratico

per condividere una interfaccia comune QGIS fra più utenti. Basta fare click su Carica da file dal computer di
destinazione per importare il file .ini. Puoi anche utilizzare opzioni della riga dei comandi e salvare varie
impostazioni anche per casi d’uso diversi.

Suggerimento: Ripristinare in modo semplice lo stato predefinito di QGIS
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La configurazione iniziale della GUI di QGIS può essere ripristinata in uno dei seguenti modi:

• deselezionando l’opzione Abilita personalizzazione nella finestra di dialogo Personalizzazione o fare

clic su Verifica tutto

• pressing the [Reset] button in the QSettings frame under Settings → Options menu, System tab

• lanciando QGIS al prompt dei comandi con la seguente riga di comando qgis --nocustomization

• impostando a false il valore della variabile UI -> Personalizzazione -> Abilitato nel menu Impostazioni
→ Opzioni, scheda Avanzato (vedi warning).

In quasi tutti i metodi esposti per rendere operativo il ripristino è necessario riavviare QGIS.

9.4 Tasti di scelta rapida

QGIS provides default keyboard shortcuts for many features. You can find them in section Barra dei Menu. Ad-
ditionally, the menu option Settings → Configure Shortcuts... allows you to change the default keyboard shortcuts
and add new keyboard shortcuts to QGIS features.

Figure 9.7: Definire le opzioni di scelta rapida

Configuration is very simple. Just select a feature from the list and click on :

• [Change] and press the new combination you want to assign as new shortcut

• [Set none] to clear any assigned shortcut

• or [Set default] to backup the shortcut to its original and default value.

Proceed as above for any other tools you wish to customize. Once you have finished your configuration, simply
[Close] the dialog to have your changes applied. You can also [Save] the changes as an .XML file and [Load]
them into another QGIS installation.
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CHAPTER 10

Lavorare con le proiezioni

QGIS consente agli utenti di definire un sistema di riferimento SR ( o CRS Coordinate Reference System) glob-
ale o a livello di singolo progetto per i layer privi di un SR predefinito. Consente inoltre di definire sistemi di
coordinate personalizzati e supporta anche la riproiezione al volo (on-the-y, OTF) di vettori e raster. Tutte queste
funzionalità permettono all’utente di visualizzare layers con SR diversi e di sovrapporli correttamente.

10.1 Panoramica sul supporto alle proiezioni

QGIS supporta all’incirca 2.700 SR. Le definizioni di ognuno di questi SR sono memorizzate in un database
SQLite che viene installato insieme a QGIS. Normalmente non è necessario manipolare il database direttamente,
infatti potresti causare il malfunzionamento del supporto alle proiezioni. I SR personalizzati invece, sono salvati
in un database utente. Vedi la sezione Sistemi di riferimento personalizzati per informazioni sulla gestione dei tuoi
SR personalizzati.

I SR disponibili in QGIS sono basati su quelli definiti dall’European Petroleum Survey Group (EPSG) e
dall’Institut Geographique National francese (IGN) e sono ricavati essenzialmente dalle tabelle di riferimento
spaziale usate da GDAL. I codici EPSG sono presenti nel database e possono essere utilizzati per specificare un
SR in QGIS.

In order to use OTF projection, either your data must contain information about its coordinate reference system or
you will need to define a global, layer or project-wide CRS. For PostGIS layers, QGIS uses the spatial reference
identifier that was specified when the layer was created. For data supported by OGR, QGIS relies on the presence
of a recognized means of specifying the CRS. In the case of shapefiles, this means a file containing the well-known
text (WKT) specification of the CRS. This projection file has the same base name as the shapefile and a .prj
extension. For example, a shapefile named alaska.shp would have a corresponding projection file named
alaska.prj.

Whenever you select a new CRS, the layer units will automatically be changed in the General tab of the Project

Properties dialog under the Project (or Settings) menu.

10.2 Specifiche globali delle proiezioni

QGIS imposta il SR di ogni nuovo progetto su quello definito a livello globale. Il SR globale di default è
EPSG:4326 - WGS84 (proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs), ed è il predefinito

in QGIS. Questo default può essere modificato tramite il pulsante Seleziona SR nella prima sezione della scheda,
che viene utilizzato per definire il sistema di coordinate di riferimento di default per i nuovi progetti come mostrato
in figure_projection_options. Questa impostazione verrà salvata e sarà valida per tutte le successive sessioni di
QGIS.

Quando usi layers che non hanno un SR, devi specificare come QGIS deve interpretare questi layers. La scelta
può essere globale oppure solamente per il progetto corrente: le impostazioni sono disponibili nella scheda SR del
menu Impostazioni → Opzioni.
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Figure 10.1: Scheda SR nella finestra di dialogo Opzioni QGIS

Le opzioni mostrate in figure_projection_options sono:

• Richiedi SR

• Usa il SR del Progetto

• Usa il SR predefinito visualizzato di seguito

If you want to define the coordinate reference system for a certain layer without CRS information, you can also do
that in the General tab of the raster and vector properties dialog (see General Properties for rasters and General
Properties for vectors). If your layer already has a CRS defined, it will be displayed as shown in General tab in
vector layers properties dialog.

Suggerimento: SR nel Pannello Layer
Facendo click con il tasto destro su di un layer nel Layers Panel hai a disposizione due scorciatoie per
l’impostazione del SR. Imposta SR del layer apre direttamente la finestra per la scelta del sistema di riferimento
(vedi figure_projection_project). Imposta il SR del progetto dal layer imposta il SR del progetto sulla base di
quello del layer

10.3 Definire la trasformazione del SR al volo (OTF)

QGIS supporta la riproiezione al volo del SR sia per i raster che per i vettori. Comunque l’opzione OTF non è
abilitata in modo predefinito. Quando OTF è disattivato, ogni layer viene rappresentato utilizzando le coordinate
come lette dall’origine dati. Quando l’OTF è attivo, le coordinate di ciascun layer vengono trasformate nel SR del
progetto.

Ci sono tre modi per fare la trasformazione al volo del SR
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• Select Project Properties → CRS from the Project ( or Settings) menu. You can then activate the

Enable on the fly CRS transformation (OTF) checkbox in the CRS tab and select the CRS to use
(see Scelta del sistema di riferimento delle coordinate)

• Click sull’icona SR attuale nell’angolo in basso a destra della barra di stato, che porta alla finestra di
dialogo precedente.

• Attiva OTF all’impostazione predefinita nella scheda SR della finestra di dialogo Impostazioni →
Opzioni selezionando Effettua sempre la riproiezione al volo o Abilita automaticamente la riproiezione
al volo se i layer hanno SR differenti.

Se hai già caricato un layer e vuoi abilitare la riproiezione OTF, la scelta migliore è aprire la scheda SR della

finestra di dialogo Proprietà progetto, attivare la casella di controllo Effettua la trasformazione ‘al volo’ del

SR, e selezionare un SR. L’icona SR attuale non sarà più disattiva e tutti i layer verranno proiettati in OTF sul
SRS accanto all’icona.

Figure 10.2: Finestra di dialogo Proprietà del progetto

10.4 Scelta del sistema di riferimento delle coordinate

Questa finestra di dialogo consente di assegnare un sistema di riferimento di coordinate a un progetto o a un layer,
a condizione che siano disponibili database di sistemi di proiezione. Gli elementi nella finestra di dialogo sono:

• Filtro: se conosci il codice EPSG, l’identificatore o il nome del sistema di riferimento delle coordinate,
puoi utilizzare la funzione di ricerca per trovarlo. Inserisci il codice EPSG, l’identificatore o il nome.

• Sistemi di riferimento usati di recente: se hai certi SR che usi frequentemente nel tuo lavoro GIS quotidi-
ano, questi verranno visualizzati in questa sezione della finestra di dialogo. Clicca su una di queste voci per
impostare il SR associato.

• Sistemi di riferimento mondiali: questa è una lista di tutti i SR supportati da QGIS, compresi quelli
geografici, proiettati e personalizzati. Per specificare un SR, selezionalo dalla lista espandendo la lista dallo
specifico raggruppamento. Il SR attivo è preselezionato.
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• Testo PROJ.4: Questa è la stringa SR usata dal motore di proiezione PROJ.4. È un testo di sola lettura, a
solo scopo informativo.

Suggerimento: Cerchi un SR per un layer? Usa il selettore SR
Sometimes, you receive a layer and you don’t know its projection. Assuming that you have another layer with a
valid crs that should overlaps with it, enable the OTF reprojection and, in the General tab of the Layer properties
dialog, use the Coordinate Reference System selector to assign a projection. Your layer position is then moved
accordingly. You may have to do some trial and error in order to find the right position, hence its original CRS.

Nota: Quando si lavora con più layer, ad esempio, si devono trovare le intersezioni tra due layer, è importante
che entrambi i layer siano nello stesso SR. Per modificare la proiezione di uno strato, è impossibile modificare
semplicemente il SR nelle proprietà di quel layer. Invece devi salvare il layer come nuovo layer e scegliere il SR
desiderato per il nuovo layer.

10.5 Sistemi di riferimento personalizzati

Se QGIS non ha le informazioni sul sistema di riferimento di cui hai bisogno, puoi crearne uno personalizzato.

Per farlo, seleziona SR personalizzato... dal menu Impostazioni. I SR personalizzati vengono salvati nel tuo
database utente di QGIS. Oltre ai SR personalizzati, questo database contiene anche i segnalibri geospaziali e altri
dati utente.

Definire un SR personalizzato in QGIS richiede una buona comprensione delle librerie PROJ.4. Per iniziare,
fai riferimento al documento “Cartographic Projection Procedures for the UNIX Environment - A User’s Man-
ual” di Gerald I. Evenden, U.S. Geological Survey Open-File Report 90-284, 1990 (disponibile all’indirizzo
ftp://ftp.remotesensing.org/proj/OF90-284.pdf).

Questo manuale descrive l’uso del proj.4 e delle relative utility da riga di comando. I parametri cartografici
usati con proj.4 sono descritti nel manuale utente e sono gli stessi usati da QGIS.

La finestra di dialogo Definizione Sistema Riferimento Spaziale Personalizzato richiede solamente due parametri
per definire un SR personalizzato:

1. Il nome

2. I parametri cartografici in formato PROJ.4.

Per creare un nuovo SR, click sul pulsante Aggiungi nuovo SR e immetti un nome e i parametri del SR.

La voce Parametri deve iniziare con un blocco +proj=, per rappresentare il nuovo SR.

You can test your CRS parameters to see if they give sane results. To do this, enter known WGS 84 latitude and
longitude values in North and East fields, respectively. Click on [Calculate], and compare the results with the
known values in your coordinate reference system.

10.6 Trasformazioni datum predefinite

OTF depends on being able to transform data into a ‘default CRS’, and QGIS uses WGS84. For some CRS there
are a number of transforms available. QGIS allows you to define the transformation used otherwise QGIS uses a
default transformation.

In the CRS tab under Settings → Options you can:

• set QGIS to ask you when it needs define a transformation using Ask for datum transformation when no
default is defined

• edit a list of user defaults for transformations.
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Figure 10.3: Finestra di dialogo SR personalizzato
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QGIS asks which transformation to use by opening a dialogue box displaying PROJ.4 text describing the source
and destination transforms. Further information may be found by hovering over a transform. User defaults can be
saved by selecting Remember selection.
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CHAPTER 11

Gestione fonti dati

11.1 Accedere ai dati

Facendo parte di un ecosistema Software Open Source QGIS è costruito su diverse librerie che, unitamente agli
specifici provider, offrono la capacità di leggere e spesso scrivere molti formati:

• Vector data formats include ESRI formats (shapefiles, geodatabases...), MapInfo and MicroStation file for-
mats, AutoCAD DWG/DXF, GeoPackage, GeoJSON, GRASS, GPX, KML, Comma Separated Values, and
many more... Read the complete list of OGR vector supported formats;

• Raster data formats include ArcInfo Binary Grid, ArcInfo ASCII Grid, JPEG, GeoTIFF, ERDAS IMAGINE,
MBTiles, R or Idrisi rasters, ASCII Gridded XYZ, GDAL Virtual, SRTM, Sentinel Data, and many more...
Read the complete list of raster supported formats;

• Database formats include PostgreSQL/PostGIS, SQLite/SpatiaLite, Oracle, DB2 or MSSQL Spatial,
MySQL...;

• Support of web data services (WM(T)S, WFS, WCS, CSW, ArcGIS Servers...) is also handled by QGIS
providers (see QGIS come client di dati OGC);

• Puoi anche leggere i files supportati dalle cartelle archiviate e utilizzare formati nativi di QGIS come i layer
virtuali e i layer in memoria.

As of the date of this document, more than 80 vector and 140 raster formats are supported by the GDAL/OGR and
QGIS native providers.

Nota: Non tutti i formati in elenco possono funzionare in QGIS per vari motivi. Ad esempio, alcuni richiedono
librerie proprietarie esterne o il sistema operativo in uso potrebbe non essere tra quelli previsti per l’installazione
del formato GDAL/OGR che tu desideri utilizzare. Per avere un elenco di formati disponibili, eseguire la linea
di comando ogrinfo --formats (per i vettori) o vedere il menu Impostazioni → Opzioni → GDAL (per i
raster) in QGIS.

11.1.1 Il Pannello Browser

QGIS Browser is one of the main panels of QGIS that lets you quickly and easily add your data to projects. It
helps you navigate in your filesystem and manage geodata, regardless the type of layer (raster, vector, table), or
the datasource format (plain or compressed files, database, web services).

To add a layer into a project:

1. right-click on QGIS toolbar and check Browser Panel to activate it or select it from the menu View →

Panels (or Settings → Panels);

2. a browser tree with your filesystem, databases and web services is displayed;

3. find the layer in the list;
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4. right-click on its name and select Add selected layer(s). Your layer is now added to the Layers Panel and
can be viewed in the map canvas.

Nota: You can also add a layer or open a QGIS project directly from the Browser panel by double-clicking its
name or by drag-and-drop into the map canvas.

Una volta caricato un file, puoi ingrandirlo utilizzando gli strumenti di navigazione della mappa. Per modificare
lo stile di un layer, apri la finestra di dialogo Proprietà Layer facendo doppio clic sul nome del layer o facendo
clic con il pulsante destro del mouse sul nome nella legenda e scegliendo Proprietà nel menu contestuale. Vedi la
sezione Style Properties per ulteriori informazioni sull’impostazione di simbologia dei layer vettoriali.

Nella parte superiore del Browser panel trovi alcune icone che ti aiutano a:

• Aggiungi layer selezionati: puoi aggiungere dati nella mappa anche selezionando Aggiungi layer selezionato
dal menu contestuale del layer;

• Aggiorna la visualizzazione ad albero;

• Browser filtro per cercare dati specifici. Immetti una parola di ricerca o un carattere jolly e il browser
visualizzerà l’albero per visualizzare solo i percorsi corrispondenti a tabelle DB, file o cartelle DB - al-
tri dati o cartelle non verranno visualizzate. Vedi l’esempio del Pannello di Browser (2) sulla figura fig-
ure_browser_panels. La ricerca può essere sensibile alla distinzione tra maiuscole e minuscole o meno. Può
anche essere impostata su:

– normale: restituisce qualsiasi elemento contenente il testo cercato;

– utilizzando il/i carattere(i) jolly: confermare la ricerca utilizzando ? e/o * per specificare la posizione
del testo cercato;

– usando una espressione regolare.

• Racchiudi tutto collassa la struttura ad albero;

• Enable/disable properties widget: when toggled on, a new widget is added at the bottom of the panel showing, if
applicable, metadatas of the selected item.

Click destro su un elemento nell’albero del browser ti aiuta a:

• in caso di un file o di una tabella, visualizzarne i metadati o aprirli nel tuo progetto. Le tabelle possono
anche essere rinominate, cancellate o troncate;

• in caso di cartella, definirla come segnalibro nei preferiti, nasconderla dall’albero del browser. Le cartelle
nascoste possono essere gestite dalla scheda Impostazioni → Opzioni → Origine dati;

• creare collegamento a database o server web;

• aggiornare, rinominare o eliminare la scelta.

Puoi anche importare i les nei database o copiare le tabelle da uno schema/database a un altro con un semplice
trascinamento drag-and-drop. C’è un secondo pannello del browser disponibile per evitare lunghi scorrimenti
durante il trascinamento. Basta selezionare il le e fare drag-and-drop da un pannello all’altro.

Suggerimento: Aggiungi layers a QGIS con un semplice drag-and-drop dal visualizzatore file del tuo
sistema operativo

Puoi anche aggiungere i le al progetto trascinandoli dal proprio visualizzatore di le del sistema operativo in uso al
Panello Layer o all’area di visualizzazione mappa.

11.1.2 Il DB Manager

Il Plugin DB Manager è un altro degli strumenti principali e nativi per integrare e gestire i formati di database
spaziali supportati da QGIS (PostGIS, SpatiaLite, GeoPackage, Oracle Spatial, MSSQL, DB2, Virtual layers) in
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Figure 11.1: Pannelli QGIS Browser affiancati

un’interfaccia utente. Può essere attivato dal menu Plugins → Gestisci ed installa Plugins....

Il Plugin DB Manager offre diverse funzionalità:

• collegarsi a database e visualizzare la struttura e il contenuto;

• anteprima di tabelle di database;

• aggiungere layers alla visualizzazione mappa, sia con un doppio clic che con trascina e rilascia;

• aggiungere layers a un database da QGIS Browser o da un altro database;

• creare e aggiungere l’output delle query SQL alla visualizzazione mappa;

• creare virtual layers.

Ulteriori informazioni sulle funzionalità di DB Manager sono esposte in Plugin DB Manager.

11.1.3 Strumenti di caricamento per specifici provider di dati

Oltre a Pannello Browser e DB Manager che sono gli strumenti di base forniti da QGIS per aggiungere layers a
prescindere dal formato, puoi anche trovate strumenti che sono specifici ai fornitore di dati.

Nota: Alcuni external plugins propongono anche strumenti per aprire file di formato specifico in QGIS..

Caricare un layer da un le

Per caricare un layer da un file, puoi:

• for vector data (like Shapefile, Mapinfo or dxf layer), click on Add Vector Layer toolbar button, select the

Layer → Add Layer → Add Vector Layer menu option or press Ctrl+Shift+V. This will bring up a
new window (see figure_vector_add) from which you can check File and click on [Browse]. You can
also specify the encoding for the file if desired.
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Figure 11.2: Finestra di dialogo DB Manager

Figure 11.3: Finestra di dialogo aggiungi vettore
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• per i layer raster, clicca sull’icona Aggiungi raster, selezione l’opzione del menu Layer → Aggiungi layer
→ o digita Ctrl+Shift+R.

Verrà visualizzata una finestra di dialogo standard per i file aperti (vedi figure_vector_open), che ti consente di
navigare nel file system e caricare uno shapefile, un geotiff o un’altra fonte dati supportata. La casella di selezione

Filtro ti consente di preselezionare alcuni formati di file supportati. Solo i formati che sono stati ben testati
appaiono nella lista. Altri formati non testati possono essere caricati selezionando Tutti i file (*. *) .

Figure 11.4: Aprire una finestra di dialogo di un layer vettoriale supportato OGR

Selecting a file from the list and clicking [Open] loads it into QGIS. More than one layer can be loaded at the same
time by holding down the Ctrl or Shift key and clicking on multiple items in the dialog. Figure_vector_loaded
shows QGIS after loading the alaska.shp file.

Nota: Poiché alcuni formati come MapInfo (ad esempio .tab) o Autocad (.dxf) consentono di mescolare
diversi tipi di geometrie in un singolo file, il caricamento di tale formato in QGIS apre una finestra di dialogo per
selezionare le geometrie da utilizzare in modo da ricavare un layer a singola tipologia geometrica.

Using the Add Vector Layer tool:

• You can also load specific formats like ArcInfo Binary Coverage, UK. National Transfer
Format, as well as the raw TIGER format of the US Census Bureau or OpenfileGDB. To do that,
you’d need to select Directory as Source type. In this case a directory can be selected in the dialog after
pressing [Browse].

• With the Database source type you can select an existing database connection or create one to
the selected database type. Available database types are ODBC, OGDI Vectors, Esri Personal
Geodatabase, MySQL as well as PostgreSQL or MSSQL.

Pressing the [New] button opens the Create a New OGR Database Connection dialog whose parameters
are among the ones you can find in Creazione della connessione. Pressing [Open] you can select from the
available tables for example of the PostGIS enabled database.

• The last source type, Protocol, enables to open data from the web using for example GeoJSON or
CouchDB format. After selecting the type you have to fill URI of the source.

Suggerimento: Caricare layers e progetti da unità esterne montate su macOS
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Figure 11.5: QGIS con il caricamento dello Shapefile Alaska

On macOS, portable drives that are mounted beside the primary hard drive do not show up as expected under File
→ Open Project. We are working on a more macOS-native open/save dialog to fix this. As a workaround, you can
type /Volumes in the File name box and press Enter. Then you can navigate to external drives and network
mounts.

Importare file di testo delimitato

Delimited text file (e.g. .csv, .txt) can be loaded in QGIS using the tools described above. However, loaded
this way, it’ll show up like a simple table data. Sometimes, delimited text files can contain geometric data you’d

want to visualize; this is what the Add Delimited Text Layer is designed for.

Click the toolbar icon Add Delimited Text Layer in the Manage layers toolbar to open the Create a Layer from a
Delimited Text File dialog, as shown in figure_delimited_text.

First, select the file to import (e.g., qgis_sample_data/csv/elevp.csv) by clicking on the [Browse]
button. Once the file is selected, QGIS attempts to parse the file with the most recently used delimiter. To enable
QGIS to properly parse the file, it is important to select the correct delimiter. You can specify a delimiter by
activating:

• CSV (comma separated values);

• Delimitatori personalizzati, scegliendo tra alcuni delimitatori predeniti come comma, spazio, TAB‘,
punto e virgola...;

• o Delimitatore espressione regolare e inserendo un testo nel campo Espressione. Per esempio se vuoi
usare TAB come delimitatore usa \t (questa è l’espressione regolare usata per TAB).

Once the file is parsed, set Geometry definition to Point coordinates and choose the X and Y fields from the

dropdown lists. If the coordinates are defined as degrees/minutes/seconds, activate the DMS coordinates
checkbox.
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Figure 11.6: Finestra di dialogo Testo Delimitato

Finally, enter a layer name (e.g., elevp), as shown in figure_delimited_text. To add the layer to the map, click
[OK]. The delimited text file now behaves as any other map layer in QGIS.

There is also a helper option that allows you to trim leading and trailing spaces from fields — Trim fields.

Also, it is possible to Discard empty fields. If necessary, you can force a comma to be the decimal separator

by activating Decimal separator is comma.

If spatial information is represented by WKT, activate the Well Known Text option and select the field with the
WKT definition for point, line or polygon objects. If the file contains non-spatial data, activate No geometry
(attribute only table) and it will be loaded as an ordinal table.

Puoi anche attivare:

• Use spatial index to improve the performance of displaying and spatially selecting features;

• Use subset index;

• Watch file to watch for changes to the file by other applications while QGIS is running.

Importare file DXF o DWG

DXF and DWG files can be added to QGIS by simple drag-and-drop from the common Browser Panel. You’ll be
prompted to select the sublayers you’d like to add to the project. Layers are added with random style properties.

Nota: Per i file DXF contenenti diversi tipi di geometria (punto, linea e/o poligono) il nome del layer verrà
ricavato da <filename.dxf> entities <geometry type>.

To keep the dxf/dwg structure and its symbology in QGIS, you may want to use the dedicated Project →
DWG/DXF Import... tool. Indeed, the DWG/DXF Import dialog allows you to import into GeoPackage database
any element of the drawing file.

In the dialog, you have to:

• Input a location for a GeoPackage file, that will be created to store the DWG/DXF content to;

• Specify which coordinate system the data in the DWG data is in;
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• Then use the [Import] button to select the DWG/DXF file to use (one per geopackage). The GeoPackage
database will be automatically populated with the drawing file content. Depending on the size of the *CAD
file, this could take some time;

• The Expand block references will transform the existing blocks into normal elements;

• the Use curves promotes the output layers geometry type to a curved one.

After the .dwg or .dxf data is imported into the GeoPackage database the frame in the lower half of the dialog
is populated with the list of layers from the imported file. There you can select which layers to add to the QGIS
project:

• At the top, set a Group name to group the drawing files in the project;

• Check layers to show: Each selected layer is added to an ad hoc group which contains vector layers for the
point, line, label and area features of the drawing layer. The style of each layer is setup so that it resembles
the look it originally had in *CAD;

• Check whether layer should be visible at opening;

• Alternatively using the Merge layers option places all layers in a single group;

• Press [OK] to open the layers in QGIS.

Importare vettori OpenStreetMap

Negli ultimi anni il progetto OpenStreetMap ha guadagnato popolarità perché in molti Paesi non sono disponibili
dati geodati gratuiti quali mappe stradali digitali. L’obiettivo del progetto OSM è quello di creare una mappa
liberamente modificabile del mondo da dati GPS, fotografia aerea o conoscenze locali. Per supportare questo
obiettivo, QGIS fornisce il supporto per i dati OSM.

Utilizzando il Browser Panel, puoi caricare un file .osm sulla mappa, nel qual caso ti verrà visualizzata una
finestra di dialogo per selezionare i sublayers in base al tipo di geometria. I layers caricati conterrano tutti i dati di
quella tipologia di geometria presenti nel file e manterranno la struttura dati del file osm.

To avoid working with a such complex data structure, and be able to select only features you need based on their
tags, QGIS provides a core and fully integrated OpenStreetMap import tool:

• To connect to the OSM server and download data, open the menu Vector → OpenStreetMap → Download
data.... You can skip this step if you already obtained an .osm XML file using JOSM, Overpass API or any
other source;

• The menu Vector → OpenStreetMap → Import Topology from XML... will convert your .osm file into a
SpatiaLite database and create a corresponding database connection;

• The menu Vector → OpenStreetMap → Export Topology to SpatiaLite... then allows you to open the
database connection, select the type of data you want (points, lines, or polygons) and choose tags to im-

port. This creates a SpatiaLite geometry layer that you can add to your project by clicking on the
Add SpatiaLite Layer toolbar button or by selecting the Add SpatiaLite Layer... option from the Layer menu
(see section SpatiaLite Layers).

GPS

Il caricamento dei dati GPS in QGIS può essere effettuato utilizzando il plugin di base: Strumenti GPS. Le
istruzioni sono descritte nel paragrafo Plugin GPS.

GRASS

Lavorare con i dati vettoriali GRASS è descritto nel capitolo Integrazione con GRASS GIS.
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SpatiaLite Layers

La prima volta che carichi i dati da un database di SpatiaLite, inizia da:

• facendo clic sul pulsante Aggiungi vettore SpatiaLite della barra degli strumenti;

• selezionando l’opzione Aggiungi vettore SpatiaLite... dal menu Layer → Aggiungi Layer;

• o digitando Ctrl+Shift+L.

This will bring up a window that will allow you either to connect to a SpatiaLite database already known to QGIS,
which you can choose from the drop-down menu, or to define a new connection to a new database. To define a
new connection, click on [New] and use the file browser to point to your SpatiaLite database, which is a file with
a .sqlite extension.

QGIS supporta anche viste modificabili in SpatiaLite.

Strumenti riferiti ai Database

Creazione della connessione

In order to read and write tables from the many database formats QGIS supports you’ll need to create a connection
to that database. While QGIS Browser Panel is the simplest and recommanded way to connect and use databases
within, QGIS provides specific tools you can use to connect to each of them and load their tables:

• Add PostGIS Layer... or by typing Ctrl+Shift+D

• Add MSSQL Spatial Layer or by typing Ctrl+Shift+M

• Add Oracle Spatial Layer... or typing Ctrl+Shift+O

• Add DB2 Spatial Layer... or typing Ctrl+Shift+2

Questi strumenti sono accessibili dalla Barra degli strumenti Gestisci la barra dei layer o dal menu Layer →
Aggiungi Layer → menu. La connessione al database SpatiaLite è descritta in SpatiaLite Layers.

Suggerimento: Creare una connessione al database dal pannello Browser QGIS
Seleziona il formato di database corrispondente nell’albero Browser, fai clic con il pulsante destro del mouse e
scegliendo connetti ti fornirà la finestra di dialogo per la connessione al database.

Most of the connection dialogs follow a common basis that will be described below using the PostGreSQL
database tool as example.

The first time you use a PostGIS data source, you must create a connection to a database that contains the data.
Begin by clicking the appropriate button as exposed above, opening an Add PostGIS Table(s) dialog (see fig-
ure_add_postgis_tables). To access the connection manager, click on the [New] button to display the Create a
New PostGIS Connection dialog.

I parametri richiesti per la connessione di PostGIS sono elencati di seguito. Per gli altri tipi di database, vedere le
loro differenze ai requisiti di connessione in Requisiti specifici per le connessioni.

• Nome: Nome della connessione. Può essere uguale a quello del Database.

• Servizio: Parametri del servizio da usare alternativamente a host/porta (e potenzialmente database). Lo
puoi definire in pg_service.conf. Vedi la sezione File per la connessione a Servizio PostgreSQL per
maggiori dettagli.

• Host: Nome del server che ospita il database. Deve essere un host con indirizzo raggiungibile, lo stesso
che potrebbe essere usato per aprire una connessione telnet o per fare il ping all’host. Se il database è sullo
stesso computer sul quale è installato QGIS, inserisci semplicemente localhost.
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Figure 11.7: Crea una nuova finestra di dialogo PostGIS

• Porta: Numero della porta del server database PostgreSQL. La porta di default per PostGIS è 5432.

• Database: Nome del database.

• Modalità SSL: Come la connessione SSL verrà negoziata con il server. Puoi velocizzare la visualizzazione
dei vettori PostGIS disabilitando la connessione SSL. Sono disponibili le seguenti opzioni:

– Disabilitato: Prova solo una connessione SSL non criptata.

– Permesso: Tenta una connessione non-SSL, se questa fallisce ne tenta una SSL;

– Preferito (predefinito): Tenta una connessione SSL, se questa fallisce ne prova una non-SSL;

– Richiesto: Tenta solo una connessione SSL.

• Nome utente: Nome dell’utente usato per accedere al database.

• Password: Password usata dal Nome utente per collegarsi al database.

You can save any or both of the username and password parameters, in which case they will be used by
default each time you need to connect to this database. If not saved, you’ll be prompted to fill the missing
credentials to connect to the database in next QGIS sessions; meanwhile the connection parameters you
entered are stored in a temporary internal cache and returned whenever a username/password for the same
database is requested, until you close the current QGIS process.

Avvertimento: QGIS impostazioni utente e sicurezza
Nella scheda Authentication il salvataggio del filenome utente e della password manterrà le credenziali
non protette nella configurazione di connessione. Queste credenziali saranno visibili se, ad esempio,
hai condiviso il progetto con qualcuno. Pertanto, è consigliabile salvare le credenziali in una Configu-
razione di autenticazione (scheda Configurations, - vedi Authentication System per maggiori dettagli) o
in una connessione di servizio (vedi File per la connessione a Servizio PostgreSQL per un esempio).

In alternativa, a seconda del tipo di database, è possibile attivare le seguenti caselle di controllo:
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• Cerca solo nei registri del layer

• Non risolvere tipo di geometria senza restrizioni (GEOMETRY)

• Cerca solo nello schema ‘public’

• Mostra anche le tabelle senza geometria

• Usa i metadati stimati della tabella

Suggerimento: Utilizza metadati di tabella stimati per velocizzare le operazioni
Durante l’inizializzazione dei layer, potrebbero essere necessarie varie query per stabilire le caratteristiche delle
geometrie memorizzate nella tabella del database. Quando l’opzione Usa i metadati stimati della tabella è se-
lezionata, queste query esaminano solo un esempio delle righe e utilizzano le statistiche della tabella anziché
l’intera tabella. Ciò può accelerare in modo drastico le operazioni su grandi set di dati, ma può causare una carat-
terizzazione non corretta dei layers (ad esempio, il conteggio delle funzioni dei layer risolti non verrà determinato
in modo preciso) e può anche causare un comportamento strano nel caso in cui le colonne che si supponga siano
uniche in realtà non lo sono.

Once all parameters and options are set, you can test the connection by clicking on the [Test connection] button
or apply it hitting [OK]. From the Add PostGIS Table(s), click now on [Connect] and the dialog is filled with
tables from the selected database (as shown in figure_add_postgis_tables).

Requisiti specifici per le connessioni

In funzione delle particolarità del tipo di database, le opzioni fornite sono tutte uguali per tutti i database. Di
seguito sono esposte queste specificità di connessione.

File per la connessione a Servizio PostgreSQL Il file di connessione del servizio consente di associare
parametri di connessione PostgreSQL a un singolo nome di servizio. Quel nome di servizio può essere speci-
ficato da un client e verranno utilizzate le impostazioni associate.

Si chiama .pg_service.conf nei sistemi *nix systems (GNU/Linux, macOS etc.) e pg_service.conf
in Windows.

Il file di servizio è del tipo:

[water_service]
host=192.168.0.45
port=5433
dbname=gisdb
user=paul
password=paulspass

[wastewater_service]
host=dbserver.com
dbname=water
user=waterpass

Nota: Nell’esempio precedente ci sono due servizi: water_service e wastewater_service. Puoi
utilizzarli per connetterti da QGIS, pgAdmin etc. specificando solo il nome del servizio a cui desideri connet-
terti (senza le parentesi di chiusura). Se vuoi utilizzare il servizio con psql devi fare qualcosa come export
PGSERVICE=water_service prima di eseguire i comandi psql.

Nota: Puoi trovare tutti i parametri qui

Nota: Se non desideri salvare le password nel file di servizio puoi utilizzare l’opzione .pg_pass .
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Nei sistemi operativi *nix (GNU/Linux, macOS etc.) puoi salvare il file .pg_service.conf nella directory
home dell’utente e i clients PostgreSQL ne saranno automaticamente a conoscenza. Ad esempio, se l’utente
registrato è web, .pg_service.conf dovrebbe essere salvato nella directory /home/web/ per funzionare
direttamente (senza specificare nessun altro ambiente variabili).

Puoi specificare la posizione del file di servizio creando una variabile di ambiente PGSERVICEFILE (e.g. es-
eguire il comando export PGSERVICEFILE=/home/web/.pg_service.conf nel proprio OS *nix OS
per impostare temporaneamente la variabile PGSERVICEFILE)

Puoi anche rendere disponibile il file di servizio a livello di sistema (tutti gli utenti) o posizio-
nando il .pg_service.conf in pg_config --sysconfdir o aggiungendo la variabile di ambiente
PGSYSCONFDIR per specificare la directory contenente il file di servizio. Se esistono definizioni di servizio
con lo stesso nome nel file utente e nel file di sistema, il file utente ha la precedenza.

Avvertimento: Ci sono alcune particolarità per Windows:
• Il service le deve essere salvato come pg_service.conf e non come .pg_service.conf.
• Il service le deve essere salvato nel formato Unix. Un modo per fare ciò è di aprire il file con Notepad++

ed eseguire Edit → EOL Conversion → UNIX Format → File save.
• Puoi aggiungere le variabili di ambiente in vario modo, un modo testato è Control Panel → Sys-

tem and Security → System → Advanced system settings → Environment Variables aggiungendo
PGSERVICEFILE e un percorso del tipo C:\Users\John\pg_service.conf

• Dopo l’aggiunta di una variabile di ambiente è necessario riavviare il computer.

Connessione a Oracle Spatial Le caratteristiche spaziali di Oracle Spatial aiutano gli utenti a gestire i dati
geografici e di localizzazione in un tipo nativo all’interno di un database Oracle. Oltre ad alcune delle opzioni in
Creazione della connessione, la finestra di dialogo di connessione propone:

• Database: SID o SERVICE_NAME dell’istanza Oracle;

• Porta: Numero di porta su cui il database Oracle rimane in ascolto. La porta predefinita è 1521;

• Workspace: La Workspace alla quale collegarsi.

Opzionalmente puoi attivare le seguenti scelte:

• Only look in metadata table: restricts the displayed tables to those that are in the
all_sdo_geom_metadata view. This can speed up the initial display of spatial tables;

• Only look for user’s tables: when searching for spatial tables, restrict the search to tables that are owned
by the user;

• Also list tables with no geometry: indicates that tables without geometry should also be listed by default;

• Use estimated table statistics for the layer metadata: when the layer is set up, various metadata are
required for the Oracle table. This includes information such as the table row count, geometry type and
spatial extents of the data in the geometry column. If the table contains a large number of rows, determining
this metadata can be time-consuming. By activating this option, the following fast table metadata operations
are done: Row count is determined from all_tables.num_rows. Table extents are always determined
with the SDO_TUNE.EXTENTS_OF function, even if a layer filter is applied. Table geometry is determined
from the first 100 non-null geometry rows in the table;

• Only existing geometry types: only list the existing geometry types and don’t offer to add others;

• Includere attributi aggiuntivi alla geometrie.

Suggerimento: Vettori Oracle Spatial
Normalmente un vettore Oracle Spatial è definito con una voce nella tabella USER_SDO_METADATA.
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Connessione a DB2 Spatial Oltre a alcune delle opzioni descritte in Creazione della connessione, è possibile
specificare la connessione a un database DB2 (vedi Layers DB2 Spatial per maggiori informazioni) utilizzando o
un nome di Servizio/DSN definito in ODBC o i parametri driver, host e porta.

Una connessione ODBC Service/DSN richiede il nome del servizio definito per ODBC.

Una connessione driver/host/porta richiede:

• Driver: Nome del driver DB2. In genere questo dovrebbe essere IBM DB2 ODBC DRIVER.

• Host DB2: Nome del database nell’host. Questo deve essere un nome host risolvibile come quello utilizzato
per aprire una connessione TCP/ IP o per il ping all’host. Se il database è sullo stesso computer di QGIS,
digitare localhost.

• Porta DB2: Numero di porta in cui il server di database DB2 ascolta. La porta DBW LUW predefinita è
50000. La porta DB2 z/OS predefinita è 446.

Suggerimento: DB2 Spatial Layers
Un DB2 Spatial layer è definito da una riga nella vista DB2GSE.ST_GEOMETRY_COLUMNS.

Nota: Per poter lavorare in modo efficace con le tabelle spaziali DB2 in QGIS, è importante che le tabelle pre-
sentino una colonna INTEGER o BIGINT definita come PRIMARY KEY e se nuove funzioni saranno aggiunte,
questa colonna dovrebbe avere anche la caratteristica GENERATED.

È inoltre utile che la colonna spaziale venga registrata con un identificativo spaziale specifico (spesso 4326 per
le coordinate WGS84). Una colonna spaziale può essere registrata chiamando la procedura di memorizzazione
ST_Register_Spatial_Column.

Connessione a MSSQL Spatial Oltre ad alcune delle opzioni in Creazione della connessione, la creazione di
una nuova finestra di connessione MSSQL ti propone di inserire un nome a Provider/DSN. Puoi anche visualiz-
zare i database disponibili.

Caricare layer da Database

Una volta che disponi di una o più connessioni definite in un database (vedi la sezione Creazione della connes-
sione), puoi caricare dei layer da esso. Naturalmente, questo richiede la disponibilità di dati. Vedi ad esempio la
sezione Importare dati in PostgreSQL per una discussione sull’importazione di dati in un database PostGIS.

Per caricare un layer da un database, puoi eseguire le seguenti operazioni:

1. Open the “Add <database> table(s)” dialog (see Creazione della connessione),

2. Choose the connection from the drop-down list and click [Connect].

3. Selezionare o deselezionare Mostra anche le tabelle senza geometria.

4. Optionally, use some Search Options to reduce the list of tables to those matching your search. You can
also set this option before you hit the [Connect] button, speeding this way the database fetching.

5. Individuare il(i) layer(s) che vuoi aggiungere nell’elenco dei layers disponibili.

6. Selezionalo facendo clic su di esso. Puoi selezionare più layers tenendo premuto il tasto Shift mentre fai
clic.

7. If applicable, use the [Set Filter] button (or double-click the layer) to start the Query builder dialog (See
section Costruttore di interrogazioni) and define which features to load from the selected layer. The filter
expression appears in the sql column. This restriction can be removed or edited in the Layer Properties →
General → Provider Feature Filter frame.

8. The checkbox in the Select at id column that is activated by default gets the features ids without the
attributes and speed in most cases the data loading.
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9. Click on the [Add] button to add the layer to the map.

Figure 11.8: Finestra di dialogo Aggiungi tabella(e) PostGIS

Suggerimento: Load database table(s) from the Browser Panel
Like simple files, connected database are also listed in the Browser Panel. Hence, you can load tables from
databases using the Browser:

1. Find the layer to use with the Filter Browser tool at the top the browser panel (see Il Pannello Browser for
the search options);

2. select and drag-and-drop it in the map canvas.

11.1.4 Formati QGIS personalizzati

QGIS dispone di due formati personalizzati che puoi caricare nell’applicazione utilizzando l’appropriato stru-
mento di caricamento:

• Layer temporaneo: un layer in memoria associato al progetto con il quale viene aperto (vedi Creazione di
un nuovo Layer temporaneo per ulteriori informazioni)

• Layers virtuali: un layer risultante da una query su altro(i) layer(s) (per ulteriori informazioni, vedi Layers
virtuali)

11.1.5 Connessione a web services

Con QGIS puoi accedere a diversi tipi di servizi web OGC (WM(T)S, WFS(-T), CSW ...). Grazie a QGIS Server,
puoi anche pubblicare questi servizi. La descrizione di queste funzionalità e le istruzioni per l’uso sono fornite nel
capitolo Lavorare con i dati OGC.
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11.2 Creare Layer

Layers can be created in many ways, including:

• empty layers from scratch;

• layers from existing layers;

• layers from the clipboard;

• layers as a result of an SQL-like query based on one or many layers: the virtual layer.

QGIS also provides tools to import/export different formats.

11.2.1 Creating new vector layers

QGIS allows you to create new Shapefile layers, new SpatiaLite layers, new GPX layers and new Temporary
Scratch layers. Creation of a new GRASS layer is supported within the GRASS plugin. (Please refer to section
Creare un nuovo layer vettoriale GRASS for more information on creating GRASS vector layers.)

Creare un nuovo layer Shapele

To create a new Shapefile layer, choose Create Layer → New Shapefile Layer... from the Layer menu. The
New Shapefile Layer dialog will be displayed as shown in figure_create_shapefile. Choose the type of layer (point,
line or polygon) and the CRS (coordinate reference system).

Note that QGIS does not yet support creation of 2.5D features (i.e., features with X,Y,Z coordinates).

Figure 11.9: Finestra di dialogo creazione nuovo Layer Shapefile

To complete the creation of the new Shapefile layer, add the desired attributes by specifying a name and type
for each attribute and clicking on the [Add to fields list] button. A first ‘id’ column is added by default but
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can be removed, if not wanted. Only Decimal number , Whole number , Text data and Date

attributes are supported. Additionally, depending on the attribute type, you can also define the length and
precision of the new attribute column. Once you are happy with the attributes, click [OK] and provide a name for
the Shapefile. QGIS will automatically add the .shp extension to the name you specify. Once the Shapefile has
been created, it will be added to the map as a new layer, and you can edit it in the same way as described in section
Modifica di un layer esistente.

Creare un nuovo layer SpatiaLite

To create a new SpatiaLite layer for editing, choose New → New SpatiaLite Layer... from the Layer menu.
The New SpatiaLite Layer dialog will be displayed as shown in Figure_create_spatialite.

Figure 11.10: Finestra di dialogo creazione Nuovo layer SpatiaLite

The first step is to select an existing SpatiaLite database or to create a new SpatiaLite database. This can be done

with the browse button to the right of the database field. Then, add a name for the new layer, define the

layer type, and specify the coordinate reference system with [Specify CRS]. If desired, you can select Create
an autoincrementing primary key.

To define an attribute table for the new SpatiaLite layer, add the names of the attribute columns you want to create
with the corresponding column type, and click on the [Add to attribute list] button. Once you are happy with the
attributes, click [OK]. QGIS will automatically add the new layer to the legend, and you can edit it in the same
way as described in section Modifica di un layer esistente.

Ulteriore gestione dei layers di SpatiaLite può essere eseguita con il DB Manager. Vedi Plugin DB Manager.
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Creating a new GeoPackage layer

To create a new GeoPackage layer go to Layer → New → New GeoPackage Layer.... The New GeoPackage
Layer dialog will be displayed as shown in figure_create_geopackage.

The first step is to select an existing GeoPackage or create a new one. This can be done by pressing the ellipses
[...] button at the right of the Database field. Then, give a name for the new layer, define the layer type and specify
the coordinate reference system with [Specify CRS].

To define an attribute table for the new GeoPackage layer, add the names of the attribute columns you want to
create with the corresponding column type, and click on the [Add to fields list] button. Once you are happy with
the attributes, click [OK]. QGIS will automatically add the new layer to the legend, and you can edit it in the same
way as described in section Modifica di un layer esistente.

Creare un nuovo layer GPX

Per creare un nuovo file GPX, devi prima aver caricato il plugin GPS. Plugins → Plugin Manager... apre la

finestra di dialogo Plugin Manager. Attiva la casella GPS Tools.

When this plugin is loaded, choose New → Create new GPX Layer... from the Layer menu. In the Save new
GPX file as dialog, choose where to save the new file and press [Save]. Three new layers are added to the Layers
Panel: waypoints, routes and tracks with predefined structure.

Creare un nuovo vettore temporaneo

Temporary Scratch Layers are in-memory layers, meaning that they are not saved on disk and will be discarded
when QGIS is closed. They can be handy to store features you temporarily need or as intermediate layers during
geoprocessing operations.

Empty, editable temporary scratch layers can be defined using Layer → Create Layer → New Temporary Scratch
Layer. Here you can create Multipoint, Multiline and Multipolygon Layers beneath Point, Line and

Polygon layers.

You can also create Temporary Scratch Layers from the clipboard. See Creating new layers from the clipboard.

11.2.2 Creating new layers from an existing layer

Both raster and vector layers can be saved in a different format and/or reprojected to a different coordinate refer-
ence system (CRS) using the Save As... function in the layer context menu (by right-clicking in the layer in the
layer tree) or in the Layer → Save As... menu.

Parametri comuni

The Save As dialog shows several parameters to change the behavior when saving the layer. Common parameters
for raster and vector are:

• Format

• Nome del File

• CRS can be changed to reproject the data

• Add saved file to map to add the new layer to the canvas

• Estensione (i valori possibili sono Estensione del Layer, Estensione della mappa o Estensione definita
dall’utente)

Tuttavia, alcuni parametri sono specifici per i formati raster e vettoriali
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Figure 11.11: Creating a New GeoPackage layer dialog
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Parametri specifici per i Raster

• Modalità uscita (può essere Dati grezzi o Immagine visualizzata)

• Risoluzione

• Create Options: advanced options (file compression, block sizes, colorimetry...) to fine tune the output file.
See the gdal-ogr driver documentation.

• Pyramidi creazione

• VRT Tiles

• Valori nulli

Figure 11.12: Salvare come un nuovo layer raster

Parametri specifici per i Vettori

A seconda del formato di esportazione, alcune di queste opzioni sono disponibili o meno:

• Codifica

• Salva solo le geometrie selezionate

• Seleziona i campi da esportare e le loro opzioni di esportazione. Nel caso in cui imposti i comportamenti dei
campi con alcuni Edit widgets ad esempio “valore”, puoi mantenere i valori visualizzati nel layer scegliendo

Sostituisci tutti i valori grezzi selezionati dai valori mostrati.

• Esporta simbologia: opzione che puoi utilizzare principalmente per l’esportazione del formato DXF e per
tutti i formati di file che gestiscono le tipologie di file OGR (vedi nota di seguito) come i formati DXF,
KML, i formati tabelle:

– Nessuna simbologia: stile di default dell’applicazione che legge i dati
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– Simbologia geometrie: salva lo stile utilizzando gli stili OGR (vedi la nota di seguito)

– Simbologia simboli vettore: salva con gli stili OGR (vedi nota di seguito) ma esporta la stessa ge-
ometria più volte se sono utilizzati più simboli

– Un valore di Scala può essere applicato alle scelte più recenti.

Nota: OGR Feature Styles are a way to store style directly in the data as a hidden attribute. Only some formats
can handle this kind of information. KML, DXF and TAB file formats are such formats. For advanced users, you
can read the OGR Feature Styles specification document.

• Geometria: puoi definire le caratteristiche geometriche del layer in output

– geometry type: keep the original geometry of the features when set to Automatic, otherwise removes
or overrides it with any type. You can add an empty geometry column to an attribute table, remove the
geometry column of a spatial layer.

– Force multi-type: force creation of multi-geometry features in the layer

– Include z-dimension alle geometrie.

Suggerimento: Overriding layer geometry type makes it possible to do things like save a geometryless table
(e.g. .csv file) into a shapefile WITH any type of geometry (point, line, polygon), so that geometries can then be

manually added to rows with the Add Part tool .

• Datasources Options, Layer Options or Custom Options which allow you to configure some advanced pa-
rameters. See the gdal-ogr driver documentation.

Figure 11.13: Salvare come un nuovo layer vettoriale
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Quando si salva un layer vettoriale in un file esistente, a seconda delle capacità del formato di output (Geopackage,
SpatiaLite, FileGDB ...), l’utente può decidere se:

• sovrascrivere l’intero file

• sovrascrivere solo il layer di destinazione (il nome del layer è configurabile)

• aggiungere geometrie ad un layer esistente

• aggiungere geometrie, aggiungere nuovi campi se ce ne sono.

Sono disponibili opzioni per aggiungere geometrie ai formati come ESRI Shapefile, MapInfo .tab,.

11.2.3 Creating new DXF files

Besides the Save As... dialog which provides options to export a single layer to another format, including *.DXF,
QGIS provides another tool to export multiple layers as a single DXF layers. It’s accessible in the Project → DXF
Export... menu.

The DXF Export dialog allows the user to:

• indicate the destination layer file;

• choose the symbology mode and scale (see the OGR Feature Styles note);

• select the encoding and CRS;

• check the loaded layers to include in the DXF files or pick them from an existing visibility preset.

For each layer, you can choose a field whose values are used to split features in generated destination layers

in the DXF output. You can also choose to Use the layer title as name if set and keep features grouped.

• choose to only Export features intersecting the current map extent.

11.2.4 Creating new layers from the clipboard

Le geometrie che si trovano negli appunti possono essere incollate in un nuovo layer. Seleziona alcune geometrie
e poi copiale in un nuovo layer usando Modifica → Incolla geometrie come → e scegliendo:

• New Vector Layer...: you need to select the layer CRS, poping up the Save vector layer as... dialog from
which you can select any supported data format (see Creating new layers from an existing layer for param-
eters);

• or Temporary Scratch Layer...: you need to select the layer CRS and give a name.

Viene creato un nuovo layer, completo delle geometrie selezionate e relativi attributi e aggiunto alla visualiz-
zazione mappa se richiesto.

Nota: Creating layers from clipboard applies to features selected and copied within QGIS and also to features
from another source defined using well-known text (WKT).

11.2.5 Creating virtual layers

Virtual layers are a special kind of vector layer. They allow you to define a layer as the result of an SQL query in-
volving any number of other vector layers that QGIS is able to open. Virtual layers do not carry data by themselves
and can be seen as views to other layers.

To create a virtual layer, open the virtual layer creation dialog by clicking on Add Virtual Layer in the Layer menu
or from the corresponding toolbar.

The dialog allows you to specify a Layer name and an SQL Query. The query can use the name (or id) of loaded
vector layers as tables, as well as their field names as columns.
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Ad esempio, se hai un layer chiamato airports, puoi creare un nuovo layer virtuale da denominare
public_airports con una query SQL del tipo:

SELECT *
FROM airports
WHERE USE = "Civilian/Public"

The SQL query will be executed, regardless of the underlying provider of the airports layer, even if this
provider does not directly support SQL queries.

Figure 11.14: Finestra di dialogo creare layer virtuali

Joins and complex queries can also be created, for example, to join airports and country information:

SELECT airports.*, country.population
FROM airports
JOIN country
ON airports.country = country.name

Nota: Layers virtuali possono essere creati anche usando la finestra di dialogo SQL di Plugin DB Manager.

Embedding layers for use in queries

Oltre ai layers vettoriali disponibili nell’area di visualizzazione della mappa, l’ utente può aggiungere layers alla
lista Layers inckusi, layers che può utilizzare nelle query senza doverli mostrare nell’area di visualizzazione della
mappa o nel Layers Panel.

Per incorporare un layer, fariclick su Aggiungi e inserisci Nome locale, Sorgente dati, Codifica e il percorso della
Sorgente dati.

Il pulsante Importa consente di aggiungere i layer caricati nell’area di disegno della mappa all’elenco dei layer
incorporati. Questo consente di rimuovere successivamente questi layers dal Layers Panel senza interrompere
alcuna query esistente.
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Supported query language

Il motore sottostante utilizza SQLite e SpatiaLite per funzionare.

Ciò significa che è possibile utilizzare tutti l’SQL che l’installazione locale di SQLite comprende.

Funzioni di SQLite e funzioni spaziali di SpatiaLite possono anche essere utilizzate in una query di layer virtuale.
Ad esempio, la creazione di un layer di punti da un layer di solo attributo può essere fatto con una query simile a:

SELECT id, MakePoint(x, y, 4326) as geometry
FROM coordinates

Functions of QGIS expressions possono essere utilizzate anche in una query di layer virtuale..

Per fare riferimento alla colonna geometrica di un layer, utilizzare il nome geometria.

Contrariamente a una query SQL pura, devono essere denominati tutti i campi di una query di layer virtuale. Non
dimenticare di utilizzare la parola chiave as per indicare le colonne se sono il risultato di un calcolo o di una
funzione.

Problemi relativi alle prestazioni

Con parametri predefiniti, il motore del layer virtuale proverà a rilevare il tipo delle diverse colonne della query,
incluso il tipo di colonna geometria se presente.

Questo viene fatto analizzando l’interrogazione se possibile o recuperando la prima riga dell’interrogazione
(LIMIT 1) in ultima istanza. Il recupero della prima riga del risultato per creare lo strato può essere indesiderabile
per motivi di prestazioni

La finestra di dialogo per creare un layer virtuale ti permette di specificare diversi parametri.

• Colonna identificativa univoca: questa opzione ti permette di specificare quale campo dell’interrogazione
rappresenta i valori interi univoci che QGIS può utilizzare come identificatore di riga. Per default, viene
utilizzato un valore intero autoincrementale. Specificando una colonna identificatore univoco potrai velo-
cizzare la selezione delle righe.

• Nessuna geometria: questa opzione forza il layer virtuale a ignorare qualsiasi campo geometria. Il layer
risultante sarà solamente un layer tabella attributi.

• Colonna geometria: questa opzione ti permette di specificare il nome della colonna da utilizzare come
geometria del layer.

• Tipo: questa opzione ti permette di specificare il tipo di geometria del layer virtuale.

• SR: quest’opzione ti permette di specificare il sistema di riferimento delle coordinate del layer virtuale.

Commenti speciali

L’interprete del layer virtuale tenta di determinare il tipo di ogni colonna della query. Se non riesce, viene eseguita
la prima riga della query per determinare i tipi colonna.

Il tipo di una particolare colonna può essere specificato direttamente nella query utilizzando alcuni commenti
speciali.

La sintassi è la seguente: /*: type*/. Deve essere inserita subito dopo il nome di una colonna. il tipo può
essere int per interi, real per numeri a virgola mobile o text.

Ad esempio:

SELECT id+1 as nid /*:int*/
FROM table

Il tipo e il sistema di riferimento della colonna geometrica può essere impostato anche grazie a speciali commenti
con la seguente sintassi /*:gtype: srid*/ dove gtype è il tipo geometrico (point, linestring,
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polygon, multipoint, multilinestring or multipolygon) e srid un intero che rappresenta il
codice EPSG di un sistema di riferimento di coordinate.

Uso degli indici

Quando si interagisce con un layer virtuale, gli indici di questo layer vengono utilizzati nei seguenti modi:

• se viene usato = nella colonna chiave primaria del layer, al fornitore di dati sottostante verrà richiesto un id
particolare (FilterFid)

• per tutti gli altri predicati (>, <=, !=, etc.) o per richiesta su una colonna senza chiave primaria, verrà
utilizzata una richiesta costruita da un’ espressione per il driver attivo. Ciò significa che gli indici possono
essere utilizzati sui drivers di database, se esistono.

Esiste una sintassi specifica per gestire le predicazioni spaziali nelle richieste e innesca l’utilizzo di un indice
spaziale: una colonna nascosta denominata _search_frame_ esiste per ogni layer virtuale. Questa colonna
può essere paragonata per l’uguaglianza con un riquadro di limitazione. Ad esempio:

SELECT *
FROM vtab
WHERE _search_frame_=BuildMbr(-2.10,49.38,-1.3,49.99,4326)

I predicati binari spaziali come ST_Intersects consentono significative accelerazioni quando utilizzati in
combinazione con questa sintassi dell’indice spaziale.

11.3 Esplorare i formati dati e i campi

11.3.1 Dati Raster

I dati raster sono matrici di celle discrete che rappresentano oggetti della superficie terrestre o dell’ambiente al di
sopra o al di sotto di essa. Ogni cella nella matrice ha la stessa dimensione e le celle sono solitamente rettangolari
(in QGIS sono sempre rettangolari). Esempi tipici di dati raster sono quelli provenienti dal telerilevamento come
le fotografie aeree, le immagini da satellite e i dati modellati come le matrici dell’elevazione.

Unlike vector data, raster data typically do not have an associated database record for each cell. They are geocoded
by pixel resolution and the x/y coordinate of a corner pixel of the raster layer. This allows QGIS to position the
data correctly in the map canvas.

QGIS per posizionare e visualizzare correttamente i dati utilizza le informazioni di georeferenziazione incorporate
direttamente nel file raster (ad es. GeoTiff) o quelle contenute in un apposito world file.

11.3.2 Dati vettoriali

Many of the features available in QGIS work the same, regardless the vector data source. However, because of the
differences in formats specifications (ESRI shapefiles, MapInfo and MicroStation file formats, AutoCAD DXF,
PostGIS, SpatiaLite, DB2, Oracle Spatial and MSSQL Spatial databases, and many more), QGIS may handle
differently some of their properties. This section describes how to work with these specificities.

Nota: QGIS supporta geometrie con formati (multi)point, (multi)line, (multi)polygon, CircularString, Com-
poundCurve, CurvePolygon, MultiCurve, tutti con valori Z e/o M.

Devi tener presente che alcuni driver non supportano alcuni di questi formati come CircularString, Compound-
Curve, CurvePolygon, MultiCurve, MultiSurface. QGIS li convertirà in geometrie multi-poligono.
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ESRI Shapefiles

The ESRI shapefile is still one of the most used vector file format in QGIS. However, this file format has some
limitation that some other file format have not (like Geopackage, spatialite). Support is provided by the OGR
Simple Feature Library.

A shapefile actually consists of several files. The following three are required:

1. .shp file contenente le geometrie

2. .dbf file contenente gli attributi in formato dBase

3. .shx file indici

Shapefiles also can include a file with a .prj suffix, which contains the projection information. While it is very
useful to have a projection file, it is not mandatory. A shapefile dataset can contain additional files. For further
details, see the ESRI technical specification at http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf.

Improving Performance for Shapefiles

To improve the performance of drawing a shapefile, you can create a spatial index. A spatial index will improve
the speed of both zooming and panning. Spatial indexes used by QGIS have a .qix extension.

Segui questi passi per creare un indice spaziale:

• Load a shapefile (see Il Pannello Browser);

• Open the Layer Properties dialog by double-clicking on the shapefile name in the legend or by right-clicking
and choosing Properties from the context menu.

• In the General tab, click the [Create Spatial Index] button.

Problem loading a shape .prj file

If you load a shapefile with a .prj file and QGIS is not able to read the coordinate reference system from that
file, you will need to define the proper projection manually within the General tab of the Layer Properties dialog
of the layer by clicking the [Specify...] button. This is due to the fact that .prj files often do not provide the
complete projection parameters as used in QGIS and listed in the CRS dialog.

For the same reason, if you create a new shapefile with QGIS, two different projection files are created: a .prj
file with limited projection parameters, compatible with ESRI software, and a .qpj file, providing the complete
parameters of the used CRS. Whenever QGIS finds a .qpj file, it will be used instead of the .prj.

Files Testo Limitato

Tabular data is a very common and widely used format because of its simplicity and readability – data can be
viewed and edited even in a plain text editor. A delimited text file is an attribute table with each column separated
by a defined character and each row separated by a line break. The first row usually contains the column names. A
common type of delimited text file is a CSV (Comma Separated Values), with each column separated by a comma.

Such data files can also contain positional information in two main forms:

• As point coordinates in separate columns

• As well-known text (WKT) representation of geometry

QGIS allows you to load a delimited text file as a layer or ordinal table. But first check that the file meets the
following requirements:

1. The file must have a delimited header row of field names. This must be the first line in the text file.

2. The header row must contain field(s) with geometry definition. These field(s) can have any name.

3. The X and Y coordinates (if geometry is defined by coordinates) must be specified as numbers. The coor-
dinate system is not important.

4. Se hai dati che non sono una stringa (testo) e il file è un file CSV, devi avere un file CSVT (vedi sezione
CSVT Files).
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Come esempio di un file di testo valido, importa il file di punti quotati elevp.csv presente nell’insieme di dati
campione di QGIS (vedi sezione Sample Data):

X;Y;ELEV
-300120;7689960;13
-654360;7562040;52
1640;7512840;3
[...]

Alcune cose da tenere in considerazione in merito al file di testo:

1. Il file di testo usato come esempio usa ; (punto e virgola) come delimitatore. Ma qualsiasi carattere può
essere usato per delimitare i campi.

2. La prima riga è la riga di intestazione. Questa contiene i campi X, Y e ELEV.

3. Nessun tipo di virgoletta (") dev’essere usata per delimitare i campi di testo.

4. Le coordinate X sono contenute nel campo X.

5. Le coordinate Y sono contenute nel campo Y.

CSVT Files

Quando carichi i file CSV, il driver OGR presuppone che tutti i campi siano stringhe (cioè tipo testo) a meno che
non sia detto diversamente. Puoi creare un file CSVT per indicare a OGR (e QGIS) quali tipi di dati ci sono nelle
diverse colonne:

Type Name Example
Whole number Integer 4
Decimal number Real 3.456
Date Date (YYYY-MM-DD) 2016-07-28
Time Time (HH:MM:SS+nn) 18:33:12+00
Date & Time DateTime (YYYY-MM-DD HH:MM:SS+nn) 2016-07-28 18:33:12+00

Il file CSVT è un file di testo normale di UNA sola riga con i tipi di dati racchiusi da virgolette e separati da
virgole, ad esempio:

"Integer","Real","String"

Puoi anche specificare la larghezza e la precisione di ogni colonna, ad esempio:

"Integer(6)","Real(5.5)","String(22)"

Questo file viene salvato nella stessa cartella del file .csv, con lo stesso nome, ma con .csvt come estensione.

You can find more information at GDAL CSV Driver.

Others valuable informations for advanced users

Features with curved geometries (CircularString, CurvePolygon and CompoundCurve) are supported. Here are
three examples of such geometry types as a delimited text with WKT geometries:

Label;WKT_geom
CircularString;CIRCULARSTRING(268 415,227 505,227 406)
CurvePolygon;CURVEPOLYGON(CIRCULARSTRING(1 3, 3 5, 4 7, 7 3, 1 3))
CompoundCurve;COMPOUNDCURVE((5 3, 5 13), CIRCULARSTRING(5 13, 7 15,

9 13), (9 13, 9 3), CIRCULARSTRING(9 3, 7 1, 5 3))

Il formato testo delimitato supporta anche geometrie che hanno coordinate Z e M:

LINESTRINGM(10.0 20.0 30.0, 11.0 21.0 31.0)
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Layers PostGIS

I vettori PostGIS sono memorizzati in un database PostgreSQL. PostGIS ha diversi vantaggi: creazione dell’indice
spaziale, capacità di filtraggio e di interrogazione molto potenti. Usando PostGIS, le funzioni vettoriali come la
selezione e l’identificazione sono più precise che con i vettori OGR in QGIS.

Suggerimento: Layer PostGIS
Normalmente, un vettore PostGIS è definito da una voce nella tabella geometry_columns. QGIS può caricare
layers che non dispongono di una voce nella tabella geometry_columns. Ciò include sia tabelle che viste. La
definizione di una vista spaziale fornisce un potente mezzo per visualizzare i tuoi dati. Consulta il tuo manuale
PostgreSQL per informazioni sulla creazione di viste.

Questa sezione contiene alcuni dettagli su come QGIS accede ai vettori PostgreSQL. La maggior parte delle volte
QGIS dovrebbe semplicemente fornirti un elenco di tabelle del database che possono essere caricate e dovrebbe
poi caricarle in base alla tua richiesta. Comunque se hai difficoltà a caricare una tabella di PostgreSQL in QGIS,
le informazioni seguenti ti possono aiutare a capire tutti i messaggi di QGIS e ti possono dare un’indicazione di
come cambiare le tabelle o le definizioni delle viste di PostgreSQL in modo che QGIS le possa caricare.

Chiave primaria

QGIS richiede che i vettori PostgreSQL contengano una colonna che possa essere usata come chiave univoca per il
vettore. Le tabelle devono contenere una chiave primaria o una colonna con un vincolo univoco. Questa colonna
deve essere di tipo int4 (un numero intero di 4 byte). Alternativamente, la colonna ctid può essere usata come
chiave primaria. Se a una tabella mancano queste informazioni, verrà usata la colonna oid. Le prestazioni saranno
migliori se la colonna è indicizzata (le chiavi primarie sono indicizzate automaticamente in PostgreSQL).

QGIS prevede una casella di controllo Seleziona all’ID che viene attivata per impostazione predefinita. Questa
opzione ottiene gli id senza gli attributi il che è più veloce nella maggior parte dei casi.

Viste

Se il layer di PostgreSQL è una vista sussistono gli stessi requisiti, ma non sempre necessitano chiavi primarie o
colonne con vincoli univoci. Devi definire un campo della chiave primaria (deve essere un intero) nella finestra
di dialogo di QGIS prima di caricare la vista. Se non c’è una colonna adatta nella vista, QGIS non caricherà il
vettore. Se succede la soluzione è di modificare la vista in modo che contenga una colonna adatta (un intero e una
chiave primaria con un vincolo univoco, preferibilmente indicizzato).

Come per le tabelle, una casella di controllo Seleziona all’ID è attiva per impostazione predefinita (vedere sopra
per il significato della casella di controllo). Può aver senso disattivare questa opzione quando si utilizzano viste
impegnative.

Stili di default dei layer QGIS e backup del database

If you want to make a backup of your PostGIS database using the pg_dump and pg_restore commands, and
the default layer styles as saved by QGIS fail to restore afterwards, you need to set the XML option to DOCUMENT
and the restore will work.

SET XML OPTION DOCUMENT;

Filtro lato server

QGIS consente di filtrare le geometrie già sul lato server. Per fare ciò attiva Impostazioni → Opzioni → Origine

dati → Esegui le espressioni sul lato server sul lato server se possibile. Saranno accettate solo le espressioni
supportate dal database. Le espressioni che utilizzano operatori o funzioni non supportati saranno restituite alla
esecuzione in locale.

11.3. Esplorare i formati dati e i campi 111



QGIS User Guide, Release 2.18

Supporto di PostgreSQL alle diverse tipologie di dati

Most of common data types are supported by the PostgreSQL provider: integer, float, varchar, geometry and
timestamp.

Array data types are not supported.

Importare dati in PostgreSQL

I dati possono essere importati in PostreSQL/PostGIS usando diversi strumenti, come il plugin DB Manager e gli
strumenti da riga di comando shp2pgsql e ogr2ogr

DB Manager

QGIS comes with a core plugin named DB Manager. It can be used to load shapefiles and other data formats, and
it includes support for schemas. See section Plugin DB Manager for more information.

shp2pgsql

PostGIS includes an utility called shp2pgsql that can be used to import shapefiles into a PostGIS-enabled database.
For example, to import a shapefile named lakes.shp into a PostgreSQL database named gis_data, use the
following command:

shp2pgsql -s 2964 lakes.shp lakes_new | psql gis_data

Questo comando crea un nuovo vettore, chiamato lakes_new , nel database gis_data. Il nuovo vettore
avrà un identificatore del sistema di riferimento (SRID) corrispondente a 2964. Vedi la sezione Lavorare con le
proiezioni per ulteriori informazioni sui sistemi di riferimento spaziali e sulle proiezioni.

Suggerimento: Esportare dati da PostGIS
Like the import tool shp2pgsql, there is also a tool to export PostGIS datasets as shapefiles: pgsql2shp. This is
shipped within your PostGIS distribution.

ogr2ogr

Oltre a shp2pgsql e DB Manager c’è un altro strumento per caricare dati in PostGIS: ogr2ogr. Questo strumento
fa parte dell’installazione di GDAL

To import a shapefile into PostGIS, do the following:

ogr2ogr -f "PostgreSQL" PG:"dbname=postgis host=myhost.de user=postgres
password=topsecret" alaska.shp

This will import the shapefile alaska.shp into the PostGIS database postgis using the user postgres with the
password topsecret on host server myhost.de.

Nota che OGR deve essere compilato con PostgreSQL per supportare PostGIS. Puoi verificare ciò digitando (in
) :

ogrinfo --formats | grep -i post

Se preferisci utilizzare il comando COPY di PostgreSQL invece del metodo predefinito INSERT INTO, puoi

esportare la seguente variabile d’ambiente (disponibile almeno in e ):
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export PG_USE_COPY=YES

ogr2ogr non crea indici spaziali come shp2pgsl. Devi crearli manualmente, usando come passo aggiuntivo il
comando SQL CREATE INDEX dopo l’importazione, come passo aggiuntivo (come descritto nella sezione
seguente Migliorare le prestazioni).

Migliorare le prestazioni

Retrieving features from a PostgreSQL database can be time-consuming, especially over a network. You can im-
prove the drawing performance of PostgreSQL layers by ensuring that a PostGIS spatial index exists on each layer
in the database. PostGIS supports creation of a GiST (Generalized Search Tree) index to speed up spatial searches
of the data (GiST index information is taken from the PostGIS documentation available at http://postgis.net).

Suggerimento: You can use the DBManager to create an index to your layer. You should first select the layer
and click on Table → Edit table, go to Indexes tab and click on [Add spatial index].

La sintassi per creare un indice GIST è:

CREATE INDEX [indexname] ON [tablename]
USING GIST ( [geometryfield] GIST_GEOMETRY_OPS );

Nota che per tabelle molto grandi, la creazione dell’indice può richiedere parecchio tempo. Non appena l’indice
è stato creato, dovresti effettuare un VACUUM ANALYZE. Vedi la documentazione di PostGIS (POSTGIS-
PROJECT Letteratura e riferimenti web) per ulteriori informazioni.

Segue un esempio di come creare un indice GiST:

gsherman@madison:~/current$ psql gis_data
Welcome to psql 8.3.0, the PostgreSQL interactive terminal.

Type: \copyright for distribution terms
\h for help with SQL commands
\? for help with psql commands
\g or terminate with semicolon to execute query
\q to quit

gis_data=# CREATE INDEX sidx_alaska_lakes ON alaska_lakes
gis_data-# USING GIST (the_geom GIST_GEOMETRY_OPS);
CREATE INDEX
gis_data=# VACUUM ANALYZE alaska_lakes;
VACUUM
gis_data=# \q
gsherman@madison:~/current$

Vettori a cavallo dei 180° di longitudine

Many GIS packages don’t wrap vector maps with a geographic reference system (lat/lon) crossing the 180 degrees
longitude line (http://postgis.refractions.net/documentation/manual-2.0/ST_Shift_Longitude.html). As result, if
we open such a map in QGIS, we will see two far, distinct locations, that should appear near each other. In
Figure_vector_crossing, the tiny point on the far left of the map canvas (Chatham Islands) should be within the
grid, to the right of the New Zealand main islands.

Una soluzione consiste nel trasformare i valori di longitudine utilizzando PostGIS e la funzione
ST_Shift_Longitude. Questa funzione legge i punti/vertici di ogni elemento di una geometria e se la coordi-
nata di longitudine è < 0° , aggiunge 360°. Il risultato sarà una versione 0° - 360° dei dati, che verranno poi
visualizzati su una mappa centrata a 180°.
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Figure 11.15: Mappa in lat/lon a cavallo dei 180° di longitudine

Figure 11.16: Vettori a cavallo di 180° di longitudine usando la funzione ST_Shift_Longitude

Guida all’uso

• Importa i dati in PostGIS (Importare dati in PostgreSQL) usando, per esempio, il plugin DB Manager.

• Usa l’interfaccia da linea di comando di PostGIS per dare il seguente comando (nell’esempio
“TABLE” è il nome della tua tabella PostGIS): gis_data=# update TABLE set
the_geom=ST_Shift_Longitude(the_geom);

• Se tutto è andato a buon fine, riceverai la conferma sul numero di geometrie che sono state aggiornate.
Potrai cosi caricare la mappa e vedere le differenze (Figure_vector_crossing_map).

Vettori SpatiaLite

If you want to save a vector layer to SpatiaLite format, you can do this by right clicking the layer in the legend.
Then, click on Save as..., define the name of the output file, and select ‘SpatiaLite’ as format and the CRS. Also,
you can select ‘SQLite’ as format and then add SPATIALITE=YES in the OGR data source creation option field.
This tells OGR to create a SpatiaLite database. See also http://www.gdal.org/ogr/drv_sqlite.html.

QGIS supporta anche viste modificabili in SpatiaLite.

Se vuoi creare un nuovo layer SpatiaLite, fai riferimento alla sezione Creare un nuovo layer SpatiaLite.

Suggerimento: SpatiaLite data management Plugins
Per la gestione dei dati di SpatiaLite puoi utilizzare anche diversi plugin Python: QSpatiaLite, SpatiaLite Manager
o DB Manager (plugin core, consigliato). Se necessario, possono essere scaricati e installati con il programma di
installazione plugin.
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Layers DB2 Spatial

IBM DB2 per Linux, Unix e Windows (DB2 LUW), i prodotti IBM DB2 per z/OS (mainframe) e IBM DashDB
consentono agli utenti di memorizzare e analizzare i dati spaziali nelle colonne della tabella relazionale. La
funzione DB2 per QGIS supporta la gamma completa di visualizzazione, analisi e manipolazione dei dati spaziali
in questi database.

La documentazione utente su queste funzionalità può essere trovata in DB2 z/OS KnowledgeCenter, DB2 LUW
KnowledgeCenter e DB2 DashDB KnowledgeCenter.

Per ulteriori informazioni sul funzionamento delle opzioni spaziali DB2, consulta il Tutorial DB2 Spatial Tutorial
su IBM DeveloperWorks.

La funzionalità DB2 attualmente supporta solo l’ambiente Windows tramite il driver ODBC di Windows.

Il client che esegue QGIS deve disporre di uno dei seguenti componenti installati:

• DB2 LUW

• IBM Data Server Driver Package

• IBM Data Server Client

Se stai accedendo a un database DBW LUW sulla stessa macchina o che utilizza DB2 LUW come client, i file di
esecuzione e i files di supporto DB2 devono essere inclusi nel percorso di Windows. Ciò può essere fatto creando
una file batch come seguire con il nome db2.bat e includendolo nella directory %OSGEO4W_ROOT%/etc/ini.

@echo off
REM Point the following to where DB2 is installed
SET db2path=C:\Program Files (x86)\sqllib
REM This should usually be ok - modify if necessary
SET gskpath=C:\Program Files (x86)\ibm\gsk8
SET Path=%db2path%\BIN;%db2path%\FUNCTION;%gskpath%\lib64;%gskpath%\lib;%path%
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CHAPTER 12

Lavorare con i vettori

12.1 Libreria della simbologia

12.1.1 Gestore di stile

The Style Manager is the place where users can manage and create generic symbols to be used in several QGIS
projects. You can open it with the Settings → Style Manager or from the Style tab in the vector layer’s Properties.
It allows users to:

• create, edit and remove symbols

• organize symbols in custom groups

• export and import symbols.

Figure 12.1: Gestore di stile

Groups and smart groups

You can organize symbols into different categories. These categories, listed in the panel at the left, can be static
(called Group) or dynamic (named Smart Group). A group is smart when its symbols are dynamically fetched
according to conditions set. See figure_smart_group:

To create a group, right click on an existing group or on the main Groups directory in the left of the dialog. You

can also select a group and click the Add Group button. The new group will be a sub-group of the selected one.

Create Smart Group is similar to creating group, but instead select Smart Groups. The dialog box allows user
to choose the expression to select symbols in order to appear in the smart group (contains some tags, member of
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a group, have a string in its name, etc.). Any symbol that satisfies the entered condition(s) is automatically added
to the smart group.

Figure 12.2: Creare un gruppo intelligente

To remove a group or a smart group, right click on the group and select Remove Group or select it and push
Remove Group button.

Unlike the smart groups that automatically fetch their belonged symbols, simple groups are filled by the user. To
add a symbol into a group, you can either right click on a symbol, choose Apply Group and then the group name.

There is a second way to add several symbols into a group: just select the group, click and choose Group
Symbols. All symbols display a checkbox that allows you to add the symbol into the selected groups. When
selection is finished, you can click the same button, and choose Finish Grouping.

All the symbols that are not placed under a custom group belong to a default group named Ungrouped.

Add, Edit, Remove Symbol

Selecting a group returns in the right panel, if applicable, the list of symbols of the group (including its subgroups).
These symbols are organized in four different tabs:

• Marker for point symbols

• Line for linear symbols

• Fill for surface symbols

• and Scala di colori.

To delete a symbol you no longer need, just select it and click Remove item (also available through right-click).
The symbol will be deleted from the local symbols database.

The symbol list can be modified by adding new symbols with Add item button or modifying existing ones with
Edit item. See Selettore Simbolo for further information.

Share symbols

The Share item tool, at the right bottom of the Style Library dialog, offers options to easily share symbols with
others: users can indeed export their symbols and import symbols to their library.

Exporting symbols

You can export the selected symbols to PNG, SVG or XML file formats. Exporting to PNG or SVG (both not
available for color ramp symbols) creates a file for each selected symbol, and the SVG folder can be added to
SVG Paths in Settings → Options to e.g. share these symbols on a network. The XML format generates a single
file containing all the selected symbols. This file can then be imported in another user’s style library.

Importing symbols
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You can extend your symbols library by importing new symbols. Just select Import from the drop-down list
at the right bottom of the dialog. In the new dialog, you’ll need to :

• indicate the source of the symbols (it can be a .xml file on the disk or an url),

• give the name of the group under which the symbols will be put

• select the symbols you want to add to your library

• and press Import.

Note that import and export options are also available through right-click.

Figure 12.3: Importing symbols

Scala di colori

The Color ramp tab in the Style Manager presents different types of color ramps you can use to style layers.

Per creare una scala di colori personalizzata, attiva la scheda Scala di colori e clicca il pulsante Agiungi oggetto.
Il pulsante apre un menù a tendina per scegliere il tipo di scala:

• Gradiente: dati i colori di inizio e fine, genera una scala di colori che può essere di tipo continuo o discreto.
Facendo doppio click sull’anteprima della scala, puoi aggiungere tutti i punti di interruzione intermedi di
colore che vuoi.

• Random: creates a random set of colors based on range of values for hue, saturation, value and opacity and
a number of colors (classes)

• ColorBrewer: a set of predefined discrete color gradients you can custom the number of colors in the ramp

• or cpt-city: an access to a whole catalog of color gradients to locally save as gradient color.

Suggerimento: Easily custom the color stops of the gradient color ramp
Facendo doppio click sull’anteprima della scala o trascinando e rilasciando un colore da quelli disponibili dentro
l’anteprima della scala, si aggiunge una nuova interruzione di colore. Ciascuna interruzione di colore può essere
aggiustati usando il widget Scelta colore o tramite il grafico per ciascun parametro. Puoi anche riposizionarla
usando il mouse , i tasti freccia (in combinazione con il tasto Shift per uno spostamento maggiore) o la casella
di selezione Posizione relativa . Premendo Elimina interruzione oppure il tasto DEL si rimuove l’interruzione di
colore selezionata.
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You can use the Invert option while classifying the data with a color ramp. See figure_color_custom_ramp for
an example of a custom color ramp and figure_color_cpt_city for the cpt-city Colors dialog.

Figure 12.4: Esempio di Scala di colori a gradiente personalizzata con interruzioni multiple

The cpt-city option opens a new dialog with hundreds of themes included ‘out of the box’.

12.1.2 Selettore Simbolo

Il selettore simbolo è la finestra di dialogo principale per disegnare una simbologia. Puoi creare o modificare la
simbologia Simbolo, Linea o Riempimento.

Due componenti principali strutturano la finestra di dialogo Selettore simbolo:

• l’albero del simbolo, che mostra i layer del simbolo che vengono poi combinati per formare un nuovo
simbolo globale

• e le impostazioni per configurare il layer simbolo selezionato all’interno dell’albero.
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Figure 12.5: Finestra di dialogo cpt-city con molte scale di colori
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Figure 12.6: Designing a Marker symbol
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L’albero dei layer simbolo

Un simbolo può essere costituito da vari Layer simbolo. L’albero del simbolo mostra la sovrapposizione di questi
layer simbolo che vengono poi combinati per formare un nuovo simbolo globale. Infatti, appena le proprietà del
simbolo cambiano, una rappresentazione dinamica del simbolo viene aggiornata.

È disponibile una serie di strumenti per gestire gli oggetti dell’albero del simbolo e, in corrispondenza con il livello
selezionato, saranno abilitati differenti strumenti sotto la finestra di dialogo per:

• aggiungere un nuovo layer simbolo: puoi impilare quanti simboli vuoi

• rimuovere il layer simbolo selezionato

• bloccare i colori del layer del simbolo: un colore bloccato rimane invariato quando l’utente cambia il
colore del simbolo a livello globale (o superiore)

• duplicare un (gruppo di) layer simbolo

• spostare in sù o in giù un layer simbolo

Configurare una simbologia

In QGIS la configurazione di una simbologia viene fatta in due fasi: il simbolo e il layer simbolo

Il simbolo

Al livello superiore dell’albero, la simbologia diipende dalla geometria del layer e può essere di tipo Simbolo,
Linea o Riempimento. Ogni simbolo può incorporare uno o più simboli (compresi quelli di qualsiasi altro tipo)
o simboli vettoriali.

Puoi impostare alcuni parametri che si appliccano al simbolo globale:

• Unit: it can be Millimeter, Pixels or Map unit

• Trasparenza

• Colore: quando questo parametro viene cambiato dall’utente, il suo valore viene ereditato dai colori dei
sotto-simboli purché non siano bloccati

• Dimensione e Rotazione per simboli puntuali

• Larghezza per simboli lineari

Nota: The Data-defined override button beside the last layer-related parameters is inactive when setting the
symbol from the Style manager dialog. When the symbol is connected to a map layer, this button offers access to
the size assistant dialog which helps to create proportional or multivariate analysis rendering.

The symbols used at this level are items you can pick from the symbols library. A list of available symbols of the
same type from your symbol library is shown and can be filtered by selecting a group in the drop-down list just
above. Click the Save button to add the designed symbol to your symbol library.

With the Advanced option, you can:

• impostare Livelli simbolo: definire il modo in cui i livelli del simbolo sono connessi tra loro nella mappa
(vedi Symbols levels per maggiori informazioni)

• per simboli Linea e Riempimento, Ritaglia le geometrie all’estensione della mappa.

Suggerimento: Nota che una volta impostata la dimensione nei livelli inferiori della finestra di dialogo del Layer
simbologia , la dimensione dell’intero simbolo può essere cambiata nuovamente con il menù Dimensione (per
simboli punto) o Larghezza (per simboli linea). La dimensione dei livelli inferiori cambia di conseguenza, mentre
il rapporto di proporzione tra le dimensioni rimane invariato.
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Layer della simbologia

Al livello inferiore dell’albero puoi personalizzare i layer della simbologia. I tipi di simbolo del layere dipendono

dal tipo di simbologia del livello superiore. Puoi applicare al layer della simbologia Effetti disegno per
migliorarne la visualizzazione.

Because describing all the options of all the symbol layer types would not be possible, only particular and signi-
ficative ones are mentioned below.

Parametri comuni Sono diponibili alcune opzioni e widget comuni per costruire un layer simbolo, a prescindere
che sia di tipo puntuale, lineare o riempimento

• il widget selettore colore per facilitare la manipolazione del colore

• Units: it can be Millimeter, Pixels or Map unit

• il widget sovrascrittura definita dai dati accanto a quasi tutte le opzioni, per estendere le possibilità di personal-
izzare ciascun simbolo (vedi Impostazione Sovrascrittura definita dai dati per maggiori informazioni)

Nota: La descrizione qui sotto presuppone che il Tipo simbolo del vettore sia legato alla geometria dell’elemento,
ma tieni a mente che puoi impilare i layer della simbologia l’uno sull’altro. In tal caso il parametro del simbolo di
livello inferiore (posizionamento, offset...) può essere legato al simbolo del livello superiore, e non alla geometria
dell’elemento in sé.

Simboli per vettori puntuali Per caratterizzare le geometria puntuali sono disponibili diverse Tipologie di sim-
boli:

• Simbolo semplice (default);

• Simbolo ellisse: un simbolo semplice con larghezza e altezza personalizzabili;

• Filled marker: similar to the simple marker symbol layer, except that it uses a fill sub symbol to render the
marker. This allows use of all the existing QGIS fill (and outline) styles for rendering markers, e.g. gradient
or shapeburst fills;

• Simbolo carattere: utilizza per i simboli puntuali i caratteri installati;

• Generatore geometria (vedi Generatore geometria);

• Simbolo campo vettoriale (vedi Il Simbolo di Campo Vettoriale);

• SVG marker: provides you with images from your SVG paths (set in Settings → Options → System menu)
to render as marker symbol. Each SVG file colors and outline can be adapted.

Nota: Requisiti per un simbolo di marcatore SVG personalizzabile

To have the possibility to change the colors of a SVG marker, you have to add the placeholders
param(fill) for fill color, param(outline) for outline color and param(outline-width) for
stroke width. These placeholders can optionally be followed by a default value, e.g.:

<svg width="100%" height="100%">
<rect fill="param(fill) #ff0000" stroke="param(outline) #00ff00" stroke-width="param(stroke-width) 10" width="100" height="100">
</rect>
</svg>

Per ogni tipologia di simbolo puntuale, puoi impostare alcune delle seguenti proprietà:

• Color for the fill and/or stroke, using all the capabilities of the Scelta colore widget;

• Dimensione
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• Outline style

• Outline width

• Stile unione

• Rotazione

• Offset X,Y: You can shift the symbol in the x- or y- direction;

• Punto di ancoraggio.

Nella maggior parte delle finestre di dialogo dei simboli di marcatura, è anche disponibile una finestra con an-
teprime dei simboli predefiniti fra cui è possibile scegliere.

Simboli lineari Appropriate for line geometry features, line symbols have following symbol layer types:

• Linea semplice (predefinito): le impostazioni disponibili sono:

– Colore

– Pen width

– Pen style

– Stile unione

– Stile testata

– Offset

– Use custom dash pattern: overrides the Pen style setting with a custom dash.

• Freccia: disegna linee con frecce curve (o non) con una singola o una doppia testa con larghezza, lunghezza
e spessore configurabili. Per creare una linea con freccia curva la linea deve avere almeno tre vertici. Usa
anche fill symbol come gradiente o ombreggiatura per enfatizzare il corpo della freccia. In combinazione
con il generatore di geometrie, questo tipo di simbolo per le linee aiuta a rappresentare mappe di flusso;

• Generatore geometria (vedi Generatore geometria);

• Linea di evidenziazione: visualizza un simbolo marcatore lungo la linea. Può essere a una distanza regolare
o basata sulla sua geometria: primo, ultimo o ogni vertice, sul punto centrale o su ogni punto della curva.
Puoi impostare un offset lungo la linea per la simbologia o compensare la linea stessa. L’opzione Ruota
simbolo ti consente di impostare se il simbolo deve seguire l’orientamento della linea o meno.

Simboli di riempimento Appropriati per le geometrie poligonali, i simboli di riempimento sono di diverse
tipologie:

• Riempimento semplice (predefinito): sono disponibili le seguenti impostazioni:

– Fill color

– Outline color

– Stile riempimento

– Outline style

– Outline width

– Stile unione

– Offset X,Y

• Centroid fill: places a marker symbol at the centroid of the visible feature. The position of the marker may
however not be the real centroid of the feature because calculation takes into account the polygon(s) clipped
to area visible in map canvas for rendering and ignores holes. Use Generatore geometria if you want the
exact centroid.
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Il simbolo può essere posizionato su ogni parte di un poligono a più parti o solo sulla sua parte più grande
e costretto ad essere all’interno del poligono;

• Geometry generator (see geometry_generator_symbol);

• Riempimento a gradiente: per riempire le superfici poligonali utilizza un gradiente radiale, lineare o
conico, basato su gradienti semplici di due colori o su una gradient color ramp predefinita. Il gradiente può
essere ruotato e applicato su una singola geometria o in tutta l’estensione della mappa. Anche i punti di
inizio e di fine possono essere impostati tramite coordinate o utilizzando il centroide (del poligono o nella
sua visualizzazione in mappa);

• Riempimento a pattern lineare: riempe il poligono con un tipo di tratteggio della simbologia linerare. È
possibile impostare la spaziatura tra le righe e un offset dal contorno del poligono;

• Riempimento a pattern puntuale: riempe il poligono con un simbolo puntuale scelta tra la simbologia
puntuale. È possibile impostare la spaziatura tra le righe e un offset dal contorno del poligono;

• Riempimento Raster: puoi riempire i poligoni con una immagine raster ripetuta. Le opzioni includono
(definizione dati) il nome del le, l’opacità, la dimensione dell’immagine (in pixel, mm o unità mappa), la
modalità coordinata (geometria o parte visualizzata) e la rotazione;

• Riempimento SVG: riempe il poligono usando SVG markers;

• Riempimento sfumato: questa opzione riempe il poligono in modo sfumato, la sfumatura viene disegnata
dal contorno del poligono verso il centro del poligono. I parametri di configurazione includono la distanza
dal contorno all’ombra, l’uso delle scale di colore o semplici due gradienti di colore, la sfocatura facoltativa
del riempimento e gli offset;

• Cornice: freccia: usa un simbolo lineare arrow symbol per rappresentare il contorno del poligono;

• Cornice: Simbolo lineare: utilizza una simbologia lineare per rappresentare il contorno del poligono;

• Cornice: linea semplice: utilizza un semplice simbolo lineare per rappresentare il contorno poligonale.
L’opzione Disegna la linea solo all’interno del poligono evidenzia i bordi poligonali all’interno e può essere
utile per meglio evidenziare i confini poligonali di aree adiacenti.

Nota: Quando il tipo geometria è un poligono, è possibile scegliere di disabilitare il ritaglio automatico di
linee/poligoni sull’estensione della mappa in visualizzazione. In alcuni casi questo ritaglio si traduce in una
simbologia non ottimale (ad esempio non può essere rispettato che il baricentro del riempimento sia nel baricentro
effettivo del poligono).

Generatore geometria Disponibile per tutti i tipi di simbologia, il layer simbolo generatore geometria permette
di usare le espressioni per generare una geometria al volo durante il processo di visualizzazione. La geometria
risultante non deve corrispondere con il tipo di geometria originaria del vettore e puoi aggiungere vari layer
simbolo, modificati diversamente, l’uno sull’altro.

Alcuni esempi:

-- render the centroid of a feature
centroid( $geometry )

-- visually overlap features within a 100 map units distance from a point
-- feature, i.e generate a 100m buffer around the point
buffer( $geometry, 100 )

-- Given polygon layer1( id1, layer2_id, ...) and layer2( id2, fieldn...)
-- render layer1 with a line joining centroids of both where layer2_id = id2
make_line( centroid( $geometry ),

centroid( geometry( get_feature( ’layer2’, ’id2’, attribute(
$currentfeature, ’layer2_id’) ) )

)
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Il Simbolo di Campo Vettoriale Il simbolo di campo vettoriale viene utilizzato per visualizzare dati puntuali a
variabilità vettoriale come la deformazione della terra, le ampiezze di marea e simili. Visualizza gli indicatori con
segmenti (preferibilmente frecce) che vengono ridimensionati e orientati in base agli attributi selezionati dei punti
dati. Può essere utilizzato solo per la visualizzazione di dati puntuali; i layer lineari e poligonali non utilizzano
questa simbologia.

Il simbolo di campo vettoriale è definito dagli attributi nei dati, tramite:

• le componenti cartesiane (componenti x e y del campo)

• o le coordinate polari: in questo caso, gli attributi definiscono la Lunghezza e l’Angolo. L’angolo può
essere misurato in senso orario da nord, o in senso antiorario da est, e può essere in gradi o radianti.

• o solo come dati di altezza, che visualizza una freccia verticale che viene dimensionata utilizzando un at-
tributo dei dati. Ciò è appropriato ad esempio per visualizzare la componente verticale di una deformazione.

La grandezza del simbolo può essere aumentata o diminuita per ottimizzare la visualizzazione nella rappresen-
tazione.

12.2 Proprietà dei vettori

La finestra di dialogo Proprietà vettore fornisce le impostazioni generali per gestire l’aspetto degli elementi del
layer nella mappa (simbologia, etichettatura, diagrammi), l’interazione con il mouse (azioni, suggerimenti per la
mappa). Fornisce anche informazioni sul layer.

To access the Layer Properties dialog, double-click on a layer in the legend or right-click on the layer and select
Properties from the pop-up menu.

Nota: Depending on the external plugins you have installed, new tabs may be added to the layer properties
dialog. Those are not presented below.

Suggerimento: Live update rendering
The Pannello Stile Layer provides you with some of the common features of the Layer properties dialog and is a
good modeless widget that you can use to speed up the configuration of the layer styles and automatically view
your changes in the map canvas.

Nota: Poiché le proprietà (simbologia, etichetta, azioni, valori predefiniti, moduli ...) di layers incorporati (vedi
Progetti nidificati) sono ricavate dal file di progetto originale per evitare modifiche che potrebbero alterare questo
comportamento, la finestra di dialogo delle proprietà dei layer non è disponibile per questi strati.

12.2.1 General Properties

Use this tab to make general settings for the vector layer. There are several options available:

Layer Info

• Set the Layer name to display in the Layers Panel

• Display the Layer source of the vector layer

• Define the Data source encoding to define provider-specific options and to be able to read the file
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Sistema di Riferimento

• Visualizza il Sistema di Riferimento delle Coordinate (SR) del vettore come una stringa PROJ.4. Puoi
modificare il SR del vettore selezionando un SR usato di recente nell’elenco a discesa o facendo clic sul

pulsante Select CRS (vedi Scelta del sistema di riferimento delle coordinate). Utilizza questo metodo solo
se il SR applicato al vettore è sbagliato o se non ne è stato applicato alcuno. Se si desidera riproiettare i dati
in un altro SR, utilizzare piuttosto gli algoritmi di riproiezione layer da Processing o Save it into another
layer.

• Create a Spatial Index (only for OGR-supported formats)

• Update Extents information for a layer

Visibilità dipendente dalla scala

Puoi impostare la scala Massima (inclusiva) e quella minima (esclusiva), definendo un intervallo di valori di scala

in cui le geometrie saranno visibili. Fuori di questo intervallo sono nascoste. Il pulsante Imposta alla scala corrente

dell’estensione della mappa ti consente di utilizzare la scala corrente della mappa come limite di visibilità.

Figure 12.7: General tab in vector layers properties dialog

Costruttore di interrogazioni

Under the Provider Feature Filter frame, the Query Builder allows you to define a subset of the features in the
layer using a SQL-like WHERE clause and to display the result in the main window. As long as the query is
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active, only the features corresponding to its result are available in the project. The query result can be saved as a
new vector layer.

The Query Builder is accessible through the eponym term at the bottom of the General tab in the Layer Properties.
Under Feature subset, click on the [Query Builder] button to open the Query builder. For example, if you have
a regions layer with a TYPE_2 field, you could select only regions that are borough in the Provider specific
filter expression box of the Query Builder. Figure_vector_querybuilder shows an example of the Query Builder
populated with the regions.shp layer from the QGIS sample data. The Fields, Values and Operators sections
help you to construct the SQL-like query.

Figure 12.8: Costruttore di interrogazioni

The Fields list contains all attribute columns of the attribute table to be searched. To add an attribute column to
the SQL WHERE clause field, double click its name in the Fields list. Generally, you can use the various fields,
values and operators to construct the query, or you can just type it into the SQL box.

The Values list lists the values of an attribute table. To list all possible values of an attribute, select the attribute in
the Fields list and click the [all] button. To list the first 25 unique values of an attribute column, select the attribute
column in the Fields list and click the [Sample] button. To add a value to the SQL WHERE clause field, double
click its name in the Values list.

The Operators section contains all usable operators. To add an operator to the SQL WHERE clause field, click
the appropriate button. Relational operators ( = , > , ...), string comparison operator (LIKE), and logical operators
(AND, OR, ...) are available.

The [Test] button shows a message box with the number of features satisfying the current query, which is useful
in the process of query construction. The [Clear] button clears the text in the SQL WHERE clause text field.
The [OK] button closes the window and selects the features satisfying the query. The [Cancel] button closes the
window without changing the current selection.

QGIS treats the resulting subset acts as if it were the entire layer. For example if you applied the filter above for
‘Borough’, you can not display, query, save or edit Anchorage, because that is a ‘Municipality’ and therefore not
part of the subset.

The only exception is that unless your layer is part of a database, using a subset will prevent you from editing the
layer.
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12.2.2 Style Properties

The Style tab provides you with a comprehensive tool for rendering and symbolizing your vector data. You
can use tools that are common to all vector data, as well as special symbolizing tools that were designed for the
different kinds of vector data. However all types share the following dialog structure: in the upper part, you
have a widget that helps you prepare the classification and the symbol to use for features and at the bottom the
Visualizzazione del layer widget.

Suggerimento: Esporta simbologia vettore
Hai la possibilità di esportare la simbologia del vettore da QGIS nei file Google *.kml, *.dxf e MapInfo *.tab.
Semplicemente, clicca con il tasto destro sul vettore per aprire il menu contestuale e clicca su Salva con nome...
per specificare il nome del file in uscita e il suo formato. Nella finestra di dialogo, usa il menu Esporta simbologia
per salvare la simbologia o come Simbologia elementi → o come Simbologia simboli del vettore →. Se hai
utilizzato dei simboli, si consiglia di utilizzare la seconda impostazione.

Visualizzazione delle geometrie

The renderer is responsible for drawing a feature together with the correct symbol. Regardless layer geometry
type, there are four common types of renderers: single symbol, categorized, graduated and rule-based. For point
layers, there are a point displacement and a heatmap renderers available while polygon layers can also be rendered
with the inverted polygons and 2.5 D renderers.

Il visualizzatore a colorazione continua non c’è perché è a tutti gli effetti un caso speciale del visualizzatore
graduato. I visualizzatori categorizzato e graduato possono essere modificati con simboli specifici e con scale di
colore personalizzate - i colori per i simboli saranno realizzati in modo appropriato. Per ogni tipo di vettori (punti,
linee e poligoni), sono disponibili tipi di simboli. A seconda del visualizzatore selezionato, la finestra di dialogo
offre diverse sezioni aggiuntive.

Nota: Se cambi il tipo di visualizzatore mentre imposti lo stile di un vettore, le impostazioni effettuate per
il simbolo saranno mantenute. Questo funziona solo per un cambiamento. Se si ripete la modifica del tipo di
visualizzatore le impostazioni per il simbolo saranno perse.

Visualizzatore Simbolo Singolo

The Single Symbol renderer is used to render all features of the layer using a single user-defined symbol. See
Selettore Simbolo for further information about symbol representation.

Suggerimento: Editare simboli direttamente dal Pannello Layer

If in your Layers Panel you have layers with categories defined through categorized, graduated or rule-based style
mode, you can quickly change the fill color of the symbol of the categories by right-clicking on a category and

choose the color you prefer from a color wheel menu. Right-clicking on a category will also give you access to
the options Hide all items, Show all items and Edit symbol.

Visualizzatore Senza Simboli

Il visualizzatore Senza Simboli è un caso di utilizzo speciale della visualizzazione a Simbolo Singolo in
quanto applica la stessa rappresentazione a tutti gli oggetti. Utilizzando questa tipologia di visualizzazione, nes-
suna simbologia verrà disegnata sulle caratteristiche geometriche (sulla rappresentazione del punto o della linea
o del poligono), ma l’etichettatura, eventuali diagrammi e altre parti non-simbologia geometrica saranno ancora
visualizzate.
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Figure 12.9: Finestra di dialogo Simbolo singolo

Le selezioni possono ancora essere effettuate sul layer in mappa e le geometrie selezionate verranno visualizzate
con un simbolo predefinito. Verranno mostrate anche le geometrie modificate.

Questo è inteso come una comoda scorciatoia per i layer per i quali vuoi mostrare solo le etichette o i diagrammi
evitando di dover rendere totalmente trasparente la simbologia per raggiungere questo obiettivo.

Visualizzatore Categorizzato

The Categorized renderer is used to render the features of a layer, using a user-defined symbol whose aspect
reflects the discrete values of a field or an expression. The Categorized menu allows you to

• seleziona un campo esistente (utilizzando la lista a discesa) o

• digita o genera una expression utilizzando il pulsante Set column expression. L’espressione utilizzata per
classificare le geometrie può essere di qualsiasi tipo; può per esempio:

– fare un confronto, ad esempio myfield >= 100, $id = @atlas_featureid, myfield %
2 = 0, within( $geometry, @atlas_geometry ). In questo caso le risposte possibili
sono 1 (Vero) e 0 (Falso).

– combinare campi diversi, ad esempio concat( field1, ’ ’, field2 ) particolarmente
utile quando si desidera elaborare classificazioni su due o più campi contemporaneamente.

– eseguire calcoli su campi, ad esempio: myfield % 2, year( myfield ) field_1 +
field_2.

– trasformare valori lineari in classi discrete, ad esempio:

CASE WHEN x > 1000 THEN ’Big’ ELSE ’Small’ END

– combinare diversi valori discreti in una singola categoria, ad esempio:
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CASE
WHEN building IN (’residence’, ’mobile home’) THEN ’residential’
WHEN building IN (’commercial’, ’industrial’) THEN ’Commercial and Industrial’
END

Nota: Sebbene puoi utilizzare qualsiasi tipo di espressione per categorizzare le geometrie, per alcune
espressioni complesse potrebbe essere più semplice utilizzare la rule-based rendering.

• scegliere il simbolo (utilizzando la finestra di dialogo Selettore Simbolo) che sarà utilizzato come simbolo
di base per ogni classe;

• definire l’intervallo di colori (utilizzando la casella di riepilogo della scala di colori) da cui viene selezionato
il colore applicato al simbolo.

Then click on [Classify] button to create classes from the distinct value of the attribute column. Each class can be
disabled unchecking the checkbox at the left of the class name.

Per cambiare simbolo, valore e/o etichetta della classe, semplicemente fai doppio click sull’oggetto che vuoi
cambiare.

Il tasto destro mostra un menù contestuale con Copia/Incolla, Cambia colore, Cambia trasparenza, Cambia
unità, Cambia dimensione del simbolo.

L’esempio in figure_categorized_symbology mostra la finestra di dialogo per la visualizzazione per categorie sul
layer rivers del DataSet di esempio QGIS.

Figure 12.10: Finestra di dialogo Simbologia Categorizzata

Suggerimento: Selezionare e cambiare simboli multipli
La Simbologia ti permette di scegliere simboli multipli e di cliccare con il tasto destro per cambiare il coloro, la
trasparenza, la dimensione e lo spessore di quello che hai selezionato.

Suggerimento: Abbina le categorie al nome del simbolo
Nel menu [Avanzato], sotto le classi, puoi scegliere una delle prime due azioni per abbinare il nome del simbolo
al nome di una categoria nella tua classificazione. Fai corrispondere ai simboli salvati nome della categoria di

132 Chapter 12. Lavorare con i vettori



QGIS User Guide, Release 2.18

corrispondenza con un nome di simbolo dal tuo Gestore di stile. Fai corrispondere ai simboli da file nome della
categoria di corrispondenza a un nome di simbolo da un file esterno.

Visualizzatore Graduato

The Graduated renderer is used to render all the features from a layer, using an user-defined symbol whose
color or size reflects the assignment of a selected feature’s attribute to a class.

Come il Visualizzatore Categorizzato, quello Graduato ti permette di impostare la rotazione e la dimensione della
scala in base a valori presenti in colonne specifiche.

Inoltre, analogamente al Visualizzatore Categorizzato, ti permette di selezionare:

• L’attributo (utilizzando la casella di riepilogo Colonna o la funzione Finestra dell’espessione)

• Il simbolo (utilizzando la finestra di dialogo Selettore simbolo)

• Il formato legenda e la precisione

• Il metodo da usare per cambiare il simbolo: colore e dimensione

• I colori (usando la Scala di colori) se il metodo per il colore è selezionato

• La dimensione (utilizzando il dominio di dimensioni e la sua unità)

Quindi puoi utilizzare la scheda Istogramma che mostra un istogramma interattivo dai valori del campo assegnato
o dalla espressione. Le interruzioni di classe possono essere spostate o aggiunte utilizzando il widget istogramma.

Nota: Puoi usare il pannello Sintesi delle Statistiche per ottenere maggiori informazioni sul tuo vettore. Vedi
Pannello Statistiche.

Tornando alla scheda Classi, puoi specificare il numero di classi e anche la modalità per classificare le geometrie
all’interno delle classi (utilizzando l’elenco in Modo). Le modalità disponibili sono:

• Equal Interval: each class has the same size (e.g. values from 0 to 16 and 4 classes, each class has a size of
4);

• Quantile: each class will have the same number of element inside (the idea of a boxplot);

• Natural Breaks (Jenks): the variance within each class is minimal while the variance between classes is
maximal;

• Standard Deviation: classes are built depending on the standard deviation of the values;

• Pretty Breaks: calcola una sequenza di circa n + 1 valori, valori che vengono scelti in modo che siano di
1, 2 o 5 volte la potenza di 10 che coprono l’intervallo dei valori in x. (I valori vengono scelti secondo
l’ambiente statistico R http://astrostatistics.psu.edu/datasets/R/html/base/html/pretty.html)

The listbox in the center part of the Style tab lists the classes together with their ranges, labels and symbols that
will be rendered.

Clicca sul pulsante Classifica per creare la classi usando il metodo scelto. Ogni classe può essere disabilitata
spuntando la casella a sinistra del nome della classe.

Per cambiare simbolo, valore e/o etichetta della classe, semplicemente fai doppio click sull’oggetto che vuoi
cambiare.

Il tasto destro mostra un menù contestuale con Copia/Incolla, Cambia colore, Cambia trasparenza, Cambia
unità, Cambia dimensione del simbolo.

L’esempio in figure_graduated_symbology mostra la finestra di dialogo di visualizzazione graduata per il vettore
dei fiumi dell’insieme di dati di esempio di QGIS.

Suggerimento: Mappe tematiche usando un’espressione
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Figure 12.11: Finestra di dialogo Simbologia Graduata

Puoi creare mappe tematiche categorizzate o graduate usando il risultato di un’espressione. Nella fines-

tra di dialogo delle proprietà del vettore il selettore degli attributi viene esteso con una funzione
Imposta funzione espressione colonna. Non hai quindi più bisogno di creare una nuova colonna nella tabella degli attributi di
un vettore se desideri che l’attributo di classificazione sia composto da più campi o da un qualche tipo di formula.

Simboli Proporzionali e Analisi Multivariata

Proportional Symbol and Multivariate Analysis are not rendering types available from the Style rendering drop-
down list. However with the Size Assistant options applied over any of the previous rendering options, QGIS
allows you to display your point and line data with such representation. Creare simboli proporzionali

Proportional rendering is done by first applying to the layer the Visualizzatore Simbolo Singolo. Once you set the

symbol, at the upper level of the symbol tree, the Data-defined override button available beside Size or Width
options (for point or line layers respectively) provides tool to create proportional symbology for the layer. An

assistant is moreover accessible through the menu to help you define size expression.

The assistant lets you define:

• The attribute to represent, using the Field listbox or the Set column expression function (see Espressioni)

• the scale method of representation which can be ‘Flannery’, ‘Surface’ or ‘Radius’

• The minimum and maximum size of the symbol

• The range of values to represent: The down pointing arrow helps you fill automatically these fields with the
minimum (or zero) and maximum values returned by the chosen attribute or the expression applied to your
data.
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Figure 12.12: Varying size assistant

• An unique size to represent NULL values.

To the right side of the dialog, you can preview the features representation within a live-update widget. This
representation is added to the layer tree in the layer legend and is also used to shape the layer representation in the
print composer legend item.

The values presented in the varying size assistant above will set the size ‘Data-defined override’ with:

coalesce(scale_exp(Importance, 1, 20, 2, 10, 0.57), 1)

Creazione di analisi multivariata

Una visualizzazione con analisi multivariata ti consente di valutare la relazione tra due o più variabili ad esempio,
una può essere rappresentata da una scala di colori mentre l’altra è rappresentata da una dimensione.

The simplest way to create multivariate analysis in QGIS is to first apply a categorized or graduated rendering on
a layer, using the same type of symbol for all the classes. Then, clicking on the symbol [Change] button above
the classification frame, you get the Selettore Simbolo dialog from which, as seen above, you can activate and set
the size assistant option either on size (for point layer) or width (for line layer).

Like the proportional symbol, the size-related symbol is added to the layer tree, at the top of the categorized or
graduated classes symbols. And both representation are also available in the print composer legend item.

Figure 12.13: Multivariate example
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Rule-based Renderer

The Rule-based renderer is used to render all the features from a layer, using rule-based symbols whose aspect
reflects the assignment of a selected feature’s attribute to a class. The rules are based on SQL statements. The
dialog allows rule grouping by filter or scale, and you can decide if you want to enable symbol levels or use only
the first-matched rule.

To create a rule, activate an existing row by double-clicking on it, or click on ‘+’ and click on the new rule. In the

Rule properties dialog, you can define a label for the rule. Press the button to open the expression string
builder. In the Function List, click on Fields and Values to view all attributes of the attribute table to be searched.
To add an attribute to the field calculator Expression field, double click on its name in the Fields and Values list.
Generally, you can use the various fields, values and functions to construct the calculation expression, or you can
just type it into the box (see Espressioni). You can create a new rule by copying and pasting an existing rule with
the right mouse button. You can also use the ‘ELSE’ rule that will be run if none of the other rules on that level
matches. Since QGIS 2.8 the rules appear in a tree hierarchy in the map legend. Just double-click the rules in
the map legend and the Style tab of the layer properties appears showing the rule that is the background for the
symbol in the tree.

L’esempio in figure_rule_based_symbology mostra la finestra di dialogo visualizzazione basata su regole per il
layer dei fiumi majrivers del DataSet di esempio QGIS.

Figure 12.14: Opzioni Simboli definiti Tramite regole

Point displacement Renderer

The Point Displacement renderer works to visualize all features of a point layer, even if they have the same
location. To do this, the symbols of the points are placed on a displacement circle around one center symbol or on
several concentric circles.

Nota: You can still render features with other renderer like Single symbol, Graduated, Categorized or Rule-Based
renderer using the Renderer drop-down list then the Renderer Settings... button.
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Figure 12.15: Finestra di dialogo Spostamento punti

Inverted Polygon Renderer

La visualizzazione Poligoni invertiti consente all’utente di definire un simbolo al di fuori dei poligoni del
layer. Come sopra puoi selezionare le altre visualizzazioni, ovvero Simbolo singolo, Graduato, Categorizzato,
Basato su regole o Visualizzazione 2.5D.

Heatmap Renderer

With the Heatmap renderer you can create live dynamic heatmaps for (multi)point layers. You can specify
the heatmap radius in pixels, mm or map units, choose and edit a color ramp for the heatmap style and use a slider
for selecting a trade-off between render speed and quality. You can also define a maximum value limit and give a
weight to points using a field or an expression. When adding or removing a feature the heatmap renderer updates
the heatmap style automatically.

2.5D Renderer

Utilizzando la visualizzazione 2.5D è possibile creare un effetto 2.5D sulle geometrie del tuo layer. Inizia
scegliendo un valore di Altezza (in unità di mappe). Per questo puoi utilizzare un valore fisso, uno dei campi del
tuo layer o un’espressione. È inoltre devi scegliere un Angolo (in gradi) per ricreare la posizione del visualizzatore
(0 ° significa ovest, crescente in senso antiorario). Usa le opzioni avanzate di configurazione per impostare il
Colore tetto e Colore muro. Se vuoi simulare la radiazione solare sulle pareti delle caratteristiche, assicurati di
scegliere l’opzione Ombra muri basata sull’aspetto. Puoi anche simulare la presenza di un’ombra impostando un
Colore e una Dimensione (in unità di mappa).
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Figure 12.16: Finestra di dialogo Poligoni invertiti

Figure 12.17: Finestra di dialogo Mappa di concentrazione
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Figure 12.18: Finestra di dialogo mappa 2.5D

Suggerimento: Utilizzare l’effetto 2.5D con altre visualizzazioni
Una volta che hai finito di impostare lo stile di base nella visualizzazione 2.5D, puoi convertirlo in un altra tipologia
di visualizzazione (Singolo, Categorizzato, Graduato). Gli effetti 2.5D verranno mantenuti e tutte le altre opzioni
di visualizzazione saranno disponibili per essere o meno confermate (in questo modo puoi avere, ad esempio,
simboli categorizzati con una bella rappresentazione 2.5D o aggiungere un certo stile aggiuntivo ai tuoi simboli
2.5D). Per assicurarti che l’ombra e l“‘edificio” non interferiscano con altre geometrie vicine, potrebbe essere
necessario attivare i Livelli dei simboli ( Avanzate → Livelli dei Simboli...). I valori di altezza e angolo 2.5D
vengono salvati nelle variabili del layer, quindi puoi modificarla successivamente nella scheda variabili della
finestra di dialogo delle proprietà del layer

Visualizzazione del layer

From the Style tab, you can also set some options that invariabily act on all features of the layer:

• Layer transparency : You can make the underlying layer in the map canvas visible with
this tool. Use the slider to adapt the visibility of your vector layer to your needs. You can also make a
precise definition of the percentage of visibility in the the menu beside the slider.

• Layer blending mode and Feature blending mode: You can achieve special rendering effects with these tools
that you may previously only know from graphics programs. The pixels of your overlaying and underlaying
layers are mixed through the settings described in Metodi di fusione.

• Applica paint effects su tutte le geometrie del layer con il pulsante Personalizza effetti.

• Controllo ordine di visualizzazione ti permette, utilizzando gli attributi delle geometrie, di definire in quale

ordine z vengono visualizzati. Attiva la casella di controllo e fai click sul pulsante accanto . Ottiene
quindi la finestra di dialogo Definisci l’ordine in cui:

– choose a field or build an expression to apply to the layer features

– set in which order the fetched features should be sorted, i.e. if you choose Ascending order, the
features with lower value are rendered under those with upper value.

– define when features returning NULL value should be rendered: first or last.
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You can add several rules of ordering. The first rule is applied to all the features in the layer, z-ordering
them according to the value returned. Then, for each group of features with the same value (including those
with NULL value) and thus same z-level, the next rule is applied to sort its items among them. And so on...

Figure 12.19: Opzioni di visualizzazione del layer

Altre impostazioni

Symbols levels

Per i visualizzatori che permettono layer di simbolo sovrapposti (solo la mappa di concentrazione non lo permette)
c’è un’opzione per controllare l’ordine di visualizzazione di ciascun livello del simbolo.

For most of the renderers, you can access the Symbols levels option by clicking the [Advanced] button below
the saved symbols list and choosing Symbol levels. For the Rule-based Renderer the option is directly available
through [Symbols levels] button, while for Point displacement Renderer renderer the same button is inside the
Rendering settings dialog.

Per attivare i livelli dei simboli, selezionare Abilita livelli simbolo. Ogni riga mostrerà un piccolo campione
del simbolo combinato, la sua etichetta e il singolo livello di simbolo diviso in colonne con un numero accanto ad
esso. I numeri rappresentano l’ordine di visualizzazione con cui verrà prelevato il livello di simbolo. I livelli di
valori inferiori vengono tracciati prima, rimanendo in basso, mentre i valori più alti vengono tracciati per ultimi,
sopra agli altri.

Figure 12.20: Finestra di dialogo dei livelli simbolo

Nota: Se i livelli simbolo sono disattivati, saranno mostrati i simboli completi secondo il rispettivo ordine delle
geometrie. I simboli sovrapposti copriranno quelli al di sotto di essi. Inoltre, simboli simili non si “uniranno” gli
uni con gli altri.

140 Chapter 12. Lavorare con i vettori



QGIS User Guide, Release 2.18

Figure 12.21: Differenza tra i livelli simboli attivati (A) e disattivati (B)

Effetti disegno

Al fine di migliorare la rappresentazione dei vettori ed evitare (o perlomeno ridurre) il ricorso ad altri software per

la rappresentazione finale delle mappe, QGIS fornisce un’altra potente funzionalità: l’opzione Effetti Disegno,
che aggiunge effetti grafici per personalizzare la visualizzazione di vettori.

The option is available in the Layer Properties –> Style dialog, under the Layer rendering group (applying to the
whole layer) or in symbol layer properties (applying to corresponding features). You can combine both usage.

Paint effects can be activated by checking the Draw effects option and clicking the Customize effects button,
that will open the Effect Properties Dialog (see figure_effects_source). The following effect types, with custom
options are available:

• Source: Draws the feature’s original style according to the configuration of the layer’s properties. The
transparency of its style can be adjusted.

Figure 12.22: Finestra di dialogo Effetti di disegno

• Blur: Adds a blur effect on the vector layer. The options that someone can change are the Blur type (Stack
or Gaussian blur), the strength and transparency of the blur effect.
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Figure 12.23: Effetti di disegno: finestra di dialogo Sfumatura

• Colorize: This effect can be used to make a version of the style using one single hue. The base will always

be a grayscale version of the symbol and you can use the Grayscale to select how to create it (options

are: ‘lightness’, ‘luminosity’ and ‘average’). If Colorise is selected, it will be possible to mix another
color and choose how strong it should be. You can also control the Brightness, contrast and saturation
levels of the resulting symbol.

• Drop Shadow: Using this effect adds a shadow on the feature, which looks like adding an extra dimension.
This effect can be customized by changing the offset degrees and radius, determining where the shadow
shifts towards to and the proximity to the source object. Drop Shadow also has the option to change the blur
radius, the transparency and the color of the effect.

• Inner Shadow: This effect is similar to the Drop Shadow effect, but it adds the shadow effect on the inside
of the edges of the feature. The available options for customization are the same as the Drop Shadow effect.

• Inner Glow: Adds a glow effect inside the feature. This effect can be customized by adjusting the spread
(width) of the glow, or the Blur radius. The latter specifies the proximity from the edge of the feature where
you want any blurring to happen. Additionally, there are options to customize the color of the glow, with a
single color or a color ramp.

• Outer Glow: This effect is similar to the Inner Glow effect, but it adds the glow effect on the outside of the
edges of the feature. The available options for customization are the same as the Inner Glow effect.

• Transform: Adds the possibility of transforming the shape of the symbol. The first options available
for customization are the Reflect horizontal and Reflect vertical, which actually create a reflection on the
horizontal and/or vertical axes. The 4 other options are:

– Shear: slants the feature along the x and/or y axis

– Scale: enlarges or minimizes the feature along the x and/or y axis by the given percentage

– Rotation: turns the feature around its center point

– and Translate changes the position of the item based on a distance given on the x and/or the y axis.

There are some common options available for all draw effect types. Transparency and Blend mode options work
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Figure 12.24: Effetti di disegno: finestra di dialogo Colorazione

Figure 12.25: Effetti di disegno: finestra di dialogo Ombreggiatura

12.2. Proprietà dei vettori 143



QGIS User Guide, Release 2.18

Figure 12.26: Effetti di disegno: finestra di dialogo Ombreggiatura interna

Figure 12.27: Effetti di disegno: finestra di dialogo Ombreggiatura interna
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Figure 12.28: Effetti di disegno: finestra di dialogo Ombreggiatura esterna

Figure 12.29: Effetti di disegno: finestra di dialogo Trasformazione
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similar to the ones described in Visualizzazione del layer and can be used in all draw effects except for the trans-
form one.

One or more draw effects can used at the same time. You activate/deactivate an effect using its checkbox in the

effects list. You can change the selected effect type by using the Effect type option. You can reorder the

effects using Move up and Move down buttons, and also add/remove effects using the Add effect and
Remove effect buttons.

There is also a Draw mode option available for every draw effect, and you can choose whether to render
and/or to modify the symbol. Effects render from top to bottom.’Render only’ mode means that the effect will be
visible while the ‘Modify only’ mode means that the effect will not be visible but the changes that it applies will
be passed to the next effect (the one immediately below). The ‘Render and Modify’ mode will make the effect
visible and pass any changes to the next effect. If the effect is in the top of the effects list or if the immediately
above effect is not in modify mode, then it will use the original source symbol from the layers properties (similar
to source).

12.2.3 Proprietà etichette

Le proprietà Etichette ti offrono tutte le funzioni necessarie e appropriate per configurare l’etichettatura
intelligente dei vettori. Puoi accedere a questa finestra di dialogo anche dal pannello Stile o utilizzando
Opzioni per l’etichetta del layer dell’icona Barra degli strumenti delle etichette.

Impostazione etichetta

The first step is to choose the labeling method from the drop-down list. There are four options available:

• No labels

• Show labels for this layer

• Rule-based labeling

• and Blocking: allows to set a layer as just an obstacle for other layer’s labels without rendering any labels
of its own.

The next steps assume you select the Show labels for this layer option, enabling following tabs that help you
configure the labeling:

• Testo

• Formattazione

• Contorno

• Sfondo

• Ombra

• Posizionamento

• Visualizzazione

It also enables the Label with drop-down list, from which you can select an attribute column to use. Click if
you want to define labels based on expressions - See Definire le etichette tramite espressioni.

I passi seguenti descrivono un’etichettatura semplice, senza usare la funzione di Sovrascrittura definita dai dati,
situata vicino ai menu a tendina - vedi Etichettare in funzione dei dati per un caso di uso.

Scheda testo

In the Text tab, you can define the Font, Style, and Size of your labels’ text (see Figure_labels). There are options
available to set the labels’ Color and Transparency. Use the Type case option to change the capitalization style of
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Figure 12.30: Impostazioni etichettatura vettore - Scheda testo
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the text. You have the possibility to render the text as ‘All uppercase’, ‘All lowercase’ or ‘Capitalize first letter’.
In Spacing, you can change the space between words and between individual letters. Finally, use the Blend mode
option to determine how your labels will mix with the map features below them (see more about it in Metodi di
fusione).

L’opzione Apply label text substitutes ti consente di specificare una lista di testi delle etichette delle geometrie
da sostituire (ad esempio abbreviazione di tipi di strada). I testi di sostituzione vengono quindi utilizzati per
visualizzare le etichette nella mappa al posto di quello/i contenuti nella colonna di attributi scelta per la etichet-
tatura. Gli utenti possono anche esportare e importare elenchi di sostituzione per rendere più facile il riutilizzo e
la condivisione.

Scheda Formattazione

In the Formatting tab, you can define a character for a line break in the labels with the Wrap on character option.
You can also format the Line Height and the alignment. For the latter, typical values are available (left, right, and
center), plus Follow label placement for point layers. When set to this mode, text alignment for labels will be
dependent on the final placement of the label relative to the point. E.g., if the label is placed to the left of the point,
then the label will be right aligned, while if it is placed to the right, it will be left aligned.

Per i layer vettoriali lineari puoi includere Simbolo di direzione della linea per determinare le linee di direzione.
Funzionano particolarmente bene quando vengono utilizzate con le opzioni di posizionamento ‘Parallelo’ o ‘Cur-
vato’ della successiva scheda Posizionamento. Ci sono opzioni per impostare la posizione dei simboli e per
invertire la direzione.

Utilizza l’opzione Numeri formattati per formattare etichette numeriche. Puoi impostare il numero di Posizioni
decimali. Per impostazione predefinita, verranno utilizzate 3 cifre decimali. Utilizza Mostra il segno più se
desideri mostrare il segno più per i numeri positivi.

Scheda Buffer

To create a buffer around the labels, activate the Draw text buffer checkbox in the Buffer tab. You can set the

buffer’s Size, color, and Transparency. The buffer expands from the label’s outline , so, if the color buffer’s fill
checkbox is activated, the buffer interior is filled. This may be relevant when using partially transparent labels or

with non-normal blending modes, which will allow seeing behind the label’s text. Deactivating color buffer’s
fill checkbox (while using totally transparent labels) will allow you to create outlined text labels.

Scheda Sfondo

In the Background tab, you can define with Size X and Size Y the shape of your background. Use Size type to
insert an additional ‘Buffer’ into your background. The buffer size is set by default here. The background then
consists of the buffer plus the background in Size X and Size Y. You can set a Rotation where you can choose
between ‘Sync with label’, ‘Offset of label’ and ‘Fixed’. Using ‘Offset of label’ and ‘Fixed’, you can rotate the
background. Define an Offset X,Y with X and Y values, and the background will be shifted. When applying
Radius X,Y, the background gets rounded corners. Again, it is possible to mix the background with the underlying
layers in the map canvas using the Blend mode (see Metodi di fusione).

Scheda Ombra

Use the Shadow tab for a user-defined Drop shadow. The drawing of the background is very variable. Choose
between ‘Lowest label component’, ‘Text’, ‘Buffer’ and ‘Background’. The Offset angle depends on the orienta-

tion of the label. If you choose the Use global shadow checkbox, then the zero point of the angle is always
oriented to the north and doesn’t depend on the orientation of the label. You can influence the appearance of the
shadow with the Blur radius. The higher the number, the softer the shadows. The appearance of the drop shadow
can also be altered by choosing a blend mode.
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Scheda Posizionamento

Choose the Placement tab for configuring label placement and labeling priority. Note that the placement options
differ according to the type of vector layer, namely point, line or polygon.

Posizionamento per vettori di punti Con la modalità di posizionamento Cartografico le etichette per i
vettori puntuali vengono generate con una migliore relazione visiva seguendo le regole di posizionamento car-
tografico ideali. Le etichette possono essere posizionate ad una Distanza impostata sia dal punto che dai bordi
del simbolo utilizzato per rappresentare l’oggetto puntuale. Quest’ultima opzione è particolarmente utile quando
la dimensione del simbolo non è fissa, ad esempio se è impostato da una dimensione definita dai dati o quando
si utilizzano diversi simboli in una classificazione categorizzata. Per impostazione predefinita, i posizionamenti
sono effettuati nel seguente ordine:

Per impostazione predefinita, i posizionamenti sono effettuati nel seguente ordine:

1. in alto a destra

2. in alto a sinistra

3. in basso a destra

4. in basso a sinistra

5. al centro a destra

6. al centro a sinistra

7. in alto, leggermente a destra

8. in basso, leggermente a sinistra

La priorità di posizionamento può tuttavia essere personalizzata o impostata utilizzando un elenco definito di po-
sizioni prioritarie. Ciò consente inoltre di utilizzare solo determinati posizionamenti, ad esempio per gli elementi
sulla costa è possibile impedire che le etichette siano collocate sulla terra.

L’impostazione Intorno al punto posiziona l’etichetta in un raggio uguale (impostato in Distanza) intorno
all’elemento. Il posizionamento dell’etichetta può anche essere limitato utilizzando l’opzione Quadrant.

Con Offset dal punto, le etichette vengono posizionate ad un offset fisso dal punto. Puoi selezionare il Quad-
rante in cui inserire l’etichetta. Puoi inoltre impostare le distanze di Offset X,Y tra i punti e le rispettive etichette
e puoi modificare l’angolo del posizionamento delle etichette con l’impostazione Rotazione. Pertanto è possibile
il posizionamento in un quadrante selezionato con una rotazione definita.

Posizionamento per vettori di linee Le opzioni per le etichette di layers lineari includono Parallelo,

Curvato o Orizzontale. Per le opzioni Parallelo e Curvato puoi impostare la posizione su Sopra

la linea, Sulla linea e Sotto la linea. Puoi selezionare più opzioni contemporaneamente. In questo caso,
QGIS cercherà per l’etichetta la posizione ottimale. Per le opzioni di posizionamento parallelo e curvo, puoi anche
utilizzare l’orientamento della linea per la posizione dell’etichetta. Inoltre, puoi definire un Angolo massimo tra
caratteri curvi quando selezioni l’opzione Curvato (vedi Figure_labels_placement_line).

Per tutte le tre opzioni di posizionamento, in Ripeti, è possibile impostare una distanza minima per ripetere le
etichette. La distanza può essere in mm o in unità di mappa.

Posizionamento per vettori poligonali Puoi scegliere una delle seguenti opzioni per il posizionamento di
etichette in poligoni (vedi figure_labels_placement_polygon):

• Offset dal centroide,

• Orizzontale (lento),

• Attorno al centroide,
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Figure 12.31: Esempi di posizionamento di etichette in vettori lineari

• Libero (lento),

• Utilizzando il perimetro,

• and Utilizzando il perimetro (curvo).

Nelle impostazioni Offset dal centroide puoi specificare se il centroide è del poligono visibile o del intero
poligono. Ciò significa che venga utilizzato o il centroide della parte di poligono che si può vedere sulla mappa
o il centroide dell’intero poligono, non importa se si può vedere tutto sulla mappa. Puoi inserire l’etichetta in un
quadrante specifico e definire offset e rotazione.

L’impostazione Attorno al centroide indica a quale distanza porre l’etichetta dal centroide. Ancora una volta, puoi
definire il centroide del poligono visibile o dell’ intero poligono.

Con le opzioni Orizzontale (lento) o Libero (lento), QGIS posiziona nella posizione migliore un’etichetta orizzon-
tale o una etichetta ruotata all’interno del poligono.

Con l’opzione Utilizzando il perimetro, l’etichetta verrà disegnata accanto al limite del poligono. L’etichetta
si comporterà come nell’opzione parallela per le linee. È possibile definire una posizione e una distanza per

l’etichetta. Per la posizione sono possibili le opzioni Sopra la linea, Sulla linea, Sotto la linea e

Posizione dipendente dall’orientazione della linea. Puoi specificare la distanza tra l’etichetta e il bordo del
poligono, nonché l’intervallo di ripetizione per l’etichetta.

L’opzione Using perimeter (curved) ti consente di disegnare l’etichetta lungo il contorno del poligono, utilizzando
un’etichetta curva. Oltre ai parametri disponibili con l’utilizzo dell’impostazione Usando il perimetro, è possibile
impostare l’ Angolo massimo tra caratteri curvi, sia all’interno che all’esterno.

Nella sezione Priorità puoi definire la priorità con cui vengono generate le etichette per tutti e tre i tipi di layer
vettoriali (punto, linea, poligono). Questa opzione di posizionamento interagisce con le etichette di altri strati
vettoriali nella mappa. Se ci sono etichette di diversi layers nella stessa posizione, verrà visualizzata l’etichetta
con la priorità più alta e le altre non saranno visibili.

Scheda Visualizzazione

In the Rendering tab, you can tune when the labels can be rendered and their interaction with other labels and
features.

In Opzioni etichetta, trovi le impostazioni di visibilità visibilità in base alla scala e la :guilabel:Visibilita basate
sulla dimensione del pixel ”.

Label z-index determina l’ordine in cui vengono visualizzate le etichette, nonché in relazione ad altre etichette
degli elementi del layer (utilizzando l’espressione definita in funzione dei dati) come con le etichette di altri
livelli. Le etichette con un z-index più alto vengono visualizzate sopra le etichette (di qualsiasi layer) con z-index
inferiore.
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Figure 12.32: Esempi di posizionamento di etichette in vettori poligonali

Inoltre, se 2 etichette hanno corrispondenti z-indici, allora:

• Se provengono dallo stesso layer, l’etichetta più piccola verrà disegnata sopra l’etichetta più grande

• Se vengono da diversi layer, le etichette verranno disegnate nello stesso ordine dei loro stessi layer (rispet-
tando l’ordine impostato nella leggenda della mappa).

Tieni presente che questa impostazione non permette alle etichette di essere disegnate sotto gli elementi di altri
vettori, ma controlla semplicemente l’ordine in cui le etichette vengono disegnate sopra tutte le geometrie dei
layers.

Durante la creazione di etichette e per visualizzare le etichette leggibili, QGIS valuta automaticamente la po-
sizione delle etichette e può nascondere alcune di esse in caso di collisione. Puoi comunque scegliere l’opzione
Mostra tutte le etichette per questo layer (incluse le etichette che collidono) al fine di definire manualmente il loro
posizionamento.

Con Sovrascrittura definita dai dati in Mostra etichetta e Mostra sempre puoi meglio definire quali etichette devono
essere visualizzate.

Nella scheda Opzioni elementi, puoi scegliere to Etichetta ogni parte delle geometria multipart e Numero massimo
di elementi da etichettare. Sia i layers lineari che poligonali offrono l’opzione di impostare una dimensione
minima per le geometrie da etichettare, utilizzando Elimina l’etichettatura degli elementi più piccoli di. Per
le geometrie poligonali, puoi anche definire come visibili solo le etichette secondo se stanno completamente
all’interno della geometria o meno. Per le geometrie lineari, puoi scegliere l’opzione Fondi le linee collegate per
evitare la duplicazione delle etichette, rendendo la mappa abbastanza alleggerita in combinazione con le opzioni
Distanza o Ripeti nella scheda Posizionamento.

Con la scheda Ostacoli puoi gestire la relazione di copertura tra le etichette e le geometrie. Attiva l’opzione
Evita che le etichette si sovrappongano alle geometrie per decidere se le geometrie del layer devono agire come
ostacoli per qualsiasi etichetta (incluse le etichette di altri elementi dello stesso layer). Un ostacolo è un elemento
che QGIS cerca per quanto possibile di evitare nel posizionare le etichette. Invece di tutto il layer, è possibile

definire un sottoinsieme di elementi da considerare come ostacoli, utilizzando Sovrascrittura definita dai dati accanto
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all’opzione

Il cursore di controllo di priorità per gli ostacoli ti consente di mostrare in caso di sovrap-
posizione le etichette di determinati layers anziché di altri. Una priorità di ostacolo a Basso peso significa che le
geometrie del layer sono meno considerate come ostacoli e quindi è più probabile che possano essere ricoperte
da etichette di altri layers. Questa priorità può anche essere definita dai dati, in modo che all’interno dello stesso
layer, per alcune geometrie ci sia più probabilità di essere ricoperte rispetto ad altre.

Per i layers poligonali, puoi scegliere il tipo di geometria da considerare come ostacolo riducendo al minimo i
posizionamenti delle etichette:

• All’interno dell’elemento: evita di inserire etichette all’interno del poligono (preferisce collocare le
etichette all’esterno o solo leggermente all’interno del poligono)

• o Lungo il contorno dell’elemento: evita di posizionare etichette oltre il contorno del poligono (preferisce
inserire le etichette all’esterno o completamente all’interno del poligono). Ad esempio, può essere utile per
i layers di confini regionali, dove le geometrie coprono un’intera area. In questo caso, è impossibile evitare
di inserire etichette all’interno di queste geometrie, e sembra molto meglio evitare di metterle oltre i confini
tra le geometrie.

Etichettatura tramite regole

Con Etichettatura tramite regole le etichette possono essere definite e applicate selettivamente sulla base di filtri
tramite espressioni e di intervalli di scala, come nella Rule-based rendering.

To create a rule, select the Rule-based labeling option in the main drop-down list from the Labels tab and click

the button at the bottom of the dialog. Then fill the new dialog with a description and an expression to filter
features. You can also set a scale range in which the label rule should be applied. The other options available in
this dialog are the common settings seen beforehand.

Un riepilogo delle regole esistenti è mostrato nella finestra di dialogo principale (vedi figure_labels_rule_based).
Puoi aggiungere più regole, riordinarle o sovrapporle con un drag-and-drop. Puoi anche rimuoverle con il pulsante

o modificarle con il pulsante o con un doppio click.

Definire le etichette tramite espressioni

Whether you choose simple or rule-based labeling type, QGIS allows using expressions to label features.

Click the icon near the Label with drop-down list in the Labels tab of the properties dialog. In fig-
ure_labels_expression, you see a sample expression to label the alaska regions with name and area size, based on
the field ‘NAME_2’, some descriptive text, and the function $area in combination with format_number()
to make it look nicer.

L’etichettatura a base di espressioni è facile da gestire. Tutto quello che devi fare è che:

• You need to combine all elements (strings, fields, and functions) with a string concatenation function such
as concat, + or ||. Be aware that in some situations (when null or numeric value are involved) not all of
these tools will fit your need.

• Le stringhe sono scritte tra ‘singoli apici’.

• I campi sono scritti tra “apici doppi” o senza alcun apice.

Guarda alcuni esempi:

1. Etichetta basata su due campi ‘nome’ e ‘luogo’ con una virgola come separatore:

"name" || ’, ’ || "place"

Risulta:

John Smith, Paris
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Figure 12.33: Modifica regola

Figure 12.34: Pannello etichettatura tramite regole
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Figure 12.35: Uso di espressioni per l’etichettatura

2. Etichetta basata su due campi ‘nome’ e ‘luogo’ con altri testi:

’My name is ’ + "name" + ’and I live in ’ + "place"
’My name is ’ || "name" || ’and I live in ’ || "place"
concat(’My name is ’, name, ’ and I live in ’, "place")

Risulta:

My name is John Smith and I live in Paris

3. Etichetta basata su due campi ‘nome’ e ‘luogo’ con altri testi che combinano diverse funzioni di concate-
nazione:

concat(’My name is ’, name, ’ and I live in ’ || place)

Risulta:

My name is John Smith and I live in Paris

Oppure, se il campo ‘luogo’ è NULL, restituisce:

My name is John Smith

4. Etichetta a più righe basata su due campi ‘nome’ e ‘luogo’ con un testo descrittivo:

concat(’My name is ’, "name", ’\n’ , ’I live in ’ , "place")

Risulta:

My name is John Smith
I live in Paris

5. Etichetta basata su un campo e la funzione $area per mostrare il nome del luogo e la sua superficie arroton-
data in una unità convertita:

’The area of ’ || "place" || ’ has a size of ’
|| round($area/10000) || ’ ha’

Risulta:
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The area of Paris has a size of 10500 ha

6. Creare una condizione CASE ELSE. Se il valore della popolazione nel campo ‘popolazione’ è <= 50000 è
una town, altrimenti è una city:

concat(’This place is a ’,
CASE WHEN "population <= 50000" THEN ’town’ ELSE ’city’ END)

Risulta:

This place is a town

Come puoi vedere nel costruttore di espressioni, puoi creare espressioni semplici o molto complesse con tentissime
funzioni utili, per etichettare i tuoi dati in QGIS. Vedi il capitolo Espressioni per ulteriori esempi e informazioni
sulle espressioni.

Etichettare in funzione dei dati

With the Data defined override functions, the settings for the labeling are overridden by entries in the attribute table.
It can be used to set values for most of the labeling options described above. See the widget’s description and
manipulation in Impostazione Sovrascrittura definita dai dati section.

Barra delle etichette

La Barra delle etichette fornisce alcuni strumenti per manipolare le proprietà dell’ etichetta o del dia-
gramma, ma solo se è indicata l’opzione corrispondente definita dai dati (altrimenti i pulsanti sono disabilitati). Il
vettore dovrebbe anche essere in modalità di modifica.

Figure 12.36: La barra degli strumenti etichetta

Mentre per la leggibilità è stato usato etichetta per descrivere la barra degli strumenti etichette, nota che
quando menzionati nel loro nome, gli strumenti funzionano quasi nello stesso modo con i diagrammi:

• Ancora/disancora etichette e diagrammi che dispongono di una posizione definita da dati. Facendo clic o trasci-
nando un’area, inserire le etichette. Se scegli o trascini su una zona premendo Maiuscolo, la(e)
etichetta(e) sono disattivate. Infine, puoi anche cliccare o trascinare un’area tenendo Ctrl per alternare
lo stato dei pin della(e) etichetta(e).

• Evidenzia etichette e diagrammi ancorati. Se il vettrore delle etichette è modificabile, allora gli evidenziati sono
verdi altrimenti sono blu.

• Muovi etichetta e diagramma che ha posizione definita. Devi trascinare l’etichetta nella posizione desiderata.

• Mostra/Nascondi etichette e diagrammi che hanno la visibilità definita dai dati. Se scegli o trascini su una zona
premendo Maiuscolo, la(e) etichetta(e) sono nascoste. Quando un’etichetta è nascosta, devi solo cliccare
o trascinare un’area attorno al punto dell’elemento per ripristinare la sua visibilità.

• Ruota etichetta. Click sull’etichetta e ruotala.

• Cambia l’etichetta. Apre una finestra di dialogo per modificare le proprietà dell’etichetta cliccata; può essere
l’etichetta stessa, le sue coordinate, l’angolo, il carattere, la dimensione ...
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Avvertimento: Gli strumenti di etichetta sovrascrivono i valori del campo corrente
L’utilizzo di Barra degli strumenti di etichetta per personalizzare l’etichetta effettivamente scrive il nuovo
valore della proprietà nel campo mappato. Quindi, presta attenzione a non sostituire inavvertitamente i dati
che ti potrebbero essere necessari in seguito!

Personalizza le etichette nella mappa

Combined with the Label Toolbar, the data defined override setting helps you manipulate labels in the map canvas

(move, edit, rotate). We now describe an example using the data-defined override function for the Move label

function (see figure_labels_data_defined).

1. Importa il lakes.shp dall’insieme di dati di esempio di QGIS.

2. Fai doppio clic sul layer per aprire le proprietà del livello. Clicca su Etichette e Posizionamento. Seleziona
Offset dal centride.

3. Cercare la voce Definito in funzione dei dati. Fai clic sull’icona per definire il tipo campo per Coordi-
nata. Scegli xlabel per X e ylabel per Y. Le icone sono ora evidenziate in giallo.

Figure 12.37: Etichettatura di vettori poligonali sovrascritti in funzione dei dati

4. Fai zoom su un lago

5. Impostare come modificabile il layer utilizzando il pulsante Attiva modifiche

6. Vai sulla Barra delle etichette e fai clic sull’icona . Adesso puoi spostare manualmente l’etichetta in
un’altra posizione (vedi figure_labels_move). La nuova posizione dell’etichetta viene salvata nelle colonne
xlabel e ylabel della tabella degli attributi.

7. Utilizzando Generatore geometria con l’espressione sottostante, puoi anche aggiungere un layer di simboli
di linea per collegare ciascun lago alla sua etichetta spostata:

make_line( centroid( $geometry ), make_point( "xlabel", "ylabel" ) )

12.2.4 Fields Properties

The Fields tab helps you organize the fields of the selected dataset and the way you can interact with the

feature’s attributes. The buttons New field and Delete field can be used when the dataset is in Editing mode.

You can rename fields by double-clicking in the fields name (note that you should switch to editing mode to edit
the field name). This is only supported for data providers like PostgreSQL, Oracle, Memory layer and some OGR
layer depending the OGR data format and version.

Puoi definire alcuni alias per rendere più comprensibili i nomi dei campi nel modulo Campi o nella tabella degli
attributi. In questo caso, non è necessario passare alla modalità di modifica. Gli Alias vengono salvati nel file di
progetto.
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Figure 12.38: Spostamento etichette

Comments can be added by clicking in the comment field of the column but if you are using a PostgreSQL layer,
comment of the column could be the one in the PostgreSQL table if set. Comments are saved in the QGIS project
file as for the alias.

The dialog also lists read-only characteristics of the field such as its type, type name, length and
precision. When serving the layer as WMS or WFS, you can also check here which fields could be retrieved.

Configurare il comportamento dei campi

Within the Fields tab, you also find an Edit widget column. This column can be used to define values or a range
of values that are allowed to be added to the specific attribute table column. It also helps to set the type of widget
used to fill or display values of the field, in the attribute table or the feature form. If you click on the [Edit widget]
button, a dialog opens, where you can define different widgets.

Impostazioni comuni

Regardless the type of widget applied to the field, there are some common properties you can set to control whether
and how a field can be edited:

• Editable: uncheck this to set the field read-only (not manually modifiable) when the layer is in edit mode.
Note that checking this setting doesn’t override any edit limitation from the provider.

• Label on top: places the field name above or beside the widget in the feature form

• Default value: for new features, automatically populates by default the field with a predefined value or an
expression-based one. For example, you can:

– use $x, $length, $area to populate a field with the feature’s x coordinate, length, area or any
geometric information at its creation;

– incremente a field by 1 for each new feature using maximum("field")+1;
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Figure 12.39: Field properties tab

Figure 12.40: Finestra di dialogo per modificare un campo
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– save the feature creation datetime using now();

– use variables in expressions, making it easier to e.g. insert the operator name (@user_full_name),
the project file path (@project_path), ...

A preview of the resulting default value is displayed at the bottom of the widget.

Nota: The Default value option is not aware of the values in any other field of the feature being
created so it won’t be possible to use an expression combining any of those values i.e using an expression
like concat(field1, field2) may not work.

• Constraints: you can constrain the value to insert in the field. This constraint can be:

– Not null: force the user to provide a value

– based on a custom expression: e.g. regexp_match(col0,’A-Za-z’) to ensure that the value
of the field col0 has only alphabetical letter.

A short description of the constraint can be added and will be displayed at the top of the form as a
warning message when the value supplied does not match the constraint.

Widgets disponibili

The available widgets are:

• Checkbox: Displays a checkbox, and you can define what attribute is added to the column when the check-
box is activated or not.

• Classification: Displays a combo box with the values used for classification, if you have chosen ‘unique
value’ as legend type in the Style tab of the properties dialog.

• Color: Displays a color button allowing user to choose a color from the color dialog window.

• Data/ora: Visualizza un campo che può aprire un widget di calendario per inserire una data, un tempo
o entrambi. Il tipo di colonna deve essere testo. Puoi selezionare un formato personalizzato, aprire un
calendario, ecc.

• Enumeration: Opens a combo box with values that can be used within the columns type. This is currently
only supported by the PostgreSQL provider.

• External Resource: Uses a “Open file” dialog to store file path in a relative or absolute mode. It can also
be used to display a hyperlink (to document path), a picture or a web page.

• File Name: Simplifies the selection by adding a file chooser dialog.

• Nascosto: rende invisibile la colonna, quindi non potrai vederne il contenuto.

• Photo: Field contains a filename for a picture. The width and height of the field can be defined.

• Intervallo: ti permette di impostare dei valori di un preciso intervallo numerico. Il widget può apparire
come un cursore o come un campo modificabile.

• Riferimento della relazione: questo widget ti consente di incorporare il modulo della geometria del layer
di riferimento nel modulo della geometria del layer attivo. Vedi Creare una relazione uno a molti o molti a
molti.

• Modifica testo (impostazione predefinita): consente di aprire un campo di modifica del testo che consente
di utilizzare testi semplici testi o a più righe. Se scegli più righe puoi anche scegliere contenuto html.

• Valori univoci: puoi selezionare uno dei valori già utilizzati nella tabella degli attributi. Se è attivato
‘Modifica’, viene visualizzata una scelta in linea con il supporto di autocompletamento, altrimenti viene
visualizzato un menu a tendina.

• UUID Generator: Generates a read-only UUID (Universally Unique Identifiers) field, if empty.
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• Mappa valore: un menu a tendina con elementi predefiniti. Il valore viene memorizzato nell’attributo, la
descrizione viene visualizzata nel menu a tendina. Puoi definire i valori manualmente oppure caricarli da
un layer o da un file CSV.

• Value Relation: Offers values from a related table in a combobox. You can select layer, key column and
value column. Several options are available to change the standard behaviours: allow null value, order by
value, allow multiple selections and use of autocompleter. The forms will display either a drop-down list or
a line edit field when completer checkbox is enabled.

• Web View: Field contains a URL. The width and height of the field is variable.

Suggerimento: Relative Path in widgets
If the path which is selected with the file browser is located in the same directory as the .qgs project file or below,
paths are converted to relative paths. This increases portability of a .qgs project with multimedia information
attached. This is enabled only for File Name, Photo and Web View at this moment.

Customize a form for your data

By default, when you click on a feature with the Identify Features tool or switch the attribute table to the form view
mode, QGIS displays a form with tabulated textboxes (one per field). This rendering is the result of the default
Autogenerate value of the Layer properties → Fields → Attribute editor layout setting. Thanks to the widget
setting, you can improve this dialog.

You can furthermore define built-in forms (see figure_fields_form), e.g. when you have objects with many at-
tributes, you can create an editor with several tabs and named groups to present the attribute fields.

Figure 12.41: Modulo personalizzato con schede e gruppi distinti

Editore clicca e trascina

Choose Drag and drop designer from the Attribute editor layout combobox to layout the features form
within QGIS. Then, drag and drop rows from the Fields frame to the Label panel to have fields added to your
custom form.
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You can also use categories (tab or group frames) to better structure the form. The first step is to use the icon
to create a tab in which fields and groups will be displayed (see figure_fields_layout). You can create as many

categories as you want. The next step will be to assign to each category the relevant fields, using the icon.
You’d need to select the targeted category beforehand. You can use the same fields many times.

Figure 12.42: Finestra di dialogo per creare categorie con la maschera di inserimento

Puoi configurare schede o gruppi con un doppio clic. QGIS apre un modulo in cui puoi:

• choose to hide or show the item label

• rename the category

• set over how many columns the fields under the category should be distributed

• enter an expression to control the category visibility. The expression will be re-evaluated everytime values
in the form change and the tab or groupbox shown/hidden accordingly.

• show the category as a group box (only available for tabs)

Con un doppio clic su un’etichetta di campo, puoi anche specificare se l’etichetta del suo widget deve essere
visibile o meno nel modulo.

In case the layer is involved in one to many relations (see Creare una relazione uno a molti o molti a
molti), referencing layers are listed in the Relations frame and their form can be embedded in the current layer
form by drag-and-drop. Like the other items, double-click the relation label to configure some options:

• choose to hide or show the item label

• show the link button

• show the unlink button

Provide an ui-file

L’opzione Fornisci ui-file ti permette di usare finestre di dialogo complesse fatte con Qt-Designer.
L’utilizzo di un file UI consente una grande libertà nella creazione di una finestra di dialogo. Si noti che, per
collegare gli oggetti grafici (casella di testo, casella combinata ...) ai campi del livello, è necessario assegnare loro
lo stesso nome.
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Usa Modifica UI per definire il percorso del file da utilizzare.

You’ll find some example in the Creating a new form lesson of the QGIS-training-manual-index-reference.
For more advanced information, see http://nathanw.net/2011/09/05/qgis-tips-custom-feature-forms-with-python-
logic/.

Migliora il tuo modulo con funzioni personalizzate

I moduli QGIS possono avere una funzione Python chiamata quando viene aperta la finestra di dialogo. Usa questa
funzione per aggiungere ulteriori comandi alle tue finestre di dialogo. Il codice del modulo può essere specificato
in tre modi diversi:

• carica dall’ambiente: usa una funzione, ad esempio in: file: startup.py o da un plugin installato)

• carica da un file esterno: in questo caso verrà visualizzato un selezionatore di fileper consen-
tire all’utente di selezionare un file Python dal proprio filesystem

• Fornisci il codice in questa finestra: apparirà un editor Python dove puoi digitare diret-
tamente la funzione da usare.

In tutti i casi devi inserire il nome della funzione che verrà chiamata (apri nell’esempio sotto).

Un esempio è (nel modulo MyForms.py):

def open(dialog,layer,feature):
geom = feature.geometry()
control = dialog.findChild(QWidged,"My line edit")

Riferimento in Python Init Function in questo modo: open

12.2.5 Scheda Join

La scheda Joins ti consente di unire una tabella di attributi a un layer vettoriale. Dopo aver cliccato su ,
viene visualizzata la finestra Aggiungi vettore da unire (join). Come colonne chiave, devi definire un layer da
unire (join) da connettere con il layer vettoriale. Quindi, devi specificare il campo join che è comune sia al layer
di unire e al layer destinazione. Ora puoi anche specificare un sottoinsieme di campi dal layer di join in base alla
casella seleziona i campi per l’unione. Come risultato del join, tutte le informazioni dal layer di join e del layer
di destinazione vengono visualizzate nella tabella degli attributi del vettore di destinazione come informazioni
aggiunte. Se hai specificato un sottoinsieme di campi solo questi campi vengono visualizzati nella tabella degli
attributi del layer di destinazione.

QGIS attualmente supporta anche join di tabelle non spaziali supportate da OGR (come CSV, DBF e EXcel), le di
testo delimitato e fonti dati di PostgreSQL (vedi figure_joins).

Inoltre, la finestra di dialogo aggiungi vettore da unire ti permette di:

• Cache join layer in virtual memory

• Crea un indice nel campo unito

• Seleziona i campi per l’unione

• Crea un Prefisso del nome del campo personalizzato

12.2.6 Proprietà Diagrammi

La scheda Diagrammi ti consente di aggiungere una sovrapposizione grafica a un layer vettoriale (vedi
figure_diagrams_attributes).
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Figure 12.43: Unisci una tabella di attributi ad un layer vettoriale

Attualmente le tipologie di diagrammi supportati sono:

• pie charts, a circular statistical graphic divided into slices to illustrate numerical proportion. The arc length
of each slice is proportional to the quantity it represents,

• text diagrams, a horizontaly divided circle showing statistics values inside

• and histograms.

Suggerimento: Passare rapidamente tra tipi di diagrammi
Dato che le impostazioni sono quasi comuni ai diversi tipi di diagrammi, nella progettazione del diagramma è
possibile modificare facilmente il tipo di diagramma e verificare quale è più appropriato ai tuoi dati senza perdita
delle impostazioni e dei dati.

Per ogni tipo di diagramma, le proprietà sono suddivise in più schede:

• Attributes

• Appearance

• Size

• Placement

• Options

• Legend

Attributi

Attributi definisce quali variabili da visualizzare nel diagramma. Utilizza il pulsante Aggiungi elemento per se-
lezionare i campi desiderati nel pannello “Attributi assegnati”. Possono essere utilizzati anche gli attributi generati
con le Espressioni.

Puoi spostarsi su e giù in qualsiasi riga con il click e trascinare, ordinando come vengono visualizzati gli at-
tributi. Puoi inoltre modificare l’etichetta nella colonna “Legenda” o nel colore dell’attributo facendo doppio clic
sull’elemento.

12.2. Proprietà dei vettori 163



QGIS User Guide, Release 2.18

This label is the default text displayed in the legend of the print composer or of the layer tree.

Figure 12.44: Proprietà Diagrammi – Scheda Attributi

Appearance

Appearance defines how the diagram looks like. It provides general settings that do not interfere with the statistic
values such as:

• the graphic transparency, its outline width and color

• the width of the bar in case of histogram

• the circle background color in case of text diagram, and the font used for texts

• l’orientamento della linea sinistra della prima fetta rappresentata nel grafico a torta. Si noti che le fette sono
visualizzate in senso orario.

In this tab, you can also manage the diagram visibility:

• by removing diagrams that overlap others or Show all diagrams even if they overlap each other

• by selecting a field with Data defined visibility to precisely tune which diagrams should be rendered

• by setting the scale visibility

Dimensione

Size is the main tab to set how the selected statistics are represented. The diagram size units can be ‘Map Units’
or ‘Millimeters’. You can use :

• Dimensione fissa, una dimensione unica per rappresentare l’immagine di tutti gli elementi, ad eccezione
della visualizzazione di istogrammi

• o Dimensione scalata, basata su un’espressione che utilizza gli attributi del layer.
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Figure 12.45: Diagram properties - Appearance tab

Figure 12.46: Proprietà Diagrammi – Scheda Dimensione
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Posizionamento

Posizionamento aiuta a disegnare la posizione del diagramma. Secondo il tipo di geometria del layer, offre diverse
opzioni per il posizionamento:

• ‘Sopra il punto’ o ‘Intorno al punto’ per la geometria puntuale. Quest’ultima variabile richiede
l’assegnazione di una distanza.

• ‘Sopra la linea’ o ‘Intorno alla linea’ per la geometria lineare. Come per la geometria punto, l’ultima vari-
abile richiede una distanza da rispettare e l’utente può specificare il posizionamento del diagramma relativo
alla funzione (‘sopra’, ‘su’ e / o ‘sotto’ la linea) È possibile selezionare più opzioni contemporaneamente.
In questo caso, QGIS cercherà la posizione ottimale del diagramma. Ricorda che qui puoi anche utilizzare
l’orientamento della linea per la posizione del diagramma.

• ‘Sopra il centroide’, ‘Sopra al centroide’ (con una impostazione di distanza), ‘Perimetro’ e comunque ‘Den-
tro il poligono’ sono le opzioni per le geometrie poligonali.

The diagram can also be placed using feature data by filling the X and Y fields with an attribute of the feature.

The placement of the diagrams can interact with the labeling, so you can detect and solve position conflicts
between diagrams and labels by setting the Priority slider or the z-index value.

Figure 12.47: Finestra di dialogo proprietà vettori con Proprietà Diagrammi, Scheda Posizionamento

Opzioni

La scheda Opzioni ha impostazioni solo in caso di istogramma. Puoi scegliere se l’orientamento della barra sia
‘Su’, ‘Giù’, ‘Destra’ e ‘Sinistra’.

Legenda

From the Legend tab, you can choose to display items of the diagram in the Pannello dei Layer, besides the layer
symbology. It can be:

• the represented attributes: color and legend text set in Attributes tab

• and if applicable, the diagram size, whose symbol you can customize.

When set, the diagram legend items are also available in the print composer legend, besides the layer symbology.

Argomenti di studio

Mostreremo un esempio mostrando una sovrapposizioni di un layer vettoriale dei dati climatici di temperatura
sul layer del confine Alaska. Entrambi i layers vettoriali fanno parte del set di dati del campione QGIS (vedi la
sezione Sample Data).
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1. Innanzitutto, fai clic sull’icona Aggiungi Vettore, esegui la ricerca nella cartella dei dataset di esempio di
QGIS e carica i due layers vettoriali in formato shapefile alaska.shp e climate.shp.

2. Fai doppio click sul vettore climate nella legenda per aprire la finestra di dialogo Proprietà layer.

3. Fai click sulla scheda Diagrammi e dalla casella combinata di scelta del Tipo Diagramma seleziona
“Diagramma testo”.

4. Nella scheda Aspetto scegli un blu chiaro come colore di sfondo e nella scheda Dimensione imposta 18 mm
come dimensione fissa.

5. Nella scheda Posizione scegli ‘Intorno al punto’ come posizionamento.

6. Nel diagramma, vogliamo visualizzare i valori delle tre colonne T_F_JAN, T_F_JUL e T_F_MEAN.

Quindi, nella scheda Attributi, prima seleziona T_F_JAN e fai click sul pulsante quindi ripeti con
T_F_JUL e infine T_F_MEAN.

7. Now click [Apply] to display the diagram in the QGIS main window.

8. Puoi adattare la dimensione del grafico nella scheda Dimensioni. Attiva Dimensione scalata e imposta la
dimensione dei diagrammi in base al Valore massimo di un attributo e l’opzione Dimensioni. Se i diagrammi

appaiono troppo piccoli sullo schermo, puoi attivare la casella di controllo Aumenta la dimensione dei
diagrammi piccoli e definire la dimensione minima dei diagrammi.

9. Modifica i colori degli attributi facendo doppio click sui valori di colore nel campo ‘Attributi assegnati.
Figure_diagrams_mapped dà un’idea del risultato.

10. Finally, click [Ok].

Figure 12.48: Diagrammi di temperatura sovrapposti su una mappa

Ricordati che puoi usare anche l’opzione Posizione definita da attributo per posizionare i diagrammi. Inoltre puoi
anche impostare la visibilità dei diagrammi in funzione di determinate scale dalla scheda Aspetto.

La dimensione e gli attributi possono anche essere un’espressione. Utilizza il pulsante per aggiungere
un’espressione. Per ulteriori informazioni ed esempi vedi il capitolo Espressioni.

Utilizzo di sovrascrittura definita dei dati

Come ricordato sopra, puoi utilizzare alcuni modi di definizione dati per affinare la visualizzazione dei diagrammi:

• posizione tramite il riempimento dei campi X e Y nella scheda Posizionamento

• visibilità nella scheda Aspetto tramite il riempimento del campo Visibilità
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Vedi Etichettare in funzione dei dati per maggiori informazioni.

12.2.7 Proprietà Azioni

QGIS ti offre la possibilità di creare azioni sulla base degli attributi associati ai singoli elementi del vettore.
Potrai cosi creare un grande numero di azioni, per esempio, avviare un programma con argomenti come gli attributi
di un vettore o inviare parametria una applicazione di rete.

Figure 12.49: Panoramica della finestra di dialogo Azioni con esempi

Le azioni sono utili quando vuoi avviare un’applicazione esterna oppure aprire una pagina web sulla base di uno
o più valori associati al vettore. Ci sono sei tipologie di azioni che puoi usare nel seguente modo:

• Le azioni Generic, Mac, Windows e Unix avviano un processo esterno.

• Le azioni python eseguono un’espressione python,

• Le azioni generic e python sono visibili ovunque.

• Le azioni Mac, Windows e Unix sono visibili solo sulle rispettive piattaforme (cioè puoi definire le azioni,
ma sarai in grado di vedere i risultati solamente sulla piattaforma dalla quale è stato lanciato l’editor).

There are several examples included in the dialog. You can load them by clicking on [Create default actions].
To edit any of the examples, double-click its row. One example is performing a search based on an attribute value.
This concept is used in the following discussion.

Definire le azioni

Per definire un’azione di attributo, apri la finestra di dialogo Proprietà e fai click sulla scheda Azioni. Nella scheda

Azioni fai click su Aggiunge una nuova azione per aprire la finestra di dialogo Aggiunge nuova azione.

Seleziona Tipo e fornisci un nome descrittivo per l’azione. L’azione stessa deve contenere il nome
dell’applicazione che verrà eseguita quando viene richiamata l’azione. Puoi aggiungere uno o più valori del
campo attributo come argomenti all’applicazione. Quando viene richiamata l’azione, qualsiasi gruppo di caratteri
che inizia con un % seguito dal nome di un campo verrà sostituito dal valore di quel campo. I caratteri speciali
%% verranno sostituiti dal valore del campo selezionato dalla opzione di identificazione dei risultati o dalle tabella
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attributi (vedi using_actions_below). Le virgolette doppie possono essere utilizzate per raggruppare il testo come
un unico argomento al programma, allo script o al comando. Le virgolette doppie saranno ignorate se precedute
dal carattere .

Se sono presenti nomi di campi che possono essere interpretati come sotto-stringhe di altri nomi di campi (ad
es. col1 e col10) devi racchiudere il nome (e il carattere %) tra parentesi quadre (es. [%col10]). Questo
impedirà che il nome di campo %col10 possa essere confuso con %col1 con uno 0 alla fine. Le virgolette
saranno rimosse da QGIS man mano che inserirai i valori del campo. Se vuoi che i campi sostituiti vengano
racchiusi entro parentesi quadre, aggiungi una seconda coppia di parentesi quadre: [[%col10]].

La finestra di dialogo Informazione sui risultati che compare quando usi lo strumento Informazioni elementi ha una
voce (Derivato) che contiene informazioni che dipendono dal tipo di vettore interrogato. Puoi accedere ai valori
di questa voce in modo simile a come accedi ad altri campi della tabella attributi anteponendo al nome del campo
(Derivato). Per esempio un vettore di punti ha due campi, X e Y, e puoi usare il loro valore nell’azione con
l’espressione %(Derivato).X e %(Derivato).Y. Gli attributi derivati sono disponibili solo nella finestra
Informazione sui risultati e non nella finestra Tabella degli attributi.

Due esempi di azioni sono di seguito mostrati:

• konqueror http://www.google.com/search?q=%nam

• konqueror http://www.google.com/search?q=%%

In the first example, the web browser konqueror is invoked and passed a URL to open. The URL performs a
Google search on the value of the nam field from our vector layer. Note that the application or script called
by the action must be in the path, or you must provide the full path. To be certain, we could rewrite the first
example as: /opt/kde3/bin/konqueror http://www.google.com/search?q=%nam. This will
ensure that the konqueror application will be executed when the action is invoked.

Nel secondo esempio viene usata la notazione %% che non si basa su un particolare campo per il suo valore.
Quando richiami l’azione, il %% sarà rimpiazzato dal valore del campo selezionato nella finestra Informazioni
risultati o nella tabella degli attributi.

Uso delle azioni

Actions can be invoked from either the Identify Results dialog, an Attribute Table dialog or from Run Fea-

ture Action (recall that these dialogs can be opened by clicking Identify Features or Open Attribute Table or
Run Feature Action). To invoke an action, right click on the feature and choose the action from the pop-up menu (they
should have been enabled to be displayed in the attribute table). Actions are listed in the popup menu by the name
you assigned when defining the action. Click on the action you wish to invoke.

Se stai richiamando un’azione che usa l’annotazione %%, fai click con il tasto destro sul valore del campo nella
finestra Informazioni risultati oppure dalla finestra Tabella attributi e scegli l’applicazione o lo script da assegnare.

In questo altro esempio viene mostrato come estrarre dati da un vettore per inserirli in un file usando il terminale e

il comando echo (quindi funzionerà su e forse su ). Il vettore in questione ha i seguenti campi nella tabella
attributi: nome della specie taxon_name, latitudine lat e longitudine long. Vuoi eseguire una selezione
spaziale delle specie (taxon) presenti in determinate posizioni, esportando i risultati in un file di testo (evidenziate
in giallo sulla mappa di QGIS). Ecco l’azione giusta per questo scopo:

bash -c "echo \"%taxon_name %lat %long\" >> /tmp/species_localities.txt"

Selezionando solo alcune posizioni, l’esecuzione dell’azione precedente genera un file di output fatto così:

Acacia mearnsii -34.0800000000 150.0800000000
Acacia mearnsii -34.9000000000 150.1200000000
Acacia mearnsii -35.2200000000 149.9300000000
Acacia mearnsii -32.2700000000 150.4100000000

As an exercise, we can create an action that does a Google search on the lakes layer. First, we need to determine
the URL required to perform a search on a keyword. This is easily done by just going to Google and doing a
simple search, then grabbing the URL from the address bar in your browser. From this little effort, we see that the
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format is http://google.com/search?q=qgis, where QGIS is the search term. Armed with this information, we can
proceed:

1. Assicurarti di aver caricato il vettore lakes.

2. Apri la finestra di dialogo Proprietà layer facendo doppio click sul vettore o cliccandoci sopra con il tasto
destro del mouse e scegliendo Proprietà dal menu contestuale.

3. Click sulla scheda Actions.

4. click Add a new action.

5. Inserisci un nome descrittivo per l’azione, ad esempio Ricerca Google.

6. Devi fornire il nome del programma esterno, in questo caso Firefox. Se il programma non è presente nel
tuo path, devi inserire il path assoluto.

7. Following the name of the external application, add the URL used for doing a Google search, up to but not
including the search term: http://google.com/search?q=

8. The text in the Action field should now look like this: firefox http://google.com/search?q=

9. Click on the drop-down box containing the field names for the lakes layer. It’s located just to the left of
the [Insert] button.

10. From the drop-down box, select ‘NAMES’ and click [Insert].

11. Il testo dell’azione dovrebbe ora apparire come segue:

firefox http://google.com/search?q=%NAMES

12. To finalize and add the action, click the [OK] button.

Figure 12.50: Esempio finestra di dialogo di definizione di un azione

Questo ultimo passo completa l’azione che è ora pronta per essere usata. Il testo finale dell’azione dovrebbe
apparire così:

firefox http://google.com/search?q=%NAMES
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A questo punto puoi usare l’azione. Chiudi la finestra Proprietà layer e usa lo zoom su un’area a scelta. Assicurati
che il vettore lakes sia attivo ed identifica con l’apposito strumento un lago qualsiasi. Nella finestra risultante
dovrebbe essere visibile l’azione:

Figure 12.51: Seleziona un elemento e scegli un’azione

When we click on the action, it brings up Firefox and navigates to the URL
http://www.google.com/search?q=Tustumena. It is also possible to add further attribute fields to the ac-
tion. Therefore, you can add a + to the end of the action text, select another field and click on [Insert Field]. In
this example, there is just no other field available that would make sense to search for.

Puoi definire più di un’azione per ogni vettore, ognuna delle quali verrà mostrata nella finestra di dialogo Infor-
mazioni sui risultati.

Puoi anche richiamare le azioni dalla tabella degli attributi selezionando una riga e cliccando col tasto destro,
allora puoi scegliere un’azione dal menu a tendina.

Puoi creare tantissimi tipi di azione. Per esempio se hai un vettore di punti che fa riferimento alle posizioni
dove sono state scattate foto o immagini, insieme al nome stesso del file, puoi creare un’azione per avviare un
programma che visualizzerà l’immagine. Puoi usare le azioni anche per lanciare report sul web per uno o più
campi della tabella degli attributi, definendole allo stesso modo dell’esempio per la ricerca con Google.

Ci sono esempi anche molto più complicati, per esempio usando le azioni Python.

Usually, when we create an action to open a file with an external application, we can use absolute paths, or
eventually relative paths. In the second case, the path is relative to the location of the external program executable
file. But what about if we need to use relative paths, relative to the selected layer (a file-based one, like a shapefile
or SpatiaLite)? The following code will do the trick:

command = "firefox"
imagerelpath = "images_test/test_image.jpg"
layer = qgis.utils.iface.activeLayer()
import os.path
layerpath = layer.source() if layer.providerType() == ’ogr’

else (qgis.core.QgsDataSourceURI(layer.source()).database()
if layer.providerType() == ’spatialite’ else None)

path = os.path.dirname(str(layerpath))
image = os.path.join(path,imagerelpath)
import subprocess
subprocess.Popen( [command, image ] )

Ricordati che l’azione è del tipo Python, quindi devi cambiare le variabili command e imagerelpath.

E se il percorso relativo deve essere relativo al file di progetto (salvato)? Il codice per l’azione Python diventa:
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command = "firefox"
imagerelpath = "images/test_image.jpg"
projectpath = qgis.core.QgsProject.instance().fileName()
import os.path
path = os.path.dirname(str(projectpath)) if projectpath != ’’ else None
image = os.path.join(path, imagerelpath)
import subprocess
subprocess.Popen( [command, image ] )

Un altro esempio di azione python è quello che ti permette di aggiungere nuovi layer al progetto. In questo esempio
aggiungeremo sia un vettore che un raster. Il nome dei file da aggiungere al progetto e il nome da assegnare ai
layer è specificato dai dati (filename e layname sono nomi di colonne della tabella dagli attributi del vettore dove
l’azione è stata creata):

qgis.utils.iface.addVectorLayer(’/yourpath/[% "filename" %].shp’,
’[% "layername" %]’, ’ogr’)

Per aggiungere un raster (in questo caso un’immagine TIF), diventa:

qgis.utils.iface.addRasterLayer(’/yourpath/[% "filename" %].tif’,
’[% "layername" %]’)

12.2.8 Scheda Suggerimenti

This tab is specifically created for map tips: display a message in the map canvas when hovering over a feature
of the active layer. This message can either be the value of a Field or a more complex and full HTML text
mixing fields, expressions and html tags (multiline, fonts, images, hyperlink ...).

To activate Map Tips, select the menu option View → Map Tips or click on the Map Tips icon. Map tip is a
cross-session feature meaning that once activated, it stays on and apply to any set layer in any project, even in
future QGIS sessions until it’s toggled off.

Figures Display Code and Mapped show an example of HTML code and how it behaves in map canvas.

Figure 12.52: Codice HTML per suggerimento mappa

12.2.9 Scheda Visualizzazione

QGIS offers support for on-the-fly feature generalisation. This can improve rendering times when drawing

many complex features at small scales. This feature can be enabled or disabled in the layer settings using the
Simplify geometry option. There is also a global setting that enables generalisation by default for newly added
layers (see global simplification for more information).
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Figure 12.53: Suggerimento mappa realizzato con codice HTML

Figure 12.54: Finestra di dialogo vettore Semplifica geometrie
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Nota: La generalizzazione delle geometrie può in alcuni casi presentare artefatti nel tuo output di visualizzazione.
Questi possono includere slivers tra poligoni e visualizzazioni imprecise quando si utilizzano layers di simboli
basati su offset.

While rendering extremely detailed layers (e.g. polygon layers with a huge number of nodes), this can cause
composer exports in PDF/SVG format to be huge as all nodes are included in the exported file. This can also make
the resultant file very slow to work with/open in other programs.

Con l’opzione Forza la visualizzazione del vettore come raster si impone per questi layer una rasterizzazione
in modo che i file esportati non dovranno includere tutti i nodi contenuti in questi layers e quindi rendere più
rapida la visualizzazione.

You can also do this by forcing the composer to export as a raster, but that is an all-or-nothing solution, given that
the rasterisation is applied to all layers.

12.2.10 Scheda Metadati

The Metadata tab consists of Description, Attribution, MetadataURL, LegendUrl and Properties sections.

In the Properties section, you get general information about the layer, including specifics about the type and loca-
tion, number of features, feature type, and editing capabilities. The Extents table provides you with information
on the layer extent and the Layer Spatial Reference System, which is information about the CRS of the layer. This
can provide a quick way to get useful information about the layer.

Additionally, you can add or edit a title and abstract for the layer in the Description section. It’s also possible to
define a Keyword list here. These keyword lists can be used in a metadata catalog. If you want to use a title from
an XML metadata file, you have to fill in a link in the DataUrl field.

Utilizza Attribuzione per ottenere i dati di attributo da un catalogo di metadati in formato XML.

In URL Metadati, puoi definire il percorso generale del catalogo metadati XML. Queste informazioni verranno
salvate nel file di progetto QGIS per le sessioni successive e verranno utilizzate per il server QGIS.

Nella sezione LegendUrl puoi fornire l’URL di un’immagine per la legenda nel campo URL. È possibile utilizzare
le opzioni del menu a discesa su Formato per applicare il formato appropriato dell’immagine. Attualmente sono
supportati i formati di immagine png, jpg e jpeg.

Suggerimento: Scorri rapidamente tra le diverse rappresentazioni del layer
Using the Styles → Add combobox at the bottom of the Layer Properties dialog, you can save as many combi-
nations of layer properties settings (symbology, labeling, diagram, fields form, actions...) as you want. Then,
simply switch between styles from the context menu of the layer in Layers Panel to automatically get different
representations of your data.

12.2.11 Scheda Variabili

La scheda Variabili elenca tutte le variabili disponibili a livello di layer (che include tutte le variabili globali
e di progetto).

Consente inoltre all’utente di gestire le variabili a livello di layer. Fai click sul pulsante per aggiungere
una nuova variabile a livello di layer personalizzato. Allo stesso modo, seleziona una variabile a livello di layer

personalizzato dall’elenco e fai click sul pulsante per rimuoverla.

Ulteriori informazioni sull’utilizzo delle variabili nella sezione Variables.
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Figure 12.55: Metadata tab in vector layers properties dialog

12.2.12 Scheda Legenda

The Legend tab provides you with a list of widgets you can embed within the layer tree in the Layers panel.
The idea is to have a way to quickly access some actions that are often used with the layer (setup transparency,
filtering, selection, style or other stuff...).

Per impostazione predefinita, QGIS fornisce widget di trasparenza, ma questo può essere esteso da plugin che
registrano i propri widget e assegnano azioni personalizzate ai layers che gestiscono.

12.3 Espressioni

Based on layer data and prebuilt or user defined functions, Expressions offer a powerful way to manipulate
attribute value, geometry and variables in order to dynamically change the geometry style, the content or position
of the label, the value for diagram, the height of a composer item, select some features, create virtual field ...

12.3.1 Il Calcolatore di campi

La finestra di dialogo principale per la creazione di espressioni Calcolatore di campi è disponibile da molte parti
in QGIS e, in particolare, puoi accederci:

• facendo click sul pulsante ;

• selecting features con lo strumento Seleziona con espressione...;

• Modifica attributi per esempio con il Calcolatore di campi ;

• manipulating symbology, label or composer item parameters with the Data defined override tool (see Im-
postazione Sovrascrittura definita dai dati);

• nel costruire geometry generator un layer di simboli;

• nell’attivare alcuni geoprocessing.
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Le finestre di dialogo del Costruttore di Espressioni offrono l’accesso a:

• Expression tab che, grazie ad un elenco di funzioni predefinite, aiuta a scrivere e controllare l’espressione
da utilizzare;

• Function Editor tab delle funzioni che consente di ampliare l’elenco delle funzioni creando quelle person-
alizzate.

Alcuni casi d’uso di espressioni:

• Dal Calcolatore Campo, calcolare un campo “pop_density” utilizzando i campi esistenti “total_pop” e
“area_km2”:

"total_pop" / "area_km2"

• Aggiornare il campo “density_level” con le categorie in base ai valori “pop_density”:

CASE WHEN "pop_density" < 50 THEN ’Low population density’
WHEN "pop_density" >= 50 and "pop_density" < 150 THEN ’Medium population density’
WHEN "pop_density" >= 150 THEN ’High population density’

END

• Applicare uno stile categorizzato a tutte le geometrie in base al fatto che il prezzo medio della casa sia più
piccolo o superiore a 10000C per metro quadrato:

"price_m2" > 10000

• Utilizzando lo strumento “Seleziona per espressione ...”, selezionare tutte le geometrie che rappresentano
aree di “Alta densità di popolazione” e il cui prezzo medio di casa è superiore a 10000C per metro quadrato:

"density_level" = ’High population density’ and "price_m2" > 10000

Allo stesso modo, l’espressione precedente potrebbe anche essere utilizzata per definire quali geometrie
dovrebbero essere etichettate o mostrate nella mappa.

L’uso delle espressioni offre molte possibilità.

Suggerimento: Utilizzare parametri specifici per migliorare la lettura dell’espressione
Alcune funzioni richiedono che siano impostati molti parametri. Il motore di espressione supporta l’utilizzo di
parametri denominati. Ciò significa che, invece di scrivere l’espressione criptica clamp( 1, 2, 9), puoi us-
are clamp( min:=1, value:=2, max:=9). Ciò consente inoltre l’inserimento di argomenti, ad esempio
clamp( value:=2, max:=9, min:=1). L’utilizzo di parametri denominati aiuta a chiarire quali sono gli
argomenti di una funzione espressione, utile quando si tenta di interpretare un’espressione in una data successiva!

12.3.2 Lista delle funzioni

The Expression tab provides the main interface to write expressions using functions, layer’s fields and values. It
contains widgets to:

• type expressions using functions and/or fields. At the bottom of the dialog, is displayed the result of the
expression evaluated on the first feature of the layer.

• select the appropriate function among a list, organized in groups. A search box is available to filter the list
and quickly find a particular function or field. Double-clicking on the item’s name adds it to the expression
being written.

• display help for each function selected. When a field is selected, this widget shows a sample of its values.
Double-clicking a value adds it to the expression.
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Figure 12.56: La scheda Espressioni

Operatori

Questo gruppo contiene operatori (e.g., +, -, *). Si noti che per la maggior parte delle funzioni matematiche di
seguito se uno dei input è NULL il risultato è NULL.
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Funzioni Descrizione
a + b Somma di due valori (a più b)
a - b Sottrazione tra due valori (a meno b).
a * b Moltiplicazione tra due valori (a moltiplicato per b)
a / b Divisione tra due valori (a diviso per b)
a % b Resto della divisione di a diviso b (ad esempio, 7 % 2 = 1 o 2 si entra nel 7 tre volte con il

resto di 1)
a ^ b Elevazione a potenza di due valori (ad esempio, 2^2=4 o 2^3=8)
a < b Confronta due valori e restituisce 1 se il valore di sinistra è inferiore al valore di destra (a è

minore di b)
a <= b Confronta due valori e restituisce 1 se il valore di sinistra è minore o uguale al valore di

destra
a <> b Confronta due valori e restituisce 1 se non sono uguali
a = b Confronta due valori e restituisce 1 se sono uguali
a ! = b a e b non sono uguali
a > b Confronta due valori e restituisce 1 se il valore di sinistra è maggiore del valore di destra (a

è maggiore di b)
a >= b Confronta due valori e restituisce 1 se il valore di sinistra è maggiore o uguale al valore di

destra
a ~ b a corrisponde al valore assoluto di b
|| Unisce insieme due valori in una stringa. Se uno dei valori è NULL, il risultato sarà NULL
‘\n’ Inserisce una nuova riga in una stringa
LIKE Restituisce 1 se il primo parametro corrisponde al filtro scelto
ILIKE Restituisce 1 se il primo parametro corrisponde senza distinzione tra maiuscole e

minuscole al filtro scelto (ILIKE può essere usato al posto di LIKE per rendere la
corrispondenza senza distinzione tra maiuscole e minuscole)

a IS b Verifica se due valori sono identici. Restituisce 1 se a è uguale a b
a OR b Restituisce 1 quando la condizione a o la condizione b è vera
a AND b Restituisce 1 quando le condizioni a e b sono vere
NOT Inverte una condizione
column name
“column name”

Valore del nome della colonna del campo, fare attenzione a non essere confuso con i
semplici apici, vedi sotto

‘string’ valore stringa, fare attenzione a non essere confuso gli apici doppi, vedi sopra
NULL valore nullo
a IS NULL a ha valore nullo
a IS NOT
NULL

a contiene un valore

a IN
(value[,value])

a ha valore contenuto nei valori in lista

a NOT IN
(value[,value])

il valore di a non è tra i valori in lista

Nota: Informazioni sulla concatenazione dei campi
Puoi concatenare le stringhe utilizzando o || o +. Quest’ultimo ha anche il significato di somma. Quindi, se
si dispone di un numero intero (campo o valore numerico) questo può essere causa di errore. In questo caso, si
dovrebbe usare ||. Se concatenate due valori di stringa, è possibile utilizzare entrambi.

Alcuni esempi:

• Unire una stringa e un valore da un nome di colonna:

’My feature’’s id is: ’ || "gid"
’My feature’’s id is: ’ + "gid" => triggers an error as gid is an integer
"country_name" + ’(’ + "country_code" + ’)’
"country_name" || ’(’ || "country_code" || ’)’

• Testare se il campo di attributo “descrizione” inizia con la stringa “Hello” (notare la posizione del carattere
%):
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"description" LIKE ’Hello%’

Conditionals

Questo gruppo contiene funzioni per eseguire controlli condizionali nelle espressioni.

Funzioni Descrizione
CASE WHEN ... THEN ...
END

Valuta un’espressione e restituisce un risultato se è vera. Puoi testare più
condizioni

CASE WHEN ... THEN ...
ELSE ... END

Valuta un’espressione e restituisce un risultato diverso secondo se è vera o
falsa. Puoi testare più condizioni

coalesce Restituisce il primo valore non NULL dall’elenco in espressione
if Verifica una condizione e restituisce un risultato diverso a seconda della

verifica della condizione
regexp_match Returns true if any part of a string matches the supplied regular expression

Alcuni esempi

• Restituisce un valore se la prima condizione è vera, altrimenti un altro valore

CASE WHEN "software" LIKE ’%QGIS%’ THEN ’QGIS’ ELSE ’Other’ END

Funzioni Matematiche

Questo gruppo contiene funzioni matematiche (ad es. Radice quadrata, seno e coseno).
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Funzioni Descrizione
abs Restituisce il valore assoluto di un numero
acos Restituisce l’arcocoseno di un valore in radianti
asin Restituisce l’arcoseno di un valore in radianti
atan Returns the inverse tangent of a value in radians
atan2(y,x) Returns the inverse tangent of y/x by using the signs of the two arguments to determine the

quadrant of the result
az-
imuth(a,b)

Restituisce l’azimut a nord come angolo in radianti misurato in senso orario dalla verticale sul
punto a al punto b

ceil Arrotonda un numero verso l’alto
clamp Limita un valore in ingresso a un intervallo specificato
cos Restituisce il coseno di un angolo in radianti
degrees Converte da radianti a gradi
exp Restituisce un valore esponenziale
floor Arrotonda un numero verso il basso
ln Restituisce il logaritmo naturale dell’espressione immessa
log Restituisce il valore del logaritmo immesso in una data base
log10 Restituisce il valore del logaritmo di base 10 dell’espressione immessa
max Returns the largest value in a set of values
min Returns the smallest value in a set of values
pi Restituisce il valore di pi greco per i calcoli
radians Converte da gradi a radianti
rand Restituisce il numero intero casuale nell’intervallo specificato dal parametro minimo e massimo

(incluso)
randf Restituisce il numero reale casuale all’interno dell’intervallo specificato dal parametro minimo e

massimo (incluso)
round Arrotonda al numero di cifre decimali
scale_exp Trasforma un determinato valore da un dominio di input a un intervallo di output utilizzando

una curva esponenziale
scale_linear Trasforma un determinato valore da un dominio di input a un intervallo di output utilizzando

l’interpolazione lineare
sin Restituisce il seno di un angolo in radianti
sqrt Restituisce la radice quadrata di un valore
tan Restituisce la tangente di un angolo

Funzioni di aggregazione

Questo gruppo contiene funzioni che aggregano valori su layers e campi

180 Chapter 12. Lavorare con i vettori



QGIS User Guide, Release 2.18

Funzioni Descrizione
aggregate Restituisce un valore aggregato calcolato utilizzando le geometrie di un altro layer
concatenate Restituisce tutte le stringhe aggregate da un campo o un’espressione unita da un delimitatore
count Restituisce il conteggio delle geometrie corrispondenti
count_distinct Restituisce il conteggio di valori distinti
count_missing Restituisce il conteggio di valori mancanti (nulli)
iqr Restituisce l’intervallo inter quartile calcolato da un campo o un’espressione
majority Restituisce la maggioranza aggregata di valori (il valore più comunemente presente) da un

campo o da un’espressione
max_length Restituisce la lunghezza massima delle stringhe da un campo o da un’espressione
maximum Restituisce il valore massimo aggregato da un campo o da un’espressione
mean Restituisce il valore medio aggregato da un campo o da un’espressione
median Restituisce il valore della mediana aggregato da un campo o da un’espressione
min_length Restituisce la lunghezza minima delle stringhe da un campo o da un’espressione
minimum Restituisce il valore minimo aggregato da un campo o da un’espressione
minority Restituisce la minoranza dei valori aggregata (valore che si verifica meno comunemente) da

un campo o da un’espressione
q1 Restituisce il primo quartile calcolato da un campo o da un’espressione
q3 Restituisce il terzo quartile calcolato da un campo o da un’espressione
range Restituisce l’intervallo di valori aggregato (massimo - minimo) da un campo o

un’espressione
rela-
tion_aggregate

Restituisce un valore aggregato calcolato utilizzando tutte le geometrie figlie corrispondenti
da una relazione sul layer

stdev Restituisce il valore della deviazione standard aggregato da un campo o da un’espressione
sum Restituisce il valore sommato aggregato da un campo o da un’espressione

Esempi:

• Restituisce il massimo del campo “Passeggeri” dalle geometrie nel layer raggruppato dal campo “sta-
tion_class” :

maximum("passengers", group_by:="station_class")

• Calcola il numero totale di passeggeri per le stazioni all’interno della geometria Atlante corrente:

aggregate(’rail_stations’,’sum’,"passengers",
intersects(@atlas_geometry, $geometry))

• Restituisce la media del campo “field_from_related_table” per tutte le geometrie figlio corrispondenti us-
ando la relazione ‘my_relation’ dal layer:

aggregate_relation(’my_relation’, ’mean’, "field_from_related_table")

oppure:

aggregate_relation(relation:=’my_relation’, calculation := ’mean’,
expression := "field_from_related_table")

Funzioni colore

Questo gruppo contiene funzioni per la manipolazione dei colori.
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Funzioni Descrizione
color_cmyk Restituisce una rappresentazione in formato stringa di un colore in base alle componenti ciano,

magenta, giallo e nero
color_cmykaRestituisce una rappresentazione in formato stringa di un colore in base ai componenti ciano,

magenta, giallo, nero e alfa (trasparenza)
color_hsl Restituisce una rappresentazione in formato stringa di un colore in base agli attributi di tonalità,

saturazione e luminosità
color_hsla Restituisce una rappresentazione in formato stringa di un colore in base agli attributi di tonalità,

saturazione, luminosità e alfa (trasparenza)
color_hsv Restituisce una rappresentazione in formato stringa di un colore in base agli attributi di tonalità,

saturazione e valore
color_hsva Restituisce una rappresentazione in formato stringa di un colore in base agli attributi di tonalità,

saturazione, valore e alfa (trasparenza)
color_part Restituisce un componente specifico da una stringa di colori, ad esempio il componente rosso o

il componente alfa
color_rgb Restituisce una rappresentazione in formato stringa di un colore in base alle componenti rosso,

verde e blu
color_rgba Restituisce una rappresentazione in formato stringa di un colore in base alle componenti rosso,

verde, blu e alfa (trasparenza)
darker Restituisce una stringa di colore più scuro (o più chiaro)
lighter Restituisce una stringa di colore più chiara (o più scura)
project_colorRestituisce un colore dalla combinazione dei colori del progetto
ramp_color Restituisce una stringa che rappresenta un colore da una scala di colori
set_color_partImposta un componente di colore specifico per una stringa di colore, ad esempio il componente

rosso o il componente alfa

Funzioni di conversione

Questo gruppo contiene funzioni per convertire un tipo di dati in un altro (ad esempio stringa su intero, intero su
stringa).

Funzioni Descrizione
to_date Converte una stringa in formato data
to_datetime Converte una stringa in formato datetime
to_int Converte una stringa in numero intero
to_interval Converte una stringa in un tipo di intervallo (può essere utilizzata per ricavare giorni, ore, mesi,

ecc. da un dato)
to_real Converte una stringa in un numero reale
to_string Converte numero in stringa
to_time Converte una stringa in un formato orario

Funzioni personalizzate

Questo gruppo contiene funzioni create dall’utente. Vedi Editor delle Funzioni per maggiori dettagli.

Funzioni di data e ora

Questo gruppo contiene funzioni per la gestione dei dati in formato data e ora.
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Funzioni Descrizione
age Restituisce come intervallo la differenza tra due date o datetime
day Estrae il giorno da una data o un datetime o il numero di giorni da un intervallo
day_of_week Restituisce un numero corrispondente al giorno della settimana per una data o un datetime

specificato
hour Estrae l’ora da un datetime o tempo, o il numero di ore da un intervallo
minute Estrae il minuto da un datetime o tempo, o il numero di minuti da un intervallo
month Estrae la parte del mese da una data o datetime o il numero di mesi da un intervallo
now Restituisce la data e l’ora correnti
second Estrae il secondo da un datetime o time, o il numero di secondi da un intervallo
week Estrae il numero della settimana da una data o datetime, o il numero di settimane da un

intervallo
year Estrae la parte dell’anno da una data o datetime o il numero di anni da un intervallo

Questo gruppo condivide anche diverse funzioni con i gruppi Funzioni di conversione (to_date, to_time,
to_datetime, to_interval) e Funzioni Stringa (format_date).

Alcuni esempi:

• Ricava il mese e l’anno di oggi nel formato “numero_mese/anno”:

format_date(now(),’MM/yyyy’)
-- Returns ’03/2017’

Oltre a queste funzioni, le differenze di data, i tempi o le ore che usano l’operatore ‘‘ -‘‘ (meno) restituiscono un
intervallo.

Aggiungendo o sottraendo un intervallo a date, datetime o tempi, usando gli operatori + (più) e - (meno), restitu-
isce un datetime.

• Fino alla versione di QGIS 3.0 dà il numero di giorni:

to_date(’2017-09-29’) - to_date(now())
-- Returns <interval: 203 days>

• Lo stesso con time:

to_datetime(’2017-09-29 12:00:00’) - to_datetime(now())
-- Returns <interval: 202.49 days>

• Ottieni il tempo di 100 giorni a partire da adesso:

now() + to_interval(’100 days’)
-- Returns <datetime: 2017-06-18 01:00:00>

Nota: Memorizzazione di formati data e di intervalli di tempo su campi
The ability to store date, time and datetime values directly on fields may depend on the data source’s provider (e.g.,
shapefiles accept date format, but not datetime or time format). The following are some suggestions to overcame
this limitation.

date, datetime e time possono essere memorizzati nei campi di tipo di testo dopo aver utilizzato la funzione
to_format().

intervals possono essere memorizzati in campi di numeri interi o decimali dopo aver utilizzato una delle funzioni
di estrazione della data (ad esempio, day() per ottenere l’intervallo espresso in giorni)

Campi e Valori

Contiene la lista dei campi di un layer.

Generally, you can use the various fields, values and functions to construct the calculation expression, or you can
just type it into the box.
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To display the values of a field, you just click on the appropriate field and choose between Load top 10 unique
values and Load all unique values. On the right side, the Field Values list opens with the unique values. At the
top of the list, a search box helps filtering the values. To add a value to the expression you are writing, double
click its name in the list.

Sample values can also be accessed via right-click. Select the field name from the list, then right-click to access a
context menu with options to load sample values from the selected field.

Fields name should be double-quoted in the expression. Values or string should be simple-quoted.

Funzioni varie di confronto

Questo gruppo contiene funzioni per confronti vari tra valori.

Funzioni Descrizione
ham-
ming_distance

Restituisce il numero di caratteri nelle posizioni corrispondenti all’interno delle stringhe in
input in cui i caratteri sono diversi

levensheim Restituisce il numero minimo di caratteri (inserzioni, cancellazioni o sostituzioni) richiesti
per cambiare una stringa in un’altra. Misura la somiglianza tra due stringhe

longest_common_substringRestituisce la sottostringa comune più lunga tra due stringhe
soundex Restituisce la rappresentazione Soundex di una stringa

Funzioni Generali

Questo gruppo contiene funzioni assortite generali.

Funzioni Descrizione
eval Valuta un’espressione che viene passata in una stringa. Utile per espandere i parametri dinamici

passati come variabili di contesto o campi
layer_propertyRestituisce una proprietà di un layer o un valore dei suoi metadati. Può essere nome del layer,

SR, tipo di geometria, conteggio delle geometrie ...
var Restituisce il valore memorizzato all’interno di una variabile specificata. Vedi funzioni variabili

di seguito

Funzioni Geometria

Questo gruppo contiene funzioni che operano su caratteristiche geometriche (ad es. Lunghezza, area).

Funzioni Descrizione
$area Restituisce le dimensioni dell’area della geometria corrente
$geometry Restituisce la geometria dell’elemento corrente (può essere utilizzato per l’elaborazione con altre funzioni)
$length Restituisce la lunghezza della geometria lineare corrente
$perimeter Restituisce il perimetro della geometria poligono corrente
$x Returns the x coordinate of the current feature
$x_at(n) Returns the x coordinate of the nth node of the current feature’s geometry
$y Returns the y coordinate of the current feature
$y_at(n) Returns the y coordinate of the nth node of the current feature’s geometry
angle_at_vertex Restituisce l’angolo bisettrice (angolo medio) alla geometria per un vertice specificato su una geometria lineare. Gli angoli sono in gradi in senso orario da nord
area Restituisce l’area di una geometria poligono. I calcoli sono nel Sistema di riferimento spaziale di questa geometria
azimuth Restituisce l’azimut a nord come angolo in radianti misurato in senso orario dalla verticale su point_a a point_b
boundary Returns the closure of the combinatorial boundary of the geometry (ie the topological boundary of the geometry).
bounds Returns a geometry which represents the bounding box of an input geometry. Calculations are in the Spatial Reference System of this geometry
bounds_height Restituisce l’altezza del riquadro di delimitazione di una geometria. I calcoli sono nel Sistema di riferimento spaziale di questa geometria
bounds_width Restituisce la larghezza del riquadro di delimitazione di una geometria. I calcoli sono nel Sistema di riferimento spaziale di questa geometria
buffer Returns a geometry that represents all points whose distance from this geometry is less than or equal to distance. Calculations are in the Spatial Reference System of this geometry
centroid Returns the geometric center of a geometry
closest_point Restituisce il punto su una geometria che è più vicino a una seconda geometria

Continua alla pagina successiva
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Table 12.1 – continua dalla pagina precedente
Funzioni Descrizione
combine Restituisce la combinazione di due geometrie
contains(a,b) Restituisce 1 (vero) se e solo se nessun punto di b giace nell’esterno di a, e almeno un punto dell’interno di b si trova all’interno di a
convex_hull Returns the convex hull of a geometry (this represents the minimum convex geometry that encloses all geometries within the set)
crosses Restituisce 1 (vero) se le geometrie fornite hanno in comune alcuni punti interni, ma non tutti
difference(a,b) Returns a geometry that represents that part of geometry a that does not intersect with geometry b
disjoint Restituisce 1 (vero) se le geometrie non condividono nessuno spazio
distance Restituisce la distanza minima (in base al Sistema di riferimento spaziale) tra due geometrie in unità proiettate
distance_to_vertex Restituisce la distanza lungo la geometria a un vertice specificato
end_point Returns the last node from a geometry
exterior_ring Restituisce una stringa lineare che rappresenta l’anello esterno di una geometria poligonale o null se la geometria non è un poligono
extrude(geom,x,y) Returns an extruded version of the input (Multi-) Curve or (Multi-)Linestring geometry with an extension specified by x and y
geom_from_gml Restituisce una geometria creata da una rappresentazione GML della geometria
geom_from_wkt Restituisce una geometria creata da una rappresentazione Well-Known Text (WKT)
geom_to_wkt Restituisce la rappresentazione Well-Known Text (WKT) della geometria senza i metadati del SRID
geometry Restituisce la geometria di un elemento
geometry_n Restituisce l’ennesima geometria da una raccolta di geometrie, o null se la geometria in input non è una raccolta
interior_ring_n Restituisce la geometria dell’ennesimo anello interno da una geometria poligonale, oppure null se la geometria non è un poligono
intersection Returns a geometry that represents the shared portion of two geometries
intersects Verifica se una geometria interseca un’altra. Restituisce 1 (vero) se le geometrie si intersecano spazialmente (condividono qualsiasi porzione di spazio) e 0 se non lo fanno
intersects_bbox Verifica se il riquadro di delimitazione di una geometria si sovrappone al riquadro di delimitazione di un’altra geometria. Restituisce 1 (vero) se le geometrie intersecano spazialmente (condividono qualsiasi porzione di spazio) nelle loro casella di delimitazione, o 0 se non lo fanno
is_closed Restituisce vero se una linea è chiusa (i punti di inizio e di fine sono coincidenti), falso se una linea non è chiusa o null se la geometria non è una linea
length Restituisce la lunghezza di una geometria lineare (o la lunghezza di una geometria di tipo linestring)
line_interpolate_angle Restituisce l’angolo parallelo alla geometria ad una distanza specificata lungo una geometria di tipo linestring. Gli angoli sono in gradi in senso orario da nord.
line_interpolate_point Returns the point interpolated by a specified distance along a linestring geometry.
line_locate_point Restituisce la distanza lungo una linestring corrispondente alla posizione più vicina alla linestring di una geometria puntuale specificata
line_merge Restituisce una geometria (Multi-)LineString, in cui tutte le LineString connesse dalla geometria in input sono state unite in una singola linestring.
m Returns the m value of a point geometry
make_line Crea una geometria lineare da una serie di geometrie punto
make_point(x,y,z,m) Returns a point geometry from x and y (and optional z or m) values
make_point_m(x,y,m) Returns a point geometry from x and y coordinates and m values
make_polygon Crea una geometria poligono da un anello esterno e una serie opzionale di geometrie ad anello interne
nodes_to_points Returns a multipoint geometry consisting of every node in the input geometry
num_geometries Restituisce il numero di geometrie in una raccolta di geometrie, o null se la geometria in ingresso non è una raccolta
num_interior_rings Restituisce il numero di anelli interni in un poligono o in una raccolta di geometrie, oppure null se la geometria in input non è un poligono o una raccolta
num_points Restituisce il numero di vertici in una geometria
num_rings Restituisce il numero di anelli (inclusi gli anelli esterni) in un poligono o in una raccolta di geometrie, oppure null se la geometria in input non è un poligono o una raccolta
order_parts Ordina le parti di una MultiGeometry secondo un determinato criterio
overlaps Verifica se una geometria si sovrappone a un’altra. Restituisce 1 (vero) se le geometrie condividono lo spazio, sono della stessa dimensione, ma non sono completamente contenute l’una all’altra
perimeter Restituisce il perimetro di una geometria poligonale. I calcoli sono nel Sistema di riferimento spaziale di questa geometria
point_n Returns a specific node from a geometry
point_on_surface Returns a point guaranteed to lie on the surface of a geometry
project Returns a point projected from a start point using a distance and bearing (azimuth) in radians
relate Testa o restituisce la rappresentazione Dimensional Extended 9 Intersection Model (DE-9IM) della relazione tra due geometrie.
reverse Reverses the direction of a line string by reversing the order of its vertices
segments_to_lines Returns a multi line geometry consisting of a line for every segment in the input geometry
shortest_line Restituisce la linea più breve che unisce due geometrie. La linea risultante inizierà dalla geometria 1 e terminerà alla geometria 2
start_point Returns the first node from a geometry
sym_difference Returns a geometry that represents the portions of two geometries that do not intersect
touches Verifica se una geometria tocca un’altra. Restituisce 1 (vero) se le geometrie hanno almeno un punto in comune, ma i loro interni non si intersecano
transform Returns the geometry transformed from the source CRS to the destination CRS
translate Returns a translated version of a geometry. Calculations are in the Spatial Reference System of this geometry
union Restituisce una geometria che rappresenta l’unione dell’insieme dei punti delle geometrie
within (a,b) Verifica se una geometria si trova all’interno di un’altra. Restituisce 1 (vero) se la geometria a è completamente all’interno della geometria b
x Returns the x coordinate of a point geometry, or the x coordinate of the centroid for a non-point geometry
x_min Returns the minimum x coordinate of a geometry. Calculations are in the Spatial Reference System of this geometry
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Table 12.1 – continua dalla pagina precedente
Funzioni Descrizione
x_max Returns the maximum x coordinate of a geometry. Calculations are in the Spatial Reference System of this geometry
y Returns the y coordinate of a point geometry, or the y coordinate of the centroid for a non-point geometry
y_min Returns the minimum y coordinate of a geometry. Calculations are in the Spatial Reference System of this geometry
y_max Returns the maximum y coordinate of a geometry. Calculations are in the Spatial Reference System of this geometry
z Returns the z coordinate of a point geometry

Alcuni esempi:

• Puoi manipolare la geometria corrente con la variabile $geometry per creare un buffer o ottenere il punto
sulla superficie:

buffer( $geometry, 10 )
point_on_surface( $geometry )

• Return the x coordinate of the current feature’s centroid:

x( $geometry )

• Generare un valore in base all’area della geometria:

CASE WHEN $area > 10 000 THEN ’Larger’ ELSE ’Smaller’ END

Record Functions

Questo gruppo contiene funzioni che operano sugli identificativi dei record.

Funzioni Descrizione
$current-
feature

Restituisce l’elemento corrente da valutare. Questo può essere usato con la funzione ‘attribute’
per valutare i valori degli attributi dell’elemento corrente.

$id Restituisce l’ID della geometria della riga corrente
$map Returns the id of the current map item if the map is being drawn in a composition, or “canvas” if

the map is being drawn within the main QGIS window
$rownum Returns the number of the current row
$scale Returns the current scale of the map canvas
attribute Restituisce il valore di uno specifico attributo di una geometria
get_feature Restituisce la prima geometria di un layer che corrisponde a un determinato valore di attributo
uuid Genera un Identificatore Univoco Universale (UUID) per ogni riga. Ogni UUID è lungo 38

caratteri

Alcuni esempi:

• Restituire la prima geometria nel layer “LayerA” il cui campo “id” ha lo stesso valore del campo “name”
della geometria corrente (una specie di jointure) :

get_feature( ’layerA’, ’id’, attribute( $currentfeature, ’name’) )

• Calcolare l’area della geometria unita con l’esempio precedente:

area( geometry( get_feature( ’layerA’, ’id’, attribute( $currentfeature, ’name’) ) ) )

Funzioni Stringa

Questo gruppo contiene le funzioni che operano sulle stringhe (ad esempio sostituisci, converti in maiuscolo).
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Funzioni Descrizione
char Restituisce il carattere associato a un codice Unicode
concat Concatena più stringhe in una
format Formatta una stringa usando gli argomenti forniti
for-
mat_date

Formatta un tipo data o una stringa in un formato stringa personalizzato

for-
mat_number

Restituisce un numero formattato con il separatore delle impostazioni internazionali per le
migliaia (inoltre tronca il numero al numero di posti forniti)

left(string,
n)

Restituisce una sottostringa che contiene gli n caratteri più a sinistra della stringa

length Restituisce la lunghezza di una stringa (o la lunghezza di una geometria di tipo linestring)
lower converte una stringa in lettere minuscole
lpad Returns a string with supplied width padded using the fill character
reg-
exp_replace

Restituisce una stringa con la parte che soddisfa l’espressione regolare sostituita

reg-
exp_substr

Restituisce la parte di una stringa che corrisponde all’espressione regolare fornita

replace Returns a string with the supplied string replaced
right(string,
n)

Restituisce una sottostringa che contiene gli n caratteri più a destra della stringa

rpad Returns a string with supplied width padded using the fill character
strpos Returns the index of a regular expression in a string
substr Restituisce una parte di una stringa
title Converte tutte le parole di una stringa in ‘Titolo maiuscolo’ (tutte le parole in minuscolo con la

prima lettera maiuscola)
trim Rimuove tutti gli spazi bianchi iniziali e finali (spazi, tabulazioni, ecc.) da una stringa
upper Converte una stringa in lettere maiuscole
word-
wrap

Restituisce una stringa posta a capo ad un massimo/minimo numero di caratteri

Funzioni recenti

This group contains recently used functions. Any expression used in the Expression dialog is added to the list,
sorted from the more recent to the less one. This helps to quickly retrieve any previous expression.

Funzioni Variabili

Questo gruppo contiene variabili dinamiche relative all’applicazione, al file di progetto e ad altre impostazioni.
Significa che alcune funzioni potrebbero non essere disponibili in base al contesto:

• dalla finestra di dialogo Seleziona tramite una espressione

• dalla finestra di dialogo Calcolatore campo

• dalla finestra di dialogo Proprietà layer

• from the print composer

Per utilizzare queste funzioni in un’espressione, dovrebbero essere precedute da un carattere @ (ad esempio,
@row_number). Riguardano:

Funzioni Descrizione
atlas_feature Restituisce la geometria atlante corrente (come oggetto geometria)
atlas_featureid Restituisce l’ID della geometria atlante corrente
atlas_featurenumber Returns the number of pages in composition
atlas_filename Restituisce il nome del file atlante corrente
atlas_geometry Restituisce la geometria dell’elemento corrente dell’atlante

Continua alla pagina successiva
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Funzioni Descrizione
atlas_pagename Restituisce il nome della pagina atlante corrente
atlas_totalfeatures Restituisce il numero totale di geometrie nell’atlante
grid_axis Restituisce l’annotazione corrente dell’asse del reticolo (ad esempio ‘X’ per longitudine, ‘y’ per latitudine)
grid_number Restituisce il valore corrente dell’annotazione del reticolo
item_id Returns the composer item user ID (not necessarily unique)
item_uuid Returns the composer item unique ID
layer_id Restituisce l’ID del layer corrente
layer_name Restituisce il nome del layer corrente
layout_dpi Restituisce la risoluzione della composizione di stampa (DPI)
layout_numpages Returns the number of pages in the composition
layout_pageheight Returns the composition height in mm
layout_pagewidth Returns the composition width in mm
map_extent_center Restituisce il punto centrale della mappa
map_extent_height Restituisce l’altezza corrente della mappa
map_extent_width Restituisce la larghezza corrente della mappa
map_id Returns the ID of current map destination. This will be ‘canvas’ for canvas renders, and the item ID for composer map renders
map_rotation Restituisce la rotazione corrente della mappa
map_scale Restituisce la scala corrente della mappa
project_filename Returns the filename of current project
project_folder Returns the folder for current project
project_path Returns the full path (including file name) of current project
project_title Restituisce il titolo del progetto corrente
qgis_os_name Restituisce il nome corrente del sistema operativo, ad esempio “windows”, “linux” o “osx”
qgis_platform Restituisce la piattaforma QGIS, ad esempio ‘desktop’ o ‘server’
qgis_release_name Restituisce il nome della versione corrente di QGIS
qgis_version Restituisce la stringa della versione corrente di QGIS
qgis_version_no Restituisce il numero di versione corrente di QGIS
symbol_angle Restituisce l’angolo del simbolo utilizzato per la visualizzazione dell’elemento (valido solo per i simboli marker)
symbol_color Restituisce il colore del simbolo utilizzato per la visualizzazione dell’elemento
user_account_name Restituisce il nome corrente dell’account utente nel sistema operativo
user_full_name Restituisce il nome corrente dell’utente nel sistema operativo
row_number Memorizza il numero della riga corrente
value Restituisce il valore corrente

12.3.3 Editor delle Funzioni

With the Function Editor, you are able to define your own Python custom functions in a comfortable way.

The function editor will create new Python files in .qgis2\python\expressions folder and will auto load
all functions defined when starting QGIS. Be aware that new functions are only saved in the expressions
folder and not in the project file. If you have a project that uses one of your custom functions you will need to also
share the .py file in the expressions folder.

Ecco un breve esempio su come creare proprie funzioni:

@qgsfunction(args="auto", group=’Custom’)
def myfunc(value1, value2, feature, parent):

pass

The short example creates a function myfunc that will give you a function with two values. When using the
args=’auto’ function argument the number of function arguments required will be calculated by the number
of arguments the function has been defined with in Python (minus 2 - feature, and parent).

This function then can be used with the following expression:

188 Chapter 12. Lavorare con i vettori



QGIS User Guide, Release 2.18

Figure 12.57: La scheda Editor delle funzioni

myfunc(’test1’, ’test2’)

Your function will be implemented in the Custom functions group of the Expression tab after using the Run Script
button.

Ulteriori informazioni sulla creazione di codice Python possono essere trovate nel PyQGIS-Developer-Cookbook.

The function editor is not only limited to working with the field calculator, it can be found whenever you work
with expressions.

‘ ‘

12.4 Lavorare con la tabella degli attributi

The attribute table displays information on features of a selected layer. Each row in the table represents a feature
(with or without geometry), and each column contains a particular piece of information about the feature. Features
in the table can be searched, selected, moved or even edited.

12.4.1 Foreword: Spatial and non-spatial tables

QGIS allows you to load spatial and non-spatial layers. This currently includes tables supported by OGR and
delimited text, as well as the PostgreSQL, MSSQL, SpatiaLite, DB2 and Oracle provider. All loaded layers are
listed in the Layers Panel. Whether a layer is spatially enabled or not determines whether you can interact with it
on the map.

Non-spatial tables can be browsed and edited using the attribute table view. Furthermore, they can be used for
field lookups. For example, you can use columns of a non-spatial table to define attribute values, or a range of
values that are allowed, to be added to a specific vector layer during digitizing. Have a closer look at the edit
widget in section Fields Properties to find out more.

12.4.2 Introducing the attribute table interface

To open the attribute table for a vector layer, activate the layer by clicking on it in the Pannello dei Layer. Then,

from the main Layer menu, choose Open Attribute Table. It is also possible to right-click on the layer and
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choose Open Attribute Table from the drop-down menu, or to click on the Open Attribute Table button in
the Attributes toolbar.

This will open a new window that displays the feature attributes for the layer (figure_attributes_table). According
to the setting in Settings → Options → Data sources menu, the attribute table will open in a docked window or
a regular window. The total number of features in the layer and the number of currently selected/filtered features
are shown in the attribute table title, as well as if the layer is spatially limited.

Figure 12.58: Tabella degli attributi per il layer regions

I pulsanti nella parte superiore della finestra della tabella degli attributi forniscono le seguenti funzionalità:
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Icona Etichetta Azione Scorciatoie da
tastiera

Attivare/disattivare modalità
modifica

Attivare modalità modifica Ctrl+E

Attivare modalità modifica multipla Aggiornare più campi di molte
geometrie

Salva modifiche Salva le modifiche in corso Ctrl+S

Ricarica la tabella

Aggiungi geometria Aggiungi un nuovo oggetto senza
geometria

Eliminare geometrie selezionate Rimuovi le geometrie selezionate dal
layer

Seleziona le geometrie usando
un’espressione

Seleziona tutto Seleziona tutte le geometrie del layer Ctrl+A

Inverti la selezione Inverti la selezione corrente del layer Ctrl+R

Deseleziona tutto Deseleziona tutte le geometrie del layer
corrente

Ctrl+Shift+A

Filtra/Seleziona le geometrie usando
un modulo

Ctrl+F

Sposta la selezione in cima Sposta le righe selezionate in cima alla
tabella

Spostare mappa alle righe
selezionate

Ctrl+P

Zoom mappa alle righe selezionate Ctrl+J

Copy selected rows to clipboard Ctrl+C

Incolla le geometrie dagli appunti Inserisci nuove geometrie da quelle
copiate

Ctrl+V

Nuovo campo Aggiungi un nuovo campo ai dati
originari

Ctrl+W

Eliminare campo Rimuovi un campo dall’origine dati Ctrl+L

Aprire il calcolatore di campo Aggiornare il campo per molte
geometrie in una riga

Ctrl+I

Formattazione condizionale Abilitare formattazione tabella

Tabella Attributo 1: Strumenti disponibili

Nota: A seconda del formato dei dati e della libreria OGR creata con la versione di QGIS, alcuni strumenti
potrebbero non essere disponibili.

Sotto questi pulsanti c’è un pulsante (abilitato solo in modalità modifica), che ti consente di applicare rapida-
mente filtri e calcoli a tutti o parte degli elementi nel vettore. Per i calcoli usa le stesse ref:expressions <vec-

tor_expressions> del Calcolatore di campi (vedi Modifica dei valori nella tabella degli attributi).

Suggerimento: Skip WKT geometry

If you want to use attribute data in external programs (such as Excel), use the Copy selected rows to clipboard but-
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ton. You can copy the information without vector geometries if you deactivate the Copy geometry in WKT
representation from attribute table option in Settings → Options → Data Sources menu.

Visualizzazione Tabella e Visualizzazione Modulo

QGIS fornisce due modi di visualizzazione per manipolare facilmente i dati nella tabella degli attributi:

• the Table view, displaying values of multiple features in a tabular mode, each row representing a feature
and each column a field;

• and the Form view which shows identifiers of features in a first panel and displays only the attributes of
the clicked identifier in the second one. Form view uses the layer fields configuration (see Fields Properties).

You can switch from one mode to the other by clicking the convenient icon at the bottom right of the dialog.

Puoi anche specificare la modalità di Vista predefinita all’apertura della tabella degli attributi nel menu Im-
postazioni → Opzioni → Sorgente dei dati. Può essere ‘Ricorda ultima vista’, ‘Vista tabella’ o ‘Vista modulo’.

Figure 12.59: Tabella degli Attributi nei formati di visualizzazione Modulo (in alto) e Tabella (in basso)
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Configuring the columns

Fai click con il pulsante destro del mouse in un’intestazione di colonna quando sei è in visualizzazione tabella
per accedere agli strumenti che ti consentono di definire ciò che può essere visualizzato e come nella tabella degli
attributi.

Hiding and organizing columns and enabling actions

Facendo click con il pulsante destro del mouse in un’intestazione di colonna, puoi scegliere di nasconderla dalla
tabella degli attributi. Per modificare contemporaneamente il comportamento di più colonne, mostrare una colonna
o cambiare l’ordine delle colonne, scegli Organizza colonne .... Nella nuova finestra di dialogo puoi:

• selezionare/deselezionare le colonne da visualizzare o nascondere

• trascinare e rilasciare gli oggetti per riordinare le colonne nella tabella degli attributi. Si noti che questa
modifica riguarda la visualizzazione della tabella e non modifica l’ordine dei campi nell’origine dati del
layer

• abilitare una nuova colonna virtuale Azioni che visualizza in ciascuna riga una casella a discesa o un elenco
di pulsanti di azioni per ciascuna riga, per ulteriori informazioni sulle azioni, vedi Proprietà Azioni.

Resizing columns widths

La larghezza delle colonne può essere impostata tramite un click destro sull’intestazione della colonna e se-
lezionare:

• Imposta larghezza... per immettere il valore desiderato. Per impostazione predefinita, il valore corrente
viene visualizzato nel widget

• DimensioneAuto per ridimensionare al meglio la colonna.

Può essere modificata anche trascinando il limite a destra della colonna con il mouse tenendo premuto il tasto
sinistro. La nuova dimensione della colonna viene mantenuta per il layer e viene ripristinata all’apertura successiva
della tabella degli attributi.

Sorting columns

La tabella può essere ordinata su qualsiasi colonna, facendo click sull’intestazione della colonna. Una piccola
freccia indica l’ordine di ordinamento (verso il basso significa scendere i valori dalla riga superiore in basso, verso
l’alto significa valori ascendenti dalla riga superiore in basso). Puoi anche ordinare le righe con l’opzione di
ordinamento del menu contestuale dell’intestazione di colonna e scrivere un’espressione, ad esempio per ordinare
la riga con più colonne puoi scrivere concat(col0, col1).

Nella visualizzazione modulo, l’identificatore degli elementi può essere ordinato utilizzando l’opzione Ordina
tramite anteprima espressione.

Suggerimento: Sorting based on columns of different types
Trying to sort an attribute table based on columns of string and numeric types may lead to unexpected re-
sult because of the concat("USE", "ID") expression returning string values (ie, ’Borough105’ <
’Borough6’). You can workaround this by using eg concat("USE", lpad("ID", 3, 0)) which re-
turns ’Borough105’ > ’Borough006’.

Formatting of table cells using conditions

Conditional formatting settings can be used to highlight in the attribute table features you may want to put a
particular focus on, using custom conditions on feature’s:
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• geometria (ad esempio, identificazione delle geometrie multi-parti, piccole aree o in una estensione limitata
della mappa ...);

• or field value (e.g., comparing values to a threshold, identifying empty cells...)

Puoi abilitare il pannello di formattazione condizionale cliccando in alto a destra nella finestra attributi in visual-
izzazione tabella (non disponibile in visualizzazione modulo).

Il nuovo pannello consente all’utente di aggiungere nuove regole per modificare la visualizzazione del Campo
o Riga intera. L’aggiunta di una nuova regola apre un modulo per definire:

• il nome della regola;

• una condizione che utilizza una qualsiasi delle funzioni del expression builder

• la formattazione: può essere scelta da un elenco di formati predefiniti o creata in base a proprietà come:

– colori di sfondo e testo;

– uso dell’icona;

– grassetto, corsivo, sottolineato o testo barrato;

– carattere.

Figure 12.60: Formattazione condizionale di una tabella degli attributi

12.4.3 Interagire con le geometrie nella tabella degli attributi

Selezionare geometrie

Nella vista tabella, ogni riga nella tabella degli attributi visualizza gli attributi di una specifica geometria nel layer.
Selezionando una sola riga si seleziona una geometria e allo stesso modo, selezionando una geometria nella mappa
(in caso di geometria del layer attivato), viene selezionata la corrispondente riga nella tabella degli attributi. Se
viene modificato un insieme di geometrie selezionate nella mappa (o nella tabella degli attributi), la selezione
viene aggiornata anche nella tabella degli attributi (o nella visualizzazione della mappa).

Le righe possono essere selezionate facendo clic sul numero di riga sul lato sinistro della riga. È possibile con-
trassegnare più righe tenendo premuto il tasto Ctrl. Una selezione continua può essere effettuata tenendo
premuto il tasto Shift e facendo click su più intestazioni di riga sul lato sinistro delle righe. Sono selezionate
tutte le righe tra la posizione corrente del cursore e la riga cliccata. Spostando la posizione del cursore nella tabella
degli attributi, facendo clic su una cella nella tabella, non cambia la selezione di riga. Cambiare la selezione nella
finestra principale non sposta la posizione del cursore nella tabella degli attributi
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Nella impostazione visualizzazione della tabella degli attributi, le geometrie vengono identificate per default nel
pannello di sinistra per il valore del loro campo visualizzato (vedere Scheda Suggerimenti). Questo identificatore
può essere sostituito utilizzando l’elenco a discesa nella parte superiore del pannello, selezionando un campo
esistente o utilizzando un’espressione personalizzata. Puoi inoltre scegliere di ordinare l’elenco delle geometrie
dal menu a discesa.

Fai click su un valore nel pannello di sinistra per visualizzare gli attributi della geometria nella destra. Per se-
lezionare una geometria, devi fare click all’interno del simbolo quadrato a sinistra dell’identificatore. Per im-
postazione predefinita, il simbolo diventa giallo. Come nella visualizzazione tabella, puoi eseguire la selezione di
più geometrie utilizzando le combinazioni di tasti precedentemente esposte.

Oltre a selezionare le geometrie con il mouse, è possibile eseguire la selezione automatica in base all’attributo
della geometria utilizzando gli strumenti disponibili nella barra degli strumenti della tabella degli attributi, ad
esempio (vedi la sezione Selezione automatica e la successiva per ulteriori informazioni e casi d’uso):

• Seleziona con espressione....

• Seleziona geometrie per valore....

• Deseleziona tutto

• Seleziona tutte le geometrie

• Inverti la selezione delle geometrie.

È anche possibile selezionare le geometrie utilizzando Filtering and selecting features using forms.

Filtrare geometrie

Una volta che hai selezionato le geometrie nella tabella degli attributi, potresti voler visualizzare solo questi record
nella tabella. Questo può essere fatto facilmente utilizzando la voce Mostra gli elementi selezionati dall’elenco a
discesa in basso a sinistra della finestra di dialogo della tabella degli attributi. Questa lista offre i seguenti filtri:

• Mostra tutti gli elementi

• Mostra gli elementi selezionati

• Mostra gli elementi visibili nella mappa

• Mostra gli elementi modificati ed i nuovi

• Filtro campo: consente all’utente di eseguire il filtro in base al valore di un campo: scegliere una colonna
da un elenco, digitare un valore e premere Enter per filtrare. Quindi, nella tabella degli attributi vengono
visualizzati solo gli elementi corrispondenti.

• Advanced filter (Expression) - Opens the expression builder dialog. Within it, you can create complex
expressions to match table rows. For example, you can filter the table using more that one field. See
Espressioni for more information.

È inoltre possibile filtrare elementi utilizzando Filtering and selecting features using forms.

Nota: Filtrare records fuori dalla tabella degli attributi non consente di eliminare gli elementi dal layer; essi
sono semplicemente momentaneamente nascosti dalla tabella e si possono selezionare sulla mappa ovvero si può
rimuovere il filtro. Per filtri che nascondono gli elementi dal layer, utilizzare il Query Builder.

Suggerimento: Aggiornare il filtraggio della sorgente dati con Mostra gli elementi visibili
nella mappa

Quando per motivi di prestazione, gli elementi visualizzati nella tabella degli attributi sono limitati nella visual-
izzazione mappa alla sua apertura (vedi Data Source Options per come fare), selezionando Mostra gli elementi
visibili nella mappa su una nuova estensione di visibilità della mappa si aggiorna la precedente restrizione spaziale.
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Filtering and selecting features using forms

Facendo clic su Seleziona/filtra usando un modulo o premento Ctrl+F la finestra di dialogo della tabella degli attributi
passerà alla visualizzazione modulo e tutti i widget verranno sostituiti con la loro variante di ricerca

Da questo punto in poi, questa funzionalità degli strumenti è simile a quella descritta nelle Seleziona geometrie
per valore.., in cui è possibile trovare le descrizioni di tutti gli operatori e selezionarne le modalità.

Inoltre, nel caso della tabella degli attributi, c’è anche in basso a sinistra un guilabel:Filtra elementi che consente
di configurare le modalità di selezione e di creare un Filtro avanzato (Espressione).

Figure 12.61: Filtro tramite modulo della tabella degli attributi

Se ci sono elementi già selezionati, puoi reimpostare il filtro usando l’elenco a discesa accanto al pulsante in basso
a destra Filtra elementi. Le opzioni sono:

• Filtra all’interno (“AND”)

• Estendi filtro (“OR”)

To clear the filter, either select Show all features option mentioned in Filtrare geometrie, or click the clear the
expression and click [Apply].

12.4.4 Using action on features

Gli utenti hanno diverse possibilità di manipolare elementi con il menu contestuale come:

• Select all (Ctrl+A) the features

• Copy the content of a cell in the clipboard with Copy cell content.

• Zoom to feature without having to select it beforehand

• Open form. It toggles attribute table into form view with a focus on the clicked feature

Se vuoi utilizzare i dati degli attributi in programmi esterni (ad esempio Excel, LibreOffice,

QGIS o un’applicazione Web personalizzata), seleziona una o più righe e utilizza il pulsante
Copia le righe selezionate negli appunti o premi Ctrl+C. Nel menu Impostazioni → Opzioni... → Sorgente dei dati,
puoi definire il formato da incollare con le opzioni in Copia geometrie come:

• Testo normale, nessuna geometria,

• Testo normale, geometria WKT,
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Figure 12.62: Copiare il contenuto di una cella

• GeoJSON

Puoi anche visualizzare un elenco di azioni in questo menu contestuale. Questa opzione è attivata nella scheda
Proprietà vettore → Azioni. Vedi Proprietà Azioni per ulteriori informazioni sulle azioni.

Saving selected features as new layer

The selected features can be saved as any OGR-supported vector format and also transformed into another coor-
dinate reference system (CRS). In the contextual menu of the layer, from the Layers Panel, click on Save as to
define the name of the output file, its format and CRS (see section Creating new layers from an existing layer).

To save the selection ensure that the Save only selected features is selected. It is also possible to specify OGR
creation options within the dialog.

12.4.5 Modifica dei valori nella tabella degli attributi

La modifica dei valori degli attributi può essere eseguita:

• digitando il nuovo valore direttamente nella cella, se la tabella degli attributi è in visualizzazione tabella o
modulo. Le modifiche vengono quindi effettuate per cella, elemento per elemento;

• using the field calculator: update in a row a field that may already exist or to be created but for multiple
features; it can be used to create virtual fields.

• using the quick field calculation bar: same as above but for only existing field

• o utilizzando la modalità multi edit: aggiorna in una riga più campi per più geometrie

Using the Field Calculator

The Field Calculator button in the attribute table allows you to perform calculations on the basis of existing
attribute values or defined functions, for instance, to calculate length or area of geometry features. The results can
be written to a new attribute field, a virtual field, or they can be used to update values in an existing field.

Il calcolatore campo è disponibile su qualsiasi layer che supporta la modifica. Quando fai click sull’icona del
calcolatore del campo, si apre la finestra di dialogo (vedi figure_field_calculator). Se il layer non è in modalità
di modifica, viene visualizzato un avviso e l’utilizzo del calcolatore provoca il cambiamento di stato del layer in
modalità di modifica prima del calcolo.

Based on the Expression Builder dialog, the field calculator dialog offers a complete interface to define an expres-
sion and apply it to an existing or a newly created field. To use the field calculator dialog, you first must select
whether you want to only update selected features, create a new attribute field where the results of the calculation
will be added or update an existing field.
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Figure 12.63: Calcolatore Campo

If you choose to add a new field, you need to enter a field name, a field type (integer, real, date or string) and if
needed, the total field length and the field precision. For example, if you choose a field length of 10 and a field
precision of 3, it means you have 6 digits before the dot, then the dot and another 3 digits for the precision.

Un breve esempio illustra come funziona il calcolatore di campo quando si utilizza la scheda Espressione.
Vogliamo calcolare la lunghezza in km del layer railroads dal dataset di esempio di QGIS:

1. Carica lo shapefile railroads.shp in QGIS e premi Apri tabella attributi.

2. Fai clic su Attiva modifiche e apri la finestra di dialogo Calcolatore di campi.

3. Seleziona la casella di controllo Crea un nuovo campo per salvare i calcoli in un nuovo campo.

4. Aggiungi lunghezza come Nome campo in uscita e real come Tipo campo in uscita, e definisci la
Lunghezza campo in uscita a 10 e la Precisione a 3.

5. Ora fai doppio clic sulla funzione $lenght nel gruppo Geometria per aggiungerlo nella casella di espres-
sione del Calcolatore campo.

6. Complete the expression by typing / 1000 in the Field calculator expression box and click [Ok].

7. Puoi ora trovare un nuovo campo lunghezza nella tabella degli attributi.

Creating a Virtual Field

A virtual field is a field based on an expression calculated on the fly, meaning that its value is automatically updated
as soon as the underlying parameter changes. The expression is set once; you no longer need to recalculate the
field each time underlying values change. For example, you may want to use a virtual field if you need area to
be evaluated as you digitize features or to automatically calculate a duration between dates that may change (e.g.,
using now() function).

Nota: Uso dei Campi Virtuali
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• I campi virtuali non sono permanenti negli attributi del layer, nel senso che sono solo salvati e disponibili
nei file di progetto dove sono stati creati.

• Un campo può essere impostato virtuale solo alla sua creazione e l’espressione utilizzata non può più essere
modificata: è necessario eliminare e ricreare quel campo.

Using the Quick Field Calculation Bar

While Field calculator is always available, the quick field calculation bar on top of the attribute table is only visible
if the layer is in edit mode. Thanks to the expression engine, it offers a quicker access to edit an already existing
field.

In quick field calculation bar, you simply need to:

• select the existing field name in the drop-down list

• fill the textbox with an expression you directly write or build using the expression button

• and click on [Update All], [Update Selected] or [Update Filtered] button according to your need.

Editing multiple fields

A differenza degli strumenti precedenti, la modalità modifica multipla consente di modificare più attributi di diversi
elementi simultaneamente. Quando il layer viene impostato in modifica, sono disponibili strumenti di modifica
multipla:

• using the Toggle multi edit mode button from the toolbar inside the attribute table dialog,

• o selezionando il menu Modifica → Modifica gli attributi delle geometrie selezionate

Per modificare più campi di una riga:

1. select the features you want to edit;

2. from the attribute table toolbar, click the button. This will toggle the dialog to its form view. Feature
selection could also be made at this step;

3. at the right side of the attribute table, fields (and values) of selected features are shown. New widgets appear
next to each field allowing for display of the current multi edit state:

• the field contains different values for selected features. It’s shown empty and each feature will
keep its original value. You can reset the value of the field from the drop-down list of the widget.

• all selected features have the same value for this field and the value displayed in the form will be
kept.

• the field has been edited and the entered value will be applied to all the selected features. A
message appears at the top of the dialog, inviting you to either apply or reset your modification.

Facendo click su uno di questi widget puoi o impostare il valore corrente per il campo o ripristinare il valore
originale, il che significa che puoi ripristinare le modifiche campo per campo.

4. make the changes to the fields you want and click on Apply changes in the upper message text or any other
feature in the left panel.

Le modifiche verranno applicate a tutte le geometrie selezionate. Se non è selezionata alcuna geometria, l’intera
tabella viene aggiornata con le tue modifiche. Le modifiche vengono eseguite come un singolo comando di
modifica. Quindi, premendo Annulla vengono ripristinate contemporaneamente le modifiche degli attributi per tutte
le geometrie selezionate.
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Nota: A differenza dello strumento dalla tabella degli attributi, premendo l’opzione Modifica → Modifica gli
attributi delle geometrie selezionate viene fornita una finestra di dialogo per definire le modifiche degli attributi.
Di conseguenza, è necessario selezionare le geometrie prima dell’esecuzione.

Figure 12.64: Modifiche di campi per più geometrie

Nota: La modalità di modifica multipla è disponibile solo per i moduli generati automaticamente o personalizzati
drag and drop (vedi Customize a form for your data); non è supportato da moduli personalizzati UI.

12.4.6 Creare una relazione uno a molti o molti a molti

Le relazioni sono una tecnica utilizzata spesso nelle banche dati. Il concetto è che le geometrie (righe) di layer
diversi (tabelle) possono appartenersi a vicenda.

Introducing 1-N relations

Come esempio hai un livello con tutte le regioni dell’Alaska (poligono) con alcuni attributi sul suo nome e il tipo
regione e un ID univoco (che funge da chiave primaria).

Poi hai caricato un altro layer di punti o una tabella con informazioni sugli aeroporti che si trovano nelle regioni
e desideri anche tenere traccia di questi. Se vuoi aggiungerli al layer regioni, devi creare rapporti uno a molti
utilizzando chiavi esterne, in quanto in molte regioni esistono più aeroporti.

Layers in 1-N relations

QGIS non fa differenza tra una tabella e un layer vettoriale. Fondamentalmente, un layer vettoriale è una tabella
con una geometria. Quindi puoi aggiungere la tua tabella come un layer vettoriale. Per mostrare la relazione
1-n, puoi caricare lo shapefile airports e lo shapefile airports che contiene un campo chiave esterna
(fk_region) al layer regions. Ciò significa che ogni aeroporto appartiene esattamente ad una regione, men-
tre ogni regione può avere un certo numero di aeroporti (una tipica relazione uno a molti).

Foreign keys in 1-N relations

Oltre agli attributi già esistenti nella tabella degli attributi degli aeroporti, avrai bisogno di un altro campo ‘
fk_region‘‘ che funge da chiave esterna (se hai un database, probabilmente vorrai definire un vincolo su di esso).
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Figure 12.65: Regione dell’Alaska con areoporti

Questo campo fk_region conterrà sempre un id di una regione. Può essere visto come un puntatore alla regione a
cui appartiene. E si può progettare un modulo di modifica personalizzato per l’editing e QGIS si fa carico della
sua definizione. Funziona con diverse fonti dati (quindi puoi anche usarlo con shapefile e csv) e tutto quello che
devi fare è dire a QGIS le relazioni tra le tue tabelle.

Defining 1-N relations (Relation Manager)

The first thing we are going to do is to let QGIS know about the relations between the layers. This is done in
Project → Project Properties.... Open the Relations tab and click on [Add Relation].

• name is going to be used as a title. It should be a human readable string, describing, what the relation is
used for. We will just call say Airports in this case.

• referencing layer also considered as child layer, is the one with the foreign key field on it. In our case, this
is the airports layer

• referencing field will say, which field points to the other layer so this is fk_region in this case

• referenced layer also considered as parent layer, is the one with the primary key, pointed to, so here it is
the regions layer

• referenced field is the primary key of the referenced layer so it is ID

• id will be used for internal purposes and has to be unique. You may need it to build custom forms. If you
leave it empty, one will be generated for you but you can assign one yourself to get one that is easier to
handle.

Forms for 1-N relations

Ora che QGIS sa la relazione, sarà usato per migliorare il modulo che genera. Poiché non abbiamo modificato
il modulo predefinito (autogenerato) aggiungerà semplicemente un nuovo widget nel nostro modulo. Quindi,
selezioniamo la regione del layer nella legenda e utilizziamo lo strumento di identificazione. A seconda delle
impostazioni, il modulo si potrebbe aprire direttamente o dovrai scegliere di aprirlo nella finestra di dialogo di
identificazione in azioni.

As you can see, the airports assigned to this particular region are all shown in a table. And there are also some
buttons available. Let’s review them shortly

• Il pulsante serve per attivare la modalità di modifica. Tieni presente che cambia la modalità di mod-
ifica del layer aeroportuale, anche se siamo nel modulo di un elemento del layer regione. Ma la tabella
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Figure 12.66: Gestore delle relazioni

Figure 12.67: Finestra di dialogo identificazione relazione regioni con aeroporti
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rappresenta le geometrie del layer aeroportuale.

• The button will add a new feature to the airport layer. And it will assign the new airport to the current
region by default.

• The button will delete the selected airport permanently.

• Il simbolo aprirà una nuova finestra di dialogo in cui è possibile selezionare qualsiasi aeroporto esistente
che verrà assegnato alla regione corrente. Questo può essere utile se si è creato accidentalmente l’aeroporto
sulla regione sbagliata.

• Il simbolo scollegherà gli aeroporti selezionati dalla regione corrente, lasciandoli non assegnati (la
chiave esterna viene impostata su NULL).

• The two buttons to the right switch between table view and form view where the later let’s you view all the
airports in their respective form.

If you work on the airport table, a new widget type is available which lets you embed the feature form of the
referenced region on the feature form of the airports. It can be used when you open the layer properties of the
airports table, switch to the Fields menu and change the widget type of the foreign key field ‘fk_region’ to Relation
Reference.

Se ora guardi alla finestra di dialogo delle geometrie, vedrai che il modulo della regione è incorporato all’interno
del modulo aeroportuale e avrà anche una combinazione di opzioni di scelta, che ti consentono di assegnare
l’attuale aeroporto ad un’altra regione.

Figure 12.68: Finestra di dialogo identificazione aeroporti in relazione con regioni

Introducing many-to-many (N-M) relations

N-M relations are many-to-many relation between two tables. For instance, the airports and airlines
layers: an airport receives several airline companies and an airline company flies to several airports.

In such case, we need a pivot table to list all airlines for all airports. In QGIS, you should setup two one-to-many
relations as explained above:

• una relazione tra la tabella delle compagnie aeree e la tabella pivot;

• e una seconda tra la tabella degli aeroporti e la tabella pivot.

When we add a new child (i.e. a company to an airport), QGIS will add a new row in the pivot table and in the
airlines table. If we link a company to an airport, QGIS will only add a row in the pivot table.

In case you want to remove a link, an airline or an airport, QGIS won’t remove the row in the pivot table. The
database administrator should add a ON DELETE CASCADE instruction in the foreign key constraint:
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ALTER TABLE location.airlines
ADD CONSTRAINT location_airlines_airports_id_fkey

FOREIGN KEY (id)
REFERENCES location.airports(id)

ON DELETE CASCADE;

Nota: Combining N-M relation with automatic transaction group
Dovresti abilitare la modalità Crea automaticamente la transizione dei gruppi quando possibile in Project Pro-
prietà → Sorgente dei dati → se stai lavorando in tale contesto. QGIS dovrebbe essere in grado di aggiungere o
aggiornare le righe in tutte le tabelle (compagnie aeree, aeroporti e tabelle pivot).

Finally, adding such relations in a form is done in the same way that for a one-to-many relation. The Relations
panel in the Fields properties of the vector layer will let the user add the relation in the form. It will appear as a
Many to many relation.

12.5 Modifica

QGIS supporta varie opzioni per la manipolazione di layers vettoriali e relative tabelle nei formati OGR, Spa-
tiaLite, PostGIS, MSSQL Spatial e Oracle Spatial.

Nota: La procedura per la modifica dei layers GRASS è diversa, per dettagli vedi la sezione Digitalizzare e
modificare layer vettoriali GRASS.

Suggerimento: Modifiche in uso
Questa versione di QGIS non controlla se qualcun altro sta editando la stessa geometria, vince chi per primo
effettua il salvataggio.

12.5.1 Impostare la Tolleranza dello Snapping e il raggio di ricerca degli elementi

Al fine di gestire in maniera ottimale la modifica delle geometrie di un layer vettoriale, dobbiamo impostare un
adeguato valore di snapping e di raggio di ricerca per i vertici delle geometrie.

Tolleranza di aggancio

La tolleranza di aggancio è la distanza entro la quale QGIS cerca il vertice e/o segmento più vicino al quale si
cerca di agganciarsi quando si crea un nuovo vertice o si sposta un vertice esistente. Se non si è entro la tolleranza
di aggancio, QGIS lascerà il vertice creato o spostato nella posizione in cui si rilascia il pulsante del mouse invece
di agganciarlo ad un vertice e/o segmento esistente. La tolleranza di aggancio influenza tutti gli strumenti che
lavorano con una tolleranza.

1. Una tolleranza generale, a livello di progetto, può essere definita scegliendo Impostazioni → Opzioni...,
Digitalizzazione. Puoi scegliere come modalità di aggancio predefinita tra ‘Al vertice’, ‘Al segmento’ o ‘Al
vertice e al segmento’. Puoi inoltre definire una Tolleranza di aggancio predefinita e un Raggio di ricerca per
le modifiche dei vertici. La tolleranza può essere impostata sia in unità di mappa che in pixel. Il vantaggio di
scegliere i pixel è che la tolleranza di aggancio non deve essere modificata dopo le operazioni di zoom. Nel
nostro piccolo progetto di digitalizzazione (lavorando con il dataset Alaska), definiamo le unità di aggancio
in piedi. I tuoi risultati possono variare, ma qualcosa sull’ordine di 300 piedi in una scala di 1: 10000
dovrebbe essere una impostazione ragionevole.

2. A layer-based snapping tolerance that overrides the global snapping options can be defined by choosing
Settings → Snapping options. It enables and adjusts snapping mode and tolerance on a layer basis (see
figure_edit_snapping ). This dialog offers three different modes to select the layer(s) to snap to:
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• Layer in uso: viene utilizzata solo per il layer attivo, un modo semplice per garantire la topologia
all’interno del layer da modificare

• Tutti i layer visibili: una impostazione rapida e semplice per tutti i layer visibili del progetto in modo
che il puntatore attivi lo snap a tutti i vertici e/o ai segmenti. Nella maggior parte dei casi è sufficiente
utilizzare questa modalità di aggancio.

• Avanzato: se devi modificare un layer e fare lo snap dei vertici in un altro layer, assicurati di controllare
il layer di destinazione e aumenta la tolleranza di aggancio ad un valore maggiore. Inoltre, l’aggancio
non si verificherà mai ad un layer che non è selezionato nella finestra di dialogo delle opzioni di
aggancio, indipendentemente dalla tolleranza globale di aggancio. Quindi assicurati di contrassegnare
la casella di controllo per quei layer su cui vuoi fare lo snap.

Figure 12.69: Gestione delle opzioni di aggancio per layer (modalità Avanzato)

Suggerimento: Controllare la lista dei layer ai quali applicare le opzioni di aggancio
La finestra di dialogo Aggancio è predefinita con parametri (modalità, tolleranza, raggio, unità) impostati nella
scheda globale Digitalizzazione. Per evitare che i layer possano essere controllati da impostazione di default con
snap attivo in modalità Avanzato e quindi agganciabili, impostare Modalità di aggancio predefinita su Spento.

La tolleranza di aggancio può essere impostata in pixel o in unità mappa (le unità della visualizzazione
mappa). Mentre nella modalità Avanzato di selezione dei layer, è possibile utilizzare una tolleranza di aggancio
che si riferisce a unità del layer, le unità del layer riproiettato quando la trasformazione al volo di SR è
attiva.

Raggio di ricerca

Search radius is the distance QGIS uses to search for the closest vertex you are trying to select when you click
on the map. If you aren’t within the search radius, QGIS won’t find and select any vertex for editing. The search
radius for vertex edits can be defined under Settings → Options → Digitizing tab. This is the same place where
you define the general, project-wide snapping tolerance.

Snap tolerance and search radius are set in map units or pixels, so you may find you need to experiment to
get them set right. If you specify too big of a tolerance, QGIS may snap to the wrong vertex, especially if you are
dealing with a large number of vertices in close proximity. Set search radius too small, and it won’t find anything
to move.

12.5.2 Modifiche topologiche

Oltre alle opzioni di aggancio riferite ai layers, puoi definire le funzionalità topologiche nella finestra di dialogo

Opzioni di aggancio ... del menu Impostazioni (o File). Qui puoi definire :guilabel: Abilita la modifica

topologica, e/o per layers poligonali, attivare l’opzione Evita intersezioni.
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Abilitare la modifica topologica

L’opzione Abilita la modifica topologica serve per la modifica e il mantenimento di confini comuni nei mosaici
di geometrie. QGIS rileva un limite condiviso dalle geometrie, quindi devi solo spostare un vertice/segmento
comune alla volta, e QGIS si occuperà dell’aggiornamento delle geometrie vicine.

Evita intersezioni di nuovi poligoni

Una seconda opzione topologica chiamata Evita intersezioni ti impedisce di disegnare nuove geometrie che si
sovrappongono a quelli esistenti. È per una digitalizzazione più rapida di poligoni adiacenti. Se disponi già di un
poligono, puoi con questa opzione digitalizzare il secondo in modo tale che entrambi si intersecano e QGIS quindi
taglia il secondo poligono al limite dell’attuale esistente. Il vantaggio è che non devi digitalizzare tutti i vertici del
confine comune.

Nota: Se la nuova geometria è totalmente coperta da quelle esistenti, viene eliminata e la nuova definizione non
avrà alcuna geometria se ciò è previsto dal fornitore dei dati, altrimenti QGIS nel salvare le modifiche darà con un
pop-up un messaggio di errore.

Avvertimento: Usare con cautela l’opzione Evita intersezioni
Poiché l’opzione taglia o cancella la geometria di qualsiasi oggetto in sovrapposizione da ogni layer poligonale,
non dimenticare di deselezionare questa opzione una volta che non ne hai più bisogno altrimenti puoi ottenere
geometrie inaspettate.

Abilita l’aggancio alle intersezioni

Un’altra opzione consiste nell’utilizzare Abilita l’aggancio alle intersezioni. Ti consente di effettuare
l’aggancio su un incrocio di layers di sfondo, anche se non c’è vertice sull’intersezione.

Controllo Geometria

Un plugin di base che può aiutare l’utente a controllare la validità della geometria. Puoi trovare ulteriori infor-
mazioni su questo plugin in Plugin Controllo Geometria.

12.5.3 Modifica di un layer esistente

Di default, i dati sono caricati in QGIS in modalità di sola lettura. Questa è una salvaguardia per evitare di
modificare accidentalmente un layer se c’è uno spostamento involontario del mouse. Comunque, puoi sempre
modificare un layer se ciò è consentito dalla sorgente dati e se il dato medesimo è anche scrivibile (ad esempio i
suoi file non sono in modalità di sola lettura).

Suggerimento: Limitare l’autorizzazione di modifica ai layers all’interno di un progetto
From the Project → Project properties → Identify tab, You can choose to set any layer read-only regardless
the provider permission. This can be a handy way, in a multi-users environment to avoid unauthorized users to
mistakenly edit layers (e.g., shapefile), hence potentially corrupt data. Note that this setting only applies inside
the current project.

In generale, gli strumenti per la modifica dei layer vettoriali sono suddivisi in una Barra degli strumenti
di digitalizzazione e in una Barra degli strumenti di digitalizzazione avanzata, descritta nella sezione Dig-
italizzazione avanzata. Puoi selezionare e deselezionare le due barre sotto Visualizza → Barre degli stru-
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menti →. Utilizzando gli strumenti di digitalizzazione di base, puoi eseguire le seguenti funzioni:
Icona Azione Icona Azione

Modifiche in uso Attiva modifica

Aggiungi Elemento: inserisci punto Aggiungi geometria: inserisci linea

Aggiungi geometria: inserisci poligono Move Feature

Add Circular String Add Circular String By Radius

Node Tool Elimina Elementi selezionati

Taglia Elementi Copia Elementi

Incolla Elementi Salva modifiche

Modifica Tabella: Strumenti di base per la modifica di layer vettoriali

Si noti che durante l’utilizzo di uno degli strumenti di digitalizzazione, è possibile fare zoom or pan nella visual-
izzazioni mappa senza perdere l’operatività dello strumento.

Tutte le sessioni di modifica iniziano selezionando l’opzione Attiva modifiche che si trova cliccando con il tasto
destro del mouse sul nome del layer nella legenda, nella finestra di dialogo degli attributi, o nella barra degli
strumenti di digitalizzazione o nel menu Layer.

Una volta che il layer è in modalità modifica, ulteriori pulsanti di modifica diventeranno disponibili nella barra
degli strumenti e i marcatori verranno visualizzati ai vertici di tutte le geometrie a meno che non si seleziona
l’opzione Usa simboli solo per le geometrie selezionate in Impostazioni → Opzioni... → Digitalizzazione.

Suggerimento: Salvataggio ad intervalli regolari

Ricordatii di usare Salva modifiche vettore regolarmente, in modo da consentire il salvataggio delle tue modifiche
recenti e per verificare che le stesse siano accettate dalla fonte di dati.

Aggiungere Elementi

You can use the Add Feature, Add Feature or Add Feature icons on the toolbar to add new feature (point, line
and polygon) into the current layer.

The next buttons Add circular string or Add circular string by radius allow users to add line or polygon features with a
circular geometry.

To create features with these tools, you first digitize the geometry then enter its attributes. To digitize the geometry,
left-click on the map area to create the first point of your new feature.

For linear or curved geometries, keep on left-clicking for each additional point you wish to capture or use au-
tomatic tracing capability to accelerate the digitization. You can switch back and forth between linear Add fea-
ture tool and curved Add circular string... tools to create compound curved geometry. Pressing Delete or
Backspace key reverts the last node you add. When you have finished adding points, right-click anywhere on
the map area to confirm you have finished entering the geometry of that feature.

Nota: Le geometrie curve vengono memorizzate come tali solo nei gestori di dati compatibili
Although QGIS allows to digitize curved geometries within any editable data format, you need to be using a data
provider (e.g. PostGIS, GML or WFS) that supports curves to have features stored as curved, otherwise QGIS
segmentizes the circular arcs. The memory layer provider also supports curves.

Suggerimento: Personalizza il tracciamento ad elastico durante la digitalizzazione
Mentre si genera il poligono, il tracciamento ad elastico rosso di default può nascondere le geometrie o i luoghi
sottostanti per i quali potresti desiderare di catturare un punto. Ciò può essere cambiato impostando un opacità
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inferiore (o un canale alfa) al Colore di riempimento nel menu Impostazioni → Opzioni... → Digitalizzazione.
Puoi inoltre evitare l’uso del tracciamento ad elastico selezionando Non agganciare linea elastico durante l’edit
dei nodi.

Verrà visualizzata la finestra attributo, che ti consente di inserire le informazioni per la nuova geometria. Fig-
ure_edit_values mostra gli attributi di impostazione per un nuovo tronco di fiume fittizio in rivers di Alaska.
Comunque, nel menu Digitalizzazione in Impostazioni → Ozioni... puoi anche attivare:

• Suppress attributes pop-up windows after each created feature to avoid the form opening

• o Ripeti i valori degli attributi usati per ultimi per avere i campi automaticamente riempiti all’apertura
del modulo e doverli solo eventualmente cambiare.

Figure 12.70: Attivare la finestra di dialogo dei valori degli attributi dopo aver digitalizzato una nuova geometria
vettoriale

With the Move Feature(s) icon on the toolbar, you can move existing features.

Node Tool

For shapefile-based or MapInfo layers as well as SpatiaLite, PostgreSQL/PostGIS, MSSQL Spatial, and Oracle

Spatial tables, the Node Tool provides manipulation capabilities of feature vertices similar to CAD programs. It
is possible to simply select multiple vertices at once and to move, add or delete them altogether. The node tool
also works with ‘on the fly’ projection turned on and supports the topological editing feature. This tool is, unlike
other tools in QGIS, persistent, so when some operation is done, selection stays active for this feature and tool.

È importante impostare la proprietà Impostazioni ->‘|options|:menuselection:‘Opzioni -> Digitalizzazione -
>Raggio di ricerca per la modifica dei vertici a un numero maggiore di zero. Altrimenti, QGIS non
riconoscerà il vertice da editare.

Suggerimento: Indicatori dei vertici
L’attuale versione di QGIS supporta tre tipi di indicatori di vertice: ‘Cerchio semi trasparente’, ‘Croce’ e ‘Nes-
suno’. Per cambiare lo stile dell’indicatore, scegli Impostazioni Opzioni -> Digitalizzazione ->, e seleziona la
voce appropriata.

Operazioni di base

Start by activating the Node Tool and selecting a feature by clicking on it. Red boxes will appear at each vertex
of this feature.

• Selecting vertices: You can select vertices by clicking on them one at a time, by clicking on an edge to
select the vertices at both ends, or by clicking and dragging a rectangle around some vertices. When a
vertex is selected, its color changes to blue. To add more vertices to the current selection, hold down the
Ctrl key while clicking. Hold down Ctrl when clicking to toggle the selection state of vertices (vertices
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that are currently unselected will be selected as usual, but also vertices that are already selected will become
unselected).

• Adding vertices: To add a vertex, simply double click near an edge and a new vertex will appear on the
edge near to the cursor. Note that the vertex will appear on the edge, not at the cursor position; therefore, it
should be moved if necessary.

• Eliminazione di vertici: dopo aver selezionato i vertici per l’eliminazione, fai click sul tasto Delete.
L’eliminazione di tutti i vertici di una geometria genera, se compatibile con la sorgente dei dati, un oggetto
privo di geometria. Notare che non elimina completamente una geometria, ma solo la parte geometrica. Per

eliminare completamente una geometria utilizza lo strumento Elimina selezionato.

• Moving vertices: Select all the vertices you want to move, click on a selected vertex or edge and drag in the
direction you wish to move. All the selected vertices will move together. If snapping is enabled, the whole
selection can jump to the nearest vertex or line.

Each change made with the node tool is stored as a separate entry in the Undo dialog. Remember that all operations
support topological editing when this is turned on. On-the-fly projection is also supported, and the node tool
provides tooltips to identify a vertex by hovering the pointer over it.

Suggerimento: Move features with precision

The Move Feature tool doesn’t currently allow to snap features while moving. Using the Node Tool, select
ALL the vertices of the feature, click a vertex, drag and snap it to a target vertex: the whole feature is moved and
snapped to the other feature.

The Vertex Editor

With activating the Node Tool on a feature, QGIS opens the Vertex Editor panel listing all the vertices of the
feature with their x, y (z, m if applicable) coordinates and r (for the radius, in case of circular geometry). Simply
select a row in the table does select the corresponding vertex in the map canvas, and vice versa. Simply change
a coordinate in the table and your vertex position is updated. You can also select multiple rows and delete them
altogether.

Figure 12.71: Pannello Editor Vertice con selezione di alcuni nodi

Tagliare, copiare ed incollare elementi

Le geometrie selezionate possono essere tagliate, copiate e incollate tra i layers nello stesso progetto QGIS, a patto

che i layers di destinazione siano impostati in precedenza in modalità Attiva modifiche.
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Suggerimento: Trasformare il poligono in linea e viceversa usando copia/incolla
Copiare una linea e incollarla in un vettore poligonale: QGIS copia nel layer di destinazione un poligono il cui
confine corrisponde alla geometria chiusa della geometria lineare. Questo è un modo rapido per generare diverse
geometrie con gli stessi dati.

Le geometrie possono anche essere incollate ad applicazioni esterne come testo. Cioè, le geometrie sono rapp-
resentate in formato CSV, con i dati di geometria che appaiono nel formato OGC Well-Known Text (WKT). Le
geometrie WKT e GeoJSON dall’esterno di QGIS possono anche essere incollate ad un layer all’interno di QGIS.

Quando la funzione di copia e incolla è utile? Beh, si scopre che è possibile modificare più di un layer alla volta e
copiare/incollare le geometrie tra i layers. Perché vogliamo farlo? Diciamo che dobbiamo fare un po’ di lavoro su
un nuovo layer, ma abbiamo solo bisogno di uno o due laghi, non i 5.000 del nostro layer big_lakes. Possiamo
creare un nuovo layer e utilizzare copia/incolla per copiare i laghi necessari.

Ad esempio, copiamo alcuni laghi in un nuovo layer:

1. Caricare il layer dal quale vogliamo copiare gli elementi (layer sorgente)

2. Caricare o creare il layer nel quale vogliamo incollare gli elementi copiati (layer di destinazione)

3. Impostare entrambi i layer in modalità modifica

4. Rendere attivo il layer sorgente cliccando sul relativo nome nella legenda

5. Utilizza lo strumento Seleziona le geometrie con un rettangolo o con un singolo click per selezionare la geometria(e) sul
layer sorgente

6. Fai click sullo strumento Copia geometrie

7. Rendere attivo il layer di destinazione cliccando sul relativo nome nella legenda

8. Fai clic sullo strumento Incolla geometrie

9. Terminare le modifiche e salvare

Cosa succede se gli strati di origine e di destinazione presentano schemi diversi (i nomi dei campi e i tipi non sono
gli stessi)? QGIS popola ciò che corrisponde e ignora il resto. Se non ti interessa che gli attributi che vengano
copiati nel layer di destinazione, non importa come progetti i campi e i tipi di dati. Se vuoi assicurarti che tutto -
la geometria e i suoi attributi - sia copiato, assicurati che gli schemi corrispondano.

Nota: Congruenza degli elementi incollati
Se i tuoi layer di origine e destinazione utilizzano la stessa proiezione, le geometrie incollate avranno geometria
identica al layer di origine. Però, se il layer di destinazione è in una proiezione diversa, QGIS non può garantire
che la geometria sia identica. Questo è semplicemente perché ci sono piccoli errori di arrotondamento coinvolti
nella conversione tra le proiezioni.

Suggerimento: Copiare attributo tipo stringa
Se hai creato una nuova colonna nella tua tabella degli attributi con il tipo ‘stringa’ e vuoi incollare i valori da
un’altra colonna di attributo che ha una lunghezza maggiore, la lunghezza della dimensione della colonna verrà
estesa allo stesso valore. Questo perché il driver di GDAL Shapefile dalla versione GDAL/OGR 1.10 è capace di
estendere automaticamente campi stringa e interi per ospitare dinamicamente la lunghezza dei dati da inserire.

Cancellare elementi selezionati

Se desideriamo eliminare un’intera geometria (attributo e geometria), possiamo farlo prima selezionando la ge-

ometria usando il normale strumentoi Seleziona le geometrie con un rettangolo o con un singolo click. La selezione può es-
sere effettuata anche dalla tabella degli attributi. Una volta impostata la selezione, premi il tasto Cancella o
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Backspace o utilizza lo strumento Elimina selezionato per eliminare le geometrie. È possibile eliminare più
geometrie selezionate contemporaneamente.

Anche lo strumento Taglia geometrie sulla barra degli strumenti di digitalizzazione può essere utilizzato per elim-
inare le geometrie. Questo elimina effettivamente le geometrie ma le mette anche su “appunti spaziali”. Quindi,

dobbiamo tagliare la geometria per eliminarla. Potremmo però utilizzare lo strumento Incolla geometrie per ri-
portarci indietro, dandoci la possibilità di annullare l’eliminazione. Taglia, copia e incolla sono opzioni attive
sulle geometrie attualmente selezionate, il che significa che possiamo operare su più di una alla volta.

Salvare i layer modificati

Quando un layer è in modalità di modifica, tutte le modifiche rimangono nella memoria di QGIS. Pertanto, non
vengono eseguite/salvate immediatamente nei dati di origine o nel disco. Se vuoi salvare le modifiche al layer
corrente ma vuoi continuare a modificare senza lasciare la modalità di modifica, è possibile fare clic sul pulsante

Salva modifiche vettore. Quando si disattiva la modalità con Attiva modifiche (o uscire da chiude QGIS per qualche
ragione), ti viene anche chiesto se si vuoi salvare le modifiche o eliminarle.

Se le modifiche non possono essere salvate (ad esempio, il disco è pieno o gli attributi hanno valori fuori gamma),
lo stato di QGIS nello stato di memoria viene preservato. Ciò consente di regolare le modifiche e di riprovare.

Suggerimento: Integrità dei dati
È sempre una buona idea eseguire il backup dei dati originari prima di iniziare a modificare. Mentre gli autori
di QGIS hanno fatto ogni sforzo per preservare l’integrità dei tuoi dati, non offriamo alcuna garanzia a questo
proposito.

Salvare più layers contemporaneamente

Questa funzione si riferisce alla digitalizzazione di più layers. Scegli Salva vettore selezionato/i per salvare

tutte le modifiche apportate in più layers. Hai anche l’opportunità di Rollback per il vettore selezionato/i,
in modo che la digitalizzazione possa essere annullata per uno/tutti i layer selezionato/i. Se vuoi interrompere la

modifica dei layer selezionati un modo semplice è attivare l’opzione Annulla per il vettore selezionato/i.

Le stesse funzioni sono disponibili per la modifica di tutti i layers del progetto.

Suggerimento: Utilizza gruppo di transazioni per modificare, salvare o ripristinare contemporaneamente
le modifiche di più layers

When working with layers from the same PostGreSQL database, activate the Automatically create transaction
groups where possible option in Project → Project Properties → Data Sources to sync their behavior (enter or
exit the edit mode, save or rollback changes at the same time).
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12.5.4 Digitalizzazione avanzata

Icona Azione Icona Azione

Attiva gli strumenti di digitalizzazione avanzata Attiva tracciamento

Annulla Ripristina

Ruota Elemento/i Semplifica Elemento

Aggiungi buco Aggiungi Parte

Riempi buco

Elimina buco Elimina Parte

Curva di Offset Modifica la forma

Spezza elemento Spezza Elementi

Unisci gli sttributi delle geometrie selezionate Fondi Elementi Selezionati

Ruota Simboli del Punto Offset dei simboli per i punti

Barra degli strumenti di digitalizzazione avanzata

Annullare e rispristinare

Gli strumenti Annulla e Ripristina ti consentono di annullare o ripetere le operazioni di modifica dei vettori.
Esiste anche un pannello associato che mostra tutte le operazioni nella cronologia di annullamento/ripristino (vedi
Figure_edit_undo). Questo pannello non viene visualizzato per impostazione predefinita; può essere visualizzato
facendo click con il pulsante destro sulla barra degli strumenti di digitalizzazione avanzata attivando nell’elenco
Pannelli la casella di controllo Annulla/Rifai. La funzione Annulla/Rifai è comunque attiva, anche se il pannello
non viene visualizzato.

Figure 12.72: Ripristinare e annullare nelle fasi di digitalizzazione

Quando viene premuto Annulla o Ctrl+Z (o Cmd+Z) lo stato di tutte le geometrie e gli attributi vengono riportati
allo stato in cui erano avevano prima di quella modifica. Le modifiche diverse dalle operazioni normali di modifica
vettore (ad esempio, le modifiche apportate da un plugin) potrebbero o non potrebbero essere ripristinate a seconda
di come sono state eseguite le modifiche.

Per utilizzare il widget della cronologia Annulla/Ripristina, fai clic per selezionare un’operazione nell’elenco della
cronologia. Tutti le geometrie verranno ripristinate allo stato in cui si trovavano dopo l’operazione selezionata.

212 Chapter 12. Lavorare con i vettori



QGIS User Guide, Release 2.18

Ruota Elemento/i

Use Rotate Feature(s) to rotate one or multiple features in the map canvas. Press the Rotate Feature(s) icon and
then click on the feature to rotate. Either click on the map to place the rotated feature or enter an angle in the user
input widget. If you want to rotate several features, they shall be selected first.

If you enable the map tool with feature(s) selected, its (their) centroid appears and will be the rotation anchor
point. If you want to move the anchor point, hold the Ctrl button and click on the map to place it.

Se tieni premuto Shift prima di cliccare sulla mappa, la rotazione verrà eseguita in passi di 45 gradi, che possono
essere modificati successivamente nel widget di input dell’utente.

To abort feature rotation, you need to click on Rotate Feature(s) icon.

Semplifica Elemento

The Simplify Feature tool allows you to reduce the number of vertices of a feature, as long as the geometry
remains valid. With the tool you can also simplify many features at once or multi-part features.

First, click on the feature or drag a rectangle over the features. A dialog where you can define a tolerance in map
units, layer units or pixels pops up and a colored and simplified copy of the feature(s), using the given
tolerance, appears over them. QGIS calculates the amount of vertices that can be deleted while maintaining the
geometry. The higher the tolerance is the more vertices can be deleted. When the expected geometry fits your
needs just click the [OK] button. The tolerance you used will be saved when leaving a project or when leaving an
edit session. So you can go back to the same tolerance the next time when simplifying a feature.

To abort feature simplification, you need to click on Simplify Feature icon.

Nota: A differenza dell’opzione di semplificazione delle geometrie nel menu Impostazioni → Opzioni → Vi-

sualizzazione, che semplifica la geometria solo nella visualizzazione, lo strumento Semplifica geometria modifica
permanentemente la geometria dell’oggetto nell’origine dei dati.

Aggiungi Parte

Puoi attivare Aggiungi parte a una geometria selezionata generando una geometria multipunto, multilinea o mul-
tipoligono. La nuova parte deve essere digitalizzata al di fuori di quella esistente che deve essere selezionata in
precedenza.

Lo strumento Aggiungi parte può essere utilizzato anche per aggiungere una geometria a un oggetto senza geome-
trie. Innanzitutto, seleziona l’oggetto nella tabella degli attributi e digitalizza la nuova geometria con lo strumento

Aggiungi parte.

Elimina Parte

Lo strumento Elimina parte ti consente di eliminare parti da più geometrie (ad esempio, per eliminare i poligoni
da una geometria multi-poligono). Questo strumento funziona con tutte le geometrie a più parti: punto, linea e
poligono. Inoltre, può essere utilizzato per rimuovere completamente la componente geometrica di un oggetto.
Per eliminare una parte, basta cliccare all’interno della parte che si vuole eliminare.
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Aggiungi buco

Puoi creare poligoni con buchi utilizzando l’icona Aggiungi buco nella barra degli strumenti. Ciò significa che
all’interno di un’area esistente è possibile digitalizzare ulteriori poligoni che si presentano come un ‘buco’, quindi
rimane solo l’area tra i confini dei poligoni esterni e interni come un poligono bucato.

Riempi buco

You can use the Fill Ring function to add a ring to a polygon and add a new feature to the layer at the same time.

Using this tool, you simply have to digitize a polygon within an existing one. Thus you need not first use the
Add Ring icon and then the Add feature function anymore.

Elimina buco

Lo strumento Elimina buco ti consente di eliminare i buchi all’interno di un poligono esistente, facendo clic
all’interno del buco. Questo strumento funziona solo con geometrie poligonali e multi-poligonali. Non cambia
niente quando viene utilizzato su un anello esterno al poligono.

Modifica la forma

Puoi cambiare la forma di linee e poligoni utilizzando lo strumento Modifica la forma sulla barra degli strumenti. Per
le linee, sostituisce la linea originale a partire dalla prima intersezione fino all’ultima intersezione.

Figure 12.73: Modificare la forma di vettore linea

Suggerimento: Estendere le geometrie di vettori lineari con lo strumento di modifica forma

Utilizza lo strumento Modifica la forma per estendere le geometrie esistenti di vettori lineari: aggancia al primo o
ultimo vertice della linea e disegna una nuova. Validare e la geometria del vettore è il risultato della combinazione
delle due righe.

Per i poligoni, si rimodella il bordo del poligono. Per farlo funzionare, la linea dello strumento di modifica forma
deve attraversare almeno due volte il limite del poligono. Per disegnare la riga, fare click sulla visualizzazione
della mappa per aggiungere vertici. Per finire, basta fare click con il pulsante destro del mouse. Come con le linee,
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viene considerato solo il segmento tra le prime e le ultime intersezioni. I segmenti della linea di modifica forma
che si trovano all’interno del poligono lo ridurranno e quelli esterni al poligono lo estenderanno.

Figure 12.74: Modificare la forma di vettore poligono

Con i poligoni, la modifica forma può talvolta portare a risultati non voluti. È principalmente utile per sostituire
le parti più piccole di un poligono, non per fare grandi cambiamenti, da notare che la linea di modifica forma non
può attraversare poligoni con buchi in quanto ciò genererebbe un poligono non valido.

Nota: Lo strumento di rimodellamento può alterare la posizione di partenza di un anello poligonale o di una linea
chiusa. Quindi, il punto che è rappresentato ‘due volte’ non sarà più lo stesso. Questo non può essere un problema
per la maggior parte delle applicazioni, ma è qualcosa da considerare.

Dividere elementi

Lo strumento Curva di offset effettua spostamenti paralleli di layers lineari. Lo strumento può essere applicato
al layer modificato (le geometrie sono modificate) o anche ai layers di sfondo (nel qual caso crea copie delle
linee/anelli e li aggiunge al layer modificato). È quindi ideale per la creazione di layer di distanza. Viene visual-
izzata la finestra di dialogo Pannello Input Utente che mostra la distanza di spostamento.

Per creare uno spostamento di un vettore linea, devi entrare in modalità di modifica e attivare lo strumento
Curva di offset. Quindi fai click su una geometria per spostarla. Sposta il mouse e fai click su dove vuoi oppure anche

immetti la distanza desiderata nel widget di input dell’utente. Puoi salvare le modifiche con lo strumento
Salva modifica vettore.

La finestra di dialogo Opzioni di QGIS (scheda Digitalizzazione quindi sezione Strumento per la curva di offset)
consente di configurare alcuni parametri come lo Stile unione, i Segmenti di quadrante, il Limite di smusso.

Spezza Elementi

You can split features using the Split Features icon on the toolbar. Just draw a line across the feature you want to
split.
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Spezza elementi

In QGIS è possibile dividere le parti di una geometria a più parti di modo che il numero di parti viene aumentato.

Basta disegnare una riga sulla parte che desideri dividere usando l’icona Dividi parti.

Suggerimento: Split a polyline feature in one-click

A single click on a snapped vertex of a line feature with the Split Features or Split Parts tool is enough to have
it split into new features or parts.

Fondi elementi selezionati

Lo strumento Unisci gli elementi selezionati ti consente di creare una nuova geometria unendo quelle esistenti: le loro
geometrie vengono unite per generarne una nuova. Se le geometrie non hanno confini comuni, viene creata una
geometria multipoligono/multilinea/multipunti.

First, select several features. Then press the Merge Selected Features button. In the new dialog, you can select at the
top of the dialog which value to apply to each field of the new feature. That value can be:

• picked from the attributes of the initial features,

• an aggregation of the initial features attributes (Minimum, Maximum, Median, Sum, Count Concatenation...
depending on the type of the field. see Pannello Statistiche for the full list of functions),

• skipped, meaning that the field will be empty,

• or manually entered, at the bottom of the rows.

Unire attributi di elementi

Lo strumento Unire gli attributi degli elementi selezionati ti consente di applicare gli stessi attributi agli elementi senza
fondere i loro confini. La finestra di dialogo è la stessa del precedente strumento Unisci gli elementi
selezionati ma a differenza di quello strumento, gli oggetti selezionati vengono mantenuti con la loro ge-
ometria mentre alcuni dei loro attributi vengono resi identici.

Ruota Simboli del Punto

The Rotate Point Symbols allows you to change the rotation of point symbols in the map canvas. First of all, you

must apply to the symbol a data-defined rotation: in the Layer Properties → Style dialog, click the Data-
defined override widget near the Rotation option of the highest level (preferably) of the symbol layers and choose
a field in the Field Type combobox. Values of this field are hence used to rotate each feature’s symbol accordingly.

Nota: As a global option, setting the rotation field at the first level of the symbol applies it to all the underlying
levels while setting it at a lower level will rotate only this symbol layer (unless you have a single symbol layer).

To change the rotation of a symbol, click on a point feature in the map canvas with the Rotate Point Symbols and
move the mouse around, holding the left button pressed. A red arrow with the rotation value will be visualized (see
Figure_rotate_point). When you release the left mouse button again, the symbol is defined with this new rotation
and the rotation field is updated in the layer’s attribute table.

Suggerimento: Se si tiene premuto il tasto Ctrl, la rotazione avverrà per step di 15 gradi.
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Figure 12.75: Ruota Simboli del Punto

Offset dei simboli per i punti

Lo strumento Simbolo del punto di offset ti consente di modificare in modo interattivo la posizione di visualizzazione

di simboli puntuali nella mappa. Questo strumento si comporta come lo strumento Ruota i simboli del punto salvo
che richiede di connettere un campo al dato definito in Offset (X, Y) del simbolo, campo che verrà quindi popolato
con le coordinate di offset mentre si sposta il simbolo nell’area di visualizzazione mappa.

Nota: The Offset Point Symbols tool doesn’t move the point feature itself; you should use the Node Tool or
Move Feature tool for this purpose.

Avvertimento: Ensure to assign the same field to all symbol layers
If at least two layers of the symbol have different fields assigned to their data-defined property (e.g. rotation),
the corresponding tool will consider that no field is assigned to the symbol property and won’t perform the
action.

Tracciamento automatico

Usually, when using capturing map tools (add feature, add part, add ring, reshape and split), you need to click
each vertex of the feature.

Using the automatic tracing mode you can speed up the digitization process. Enable the Tracing tool by pushing
the icon or pressing t key and snap to a vertex or segment of a feature you want to trace along. Move the mouse
over another vertex or segment you’d like to snap and instead of an usual straight line, the digitizing rubber band
represents a path from the last point you snapped to the current position. QGIS actually uses the underlying
features topology to build the shortest path between the two points. Click and QGIS places the intermediate
vertices following the path. You no longer need to manually place all the vertices during digitization.

Tracing requires snapping to be activated in traceable layers to build the path. You should also snap to an existing
vertex or segment while digitizing and ensure that the two nodes are topologically connectable following existing
features, otherwise QGIS is unable to connect them and thus traces a single straight line.

Nota: Regolare la scala della mappa o le impostazioni di aggancio per un tracciamento ottimale
Se ci sono troppe geometrie nella visualizzazione della mappa, il tracciamento è disattivato per evitare una elabo-
razione potenzialmente lunga nella costruzione del tracciamento e un sovraccarico di memoria elevato. Dopo aver
ingrandito o disattivato alcuni layers, il tracciamento viene nuovamente abilitato.

Suggerimento: Quickly enable or disable automatic tracing by pressing t key
By pressing t key, tracing can be enabled/disabled anytime even while digitizing one feature, so it is possible to
digitize some parts of the feature with tracing enabled and other parts with tracing disabled. Tools behave as usual
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when tracing is disabled.

12.5.5 Il Pannello di Digitalizzazione Avanzata

Durante la cattura, la rimodellazione, la suddivisione delle geometrie nuove o esistenti, puoi anche utilizzare il
pannello Digitalizzazione Avanzata. Puoi digitalizzare linee esattamente parallele o perpendicolari ad una parti-
colare angolazione o bloccare le linee ad angoli specifici. Inoltre, puoi immettere direttamente le coordinate così
da poter definire in modo preciso la nuova geometria.

Figure 12.76: Il Pannello di Digitalizzazione Avanzata

Nota: Gli strumenti non sono abilitati se la visualizzazione mappa è in coordinate geografiche.

The Advanced Digitizing panel can be open either with a right-click on the toolbar and choose Advanced Dig-

itizing panel or in View → Panels → Advanced Digitizing Panel. Once the panel is visible, click the
enable advanced digitizing tool button to activate the Advanced Digitizing tool.

Concetti

Lo scopo dello strumento di Digitalizzazione Avanzata è quello di bloccare le coordinate, le lunghezze e gli angoli
quando si sposta il mouse durante la digitalizzazione nella area di visualizzazione mappa.

Puoi inoltre creare vincoli con riferimenti relativi o assoluti. Il riferimento relativo significa che i successivi valori
dei vincoli saranno relativi al vertice o al segmento precedente.

Impostazioni di aggancio

Fai click sul pulsante per definire le impostazioni dello strumento Digitalizzazione Avanzata. Puoi utilizzare
lo strumento di aggancio ai comuni angoli. Le opzioni sono:

• Non agganciare agli angoli comuni

• Agganciare agli angoli 30°

• Agganciare agli angoli 45°

• Agganciare agli angoli 90°

Puoi anche controllare le modalità di aggancio alle geometrie. Le opzioni sono:

• Non agganciare a vertici o segmenti
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• Agganciare in base alle impostazioni del progetto

• Agganciare su tutti i layer

Tasti di scelta rapida

Per accelerare l’uso del pannello di Digitalizzazione Avanzata, sono disponibili un paio di scorciatoie da tastiera:

Chiave Semplice Ctrl + or Alt + Shift +
d impostare distanza Bloccare distanza
a Impostare angolo Bloccare angolo Attivare l’angolo riferito all’ultimo segmento
x Set x coordinate Lock x coordinate Toggle relative x to last vertex
y Set y coordinate Lock y coordinate Toggle relative y to last vertex
c Attivare modalità costruzione
p Attivare modalità perpendicolare e parallela

Digitalizzazione a riferimento assoluto

Quando si disegna una nuova geometria da zero, è molto utile avere la possibilità di avviare la digitalizzazione dei
vertici in corrispondenza di determinate coordinate.

Ad esempio, per aggiungere una nuovo elemento a un layer poligonale, fai click sul pulsante . Puoi scegliere
le coordinate X e Y da cui vuoi iniziare a modificare la geometria, quindi:

• Click the x text box (or use the x keyboard shortcuts).

• Immetti il valore della coordinata X desiderato e premi Invio oppure fai click sul pulsante a destra per
bloccare il mouse sull’asse X sulla mappa.

• Click the y text box (or use the y keyboard shortcuts).

• Immetti il valore della coordinata Y desiderato e premi Invio oppure fai click sul pulsante a destra per
bloccare il mouse sull’asse Y sulla mappa.

Due linee tratteggiate in blu e una croce verde identificano le coordinate esatte che hai immesso. Inizia la digital-
izzazione facendo clic sulla mappa; la posizione del mouse è bloccata alla croce verde.

Figure 12.77: Iniziare a tracciare da coordinate scelte

Puoi continuare la digitalizzazione a mano libera, aggiungere una nuova coppia di coordinate oppure digitare la
lunghezza (distanza) e l’ angolo del segmento.

If you want to draw a segment of a given length, click the d (distance) text box (keyboard shortcut d), type the

distance value (in map units) and press Enter or click the button on the right to lock the mouse in the map
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canvas to the length of the segment. In the map canvas, the clicked point is surrounded by a circle whose radius is
the value entered in the distance text box.

Figure 12.78: Segmento di lunghezza fissata

Finally, you can also choose the angle of the segment. As described before , click the a (angle) text box (keyboard

shortcut a), type the angle value (in degrees), and press Enter or click the buttons on the right to lock it. In
this way the segment will follow the desired angle:

Figure 12.79: Segmento ad angolo fissato

Digitalizzazione di riferimento relativo

Invece di utilizzare valori assoluti di angoli o coordinate, puoi anche utilizzare valori relativi all’ultimo vertice o
segmento digitalizzato.

For angles, you can click the button on the left of the a text box (or press Shift + a) to toggle relative
angles to the previous segment. With that option on, angles are measured between the last segment and the mouse
pointer.

For coordinates, click the buttons to the left of the x or y text boxes (or press Shift + x or Shift + y) to
toggle relative coordinates to the previous vertex. With these options on, coordinates measurement will consider
the last vertex to be the x and y axes origin.
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Blocco continuo

Both in absolute or relative reference digitizing, angle, distance, x and y constraints can be locked continuously by

clicking the Continuous lock buttons. Using continuous lock allows you to digitize several points or vertexes
using the same constraints.

Parallel and perpendiculars line

Tutti gli strumenti sopra descritti possono essere combinati con gli strumenti Perpendicolare e Parallelo. Questi
due strumenti consentono di disegnare segmenti perfettamente perpendicolari o paralleli ad un altro segmento.

To draw a perpendicular segment, during the editing click the Perpendicular icon (keyboard shortcut p) to ac-
tivate it. Before drawing the perpendicular line, click on the segment of an existing feature that you want to be
perpendicular to (the line of the existing feature will be colored in light orange); you should see a blue dotted line
where your feature will be snapped:

Figure 12.80: Digitalizzare in perpendicolare

To draw a parallel feature, the steps are the same: click on the Parallel icon (keyboard shortcut p twice), click
on the segment you want to use as reference and start drawing your feature:

Solo questi due strumenti determinano l’angolo corretto perpendicolare e parallelo e bloccano questo parametro
durante la modifica.

Modalità di costruzione

You can enable and disable construction mode by clicking on the Construction icon or with the c keyboard
shortcut. While in construction mode, clicking the map canvas won’t add new vertexes, but will capture the
clicks’ positions so that you can use them as reference points to then lock distance, angle or x and y relative
values.

Ad esempio, la modalità di costruzione può essere usata per disegnare un certo punto in una distanza esatta da un
punto esistente.

With an existing point in the map canvas and the snapping mode correctly activated, you can easily draw other

points at given distances and angles from it. In addition to the button, you have to activate also the construction

mode by clicking the Construction icon or with the c keyboard shortcut.
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Figure 12.81: Digitalizzare in parallelo

Click next to the point from which you want to calculate the distance and click on the d box (d shortcut) type the
desired distance and press Enter to lock the mouse position in the map canvas:

Figure 12.82: Distanza da un punto

Before adding the new point, press c to exit the construction mode. Now, you can click on the map canvas, and
the point will be placed at the distance entered.

You can also use the angle constraint to, for example, create another point at the same distance of the original one,

but at a particular angle from the newly added point. Click the Construction icon or with the c keyboard shortcut
to enter construction mode. Click the recently added point, and then the other one to set a direction segment. Then,
click on the d text box (d shortcut) type the desired distance and press Enter. Click the a text box (a shortcut)
type the angle you want and press Enter. The mouse position will be locked both in distance and angle.

Before adding the new point, press c to exit the construction mode. Now, you can click on the map canvas, and
the point will be placed at the distance and angle entered. Repeating the process, several points can be added.
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Figure 12.83: Distanza ed angolo fra punti

Figure 12.84: Punti a distanza ed angolo fissato
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CHAPTER 13

Lavorare con i dati raster

13.1 Proprietà raster

To view and set the properties for a raster layer, double click on the layer name in the map legend, or right click on
the layer name and choose Properties from the context menu. This will open the Raster Layer Properties dialog
(see figure_raster_properties).

Ci sono diverse schede nella finestra di dialogo:

• General

• Style

• Transparency

• Pyramids

• Histogram

• Metadata

• Legend

Figure 13.1: Raster Layers Properties Dialog

Suggerimento: Aggiornamenti in tempo reale
Il pannello Pannello Stile Layer ti fornisce alcune delle caratteristiche comuni della finestra di dialogo Proprietà
layer ed è uno strumento semplice che puoi utilizzare per velocizzare la configurazione degli stili del layer e
automaticamente visualizzare le modifiche apportate alla mappa.
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Nota: Poiché le proprietà (simbologia, etichetta, azioni, valori predefiniti, forms...) dei layers nidificati (vedi
Progetti nidificati) vengono estratte dal progetto originale, per evitare modifiche che potrebbero interrompere
questo comportamento, la finestra di dialogo Proprietà Layer non è disponibile per questi layers.

13.1.1 General Properties

Layer Info

The General tab displays basic information about the selected raster, including the layer source path, the display
name in the legend (which can be modified), and the number of columns, rows and no-data values of the raster.

Coordinate Reference System

Displays the layer’s Coordinate Reference System (CRS) as a PROJ.4 string. You can change the layer’s CRS,

selecting a recently used one in the drop-down list or clicking on Select CRS button (see Scelta del sistema di
riferimento delle coordinate). Use this process only if the CRS applied to the layer is a wrong one or if none
was applied. If you wish to reproject your data into another CRS, rather use layer reprojection algorithms from
Processing or Save it into another layer.

13.1.2 Scale dependent visibility

Puoi impostare la scala a Massimo (incluso) e Minimumo (escluso), definendo un intervallo di scala in cui il layer

sarà visibile. Fuori di questo intervallo, il layer sarà nascosto. Il pulsante Imposta alla scala corrente dell’estensione di mappa

ti consente di utilizzare la scala corrente della mappa come limite di visibilità del raster. Per maggiori informazioni
vedi Visualizzazione in funzione della scala.

13.1.3 Style Properties

Visualizzazione banda

QGIS offre quattro Tipo visualizzazione. La scelta dipende dal tipo di dato.

1. Multiband color - if the file comes as a multiband with several bands (e.g., used with a satellite image with
several bands)

2. Paletted - if a single band file comes with an indexed palette (e.g., used with a digital topographic map)

3. Singleband gray - (one band of) the image will be rendered as gray; QGIS will choose this renderer if the
file has neither multibands nor an indexed palette nor a continuous palette (e.g., used with a shaded relief
map)

4. Singleband pseudocolor - this renderer is possible for files with a continuous palette, or color map (e.g.,
used with an elevation map)

Multiband color

With the multiband color renderer, three selected bands from the image will be rendered, each band representing
the red, green or blue component that will be used to create a color image. You can choose several Contrast
enhancement methods: ‘No enhancement’, ‘Stretch to MinMax’, ‘Stretch and clip to MinMax’ and ‘Clip to min
max’.

This selection offers you a wide range of options to modify the appearance of your raster layer. First of all, you
have to get the data range from your image. This can be done by choosing the Extent and pressing [Load]. QGIS
can Estimate (faster) the Min and Max values of the bands or use the Actual (slower) Accuracy.

Now you can scale the colors with the help of the Load min/max values section. A lot of images have a few very
low and high data. These outliers can be eliminated using the Cumulative count cut setting. The standard data
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Figure 13.2: Raster Style - Multiband color rendering

range is set from 2% to 98% of the data values and can be adapted manually. With this setting, the gray character
of the image can disappear. With the scaling option Min/max, QGIS creates a color table with all of the data
included in the original image (e.g., QGIS creates a color table with 256 values, given the fact that you have 8
bit bands). You can also calculate your color table using the Mean +/- standard deviation x . Then,
only the values within the standard deviation or within multiple standard deviations are considered for the color
table. This is useful when you have one or two cells with abnormally high values in a raster grid that are having a
negative impact on the rendering of the raster.

All calculations can also be made for the Current extent.

Suggerimento: Visualizzare una singola banda di un raster multibanda
If you want to view a single band of a multiband image (for example, Red), you might think you would set the
Green and Blue bands to “Not Set”. But this is not the correct way. To display the Red band, set the image type to
‘Singleband gray’, then select Red as the band to use for Gray.

Paletted

Questa è l’opzione normale di visualizzazione per i file a banda singola che includono già una tabella di colori,
dove ad ogni valore di pixel viene assegnato un determinato colore. In questo caso, la tavolozza viene visualizzata
automaticamente. Se vuoi modificare i colori assegnati a determinati valori, basta fare doppio click sul colore e
viene visualizzata la finestra di dialogo Scegli colore. Inoltre, in QGIS puoi assegnare un’etichetta ai valori di
colore. L’etichetta compare quindi nella legenda del layer raster.

Miglioramento contrasto

Nota: Quando si aggiungono raster GRASS, l’opzione Miglioramento del contrasto sarà sempre impostata
automaticamente su Stira a MinMax, indipendentemente dal fatto che sia impostata su un altro valore nelle opzioni
generali di QGIS.
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Figure 13.3: Raster Style - Paletted Rendering

Singleband gray

This renderer allows you to render a single band layer with a Color gradient: ‘Black to white’ or ‘White to black’.
You can define a Min and a Max value by choosing the Extent first and then pressing [Load]. QGIS can
Estimate (faster) the Min and Max values of the bands or use the Actual (slower) Accuracy.

Figure 13.4: Raster Style - Singleband gray rendering

With the Load min/max values section, scaling of the color table is possible. Outliers can be eliminated using the
Cumulative count cut setting. The standard data range is set from 2% to 98% of the data values and can be

adapted manually. With this setting, the gray character of the image can disappear. Further settings can be made
with Min/max and Mean +/- standard deviation x . While the first one creates a color table with
all of the data included in the original image, the second creates a color table that only considers values within
the standard deviation or within multiple standard deviations. This is useful when you have one or two cells with
abnormally high values in a raster grid that are having a negative impact on the rendering of the raster.

Singleband pseudocolor

Questa è l’opzione di visualizzazione per i le a banda singola che includono una tavolozza continua. Qui puoi
anche creare mappe di colori specifici per le bande singole.

Three types of color interpolation are available:

1. Discrete

2. Lineare

3. Exact
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Figure 13.5: Raster Style - Singleband pseudocolor rendering
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In the left block, the button Add values manually adds a value to the individual color table. The button
Remove selected row deletes a value from the individual color table, and the Sort colormap items button sorts the color
table according to the pixel values in the value column. Double clicking on the value column lets you insert a
specific value. Double clicking on the color column opens the dialog Change color, where you can select a color
to apply on that value. Further, you can also add labels for each color, but this value won’t be displayed when you

use the identify feature tool. You can also click on the button Load color map from band, which tries to load the table

from the band (if it has any). And you can use the buttons Load color map from file or Export color map to file to load
an existing color table or to save the defined color table for other sessions.

In the right block, Generate new color map allows you to create newly categorized color maps. For the Classi-

fication mode ‘Equal interval’, you only need to select the number of classes and press the button

Classify. You can invert the colors of the color map by clicking the Invert checkbox. In the case of the Mode

‘Continuous’, QGIS creates classes automatically depending on the Min and Max. Defining Min/Max val-
ues can be done with the help of the Load min/max values section. A lot of images have a few very low and high
data. These outliers can be eliminated using the Cumulative count cut setting. The standard data range is set
from 2% to 98% of the data values and can be adapted manually. With this setting, the gray character of the image
can disappear. With the scaling option Min/max, QGIS creates a color table with all of the data included in the
original image (e.g., QGIS creates a color table with 256 values, given the fact that you have 8 bit bands). You can
also calculate your color table using the Mean +/- standard deviation x . Then, only the values within
the standard deviation or within multiple standard deviations are considered for the color table.

Visualizzazione colore

Per ogni Visualizzazione banda, è disponibile una Visualizzazione colore.

Puoi anche ottenere effetti speciali per i tuoi file(s) raster usando una delle modalità di fusione (vedi Metodi di
fusione).

Ulteriori impostazioni possono essere fatte modificando la Luminosità, la Saturazione e il Contrasto. Puoi usare
anche l’opzione Scala di grigi dove puoi scegliere fra ‘Per chiarezza’, ‘Per luminosità’ e ‘Per media’. Puoi
modificare la ‘Forza’ per ogni tonalità della tabella dei colori.

Ricampionamento

La sezione Ricampionamento ha effetto quando ingrandisci o rimpicciolisci l’immagine. I metodi di ricampiona-
mento ottimizzano l’aspetto della mappa perché calcolano una nuova matrice di grigi attraverso una trasformazione
geometrica.

Figure 13.6: Raster Style - Color rendering and Resampling settings

Applicando il metodo ‘vicino più prossimo’ la mappa potrebbe avere una struttura con molti pixel quando viene
ingrandita. Questo aspetto può essere migliorato usando i metodi ‘Bilineare’ o ‘Cubico’ perché creano delle
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geometrie più appuntite e offuscate. Il risultato è un’immagine più morbida. Puoi applicare questo metodo, per
esempio, a mappe raster topografiche.

At the bottom of the Style tab, you can see a thumbnail of the layer, its legend symbol, and the palette.

13.1.4 Scheda Trasparenza

QGIS has the ability to display each raster layer at a different transparency level. Use the transparency slider

to indicate to what extent the underlying layers (if any) should be visible though the current
raster layer. This is very useful if you like to overlay more than one raster layer (e.g., a shaded relief map overlayed
by a classified raster map). This will make the look of the map more three dimensional.

Inoltre puoi inserire un valore del dato raster che deve essere trattato come NODATA con la opzione Valori nulli
aggiuntivi.

An even more flexible way to customize the transparency can be done in the Custom transparency options section.
The transparency of every pixel can be set here.

As an example, we want to set the water of our example raster file landcover.tif to a transparency of 20%.
The following steps are necessary:

1. Load the raster file landcover.tif.

2. Open the Properties dialog by double-clicking on the raster name in the legend, or by right-clicking and
choosing Properties from the pop-up menu.

3. Select the Transparency tab.

4. From the Transparency band drop-down menu, choose ‘None’.

5. Clicca sul pulsante Aggiungi valori manualmente. Apparirà cosi una nuova riga.

6. Enter the raster value in the ‘From’ and ‘To’ column (we use 0 here), and adjust the transparency to 20%.

7. Press the [Apply] button and have a look at the map.

You can repeat steps 5 and 6 to adjust more values with custom transparency.

Come puoi vedere è molto semplice impostare una trasparenza personalizzata, però richiede comunque un po’ di

lavoro. Proprio per questo puoi usare il pulsante Esporta su le per salvare la lista dei valori su un le esterno. Il

pulsante Importa da file ti permette di caricare le impostazioni di trasparenza e applicarle al raster selezionato.

13.1.5 Proprietà delle Piramidi

I raster ad alta risoluzione possono rallentare notevolmente il lavoro in QGIS. Creando copie a bassa risoluzione
dei dati (piramidi) puoi incrementare notevolmente le prestazioni in quanto QGIS sceglierà la risoluzione migliore
in funzione del fattore di zoom.

Per creare piramidi devi avere i permessi di scrittura nella cartella contenente il dato originale: in questa cartella
verranno salvate le copie a bassa risoluzione.

Dall’elenco Risoluzioni, seleziona le risoluzioni per le quali si desidera creare la piramide facendo clic su di esse.

Se scegli Interno (se possibile) dal menu a tendina Formato panoramica, QGIS proverà a costruire le piramidi
internamente.

Nota: La costruzione delle piramidi può alterare il dato originale in maniera irreversibile, quindi ti raccomandi-
amo di fare una copia del raster originale prima di eseguire l’operazione.

Se scegli Esterno e Esterno (immagine Erdas) le piramidi verranno create in un file accanto al raster originale
con lo stesso nome e un’estensione .ovr.

Diversi metodi di Ricampionamento possono essere utilizzati per calcolare le piramidi:
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• Vicino più prossimo (metodo Nearest Neighbour)

• Media

• Gauss

• Cubico

• Modo

• Nessuno

Finally, click [Build pyramids] to start the process.

Figure 13.7: Piramidi raster

13.1.6 Proprietà Istogramma

The Histogram tab allows you to view the distribution of the bands or colors in your raster. The histogram is
generated automatically when you open the Histogram tab. All existing bands will be displayed together. You

can save the histogram as an image with the button. With the Visibility option in the Prefs/Actions menu,
you can display histograms of the individual bands. You will need to select the option Show selected band.
The Min/max options allow you to ‘Always show min/max markers’, to ‘Zoom to min/max’ and to ‘Update style
to min/max’. With the Actions option, you can ‘Reset’ and ‘Recompute histogram’ after you have chosen the
Min/max options.

13.1.7 Proprietà Metadati

The Metadata tab displays a wealth of information about the raster layer, including statistics about each band in
the current raster layer. From this tab, entries may be made for the Description, Attribution, MetadataUrl and
Properties. In Properties, statistics are gathered on a ‘need to know’ basis, so it may well be that a given layer’s
statistics have not yet been collected.

13.1.8 Proprietà Legenda

The Legend tab provides you with a list of widgets you can embed within the layer tree in the Layers panel. The
idea is to have a way to quickly access some actions that are often used with the layer (setup transparency, filtering,
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Figure 13.8: Istogramma del raster

Figure 13.9: Raster Metadata
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selection, style or other stuff...).

Per impostazione predefinita, QGIS fornisce il widget di trasparenza ma a questa opzione possono aggiungersi i
widget dei plugin che hanno propri widget e assegnano azioni personalizzate ai layer che gestiscono.

13.2 Analisi raster

13.2.1 Calcolatore raster

Il Calcolatore raster. . . . nel menu Raster ti consente di eseguire calcoli sulla base dei valori dei pixel esistenti nel
raster (vedi figure_raster_calculator). I risultati vengono scritti in un nuovo raster con un formato supportato da
GDAL

Figure 13.10: Calcolatore raster

La lista Bande raster elenca i raster caricati che possono essere utilizzati. Per aggiungere un raster nella fines-
tra Espressione del calcolatore di raster, fai doppio click sul suo nome nella finestra Bande raster. Puoi usare
gli operatori per costruire un’espressione oppure puoi scriverla direttamente nella finestra delle Espressione del
calcolatore di raster.

Nella sezione Risultato del layer devi definire il nome del raster in output. Hai diverse opzioni per scegliere
l’estensione dell’area di calcolo: sulla base del raster in input, su coordinate X e Y oppure sulla base del numero
di righe e colonne, per impostare la risoluzione finale del raster in output. Se il raster in input ha una risoluzione
diversa, i valori verranno ricampionati con l’algoritmo del vicino più prossimo.

La sezione Operatori elenca tutti gli operatori disponibili. Per aggiungere un operatore alla finestra Espressione
del calcolatore di raster, clicca sull’icona appropriata. Sono disponibili operatori Matematici (+, -, *, ... ) e
funzioni trigonometriche ((sin, cos, tan, ... ). Le espressioni condizionali (=‘‘, ‘!=‘‘, <‘, >=, .... )
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restituiscono 0 per falso o 1 per vero, e quindi possono essere utilizzate con altri operatori e funzioni. Restate
sintonizzati per l’arrivo di altri operatori!

Selezionando la casella di controllo Aggiungi al progetto il raster finale verrà aggiunto automaticamente alla
legenda e lo potrai visualizzare sulla mappa.

Esempi

Convertire unità di misura dell’elevazione da metri a piedi

Per creare un raster con altimetria in piedi a partire da un raster con altimetria in metri devi utilizzare il fattore di
conversione di 3,28 piedi per metro. L’espressione è:

"elevation@1" * 3.28

Utilizzare una maschera

Se vuoi usare una maschera su parti di un raster - perché, per esempio, sei interessato solo ai valori di altezza
superiori allo 0 - puoi usare l’espressione seguente per creare in un solo passaggio una maschera e applicare il
risultato al raster.

("elevation@1" >= 0) * "elevation@1"

In altre parole, per ogni cella maggiore o uguale a 0 imposta il valore uguale a 1, in questo modo si mantiene il
valore originario moltiplicandolo per 1. Altrimenti imposta 0, il che imposta il valore del raster a 0. In questo
modo creerai la maschera al volo.

Se vuoi classificare un raster, ad esempio, in due classi di elevazione, puoi utilizzare la seguente espressione per
creare un raster con due valori 1 e 2 in un solo passo.

("elevation@1" < 50) * 1 + ("elevation@1" >= 50) * 2

In altre parole, per ogni cella minore di 50 imposta il valore su 1. Per ogni cella maggiore o uguale a 50 imposta
il valore su 2.

13.2.2 Allineamento Raster

Questo strumento è in grado di prendere diversi raster come input e di allinearli perfettamente, il che significa:

• riproiettare allo stesso SR,

• ricampionare alla stessa dimensione di cella e offset nella griglia,

• ritagliare a una regione di interesse,

• ridimensionare i valori quando necessario.

Tutti i raster saranno salvati in altri files.

In primo luogo, apri gli strumenti da Raster → Allinea Raster. . . e fai click sul pulsante Aggiungi nuovo raster

per scegliere un raster esistente in QGIS. Seleziona un le di output per salvare il raster dopo l’allineamento, il
metodo di ricampionamento e se è necessario Riscala i valori in base alla dimensione della cella. Il metodo di
ricampionamento può essere (vedi figure_raster_align_edit):

• Vicini più prossimi (Nearest Neighbor)

• Bilineare (2x2 kernel)

• Cubica (4x4 kernel)

• Cubica B-Spline (4x4 kernel)

• Lanczos (6x6 kernel)

• Media
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• Modo

• Massimo, Minimo, Mediana, Primo Quartile (Q1) o Terzo Quartile (Q3) di tutti i pixel diversi da
NODATA

Nota: I metodi Massimo, Minimo, Mediana, Primo e Terzo Quartile sono disponibili solo se QGIS opera con
GDAL >= 2.0.

Figure 13.11: Selezione Opzioni di ricampionamento raster

Nella finestra di dialogo principale Align raster puoi anche Modificare le impostazioni del file o Rimuovere un file esistente

dall’elenco dei layers raster. Puoi scegliere una o più opzioni (vedi figure_raster_align):

• Seleziona Layer di riferimento,

• Trasforma in un nuovo SR,

• Settaggio ad una diversa Dimensione cella,

• Settaggio ad un differente Offset reticolo,

• Ritaglio all’estensione della mappa: definito dall’utente o basato sul layer o sulla vista del layer nella mappa

• Dimensioni in uscita,

• Aggiungi i raster allineati alla mappa.
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Figure 13.12: Allineamento Raster
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CHAPTER 14

Print Composer

With the Print Composer you can create nice maps and atlasses that can be printed or saved as PDF-file, an image
or an SVG-file. This is a powerful way to share geographical information produced with QGIS that can be included
in reports or published.

14.1 Overview of the Print Composer

The Print Composer provides growing layout and printing capabilities. It allows you to add elements such as
the QGIS map canvas, text labels, images, legends, scale bars, basic shapes, arrows, attribute tables and HTML
frames. You can size, group, align, position and rotate each element and adjust their properties to create your
layout. The layout can be printed or exported to image formats, PostScript, PDF or to SVG (export to SVG is
not working properly with some recent Qt4 versions; you should try and check individually on your system). You
can save the layout as a template and load it again in another session. Finally, generating several maps based on a
template can be done through the atlas generator.

14.1.1 Sessione di esempio

Before you start to work with the Print Composer, you need to load some raster or vector layers in the QGIS map
canvas and adapt their properties to suit your own convenience. After everything is rendered and symbolized to

your liking, click the New Print Composer icon in the toolbar or choose File → New Print Composer. You will be
prompted to choose a title for the new Composer.

Per mostrare come creare una mappa segui le seguenti istruzioni.

1. Nella barra degli Strumenti oggetti del compositore, seleziona il pulsante Aggiungi nuova mappa e disegna un
rettangolo sul foglio del compositore di stampa tenendo premuto il pulsante sinistro del mouse. All’interno
del rettangolo disegnato si attiva la visualizzazione della mappa QGIS.

2. Select the Add new scalebar toolbar button and click with the left mouse button on the Print Composer
canvas. A scalebar will be added to the canvas.

3. Seleziona Aggiungi nuova legenda e disegna un rettangolo sul foglio tenendo premuto il pulsante sinistro del
mouse. Nel rettangolo verrà disegnata una legenda.

4. Seleziona Seleziona/Muovi oggetto per selezionare la mappa sul foglio e spostarla.

5. Mentre l’oggetto mappa è ancora selezionato puoi modificare le dimensioni della mappa. Fai click tenendo
premuto il pulsante sinistro del mouse, in un piccolo rettangolo bianco in uno degli angoli dell’oggetto
mappa e scegli una nuova posizione per modificare la sua dimensione.

6. Fai click sulla scheda Proprietà oggetto sul lato sinistro e cerca le impostazioni per l’orientamento. Cam-
bia il valore dell’impostazione Rotazione a ‘15,00° ‘. Dovresti vedere l’orientamento della modifica della
mappa.

239



QGIS User Guide, Release 2.18

7. Now, you can print or export your print composition to image formats, PDF or to SVG with the export tools
in Composer menu.

8. Finally, you can save your print composition within the project file with the Save Project button.

You can add multiple elements to the Composer. It is also possible to have more than one map view or legend or
scale bar in the Print Composer canvas, on one or several pages. Each element has its own properties and, in the
case of the map, its own extent. If you want to remove any elements from the Composer canvas you can do that
with the Delete or the Backspace key.

14.1.2 The Composer Manager

The Composer Manager is the main window to manage print composers in the project. It helps you add new print

composer, duplicate an existing one, rename or delete it. To open the composer manager dialog, click on the
Composer Manager button in the toolbar or choose Composer → Composer Manager. It can also be reached from the
main window of QGIS with Project → Composer Manager.

Figure 14.1: The Print Composer Manager

The composer manager lists in its upper part all the available print composers in the project. The bottom part
shows tools that help to:

• show the selected composer(s): you can open multiple print composers in one-click

• duplicate the selected composer (available only if one print composer is selected): it creates a new composer
using the selected composer as template. You’ll be prompted to choose a new title for the new composer

• rename the composer (also available only if one print composer is selected): You’ll be prompted to choose
a new title for the composer. Note that you can also rename the composer by double-clicking on its title in
the upper part

• remove the composer: the selected print composer(s) will be deleted from the project.

With the Composer Manager, it’s also possible to create new print composers as an
empty composer or from a saved template. By default, QGIS will look for tem-
plates in user directory (~/.qgis2/composer_templates) or application’s one
(ApplicationFolder/composer_templates). QGIS will retrieve all the available templates and
propose them in the combobox. The selected template will be used to create a new composer when clicking Add
button. You can also save composer templates in another folder. Choosing specific in the template list offers the
ability to select such template and use it to create a new print composer.
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14.1.3 Menus, tools and panels of the print composer

Opening the Print Composer provides you with a blank canvas that represents the paper surface when using the
print option. Initially you find buttons on the left beside the canvas to add map composer items: the current QGIS
map canvas, text labels, images, legends, scale bars, basic shapes, arrows, attribute tables and HTML frames. In
this toolbar you also find toolbar buttons to navigate, zoom in on an area and pan the view on the composer and
toolbar buttons to select a map composer item and to move the contents of the map item.

Figure_composer_overview shows the initial view of the Print Composer before any elements are added.

Figure 14.2: Print Composer

On the right beside the canvas you find two set of panels. The upper one holds the panels Items and Command
History and the lower holds the panels Composition, Item properties and Atlas generation.

• The Items panel provides a list of all map composer items added to the canvas.

• The Command history panel displays a history of all changes applied to the Print Composer layout. With a
mouse click, it is possible to undo and redo layout steps back and forth to a certain status.

• The Composition panel allows you to set paper size, orientation, the page background, number of pages and

print quality for the output file in dpi. Furthermore, you can also activate the Print as raster checkbox.
This means all items will be converted to raster before printing or saving as PostScript or PDF. In this panel,
you can also customize settings for grid and smart guides.

• The Item Properties panel displays the properties for the selected item. Click the Select/Move item icon
to select an item (e.g., legend, scale bar or label) on the canvas. Then click the Item Properties panel and
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customize the settings for the selected item (see Composer Items for detailed information on each item
settings).

• The Atlas generation panel allows you to enable the generation of an atlas for the current Composer and
gives access to its parameters (see Generazione Atlante for detailed information on atlas generation usage).

In the bottom part of the Print Composer window, you can find a status bar with mouse position, current page
number, a combo box to set the zoom level, the number of selected items if applicable and, in the case of atlas
generation, the number of features.

In the upper part of the Print composer window, you can find menus and other toolbars. All Print Composer tools
are available in menus and as icons in a toolbar. See a list of tools in table_composer_tools.

The toolbars and the panels can be switched off and on using the right mouse button over any toolbar or through
View → Toolbars or View → Panels.
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Tools

Icon Purpose Icon Purpose

Save Project New Composer

Duplicate Composer Composer Manager

Load from template Save as template

Print or export as PostScript Export to an image format

Export print composition to SVG Export as PDF

Revert last change Restore last change

Zoom to full extent Zoom to 100%

Zoom in Zoom out

Refresh View

Pan Zoom to specific region

Select/Move item in print composition Move content within an item

Add new map from QGIS map canvas Add image to print composition

Add label to print composition Add new legend to print composition

Add scale bar to print composition Add basic shape to print composition

Add arrow to print composition Add attribute table to print composition

Add an HTML frame Add nodes shape to print composition

Edit a nodes shape

Group items of print composition Ungroup items of print composition

Lock Selected Items Unlock All items

Raise selected items Lower selected items

Move selected items to top Move selected items to bottom

Align selected items left Align selected items right

Align selected items center Align selected items center vertical

Align selected items top Align selected items bottom

Preview Atlas First Feature

Previous Feature Next Feature

Last feature Print Atlas

Export Atlas as Image Atlas Settings

Table Composer 1: Print Composer Tools

Composer Menu

With the Composer → Save Project action, you can save the project file directly from the print composer window.
The Composer menu also provides actions to:

• Create a new and blank print composer with New Composer...

• Duplicate Composer... : Create a new print composer by duplicating the current one
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• Open the Composer Manager...

• Print Composers... : Open an existing print composer

Once the layout is designed, with Save as template and Add items from template icons, you can save the current state
of a Print Composer session as a .qpt template and load its item again in another session.

In the Composer menu, there are also powerful ways to share geographical information produced with QGIS that

can be included in reports or published. These tools are Export as Image..., Export as PDF..., Export as SVG... and
Print....

Menu Impostazioni

From Settings → Composer Options you can set some options that will be used as default on any composer during
your work.

• Compositions defaults let you specify the default font to use.

• With Grid appearance, you can set the grid style and its color. There are three types of grid: Dots, Solid
lines and Crosses.

• Grid and guide defaults defines spacing, offset and tolerance of the grid.

Edit Menu

Copy/Cut and Paste Items

The print composer includes actions to use the common Copy/Cut/Paste functionality for the items in the layout.
As usual first you need to select the items using one of the options seen above; at this point the actions can be
found in the Edit menu. When using the Paste action, the elements will be pasted according to the current mouse
position. Using the Edit → Paste in Place action or pressing Ctrl+Shift+V will paste the items into the current
page, at the same position they were in their initial page. It ensures to copy/paste items at the same place, from
page to page.

Nota: HTML items can not be copied in this way. As a workaround, use the [Add Frame] button in the Item
Properties panel.

View Menu

Navigation Tools

To navigate in the canvas layout, the Print Composer provides some general tools:

• Zoom In

• Zoom Out

• Zoom Full

• Zoom to 100%

• Refresh view (if you find the view in an inconsistent state)

• Show Grid behind items.

• Snap Grid to snap items on the grid.
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• Show Guides to help user to align items. These are red line that you can click in the rule (above or at the
left side of the layout) and drag and drop to the desired location.

• Snap Guides: allows user to snap items to the guides,

• Smart Guides: uses other composer items as guides to dynamically snap to as user moves or reshapes an
item.

• Clear Guides to remove all current guides.

• Show Bounding box around the items.

• Show Rules around the layout.

• Show Pages or set up pages to transparent. Often composer is used to create non-print layouts, e.g. for
inclusion in presentations or other documents, and it’s desirable to export the composition using a totally
transparent background. It’s sometimes referred to as “infinite canvas” in other editing packages.

• Toggle Full Screen makes the composer window to full screen.

• Hide Panels hides/shows the right panel

• Panels lists all panels available to hide/show them.

• Toolbars same as above for toolbars.

You can change the zoom level also using the mouse wheel or the combo box in the status bar. If you need
to switch to pan mode while working in the Composer area, you can hold the Spacebar or the mouse wheel.
With Ctrl+Spacebar, you can temporarily switch to Zoom In mode, and with Ctrl+Shift+Spacebar, to
Zoom Out mode.

Hide and Show Panels

To maximise the space available to interact with a composition you can use View → Hide panels or press F10.

Nota: It’s also possible to switch to a full screen mode to have more space to interact by pressing F11 or using
View → Toggle full screen.

Composition Panel

Page size and settings

In the Composition panel, you can define the global settings of the current composition.

You can choose one of the Presets formats for your paper sheet, or enter your custom width, height and units. You
can also choose the page Orientation to use.

Composition can be divided into several pages. For instance, a first page can show a map canvas, and a second
page can show the attribute table associated with a layer, while a third one shows an HTML frame linking to your
organization website. Set the Number of pages to the desired value. you can also custom the Page Background
with the color or the symbol you want.

The Page size options apply to all the pages in the composition. However, you can modify the values using the
data defined override options (see Data Defined Override Buttons).

A custom page size can also be set, using the Resize page tool. This creates an unique page composition, resizes
the page to fit the current contents of the composition (with optional margins).
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Figure 14.3: Composition settings in the Print Composer

Impostazioni per l’esportazione

You can define a resolution to use for all exported maps in Export resolution. This setting can, however, be

overridden each time you are exporting a map. When checked, print as raster means all elements will be
rasterized before printing or saving as PostScript or PDF.

While exporting to an image file format, you can choose to generate a world file by checking Save world file

and select a map item in Reference map. The world file is created beside the exported map, has the same
name and contains information to georeference it easily.

Figure 14.4: Export Settings in the Print Composer

Grid and guides

You can put some reference marks on your composition paper sheet to help you place some items. These marks
can be:

• simple lines (called Guides) put at the position you want. To do that, ensure that Show Rulers and Show
Guides in View menu are checked. Then, click and drag from within the ruler to the paper sheet. A vertical
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or horizontal line is added to the paper and you can set its position following the coordinates displayed at
the left bottom of the composer dialog.

• or regular Grid.

Whether grids or guides should be shown is set in View menu. There, you can also decide if they might be used to
snap composer items. The Grid and guides section lets you customize grid settings like Grid spacing, Grid offset
and Snap tolerance to your need. The tolerance is the maximum distance below which an item is snapped to a
grid or a guide.

Figure 14.5: Snapping to grids in the Print Composer

In the Options → Composer menu in QGIS main canvas, you can also set the spacing, offset and snap tolerance
of the grid as much as its style and color. These options are applied by default to any new print composer.

Variabili

The Variables lists all the variables available at the composition’s level (which includes all global and project’s
variables).

It also allows the user to manage composition-level variables. Click the button to add a new custom

composition-level variable. Likewise, select a custom composition-level variable from the list and click the
button to remove it.

More information on variables usage in the General Tools Variables section.

Figure 14.6: Variables editor in the Print Composer

Command History Panel: Revert and Restore actions

During the layout process, it is possible to revert and restore changes. This can be done with the revert and restore
tools:

• Annulla l’ultimo cambiamento

• Ripristina l’ultimo cambiamento
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This can also be done by mouse click within the Command history panel (see figure_composer). The History
panel lists the last actions done within the composer. Just select the point you want to revert to and once you do
new action all the actions done after the selected one will be removed.

Figure 14.7: Command history in the Print Composer

Items Panel

The Items panel offers some options to manage selection and visibility of items. All the items added to the print
composer canvas are shown in a list and selecting an item makes the corresponding row selected in the list as well
as selecting a row does select the corresponding item in the print composer canvas. This is thus a handy way to
select an item placed behind another one. Note that a selected row is shown as bold.

Per ogni oggetto selezionato puoi:

• set it visible or not,

• lock or unlock its position,

• order its Z position. You can move up and down each item in the list with a click and drag. The upper item
in the list will be brought to the foreground in the print composer canvas. By default, a newly created item
is placed in the foreground.

• change the name by double-clicking the text.

Una volta che hai trovato la giusta posizione per un oggetto lo puoi bloccare selezionando in on la casella. Gli
oggetti bloccati non possono essere selezionati nell’area di stampa. Gli oggetti bloccati possono essere sbloccati
selezionando l’oggetto nella lista del pannello Oggetti e passando a non selezionata la relativa casella oppure puoi
usare l’icona nella barra degli strumenti.

14.2 Composer Items

14.2.1 Composer Items Common Options

Composer items have a set of common properties you will find at the bottom of the Item Properties panel: Position
and size, Rotation, Frame, Background, Item ID, Variables and Rendering (See figure_composer_common).

• The Position and size dialog lets you define the size and position of the frame which contains the item. You
can also choose which Reference point will be set at the X and Y coordinates previously defined.

• La Rotazione imposta la rotazione dell’oggetto (in gradi).

• The Frame shows or hides the frame around the item. Click on the [Color] and [Thickness] buttons to
adjust those properties.

• Use the Background color menu for setting a background color. Click on the [Color...] button to display a
dialog where you can pick a color or choose from a custom setting. Transparency can be adjusted through
atlering the alpha field settings.
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Figure 14.8: Common Item Properties Dialogs
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• Use the Item ID to create a relationship to other Print Composer items. This is used with QGIS server and
other potential web clients. You can set an ID on an item (for example, a map or a label), and then the
web client can send data to set a property (e.g., label text) for that specific item. The GetProjectSettings
command will list the items and IDs which are available in a layout.

• Rendering mode helps you set whether and how the item can be displayed.

Nota:

• If you checked Use live-updating color chooser dialogs in the QGIS general options, the color button
will update as soon as you choose a new color from Color Dialog windows. If not, you need to close the
Color Dialog.

• The Data defined override icon next to a field means that you can associate the field with data in the map
item or use expressions. These are particularly helpful with atlas generation (See Data Defined Override
Buttons).

Visualizzazione

QGIS now allows advanced rendering for Composer items just like vector and raster layers.

Figure 14.9: Visualizzazione

• Modalità fusione: con questo strumento puoi ottenere effetti che altrimenti sarebbero possibili solo usando
software specializzati per la manipolazione grafica. I pixel degli elementi di sovrapposizione e di sottofondo
possono essere mescolati in base alla modalità impostata (vedi Metodi di fusione per la descrizione di
ciascun effetto).

• Transparency : You can make the underlying item in the Composer visible with this
tool. Use the slider to adapt the visibility of your item to your needs. You can also make a precise definition
of the percentage of visibility in the menu beside the slider.

• Escludi oggetto dalle esportazioni: puoi decidere di rendere invisibile un oggetto in tutte le esportazioni.
Dopo aver attivato questa casella di controllo, l’oggetto non sarà incluso nell’esportazione in PDF, stampa
ecc.

Size and position

Each item inside the Composer can be moved and resized to create a perfect layout.For both operations the first

step is to activate the Select/Move item tool and to click on the item; you can then move it using the mouse while
holding the left button. If you need to constrain the movements to the horizontal or the vertical axis, just hold the
Shift button on the keyboard while moving the mouse. If you need better precision, you can move a selected
item using the Arrow keys on the keyboard; if the movement is too slow, you can speed up it by holding
Shift.

A selected item will show squares on its boundaries; moving one of them with the mouse, will resize the item
in the corresponding direction. While resizing, holding Shift will maintain the aspect ratio. Holding Alt will
resize from the item center.

The correct position for an item can be obtained using the grid snapping or smart guides. Guides are set by clicking
and dragging within the ruler area. To move a guide, click on the ruler, level with the guide and drag it to a new
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position. To delete a guide move it off the canvas. If you need to disable the snap on the fly, hold Ctrl while
moving the mouse.

You can choose multiple items with the Select/Move item button. Just hold the Shift button and click on all the
items you need. You can then resize/move this group like a single item.

Once you have found the correct position for an item, you can lock it by using the items on the toolbar or ticking
the box next to the item in the Items panel. Locked items are not selectable on the canvas.

Gli oggetti bloccati possono essere sbloccati selezionando l’oggetto nel pannello Oggetti e deselezionando la
casella di spunta oppure puoi utilizzare le icone sulla barra degli strumenti.

To unselect an item, just click on it holding the Shift button.

Inside the Edit menu, you can find actions to select all the items, to clear all selections or to invert the current
selection.

Allineamento

Raising or lowering the visual hierarchy for elements are inside the Raise selected items pull-down menu. Choose
an element on the Print Composer canvas and select the matching functionality to raise or lower the selected
element compared to the other elements. This order is shown in the Items panel. You can also raise or lower
objects in the Items panel by clicking and dragging an object’s label in this list.

Figure 14.10: Alignment helper lines in the Print Composer

There are several alignment options available within the Align selected items pull-down menu (see fig-
ure_composer_common_align). To use an alignment function, you first select the elements then click on the
matching alignment icon. All selected elements will then be aligned to their common bounding box. When mov-
ing items on the Composer canvas, alignment helper lines appear when borders, centers or corners are aligned.
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Variabili

The Variables lists all the variables available at the composer item’s level (which includes all global, project and
composition’s variables). Map items also include Map settings variables that provide easy access to values like
the map’s scale, extent, and so on.

In Variabili, è anche possibile gestire variabili a livello di oggetto. Fai click sul pulsante per aggiungere una
nuova variabile personalizzata. Allo stesso modo, seleziona qualsiasi variabile a livello di elemento personalizzato

dall’elenco e fai click sul pulsante per rimuoverlo.

More information on variables usage in the General Tools Variables section.

14.2.2 L’Oggetto Mappa

Click on the Add new map toolbar button in the Print Composer toolbar to add the QGIS map canvas. Now, drag
a rectangle onto the Composer canvas with the left mouse button to add the map. To display the current map, you
can choose between three different modes in the map Item Properties panel:

• Rectangle is the default setting. It only displays an empty box with a message ‘Map will be printed here’.

• Cache renders the map in the current screen resolution. If you zoom the Composer window in or out, the
map is not rendered again but the image will be scaled.

• Render means that if you zoom the Composer window in or out, the map will be rendered again, but for
space reasons, only up to a maximum resolution.

Cache is the default preview mode for newly added Print Composer maps.

You can resize the map item by clicking on the Select/Move item button, selecting the element, and dragging one
of the blue handles in the corner of the map. This button also helps to move the map to another place. Select the
item and while holding the left mouse button, move to the new place and release the mouse button. After you
have found the right place for an item, you can lock the item position within the Print Composer canvas. Select

the map item and use the toolbar Lock Selected Items or the Items panel to Lock the item. A locked item can only
be selected using the Items panel. Once selected you can use the Items panel to unlock individual items. The

Unlock All Items icon will unlock all locked composer items. With the map selected, you can now adapt more
properties in the map Item Properties panel.

To move layers within the map element, select the map element, click the Move item content icon and move the
layers within the map item frame with the left mouse button.

Proprietà principali

The Main properties dialog of the map Item Properties panel provides the following functionalities (see fig-
ure_composer_map):

• The Preview drop-down menu allows you to select one of the preview modes ‘Rectangle’, ‘Cache’ and
‘Render’, as described above. If you change the view on the QGIS map canvas by changing vector or raster
properties, you can update the Print Composer view by selecting the map element and clicking the [Update
preview] button.

• The field Scale manually sets the map item scale.

• The field Map rotation allows you to rotate the map element content clockwise in degrees. The
rotation of the map canvas can be imitated here.

• Draw map canvas items lets you show annotations that may be placed on the map canvas in the main
QGIS window.
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Figure 14.11: Pannello Proprietà Oggetto Mappa

Layers

The Layers dialog of the map item panel provides the following functionality (see figure_composer_map_layers):

Figure 14.12: Map Layers Dialog

• If you want to keep the map item constantly updated with a visibility preset, use the Follow visibility
preset and set the preset you want. Any changes applied to the preset in QGIS’s main window (using the
replace preset) will also show in the map item. In this case, the Lock styles for layers option will be disabled
because Follow visibility preset also updates the style (symbology, label, diagram) of the visibility preset
layers.

• To lock the layers shown on a map item to the current map canvas check Lock layers. After this option is
enabled, any changes on the layers visibility in the QGIS’s main window won’t affect the Composer’s map
item. Nevertheless, style and labels of locked layers are still refreshed according to QGIS’s main window.
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You can prevent this by using Lock styles for layers.

Using the button, you can lock the map item’s layers to one of the visibility presets you have prepared
in QGIS (see Pannello dei Layer to find out how to create visibility presets). Clicking the button will
show the list of all the preset views. Select the preset you want to display. The map canvas will lock the

preset layers automatically by enabling the Lock layers. You can release the preset by unchecking the

Lock layers and press the button in the map composer’s Navigation toolbar.

Note that, unlike the Follow visibility preset, using the Lock layers option enabled and set to a preset, the
map item layers won’t be updated if the preset is changed (using the replace preset option) in QGIS’s main
window.

Locked layers in the map can also be data-defined, using the icon beside the option. When used, this
overrides the selection set in the drop-down list. You need to pass a list of layers separated by | character.
The following example locks the map item to use only layers layer 1 and layer 2:

concat (’layer 1’, ’|’, ’layer 2’)

Estensione mappa

The Extents dialog of the map item panel provides the following functionalities (see fig-
ure_composer_map_extents):

Figure 14.13: Map Extents Dialog

The Map extents area allows you to specify the map extent using X and Y min/max values and by clicking the
[Set to map canvas extent] button. This button sets the map extent of the composer map item to the extent of
the current map view in the main QGIS application. The button [View extent in map canvas] does exactly the
opposite; it updates the extent of the map view in the QGIS application to the extent of the composer map item.

If you change the view on the QGIS map canvas by changing vector or raster properties, you can update the Print
Composer view by selecting the map element in the Print Composer and clicking the [Update preview] button in
the map Item Properties panel (see figure_composer_map).

Reticoli

The Grids dialog of the map Item Properties panel provides the possibility to add several grids to a map item.

• With the and buttons you can add or remove a selected grid.

• With the and buttons you can move a grid in the list and set the drawing priority.

When you double-click the added grid you can give it another name.

After you have added a grid, you can activate the checkbox Draw grid to overlay a grid onto the map element.
Expand this option to provide a lot of configuration options, see Figure_composer_map_grid_draw.
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Figure 14.14: Finestra di dialogo Reticoli mappa

Figure 14.15: Finestra di dialogo Disegna Reticolo
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As grid type, you can specify to use a ‘Solid’, ‘Cross’, ‘Markers’ or ‘Frame and annotations only’. ‘Frame and
annotations only’ is especially useful when working with rotated maps or reprojected grids. In the divisions section
of the Grid Frame Dialog mentioned below you then have a corresponding setting. Symbology of the grid and
its rendering mode can be chosen. See Visualizzazione. Furthermore, you can define an interval in the X and Y
directions, an X and Y offset, and the width used for the cross or line grid type.

Figure 14.16: Finestra di dialogo Cornice Reticolo

• There are different options to style the frame that holds the map. Following options are available: No Frame,
Zebra, Interior ticks, Exterior ticks, Interior and Exterior ticks and Lineborder.

• With ‘Latitude/Y only’ and ‘Longitude/X only’ setting in the divisions section you have the possibility to
prevent a mix of latitude/y and longitude/x coordinates showing on a side when working with rotated maps
or reprojected grids.

• Advanced rendering mode is also available for grids.

• The Draw coordinates checkbox allows you to add coordinates to the map frame. You can choose the
annotation numeric format, the options range from decimal to degrees, minute and seconds, with or without
suffix, aligned or not and a custom format using the expression dialog. You can choose which annotation
to show. The options are: show all, latitude only, longitude only, or disable(none). This is useful when the
map is rotated. The annotation can be drawn inside or outside the map frame. The annotation direction can
be defined as horizontal, vertical ascending or vertical descending. Finally, you can define the annotation
font, the annotation font color, the annotation distance from the map frame and the precision of the drawn
coordinates.

Panoramiche

The Overviews dialog of the map Item Properties panel provides the following functionalities:

You can choose to create an overview map, which shows the extents of the other map(s) that are available in the
composer. First you need to create the map(s) you want to include in the overview map and the map you want to
use as the overview map, just like a normal map.

Then expand Overviews option and press the green plus icon-button to add an overview. Initially this overview is
named ‘Overview 1’ (see Figure_composer_map_overview). You can change the name when you double-click on
the overview item in the list named ‘Overview 1’ and change it to another name.

• With the plus and minus button you can add or remove an overview.

• With the up and down button you can move an overview in the list and set the drawing priority.

When you select the overview item in the list you can customize it.
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Figure 14.17: Finestra di dialogo Scrivi Coordinate

Figure 14.18: Map Overviews Dialog
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• The Draw “<name_overview>” overview needs to be activated to draw the extent of selected map
frame.

• L’elenco combinato Cornice della mappa può essere utilizzato per selezionare l’oggetto mappa la cui es-
tensione sarà disegnata sull’attuale oggetto mappa.

• Lo Stile cornice ti consente di modificare lo stile della cornice della panoramica.

• La Modalità fusione ti consente di impostare diverse modalità di fusione e trasparenza.

• La Inverti panoramica se attivata crea una maschera attorno alla estensione: la parte di mappa a cui si
fa riferimento è visualizzata in chiaro, mentre tutto il resto viene colorato con lo stesso colore della cornice.

• La Centra sulla panoramica mette l’estensione della cornice della panoramica centrata sulla mappa
panoramica. Puoi attivare solo una panoramica in modo centrato se si sono aggiunte diverse panoramiche.

14.2.3 L’Oggetto Etichetta

To add a label, click the Add label icon, place the element with the left mouse button on the Print Composer
canvas and position and customize its appearance in the label Item Properties panel.

The Item Properties panel of a label item provides the following functionality for the label item (see Fig-
ure_composer_label):

Figure 14.19: Pannello Proprietà Oggetto Etichetta

Proprietà principali

• The main properties dialog is where the text (HTML or not) or the expression needed to fill the label is
added to the Composer canvas.

• Le etichette possono essere interpretate come codice HTML: spunta la casella di controllo Visualizza
come HTML. Ora puoi inserire un URL, un’immagine collegata a un sito web oppure qualcosa di più com-
plesso.
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• You can also insert an expression. Click on [Insert an expression] to open a new dialog. Build an ex-
pression by clicking the functions available in the left side of the panel. Two special categories can be
useful, particularly associated with the atlas functionality: geometry and records functions. At the bottom,
a preview of the expression is shown.

Apetto

• Define Font by clicking on the [Font...] button or a Font color selecting a color using the color selection
tool.

• You can specify different horizontal and vertical margins in mm. This is the margin from the edge of the
composer item. The label can be positioned outside the bounds of the label e.g. to align label items with
other items. In this case you have to use negative values for the margin.

• Using the Alignment is another way to position your label. Note that when e.g. using the Horizontal
alignment in Center Position the Horizontal margin feature is disabled.

14.2.4 L’Oggetto Legenda

To add a map legend, click the Add new legend icon, place the element with the left mouse button on the Print
Composer canvas and position and customize the appearance in the legend Item Properties panel.

The Item properties panel of a legend item provides the following functionalities (see figure_composer_legend):

Figure 14.20: Pannello Proprietà Oggetto Legenda

Proprietà principali

The Main properties dialog of the legend Item Properties panel provides the following functionalities (see fig-
ure_composer_legend_ppt):

Nelle proprietà principali puoi:

• change the title of the legend;

• set the title alignment to Left, Center or Right;
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Figure 14.21: Legend Main properties Dialog

• choose which Map item the current legend will refer to in the select list;

• wrap the text of the legend title on a given character;

• utilizzare Resize to fit contents per controllare che la legenda venga ridimensionata automaticamente al
contesto. Se non selezionato, la legenda non sarà ridimensionata e sarà impostata alla dimensione scelta
dall’utente. Qualsiasi contenuto che non rientra nel contesto sarà tagliato.

Oggetti della Legenda

The Legend items dialog of the legend Item Properties panel provides the following functionalities (see fig-
ure_composer_legend_items):

Figure 14.22: Legend Items Dialog

• La legenda verrà aggiornata automaticamente se è selezionato Aggiorna automaticamente. Quando
Aggiorna automaticamente non è selezionato questo ti darà più controllo sulle voci legenda. Le icone sotto
l’elenco delle voci legenda saranno attivate.

• La finestra degli oggetti legenda elenca tutte gli oggetti legenda e consente di modificare l’ordine degli
oggetti, raggruppare i layer, rimuovere e ripristinare gli oggetti nell’elenco, modificare i nomi dei layer e
aggiungere un filtro.

– L’ordine degli oggetti può essere modificato utilizzando i pulsanti e , oppure con la funzionalità
‘drag-and-drop’. L’ordine non può essere modificato per le legende WMS.

– Utilizza il pulsante per aggiungere un gruppo legenda.
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– Utilizza il pulsante per aggiungere layer e il pulsante per rimuovere gruppi, layer o classi di
simboli.

– Il pulsante viene utilizzato per modificare il nome del layer, del gruppo o del titolo. In primo luogo
devi selezionare l’oggetto della legenda. Facendo doppio click sull’oggetto si apre anche la casella di
testo per rinominarlo.

– Il pulsante aggiunge il conteggio delle ricorrenze per ogni tipo di layer vettoriale.

– Con il pulsante Filtra la legenda in base al contenuto della mappa solo le voci di legenda degli oggetti visibili
nella mappa saranno elencate nella finestra di dialogo legenda. Questo strumento rimane disponibile

quando è attivo Aggiorna automaticamente.

– The Filter legend by expression helps you filter which of the legend items of a layer will be displayed, i.e.
using a layer that has different legend items (e.g., from a rule-based or categorized symbology), you
can specify a boolean expression to remove from the legend tree, styles that have no feature satisfying
a condition. Note that the features are nevertheless kept and shown in the composer map item.

Mentre il comportamento predefinito dell’oggetto legenda è quello di simulare l’albero del Pannello layer,
visualizzando gli stessi gruppi, layer e classi di simbologia, facendo click con il pulsante destro del mouse
su uno oggetto offre opzioni per nascondere il nome del layer o alzarlo così come un gruppo o sottogruppo.
Nel caso in cui hai apportato alcune modifiche a un layer, puoi ripristinarle scegliendo Ripristina ai valori
predefiniti nel menu contestuale.

After changing the symbology in the QGIS main window, you can click on [Update All] to adapt the
changes in the legend element of the Print Composer.

• Durante la generazione di un atlante con layers poligonali, è possibile filtrare gli oggetti di legenda che

si trovano al di fuori della scelta fatta per l’atlante corrente. Per farlo, seleziona l’opzione Mostra
solamente elementi all’interno della geometria dell’atlante.

Caratteri, Colonne, Simboli

The Fonts, Columns and Symbol dialogs of the legend Item Properties panel provide the following functionalities
(see figure_composer_legend_fonts):

• You can change the font of the legend title, group, subgroup and item (layer) in the legend item. Click on a
category button to open a Select font dialog.

• You provide the labels with a Color using the advanced color picker, however the selected color will be
given to all font items in the legend..

• Legend items can be arranged over several columns. Set the number of columns in the Count field.

– Uguale larghezza delle colonne imposta la stessa larghezza fra le colonne affiancate.

– L’opzione Dividi Layers consente di dividere le colonne della legenda per layer categorizzati o
graduati.

• Puoi anche modificare la larghezza e l’altezza del simbolo della legenda, impostare un colore e uno spessore
in caso di simbolo di layer raster.

Legenda WMS e Spaziatura

The WMS LegendGraphic and Spacing dialogs of the legend Item Properties panel provide the following func-
tionalities (see figure_composer_legend_wms):

When you have added a WMS layer and you insert a legend composer item, a request will be sent to the WMS
server to provide a WMS legend. This Legend will only be shown if the WMS server provides the GetLegend-
Graphic capability. The WMS legend content will be provided as a raster image.
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Figure 14.23: Legend Fonts, Columns and Symbol Dialogs

Figure 14.24: WMS LegendGraphic and Spacing Dialogs
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Legenda WMS iconsente di regolare la Larghezza legenda e la Altezza legenda dell’immagine raster della legenda
WMS.

Spacing around title, group, subgroup, symbol, icon label, box space or column space can be customized through
this dialog.

14.2.5 L’oggetto Barra di Scala

To add a scale bar, click the Add new scalebar icon, place the element with the left mouse button on the Print
Composer canvas and position and customize the appearance in the scale bar Item Properties panel.

The Item properties of a scale bar item tab provides the following functionalities (see figure_composer_scalebar):

Figure 14.25: Pannello Proprietà Oggetto della Barra di scala

Proprietà principali

The Main properties dialog of the scale bar Item Properties panel provides the following functionalities (see
figure_composer_scalebar_ppt):

Figure 14.26: Scale Bar Main properties Dialog

• Prima di tutto scegli a quale mappa vuoi aggiungere la barra di scala.

• Poi scegli lo stile della barra di scala. Hai a disposizione sei stili:

– Single box and Double box styles, which contain one or two lines of boxes alternating colors.

– Middle, Up or Down line ticks.

– Numerico che mostra semplicemente il rapporto di scala (ad esempio 1:50000).
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Unità e Segmenti

The Units and Segments dialogs of the scale bar Item Properties panel provide the following functionalities (see
figure_composer_scalebar_units):

Figure 14.27: Scale Bar Units and Segments Dialogs

In these two dialogs, you can set how the scale bar will be represented.

• Select the units you want to use with Scalebar units. There are four possible choices: Map Units, the
default one and Meters, Feet or Nautical Miles which may force unit conversions.

• The Label unit multiplier specifies how many scalebar units per labeled unit. Eg, if your scalebar units are
set to “meters”, a multiplier of 1000 will result in the scale bar labels in “kilometers”.

• The Label for units field defines the text used to describe the units of the scale bar, eg “m” or “km”. This
should be matched to reflect the multiplier above.

• Puoi scegliere quanti Segmenti devono essere disegnati a sinistra e a destra della barra di scala

• You can set how long each segment will be (fixed width), or limit the scale bar size in mm with Fit segment
width option. In the latter case, each time the map scale changes, the scale bar is resized (and its label
updated) to fit the range set.

• Altezza serve per regolare lo spessore della barra.

Visualizza

The Display dialog of the scale bar Item Properties panel provides the following functionalities (see fig-
ure_composer_scalebar_display):

Puoi definire come verrà visualizzata la barra di scala nella sua cornice.

• Margine box: spazio tra i confini del testo e della cornice

• Labels margin : space between text and scale bar drawing

• Spessore linea: larghezza della linea del disegno della barra di scala

• Join style : Corners at the end of scalebar in style Bevel, Rounded or Square (only available for Scale bar
style Single Box & Double Box)

• Stile testata: imposta la parte terminale delle tacche in stile ‘Quadrato’, ‘Rotondo’ o ‘Piatto’ (disponibile
solo per gli stili della barra di scala Linee con tacche al centro, Linee con tacche in basso o Linee con tacche
in alto)
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Figure 14.28: Scale Bar Display

• Allineamento: imposta il testo sul lato sinistro, metà o destro della cornice (funziona solo per lo stile della
barra di scala Numerico)

Caratteri e colori

The Fonts and colors dialog of the scale bar Item Properties panel provides the following functionalities (see
figure_composer_scalebar_fonts):

Figure 14.29: Scale Bar Fonts and colors Dialogs

You can define the fonts and colors used for the scale bar.

• Use the [Font] button to set the font of scale bar label

• Colore carattere: imposta il colore del carattere

• Colore di riempimento: imposta il primo colore di riempimento

• Colore di riempimento secondario: imposta il secondo colore di riempimento

• Stroke color: set the color of the lines of the Scale Bar

Fill colors are only used for scale box styles Single Box and Double Box. To select a color you can use the list
option using the dropdown arrow to open a simple color selection option or the more advanced color selection
option, that is started when you click in the colored box in the dialog.

14.2.6 L’oggetto Tabella degli Attributi

It is possible to add parts of a vector attribute table to the Print Composer canvas: Click the Add attribute table

icon, click and drag with the left mouse button on the Print Composer canvas to place and size the item. You can
better position and customize its appearance in the Item Properties panel.

The Item properties panel of an attribute table provides the following functionalities (see figure_composer_table):
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Figure 14.30: Pannello Proprietà Oggetto per la Tabella degli attributi

Proprietà principali

The Main properties dialog of the attribute table provides the following functionalities (see fig-
ure_composer_table_ppt):

Figure 14.31: Attribute table Main properties Dialog

• For Source you can normally select only Layer features.

• With Layer you can choose from the vector layers loaded in the project.

• In case you activated the Generate an atlas option in the Atlas generation panel, there are two additional
Source possible:

– Current atlas feature (see figure_composer_table_atlas): you won’t see any option to choose the
layer, and the table item will only show a row with the attributes from the current feature of the atlas
coverage layer.

– and Relation children (see figure_composer_table_relation): an option with the relation names will
show up. This feature can only be used if you have defined a relation using your atlas coverage layer
as parent, and the table will show the children rows of the atlas coverage layer’s current feature (for
further information about the atlas generation, see Generazione Atlante).

• The button [Refresh table data] can be used to refresh the table when the actual contents of the table has
changed.

• The button [Attributes...] starts the Select attributes menu, see figure_composer_table_select, that can be
used to change the visible contents of the table. After making changes use the [OK] button to apply changes
to the table. The upper part of the window shows the list of the attributes to display and the lower part helps
to set the way the data is sorted.
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Figure 14.32: Proprietà principali Tabella degli Attributi per il layer corrente dell’atlante

Figure 14.33: Proprietà principali Tabella degli Attributi per ‘Relazione figlio’

Figure 14.34: Finestra di dialogo Selezione attributi della Tabella degli Attributi
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Nella sezione Colonne puoi:

– Remove an attribute, just select an attribute row by clicking anywhere in the row and press the minus
button to remove the selected attribute.

– Add a new attribute use the plus button. At the end a new empty row appears and you can select empty
cell of the column Attribute. You can select a field attribute from the list or you can select to build a

new attribute using a regular expression ( button). Of course you can modify every already existing
attribute by means of a regular expression.

– Use the up and down arrows to change the order of the attributes in the table.

– Select a cell in the Headings column and, to change the heading, just type in a new name.

– set a precise Alignment (mixing vertical and horizontal alignment options) for each column.

– Select a cell in the Width column and change it from Automatic to a width in mm, just type a number.
When you want to change it back to Automatic, use the cross.

– The [Reset] button can always be used to restore it to the original attribute settings.

Nella sezione Ordina puoi:

– Add an attribute to sort the table with. Select an attribute and set the sorting order to ‘Ascending’ or
‘Descending’ and press the plus button. A new line is added to the sort order list.

– select a row in the list and use the up and down button to change the sort priority on attribute level.
Selecting a cell in the Sort Order column helps you change the sorting order of the attribute field.

– use the minus button to remove an attribute from the sort order list.

Filtro delle geometrie

The Feature filtering dialog of the attribute table provides the following functionalities (see fig-
ure_composer_table_filter):

Figure 14.35: Attribute table Feature filtering Dialog

Puoi:

• Definire il Numero massimo righe da visualizzare.

• Attivare Elimina righe duplicate dalla tabella per mostrare solo records univoci.

• Activate Show only visible features within a map and select the corresponding Composer map to display
the attributes of features only visible on selected map.

• Activate Show only features intersecting Atlas feature is only available when Generate an atlas is
activated. When activated it will show a table with only the features which intersect the current atlas feature.
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• Attivare Filtro con e fornire un filtro digitandolo nella riga di input o inserire un’espressione regolare

usando il pulsante visualizzato. Alcuni esempi di istruzioni di filtraggio che puoi utilizzare quando hai
caricato il layer degli aeroporti dal dataset del campione dati:

– ELEV > 500

– NAME = ’ANIAK’

– NAME NOT LIKE ’AN%’

– regexp_match( attribute( $currentfeature, ’USE’ ) , ’[i]’)

L’ultima espressione includerà solo gli aeroporti che hanno la lettera ‘i’ nel campo ‘USE’ degli attributi.

Aspetto

The Appearance dialog of the attribute table provides the following functionalities (see fig-
ure_composer_table_appearance):

Figure 14.36: Attribute table appearance Dialog

• Fai click su Mostra le righe vuote per riempire la tabella degli attributi con celle vuote. Questa opzione
può anche essere utilizzata per fornire ulteriori celle vuote quando hai un risultato da mostrare!

• Con Margini cella puoi definire il margine intorno al testo in ciascuna cella della tabella.

• Con Mostra intestazione puoi scegliere una delle opzioni in elenco: ‘Sulla prima cornice’, ‘Su tutte le
cornici’ o ‘Nessuna intestazione’.

• L’opzione Tabelle vuote controlla ciò che verrà visualizzato quando la selezione risultante è vuota:

– Disegna solo le intestazioni, disegna solo l’intestazione, tranne se si è scelto ‘Nessuna intestazione’
in Mostra intestazione.

– Nascondi l’intera tabella, viene disegnato solo lo sfondo della tabella. Puoi attivare Non diseg-
nare lo sfondo se la cornice è vuota in Cornici per nascondere completamente la tabella.

– Mostra messaggio impostato, disegna l’intestazione e aggiunge una cella che attraversa tutte le
colonne e visualizza un messaggio come ‘Nessun risultato’ tche può essere fornito nell’opzione Mes-
saggio da visualizzare.

• L’opzione Messaggio da mostrare si attiva solo quando hai selezionato Mostra messaggio impostato per
Tabelle vuote. Quando il risultato è una tabella vuota il messaggio verrà mostrato nella prima riga della
tabella.

• With Background color you can set the background color of the table. The Advanced customization option
helps you define different background colors for each cell (see figure_composer_table_background)
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Figure 14.37: Finestra di dialogo Colori di sfondo della Tabella degli attributi

• Con l’opzione Testo a capo con puoi definire un carattere sul quale il contenuto della cella sarà mandato a
capo ogni volta che viene incontrato.

• With Oversized text you define the behaviour when the width set for a column is smaller than its content’s
length. It can be Wrap text or Truncate text.

Visualizza reticolo

The Show grid dialog of the attribute table provides the following functionalities (see fig-
ure_composer_table_grid):

Figure 14.38: Attribute table Show grid Dialog

• Activate Show grid when you want to display the grid, the outlines of the table cells.

• Con Spessore linea puoi impostare lo spessore delle linee utilizzate nel reticolo.

• The Color of the grid can be set using the color selection dialog.

Caratteri e stile testo

The Fonts and text styling dialog of the attribute table provides the following functionalities (see fig-
ure_composer_table_fonts):

• You can define Font and Color for Table heading and Table contents.
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Figure 14.39: Attribute table Fonts and text styling Dialog

• For Table heading you can additionally set the Alignment to Follow column alignment or override this
setting by choosing Left, Center or Right. The column alignment is set using the Select Attributes dialog
(see Figure_composer_table_select ).

Cornici

The Frames dialog of the attribute table provides the following functionalities (see fig-
ure_composer_table_frames):

Figure 14.40: Attribute table Frames Dialog

• Con Modalità ridimensionamento puoi scegliere come visualizzare il contenuto della tabella degli attributi:

– Use existing frames displays the result in the first frame and added frames only.

– Extend to next page will create as many frames (and corresponding pages) as necessary to display the
full selection of attribute table. Each frame can be moved around on the layout. If you resize a frame,
the resulting table will be divided up between the other frames. The last frame will be trimmed to fit
the table.

– Repeat until finished will also create as many frames as the Extend to next page option, except all
frames will have the same size.

• Use the [Add Frame] button to add another frame with the same size as selected frame. The result of the
table that will not fit in the first frame will continue in the next frame when you use the Resize mode Use
existing frames.

• Activate Don’t export page if frame is empty prevents the page to be exported when the table frame has
no contents. This means all other composer items, maps, scalebars, legends etc. will not be visible in the
result.

• Attiva Non disegnare lo sfondo se la cornice è vuota per non avere lo sfondo quando la cornice non ha
contenuti della tabella.
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14.2.7 The Image Item

To add an image, click the Add image icon and drag a rectangle onto the Composer canvas with the left mouse
button. You can then position and customize its appearance in the image Item Properties panel.

The image Item Properties tab provides the following functionalities (see figure_composer_image):

Figure 14.41: Image Item Properties panel

You first have to select the image you want to display. There are several ways to set the image source in the Main
properties area.

1. Use the browse button of image source to select a file on your computer using the browse dialog. The
browser will start in the SVG-libraries provided with QGIS. Besides SVG, you can also select other image
formats like .png or .jpg.

2. You can enter the source directly in the image source text field. You can even provide a remote URL-address
to an image.

3. From the Search directories area you can also select an image from loading previews ... to set the image
source.

4. Use the data defined button to set the image source from a record or using a regular expression.

With the Resize mode option, you can set how the image is displayed when the frame is changed, or choose to
resize the frame of the image item so it matches the original size of the image.

You can select one of the following modes:

• Zoom: Enlarges the image to the frame while maintaining aspect ratio of picture.

• Stretch: Stretches image to fit inside the frame, ignores aspect ratio.

• Clip: Use this mode for raster images only, it sets the size of the image to original image size without scaling
and the frame is used to clip the image, so only the part of the image inside the frame is visible.
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• Zoom and resize frame: Enlarges image to fit frame, then resizes frame to fit resultant image.

• Resize frame to image size: Sets size of frame to match original size of image without scaling.

Selected resize mode can disable the item options ‘Placement’ and ‘Image rotation’. The Image rotation is active
for the resize mode ‘Zoom’ and ‘Clip’.

With Placement you can select the position of the image inside its frame. The Search directories area allows you
to add and remove directories with images in SVG format to the picture database. A preview of the pictures found
in the selected directories is shown in a pane and can be used to select and set the image source. It is possible to
change SVG fill/outline color and outline width when using parameterized SVG files such as those included with
QGIS. If you add a SVG file you should add the following tags in order to add support for transparency:

• fill-opacity=”param(fill-opacity)”

• stroke-opacity=”param(outline-opacity)”

You can read this blog post to see an example.

Images can be rotated with the Image rotation field. Activating the Sync with map checkbox synchronizes the
rotation of the image (i.e., a rotated north arrow) with the rotation applied to the selected map item.

It is also possible to select a north arrow directly. If you first select a north arrow image from Search directories

and then use the browse button of the field Image source, you can now select one of the north arrow from
the list as displayed in figure_composer_image_north.

Nota: Molte delle frecce nord non hanno un ‘N’ aggiunto nella freccia nord, questo è fatto appositamente per le
lingue che non utilizzano la lettera ‘N’ per il Nord, in modo che possano utilizzare un’altra lettera.

Figure 14.42: Frecce Nord disponibili nella libreria SVG di installazione

14.2.8 La cornice HTML

It is possible to add a frame that displays the contents of a website or even create and style your own HTML page
and display it!
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Click the Add HTML frame icon, place the element by dragging a rectangle holding down the left mouse but-
ton on the Print Composer canvas and position and customize the appearance in the Item Properties panel (see
figure_composer_html).

Figure 14.43: Cornice HTML, il Pannello Proprietà oggetto

Sorgente HTML

As an HTML source, you can either set a URL and activate the URL radiobutton or enter the HTML source
directly in the textbox provided and activate the Source radiobutton.

The HTML Source dialog of the HTML frame Item Properties panel provides the following functionalities (see
figure_composer_html_ppt):

Figure 14.44: Cornice HTML, le proprietà Sorgente HTML

• In URL you can enter the URL of a webpage you copied from your Internet browser or select an HTML file

using the browse button . There is also the option to use the Data defined override button, to provide
an URL from the contents of an attribute field of a table or using a regular expression.

• In Sorgente puoi inserire il testo nella casella con tag HTML o fornire una pagina HTML completa.

• The [insert an expression] button can be used to insert an expression like [%Year($now)%] in the
Source textbox to display the current year. This button is only activated when radiobutton Source is selected.
After inserting the expression click somewhere in the textbox before refreshing the HTML frame, otherwise
you will lose the expression.
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• Attiva Valuta le espressioni QGIS in HTML per vedere il risultato dell’espressione che hai incluso.

• Use the [Refresh HTML] button to refresh the HTML frame(s) to see the result of changes.

Cornici

The Frames dialog of the HTML frame Item Properties panel provides the following functionalities (see fig-
ure_composer_html_frames):

Figure 14.45: Cornice HTML, proprietà cornici

• Con Modalità ridimensionamento puoi scegliere come visualizzare il contenuto HTML

– Use existing frames displays the result in the first frame and added frames only.

– Extend to next page will create as many frames (and corresponding pages) as necessary to render the
height of the web page. Each frame can be moved around on the layout. If you resize a frame, the
webpage will be divided up between the other frames. The last frame will be trimmed to fit the web
page.

– Repeat on every page will repeat the upper left of the web page on every page in frames of the same
size.

– Repeat until finished will also create as many frames as the Extend to next page option, except all
frames will have the same size.

• Use the [Add Frame] button to add another frame with the same size as selected frame. If the HTML page
that will not fit in the first frame it will continue in the next frame when you use Resize mode or Use existing
frames.

• Activate Don’t export page if frame is empty prevents the map layout from being exported when the
frame has no HTML contents. This means all other composer items, maps, scalebars, legends etc. will not
be visible in the result.

• Attiva Non disegnare lo sfondo se la cornice è vuota impedisce che la cornice HTML venga disegnata
se il contenuto della cornice è vuoto.

Usa interruzioni di pagina intelligente e fogli di stile utente

The Use smart page breaks dialog and Use style sheet dialog of the HTML frame Item Properties panel provides
the following functionalities (see figure_composer_html_breaks):

• Attiva Usa interruzioni di pagina intelligenti per impedire che i contenuti della cornice HTML vadano
a capo a metà strada di una riga di testo in modo che venga proposta in modo adeguato e senza interruzioni
nella cornice successiva.

• Imposta Distanza massima per definire dove posizionare le interruzioni di pagina nell’HTML. Questa dis-
tanza è la quantità massima di spazio vuoto consentito in fondo a una cornice dopo aver calcolato la po-
sizione di rottura ottimale. L’impostazione di un valore più grande determinerà una migliore scelta della
posizione di interruzione della pagina, ma più spazio sprecato nella parte inferiore delle cornici. Questa
opzione viene utilizzata solo quando viene attivato l’uso delle interruzioni delle pagine intelligenti.
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Figure 14.46: HTML frame, Use smart page breaks and User stylesheet properties

• Activate User stylesheet to apply HTML styles that often is provided in cascading style sheets. An
example of style code is provide below to set the color of <h1> header tag to green and set the font and
fontsize of text included in paragraph tags <p>.

h1 {color: #00ff00;
}
p {font-family: "Times New Roman", Times, serif;

font-size: 20px;
}

• Use the [Update HTML] button to see the result of the stylesheet settings.

14.2.9 Oggetti forma

L’oggetto Freccia

To add an arrow, click the Add Arrow icon, place the element holding down the left mouse button and drag a line
to draw the arrow on the Print Composer canvas and position and customize the appearance in the scale bar Item
Properties panel.

When you also hold down the Shift key while placing the arrow, it is placed in an angle of exactly 45° .

The arrow item can be used to add a line or a simple arrow that can be used, for example, to show the relation
between other print composer items. To create a north arrow, the image item should be considered first. QGIS
has a set of North arrows in SVG format. Furthermore you can connect an image item with a map so it can rotate
automatically with the map (see The Image Item).

Item Properties

The Arrow item properties panel allows you to configure an arrow item.

The [Line style...] button can be used to set the line style using the line style symbol editor.

In Arrows markers you can select one of three radio buttons.

• Default: To draw a regular arrow, gives you options to style the arrow head

• None: To draw a line without arrow head

• SVG Marker: To draw a line with an SVG Start marker and/or End marker

For Default Arrow marker you can use following options to style the arrow head.

• Arrow outline color: Set the outline color of the arrow head

• Arrow fill color: Set the fill color of the arrow head

• Arrow outline width: Set the outline width of the arrow head
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Figure 14.47: Arrow Item Properties Panel

• Arrow head width: Set the size of the arrow head

For SVG Marker you can use following options.

• Start marker: Choose an SVG image to draw at the beginning of the line

• End marker: Choose an SVG image to draw at the end of the line

• Arrow head width: Set the size of Start and/or End marker

SVG images are automatically rotated with the line. Outline and fill colors of QGIS predefined SVG images can
be changed using the corresponding options. Custom SVG may require some tags following this instruction.

The Basic Shape Items

To add a basic shape (ellipse, rectangle, triangle), click the Add basic shape icon, place the element holding down
the left mouse. Customize the appearance in the Item Properties panel.

When you also hold down the Shift key while placing the basic shape you can create a perfect square, circle or
triangle.

The Shape item properties panel allows you to select if you want to draw an ellipse, rectangle or triangle inside
the given frame.

You can set the style of the shape using the advanced symbol style dialog with which you can define its outline
and fill color, fill pattern, use markers...

For the rectangle shape, you can set the value of the corner radius to round of the corners.

Nota: Unlike other items, you can not style the frame or the background color of the frame.
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Figure 14.48: Pannello Proprietà Oggetto Forme

Oggetti Forme a Nodi predefiniti

While arrow and basic shape items offer you simple and predefined geometric item to use, a node-based shape
(polygon or polyline) helps you create a custom and more advanced geometric item. You can add as many lines
or sides as you want to the item and independently and directly interact with each of its vertices.

To add a node-based shape, click the Add nodes item icon. Then perform left clicks to add nodes to your current
shape. When you’re done, a simple right click terminates the shape. Customize the appearance in the Item
Properties panel.

Figure 14.49: Nodes Shape Item Properties Panel

You can set the style of the shape using the advanced symbol style dialog available thanks to the [Change...]
button in Main properties.

A specific tool is provided to edit node-based shapes through Edit Nodes Item. Within this mode, you can select
a node by clicking on it (a marker is displayed on the selected node). A selected node can be moved either by
dragging it or by using the arrow keys. Moreover, in this mode, you are able to add nodes to an existing shape.
You just have to do a left click near a segment and if you are not too far from the shape, a node is added. Finally,
you can remove the currently selected node by hitting the DEL key.

14.3 Creare un Output

Figure_composer_output shows the Print Composer with an example print layout, including each type of map
item described in the previous section.

Before printing a layout you have the possibility to view your composition without bounding boxes. This can be

enabled by deactivating View → Show bounding boxes or pressing the shortcut Ctrl+Shift+B.
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Figure 14.50: Print Composer with map view, legend, image, scale bar, coordinates, text and HTML frame added

The Print Composer allows you to create several output formats, and it is possible to define the resolution (print
quality) and paper size:

• L’icona Stampa ti consente di stampare il layout su una stampante collegata o su un le Postscript, a
seconda dei driver di stampa installati.

• The Export as image icon exports the Composer canvas in several image formats, such as PNG, BPM, TIF,
JPG,...

• The Export as SVG icon saves the Print Composer canvas as an SVG (Scalable Vector Graphic).

• The Export as PDF icon saves the defined Print Composer canvas directly as a PDF.

14.3.1 Esportare in formato Immagine

Clicking the Export as image icon will ask you to enter the filename to use to export composition: in the case of
multi-page composition, each page will be exported to a file with the given name appended with the page number.

You can then override the print resolution and the exported image dimensions (set in Composition panel).

By checking Crop to content option, the image output by the composer includes the minimal area enclosing
all the items (map, legend, scale bar, shapes, label, image...) of each page of the composition:

• If the composition includes a single page, then the output is resized to include EVERYTHING on the
composition. The page can then be reduced or extended to all items depending on their position (on, above,
below, left or right of the page).
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• In case of a multi-page composition, each page will be resized to include items in its area (left and right
sides for all pages, plus top for the first page and bottom for the last page). Each resized page is exported to
a separate file.

The Crop to content dialog also allows to add some margins around the cropped bounds.

Figure 14.51: Image Export Options, output is resized to items extent

If you need to export your layout as a georeferenced image (e.g., to share with other projects), you need to enable
this feature under the Composition Panel.

If the output format is a TIFF format, all you need to do is making sure to select the correct map item to use in

Reference map, and the output will always be a GeoTIFF. For other image formats, you also need to check

the Save world file option. With this option, the ‘Export as image’ action will create a world file along with
the exported image.

Nota: Exporting large rasters can sometimes fail, even if there seems to be enough memory. This is a problem
with the underlying Qt management of rasters.

14.3.2 Esportare in formato SVG

With Export as SVG, you also need to fill the filename (used as a basename for all files in case of multi-page

composition) and then can apply Crop to content option.

The SVG export options dialog also allows to:

• export map layers as svg groups:

• render map labels as outlines

Nota: Attualmente l’output SVG è molto scarno. Questo non è un problema QGIS, ma un problema con la
libreria Qt sottostante. Questo sarà probabilmente risolto nelle versioni future.

14.3.3 Esportare in formato PDF

The Export as PDF exports all the composition into a single PDF file.

If you applied to your composition or any shown layer an advanced effect such as blend modes, transparency or
symbol effects, these cannot be printed as vectors, and the effects may be lost. Checking Print as a raster in the
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Figure 14.52: Opzioni esportazione SVG

Composition Panel helps to keep the effects but rasterize the composition. Note that the Force layer to render as
raster in the Rendering tab of Layer Properties dialog is a layer-level alternative that avoids global composition
rasterization.

If you need to export your layout as a georeferenced PDF, in the Composition Panel, make sure to select the

correct map item to use in Reference map.

14.3.4 Generazione Atlante

The Print Composer includes generation functions that allow you to create map books in an automated way. The
concept is to use a coverage layer, which contains geometries and fields. For each geometry in the coverage layer,
a new output will be generated where the content of some canvas maps will be moved to highlight the current
geometry. Fields associated with this geometry can be used within text labels.

Every page will be generated with each feature. To enable the generation of an atlas and access generation param-
eters, refer to the Atlas generation panel.This panel contains the following widgets (see figure_composer_atlas):

Figure 14.53: Atlas Generation Panel

• Generate an atlas, which enables or disables the atlas generation.

• A Coverage layer combo box that allows you to choose the (vector) layer containing the features on
which to iterate over.
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• An optional Hidden coverage layer that, if checked, will hide the coverage layer (but not the other ones)
during the generation.

• An optional Page name combo box to give a more explicit name to each feature page(s) when previewing
atlas. You can select an attribute of the coverage layer or set an expression. If this option is empty, QGIS
will use an internal ID, according to the filter and/or the sort order applied to the layer.

• An optional Filter with text area that allows you to specify an expression for filtering features from the
coverage layer. If the expression is not empty, only features that evaluate to True will be selected. The
button on the right allows you to display the expression builder.

• An optional Sort by that, if checked, allows you to sort features of the coverage layer. The associated
combo box allows you to choose which column will be used as the sorting key. Sort order (either ascending
or descending) is set by a two-state button that displays an up or a down arrow.

Hai anche le opzioni per impostare l’output dell’Atlante:

• An Output filename expression textbox that is used to generate a filename for each geometry if needed. It is
based on expressions. This field is meaningful only for rendering to multiple files.

• A Single file export when possible that allows you to force the generation of a single file if this is possible
with the chosen output format (PDF, for instance). If this field is checked, the value of the Output filename
expression field is meaningless.

You can use multiple map items with the atlas generation; each map will be rendered according to the coverage

features. To enable atlas generation for a specific map item, you need to check Controlled by Atlas under the
item properties of the map item. Once checked, you can set:

• A Margin around feature that allows you to select the amount of space added around each geometry
within the allocated map. Its value is meaningful only when using the auto-scaling mode.

• A Predefined scale (best fit). It will use the best fitting option from the list of predefined scales in your
project properties settings (see Project → Project Properties → General → Project Scales to configure
these predefined scales).

• A Fixed scale that allows you to toggle between auto-scale and fixed-scale mode. In fixed-scale mode,
the map will only be translated for each geometry to be centered. In auto-scale mode, the map’s extents are
computed in such a way that each geometry will appear in its entirety.

Labels

In order to adapt labels to the feature the atlas plugin iterates over, you can include expressions. What you should
take care of is to place expression part (including functions, fields or variables) between [% and %]. For example,
for a city layer with fields CITY_NAME and ZIPCODE, you could insert this:

The area of [% upper(CITY_NAME) || ’,’ || ZIPCODE || ’ is ’
format_number($area/1000000,2) %] km2

o, un’altra espressione:

The area of [% upper(CITY_NAME)%],[%ZIPCODE%] is
[%format_number($area/1000000,2) %] km2

The information [% upper(CITY_NAME) || ’,’ || ZIPCODE || ’ is ’
format_number($area/1000000,2) %] is an expression used inside the label. Both expressions
would result in the generated atlas as:

The area of PARIS,75001 is 1.94 km2
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Data Defined Override Buttons

There are several places where you can use a Data Defined Override button to override the selected setting. These
options are particularly useful with Atlas Generation.

For the following examples the Regions layer of the QGIS sample dataset is used and selected for Atlas Generation.
We also assume the paper format A4 (210X297) is selected in the Composition panel for field Presets.

With a Data Defined Override button you can dynamically set the paper orientation. When the height (north-
south) of the extents of a region is greater than its width (east-west), you rather want to use portrait instead of
landscape orientation to optimize the use of paper.

In the Composition you can set the field Orientation and select Landscape or Portrait. We want to set the orienta-

tion dynamically using an expression depending on the region geometry. Press the button of field Orientation,
select Edit... so the Expression string builder dialog opens. Enter the following expression:

CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry)
THEN ’Landscape’ ELSE ’Portrait’ END

Now the paper orients itself automatically. For each Region you need to reposition the location of the composer

item as well. For the map item you can use the button of field Width to set it dynamically using following
expression:

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry)
THEN 297 ELSE 210 END) - 20

Use the button of field Height to provide following expression:

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry)
THEN 210 ELSE 297 END) - 20

When you want to give a title above the map in the center of the page, insert a label item above the map. First use
the item properties of the label item to set the horizontal alignment to Center. Next activate from Reference
point the upper middle checkbox. You can provide the following expression for field X :

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry)
THEN 297 ELSE 210 END) / 2

For all other composer items you can set the position in a similar way so they are correctly positioned when the
page is automatically rotated in portrait or landscape.

Information provided is derived from the excellent blog (in English and Portuguese) on the Data Defined Override
options Multiple_format_map_series_using_QGIS_2.6 .

This is just one example of how you can use the Data Defined Override option.

Preview and generate

Figure 14.54: Barra degli strumenti anteprima Atlante

Once the atlas settings have been configured and composer items (map, table, image...) linked to it, you can create

a preview of all the pages by clicking Atlas → Preview Atlas or Preview Atlas icon. You can then use the arrows
in the same toolbar to navigate through all the features:

• Prima geometria

• Geometria precedente
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• Geometria successiva

• Ultima geometria

Puoi anche utilizzare la casella combinata centrale per selezionare e visualizzare in anteprima una geometria
specifica. La casella combinata mostra il nome delle geometria dell’atlante in base all’espressione impostata
nell’opzione dell’atlante Nome pagina.

As for simple compositions, an atlas can be generated in different ways (see Creare un Output for more informa-
tion). Instead of Composer menu, rather use tools from Atlas menu or Atlas toolbar.

This means that you can directly print your compositions with Atlas → Print Atlas. You can also create a PDF
using Atlas → Export Atlas as PDF...: The user will be asked for a directory to save all the generated PDF files,

except if the Single file export when possible has been selected. In that case, you’ll be prompted to give a
filename.

With Atlas → Export Atlas as Images... or Atlas → Export Atlas as SVG... tool, you’re also prompted to select a
folder. Each page of each atlas feature composition is exported to an image or SVG file.

Suggerimento: Stampare una specifica geometria dell’Atlante
If you want to print or export the composition of only one feature of the atlas, simply start the preview, select the
desired feature in the drop-down list and click on Composer → Print (or export... to any supported file format).
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CHAPTER 15

Lavorare con i dati OGC

15.1 QGIS come client di dati OGC

L’Open Geospatial Consortium (OGC), è un’organizzazione internazionale che raggruppa più di 300 organiz-
zazioni commerciali, governative, no-profit ed enti di ricerca. I suoi membri sviluppano e implementano standard
per contenuti e servizi geospaziali, analisi GIS e scambio dati.

Describing a basic data model for geographic features, an increasing number of specifications are developed
by OGC to serve specific needs for interoperable location and geospatial technology, including GIS. Further
information can be found at http://www.opengeospatial.org/.

Importanti specifiche OGC supportate da QGIS sono:

• WMS — Web Map Service (Client WMS/WMTS)

• WMTS — Web Map Tile Service (Client WMS/WMTS)

• WFS — Web Feature Service (Client WFS e WFS-T)

• WFS-T — Web Feature Service - Transactional (Client WFS e WFS-T)

• WCS — Web Coverage Service (Client WCS)

• WPS — Web Processing Service

• CSW — Catalog Service for the Web

• SFS — Simple Features for SQL (Layers PostGIS)

• GML — Geography Markup Language

I servizi OGC sempre più numerosi sono utili per scambiare dati geografici fra differenti implementazioni GIS
e archivi di dati. QGIS può gestire le specifiche sopra esposte come client, essendo SFS (tramite il supporto a
PostgreSQL/PostGIS, vedi sezione Layers PostGIS).

15.1.1 Client WMS/WMTS

Panoramica sul servizio WMS

QGIS può agire come client WMS, nel rispetto delle specifiche server 1.1, 1.1.1 e 1.3. In particolare è stato testato
nei confronti di server accessibili pubblicamente quali DEMIS.

Un server WMS risponde alle richieste da parte del client (ad esempio QGIS) di una mappa raster di una determi-
nata estensione, con un determinato insieme di layer, simboli e trasparenze. Il server WMS quindi consulta le sue
risorse locali, genera il raster e lo invia al client in formato raster. Per QGIS tipicamente come immagini JPEG o
PNG.

WMS è un servizio REST (Representational State Transfer) piuttosto che un servizio web completo. Quindi puoi
prendere l’URL generato da QGIS e usarlo in un browser web per ottenere la stessa immagine che QGIS usa
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internamente. Questo è utile per identificare le cause di eventuali problemi, dato che esistono vari tipi di server
WMS e ciascuno ha la sua propria interpretazione degli standard WMS.

I layer WMS possono essere aggiunti molto semplicemente, una volta disponibile l’indirizzo (URL) per accedere
al server WMS, una connessione adatta e posto che il server usi HTTP come meccanismo di trasferimento dati.

Additionally, QGIS will cache your WMS responses (i.e. images) for 24h as long as the GetCapabilities request is
not triggered. The GetCapabilities request is triggered everytime the [Connect] button in the [Add layer(s) from
WMS(T)S Server] dialog is used to retrieve the WMS server capabilities. This is an automatic feature meant to
optimize project loading time. If a project is saved with a WMS layer, the corresponding WMS tiles will be loaded
from the cache the next time the project is opened as long as they are no older than 24H.

Panoramica sul servizio WMTS

QGIS può agire anche come client WMTS. WMTS è uno standard OGC che distribuisce insiemi di mattonelle di
dati geospaziali. È un modo più efficace e veloce rispetto a WMS perché gli insiemi di mattonelle vengono già
generati e il client deve solamente richiedere la trasmissione di queste mattonelle e non la loro produzione. Una
richiesta WMS tipicamente richiede sia la generazione che la trasmissione dei dati. Un esempio molto conosciuto
di standard non-OGC è Google Maps.

Per visualizzare i dati a diverse scale, l’insieme delle mattonelle WMTS vengono prodotte con scale molto differ-
enti fra loro in modo che per il client GIS sia più facile effettuare la richiesta.

Questo diagramma mostra il concetto delle mattonelle:

Figure 15.1: Concetto dell’insieme delle mattonelle WMTS

Le due tipologie di interfacce WMTS che supporta QGIS sono via Key-Value-Pairs (KVP) e RESTful. Queste
due interfacce sono differenti e devi specificarle in QGIS.

1. Per accedere a un servizio WMTS KVP, un utente QGIS deve aprire l’interfaccia WMS/WMTS e aggiun-
gere la seguente stringa all’ URL del servizio di piastrelle WMTS:

"?SERVICE=WMTS&REQUEST=GetCapabilities"

Un esempio di questo tipo di indirizzo è:

http://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

Per vedere se il layer topo2 funziona correttamente in questo WMTS, aggiungi la stringa indicata che il
servizio WMTS deve usare al posto del servizio WMS.

2. Il servizio RESTful WMTS segue un modulo diverso, ovvero un URL diretto. Il formato raccomandato da
OGC è:
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{WMTSBaseURL}/1.0.0/WMTSCapabilities.xml

This format helps you to recognize that it is a RESTful address. A RESTful WMTS is accessed in QGIS by
simply adding its address in the WMS setup in the URL field of the form. An example of this type of address
for the case of an Austrian basemap is http://maps.wien.gv.at/basemap/1.0.0/WMTSCapabilities.xml.

Nota: You can still find some old services called WMS-C. These services are quite similar to WMTS (i.e., same
purpose but working a little bit differently). You can manage them the same as you do WMTS services. Just add
?tiled=true at the end of the url. See http://wiki.osgeo.org/wiki/Tile_Map_Service_Specification for more
information about this specification.

Quando leggi WMTS, puoi anche pensare a WMS-C.

Selezionare server WMS/WMTS

Al primo utilizzo di un servizio WMS in QGIS non sono presenti server predefiniti.

Puoi avviare lo strumento cliccando sul pulsante Aggiungi layer WMS/WMTS nella barra degli strumenti,
oppure scegliendo Layer → Aggiungi layer WMS/WMTS....

The dialog Add Layer(s) from a Server for adding layers from the WMS server appears. You can add some
servers to play with by clicking the [Add default servers] button. This will add two WMS demo servers for
you to use: the WMS servers of the DM Solutions Group and Lizardtech. To define a new WMS server in the
Layers tab, select the [New] button. Then enter the parameters to connect to your desired WMS server, as listed
in table_OGC_wms:

Nome Un nome per la connessione. Questo nome verrà utilizzato nel menù a tendina dei server in
modo da distinguere i vari server WMS.

URL URL del server che fornisce i dati. Deve essere un indirizzo raggiungibile nello stesso
formato che verrebbe usato per aprire una connessione telnet o pingare un host.

Username Nome utente per accedere un WMS protetto. Questo parametro è opzionale.
Password Password per accedere ad un WMS protetto. Questo parametro è opzionale.

Ignora URI
GetMap

Ignora la URI GetMap riportata nelle capabilities. Viene utilizzato l’URI del campo
URL precedente.

Ignora URI
GetFeature-
Info

Ignora la URI GetFeatureInfo riportata nelle capabilities. Viene utilizzato l’URI del
campo URL precedente

Table OGC 1: Parametri di connessione WMS

Se hai bisogno di impostare i parametri di un proxy per ricevere i servizi WMS da internet, puoi aggiungere il
server proxy nelle opzioni. Seleziona Impostazioni → Opzioni e clicca sulla scheda Opzioni|Rete, nella quale puoi

inserire le impostazioni spuntando la casella di controllo Utilizza un proxy per l’accesso web. Assicurati di

scegliere il tipo di proxy corretto dal menù a tendina Tipo proxy .

Una volta creata la connessione al server WMS verrà memorizzata e sarà disponibile per le successive sessioni di
QGIS.

Suggerimento: A PROPOSITO DI INDIRIZZI DEI SERVER WMS

Quando inserisci l’indirizzo URL del server assicurati di usare l’indirizzo di base. Ad esempio non devi inserire
frammenti tipo request=GetCapabilities o version=1.0.0 nell’indirizzo.

Avvertimento: Entering username and password in the Authentication tab will keep unprotected credentials
in the connection configuration. Those credentials will be visible if, for instance, you shared the project
file with someone. Therefore, it’s advisable to save your credentials in a Authentication configuration instead
(configurations tab). See Authentication System for more details.
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Caricare layer WMS/WMTS

Once you have successfully filled in your parameters, you can use the [Connect] button to retrieve the capabilities
of the selected server. This includes the image encoding, layers, layer styles and projections. Since this is a
network operation, the speed of the response depends on the quality of your network connection to the WMS
server. While downloading data from the WMS server, the download progress is visualized in the lower left of the
WMS dialog.

Il vostro schermo adesso dovrebbe essere simile a quello rappresentato nella figura figure_OGC_add_wms, che
mostra la risposta fornita dal server WMS di European Soil Portal.

Figure 15.2: Finestra di dialogo per aggiungere un server WMS, mostrando i layer disponibili

Codifica immagine

La sezione Codifica immagine elenca i formati supportati sia dal client che dal server. La scelta è in funzione dei
requisiti di accuratezza.

Suggerimento: Codifica immagine
Un server WMS offre normalmente la scelta fra immagini JPEG o PNG. Il formato JPEG è un formato di com-
pressione lossy, mentre il formato PNG riproduce fedelmente i dati raster.

È meglio usare il formato JPEG per dati di natura fotografica e/o se la perdita parziale di qualità dell’immagine non
causa problemi. Questa scelta riduce normalmente di cinque volte il volume di dati trasferiti rispetto al formato
PNG.

L’uso del formato PNG permette una visualizzazione più precisa ed è da usare se non ci sono problemi per
l’incremento dei dati trasferiti.
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Opzioni

La sezione Opzioni mette a disposizione il campo testo Nome layer per dare un nome al layer WMS. Questo nome
apparirà nella legenda a caricamento avvenuto.

Sotto il nome del layer puoi scegliere la Dimensione delle tile, (per esempio 256x256) in modo da dividere la
richiesta WMS in richieste multiple.

Il campo Limite di elementi per GetFeatureInfo definisce quali elementi del server interrogare.

If you select a WMS from the list, a field with the default projection provided by the mapserver appears. If the
[Change...] button is active, you can click on it and change the default projection of the WMS to another CRS
provided by the WMS server.

Infine puoi attivare Usa la legenda WMS contestuale se il server WMS supporta questa funzionalità. Quindi
verrà mostrata solo la legenda pertinente per l’estensione della visualizzazione mappa corrente e quindi non in-
cluderà gli elementi della legenda per ciò che non puoi vedere nella mappa corrente.

Ordine dei Layer

La scheda Ordine layer elenca i diversi layer disponibili sul server WMS a cui sei connesso. Puoi notare che
alcuni layer sono espandibili; questo significa che puoi visualizzare quei layer con diversi stili di immagine.

Puoi selezionare più layer in una volta, ma solo uno stile di visualizzazione per layer. Quando più layer sono
selezionati questi vengono combinati dal server WMS ed inviati a QGIS in un’unica volta.

Suggerimento: Ordine dei layer WMS
I layer WMS caricati sono sovrapposti in base all’ordine in cui sono elencati nella sezione Layer, ovvero dall’alto
verso il basso. Se vuoi cambiare l’ordine di visualizzazione, usa la scheda Ordine layer.

Trasparenza

In questa versione di QGIS l’impostazione della Trasparenza globale che si imposta da Proprietà layer per essere
sempre attiva, se disponibile.

Suggerimento: Trasparenza dei layer WMS
La possibilità di rendere trasparenti i layer WMS dipende dalla codifica tramite la quale sono stati caricati: PNG
e GIF gestiscono la trasparenza mentre il JPEG no.

Sistema di Riferimento

Sistema di riferimento delle coordinate (CRS) è il termine OGC per una proiezione in QGIS.

Ogni layer WMS può avere diversi SR, in funzione delle capacità del server.

To choose a CRS, select [Change...] and a dialog similar to Finestra di dialogo SR personalizzato will appear.
The main difference with the WMS version of the dialog is that only those CRSs supported by the WMS server
will be shown.

Ricerca Server

Con QGIS puoi anche cercare server WMS. La figura Figure_OGC_search mostra la nuova scheda Cerca Server
della finestra di dialogo Aggiungi layer da un server WM(T)S.

As you can see, it is possible to enter a search string in the text field and hit the [Search] button. After a short
while, the search result will be populated into the list below the text field. Browse the result list and inspect your
search results within the table. To visualize the results, select a table entry, press the [Add selected row to WMS
list] button and change back to the Layers tab. QGIS has automatically updated your server list, and the selected
search result is already enabled in the list of saved WMS servers in the Layers tab. You only need to request the list
of layers by clicking the [Connect] button. This option is quite handy when you want to search maps by specific
keywords.
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Figure 15.3: Finestra di dialogo della ricerca di server WMS con alcune parole chiave

Si tratta fondamentalmente di un front end alle API di http://geopole.org.

Set di tile

Quando usi servizi WMTS (Cached WMS) come

http://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

puoi visualizzare la scheda Opzioni fornita dal server. Informazioni aggiuntive come la dimensione delle mat-
tonelle, i formati e i SR supportati sono elencati in questa tabella. In combinazione con questa funzionalità, puoi

usare il cursore della scala delle mattonelle selezionando Visualizza → Panelli ( o Impostazioni → Panelli),
scegliendo Pannello scala mattonelle. Questo ti dà le scale disponibili dal server delle mattonelle con un comodo
cursore inserito.

Uso dello strumento di identificazione

Dopo aver aggiunto un server WMS, e se sul server WMS è possibile eseguire query su qualsiasi layer, puoi utiliz-

zare lo strumento Informazione elementi per selezionare un pixel sulla mappa. Viene eseguita una query sul server
WMS per ogni selezione effettuata. I risultati della query vengono restituiti in formato testo. La formattazione di
questo testo dipende dal particolare WMS server utilizzato. Selezione formato

Se il server supporta diversi formati in output, un menu a tendina verrà automaticamente aggiunto alla finestra
delle informazioni risultati in modo che i diversi formati possano essere memorizzati nel progetto. Supporto
formato GML

Lo strumento Informazione elementi supporta anche le risposte WMS (GetFeatureInfo) in formato GML (in questo
contesto è chiamato Geometria nell’interfaccia di QGIS). Se il formato “Geometria” è supportato dal server, i
risultati dello strumento ‘Informazione elementi’ sono geometrie proprio come un layer vettore. Quando selezioni
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una singola geometria nell’albero, questa viene evidenziata sulla mappa e la puoi copiare negli appunti e incollare
su un altro layer vettore. Vedi l’esempio UMN Mapserver per il supporto GetFeatureInfo in formato GML.

# in layer METADATA add which fields should be included and define geometry (example):

"gml_include_items" "all"
"ows_geometries" "mygeom"
"ows_mygeom_type" "polygon"

# Then there are two possibilities/formats available, see a) and b):

# a) basic (output is generated by Mapserver and does not contain XSD)
# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "application/vnd.ogc.gml,text/html"

# b) using OGR (output is generated by OGR, it is send as multipart and contains XSD)
# in MAP define OUTPUTFORMAT (example):
OUTPUTFORMAT

NAME "OGRGML"
MIMETYPE "ogr/gml"
DRIVER "OGR/GML"
FORMATOPTION "FORM=multipart"

END

# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "OGRGML,text/html"

Proprietà del server

Una volta aggiunto un server WMS, puoi visualizzarne le proprietà cliccando con il tasto destro sul suo nome
nella legenda e selezionando Proprietà. Scheda Metadati

La scheda Metadati mostra molte informazioni sul server WMS: queste informazioni sono fornite dal server
stesso in risposta alla richiesta di GetCapabilities fatta da QGIS. Puoi ricavare molte informazioni leggendo gli
standard WMS (vediOPOPEN-GEOSPATIAL-CONSORTIUM Letteratura e riferimenti web). Di seguito alcune
definizioni utili:

• Proprietà del server

– Versione WMS — La versione WMS supportata dal server.

– Formati immagine - L’elenco dei tipi MIME disponibili sul server durante la visualizzazione della
mappa. QGIS permette l’uso di qualunque formato supportato dalle librerie Qt, solitamente sono
image/png ed image/jpeg.

– Interroga formati - L’elenco dei tipi MIME con i quali il server può fornire risposta quando usi lo
strumento Informazioni elementi. Attualmente QGIS supporta il tipo text-plain.

• Propertà layer

– Selezionato — Indica se il layer era selezionato quando il server è stato aggiunto al progetto.

– Visibilità - Indica se il layer è stato impostato come visibile in legenda. (funzione non ancora utilizzata
in questa versione di QGIS).

– Può interrogare —Indica se il layer fornisce o meno informazioni se si usa lo strumento Informazioni
elementi.

– Può essere trasparente - Indica se il layer può essere o meno reso trasparente. Questa versione di
QGIS userà sempre la trasparenza se questa è Sì e se il formato immagine la supporta.

– Può ingrandire- Indica se il layer può essere ingrandito dal server. Questa versione di QGIS assume
in modo predefinito che tutti i layer WMS abbiano questa impostazione su Si. I layer senza questa
impostazione potrebbero essere visualizzati in modo anomalo.

– Conteggio a cascata — I server WMS possono fungere da proxy per altri server WMS dai quali
ottengono i dati raster per un certo layer. La voce mostra quindi quante richieste per questo layer
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vengono inoltrate ai nodi per ottenere un risultato.

– Larghezza fissa, Altezza fissa - Indica se questo layer ha una dimensione fissa dei pixel. In questa
versione di QGIS tutti i layer WMS hanno questa impostazione impostata su nulla. I layer con im-
postazioni diverse potrebbero essere visualizzati in modo anomalo.

– Perimetro WGS 84 - Il riquadro di delimitazione in coordinate WGS84. Alcuni server WMS non
impostano questo parametro correttamente (ad es. usano coordinate UTM invece di WGS84). In
questo caso sembrerà che la vista iniziale del layer sia ad uno zoom molto ridotto. Bisognerebbe
informare di questi errori il webmaster del server WMS,che potrebbe conoscere come elementi WMS
XML LatLonBoundingBox, EX_GeographicBoundingBox o CRS:84 BoundingBox.

– Disponibilità in CRS — Sistemi di riferimento nel quale il layer può essere rappresentato dal server
WMS, elencati nel formato nativo WMS.

– Disponibile in stile — Stili visuali applicabili al layer dal server WMS.

Show WMS legend graphic in table of contents and composer

The QGIS WMS data provider is able to display a legend graphic in the table of contents’ layer list and in the
map composer. The WMS legend will be shown only if the WMS server has GetLegendGraphic capability and
the layer has getCapability url specified, so you additionally have to select a styling for the layer.

Se legendGraphic è disponibile, viene mostrato sotto il layer. È piuttosto piccolo e dovrai cliccarci sopra per
aprirlo nelle dimensioni reali (fatto dovuto alle limitazioni QgsLegendInterface). Cliccando sulla legenda del
layer si aprirà una finestra con la legenda alla massima risoluzione.

In the print composer, the legend will be integrated at it’s original (downloaded) dimension. Resolution of the
legend graphic can be set in the item properties under Legend –> WMS LegendGraphic to match your printing
requirements

La legenda mostrerà informazioni contestuali riferite alla scala attuale. La legenda WMS verrà mostrata solo se
il server WMS ha le capability GetLegendGraphic e se il layer ha le capability dell’url getCapability specificate,
cosi puoi anche scegliere uno stile per il layer.

Limitazioni del client WMS

Non tutte le funzionalità client WMS sono state incluse in questa versione di QGIS. Le eccezioni più rilevanti
sono le seguenti.

Modificare le impostazioni del layer WMS

Una volta completata la procedura Aggiungi layer WMS/WMTS, non puoi più modificarne i parametri. Una possibile
soluzione è quella di eliminare completamente il layer e ricaricarlo reimpostando i parametri.

Server WMS che richiedono un’autenticazione

Attualmente sono accessibili server pubblici e server protetti. Puoi accedere ai server protetti con autenticazione
pubblica. Puoi aggiungere le credenziali (opzionali) quando carichi un server WMS. Vedi sezione Selezionare
server WMS/WMTS per ulteriori dettagli.

Suggerimento: Accesso ai layer OCG protetti
If you need to access secured layers with secured methods other than basic authentication, you can use InteProxy
as a transparent proxy, which does support several authentication methods. More information can be found in the
InteProxy manual at http://inteproxy.wald.intevation.org.

Suggerimento: WMS Mapserver QGIS
A partire dalla versione 1.7.0, in QGIS è stato implementato un server WMS 1.3.0 Mapserver. Ulteriori infor-
mazioni nel capitolo QGIS as OGC Data Server.
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15.1.2 Client WCS

Un servizio WCS fornisce accesso a dati raster che sono utili per la visualizzazione lato client, come input
per modelli scientifici e per molti altri usi. Quali sono le caratteristiche che distinguono un servizio WCS dai
servizi WFS e WMS? Mentre i servizi WFS e WMS sono istanze server, il servizio WCS permette al client di
scegliere le porzioni di server che contengono le informazioni desiderate. Queste informazioni possono essere
filtrate attraverso limiti spaziali o altre tipologie di interrogazioni.

QGIS ha un servizio WCS nativo e supporta le versioni 1.0 e 1.1 (che sono molto diverse fra di loro), ma attual-
mente preferisce la versione 1.0, perché la 1.1 ha ancora troppi problemi (ad esempio ogni server lo implementa
in modo diverso con differenti particolarità).

Il supporto nativo WCS si occupa di tutte le richieste di rete e usa tutte le impostazioni standard di QGIS (spe-
cialmente i proxy). Puoi anche scegliere la modalità cache (‘sempre cache’, ‘preferisci cache’, ‘preferisci rete’,
‘sempre rete’) e la fonte dati supporta anche la posizione temporale se questa è disponibile dal server.

Avvertimento: Entering username and password in the Authentication tab will keep unprotected credentials
in the connection configuration. Those credentials will be visible if, for instance, you shared the project
file with someone. Therefore, it’s advisable to save your credentials in a Authentication configuration instead
(configurations tab). See Authentication System for more details.

15.1.3 Client WFS e WFS-T

In QGIS, un layer WFS si comporta come un qualsiasi altro layer vettoriale. Puoi identificare, selezionare elementi
e visualizzare la tabella degli attributi. A partire da QGIS 1.6.0 è anche supportata la gestione di layer WFS-T.

Normalmente la procedura per l’aggiunta di un layer WFS è molto simile a quella vista per i WMS. La differenza
sta nel fatto che non ci sono server predefiniti, quindi devi aggiungere manualmente i server noti.

Caricare un layer WFS

Come esempio puoi caricare il server WFS DM Solutions e visualizzare un layer. L’indirizzo da inserire è:
http://www2.dmsolutions.ca/cgi-bin/mswfs_gmap

1. Clicca sullo strumento Aggiungi layer WFS nella barra dei layer ed apparirà la finestra di dialogo Aggiungi
layer WFS da server.

2. Click on [New].

3. Inserisci il nome ‘DM Solutions’.

4. Inserisci l’indirizzo precedentemente indicato.

5. Click [OK].

6. Scegli ‘DM Solutions’ dal menu a tendina Connessioni Server .

7. Click [Connect].

8. Aspetta che vengano caricati tutti i layer.

9. Seleziona dalla lista il layer Parks.

10. Click [Apply] to add the layer to the map.

Ogni impostazione proxy presente nelle preferenze viene automaticamente riconosciuta.

Nella finestra di dialogo delle impostazioni WFS, è possibile definire il numero massimo di geometrie scaricate,
impostare la versione, forzare su Ignora orientamento assi (WFS 1.1 / WFS 2.0) e forzare Inverti l’orientamento
degli assi.
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Avvertimento: Entering username and password in the Authentication tab will keep unprotected credentials
in the connection configuration. Those credentials will be visible if, for instance, you shared the project
file with someone. Therefore, it’s advisable to save your credentials in a Authentication configuration instead
(configurations tab). See Authentication System for more details.

Figure 15.4: Aggiungere un layer WFS

Noterai che il progresso del download è visualizzato nella parte inferiore sinistra della finestra principale di QGIS.
Una volta caricato il layer, puoi identificare e selezionare una provincia o due e visualizzare la tabella degli
attributi.

Nota: Informazioni sulle differenze tra le versioni WFS
WFS 1.0.0, 1.1.0 e 2.0 sono supportati. Ora sono supportati il download in background e la visualizzazione
progressiva, il caching su disco delle geometrie scaricate e il rilevamento automatico della versione.

Solo il servizio WFS 2.0 supporta il paging di GetFeature.

Suggerimento: Cercare server WFS
Puoi ricercare ulteriori server WFS tramite Google o altro motore di ricerca preferito. Ci sono anche diversi
elenchi di URL pubblici, alcuni dei quali aggiornati e altri non più manutenuti.

15.2 QGIS as OGC Data Server

QGIS Server is an open source WMS 1.3, WFS 1.0.0 and WCS 1 1.1.1 implementation that, in addition, imple-
ments advanced cartographic features for thematic mapping. QGIS Server is a FastCGI/CGI (Common Gateway
Interface) application written in C++ that works together with a web server (e.g., Apache, Lighttpd). It has Python
plugin support allowing for fast and efficient development and deployment of new features. The original develop-
ment of QGIS Server was funded by the EU projects Orchestra, Sany and the city of Uster in Switzerland.

QGIS Server uses QGIS as back end for the GIS logic and for map rendering. Furthermore, the Qt library is
used for graphics and for platform-independent C++ programming. In contrast to other WMS software, the QGIS
Server uses cartographic rules as a configuration language, both for the server configuration and for the user-
defined cartographic rules.

As QGIS desktop and QGIS Server use the same visualization libraries, the maps that are published on the web
look the same as in desktop GIS.
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In the following sections, we will provide a sample configuration to set up a QGIS Server on Debian/Ubuntu
Linux. For more detailed installation instructions on other platforms or distributions and more information on
working with QGIS Server, we recommend reading the QGIS Server Training Manual or server_plugins.

15.2.1 Getting Started

Installation

At this point, we will give a short and simple sample installation how-to for a minimal working configuration
using Apache2 on Debian/Ubuntu. The first step is QGIS Server installation whose instructions are provided in
QGIS installers page.

HTTP Server configuration

Apache

Install the Apache server in a separate virtual host listening on port 80. Enable the rewrite module to pass HTTP
BASIC auth headers:

$ sudo a2enmod rewrite
$ cat /etc/apache2/conf-available/qgis-server-port.conf
Listen 80
$ sudo a2enconf qgis-server-port

This is the virtual host configuration, stored in /etc/apache2/sites-available/001-qgis-server.conf:

<VirtualHost *:80>
ServerAdmin webmaster@localhost
DocumentRoot /var/www/html

ErrorLog ${APACHE_LOG_DIR}/qgis-server-error.log
CustomLog ${APACHE_LOG_DIR}/qgis-server-access.log combined

# Longer timeout for WPS... default = 40
FcgidIOTimeout 120
FcgidInitialEnv LC_ALL "en_US.UTF-8"
FcgidInitialEnv PYTHONIOENCODING UTF-8
FcgidInitialEnv LANG "en_US.UTF-8"
FcgidInitialEnv QGIS_DEBUG 1
FcgidInitialEnv QGIS_SERVER_LOG_FILE /tmp/qgis-000.log
FcgidInitialEnv QGIS_SERVER_LOG_LEVEL 0

ScriptAlias /cgi-bin/ /usr/lib/cgi-bin/
<Directory "/usr/lib/cgi-bin">

AllowOverride All
Options +ExecCGI -MultiViews +FollowSymLinks
# for apache2 > 2.4
Require all granted
#Allow from all

</Directory>
</VirtualHost>

Now enable the virtual host and restart Apache:

$ sudo a2ensite 001-qgis-server
$ sudo service apache2 restart
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NGINX

You can use QGIS Server with nginx.

On Debian based systems:

apt-get install nginx fcgiwrap

Introduce the following in your nginx server block configuration:

1 location ~ ^/cgi-bin/.*\.fcgi$ {
2 gzip off;
3 include fastcgi_params;
4 fastcgi_pass unix:/var/run/fcgiwrap.socket;
5

6 fastcgi_param SCRIPT_FILENAME /usr/lib/cgi-bin/qgis_mapserv.fcgi;
7 fastcgi_param QGIS_SERVER_LOG_FILE /logs/qgisserver.log;
8 fastcgi_param QGIS_SERVER_LOG_LEVEL 0;
9 fastcgi_param QGIS_DEBUG 1;

10 }

As you can see from lines 6-9 you can add parameters in your location block in the form of fastcgi_param
param_name param_value, e.g. fastcgi_param DISPLAY ":99";.

The include fastcgi_params; is important as it adds the parameters from
/etc/nginx/fastcgi_params:

fastcgi_param QUERY_STRING $query_string;
fastcgi_param REQUEST_METHOD $request_method;
fastcgi_param CONTENT_TYPE $content_type;
fastcgi_param CONTENT_LENGTH $content_length;

fastcgi_param SCRIPT_NAME $fastcgi_script_name;
fastcgi_param REQUEST_URI $request_uri;
fastcgi_param DOCUMENT_URI $document_uri;
fastcgi_param DOCUMENT_ROOT $document_root;
fastcgi_param SERVER_PROTOCOL $server_protocol;
fastcgi_param REQUEST_SCHEME $scheme;
fastcgi_param HTTPS $https if_not_empty;

fastcgi_param GATEWAY_INTERFACE CGI/1.1;
fastcgi_param SERVER_SOFTWARE nginx/$nginx_version;

fastcgi_param REMOTE_ADDR $remote_addr;
fastcgi_param REMOTE_PORT $remote_port;
fastcgi_param SERVER_ADDR $server_addr;
fastcgi_param SERVER_PORT $server_port;
fastcgi_param SERVER_NAME $server_name;

# PHP only, required if PHP was built with --enable-force-cgi-redirect
fastcgi_param REDIRECT_STATUS 200;

Prepare a project to serve

To provide a new QGIS Server WMS, WFS or WCS, we have to create a QGIS project file with some data. Here,
we use the ‘Alaska’ shapefile from the QGIS sample dataset. Define the colors and styles of the layers in QGIS
and the project CRS, if not already defined.

Then, go to the OWS Server menu of the Project → Project Properties dialog and provide some information about
the OWS in the fields under Service Capabilities. This will appear in the GetCapabilities response of the WMS,

WFS or WCS. If you don’t check Service capabilities, QGIS Server will use the information given in the
wms_metadata.xml file located in the cgi-bin folder.
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Figure 15.5: Definitions for a QGIS Server WMS/WFS/WCS project
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Avvertimento: If you’re using the QGIS project with styling based on SVG files using relative paths then you
should know that the server considers the path relative to its qgis_mapserv.fcgi file (not to the qgs file).
So, if you deploy a project on the server and the SVG files are not placed accordingly, the output images may
not respect the Desktop styling. To ensure this doesn’t happen, you can simply copy the SVG files relative to
the qgis_mapserv.fcgi. You can also create a symbolic link in the directory where the fcgi file resides
that points to the directory containing the SVG files (on Linux/Unix).

WMS capabilities

In the WMS capabilities section, you can define the extent advertised in the WMS GetCapabilities response by
entering the minimum and maximum X and Y values in the fields under Advertised extent. Clicking Use Current

Canvas Extent sets these values to the extent currently displayed in the QGIS map canvas. By checking CRS
restrictions, you can restrict in which coordinate reference systems (CRS) QGIS Server will offer to render maps.

Use the button below to select those CRSs from the Coordinate Reference System Selector, or click Used to
add the CRSs used in the QGIS project to the list.

If you have print composers defined in your project, they will be listed in the GetProjectSettings response, and
they can be used by the GetPrint request to create prints, using one of the print composer layouts as a template.
This is a QGIS-specific extension to the WMS 1.3.0 specification. If you want to exclude any print composer from

being published by the WMS, check Exclude composers and click the button below. Then, select a print
composer from the Select print composer dialog in order to add it to the excluded composers list.

If you want to exclude any layer or layer group from being published by the WMS, check Exclude Layers and

click the button below. This opens the Select restricted layers and groups dialog, which allows you to choose
the layers and groups that you don’t want to be published. Use the Shift or Ctrl key if you want to select
multiple entries.

You can receive requested GetFeatureInfo as plain text, XML and GML. Default is XML, text or GML format
depends the output format chosen for the GetFeatureInfo request.

If you wish, you can check Add geometry to feature response. This will include in the GetFeatureInfo response
the geometries of the features in a text format. If you want QGIS Server to advertise specific request URLs in the
WMS GetCapabilities response, enter the corresponding URL in the Advertised URL field. Furthermore, you can
restrict the maximum size of the maps returned by the GetMap request by entering the maximum width and height
into the respective fields under Maximums for GetMap request.

If one of your layers uses the Map Tip display (i.e. to show text using expressions) this will be listed inside the
GetFeatureInfo output. If the layer uses a Value Map for one of its attributes, this information will also be shown
in the GetFeatureInfo output.

WFS capabilities

In the WFS capabilities area you can select the layers you want to publish as WFS, and specify if they will allow
update, insert and delete operations. If you enter a URL in the Advertised URL field of the WFS capabilities
section, QGIS Server will advertise this specific URL in the WFS GetCapabilities response.

WCS capabilities

In the WCS capabilities area, you can select the layers that you want to publish as WCS. If you enter a URL in the
Advertised URL field of the WCS capabilities section, QGIS Server will advertise this specific URL in the WCS
GetCapabilities response.
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Fine tuning your OWS

For vector layers, the Fields menu of the Layer → Properties dialog allows you to define for each attribute if it
will be published or not. By default, all the attributes are published by your WMS and WFS. If you don’t want a
specific attribute to be published, uncheck the corresponding checkbox in the WMS or WFS column.

You can overlay watermarks over the maps produced by your WMS by adding text annotations or SVG annotations
to the project file. See the Note testuali section for instructions on creating annotations. For annotations to be
displayed as watermarks on the WMS output, the Fixed map position checkbox in the Annotation text dialog must
be unchecked. This can be accessed by double clicking the annotation while one of the annotation tools is active.
For SVG annotations, you will need either to set the project to save absolute paths (in the General menu of the
Project → Project Properties dialog) or to manually modify the path to the SVG image so that it represents a valid
relative path.

Serve the project

Now, save the session in a project file alaska.qgs. To provide the project as a WMS/WFS, create a new folder
/usr/lib/cgi-bin/project with admin privileges and add the project file alaska.qgs and a copy of
the qgis_mapserv.fcgi file - that’s all.

Now test your project WMS, WFS and WCS. Add the WMS, WFS and WCS as described in Caricare layer
WMS/WMTS, Client WFS e WFS-T and Client WCS to QGIS and load the data. The URL is:

http://localhost/cgi-bin/project/qgis_mapserv.fcgi

Cascading OGC layers

A QGIS project can of course contain layers coming from remote OGC servers (regardless of the underlying OGC
server software used). This way QGIS will effectively cascade those layers through its OGC (QGIS Server based)
services.

If the external OGC layers are coming from services that make use of the HTTPS protocol you must take care of
some extra QGIS Server configuration. Example for the Apache web server:

$ mkdir /srv/qgis/.qgis2
$ chown www-data:www-data /srv/qgis/.qgis2
$ chmod 774 /srv/qgis/.qgis2

This ensures that the web server is able to write in some user defined folder. Then add the following line to the
Apache virtual host file to ensure that Apache will use such folder:

FcgidInitialEnv HOME "/srv/qgis"

Restart Apache.

15.2.2 Services

QGIS Server supports some vendor parameters and requests that greatly enhance the possibilities of customising
its behavior. The following paragraphs list the vendor parameters and the environment variables supported by the
server.

Web Map Service (WMS)

GetMap

In the WMS GetMap request, QGIS Server accepts a couple of extra parameters in addition to the standard
parameters according to the OGC WMS 1.3.0 specification:
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• DPI parameter: The DPI parameter can be used to specify the requested output resolution.

Example:

http://localhost/cgi-bin/qgis_mapserv.fcgi?REQUEST=GetMap&DPI=300&...

• IMAGE_QUALITY parameter is only used for JPEG images. By default, the JPEG compression is -1.
You can change the default per QGIS project in the OWS Server → WMS capabilities menu of the Project
→ Project Properties dialog. If you want to override it in a GetMap request you can do it using the
IMAGE_QUALITY parameter:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&FORMAT=image/jpeg&IMAGE_QUALITY=65&...

• image/png; mode= can be used to override the png format. You can choose between image/png;
mode=16bit, image/png; mode=8bit and image/png; mode=1bit. This can shrink the out-
put image size quite a bit. Example:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&FORMAT=image/png; mode=8bit&...

• OPACITIES parameter: Opacity can be set on layer or group level. Allowed values range from 0 (fully
transparent) to 255 (fully opaque).

Example:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&LAYERS=mylayer1,mylayer2&OPACITIES=125,200&...

• FILTER parameter: Subsets of layers can be selected with the FILTER parameter. Syntax is basically
the same as for the QGIS subset string. However, there are some restrictions to avoid SQL injections into
databases via QGIS server:

Text strings need to be enclosed with quotes (single quotes for strings, double quotes for attributes) A
space between each word / special character is mandatory. Allowed Keywords and special characters are
‘AND’,’OR’,’IN’,’=’,’<’,’>=’, ‘>’,’>=’,’!=*,’(‘,’)’. Semicolons in string expressions are not allowed

Example:

http://myserver.com/cgi/qgis_mapserv.fcgi?REQUEST=GetMap&LAYERS=mylayer1,mylayer2&FILTER=mylayer1:"OBJECTID" = 3;mylayer2:’text’ = ’blabla’&....

Nota: It is possible to make attribute searches via GetFeatureInfo and omit the X/Y parameter if a FILTER is
there. QGIS server then returns info about the matching features and generates a combined bounding box in the
xml output.

• SELECTION parameter: The SELECTION parameter can highlight features from one or more layers. Vec-
tor features can be selected by passing comma separated lists with feature ids in GetMap and GetPrint.

Example:

http://myserver.com/cgi/qgis_mapserv.fcgi?REQUEST=GetMap&LAYERS=mylayer1,mylayer2&SELECTION=mylayer1:3,6,9;mylayer2:1,5,6&...

The following image presents the response from a GetMap request using the SELECTION option e.g.
http://myserver.com/...&SELECTION=countries:171,65. As those features id’s corre-
spond in the source dataset to France and Romania they’re highlighted in yellow.

It is possible to export layers in the DXF format using the GetMap Request. Only layers that have read access in
the WFS service are exported in the DXF format. Here is a valid REQUEST and a documentation of the available
parameters:

http://your.server.address/wms/liegenschaftsentwaesserung/abwasser_werkplan?SERVICE=WMS&VERSION=1.3.0&REQUEST=GetMap&LAYERS=Haltungen,Normschacht,Spezialbauwerke&STYLES=&CRS=EPSG%3A21781&BBOX=696136.28844801,245797.12108743,696318.91114315,245939.25832905&WIDTH=1042&HEIGHT=811&FORMAT=application/dxf&FORMAT_OPTIONS=MODE:SYMBOLLAYERSYMBOLOGY;SCALE:250&FILE_NAME=werkplan_abwasser.dxf

Parameters:

• FORMAT=application/dxf
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Figure 15.6: Server response to a GetMap request with SELECTION parameter
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• FILE_NAME=yoursuggested_file_name_for_download.dxf

• FORMAT_OPTIONS=see options below, key:value pairs separated by Semicolon

FORMAT_OPTIONS Parameters:

• SCALE:scale to be used for symbology rules, filters and styles (not an actual scaling of the data - data
remains in the original scale).

• MODE:NOSYMBOLOGY|FEATURESYMBOLOGY|SYMBOLLAYERSYMBOLOGY corresponds
to the three export options offered in the QGIS Desktop DXF export dialog.

• LAYERSATTRIBUTES:yourcolumn_with_values_to_be_used_for_dxf_layernames - if not specified,
the original QGIS layer names are used.

• USE_TITLE_AS_LAYERNAME if enabled, the title of the layer will be used as layer name.

GetFeatureInfo

QGIS Server WMS GetFeatureInfo requests supports the following extra optional parameters to define the toler-
ance for point, line and polygon layers:

• FI_POINT_TOLERANCE parameter: Tolerance for point layers GetFeatureInfo request, in pixels.

• FI_LINE_TOLERANCE parameter: Tolerance for linestring layers GetFeatureInfo request, in pixels.

• FI_POLYGON_TOLERANCE parameter: Tolerance for polygon layers GetFeatureInfo request, in pixels.

GetPrint

QGIS server has the capability to create print composer output in pdf or pixel format. Print composer windows
in the published project are used as templates. In the GetPrint request, the client has the possibility to specify
parameters of the contained composer maps and labels.

Example:

The published project has two composer maps. In the GetProjectSettings response, they are listed as possible print
templates:

<WMS_Capabilities>
...
<ComposerTemplates xsi:type="wms:_ExtendedCapabilities">
<ComposerTemplate width="297" height="210" name="Druckzusammenstellung 1">
<ComposerMap width="171" height="133" name="map0"/>
<ComposerMap width="49" height="46" name="map1"/></ComposerTemplate>
</ComposerTemplates>
...
</WMS_Capabilities>

The client has now the information to request a print output:

http://myserver.com/cgi/qgis_mapserv.fcgi?...&REQUEST=GetPrint&TEMPLATE=Druckzusammenstellung 1&map0:EXTENT=xmin,ymin,xmax,ymax&map0:ROTATION=45&FORMAT=pdf&DPI=300

Parameters in the GetPrint request are:

• <map_id>:EXTENT gives the extent for a composer map as xmin,ymin,xmax,ymax.

• <map_id>:ROTATION map rotation in degrees

• <map_id>:GRID_INTERVAL_X, <map_id>:GRID_INTERVAL_Y Grid line density for a composer
map in x- and y-direction

• <map_id>:SCALE Sets a mapscale to a composer map. This is useful to ensure scale based visibility of
layers and labels even if client and server may have different algorithms to calculate the scale denominator
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• <map_id>:LAYERS, <map_id>:STYLES possibility to give layer and styles list for composer map (use-
ful in case of overview maps which should have only a subset of layers)

GetLegendGraphics

Several additional parameters are available to change the size of the legend elements:

• BOXSPACE space between legend frame and content (mm)

• LAYERSPACE versical space between layers (mm)

• LAYERTITLESPACE vertical space between layer title and items following (mm)

• SYMBOLSPACE vertical space between symbol and item following (mm)

• ICONLABELSPACE horizontal space between symbol and label text (mm)

• SYMBOLWIDTH width of the symbol preview (mm)

• SYMBOLHEIGHT height of the symbol preview (mm)

These parameters change the font properties for layer titles and item labels:

• LAYERFONTFAMILY / ITEMFONTFAMILY font family for layer title / item text

• LAYERFONTBOLD / ITEMFONTBOLD ‘TRUE’ to use a bold font

• LAYERFONTSIZE / ITEMFONTSIZE Font size in point

• LAYERFONTITALIC / ITEMFONTITALIC ‘TRUE’ to use italic font

• LAYERFONTCOLOR / ITEMFONTCOLOR Hex color code (e.g. #FF0000 for red)

• LAYERTITLE / RULELABEL (from QGIS 2.4) set them to ‘FALSE’ to get only the legend graphics
without labels

Contest based legend. These parameters let the client request a legend showing only the symbols for the features
falling into the requested area:

• BBOX the geographical area for which the legend should be built

• CRS / SRS the coordinate reference system adopted to define the BBOX coordinates

• WIDTH / HEIGHT if set these should match those defined for the GetMap request, to let QGIS Server
scale symbols according to the map view image size.

Contest based legend features are based on the UMN MapServer implementation:

GetProjectSettings

This request type works similar to GetCapabilities, but it is more specific to QGIS Server and allows a client to
read additional information which is not available in the GetCapabilities output:

• initial visibility of layers

• information about vector attributes and their edit types

• information about layer order and drawing order

• list of layers published in WFS

Web Feature Service (WFS)

GetFeature

In the WFS GetFeature request, QGIS Server accepts two extra parameters in addition to the standard parameters
according to the OGC WFS 1.0.0 specification:
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• GeometryName parameter: this parameter can be used to get the extent or the centroid as the geometry or
no geometry if none if used (ie attribute only). Allowed values are extent, centroid or none.

• StartIndex parameter: STARTINDEX is standard in WFS 2.0, but it’s an extension for WFS 1.0.0 which
is the only version implemented in QGIS Server. STARTINDEX can be used to skip some features in the
result set and in combination with MAXFEATURES will provide for the ability to use WFS GetFeature to
page through results. Note that STARTINDEX=0 means start with

Extra parameters supported by all request types

• FILE_NAME parameter: if set, the server response will be sent to the client as a file attachment with the
specified file name.

• MAP parameter: Similar to MapServer, the MAP parameter can be used to specify the path to the QGIS
project file. You can specify an absolute path or a path relative to the location of the server executable
(qgis_mapserv.fcgi). If not specified, QGIS Server searches for .qgs files in the directory where the
server executable is located.

Example:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&MAP=/home/qgis/mymap.qgs&...

Nota:
You can define a QGIS_PROJECT_FILE as an environment variable to tell the server executable
where to find the QGIS project file. This variable will be the location where QGIS will look for the
project file. If not defined it will use the MAP parameter in the request and finally look at the server
executable directory.

the first feature, skipping none.

REDLINING

This feature is available and can be used with GetMap and GetPrint requests.

The redlining feature can be used to pass geometries and labels in the request which are overlapped by the server
over the standard returned image (map). This permits the user to put emphasis or maybe add some comments
(labels) to some areas, locations etc. that are not in the standard map.

The request is in the format:

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi?map=/world.qgs&SERVICE=WMS&VERSION=1.3.0&
REQUEST=GetMap
...
&HIGHLIGHT_GEOM=POLYGON((590000 5647000, 590000 6110620, 2500000 6110620, 2500000 5647000, 590000 5647000))
&HIGHLIGHT_SYMBOL=<StyledLayerDescriptor><UserStyle><Name>Highlight</Name><FeatureTypeStyle><Rule><Name>Symbol</Name><LineSymbolizer><Stroke><SvgParameter name="stroke">%23ea1173</SvgParameter><SvgParameter name="stroke-opacity">1</SvgParameter><SvgParameter name="stroke-width">1.6</SvgParameter></Stroke></LineSymbolizer></Rule></FeatureTypeStyle></UserStyle></StyledLayerDescriptor>
&HIGHLIGHT_LABELSTRING=Write label here
&HIGHLIGHT_LABELSIZE=16
&HIGHLIGHT_LABELCOLOR=%23000000
&HIGHLIGHT_LABELBUFFERCOLOR=%23FFFFFF
&HIGHLIGHT_LABELBUFFERSIZE=1.5

Here is the image outputed by the above request in which a polygon and a label are drawn on top of the normal
map:

You can see there are several parameters in this request:

• HIGHLIGHT_GEOM: You can add POINT, MULTILINESTRING, POLYGON etc. It supports multipart
geometries. Here is an example: HIGHLIGHT_GEOM=MULTILINESTRING((0 0, 0 1, 1 1)).
The coordinates should be in the CRS of the GetMap/GetPrint request.
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Figure 15.7: Server response to a GetMap request with redlining parameters
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• HIGHLIGHT_SYMBOL: This controls how the geometry is outlined and you can change the stroke width,
color and opacity.

• HIGHLIGHT_LABELSTRING: You can pass your labeling text to this parameter.

• HIGHLIGHT_LABELSIZE: This parameter controls the size of the label.

• HIGHLIGHT_LABELCOLOR: This parameter controls the label color.

• HIGHLIGHT_LABELBUFFERCOLOR: This parameter controls the label buffer color.

• HIGHLIGHT_LABELBUFFERSIZE: This parameter controls the label buffer size.

15.2.3 Plugins

Installation

To install the HelloWorld example plugin for testing the servers, you firstly have to create a directory to hold server
plugins. This will be specified in the virtual host configuration and passed on to the server through an environment
variable:

$ sudo mkdir -p /opt/qgis-server/plugins
$ cd /opt/qgis-server/plugins
$ sudo wget https://github.com/elpaso/qgis-helloserver/archive/master.zip
# In case unzip was not installed before:
$ sudo apt-get install unzip
$ sudo unzip master.zip
$ sudo mv qgis-helloserver-master HelloServer

HTTP Server configuration

Apache

To be able to use server plugins, FastCGI needs to know where to look. So, we have to modify the Apache
configuration file to indicate the QGIS_PLUGINPATH environment variable to FastCGI:

FcgidInitialEnv QGIS_SERVER_LOG_FILE /tmp/qgis-000.log
FcgidInitialEnv QGIS_SERVER_LOG_LEVEL 0
FcgidInitialEnv QGIS_PLUGINPATH "/opt/qgis-server/plugins"

Moreover, a basic HTTP authorization is necessary to play with the HelloWorld plugin previously introduced. So
we have to update the Apache configuration file a last time:

# Needed for QGIS HelloServer plugin HTTP BASIC auth
<IfModule mod_fcgid.c>

RewriteEngine on
RewriteCond %{HTTP:Authorization} .
RewriteRule .* - [E=HTTP_AUTHORIZATION:%{HTTP:Authorization}]

</IfModule>

Then, restart Apache:

$ sudo a2ensite 001-qgis-server
$ sudo service apache2 restart

Suggerimento: If you work with a feature that has many nodes then modifying and adding a new feature will
fail. In this case it is possible to insert the following code into the 001-qgis-server.conf file:

<IfModule mod_fcgid.c>
FcgidMaxRequestLen 26214400
FcgidConnectTimeout 60
</IfModule>
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How to use a plugin

Test the server with the HelloWorld plugin:

$ wget -q -O - "http://localhost/cgi-bin/qgis_mapserv.fcgi?SERVICE=HELLO"
HelloServer!

You can have a look at the default GetCapabilities of the QGIS server at:
http://localhost/cgi-bin/qgis_mapserv.fcgi?SERVICE=WMS&VERSION=1.3.0&REQUEST=GetCapabilities

15.2.4 Advanced configuration

Logging

To log requests sent to the server, set the following environment variables:

• QGIS_SERVER_LOG_FILE: Specify path and filename. Make sure that the server has proper permis-
sions for writing to file. File should be created automatically, just send some requests to server. If it’s not
there, check permissions.

• QGIS_SERVER_LOG_LEVEL: Specify desired log level. Available values are:

– 0 INFO (log all requests),

– 1 WARNING,

– 2 CRITICAL (log just critical errors, suitable for production purposes).

Example:

SetEnv QGIS_SERVER_LOG_FILE /var/tmp/qgislog.txt
SetEnv QGIS_SERVER_LOG_LEVEL 0

Nota:
• When using Fcgid module use FcgidInitialEnv instead of SetEnv!

• Server logging is also enabled if executable is compiled in release mode.

Environment variables

You can configure some aspects of QGIS server by setting environment variables. For example, to set QGIS
server on Apache to use /path/to/config/QGIS/QGIS2.ini settings file, add to Apache config:

SetEnv QGIS_OPTIONS_PATH "/path/to/config/"

or, if using fcgi:

FcgidInitialEnv QGIS_OPTIONS_PATH "/path/to/config/"

This is a list of the variables supported by QGIS server:

• QGIS_OPTIONS_PATH: Specifies the path to the directory with settings. It works the
same way as QGIS application –optionspath option. It is looking for settings file in
<QGIS_OPTIONS_PATH>/QGIS/QGIS2.ini.

• QUERY_STRING: The query string, normally passed by the web server. This variable can be useful while
testing QGIS server binary from the command line.

• QGIS_PROJECT_FILE: the .qgs project file, normally passed as a parameter in the query string, you can
also set it as an environment variable (for example by using mod_rewrite Apache module).
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• QGIS_SERVER_LOG_FILE: Specify path and filename. Make sure that server has proper permissions
for writing to file. File should be created automatically, just send some requests to server. If it’s not there,
check permissions.

• QGIS_SERVER_LOG_LEVEL: Specify desired log level. See Logging

• MAX_CACHE_LAYERS: Specify the maximum number of cached layers (default: 100).

• DISPLAY: This is used to pass (fake) X server display number (needed on Unix-like systems).

• QGIS_PLUGINPATH: Useful if you are using Python plugins for the server, this sets the folder that is
searched for Python plugins.

• DEFAULT_DATUM_TRANSFORM: Define datum transformations between two projections, e.g.
EPSG:21781/EPSG:2056/100001/-1;EPSG:2056/EPSG:21781/-1/100001 sets the trans-
formation between CH1903 LV03 (EPSG:21781) and CH1903 LV95 (EPSG:2056) and vice versa. You
also need to place grid shift .gsb files in the directory where proj4 stores the grid shift files, e.g. in
/usr/share/proj. You need to run crssync after you added new .gsb files and look up the ID
in the srs.db. Look at attribute coord_op_code of table tbl_datum_transform in srs.db to find the
correct entry.

Short name for layers, groups and project

A number of elements have both a <Name> and a <Title>. The Name is a text string used for machine-to-
machine communication while the Title is for the benefit of humans.

For example, a dataset might have the descriptive Title “Maximum Atmospheric Temperature” and be requested
using the abbreviated Name “ATMAX”. User can already set title for layers, groups and project.

OWS name is based on the name used in layer tree. This name is more a label for humans than a name for
machine-to-machine communication.

QGIS Server supports:

• short name line edits to layers properties You can change this by right clicking on a layer, choose Properties
→ Metadata tab → Description → Short name.

• WMS data dialog to layer tree group (short name, title, abstract)

By right clicking on a layer group and selecting the Set Group WMS data option you will get:

Figure 15.8: Set group WMS data dialog

• short name line edits to project properties - add a regexp validator "^[A-Za-z][A-Za-z0-9\._-]*"
to short name line edit accessible through a static method

• add a regexp validator "^[A-Za-z][A-Za-z0-9\._-]*" to short name line edit accessible through a
static method

You can choose a short name for the project root by going to Project properties → OWS Server → Service
capabilities → Short name.

• add a TreeName element in the fullProjectSettings

If a short name has been set for layers, groups or project it is used by QGIS Sever as the layer name.
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Connection to service file

In order to make apache aware of the PostgreSQL service file (see the File per la connessione a Servizio Post-
greSQL section) you need to make your *.conf file look like:

SetEnv PGSERVICEFILE /home/web/.pg_service.conf

<Directory "/home/web/apps2/bin/">
AllowOverride None

.....

Add fonts to your linux server

Keep in mind that you may use QGIS projects that point to fonts that may not exist by default on other machines.
This means that if you share the project, it may look different on other machines (if the fonts don’t exist on the
target machine).

In order to ensure this does not happen you just need to install the missing fonts on the target machine. Doing this
on desktop systems is usually trivial (double clicking the fonts).

For linux, if you don’t have a desktop environment installed (or you prefer the command line) you need to:

• On Debian based systems:

$ sudo su
$ mkdir -p /usr/local/share/fonts/truetype/myfonts && cd /usr/local/share/fonts/truetype/myfonts

# copy the fonts from their location
$ cp /fonts_location/* .

$ chown root *
$ cd .. && fc-cache -f -v

• On Fedora based systems:

$ sudo su
$ mkdir /usr/share/fonts/myfonts && cd /usr/share/fonts/myfonts

# copy the fonts from their location
$ cp /fonts_location/* .

$ chown root *
$ cd .. && fc-cache -f -v
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CHAPTER 16

Lavorare con i dati GPS

16.1 Plugin GPS

16.1.1 Cos’è un GPS?

Il sistema di posizionamento globale GPS. il Global Positioning System, è basato sui satelliti, permette, a chiunque
sia dotato di un ricevitore GPS, di individuare esattamente la sua posizione in qualunque zona del mondo. Il GPS
è utilizzato come strumento di aiuto nella navigazione, per esempio negli aeroplani, nelle navi e anche dagli
escursionisti. Il ricevitore GPS sfrutta il segnale dei satelliti per calcolare latitudine, longitudine e (qualche volta)
l’altitudine. Molti ricevitori possono memorizzare la posizione (chiamata waypoints), la sequenza delle posizioni
che formano una route e il tracciato o track dei movimenti che il ricevitore ha compiuto nel tempo. Waypoints,
routes e tracks sono i tre principali elementi dei dati GPS. QGIS mostra i waypoints in un vettore puntuale, mentre
route e tracks (percorsi e tracciati) sono visualizzati in vettori lineari.

Nota: QGIS supporta anche ricevitori GNSS. Ma noi continuiamo a usare il termine GPS in questa documen-
tazione.

16.1.2 Caricamento dei dati GPS da file

Ci sono una dozzina di formati di le diversi per memorizzare dati GPS. Il formato utilizzato da QGIS è chiamato
GPX (GPs eXchange format), che è un formato standard di interscambio che può contenere svariati numeri di
posizioni, percorsi e tracce nello stesso le.

Per caricare un le GPX tu devi per prima cosa installare il plugin aprendo la finestra di dialogo Plugins Gestisci e

installa plugin.... Attivare la casella Strumenti GPS. Quando questo plugin viene caricato, un pulsante con un
piccolo dispositivo GPS portatile verrà visualizzato nella barra degli strumenti e in Layer → Crea vettore → :

• Strumenti GPS

• Nuovo vettore GPX

Per lavorare con i dati GPS viene fornito un le GPX di esempio disponibile nel dataset di QGIS
qgis_sample_data/gps/national_monuments.gpx. Vedere la sezione Dati campione per maggiori
informazioni sull’insieme di dati a disposizione.

1. Select Vector → GPS → GPS Tools or click the GPS Tools icon in the toolbar and open the Load GPX file
tab (see figure_GPS).

2. Browse to the folder qgis_sample_data/gps/, select the GPX file national_monuments.gpx
and click [Open].

Use the [Browse...] button to select the GPX file, then use the checkboxes to select the feature types you want
to load from that GPX file. Each feature type will be loaded in a separate layer when you click [OK]. The file
national_monuments.gpx only includes waypoints.
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Figure 16.1: La finestra di dialogo Strumenti GPS

Nota: GPS units allow you to store data in different coordinate systems. When downloading a GPX file
(from your GPS unit or a web site) and then loading it in QGIS, be sure that the data stored in the GPX
file uses WGS 84 (latitude/longitude). QGIS expects this, and it is the official GPX specification. See
http://www.topografix.com/GPX/1/1/.

16.1.3 GPSBabel

Since QGIS uses GPX files, you need a way to convert other GPS file formats to GPX. This can be done for many
formats using the free program GPSBabel, which is available at http://www.gpsbabel.org. This program can also
transfer GPS data between your computer and a GPS device. QGIS uses GPSBabel to do these things, so it is
recommended that you install it. However, if you just want to load GPS data from GPX files you will not need it.
Version 1.2.3 of GPSBabel is known to work with QGIS, but you should be able to use later versions without any
problems.

16.1.4 Importare dati GPS

Per importare dei dati che non sono dei file GPX, utilizza lo strumento Importa altro file presente nella finestra
di dialogo degli Strumenti GPS. Qui, puoi scegliere il file da importare (e il formato del files), il tipo di dato da
estrarre da esso, dove vuoi salvare il file una volta convertito in GPX e il nome che vuoi dare al nuovo vettore.
Nota che non tutti i formati di dati GPS supportano tutti e tre i tipi di dato, così per alcuni formati potrai scegliere
solo uno e due tipi.

16.1.5 Scaricare dati GPS da un dispositivo

QGIS utilizza GPSBabel per scaricare dati da un dispositivo GPS e caricarli direttamente come nuovi layer vetto-
riali. Per questo si utilizza lo strumento Scarica dal GPS presente nella finestra di dialogo Strumenti GPS (vedi
Figure_GPS_download).). Qui, è possibile selezionare il tipo di dispositivo GPS, la porta alla quale il dispositivo
è connesso (o la porta USB se il GPS supporta questa opzione), il tipo di dati che si desidera scaricare, il le GPX
che contiene i dati da scaricare e il nome del nuovo layer.

GPSBabel comunica con il GPS in base al tipo di dispositivo che viene selezionato nel menu. Se nessuna delle
opzioni disponibili è compatibile con il proprio dispositivo GPS è possibile creare un nuovo tipo (vedi sezione
Definire un nuovo tipo di dispositivo).

La porta potrebbe essere il nome del file o qualche altro termine che il tuo sistema operativo riconosce come porta
fisica alla quale è connesso il dispositivo GPS. Essa potrebbe essere un’uscita USB, nel caso di dispositivi abilitati
per l’USB.
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Figure 16.2: Lo strumento di scaricamento

• Nei sistemi Linux è qualcosa di simile a /dev/ttyS0 or /dev/ttyS1

• In Windows è COM1 or COM2.

When you click [OK], the data will be downloaded from the device and appear as a layer in QGIS.

16.1.6 Caricare dati GPS sul dispositivo

C’è anche la possibilità di caricare dati vettoriali da QGIS al dispositivo GPS utilizzando lo strumento Carica sul
GPS presente sempre nella finestra di dialogo Strumenti GPS. Per effettuare questa operazione devi seplicemente
selezionare il layer che vuoi caricare (che deve essere un layer GPX), il dispositivo GPS utilizzato, e la porta (o
l’USB) alla quale il dispositivo è collegato. Come per lo scaricamento dei dati, anche per il caricamento puoi
specificare un nuovo tipo di dispositivo se tra quelli della lista non è presente quello che si sta utilizzando.

Questo strumento è molto utile in combinazione con le capacità di editing dei dati vettoriali di QGIS. Permette
di caricare una mappa, creare delle posizioni o dei percorsi, e successivamente caricare questi dati nel dispositivo
per poi utilizzarli in campagna.

16.1.7 Definire un nuovo tipo di dispositivo

There are lots of different types of GPS devices. The QGIS developers can’t test all of them, so if you have one
that does not work with any of the device types listed in the Download from GPS and Upload to GPS tools, you
can define your own device type for it. You do this by using the GPS device editor, which you start by clicking
the [Edit devices] button in the download or the upload tab.

To define a new device, you simply click the [New device] button, enter a name, enter download and upload
commands for your device, and click the [Update device] button. The name will be listed in the device menus in
the upload and download windows – it can be any string. The download command is the command that is used to
download data from the device to a GPX file. This will probably be a GPSBabel command, but you can use any
other command line program that can create a GPX file. QGIS will replace the keywords %type, %in, and %out
when it runs the command.

%type sarà sostituito da -w se stai scaricando dei waypoints, -r se stai scaricando delle routes e -t se stai
scaricando dei tracks. Queste sono le opzioni che comunicano a GPSBabel quali elementi scaricare.

%in indica il nome della porta selezionata nella finestra di download mentre %out indica il nome del le GPX
nel quale verranno salvati i dati. Dunque quando viene creato un nuovo dispositivo il seguente comando di
download ‘‘ %type -i garmin -o gpx %in %out‘‘ (questo è il comando di download per la tipologia di dispos-
itivi predefiniti ‘Garmin serial’) verrà utilizzato per scaricare waypoints dalla porta /dev/ all’interno del le
GPX output.gpx, QGIS leggerà la stringa e avvierà il comando gpsbabel -w -i garmin -o gpx
/dev/ttyS0 output.gpx.
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Il comando di upload è il comando che viene utilizzato per caricare dati sul dispositivo. Vengono utilizzati i stessi
tasti, ma %in è utilizzato per indicare il nome del file GPX che contiene il layer in caricamento, e %out viene
sostituito dal nome della porta.

You can learn more about GPSBabel and its available command line options at http://www.gpsbabel.org.

Una volta che avrai creato una nuova periferica, essa apparirà nella lista dei dispositivi presente sia nella scheda
Scarica dal GPS sia nella scheda Carica sul GPS.

16.1.8 Scaricare points/tracks dall’unità GPS

As described in previous sections QGIS uses GPSBabel to download points/tracks directly in the project. QGIS
comes out of the box with a pre-defined profile to download from Garmin devices. Unfortunately there is a bug
#6318 that does not allow create other profiles, so downloading directly in QGIS using the GPS Tools is at the
moment limited to Garmin USB units.

Garmin GPSMAP 60cs

MS Windows

Install the Garmin USB drivers from http://www8.garmin.com/support/download_details.jsp?id=591

Connettere l’unità. Aprire gli Strumenti GPS e impostare type=garmin serial e port=usb: Riempire
i campi Nome layer and File di output. A volte si possono avere dei problemi nel salvataggio dei dati in certe
cartelle, si consiglia di utilizzare un percorso del tipo c:\temp.

Ubuntu/Mint GNU/Linux

Per prima cosa occorre risolvere un problema inerente i permessi di accesso alla periferica, seguendo quanto
scritto qui https://wiki.openstreetmap.org/wiki/USB_Garmin_on_GNU/Linux. Puoi provare a creare un file
/etc/udev/rules.d/51-garmin.rules contenente il seguente codice:

ATTRS{idVendor}=="091e", ATTRS{idProduct}=="0003", MODE="666"

Successivamente occorre essere sicuri che il modulo del kernel garmin_gps non sia caricato

rmmod garmin_gps

and then you can use the GPS Tools. Unfortunately there seems to be a bug #7182 and usually QGIS freezes
several times before the operation work fine.

Data logger BTGP-38KM (solo Bluetooth)

MS Windows

Il baco già discusso non consente di scaricare i dati tramite QGIS, per cui è necessario utilizzare GPSBabel dalla
riga di comando o tramite la sua interfaccia. Il comando da eseguire è

gpsbabel -t -i skytraq,baud=9600,initbaud=9600 -f COM9 -o gpx -F C:/GPX/aaa.gpx

Ubuntu/Mint GNU/Linux

Utilizzare lo stesso comando (o gli stessi parametri, se usate la GUI di GPSBabel). Su Linux potrebbe capitare di
vedere un messaggio tipo

skytraq: Too many read errors on serial port

Si tratta solo di spegnere e riaccendere il data logger e ritentare
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BlueMax GPS-4044 datalogger (sia BT che USB)

MS Windows

Nota: Ha bisogno di installare i propri driver prima di essere utilizzato su Windows 7. Si veda il sito del
costruttore per il file corretto da scaricare.

Scaricando con GSPBabel, sia con USB che BT, si ottiene sempre un errore tipo

gpsbabel -t -i mtk -f COM12 -o gpx -F C:/temp/test.gpx
mtk_logger: Can’t create temporary file data.bin
Error running gpsbabel: Process exited unsuccessfully with code 1

Ubuntu/Mint GNU/Linux

con USB

Dopo aver collecato il cavo, usare il comando dmesg per capire quale porta viene utilizzata, ad esempio
/dev/ttyACM3. Poi, come al solito, utilizzare GPSBabel dalla riga di comando o dalla GUI

gpsbabel -t -i mtk -f /dev/ttyACM3 -o gpx -F /home/user/bluemax.gpx

Con Bluetooth

Utilizzare il Gestore di dispositivi Blueman per accoppiare il dispositivo e renderlo disponibile tramite una porta
di sistema, poio eserguire GPSBabel

gpsbabel -t -i mtk -f /dev/rfcomm0 -o gpx -F /home/user/bluemax_bt.gpx

16.2 Tracciamento live GPS

To activate live GPS tracking in QGIS, you need to select Settings → Panels GPS information. You will get a
new docked window on the left side of the canvas.

Ci sono 4 possibili schermate nella finestra di tracciamento GPS:

• GPS position coordinates and an interface for manually entering vertices and features

• potenza del segnale di connessione del GPS ai satelliti

• GPS polar screen showing number and polar position of satellites

• opzioni di visualizzazione GPS (vedere figure_gps_options)

With a plugged-in GPS receiver (has to be supported by your operating system), a simple click on [Connect] con-
nects the GPS to QGIS. A second click (now on [Disconnect]) disconnects the GPS receiver from your computer.
For GNU/Linux, gpsd support is integrated to support connection to most GPS receivers. Therefore, you first have
to configure gpsd properly to connect QGIS to it.

Avvertimento: Se vuoi registrare la tua posizione sulla mappa devi prima creare un nuovo layer vettoriale ed
entrare nella modalità di editing in modo da registrare il percorso.

16.2.1 Posizione e attributi aggiuntivi

If the GPS is receiving signals from satellites, you will see your position in latitude, longitude and altitude
together with additional attributes.
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Figure 16.3: Tracciamento della posizione GPS e attributi aggiuntivi
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16.2.2 Potenza del segnale GPS

Con questa schermata è possibile vedere la potenza del segnale dei satelliti dai quali si sta ricevendo il segnale.

Figure 16.4: Potenza del segnale GPS

16.2.3 GPS polar window

If you want to know where in the sky all the connected satellites are, you have to switch to the polar screen.
You can also see the ID numbers of the satellites you are receiving signals from.

Figure 16.5: GPS tracking polar window

16.2.4 Opzioni GPS

Nel caso di problemi di connessione, puoi attivare una delle seguenti opzioni:

• Individuazione automatica

• Interno

• Device seriale

• gpsd (selezionando Host, Porta e Device il tuo GPS si deve connettere)

A click on [Connect] again initiates the connection to the GPS receiver.

È possibile attivare Salva automaticamente gli elementi aggiunti quando si è in modalità di editing. Oppure è

possibile attivare l’opzione Aggiungi automaticamente punti sulla mappa con una scelta di grandezza e colore.
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Figure 16.6: Opzioni di connessione del GPS
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Attivando Cursore, puoi usare una barra a scorrimento per ridurre o aumentare la dimen-
sione del cursore sulla mappa

Attivando Centratura mappa puoi decidere in quale modo la mappa dovrà essere aggiornata. Questa opzione
prevede ‘sempre’, ‘quando si chiude’ se le coordinate registrate escono fuori dall’estensione della mappa, o ‘mai’
se rientrano nell’estensione della mappa.

Infine puoi attivare File di log e definire un percorso e un le dove registrare i messaggi che vengono generati
durante il tracciamento GPS.

If you want to set a feature manually, you have to go back to Position and click on [Add Point] or [Add track
point].

16.2.5 Connessione di un GPS Bluetooth GPS per tracciamento live

Con QGIS puoi collegare un GPS Bluetooth per la raccolta di dati. Per eseguire questa operazione è necessario
che il GPS sia dotato di Bluetooth e che il tuo computer abbia il Bluetooth.

Per prima cosa devi fare in modo che il tuo dispositivo GPS sia riconosciuto e associato al computer. Accendi il
GPS, vai sull’icona Bluetooth nell’area di notifica e cerca per Nuovo Dispositivo.

On the right side of the Device selection mask make sure that all devices are selected so your GPS unit will
probably appear among those available. In the next step a serial connection service should be available, select it
and click on [Configure] button.

Ricorda il numero della porta COM assegnata alla connessione GPS risultante dalle proprietà Bluetooth.

Dopo che il GPS è stato riconosciuto, esegui l’accoppiamento per la connessione. Di solito il codice di autoriz-
zazione è 0000.

Now open GPS information panel and switch to GPS options screen. Select the COM port assigned to the GPS
connection and click the [Connect]. After a while a cursor indicating your position should appear.

Se QGIS non è in grado di ricevere dati GPS, devi riavviare il dispositivo GPS, attendere 5-10 secondi e tentare
nuovamente di collegarti. Solitamente questa soluzione funziona. Se ricevi ancora un errore di connessione
accertati di non avere un altro ricevitore Bluetooth vicino a te, accoppiato con la stessa unità GPS.

16.2.6 Usare GPSMAP 60cs

MS Windows

Easiest way to make it work is to use a middleware (freeware, not open) called GPSGate.

Launch the program, make it scan for GPS devices (works for both USB and BT ones) and then in QGIS just click
[Connect] in the Live tracking panel using the Autodetect mode.

Ubuntu/Mint GNU/Linux

Per quanto riguarda Windows, il modo più semplice è utilizzare un server, in questo caso GPSD, quindi

sudo apt-get install gpsd

Quindi carica il modulo del kernel garmin_gps

sudo modprobe garmin_gps

E quindi collegare l’unità. Poi controlla con dmesg il dispositivo reale utilizzato dall’unità, ad esempio
/dev/ttyUSB0. Ora puoi lanciare gpsd

gpsd /dev/ttyUSB0
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E infine connettiti con lo strumento di tracciamento live di QGIS.

16.2.7 Usare BTGP-38KM datalogger (solo Bluetooth)

Usare GPSD (in ambiente Linux) o GPSGate (in ambiente Windows) è semplice.

16.2.8 Usare BlueMax GPS-4044 datalogger (sia BT che USB)

MS Windows

Il Live Tracking funziona sia per le modalità USB che BT, utilizzando GPSGate o anche senza tale opzione, basta
attivare Individuazione automatica, oppure connettere lo strumento sulla porta giusta.

Ubuntu/Mint GNU/Linux

Per USB

Il live tracking funziona anche con GPSD

gpsd /dev/ttyACM3

o senza di esso, connettendo lo strumento live tracking di QGIS direttamente al device (vedi esempio al seguente
link /dev/ttyACM3).

Per Bluetooth

Il live tracking funziona anche con GPSD

gpsd /dev/rfcomm0

o senza di esso, connettendo lo strumento live tracking di QGIS direttamente al device (vedi esempio al seguente
link /dev/rfcomm0).
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Authentication System

17.1 Authentication System Overview

Figure 17.1: Anatomy of authentication system

17.1.1 Authentication database

The new authentication system stores authentication configurations in an SQLite database file located, by default,
at <user home>/.qgis2/qgis-auth.db.

This authentication database can be moved between QGIS installations without affecting other current QGIS user
preferences, as it is completely separate from normal QGIS settings. A configuration ID (a random 7-character
alphanumeric string) is generated when initially storing a configuration to the database. This represents the con-
figuration, thereby allowing the ID to be stored in plain text application components, (such as project, plugin, or
settings files) without disclosure of its associated credentials.

Nota: The parent directory of the qgis-auth.db can be set using the following environment variable,
QGIS_AUTH_DB_DIR_PATH, or set on the command line during launch with the --authdbdirectory
option.
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17.1.2 Master password

To store or access sensitive information within the database, a user must define a master password. A new master
password is requested and verified when initially storing any encrypted data to the database. Only when sensitive
information is accessed is the user prompted for the master password, which is then cached for the remainder of
the session (until application is quit), unless the user manually chooses an action to clear its cached value. Some
instances of using the authentication system do not require input of the master password, such as when selecting an
existing authentication configuration, or applying a configuration to a server configuration (such as when adding
a WMS layer).

Figure 17.2: Input new master password

Nota: A path to a file containing the master password can be set using the following environment variable,
QGIS_AUTH_PASSWORD_FILE.

Managing the master password

Once set, the master password can be reset; the current master password will be needed prior to resetting. During
this process, there is an option to generate a complete backup of the current database.

Figure 17.3: Resetting master password

If the user forgets the master password, there is no way to retrieve or override it. There is also no means of
retrieving encrypted information without knowing the master password.

If a user inputs their existing password incorrectly three times, the dialog will offer to erase the database.

17.1.3 Authentication Configurations

You can manage authentication configurations from Configurations in the Authentication tab of the QGIS Options
dialog (Settings → Options).
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Figure 17.4: Password prompt after three invalid attempts

Figure 17.5: Configurations editor
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Use the button to add a new configuration, the button to remove configurations, and the button to
modify existing ones.

Figure 17.6: Adding config from within Configuration editor

The same type of operations for authentication configuration management (Add, Edit and Remove) can be done
when configuring a given service connection, such as configuring an OWS service connection. For that, there are
action buttons within the configuration selector for fully managing configurations found within the authentication
database. In this case, there is no need to go to the configurations in Authentication tab of QGIS options unless
you need to do more comprehensive configuration management.

When creating or editing an authentication configuration, the info required is a name, an authentication method
and any other info that the authentication method requires (see more about the available authentication types in
Authentication Methods).

17.1.4 Authentication Methods

Available authentications are provided by C++ plugins much in the same way data provider plugins are sup-
ported by QGIS. The method of authentication that can be selected is relative to the access needed for the re-
source/provider, e.g. HTTP(S) or database, and whether there is support in both QGIS code and a plugin. As such,
some authentication method plugins may not be applicable everywhere an authentication configuration selector is
shown. A list of available authentication method plugins and their compatible resource/providers can be accessed
going to Settings → Options and, in the Authentication tab, click the [Installed plugins] button.

Plugins can be created for new authentication methods that do not require QGIS to be recompiled. Since the
support for plugins is currently (since QGIS 2.12) C++-only, QGIS will need to be restarted for the new dropped-
in plugin to become available to the user. Ensure your plugin is compiled against the same target version of QGIS
if you intend to add it to an existing target install.

Nota: The Resource URL is currently an unimplemented feature that will eventually allow a particular configu-
ration to be auto-chosen when connecting to resources at a given URL.
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Figure 17.7: WMS connection dialog showing [Add], [Edit], and [Remove] authentication configuration buttons

Figure 17.8: Available method plugins list

Figure 17.9: Basic HTTP authentication configs
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Figure 17.10: PKI paths authentication configs

Figure 17.11: PKI PKCS#12 file paths authentication configs

Figure 17.12: Stored Identity authentication configs
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17.1.5 Master Password and Auth Config Utilities

Under the Options menu (Settings → Options) in the Authentication tab, there are several utility actions to manage
the authentication database and configurations:

Figure 17.13: Utilities menu

• Input master password:

– Opens the master password input dialog, independent of performing any authentication database com-
mand. Clear cached master password

– Unsets the master password if it has been set via input dialog. Reset master password

– Opens a dialog to change the master password (the current password must be known) and optionally
back up the current database.

• Clear cached authentication configurations: Clears the internal lookup cache for configurations used to
speed up network connections. This does not clear QGIS’s core network access manager’s cache, which
requires a relaunch of QGIS.

• Reset master password: Replaces the current master password for a new one. The current master password
will be needed prior to resetting and a backup of database can be done.

• Remove all authentication configurations: Clears the database of all configuration records, without re-
moving other stored records.

• Erase authentication database: Schedules a backup of the current database and complete rebuild of the
database table structure. These actions are scheduled for a later time, so as to ensure other operations like
project loading do not interrupt the operation or cause errors due to a temporarily missing database.

Figure 17.14: DB erase verification menu

17.1.6 Using authentication configurations

Typically, an authentication configuration is selected in a configuration dialog for a network services (such as
WMS). However, the selector widget can be embedded anywhere authentication is needed or in non-core func-
tionality, like in third-party PyQGIS or C++ plugins.

When using the selector, No authentication is displayed in the pop-up menu control when nothing is selected,
when there are no configurations to choose from, or when a previously assigned configuration can no longer be
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found in the database. The Type and Id fields are read-only and provide a description of the authentication method
and the config’s ID respectively.

Figure 17.15: Authentication configuration selector with no authentication

Figure 17.16: Authentication configuration selector with selected config

17.1.7 Python bindings

All classes and public functions have sip bindings, except QgsAuthCrypto, since management of the master
password hashing and auth database encryption should be handled by the main app, and not via Python. See
Security Considerations concerning Python access.

17.2 User Authentication Workflows

17.2.1 HTTP(S) authentication

One of the most common resource connections is via HTTP(S), e.g. web mapping servers, and authentication
method plugins often work for these types of connections. Method plugins have access to the HTTP request
object and can manipulate both the request as well as its headers. This allows for many forms of internet-based
authentication. When connecting via HTTP(S) using the standard username/password authentication method will
attempt HTTP BASIC authentication upon connection.

17.2.2 Database authentication

Connections to database resources are generally stored as key=value pairs, which will expose usernames and
(optionally) passwords, if not using an authentication configuration. When configuring with the new auth system,
the key=value will be an abstracted representation of the credentials, e.g. authfg=81t21b9.

17.2.3 PKI authentication

When configuring PKI components within the authentication system, you have the option of importing compo-
nents into the database or referencing component files stored on your filesystem. The latter may be useful if such
components change frequently, or where the components will be replaced by a system administrator. In either
instance you will need to store any passphrase needed to access private keys within the database.
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Figure 17.17: Generic user workflow

Figure 17.18: Configuring a WMS connection for HTTP BASIC
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Figure 17.19: Configuring a Postgres SSL-with-PKI connection

All PKI components can be managed in separate editors within the Certificate Manager, which can be accessed
in the Authentication tab in QGIS Options dialog (Settings → Options) by clicking the [Manage certificates]
button.

In the Certificate Manager, there are editors for Identities, Servers and Authorities. Each of these are contained
in their own tabs, and are described below in the order they are encountered in the workflow chart above. The tab
order is relative to frequently accessed editors once you are accustomed to the workflow.

Nota: Because all authentication system edits write immediately to the authentication database, there is no need
to click the Options dialog [OK] button for any changes to be saved. This is unlike other settings in the Options
dialog.

Authorities

You can manage available Certificate Authorities (CAs) from the Authorities tab in the Certificate manager from
the Authentication tab of the QGIS Options dialog.

As referenced in the workflow chart above, the first step is to import or reference a file of CAs. This step is
optional, and may be unnecessary if your PKI trust chain originates from root CAs already installed in your
operating system (OS), such as a certificate from a commercial certificate vendor. If your authenticating root CA
is not in the OS’s trusted root CAs, it will need to be imported or have its file system path referenced. (Contact
your system administrator if unsure.)

By default, the root CAs from your OS are available; however, their trust settings are not inherited. You should
review the certificate trust policy settings, especially if your OS root CAs have had their policies adjusted. Any
certificate that is expired will be set to untrusted and will not be used in secure server connections, unless you
specifically override its trust policy. To see the QGIS-discoverable trust chain for any certificate, select it and click

the Show information for certificate.
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Figure 17.20: PKI configuration workflow
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Figure 17.21: Opening the Certificate Manager

Figure 17.22: Authorities editor
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Figure 17.23: Certificate info dialog
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You can edit the trust policy for any selected certificate within the chain. Any change in trust policy to

a selected certificate will not be saved to the database unless the Save certificate trust policy change to database button is
clicked per selected certification. Closing the dialog will not apply the policy changes.

Figure 17.24: Saving the trust policy changes

You can review the filtered CAs, both intermediate and root certificates, that will be trusted for secure connections

or change the default trust policy by clicking the Options button.

Avvertimento: Changing the default trust policy may result in problems with secure connections.

Figure 17.25: Authorities options menu

You can import CAs or save a file system path from a file that contains multiple CAs, or import individual CAs.
The standard PEM format for files that contain multiple CA chain certifications has the root cert at the bottom of
the file and all subsequently signed child certificates above, towards the beginning of the file.

The CA certificate import dialog will find all CA certificates within the file, regardless of order, and also offers the
option to import certificates that are considered invalid (in case you want to override their trust policy). You can
override the trust policy upon import, or do so later within the Authorities editor.

Figure 17.26: Import certificates dialog
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Nota: If you are pasting certificate information into the PEM text field, note that encrypted certificates are not
supported.

Identities

You can manage available client identity bundles from the Identities tab in the Certificate manager from the
Authentication tab of the QGIS Options dialog. An identity is what authenticates you against a PKI-enabled
service and usually consists of a client certificate and private key, either as separate files or combined into a single
“bundled” file. The bundle or private key is often passphrase-protected.

Once you have any Certificate Authorities (CAs) imported you can optionally import any identity bundles into the
authentication database. If you do not wish to store the identities, you can reference their component file system
paths within an individual authentication configuration.

Figure 17.27: Identities editor

When importing an identity bundle, it can be passphrase-protected or unprotected, and can contain CA certificates
forming a trust chain. Trust chain certifications will not be imported here; they can be added separately under the
Authorities tab.

Upon import the bundle’s certificate and private key will be stored in the database, with the key’s storage encrypted
using the QGIS master password. Subsequent usage of the stored bundle from the database will only require input
of the master password.

Personal identity bundles consisting of PEM/DER (.pem/.der) and PKCS#12 (.p12/.pfx) components are sup-
ported. If a key or bundle is passphrase-protected, the password will be required to validate the component prior
to import. Likewise, if the client certificate in the bundle is invalid (for example, its effective date has not yet
started or has elapsed) the bundle can not be imported.

17.2.4 Handling bad layers

Occasionally, the authentication configuration ID that is saved with a project file is no longer valid, possibly
because the current authentication database is different than when the project was last saved, or due to a credentials
mismatch. In such cases the Handle bad layers dialog will be presented upon QGIS launch.
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Figure 17.28: PEM/DER identity import

Figure 17.29: PKCS#12 identity import

Figure 17.30: Handle bad layers with authentication
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If a data source is found to have an authentication configuration ID associated with it, you will be able to edit it.
Doing so will automatically edit the data source string, much in the same way as opening the project file in a text
editor and editing the string.

Figure 17.31: Edit bad layer’s authentication config ID

17.2.5 Changing authentication config ID

Occasionally, you will need to change the authenticationn configuration ID that is associated with accessing a
resource. There are instances where this is useful:

• Resource auth config ID is no longer valid: This can occur when you have switched auth databases add
need to align a new configuration to the ID already associated with a resource.

• Shared project files: If you intended to share projects between users, e.g. via a shared file server, you can
predefine a 7-character (containing a-z and/or 0-9) that is associated with the resource. Then, individual
users change the ID of an authentication configuration that is specific to their credentials of the resource.
When the project is opened, the ID is found in the authentication database, but the credentials are different
per user.

Figure 17.32: Changing a layer’s authentication config ID (unlocked yellow text field)
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Avvertimento: Changing the auth config ID is considered an advanced operation and should only be done
with full knowledge as to why it is necessary. This is why there is a lock button that needs clicked, to unlock
the ID’s text field prior to editing the ID.

17.2.6 QGIS Server support

When using a project file, with layers that have authentication configurations, as a basis for a map in QGIS Server,
there are a couple of additional setup steps necessary for QGIS to load the resources:

• Authentication database needs to be available

• Authentication database’s master password needs to be available

When instantiating the authentication system, Server will create or use qgis-auth.db in ~/.qgis2/ or the
directory defined by the QGIS_AUTH_DB_DIR_PATH environment variable. It may be that the Server’s user has
no HOME directory, in which case, use the environment variable to define a directory that the Server’s user has
read/write permissions and is not located within the web-accessible directories.

To pass the master password to Server, write it to the first line of file at a path on the file system readable by the
Server processes user and defined using the QGIS_AUTH_PASSWORD_FILE environment variable. Ensure to
limit the file as only readable by the Server’s process user and to not store the file within web-accessible directories.

Nota: QGIS_AUTH_PASSWORD_FILE variable will be removed from the Server environment immediately
after accessing.

17.2.7 SSL server exceptions

Figure 17.33: SSL server exception

You can manage SSL server configurations and exceptions from the Servers tab in the Authentication section of
the QGIS Options dialog.

Sometimes, when connecting to an SSL server, there are errors with the SSL “handshake” or the server’s certifi-
cate. You can ignore those errors or create an SSL server configuration as an exception. This is similar to how
web browsers allow you to override SSL errors, but with more granular control.

Avvertimento: You should not create an SSL server configuration unless you have complete knowledge of
the entire SSL setup between the server and client. Instead, report the issue to the server administrator.

Nota: Some PKI setups use a completely different CA trust chain to validate client identities than the chain used
to validate the SSL server certificate. In such circumstances, any configuration created for the connecting server
will not necessarily fix an issue with the validation of your client identity, and only your client identity’s issuer or
server administrator can fix the issue.
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You can pre-configure an SSL server configuration by clicking the button. Alternatively, you can add a
configuration when an SSL error occurs during a connection and you are presented with an SSL Error dialog
(where the error can be ignored temporarily or saved to the database and ignored):

Figure 17.34: Manually adding configuration

Once an SSL configuration is saved to the database, it can be edited or deleted.

If you want to pre-configure an SSL configuration and the import dialog is not working for your server’s con-
nection, you can manually trigger a connection via the Python Console by running the following code (replace
https://bugreports.qt-project.org with the URL of your server):

from PyQt4.QtNetwork import *
req = QNetworkRequest(QUrl(’https://bugreports.qt-project.org’))
reply = QgsNetworkAccessManager.instance().get(req)

This will open an SSL error dialog if any errors occur, where you can choose to save the configuration to the
database.

17.3 Security Considerations

Once the master password is entered, the API is open to access authentication configs in the authentication
database, similar to how Firefox works. However, in the initial implementation, no wall against PyQGIS ac-
cess has been defined. This may lead to issues where a user downloads/installs a malicious PyQGIS plugin or
standalone app that gains access to authentication credentials.

The quick solution for initial release of feature is to just not include most PyQGIS bindings for the authentication
system.
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Figure 17.35: Adding configuration during SSL error

Figure 17.36: Existing SSL configuration
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Figure 17.37: Editing an existing SSL configuration

Another simple, though not robust, fix is to add a combobox in Settings → Options → Authentication (defaults to
“never”):

"Allow Python access to authentication system"
Choices: [ confirm once per session | always confirm | always allow | never]

Such an option’s setting would need to be saved in a location non-accessible to Python, e.g. the authentication
database, and encrypted with the master password.

• Another option may be to track which plugins the user has specifically

• allowed to access the authentication system, though it may be tricky to deduce which plugin is actually
making the call.

• Sandboxing plugins, possibly in their own virtual environments, would reduce ‘cross-plugin’ hacking of
authentication configs from another plugin that is authorized. This might mean limiting cross-plugin com-
munication as well, but maybe only between third-party plugins.

• Another good solution is to issue code-signing certificates to vetted plugin authors. Then validate the plu-
gin’s certificate upon loading. If need be the user can also directly set an untrusted policy for the certificate
associated with the plugin using existing certificate management dialogs.

• Alternatively, access to sensitive authentication system data from Python

• could never be allowed, and only the use of QGIS core widgets, or duplicating authentication system in-
tegrations, would allow the plugin to work with resources that have an authentication configuration, while
keeping master password and authentication config loading in the realm of the main app.

The same security concerns apply to C++ plugins, though it will be harder to restrict access, since there is no
function binding to simply be removed as with Python.

17.3.1 Restrictions

The confusing licensing and exporting issues associated with OpenSSL apply. In order for Qt to work with SSL
certificates, it needs access to the OpenSSL libraries. Depending upon how Qt was compiled, the default is to
dynamically link to the OpenSSL libs at run-time (to avoid the export limitations).

QCA follows a similar tactic, whereby linking to QCA incurs no restrictions, because the qca-ossl (OpenSSL)
plugin is loaded at run-time. The qca-ossl plugin is directly linked to the OpenSSL libs. Packagers would be the
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ones needing to ensure any OpenSSL-linking restrictions are met, if they ship the plugin. Maybe. I don’t really
know. I’m not a lawyer.

The authentication system safely disables itself when qca-ossl is not found at run-time.
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Integrazione con GRASS GIS

L’integrazione di GRASS fornisce l’accesso ai database e alle funzionalità di GRASS GIS (vedi GRASS-
PROJECT in Letteratura e riferimenti web). L’integrazione consiste di due parti: sorgente e plugin. Il sorgente
consente di sfogliare, gestire e visualizzare i layer raster e vettoriali GRASS. Il plugin può essere utilizzato per
creare nuove posizioni e gruppi di GRASS, modificare la regione di GRASS, creare e modificare i livelli vettoriali
e analizzare i dati GRASS 2D e 3D con più di 400 moduli GRASS. In questa sezione, introdurremo le funzionalità
del sorgente e del plug-in e forniremo alcuni esempi di gestione e utilizzo dei dati GRASS.

ll sorgente supporta GRASS versione 6 e 7, il plugin supporta GRASS 6 e 7 (a partire da QGIS 2.12). La
distribuzione QGIS può contenere sorgente/plugin per GRASS 6, GRASS 7 o per entrambe le versioni contempo-
raneamente (i file binari hanno nomi dei file diversi). Tuttavia, solo una versione del sorgente/plugin può essere
caricata durante l’esecuzione.

18.1 Demo insieme di dati

As an example, we will use the QGIS Alaska dataset (see section Sample Data). It includes a small sample GRASS
LOCATION with three vector layers and one raster elevation map. Create a new folder called grassdata, down-
load the QGIS ‘Alaska’ dataset qgis_sample_data.zip from http://qgis.org/downloads/data/ and unzip the
file into grassdata.

More sample GRASS LOCATIONs are available at the GRASS website at
http://grass.osgeo.org/download/sample-data/.

18.2 Caricare layer raster e vettoriali GRASS

If the provider is loaded in QGIS, the location item with GRASS icon is added in the browser tree under each
folder item which contains GRASS location. Go to the folder grassdata and expand location alaska and
mapset demo.

Puoi caricare raster e vettori GRASS come qualsiasi altro layer dal browser facendo doppio clic sul layer o trasci-
nando e rilasciando sulla mappa o sulla legenda.

Suggerimento: Caricare dati GRASS
Se non vedi la location GRASS, verifica in Guida → Informazioni → Sorgente dati se il sorgente dei vettori
GRASS è caricato.
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18.3 Importare dati nelle LOCATION GRASS tramite trascina e ri-
lascia.

Questa sezione da un esempio di come importare dati raster e vettoriali in un mapset di GRASS. 76

1. Nel browser QGIS accedi al mapset in cui desideri importare i dati.

2. Nel browser QGIS trova un layer che vuoi importare in GRASS, nota che puoi aprire un’altra finestra del
browser (Browser Panel (2)) se i dati sorgente sono troppo lontani dal mapset nell’albero.

3. Trascina un layer e rilascialo sul mapset di destinazione. L’importazione potrebbe richiedere del tempo per i
layer più grandi, vedrai un icona animata |importazione| di fronte al nuovo oggetto del layer fino al termine
dell’importazione.

Quando i raster sono in CRS diversi, possono essere riproiettati utilizzando un Approximate (veloce) o Exact
(esatta). Se viene creato un collegamento al raster sorgente (utilizzando ‘‘ r.external‘‘), i dati di origine sono nello
stesso CRS e il formato è noto a GDAL, verranno utilizzati i dati di origine CRS. Puoi impostare queste opzioni
nella scheda Browser in: ref:‘ grass_options‘.

Se un raster ha più bande, viene creata una nuova mappa GRASS per ogni raster con .<band number> suffisso e

tutto viene raggruppato in . I raster esterni hanno un’icona diversa .

18.4 Gestione dei dati GRASS in QGIS Browser

• Copia delle mappe: le mappe GRASS possono essere copiate tra i mapset all’interno della stessa location
mediante trascinamento della selezione.

• Eliminazione delle mappe: fai clic con il tasto destro su una mappa GRASS e seleziona Elimina dal menu
contestuale.

• Rinominare le mappe: fare clic con il tasto destro su una mappa GRASS e seleziona :guilabel:‘Rinomina’
dal menu contestuale.

18.5 Opzioni di GRASS

Le opzioni GRASS possono essere impostate nella finestra di dialogo Opzioni di GRASS, che può essere aperta
facendo clic con il pulsante destro del mouse sulla posizione o sull’elemento mapset nel browser e quindi
scegliendo Opzioni di GRASS.

18.6 Avviare il plugin GRASS

To use GRASS functionalities in QGIS, you must select and load the GRASS plugin using the Plugin Manager.

To do this, go to the menu Plugins → Manage and Install Plugins..., select GRASS and click [OK].

Le seguenti funzioni principali sono fornite con il menu GRASS (Plugins -> GRASS) quando si avvia il plugin
GRASS:

• Apri mapset

• Nuovo mapset

• Chiudi mapset

• Apri strumenti GRASS

• Visulalizza la regione di GRASS attuale
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• Opzioni di GRASS

18.7 Aprire un mapset GRASS

Per accedere a strumenti GRASS devi aprire un mapset di GRASS nel plugin (gli strumenti sono disabilitati se
nessun mapset è aperto). Puoi aprire un mapset dal browser: fai clic con il pulsante destro del mouse sull’elemento
mapset e quindi scegli Apri mapset dal menu contestuale.

18.8 LOCATION e MAPSET in GRASS

I dati GRASS sono memorizzati in una cartella indicata come GISDBASE. Questa cartella, spesso chiamata
grassdata, deve essere creata prima di iniziare a lavorare con il plugin GRASS in QGIS. All’interno di questa
cartella, i dati GIS GRASS sono organizzati per progetti memorizzati in sottocartelle chiamate LOCATION. Ogni
LOCATION è definito dal suo sistema di coordinate, dalla proiezione e dai confini geografici. Ciascun LOCATION
può avere diversi MAPSET (sottocartella di LOCATION) che vengono utilizzati per suddividere il progetto in
diversi argomenti o sottoregioni o come aree di lavoro per i singoli membri del team (vedere Neteler & Mitasova
2008 in: ref: literature_and_web). Per analizzare i vettori e i raster con i moduli GRASS, devi generalmente
importarli in una LOCATION GRASS. (Questo non è sempre vero - con i moduli GRASS r.external e :file:‘
v.external‘ è possibile creare collegamenti di sola lettura a insieme di dati esterni supportati da GDAL/OGR senza
importarli. Questo non è un modo perchi inizia a lavorare con GRASS, quindi questa funzionalità non sarà
descritta qui.)

Figure 18.1: Dati di GRASS all’interno della LOCATIoN Alaska

18.9 Importare dati nelle LOCATION GRASS

See section Importare dati nelle LOCATION GRASS tramite trascina e rilascia. to find how data can be easily
imported by dragging and dropping in the browser.

This section gives an example of how to import raster and vector data into the ‘alaska’ GRASS LOCATION
provided by the QGIS ‘Alaska’ dataset in traditional way, using standard GRASS modules. Therefore, we use the
landcover raster map landcover.img and the vector GML file lakes.gml from the QGIS ‘Alaska’ dataset
(see Sample Data).

1. Avvia QGIS e assicurati che il plugin GRASS sia caricato
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2. In the GRASS toolbar, click the Open MAPSET icon to bring up the MAPSET wizard.

3. Select as GRASS database the folder grassdata in the QGIS Alaska dataset, as LOCATION ‘alaska’, as
MAPSET ‘demo’ and click [OK].

4. Now click the Open GRASS tools icon. The GRASS Toolbox (see section The GRASS Toolbox) dialog
appears.

5. To import the raster map landcover.img, click the module r.in.gdal in the Modules Tree tab. This
GRASS module allows you to import GDAL-supported raster files into a GRASS LOCATION. The module
dialog for r.in.gdal appears.

6. Scorri la cartella raster nell’insieme di dati ‘Alaska’ di QGIS e seleziona il file landcover.img.

7. As raster output name, define landcover_grass and click [Run]. In the Output tab, you
see the currently running GRASS command r.in.gdal -o input=/path/to/landcover.img
output=landcover_grass.

8. When it says Successfully finished, click [View output]. The landcover_grass raster layer is now
imported into GRASS and will be visualized in the QGIS canvas.

9. To import the vector GML file lakes.gml, click the module v.in.ogr in the Modules Tree tab. This
GRASS module allows you to import OGR-supported vector files into a GRASS LOCATION. The module
dialog for v.in.ogr appears.

10. Scorri la cartella gml nell’insieme di dati ‘Alaska’ di QGIS e selezionare il file lakes.gml come file
OGR.

11. As vector output name, define lakes_grass and click [Run]. You don’t have to care about the other
options in this example. In the Output tab you see the currently running GRASS command v.in.ogr -o
dsn=/path/to/lakes.gml output=lakes\_grass.

12. When it says Succesfully finished, click [View output]. The lakes_grass vector layer is now imported
into GRASS and will be visualized in the QGIS canvas.

18.9.1 Creare una nuova LOCATION GRASS

As an example, here is the sample GRASS LOCATION alaska, which is projected in the Albers Equal Area
projection using feet as units. This sample GRASS LOCATION alaska will be used for all examples and exer-
cises in the following GRASS-related sections. It is useful to download and install the dataset on your computer
(see Sample Data).

1. Avvia QGIS e assicurati che il plugin GRASS sia caricato

2. Visualize the alaska.shp shapefile (see section Caricare un layer da un le) from the QGIS Alaska dataset
(see Sample Data).

3. In the GRASS toolbar, click on the New mapset icon to bring up the MAPSET wizard.

4. Select an existing GRASS database (GISDBASE) folder grassdata, or create one for the new
LOCATION using a file manager on your computer. Then click [Next].

5. We can use this wizard to create a new MAPSET within an existing LOCATION (see section Aggiungere
un nuovo MAPSET) or to create a new LOCATION altogether. Select Create new location (see fig-
ure_grass_new_location).

6. Enter a name for the LOCATION – we used ‘alaska’ – and click [Next].

7. Define the projection by clicking on the radio button Projection to enable the projection list.

8. We are using Albers Equal Area Alaska (feet) projection. Since we happen to know that it is represented
by the EPSG ID 2964, we enter it in the search box. (Note: If you want to repeat this process for another

LOCATION and projection and haven’t memorized the EPSG ID, click on the CRS Status icon in the lower
right-hand corner of the status bar (see section Lavorare con le proiezioni)).
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9. In Filter, insert 2964 to select the projection.

10. Click [Next].

11. To define the default region, we have to enter the LOCATION bounds in the north, south, east, and west
directions. Here, we simply click on the button [Set current QGIS extent], to apply the extent of the
loaded layer alaska.shp as the GRASS default region extent.

12. Click [Next].

13. We also need to define a MAPSET within our new LOCATION (this is necessary when creating a new
LOCATION). You can name it whatever you like - we used ‘demo’. GRASS automatically creates a special
MAPSET called PERMANENT, designed to store the core data for the project, its default spatial extent and
coordinate system definitions (see Neteler & Mitasova 2008 in Letteratura e riferimenti web).

14. Check out the summary to make sure it’s correct and click [Finish].

15. The new LOCATION, ‘alaska’, and two MAPSETs, ‘demo’ and ‘PERMANENT’, are created. The currently
opened working set is ‘demo’, as you defined.

16. Si noti che alcuni strumenti della barra di GRASS precedentemente disabilitati sono ora attivi.

Figure 18.2: Creating a new GRASS LOCATION or a new MAPSET in QGIS

If that seemed like a lot of steps, it’s really not all that bad and a very quick way to create a LOCATION. The
LOCATION ‘alaska’ is now ready for data import (see section Importare dati nelle LOCATION GRASS). You can
also use the already-existing vector and raster data in the sample GRASS LOCATION ‘alaska’, included in the
QGIS ‘Alaska’ dataset Sample Data, and move on to section Il modello dati vettoriale di GRASS.

18.9.2 Aggiungere un nuovo MAPSET

A user has write access only to a GRASS MAPSET which he or she created. This means that besides access to
your own MAPSET, you can read maps in other users’ MAPSETs (and they can read yours), but you can modify
or remove only the maps in your own MAPSET.

All MAPSETs include a WIND file that stores the current boundary coordinate values and the currently selected
raster resolution (see Neteler & Mitasova 2008 in Letteratura e riferimenti web, and section Lo strumento Regione
di GRASS).

1. Avvia QGIS e assicurati che il plugin GRASS sia caricato

2. In the GRASS toolbar, click on the New mapset icon to bring up the MAPSET wizard.

3. Select the GRASS database (GISDBASE) folder grassdata with the LOCATION ‘alaska’, where we
want to add a further MAPSET called ‘test’.

4. Click [Next].

5. We can use this wizard to create a new MAPSET within an existing LOCATION or to create a new
LOCATION altogether. Click on the radio button Select location (see figure_grass_new_location) and
click [Next].
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6. Enter the name text for the new MAPSET. Below in the wizard, you see a list of existing MAPSETs and
corresponding owners.

7. Click [Next], check out the summary to make sure it’s all correct and click [Finish].

18.10 Il modello dati vettoriale di GRASS

It is important to understand the GRASS vector data model prior to digitizing. In general, GRASS uses a topolog-
ical vector model. This means that areas are not represented as closed polygons, but by one or more boundaries.
A boundary between two adjacent areas is digitized only once, and it is shared by both areas. Boundaries must be
connected and closed without gaps. An area is identified (and labelled) by the centroid of the area.

Besides boundaries and centroids, a vector map can also contain points and lines. All these geometry elements
can be mixed in one vector and will be represented in different so-called ‘layers’ inside one GRASS vector map.
So in GRASS, a layer is not a vector or raster map but a level inside a vector layer. This is important to distinguish
carefully. (Although it is possible to mix geometry elements, it is unusual and, even in GRASS, only used in
special cases such as vector network analysis. Normally, you should prefer to store different geometry elements
in different layers.)

It is possible to store several ‘layers’ in one vector dataset. For example, fields, forests and lakes can be stored in
one vector. An adjacent forest and lake can share the same boundary, but they have separate attribute tables. It is
also possible to attach attributes to boundaries. An example might be the case where the boundary between a lake
and a forest is a road, so it can have a different attribute table.

The ‘layer’ of the feature is defined by the ‘layer’ inside GRASS. ‘Layer’ is the number which defines if there is
more than one layer inside the dataset (e.g., if the geometry is forest or lake). For now, it can be only a number. In
the future, GRASS will also support names as fields in the user interface.

Attributes can be stored inside the GRASS LOCATION as dBase, SQLite3 or in external database tables, for
example, PostgreSQL, MySQL, Oracle, etc.

Gli attributi contenuti nelle tabelle del database sono collegati alla geometria per il tramite di un valore ’category’.

’Category’ (key, ID) è un valore intero collegato alle primitive geometriche ed è usato come collegamento ad una
colonna chiave nella tabella del database.

Suggerimento: Conoscere il modello dati vettoriale di GRASS
The best way to learn the GRASS vector model and its capabilities is to download one of the many GRASS
tutorials where the vector model is described more deeply. See http://grass.osgeo.org/documentation/manuals/ for
more information, books and tutorials in several languages.

18.11 Creare un nuovo layer vettoriale GRASS

To create a new GRASS vector layer, select one of following items from mapset context menu in the browser:

• New Point Layer

• New Line Layer

• New Polygon Layer

and enter a name in the dialog. A new vector map will be created and layer will be added to canvas and editing
started. Selecting type of the layer does not restrict geometry types which can be digitized in the vector map. In
GRASS, it is possible to organize all sorts of geometry types (point, line and polygon) in one vector map. The
type is only used to add the layer to the canvas, because QGIS requires a layer to have a specific type.

It is also possible to add layers to existing vector maps selecting one of the items described above from context
menu of existing vector map.
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In GRASS, it is possible to organize all sorts of geometry types (point, line and area) in one layer, because GRASS
uses a topological vector model, so you don’t need to select the geometry type when creating a new GRASS vector.
This is different from shapefile creation with QGIS, because shapefiles use the Simple Feature vector model (see
section Creating new vector layers).

18.12 Digitalizzare e modificare layer vettoriali GRASS

GRASS vector layers can be digitized using the standard QGIS digitizing tools. There are however some particu-
larities, which you should know about, due to

• GRASS topological model versus QGIS simple feature

• complexity of GRASS model

– multiple layers in single maps

– multiple geometry types in single map

– geometry sharing by multiple features from multiple layers

The particularities are discussed in the following sections.

Save, discard changes, undo, redo

Avvertimento: All the changes done during editing are immediately written to vector map and related at-
tribute tables.

Changes are written after each operation, it is however, possible to do undo/redo or discard all changes when
closing editing. If undo or discard changes is used, original state is rewritten in vector map and attribute tables.

There are two main reasons for this behaviour:

• It is the nature of GRASS vectors coming from conviction that user wants to do what he is doing and it is
better to have data saved when the work is suddenly interrupted (for example, blackout)

• Necessity for effective editing of topological data is visualized information about topological correctness,
such information can only be acquired from GRASS vector map if changes are written to the map.

Barra degli strumenti di digitalizzazione

The ‘Digitizing Toolbar’ has some specific tools when a GRASS layer is edited:
Icona Strumento Azione

Nuovo punto Digitalizza un nuovo punto

Nuova linea Digitalizza una nuova linea

Nuovo contorno Digitize new boundary

Nuovo centroide Digitalizza un nuovo centroide (imposta l’etichetta per un’area esistente)

New Closed Boundary Digitize new closed boundary

Table GRASS Digitizing: GRASS Digitizing Tools

Suggerimento: Digitalizzare poligoni in GRASS
If you want to create a polygon in GRASS, you first digitize the boundary of the polygon. Then you add a centroid
(label point) into the closed boundary. The reason for this is that a topological vector model links the attribute
information of a polygon always to the centroid and not to the boundary.

Category

Category, often called cat, is sort of ID. The name comes from times when GRASS vectors had only singly
attribute “category”. Category is used as a link between geometry and attributes. A single geometry may have
multiple categories and thus represent multiple features in different layers. Currently it is possible to assign only
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one category per layer using QGIS editing tools. New features have automatically assigned new unique category,
except boundaries. Boundaries usually only form areas and do not represent linear features, it is however possible
to define attributes for a boundary later, for example in different layer.

New categories are always created only in currently being edited layer.

It is not possible to assign more categories to geometry using QGIS editing, such data are properly represented as
multiple features, and individual features, even from different layers, may be deleted.

Attributes

Attributes of currently edited layer can only be modified. If the vector map contains more layers, features of other
layers will have all attributes set to ‘<not editable (layer #)>’ to warn you that such attribute is not editable. The
reason is, that other layers may have and usually have different set of fields while QGIS only supports one fixed
set of fields per layer.

If a geometry primitive does not have a category assigned, a new unique category is automatically assigned and
new record in attribute table is created when an attribute of that geometry is changed.

Suggerimento: If you want to do bulk update of attributes in table, for example using ‘Field Calculator’ (Using
the Field Calculator), and there are features without category which you don’t want to update (typically bound-
aries), you can filter them out by setting ‘Advanced Filter’ to cat is not null.

Editing style

The topological symbology is essential for effective editing of topological data. When editing starts, a specialized
‘GRASS Edit’ renderer is set on the layer automatically and original renderer is restored when editing is closed.
The style may be customized in layer properties ‘Style’ tab. The style can also be stored in project file or in
separate file as any other style. If you customize the style, do not change its name, because it is used to reset the
style when editing is started again.

Suggerimento: Do not save project file when the layer is edited, the layer would be stored with ‘Edit Style’
which has no meaning if layer is not edited.

The style is based on topological information which is temporarily added to attribute table as field ‘topo_symbol’.
The field is automatically removed when editing is closed.

Suggerimento: Do not remove ‘topo_symbol’ field from attribute table, that would make features invisible
because the renderer is based on that column.

Snapping

To form an area, vertices of connected boundaries must have exactly the same coordinates. This can be achieved
using snapping tool only if canvas and vector map have the same CRS. Otherwise, due conversion from map
coordinates to canvas and back, the coordinate may become slightly different due to representation error and CRS
transformations.

Suggerimento: Use layer’s CRS also for canvas when editing.

Limitations

Simultaneous editing of multiple layers within the same vector at the same time is not supported. This is mainly
due to the impossibility of handling multiple undo stacks for a single data source.

On Linux and macOS only one GRASS layer can be edited at time. This is due to a bug in GRASS which
does not allow to close database drivers in random order. This is being solved with GRASS developers.

Suggerimento: Permessi di modifica in GRASS
You must be the owner of the GRASS MAPSET you want to edit. It is impossible to edit data layers in a MAPSET
that is not yours, even if you have write permission.
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18.13 Lo strumento Regione di GRASS

The region definition (setting a spatial working window) in GRASS is important for working with raster layers.
Vector analysis is by default not limited to any defined region definitions. But all newly created rasters will have
the spatial extension and resolution of the currently defined GRASS region, regardless of their original extension
and resolution. The current GRASS region is stored in the $LOCATION/$MAPSET/WIND file, and it defines
north, south, east and west bounds, number of columns and rows, horizontal and vertical spatial resolution.

It is possible to switch on and off the visualization of the GRASS region in the QGIS canvas using the
Display current GRASS region button.

The region can be modified in ‘Region’ tab in ‘GRASS Tolls’ dock widget. Type in the new region bounds and
resolution, and click [Apply]. If you click on [Select the extent by dragging on canvas] you can select a new
region interactively with your mouse on the QGIS canvas dragging a rectangle.

The GRASS module g.region provides a lot more parameters to define an appropriate region extent and reso-
lution for your raster analysis. You can use these parameters with the GRASS Toolbox, described in section The
GRASS Toolbox.

18.14 The GRASS Toolbox

The Open GRASS Tools box provides GRASS module functionalities to work with data inside a selected GRASS
LOCATION and MAPSET. To use the GRASS Toolbox you need to open a LOCATION and MAPSET that you
have write permission for (usually granted, if you created the MAPSET). This is necessary, because new raster or
vector layers created during analysis need to be written to the currently selected LOCATION and MAPSET.

Figure 18.3: GRASS Toolbox and Module Tree

18.14.1 Lavorare con i moduli GRASS

The GRASS shell inside the GRASS Toolbox provides access to almost all (more than 300) GRASS modules in
a command line interface. To offer a more user-friendly working environment, about 200 of the available GRASS
modules and functionalities are also provided by graphical dialogs within the GRASS plugin Toolbox.
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A complete list of GRASS modules available in the graphical Toolbox in QGIS version 2.18 is available in the
GRASS wiki at http://grass.osgeo.org/wiki/GRASS-QGIS_relevant_module_list.

It is also possible to customize the GRASS Toolbox content. This procedure is described in section Personalizzare
gli strumenti GRASS.

As shown in figure_grass_toolbox, you can look for the appropriate GRASS module using the thematically
grouped Modules Tree or the searchable Modules List tab.

By clicking on a graphical module icon, a new tab will be added to the Toolbox dialog, providing three new
sub-tabs: Options, Output and Manual.

Opzioni

The Options tab provides a simplified module dialog where you can usually select a raster or vector layer visualized
in the QGIS canvas and enter further module-specific parameters to run the module.

Figure 18.4: GRASS Toolbox Module Options

The provided module parameters are often not complete to keep the dialog simple. If you want to use further
module parameters and flags, you need to start the GRASS shell and run the module in the command line.

A new feature since QGIS 1.8 is the support for a Show Advanced Options button below the simplified module
dialog in the Options tab. At the moment, it is only added to the module v.in.ascii as an example of use, but
it will probably be part of more or all modules in the GRASS Toolbox in future versions of QGIS. This allows you
to use the complete GRASS module options without the need to switch to the GRASS shell.

Output

The Output tab provides information about the output status of the module. When you click the [Run] button, the
module switches to the Output tab and you see information about the analysis process. If all works well, you will
finally see a Successfully finished message.

Manuale

The Manual tab shows the HTML help page of the GRASS module. You can use it to check further module
parameters and flags or to get a deeper knowledge about the purpose of the module. At the end of each module
manual page, you see further links to the Main Help index, the Thematic index and the Full index.
These links provide the same information as the module g.manual.

Suggerimento: Mostrare i risultati immediatamente
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Figure 18.5: GRASS Toolbox Module Output

Figure 18.6: GRASS Toolbox Module Manual

18.14. The GRASS Toolbox 353



QGIS User Guide, Release 2.18

Se si desidera visualizzare il risultato di un’analisi immediatamente nella vista mappa, è possibile cliccare sul
pulsante Visualizza Output nella porzione inferiore della scheda.

18.14.2 Esempi di utilizzo di moduli GRASS

Gli esempi che seguono mostrano le potenzialità di alcuni moduli GRASS.

Creare curve di livello

The first example creates a vector contour map from an elevation raster (DEM). Here, it is assumed that you have
the Alaska LOCATION set up as explained in section Importare dati nelle LOCATION GRASS.

• First, open the location by clicking the Open mapset button and choosing the Alaska location.

• Now open the Toolbox with the Open GRASS tools button.

• In the list of tool categories, double-click Raster → Surface Management → Generate vector contour lines.

• Now a single click on the tool r.contour will open the tool dialog as explained above (see Lavorare con i
moduli GRASS).

• In the Name of input raster map enter gtopo30.

• Type into the Increment between Contour levels the value 100. (This will create contour lines at
intervals of 100 meters.)

• Inserire in Nome del vettoriale in output il nome ctour_100.

• Click [Run] to start the process. Wait for several moments until the message Successfully finished
appears in the output window. Then click [View Output] and [Close].

Dal momento che la regione è pittosto estesa, il comando richiede del tempo. Una volta terminata l’operazione è
possibile modificare le proprietà del nuovo layer vettoriale come descritto in Proprietà dei vettori.

Next, zoom in to a small, mountainous area in the center of Alaska. Zooming in close, you will notice that the
contours have sharp corners. GRASS offers the v.generalize tool to slightly alter vector maps while keeping
their overall shape. The tool uses several different algorithms with different purposes. Some of the algorithms
(i.e., Douglas Peuker and Vertex Reduction) simplify the line by removing some of the vertices. The resulting
vector will load faster. This process is useful when you have a highly detailed vector, but you are creating a very
small-scale map, so the detail is unnecessary.

Suggerimento: Semplifica geometrie
Note that QGIS has a Vector → Geometry Tools → Simplify geometries tool that works just like the GRASS
v.generalize Douglas-Peuker algorithm.

However, the purpose of this example is different. The contour lines created by r.contour have sharp angles
that should be smoothed. Among the v.generalize algorithms, there is Chaiken’s, which does just that (also
Hermite splines). Be aware that these algorithms can add additional vertices to the vector, causing it to load even
more slowly.

• Open the GRASS Toolbox and double-click the categories Vector → Develop map → Generalization, then
click on the v.generalize module to open its options window.

• Controllare che ‘ctour_100’ appaia come Nome della mappa vettoriale in input.

• From the list of algorithms, choose Chaiken’s. Leave all other options at their default, and scroll down to
the last row to enter in the field Name for output vector map ‘ctour_100_smooth’, and click [Run].

• The process takes several moments. Once Successfully finished appears in the output windows,
click [View output] and then [Close].
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• È possibile modificare il colore del layer vettoriale in modo da renderlo ben visibile sul raster si sfondo. Si
potrà notare come le curve di livello ora appaiano meno spigolose.

Figure 18.7: GRASS module v.generalize to smooth a vector map

Suggerimento: Altri usi di r.contour
The procedure described above can be used in other equivalent situations. If you have a raster map of precipitation
data, for example, then the same method will be used to create a vector map of isohyetal (constant rainfall) lines.

Creating a Hillshade 3-D effect

Several methods are used to display elevation layers and give a 3-D effect to maps. The use of contour lines, as
shown above, is one popular method often chosen to produce topographic maps. Another way to display a 3-D
effect is by hillshading. The hillshade effect is created from a DEM (elevation) raster by first calculating the slope
and aspect of each cell, then simulating the sun’s position in the sky and giving a reflectance value to each cell.
Thus, you get sun-facing slopes lighted; the slopes facing away from the sun (in shadow) are darkened.

• Begin this example by loading the gtopo30 elevation raster. Start the GRASS Toolbox, and under the
Raster category, double-click to open Spatial analysis → Terrain analysis.

• Cliccare r.shaded.relief per aprire il modulo.

• Change the azimuth angle 270 to 315.

• Enter gtopo30_shade for the new hillshade raster, and click [Run].

• Quando il processo sarà completato, aggiungere il raster ombreggiatura alla vista mappa.

• To view both the hillshading and the colors of the gtopo30 together, move the hillshade map below the
gtopo30 map in the table of contents, then open the Properties window of gtopo30, switch to the
Transparency tab and set its transparency level to about 25%.

Si dovrebbe vedere gtopo30 sopra la mappa di ombreggiatura in scala di grigi. Per riuscire a visualizzare
appieno gli effetti dell’ombreggiatura, deselezionare gtopo30_shade.

Usare la shell di GRASS

The GRASS plugin in QGIS is designed for users who are new to GRASS and not familiar with all the modules
and options. As such, some modules in the Toolbox do not show all the options available, and some modules do
not appear at all. The GRASS shell (or console) gives the user access to those additional GRASS modules that
do not appear in the Toolbox tree, and also to some additional options to the modules that are in the Toolbox with
the simplest default parameters. This example demonstrates the use of an additional option in the r.shaded.relief
module that was shown above.
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Figure 18.8: The GRASS shell, r.shaded.relief module
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The module r.shaded.relief can take a parameter zmult, which multiplies the elevation values relative to the X-Y
coordinate units so that the hillshade effect is even more pronounced.

• Load the gtopo30 elevation raster as above, then start the GRASS Toolbox and click on the
GRASS shell. In the shell window, type the command r.shaded.relief map=gtopo30
shade=gtopo30_shade2 azimuth=315 zmult=3 and press [Enter].

• After the process finishes, shift to the Browse tab and double-click on the new gtopo30_shade2 raster
to display it in QGIS.

• As explained above, move the shaded relief raster below the gtopo30 raster in the table of contents, then
check the transparency of the colored gtopo30 layer. You should see that the 3-D effect stands out more
strongly compared with the first shaded relief map.

Figure 18.9: Displaying shaded relief created with the GRASS module r.shaded.relief

Statistiche raster in una mappa vettoriale

Il prossimo esempio tratta di un modulo GRASS che può aggregare dati raster ed aggiungere colonne di statistiche
per ogni poligono di una mappa vettoriale.

• Again using the Alaska data, refer to Importare dati nelle LOCATION GRASS to import the trees shapefile
from the shapefiles directory into GRASS.

• Now an intermediate step is required: centroids must be added to the imported trees map to make it a
complete GRASS area vector (including both boundaries and centroids).

• From the Toolbox, choose Vector → Manage features, and open the module v.centroids.

• Inserire come Nome del vettoriale in output ‘forest_areas’ e lanciare il modulo.

• Now load the forest_areas vector and display the types of forests - deciduous, evergreen, mixed - in

different colors: In the layer Properties window, Symbology tab, choose from Legend type ‘Unique
value’ and set the Classification field to ‘VEGDESC’. (Refer to the explanation of the symbology tab in
Style Properties of the vector section.)

• Next, reopen the GRASS Toolbox and open Vector → Vector update by other maps.

• Click on the v.rast.stats module. Enter gtopo30 and forest_areas.

• Only one additional parameter is needed: Enter column prefix elev, and click [Run]. This is a computa-
tionally heavy operation, which will run for a long time (probably up to two hours).

• Finally, open the forest_areas attribute table, and verify that several new columns have been added,
including elev_min, elev_max, elev_mean, etc., for each forest polygon.
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18.14.3 Personalizzare gli strumenti GRASS

Nearly all GRASS modules can be added to the GRASS Toolbox. An XML interface is provided to parse the
pretty simple XML files that configure the modules’ appearance and parameters inside the Toolbox.

Un esempio di file XML che genera il modulo v.buffer (v.buffer.qgm) ha il seguente aspetto:

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE qgisgrassmodule SYSTEM "http://mrcc.com/qgisgrassmodule.dtd">

<qgisgrassmodule label="Vector buffer" module="v.buffer">
<option key="input" typeoption="type" layeroption="layer" />
<option key="buffer"/>
<option key="output" />

</qgisgrassmodule>

The parser reads this definition and creates a new tab inside the Toolbox when you select the module. A more
detailed description for adding new modules, changing a module’s group, etc., can be found on the QGIS wiki at
http://hub.qgis.org/projects/quantum-gis/wiki/Adding_New_Tools_to_the_GRASS_Toolbox.
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CHAPTER 19

QGIS Browser

QGIS Browser è disponibile come applicazione standalone e come pannello in QGIS Desktop. Ti consente di
navigare facilmente nel tuo disco e gestire i dati geografici. È possibile avere accesso a file vettoriali comuni
(ad es. gli shapefile ESRI o i file MapInfo), database (ad es. PostGIS, Oracle, SpatiaLite o MS SQL Spatial) e
OWS / WCS | WMS | WFS. È inoltre possibile visualizzare i dati GRASS (per ottenere i dati in QGIS, vedere
Integrazione con GRASS GIS).

La descrizione del Browser Panel di QGIS è disponibile nella sezione Il Pannello Browser mentre solo il browser
standalone è trattato qui di seguito.

Come il Browser Pannel di QGIS, l’applicazione QGIS Browser ti aiuta a navigare nel tuo disco e a gestire i
geodati. Ti aiuta anche a visualizzarli in anteprima o a crearli e ad aprirli in un progetto QGIS mediante azioni di
drag-and-drop.

Avvia QGIS browser

• Avvia QGIS Browser dal menù di avvio o dal collegamento sul desktop.

• QGIS Browser è disponibile nella tua cartella delle Applicazioni

Nella figura figure_browser_standalone_metadata, puoi vedere le funzionalità avanzate del QGIS Browser stan-
dalone. La scheda Parametro fornisce i dettagli delle tue connessioni, come PostGIS o MSSQL Spatial. La
scheda Metadata contiene informazioni generali sui file (vedere vectormetadatamenu). Con la scheda Anteprima
puoi dare uno sguardo ai tuoi file senza importarli nel progetto QGIS. E’ anche possibile visualizzare in anteprima
gli attributi dei tuoi file nella scheda Attributi.
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Figure 19.1: QGIS browser come applicazione standalone
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CHAPTER 20

ambiente Processing di QGIS

20.1 Introduzione

Questo capitolo introduce l’ambiente di processing QGIS, un ambiente di elaborazione di dati geografici grazie al
quale potrai usare algoritmi nativi di QGIS e algoritmi di terze parti. In questo modo le attività di analisi spaziale
saranno molto più produttive e facile da realizzare.

Nella sezione seguente esamineremo come usare gli elementi grafici di questo ambiente e come ottenere il mas-
simo da ciascuno di essi.

There are four basic elements in the framework GUI, which are used to run algorithms for different purposes.
Choosing one tool or another will depend on the kind of analysis that is to be performed and the particular
characteristics of each user and project. All of them (except for the batch processing interface, which is called
from the toolbox or the algorithm execution dialog, as we will see) can be accessed from the Processing menu
item. (You will see more than four entries. The remaining ones are not used to execute algorithms and will be
explained later in this chapter).

• The Toolbox. The main element of the GUI, it is used to execute a single algorithm or run a batch process
based on that algorithm.

Figure 20.1: Strumenti di Processing
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• The Graphical modeler. Several algorithms can be combined graphically using the modeler to define a
workflow, creating a single process that involves several subprocesses.

Figure 20.2: Modellatore Grafico

• The History manager. All actions performed using any of the aforementioned elements are stored in a
history file and can be later easily reproduced using the history manager.

Figure 20.3: Cronologia Processing

• The Batch processing interface. This interface allows you to execute batch processes and automate the
execution of a single algorithm on multiple datasets.

Nelle sezioni seguenti rivedremo in dettaglio ciascuno di questi elementi.

Nota: About Vector Menu

Some processing algorithms can be accessed via the Vector menu which lists some tools from the processing
framework but also from plugins.
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Figure 20.4: Interfaccia del processo in serie

20.2 Menu Vettore

Il menu Vettore fornisce una serie di funzioni predefinite veloci e funzionali per molte attività GIS comuni per la
gestione e l’analisi di dati spaziali su dati vettoriali. Queste funzioni sono parte del Framework di elaborazione.
Notare che alcuni plugin possono aggiungere altre funzionalità, in questo capitolo verranno elencate solo le fun-
zioni predefinite del framework di elaborazione.

Il Framework di elaborazione è un plugin che viene installato automaticamente e, come qualsiasi plugin, può
essere abilitato e disattivato utilizzando il plugin Manager (vedi La finestra di dialogo Plugins). Quando è abilitato,
il plugin aggiunge il menu Vettore a QGIS, fornendo funzioni che vanno dall’Analisi e Strumenti di Ricerca alla
Geometria e Strumenti di geoprocessamento, così come diversi strumenti utili per la Gestione dei dati.

Per ulteriori informazioni sul Framework di elaborazione, vedi ambiente Processing di QGIS .
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20.2.1 Strumenti di Analisi

IconaStrumento Azione

Matrice di
distanze

Misura le distanze tra due layer di punti e fornisce il risultato come a) Matrice di
distanze lineare, b) Matrice di distanze standard, c) Sintesi matrice di distanze.
Può limitare i calcoli ai ’k’ punti più vicini.

Somma lunghezza
linee

Calcola la somma totale delle lunghezze delle linee per ogni poligono di un layer
di poligoni.

Punti nel poligono Calcola il numero di punti che ricadono all’interno di ogni poligono di un layer di
poligoni.

Lista valori
univoci

Elenca tutti i valori univoci di un campo di un layer vettoriale.

Statistiche di base
per campi di testo

Calcola statistiche di base (ad esempio: conteggio, valori univoci, valori NULL,
lunghezza campo media-minima-massima) di un campo di testo di un layer
vettoriale.

Statistiche di base
per campi
numerici

Calcola statistiche di base (ad esempio: media, deviazione standard, conteggio,
somma, coefficiente di variazione) di un campo con valori numerici di un layer
vettoriale.

Analisi del vicino
più prossimo

Calcola statistiche di vicinanza per valutare il livello di raggruppamento in un
layer vettoriale di punti.

Media
coordinata(e)

Calcola la media (media normale o pesata) di un intero layer vettoriale o di una
insieme di geometrie in funzione di un campo con ID univoco.

Intersezioni linee Calcola l’intersezione tra linee e restituisce il risultato in uno shapefile di punti.
Utile per localizzare intersezioni fra strade e ponti; ignora le intersezioni con una
lunghezza > 0.

Tabella degli Strumenti 1: Strumenti di Analisi di default
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20.2.2 Strumenti di Ricerca

IconaStrumento Azione

Selezione casuale Seleziona in maniera casuale un numero intero “n” o percentuale “n%” di
geometrie.

Selezione casuale
con un
sottoinsieme

Selezione casuale di geometrie in un sottoinsieme tramite campo ID univoco.

Punti casuali in un
poligono

Genera punti pseudo-casuali in un layer poligonale (numero variabile o un
numero fisso di punti).

Punti casuali in una
zona

Genera punti pseudo-casuali in una zona

Punti casuali sui
bordi

Genera punti pseudo-casuali sui bordi di un layer in input

Punti regolari Genera una griglia regolare di punti su un’area specifica e li esporta come
shapefile di punti.

Reticolo vettoriale Genera una griglia di linee o di poligoni con spaziatura definita dall’utente.

Selezione per
posizione

Seleziona geometrie in base alla loro posizione relativa ad un altro layer per
creare una nuova selezione oppure aggiungere o sottrarre alla selezione corrente.

Poligono
dall’estensione del
layer

Crea un layer poligonale rettangolare dall’estensione di un layer raster o
vettoriale.

Tabella degli Strumenti 2: Strumenti di Ricerca di default

20.2.3 Strumenti di Geoprocessing

Icona Strumento Azione

Poligono(i) convesso(i) Crea il(i) poligono(i) minimo(i) convesso(i) per un layer vettoriale sulla
base di un campo univoco in input.

Buffer a distanza fissa
o a distanza variabile

Crea buffer intorno ad un elemento in funzione di una distanza impostata o
di un campo in input.

Intersezione Sovrappone due layer e ne restituisce uno nuovo contenente la superficie di
intersezione dei layer di input.

Unione Sovrappone due layer e ne restituisce uno nuovo contenente la superficie
totale dei layer di input.

Differenza simmetrica Sovrappone due layer e ne restituisce uno nuovo contenente la superficie dei
layer di input tranne la loro intersezione.

Clip (Ritaglio) Sovrappone due layer e ne restituisce uno nuovo contenente la superficie
intersecata dal clip layer.

Differenza Sovrappone due layer e ne restituisce uno nuovo contenente la superficie
che non interseca il clip layer.

Dissolvenza Unisce geometrie sulla base di un campo in input: le geometrie con lo
stesso valore sono combinate in una geometria unificata.

Elimina poligoni di
scarto

Unisce le geometrie selezionate con il poligono adiacente o con l’area più
grande o con l’area più piccola o con il confine comune maggiore.

Tabella degli Strumenti 3: Strumenti di Geoprocessing di default

20.2. Menu Vettore 365



QGIS User Guide, Release 2.18

20.2.4 Strumenti di Geometria

IconaStrumento Azione

Verificare la validità della geometria Verifica intersezioni dei poligoni, buchi chiusi e corregge
l’ordine dei nodi. Puoi scegliere l’algoritmo utilizzato nella
finestra delle Opzioni, scheda Digitalizzazione, Verifica le
geometrie. Sono disponibili due algoritmi: QGIS e GEOS che
hanno comportamenti leggermente diversi. Esistono anche altri
strumenti che forniscono risultati differenti: ad esempio il
plugin Validatore Topologico utilizza la regola ‘non sono
ammesse geometrie non valide’.

Esporta/Aggiungi colonne
geometriche

Aggiunge informazioni di tipo geometrico a layer di punti
(XCOORD, YCOORD), a layer di linee (LENGTH), a layer di
poligoni (AREA, PERIMETER).

Centroidi di poligoni Calcola i centroidi effettivi per ogni poligono del layer in input.

Triangolazione di Delaunay Calcola e visualizza (come poligoni) la triangolazione di
Delaunay su un layer di punti in input.

Calcola e visualizza (come poligoni)
la triangolazione di Delaunay su un
layer di punti in input.

Calcola i poligoni di Voronoi su un layer di punti in input.

Semplifica geometria Generalizza linee e/o poligoni con un algoritmo modificato di
Douglas-Peucker.

Infittisci geometria Infittisce linee o poligoni aggiungendo vertici.

Da multi parte a parti singole Converte geometrie multi-parte in più geometrie singole. Crea
linee e poligoni singoli.

Da parti singole a multi parte Fonde più geometrie in una geometria multi parte sulla base di
un univoco campo.

Da poligoni a linee Converte poligoni in linee, poligoni multi parte in linee a parti
singole.

Da linee a poligoni Converte linee in poligoni, linee multi parte in poligoni a parti
singole.

Estrae nodi Estrae nodi da layer di linee e poligoni e restituisce un nuovo
layer di punti.

Tabella degli Strumenti 4: Strumenti di Geometria di default

Nota: Lo strumento Semplifica geometria può essere usato per rimuovere nodi doppi in layer di linee o di
poligoni. Il trucco è impostare il valore 0 per il parametro Tolleranza di semplificazione.
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20.2.5 Strumenti di Gestione Dati

IconaStrumento Azione

Definisci la
proiezione
cartografica corrente

Specifica il SR per gli shapefile senza SR associato.

Unisci attributi per
posizione

Aggiunge attributi ad un layer vettoriale sulla base di relazioni spaziali. Gli
attributi di un layer vengono aggiunti alla tabella degli attributi di un altro layer:
il risultato è salvato come nuovo shapefile.

Dividi vettore Divide il layer di input in più layer separati sulla base di un campo in input.

Fondi più shapefile Fonde più shapefile contenuti in una cartella in un unico shapefile sulla base del
tipo di layer (punti, linee, poligoni).

Crea indice spaziale Crea un indice spaziale per i formati supportati da OGR.

Tabella degli Strumenti 5: Strumenti di Gestione Dati di default

20.3 The toolbox

The Toolbox is the main element of the processing GUI, and the one that you are more likely to use in your daily
work. It shows the list of all available algorithms grouped in different blocks, and it is the access point to run them,
whether as a single process or as a batch process involving several executions of the same algorithm on different
sets of inputs.

Figure 20.5: Processing Toolbox

The toolbox contains all the available algorithms, divided into so-called “Providers”.

Providers can be (de)activated in the settings dialog. A label in the bottom part of the toolbox will remind you
of that whenever there are inactive providers. Use the link in the label to open the settings window and set up
providers. We will discuss the settings dialog later in this manual.

By default, only providers that do not rely on third-party applications (that is, those that only require QGIS
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elements to be run) are active. Algorithms requiring external applications might need additional configuration.
Configuring providers is explained in a later chapter in this manual.

In the upper part of the toolbox, you will find a text box. To reduce the number of algorithms shown in the toolbox
and make it easier to find the one you need, you can enter any word or phrase on the text box. Notice that, as you
type, the number of algorithms in the toolbox is reduced to just those that contain the text you have entered in their
names.

If there are algorithms that match your search but belong to a provider that is not active, an additional label will
be shown in the lower part of the toolbox.

Figure 20.6: Processing Toolbox showing search results

If you click on the link in that label, the list of algorithms will also include those from inactive providers, which
will be shown in light gray. A link to active each inactive provider is also shown.

To execute an algorithm, just double-click on its name in the toolbox.

20.3.1 La finestra di configurazione di un algoritmo

Once you double-click on the name of the algorithm that you want to execute, a dialog similar to that in the figure
below is shown (in this case, the dialog corresponds to the ‘Polygon centroids’ algorithm).

This dialog is used to set the input values that the algorithm needs to be executed. It shows a list of input values
and configuration parameters to be set. It of course has a different content, depending on the requirements of the
algorithm to be executed, and is created automatically based on those requirements.

Anche se il numero e tipo dei parametri dipende dal tipo di algoritmo, la struttura di base è simile per tutti. I
parametri della tabella possono essere uno dei seguenti tipi.

• A raster layer, to select from a list of all such layers available (currently opened) in QGIS. The selector
contains as well a button on its right-hand side, to let you select filenames that represent layers currently not
loaded in QGIS.

• A vector layer, to select from a list of all vector layers available in QGIS. Layers not loaded in QGIS can
be selected as well, as in the case of raster layers, but only if the algorithm does not require a table field
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Figure 20.7: Processing Toolbox showing search results

Figure 20.8: Parameters Dialog
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selected from the attributes table of the layer. In that case, only opened layers can be selected, since they
need to be open so as to retrieve the list of field names available.

You will see an iterator button by each vector layer selector, as shown in the figure below.

Figure 20.9: Vector iterator button

Se l’algoritmo ne contiene molti, potrai selezionarne anche solamente uno. Se il pulsante corrispondente a
un vettore in input è attivo, allora l’algoritmo verrà eseguito iterativamente su tutte le sue geometrie, invece
di una sola volta per tutto il vettore. Il numero di output dipende da quante volte eseguirai l’algoritmo.
Questo ti permette di automatizzare il processo quando tutte le geometrie in un vettore devono essere elab-
orate separatamente.

• A table, to select from a list of all available in QGIS. Non-spatial tables are loaded into QGIS like vector
layers, and in fact they are treated as such by the program. Currently, the list of available tables that you will
see when executing an algorithm that needs one of them is restricted to tables coming from files in dBase
(.dbf) or Comma-Separated Values (.csv) formats.

• An option, to choose from a selection list of possible options.

• A numerical value, to be introduced in a spin box. You will find a button by its side. Clicking on it, you will
open the expression builder that allows you to enter a mathematical expression, so you can use it as a handy
calculator. Some useful variables related to data loaded into QGIS can be added to your expression, so you
can select a value derived from any of these variables, such as the cell size of a layer or the northernmost
coordinate of another one.

Figure 20.10: Expression based input

• A range, with min and max values to be introduced in two text boxes.

• A text string, to be introduced in a text box.

• A field, to choose from the attributes table of a vector layer or a single table selected in another parameter.

• A coordinate reference system. You can type the EPSG code directly in the text box, or select it from the
CRS selection dialog that appears when you click on the button on the right-hand side.

• An extent, to be entered by four numbers representing its xmin, xmax, ymin, ymax limits. Clicking on
the button on the right-hand side of the value selector, a pop-up menu will appear, giving you three options:
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– to select the value from a layer or the current canvas extent,

– to define it by dragging directly onto the map canvas, or

– to use the minimum coverage from all input layers.

Figure 20.11: Extent selector

Se scegliete la prima opzione verrà mostrata la seguente finestra di scelta rapida.

Figure 20.12: Extent List

Se scegliete la seconda opzione, la finestra dei parametri sparirà, così potrai scegliere l’area tramite il mouse.
Una volta selezionato il rettangolo, la finestra di dialogo riapparirà completa dei limiti della regione appena
definita.

Figure 20.13: Extent Drag

• A list of elements (whether raster layers, vector layers or tables), to select from the list of such layers
available in QGIS. To make the selection, click on the small button on the left side of the corresponding row
to see a dialog like the following one.

• A small table to be edited by the user. These are used to define parameters like lookup tables or convolution
kernels, among others.

Cliccate sul bottone sul lato destro per vedere la tabella e aggiornare i suoi valori.

A seconda dell’algoritmo, potrai modificare il numero delle righe, usando i pulsanti sul lato destro della
finestra.

Along with the Parameters tab, you will find another tab named Log. Information provided by the algorithm
during its execution is written in this tab, and allow you to track the execution and be aware and have more details
about the algorithm as it runs. Notice that not all algorithms write information to this tab, and many of them might
run silently without producing any output other than the final files.
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Figure 20.14: Multiple Selection

Figure 20.15: Fixed Table
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On the right hand side of the dialog you wil find a short description of the algorithm, which will help you un-
derstand its purpose and its basic ideas. If such a description is not available, the description panel will not be
shown.

Some algorithms might have a more detailed help file, which might include description of every parameter it uses,
or examples. In that case, you will find a Help tab in the parameters dialog.

Nota sulle proiezioni

Algorithms that are run from the processing framework — this is also true for most of the external applications
whose algorithms are exposed through it — do not perform any reprojection on input layers and assume that all
of them are already in a common coordinate system and ready to be analyzed. Whenever you use more than one
layer as input to an algorithm, whether vector or raster, it is up to you to make sure that they are all in the same
coordinate system.

Note that, due to QGIS’s on-the-fly reprojecting capabilities, although two layers might seem to overlap and match,
that might not be true if their original coordinates are used without reprojecting them onto a common coordinate
system. That reprojection should be done manually, and then the resulting files should be used as input to the
algorithm. Also, note that the reprojection process can be performed with the algorithms that are available in the
processing framework itself.

By default, the parameters dialog will show a description of the CRS of each layer along with its name, making it
easy to select layers that share the same CRS to be used as input layers. If you do not want to see this additional
information, you can disable this functionality in the Processing settings dialog, unchecking the Show CRS option.

If you try to execute an algorithm using as input two or more layers with unmatching CRSs, a warning dialog will
be shown.

Potrai comunque eseguire l’algoritmo, ma sappi che nella maggior parte dei casi ciò produrrà cattivi risultati,
come ad esempio layer di uscita inconsistenti, proprio perché questi non sono sovrapposti.

20.3.2 Dati generati dagli algoritmi

I dati generati da un algoritmo possono appartere a una delle seguenti tipologie:

• Raster

• Un vettore

• Tabella

• File HTML (usato per risultati testuali e grafici)

These are all saved to disk, and the parameters table will contain a text box corresponding to each one of these
outputs, where you can type the output channel to use for saving it. An output channel contains the information
needed to save the resulting object somewhere. In the most usual case, you will save it to a file, but in the case of
vector layers, and when they are generated by native algorithms (algorithms not using external applications) you
can also save to a PostGIS or Spatialite database, or a memory layer.

To select an output channel, just click on the button on the right side of the text box, and you will see a small
context menu with the available options.

In the most usual case, you will select saving to a file. If you select that option, you will be prompted with a
save file dialog, where you can select the desired file path. Supported file extensions are shown in the file format
selector of the dialog, depending on the kind of output and the algorithm.

The format of the output is defined by the filename extension. The supported formats depend on what is supported
by the algorithm itself. To select a format, just select the corresponding file extension (or add it, if you are directly
typing the file path instead). If the extension of the file path you entered does not match any of the supported
formats, a default extension will be appended to the file path, and the file format corresponding to that extension
will be used to save the layer or table. Default extensions are .dbf for tables, .tif for raster layers and .shp
for vector layers. These can be modified in the setting dialog, selecting any other of the formats supported by
QGIS.
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If you do not enter any filename in the output text box (or select the corresponding option in the context menu),
the result will be saved as a temporary file in the corresponding default file format, and it will be deleted once you
exit QGIS (take care with that, in case you save your project and it contains temporary layers).

You can set a default folder for output data objects. Go to the settings dialog (you can open it from the Processing
menu), and in the General group, you will find a parameter named Output folder. This output folder is used as the
default path in case you type just a filename with no path (i.e., myfile.shp) when executing an algorithm.

Durante l’esecuzione di un algoritmo che usa un vettore in modo iterativo, il percorso del file inserito è usato
come percorso di base per tutti i file generati, i quali sono nominati usando il nome del vettore e aggiungendo
poi un numero che rappresenta l’indice di iterazione. L’estensione del file (e il formato) viene usata per tutti i file
generati.

Apart from raster layers and tables, algorithms also generate graphics and text as HTML files. These results are
shown at the end of the algorithm execution in a new dialog. This dialog will keep the results produced by any
algorithm during the current session, and can be shown at any time by selecting Processing → Results viewer from
the QGIS main menu.

Some external applications might have files (with no particular extension restrictions) as output, but they do not
belong to any of the categories above. Those output files will not be processed by QGIS (opened or included into
the current QGIS project), since most of the time they correspond to file formats or elements not supported by
QGIS. This is, for instance, the case with LAS files used for LiDAR data. The files get created, but you won’t see
anything new in your QGIS working session.

Per tutti gli altri tipi di output, troverai una casella di controllo che potrai usare per indicare se caricare o meno il
file una volta che è stato generato dall’algoritmo. Come impostazione predefinita, tutti i file vengono aperti.

Optional outputs are not supported. That is, all outputs are created. However, you can uncheck the corresponding
checkbox if you are not interested in a given output, which essentially makes it behave like an optional output (in
other words, the layer is created anyway, but if you leave the text box empty, it will be saved to a temporary file
and deleted once you exit QGIS).

20.3.3 Configuring the processing framework

As has been mentioned, the configuration menu gives access to a new dialog where you can configure how algo-
rithms work. Configuration parameters are structured in separate blocks that you can select on the left-hand side
of the dialog.

Along with the aforementioned Output folder entry, the General block contains parameters for setting the default
rendering style for output layers (that is, layers generated by using algorithms from any of the framework GUI
components). Just create the style you want using QGIS, save it to a file, and then enter the path to that file in the
settings so the algorithms can use it. Whenever a layer is loaded by Processing and added to the QGIS canvas, it
will be rendered with that style.

Rendering styles can be configured individually for each algorithm and each one of its outputs. Just right-click on
the name of the algorithm in the toolbox and select Edit rendering styles for outputs. You will see a dialog like the
one shown next.

Figure 20.16: Rendering Styles
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Select the style file (.qml) that you want for each output and press [OK].

Other configuration parameters in the General group are listed below:

• Use filename as layer name. The name of each resulting layer created by an algorithm is defined by the
algorithm itself. In some cases, a fixed name might be used, meaning that the same output name will be
used, no matter which input layer is used. In other cases, the name might depend on the name of the input
layer or some of the parameters used to run the algorithm. If this checkbox is checked, the name will be
taken from the output filename instead. Notice that, if the output is saved to a temporary file, the filename
of this temporary file is usually a long and meaningless one intended to avoid collision with other already
existing filenames.

• Keep dialog open after running algorithm. Once an algorithm has finished execution and its output layers
are loaded into the QGIS project, the algorithm dialog is closed. If you want to keep it open (to run the
algorithm again with different parameters, or to better check the output that is written to the log tab), check
this option

• Use only selected features. If this option is selected, whenever a vector layer is used as input for an al-
gorithm, only its selected features will be used. If the layer has no selected features, all features will be
used.

• Pre-execution script file and Post-execution script file. These parameters refer to scripts written using the
processing scripting functionality, and are explained in the section covering scripting and the console.

Apart from the General block in the settings dialog, you will also find a block for algorithm providers. Each
entry in this block contains an Activate item that you can use to make algorithms appear or not in the toolbox.
Also, some algorithm providers have their own configuration items, which we will explain later when covering
particular algorithm providers.

20.4 Il gestore della cronologia di Processing

20.4.1 La cronologia di Processing

Ogni volta che esegui un algoritmo, le informazioni sul processo sono salvate dal gestore della cronologia. Ven-
gono salvati anche i parametri usati, la data ed il tempo di esecuzione.

In questo modo è facile tenere traccia e controllare tutto il lavoro eseguito tramite l’ambiente di Processing, e
riprodurlo.

Il gestore della cronologia è un insieme di registri raggruppati per data di esecuzione: in questo modo è molto
facile trovare l’informazione su uno specifico algoritmo eseguito in un particolare momento.

Figure 20.17: Cronologia
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L’informazione sul processo è conservata come una espressione a riga di comando, anche se l’algoritmo è stato
avviato tramite Strumenti. Questo è molto utile se stai imparando ad usare la riga di comando perché puoi vedere
il comando di un algoritmo eseguito tramite Strumenti.

Apart from browsing the entries in the registry, you can also re-execute processes by simply double-clicking on
the corresponding entry.

20.4.2 Il log di Processing

The history dialog only contains the execution calls, but not the information produced by the algorithm when
executed. That information is written to the QGIS log, in a Processing tab.

Third-party algorithms are usually executed by calling their command-line interfaces, which communicate with
the user via the console. Although that console is not shown, a full dump of it is written to the log each time you
run one of those algorithms. To avoid cluttering the log with that information, you can disable it for each provider,
looking for the corresponding option in the provider entry of the settings dialog.

Alcuni algoritmi, anche se vengono correttamente eseguiti e forniscono un risultato, possono aggiungere delle
informazioni nel log se rilevano potenziali problemi con i dati. Guarda i messaggi se vedi che il risultato non è
quello atteso.

20.5 Modellatore grafico

Il modellatore grafico ti consente di creare modelli complessi utilizzando un’interfaccia semplice e facile da usare.
Quando lavori con un GIS, la maggior parte delle operazioni di analisi non sono isolate, ma piuttosto fanno parte
di una catena di operazioni. Usando il modellatore grafico, la successione dei processi può essere confezionata
in un unico processo, quindi è più conveniente eseguire come un processo singolo anche su diversi input. Non
importa quanti passi e diversi algoritmi coinvolge, un modello è eseguito come un unico algoritmo, risparmiando
così tempo e fatica, soprattutto per i modelli più grandi.

Puoi aprire il modellatore grafico dal menu di Processing.

Il modellatore ha un’area grafica di lavoro dove sono visualizzati la struttura del modello ed il flusso delle oper-
azioni che lo rappresenta. Si può usare un pannello con due riquadri sulla sinistra della finestra per aggiungere
nuovi elementi al modello.

Figure 20.18: Modellatore

La creazione di un modello comporta due passaggi:
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1. Definizione degli input necessari. Tutti gli input verranno aggiunti alla finestra dei parametri, in questo
modo puoi impostare i valori durante l’esecuzione del modello. Il modello stesso è un algoritmo, quindi la
finestra dei parametri viene automaticamente generata come accade con tutti gli algoritmi disponibili.

2. Definizione del flusso di lavoro. Usando i dati in input del modello, il flusso di lavoro è definito aggiungendo
algoritmi e scegliendo come questi devono usare gli input o gli output generati da altri algoritmi già presenti
nel modello.

20.5.1 Definizione dei dati di ingresso

Il primo passo per creare un modello è quello di definire tutti gli input. Nella parte sinistra del modellatore trovi
la scheda Inputs dove potrai scegliere i vari elementi.

• Raster

• Vettori

• Stringhe di testo

• Campi di tabelle

• Tabelle

• Estensione

• Numero

• Booleano

• File

Facendo doppio click su uno di questi elementi, apparirà una finestra di dialogo che servirà a definire le sue
caratteristiche. A seconda del parametro, la finestra conterrà un solo elemento (la descrizione, ovvero quello che
vedrai durante l’esecuzione del modello) oppure più elementi. Per esempio, aggiungendo un valore numerico,
come puoi vedere nella figura seguente, oltre alla descrizione del parametro, dovrai definire un valore di partenza
ed un intervallo di valori validi.

Figure 20.19: Definizione Parametri del modello

Per ogni dato di ingresso aggiunto, appare un nuovo elemento nel pannello grafico del modellatore.

Puoi inoltre aggiungere input trascinandolo dall’elenco e rilasciandolo nella mappa del modellatore, nella po-
sizione in cui vuoi posizionarlo.
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Figure 20.20: Parametri del modello nella mappa

20.5.2 Definizione del flusso operativo

Una volta definiti gli input, devi scegliere gli algoritmi che intendi usare. Gli algoritmi si trovano nella casella
Algoritmi, raggruppati allo stesso modo come in Strumenti.

Figure 20.21: Input al modello

Per aggiungere un algoritmo a un modello, fai doppio click sul suo nome o trascinalo, proprio come hai fatto du-
rante l’aggiunta di input. Apparirà una finestra di dialogo, simile a quella che viene visualizzata quando si esegue
l’algoritmo dagli strumenti. Quella mostrata di seguito corrisponde all’algoritmo SAGA ‘indice di convergenza’.

Come puoi vedere, ci sono diverse differenze. Al posto della casella di output dove potevi specificare il percorso
dei layer e tabelle, qui c’è una semplice casella di testo. Se il layer generato da questo algoritmo è solamente
un layer temporaneo che deve essere usato come input da un altro algoritmo, allora non inserire niente in questa
casella. Se riempi questa casella significa che il risultato è finale e che il testo che hai inserito corrisponderà
all’output finale.

Anche il valore di ogni parametro è leggermente diverso, dal momento che che ci sono importanti differenze fra il
contesto del modello e quello degli Strumenti. Vediamo come inserire i valori per ogni tipologia di parametro.

• Layer (raster e vettoriali) e tabelle. Devi selezionarle da una lista, ma in questo caso i valori possibili
non sono i layer o le tabelle attualmente aperte in QGIS, bensì la lista dei dati di ingresso del modello
corrispondente per tipo, o altri layer e tabelle generate da algoritmi già aggiunti al modello.

• Numerical values. Literal values can be introduced directly in the text box. But this text box is also a list
that can be used to select any of the numerical value inputs of the model. In this case, the parameter will
take the value introduced by the user when executing the model.

• String. As in the case of numerical values, literal strings can be typed, or an input string can be selected.

• Table filed. Il parametro parent layer dipende da altri layer caricati nel modello e quindi lo potrai definire
solamente in un secondo momento. Inserisci prima il nome del parametro e poi scegli il parent layer dal
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Figure 20.22: Parametri dell’algoritmo del modello

menu a tendina. Nel menu avrai a disposizione tutti i layer caricati nel modello.

In tutti i casi troverai un parametro aggiunti chiamato Parent algorithms, non disponibile quando avvii un algo-
ritmo dagli Strumenti. Questo parametro ti permette di definire l’ordine in cui gli algoritmi vengono eseguiti, in
quanto scegli tu la nidificazione degli algoritmi. In altre parole, puoi forzare l’esecuzione di un algoritmo prima
di un altro.

Quando usi l’output di un algoritmo come input per un altro algoritmo, allora il primo algoritmo è implicitamente
trattato come Parent algorithm del secondo (e lo puoi anche vede dalla direzione della freccia nella finestra del
modello). Tuttavia, in alcuni casi un algoritmo può dipendere da un altro algoritmo anche se non richiede output
(per esempio, un algoritmo che esegue un’interrogazione SQL su un database PostGIS e un altro che importa
un layer nel database stesso). In questo caso, basta che selezioni l’algoritmo precedente nel parametro Parent
algorithms e i due passaggi verranno eseguiti nell’ordine corretto.

Once all the parameters have been assigned valid values, click on [OK] and the algorithm will be added to the
canvas. It will be linked to all the other elements in the canvas, whether algorithms or inputs, that provide objects
that are used as inputs for that algorithm.

Gli elementi possono essere trascinati in un’altra posizione all’interno della mappa, per cambiare il modo in cui
viene visualizzata la struttura del modulo e renderlo più chiaro e intuitivo. I collegamenti tra gli elementi vengono
aggiornati automaticamente. Puoi ingrandire e ridurre utilizzando la rotellina del mouse.

You can run your algorithm any time by clicking on the [Run] button. However, in order to use the algorithm
from the toolbox, it has to be saved and the modeler dialog closed, to allow the toolbox to refresh its contents.

20.5.3 Salvataggio e caricamento di modelli

Use the [Save] button to save the current model and the [Open] button to open any model previously saved.
Models are saved with the .model extension. If the model has been previously saved from the modeler window,
you will not be prompted for a filename. Since there is already a file associated with that model, the same file will
be used for any subsequent saves.

Prima di salvare un modello, devi inserire un nome ed un gruppo di appartenenza usando le caselle di testo nella
parte alta della finestra.
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I modelli salvati nella cartella modelli (cartella predefinita dove vengono salvati i modelli) appariranno in
Strumenti, nel gruppo corrispondente. Quando apri gli Strumenti, vengono cercati tutti i file con estensione
.model e poi caricati nella finestra. Visto che un modello è inteso come un algoritmo, lo puoi aggiungere agli
Strumenti come un algoritmo qualsiasi.

Puoi specificare la cartella dei modelli nella finestra di configurazione di Processing, presente nel gruppo Model-
latore.

I modelli caricati dalla cartella models appariranno non solo negli Strumenti, ma anche nell’albero degli al-
goritmi della scheda Algorithms presente nella finestra del modellatore. Questo significa che puoi includere un
modello all’interno di un altro modello, proprio come se fosse un semplice algoritmo.

20.5.4 Aggiornare il modello

Puoi modificare il modello mentre lo stai creando, ridefinendo il flusso e le relazioni fra gli algoritmi e i dati che
definiscono il modello stesso.

Se premi il tasto destro del mouse su un algoritmo nel grafico che rappresenta il modello, apparirà un menu come
quello sotto riportato:

Figure 20.23: Click destro sul modello

Selezionando l’opzione Remove rimuoverai l’algoritmo selezionato. Non potrai rimuovere un algoritmo se altri
algoritmi dipendono da lui, ovvero quando un algoritmo vuole come input il risultato di un altro algoritmo. Se
provi a rimuovere comunque uno di questi algoritmi, apparirà una finestra di avviso.

Figure 20.24: L’algoritmo non può essere eliminato

Selezionando l’opzione Modifica o semplicemente premendo due volte sull’icona dell’algoritmo apparirà la fines-
tra dei parametri dell’algoritmo in modo che puoi cambiarne i valori. Non tutti i valori disponibili nel modello
appariranno in questo caso come dati disponibili. Layer o valori generati ad un passaggio successivo del flusso
del modello che possono causare dipendenze circolari non saranno disponibili.

Select the new values and then click on the [OK] button as usual. The connections between the model elements
will change accordingly in the modeler canvas.

Un modello può essere eseguito parzialmente, disattivando alcuni dei suoi algoritmi. Per farlo, seleziona l’opzione
Disattiva nel menu di scelta rapida che viene visualizzato quando fai click destro e su un elemento di algoritmo.
L’algoritmo selezionato e tutti quelli del modello che ne dipendono verranno visualizzati in grigio e non verranno
eseguiti come parte del modello.

Quando fai click destro su un algoritmo che non è attivo, vedrai l’opzione Attiva che puoi utilizzare per attivarlo.
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Figure 20.25: Algoritmo disattivato

20.5.5 Informazioni ed aiuto per l’aggiornamento del modello

You can document your models from the modeler itself. Just click on the [Edit model help] button and a dialog
like the one shown next will appear.

Figure 20.26: Editor della guida

Sulla parte destra vedrai una semplice pagina HTML, creata usando la descrizione dei parametri di input e di
output dell’algoritmo insieme ad alcuni parametri aggiuntivi come la sua descrizione e l’autore. La prima volta
che apri l’editor di aiuto, vedrai tutti i campi vuoti. Li puoi riempire usando le voci corrispondenti presenti nella
parte sinistra della finestra di dialogo. Seleziona un elemento nella parte superiore e poi inserisci la descrizione
nella casella di testo.

La guida del modello è salvata come parte del modello stesso

20.5.6 Exporting a model as a Python script

As we will see in a later chapter, Processing algorithms can be called from the QGIS Python console, and new
Processing algorithms can be created as well using Python. A quick way of creating such a Python script is to
create a model and then to export is as a Python file.

To do so, click on the Export as Python script button. Select the output file in the file chooser dialog, and
Processing will write in it the Python commands that perform the same operations defined in the current model.
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20.5.7 A proposito degli algoritmi disponibili

Potrai notare che alcuni algoritmi eseguibili dagli Strumenti non appaiono nell’elenco di quelli disponibili quando
stai creando un modello. Per essere incluso in un modello, un algoritmo deve avere una semantica corretta in modo
da poter essere correttamente collegato a tutti gli altri nel flusso di lavoro. Se un algoritmo non ha una semantica
corretta (ad esempio, se il numero dei layer generati non può essere conosciuto in anticipo) allora non lo potrai
usare all’interno del modello e quindi non apparirà nell’elenco di quelli disponibili.

Additionally, you will see some algorithms in the modeler that are not found in the toolbox. These algorithms are
meant to be used exclusively as part of a model, and they are of no interest in a different context. The ‘Calculator’
algorithm is an example of that. It is just a simple arithmetic calculator that you can use to modify numerical
values (entered by the user or generated by some other algorithm). This tool is really useful within a model, but
outside of that context, it doesn’t make too much sense.

20.6 L’interfaccia per i processi in serie

20.6.1 Introduzione

All algorithms (including models) can be executed as a batch process. That is, they can be executed using not just
a single set of inputs, but several of them, executing the algorithm as many times as needed. This is useful when
processing large amounts of data, since it is not necessary to launch the algorithm many times from the toolbox.

Per eseguire un algoritmo come un processo in serie, selezionarlo e col pulsante di destra del mouse scegliere la
voce Execute as batch process dal menu che apparirà.

Figure 20.27: Processi in serie facendo click con il tasto destro del mouse

Se hai la finestra di dialogo di esecuzione dell’algoritmo aperta, puoi anche avviare l’interfaccia di processamento
in serie da lì, facendo click sul pulsante Esegui come processo batch ....

20.6.2 La tabella dei parametri

Eseguire un processo in serie è un’operazione simile ad un’esecuzione singola di un algoritmo. Devi definire i
valori dei parametri, ma in questo caso, devi definire non solo un singolo valore per ciascunodi essi, ma un insieme
di valori, uno per ogni volta che l’algoritmo verrà eseguito. I valori sono introdotti per mezzo di una tabella del
tipo di quella mostrata oltre.

Ogni riga della tabella rappresenta una singola esecuzione dell’algoritmo mentre ogni cella contiene il valore di
uno dei parametri caratteristici dell’algoritmo. In un certo senso, è simile alla finestra di dialogo dei parametri
utilizzata quando si lancia un algoritmo da Strumenti, ma organizzata in maniera differente.

Come impostazione predefinita, la tabella contiene solo due righe. Puoi aggiungere o cancellare righe utilizzando
i pulsanti della parte inferiore della finestra.

Una volta definita la dimensione della tabella, la devi riempire con i valori desiderati.
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Figure 20.28: Processi in serie dalla finestra di dialogo Algoritmo

Figure 20.29: Processo in serie
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20.6.3 Compilazione della tabella dei parametri

Per la maggior parte dei parametri, la selezione del valore corretto è banale. Basta semplicemente scrivere il valore
o selezionarlo dalla lista delle opzioni disponibili, a seconda del tipo di parametro.

Filenames for input data objects are introduced directly typing or, more conveniently, clicking on the button
on the right hand of the cell, which will show a context menu with two option: one for selecting from the layers
currently opened and another to select from the filesystem. This second option, when selected, shows a typical
file chooser dialog. Multiple files can be selected at once. If the input parameter represents a single data object
and several files are selected, each one of them will be put in a separate row, adding new ones if needed. If the
parameter represents a multiple input, all the selected files will be added to a single cell, separated by semicolons
(;).

Gli identificativi del layer possono essere immessi direttamente nella casella di testo del parametro. Puoi inserire
il percorso completo di un file o il nome di un layer attualmente caricato nel progetto QGIS corrente. Il nome del
layer verrà automaticamente definito nel suo percorso di origine. Si noti che, se più layer hanno lo stesso nome,
questo potrebbe causare risultati imprevisti a causa di ambiguità.

I dati di output vengono sempre salvati su un file e, diversamente dall’esecuzione di un algoritmo dalla toolbox,
non è consentito il salvataggio in un file o database temporaneo. Puoi digitare direttamente il nome o utilizzare la
finestra di dialogo di selezione file visualizzata quando fai click sul pulsante di contesto.

Una volta selezionato il file di output, appare una nuova finestra di dialogo che permette l’autocompletamento
delle altre celle nella stessa colonna (stesso parametro).

Figure 20.30: Salvataggio di processi in serie

Se mantieni il valore predefinito (‘Do not autocomplete’), Processing metterà il nome del file selezionato nella
cella selezionata dalla tabella dei parametri. Se selezioni una qualunque delle altre opzioni, tutte le celle sottostanti
a quella selezionata saranno riempite automaticamente basandosi sul criterio definito. In questo modo, è molto
più agevole riempire la tabella e puoi definire il processo in serie con meno fatica.

Puoi eseguire il riempimento automatico semplicemente aggiungendo numeri correlati al percorso del file se-
lezionato oppure aggiungendo il valore di un altro campo alla stessa riga. Questo è particolarmente utile per dare
un nome agli output che ricordi quello degli input.

20.6.4 Esecuzione di un processo in serie

To execute the batch process once you have introduced all the necessary values, just click on [OK]. Progress of
the global batch task will be shown in the progress bar in the lower part of the dialog.

20.7 Usare gli algoritmi di Processing dalla console dei comandi

La console permette ad utenti esperti di aumentare la propria produttività e di eseguire operazioni complesse che
non possono essere eseguite utilizzando uno qualsiasi degli altri elementi dell’interfaccia grafica di Processing. I
modelli che richiamano diversi algoritmi possono essere definiti utilizzando l’interfaccia della riga di comando, e
le operazioni aggiuntive, come i loop e le frasi condizionali possono essere aggiunte per creare flussi di lavoro più
flessibili e potenti.
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Figure 20.31: Percorso file dei processi in serie

There is not a processing console in QGIS, but all processing commands are available instead from the QGIS
built-in Python console. That means that you can incorporate those commands into your console work and connect
processing algorithms to all the other features (including methods from the QGIS API) available from there.

Il codice che puoi eseguire dalla console di python, anche se non richiama un metodo specifico di Processing, può
essere convertito in un nuovo algoritmo che potrai richiamare in seguito dagli Strumenti, dal Modellatore grafico
o da qualunque altra parte, proprio come ogni altro algoritmo. Alcuni algoritmi che trovi in Strumenti sono in
effetti degli script semplici.

In questa sezione verrà spiegato come usare gli algoritmi di Processing dalla console di Python e anche come
scrivere un algoritmo usando Python.

20.7.1 Richiamare algoritmi dalla console di python

La prima cosa da fare è importare le funzioni di Processing con la seguente istruzione:

>>> import processing

Now, there is basically just one (interesting) thing you can do with that from the console: execute an algorithm.
That is done using the runalg() method, which takes the name of the algorithm to execute as its first parameter,
and then a variable number of additional parameters depending on the requirements of the algorithm. So the first
thing you need to know is the name of the algorithm to execute. That is not the name you see in the toolbox, but
rather a unique command–line name. To find the right name for your algorithm, you can use the algslist()
method. Type the following line in your console:

>>> processing.alglist()

You will see something like this.

Accumulated Cost (Anisotropic)-------->saga:accumulatedcost(anisotropic)
Accumulated Cost (Isotropic)---------->saga:accumulatedcost(isotropic)
Add Coordinates to points------------->saga:addcoordinatestopoints
Add Grid Values to Points------------->saga:addgridvaluestopoints
Add Grid Values to Shapes------------->saga:addgridvaluestoshapes
Add Polygon Attributes to Points------>saga:addpolygonattributestopoints
Aggregate----------------------------->saga:aggregate
Aggregate Point Observations---------->saga:aggregatepointobservations
Aggregation Index--------------------->saga:aggregationindex
Analytical Hierarchy Process---------->saga:analyticalhierarchyprocess
Analytical Hillshading---------------->saga:analyticalhillshading
Average With Mask 1------------------->saga:averagewithmask1
Average With Mask 2------------------->saga:averagewithmask2
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Average With Thereshold 1------------->saga:averagewiththereshold1
Average With Thereshold 2------------->saga:averagewiththereshold2
Average With Thereshold 3------------->saga:averagewiththereshold3
B-Spline Approximation---------------->saga:b-splineapproximation
...

That’s a list of all the available algorithms, alphabetically ordered, along with their corresponding command-line
names.

You can use a string as a parameter for this method. Instead of returning the full list of algorithms, it will only
display those that include that string. If, for instance, you are looking for an algorithm to calculate slope from a
DEM, type alglist("slope") to get the following result:

DTM Filter (slope-based)-------------->saga:dtmfilter(slope-based)
Downslope Distance Gradient----------->saga:downslopedistancegradient
Relative Heights and Slope Positions-->saga:relativeheightsandslopepositions
Slope Length-------------------------->saga:slopelength
Slope, Aspect, Curvature-------------->saga:slopeaspectcurvature
Upslope Area-------------------------->saga:upslopearea
Vegetation Index[slope based]--------->saga:vegetationindex[slopebased]

This result might change depending on the algorithms you have available.

It is easier now to find the algorithm you are looking for and its command-line name, in this case
saga:slopeaspectcurvature.

Once you know the command-line name of the algorithm, the next thing to do is to determine the right syntax to
execute it. That means knowing which parameters are needed and the order in which they have to be passed when
calling the runalg() method. There is a method to describe an algorithm in detail, which can be used to get a
list of the parameters that an algorithm requires and the outputs that it will generate. To get this information, you
can use the alghelp(name_of_the_algorithm) method. Use the command-line name of the algorithm,
not the full descriptive name.

Calling the method with saga:slopeaspectcurvature as parameter, you get the following description:

>>> processing.alghelp("saga:slopeaspectcurvature")
ALGORITHM: Slope, Aspect, Curvature

ELEVATION <ParameterRaster>
METHOD <ParameterSelection>
SLOPE <OutputRaster>
ASPECT <OutputRaster>
CURV <OutputRaster>
HCURV <OutputRaster>
VCURV <OutputRaster>

Now you have everything you need to run any algorithm. As we have already mentioned, there is only one single
command to execute algorithms: runalg(). Its syntax is as follows:

>>> processing.runalg(name_of_the_algorithm, param1, param2, ..., paramN,
Output1, Output2, ..., OutputN)

The list of parameters and outputs to add depends on the algorithm you want to run, and is exactly the list that the
alghelp() method gives you, in the same order as shown.

A seconda del tipo di parametro, i valori sono inseriti in maniera diversa. Il seguente elenco dà una rapida
panoramica di come inserire valori per ogni tipo di parametro in input:

• Raster Layer, Vector Layer or Table. Simply use a string with the name that identifies the data object to use
(the name it has in the QGIS Table of Contents) or a filename (if the corresponding layer is not opened, it
will be opened but not added to the map canvas). If you have an instance of a QGIS object representing the
layer, you can also pass it as parameter. If the input is optional and you do not want to use any data object,
use None.

• Selection. If an algorithm has a selection parameter, the value of that parameter should be entered using an
integer value. To know the available options, you can use the algoptions() command, as shown in the
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following example:

>>> processing.algoptions("saga:slopeaspectcurvature")
METHOD(Method)

0 - [0] Maximum Slope (Travis et al. 1975)
1 - [1] Maximum Triangle Slope (Tarboton 1997)
2 - [2] Least Squares Fitted Plane (Horn 1981, Costa-Cabral & Burgess 1996)
3 - [3] Fit 2.Degree Polynom (Bauer, Rohdenburg, Bork 1985)
4 - [4] Fit 2.Degree Polynom (Heerdegen & Beran 1982)
5 - [5] Fit 2.Degree Polynom (Zevenbergen & Thorne 1987)
6 - [6] Fit 3.Degree Polynom (Haralick 1983)

In this case, the algorithm has one such parameter, with seven options. Notice that ordering is zero-based.

• Input multipli. Il valore è una stringa con descrittori in input separati da un punto e virgola (;). Come nel
caso di layer singoli o tabelle, ogni descrittore in input può essere il nome dell’oggetto o il suo percorso.

• Campo di una Tabella da XXX. Inserisci una stringa con il nome del campo da usare. Il parametro è sensibile
alle lettere maiuscole.

• Tabella fissa. Inserisci l’elenco di tutti i valori delle tabelle separati da una virgola (,) e racchiusi fra
virgolette ("). I valori partono dalla riga in alto e proseguono da sinistra verso destra. Puoi usare un array
2-D per i valori che rappresentano la tabella.

• SR. Inserisci il codice EPSG del SR desiderato.

• Estensione. Usa un stringa con valori xmin, xmax, ymin e ymax separati da virgole (,).

Parametri booleani, di file, di stringa e numerici non hanno bisogno di ulteriori spiegazioni.

Input parameters such as strings, booleans, or numerical values have default values. To use them, specify None
in the corresponding parameter entry.

For output data objects, type the file path to be used to save it, just as it is done from the toolbox. If you want to
save the result to a temporary file, use None. The extension of the file determines the file format. If you enter
a file extension not supported by the algorithm, the default file format for that output type will be used, and its
corresponding extension appended to the given file path.

Unlike when an algorithm is executed from the toolbox, outputs are not added to the map canvas if you execute
that same algorithm from the Python console. If you want to add an output to the map canvas, you have to do it
yourself after running the algorithm. To do so, you can use QGIS API commands, or, even easier, use one of the
handy methods provided for such tasks.

The runalg method returns a dictionary with the output names (the ones shown in the algorithm description)
as keys and the file paths of those outputs as values. You can load those layers by passing the corresponding file
paths to the load() method.

20.7.2 Additional functions for handling data

Apart from the functions used to call algorithms, importing the processing package will also import some
additional functions that make it easier to work with data, particularly vector data. They are just convenience
functions that wrap some functionality from the QGIS API, usually with a less complex syntax. These functions
should be used when developing new algorithms, as they make it easier to operate with input data.

Below is a list of some of these commands. More information can be found in the classes under the
processing/tools package, and also in the example scripts provided with QGIS.

• getObject(obj): Returns a QGIS object (a layer or table) from the passed object, which can be a
filename or the name of the object in the QGIS Layers List

• values(layer, fields): Returns the values in the attributes table of a vector layer, for the passed
fields. Fields can be passed as field names or as zero-based field indices. Returns a dict of lists, with the
passed field identifiers as keys. It considers the existing selection.

• features(layer): Returns an iterator over the features of a vector layer, considering the existing
selection.
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• uniqueValues(layer, field): Returns a list of unique values for a given attribute. Attributes can
be passed as a field name or a zero-based field index. It considers the existing selection.

20.7.3 Creare script ed eseguirli da Strumenti

You can create your own algorithms by writing the corresponding Python code and adding a few extra lines to
supply additional information needed to define the semantics of the algorithm. You can find a Create new script
menu under the Tools group in the Script algorithms block of the toolbox. Double-click on it to open the script
editing dialog. That’s where you should type your code. Saving the script from there in the scripts folder (the
default folder when you open the save file dialog) with .py extension will automatically create the corresponding
algorithm.

The name of the algorithm (the one you will see in the toolbox) is created from the filename, removing its extension
and replacing low hyphens with blank spaces.

Let’s have a look at the following code, which calculates the Topographic Wetness Index (TWI) directly from a
DEM.

##dem=raster
##twi=output
ret_slope = processing.runalg("saga:slopeaspectcurvature", dem, 0, None,

None, None, None, None)
ret_area = processing.runalg("saga:catchmentarea(mass-fluxmethod)", dem,

0, False, False, False, False, None, None, None, None, None)
processing.runalg("saga:topographicwetnessindex(twi), ret_slope[’SLOPE’],

ret_area[’AREA’], None, 1, 0, twi)

As you can see, the calculation involves three algorithms, all of them coming from SAGA. The last one calculates
the TWI, but it needs a slope layer and a flow accumulation layer. We do not have these layers, but since we have
the DEM, we can calculate them by calling the corresponding SAGA algorithms.

The part of the code where this processing takes place is not difficult to understand if you have read the previous
sections in this chapter. The first lines, however, need some additional explanation. They provide the information
that is needed to turn your code into an algorithm that can be run from any of the GUI components, like the toolbox
or the graphical modeler.

These lines start with a double Python comment symbol (##) and have the following structure:

[parameter_name]=[parameter_type] [optional_values]

Here is a list of all the parameter types that are supported in processing scripts, their syntax and some examples.

• raster. A raster layer.

• vector. A vector layer.

• table. A table.

• number. A numerical value. A default value must be provided. For instance, depth=number 2.4.

• string. A text string. As in the case of numerical values, a default value must be added. For instance,
name=string Victor.

• boolean. A boolean value. Add True or False after it to set the default value. For example,
verbose=boolean True.

• multiple raster. A set of input raster layers.

• multiple vector. A set of input vector layers.

• field. A field in the attributes table of a vector layer. The name of the layer has to be added after the
field tag. For instance, if you have declared a vector input with mylayer=vector, you could use
myfield=field mylayer to add a field from that layer as parameter.

• folder. A folder.

• file. A filename.
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The parameter name is the name that will be shown to the user when executing the algorithm, and also the variable
name to use in the script code. The value entered by the user for that parameter will be assigned to a variable with
that name.

When showing the name of the parameter to the user, the name will be edited to improve its appearance, replacing
low hyphens with spaces. So, for instance, if you want the user to see a parameter named A numerical
value, you can use the variable name A_numerical_value.

Layers and table values are strings containing the file path of the corresponding object. To turn them into a QGIS
object, you can use the processing.getObjectFromUri() function. Multiple inputs also have a string
value, which contains the file paths to all selected object, separated by semicolons (;).

Outputs are defined in a similar manner, using the following tags:

• output raster

• output vector

• output table

• output html

• output file

• output number

• output string

The value assigned to the output variables is always a string with a file path. It will correspond to a temporary file
path in case the user has not entered any output filename.

When you declare an output, the algorithm will try to add it to QGIS once it is finished. That is why, although the
runalg() method does not load the layers it produces, the final TWI layer will be loaded (using the case of our
previous example), since it is saved to the file entered by the user, which is the value of the corresponding output.

Do not use the load() method in your script algorithms, just when working with the console line. If a layer is
created as output of an algorithm, it should be declared as such. Otherwise, you will not be able to properly use
the algorithm in the modeler, since its syntax (as defined by the tags explained above) will not match what the
algorithm really creates.

Hidden outputs (numbers and strings) do not have a value. Instead, you have to assign a value to them. To do so,
just set the value of a variable with the name you used to declare that output. For instance, if you have used this
declaration,

##average=output number

the following line will set the value of the output to 5:

average = 5

In addition to the tags for parameters and outputs, you can also define the group under which the algorithm will
be shown, using the group tag.

If your algorithm takes a long time to process, it is a good idea to inform the user. You have a global named
progress available, with two possible methods: setText(text) and setPercentage(percent) to
modify the progress text and the progress bar.

Several examples are provided. Please check them to see real examples of how to create algorithms using the
processing framework classes. You can right-click on any script algorithm and select Edit script to edit its code or
just to see it.

20.7.4 Documentare gli script

As in the case of models, you can create additional documentation for your scripts, to explain what they do and
how to use them. In the script editing dialog, you will find an [Edit script help] button. Click on it and it will
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take you to the help editing dialog. Check the section about the graphical modeler to know more about this dialog
and how to use it.

Help files are saved in the same folder as the script itself, adding the .help extension to the filename. Notice that
you can edit your script’s help before saving the script for the first time. If you later close the script editing dialog
without saving the script (i.e., you discard it), the help content you wrote will be lost. If your script was already
saved and is associated to a filename, saving the help content is done automatically.

20.7.5 Script agganciati pre e post esecuzione

Scripts can also be used to set pre- and post-execution hooks that are run before and after an algorithm is run. This
can be used to automate tasks that should be performed whenever an algorithm is executed.

La sintassi è identica alla sintassi spiegato sopra, ma hai a disposizione anche una variabile globale chiamata alg
che rappresenta l’algoritmo che è appena (o che sarà) stato eseguito.

In the General group of the processing configuration dialog, you will find two entries named Pre-execution script
file and Post-execution script file where the filename of the scripts to be run in each case can be entered.

20.8 Writing new Processing algorithms as python scripts

You can create your own algorithms by writing the corresponding Python code and adding a few extra lines to
supply additional information needed to define the semantics of the algorithm. You can find a Create new script
menu under the Tools group in the Script algorithms block of the toolbox. Double-click on it to open the script
edition dialog. That’s where you should type your code. Saving the script from there in the scripts folder (the
default one when you open the save file dialog), with .py extension, will automatically create the corresponding
algorithm.

The name of the algorithm (the one you will see in the toolbox) is created from the filename, removing its extension
and replacing underscores with blank spaces.

Let’s have the following code, which calculates the Topographic Wetness Index (TWI) directly from a DEM

##dem=raster
##twi=output raster
ret_slope = processing.runalg("saga:slopeaspectcurvature", dem, 0, None,

None, None, None, None)
ret_area = processing.runalg("saga:catchmentarea", dem,

0, False, False, False, False, None, None, None, None, None)
processing.runalg("saga:topographicwetnessindextwi, ret_slope[’SLOPE’],

ret_area[’AREA’], None, 1, 0, twi)

As you can see, it involves 3 algorithms, all of them coming from SAGA. The last one of them calculates the TWI,
but it needs a slope layer and a flow accumulation layer. We do not have these, but since we have the DEM, we
can calculate them by calling the corresponding SAGA algorithms.

The part of the code where this processing takes place is not difficult to understand if you have read the previous
chapter. The first lines, however, need some additional explanation. They provide the information that is needed to
turn your code into an algorithm that can be run from any of the GUI components, like the toolbox or the graphical
modeler.

These lines start with a double Python comment symbol (##) and have the following structure

[parameter_name]=[parameter_type] [optional_values]

Here is a list of all the parameter types that are supported in processing scripts, their syntax and some examples.

• raster. A raster layer

• vector. A vector layer

• table. A table
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• number. A numerical value. A default value must be provided. For instance, depth=number 2.4

• string. A text string. As in the case of numerical values, a default value must be added. For instance,
name=string Victor

• longstring. Same as string, but a larger text box will be shown, so it is better suited for long strings,
such as for a script expecting a small code snippet.

• boolean. A boolean value. Add True or False after it to set the default value. For example,
verbose=boolean True.

• multiple raster. A set of input raster layers.

• multiple vector. A set of input vector layers.

• field. A field in the attributes table of a vector layer. The name of the layer has to be added after the
field tag. For instance, if you have declared a vector input with mylayer=vector, you could use
myfield=field mylayer to add a field from that layer as parameter.

• extent. A spatial extent defined by xmin, xmax, ymin, ymax

• folder. A folder

• file. A filename

• crs. A Coordinate Reference System

• selection. A dropdown menu that allows the user to select from a pre-populated list. For example
units=selection sq_km;sq_miles;sq_degrees

• name. Name of the script. This will be displayed as the algorithm name in the processing toolbox. For
example My Algorithm Name=name

• group. Folder name where the script will appear in the Processing Toolbox. For Example, adding
Utils=groups will put the script within a Utils folder within Scripts.

The parameter name is the name that will be shown to the user when executing the algorithm, and also the variable
name to use in the script code. The value entered by the user for that parameter will be assigned to a variable with
that name.

When showing the name of the parameter to the user, the name will be edited to improve its appearance, replacing
underscores with spaces. So, for instance, if you want the user to see a parameter named A numerical value,
you can use the variable name A_numerical_value.

Layers and tables values are strings containing the filepath of the corresponding object. To turn them into a QGIS
object, you can use the processing.getObjectFromUri() function. Multiple inputs also have a string
value, which contains the filepaths to all selected objects, separated by semicolons (;).

Outputs are defined in a similar manner, using the following tags:

• output raster

• output vector

• output table

• output html

• output file

• output number

• output string

• output extent

The value assigned to the output variables is always a string with a filepath. It will correspond to a temporary
filepath in case the user has not entered any output filename.

In addition to the tags for parameters and outputs, you can also define the group under which the algorithm will
be shown, using the group tag.
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The last tag that you can use in your script header is ##nomodeler. Use that when you do not want your
algorithm to be shown in the modeler window. This should be used for algorithms that do not have a clear syntax
(for instance, if the number of layers to be created is not known in advance, at design time), which make them
unsuitable for the graphical modeler

20.8.1 Handing data produced by the algorithm

When you declare an output representing a layer (raster, vector or table), the algorithm will try to add it to QGIS
once it is finished. That is the reason why, although the runalg() method does not load the layers it produces,
the final TWI layer will be loaded, since it is saved to the file entered by the user, which is the value of the
corresponding output.

Do not use the load() method in your script algorithms, but just when working with the console line. If a layer
is created as output of an algorithm, it should be declared as such. Otherwise, you will not be able to properly
use the algorithm in the modeler, since its syntax (as defined by the tags explained above) will not match what the
algorithm really creates.

Hidden outputs (numbers and strings) do not have a value. Instead, it is you who has to assign a value to them. To
do so, just set the value of a variable with the name you used to declare that output. For instance, if you have used
this declaration,

##average=output number

the following line will set the value of the output to 5:

average = 5

20.8.2 Comunicare con l’utente

If your algorithm takes a long time to process, it is a good idea to inform the user. You have a global named
progress available, with two available methods: setText(text) and setPercentage(percent) to
modify the progress text and the progress bar.

If you have to provide some information to the user, not related to the progress of the algorithm, you can use the
setInfo(text) method, also from the progress object.

If your script has some problem, the correct way of propagating it is to raise an exception of type
GeoAlgorithmExecutionException(). You can pass a message as argument to the constructor of the
exception. Processing will take care of handling it and communicating with the user, depending on where the
algorithm is being executed from (toolbox, modeler, Python console...)

20.8.3 Documenting your scripts

As in the case of models, you can create additional documentation for your script, to explain what they do and
how to use them. In the script editing dialog you will find a [Edit script help] button. Click on it and it will take
you to the help editing dialog. Check the chapter about the graphical modeler to find out more about this dialog
and how to use it.

Help files are saved in the same folder as the script itself, adding the .help extension to the filename. Note that
you can edit your script’s help before saving it for the first time. If you later close the script editing dialog without
saving the script (i.e. you discard it), the help content you wrote will be lost. If your script was already saved and
is associated with a filename, saving is done automatically.

20.8.4 Example scripts

Several examples are available in the on-line collection of scripts, which you can access by selecting the Get script
from on-line script collection tool under the Scripts/tools entry in the toolbox.
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Figure 20.32: Processing Get Script

Please, check them to see real examples of how to create algorithms using the processing framework classes. You
can right-click on any script algorithm and select Edit script to edit its code or just to see it.

20.8.5 Best practices for writing script algorithms

Here’s a quick summary of ideas to consider when creating your script algorithms and, especially, if you want to
share with other QGIS users. Following these simple rules will ensure consistency across the different Processing
elements such as the toolbox, the modeler or the batch processing interface.

• Do not load resulting layers. Let Processing handle your results and load your layers if needed.

• Always declare the outputs your algorithm creates. Avoid things such as declaring one output and then
using the destination filename set for that output to create a collection of them. That will break the correct
semantics of the algorithm and make it impossible to use it safely in the modeler. If you have to write an
algorithm like that, make sure you add the ##nomodeler tag.

• Do not show message boxes or use any GUI element from the script. If you want to communicate with the
user, use the setInfo() method or throw an GeoAlgorithmExecutionException

• As a rule of thumb, do not forget that your algorithm might be executed in a context other than the Processing
toolbox.

20.8.6 Pre- and post-execution script hooks

Scripts can also be used to set pre- and post-execution hooks that are run before and after an algorithm is run. This
can be used to automate tasks that should be performed whenever an algorithm is executed.

The syntax is identical to the syntax explained above, but an additional global variable named alg is available,
representing the algorithm that has just been (or is about to be) executed.

In the General group of the processing config dialog you will find two entries named Pre-execution script file and
Post-execution script file where the filename of the scripts to be run in each case can be entered.

20.9 Configurazione di applicazioni esterne

The processing framework can be extended using additional applications. Currently, SAGA, GRASS, OTB (Orfeo
Toolbox) and R are supported, along with some other command-line applications that provide spatial data analysis
functionalities. Algorithms relying on an external applications are managed by their own algorithm provider.

This section will show you how to configure the processing framework to include these additional applications,
and it will explain some particular features of the algorithms based on them. Once you have correctly configured
the system, you will be able to execute external algorithms from any component like the toolbox or the graphical
modeler, just like you do with any other geoalgorithm.

By default, all algorithms that rely on an external application not shipped with QGIS are not enabled. You can
enable them in the settings dialog. Make sure that the corresponding application is already installed in your
system.
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20.9.1 Nota per gli utenti Windows

If you are not an advanced user and you are running QGIS on Windows, you might not be interested in reading
the rest of this chapter. Make sure you install QGIS in your system using the standalone installer. That will
automatically install SAGA, GRASS and OTB in your system and configure them so they can be run from QGIS.
All the algorithms from these providers will be ready to be run without needing any further configuration. If
installing through OSGeo4W application, make sure you select for installation SAGA, GRASS and OTB as well.

If you want to know more about how these providers work, or if you want to use some algorithms not included in
the simplified toolbox (such as R scripts), keep on reading.

20.9.2 Nota sui formati dei file

When using an external software, opening a file in QGIS does not mean that it can be opened and processed as
well in that other software. In most cases, other software can read what you have opened in QGIS, but in some
cases, that might not be true. When using databases or uncommon file formats, whether for raster or vector layers,
problems might arise. If that happens, try to use well-known file formats that you are sure are understood by both
programs, and check the console output (in the history and log dialog) to know more about what is going wrong.

L’uso di layer raster GRASS è, per esempio, un caso in cui potreste avere problemi e non essere in grado di
completare il vostro lavoro se lanciate un algoritmo esterno usando in input questo layer. Per questa ragione questi
layer non appariranno disponibili agli algoritmi

You should, however, find no problems at all with vector layers, since QGIS automatically converts from the
original file format to one accepted by the external application before passing the layer to it. This adds extra
processing time, which might be significant if the layer has a large size, so do not be surprised if it takes more
time to process a layer from a DB connection than it does to process one of a similar size stored in a shapefile.

Providers not using external applications can process any layer that you can open in QGIS, since they open it for
analysis through QGIS.

Regarding output formats, all formats supported by QGIS as output can be used, both for raster and vector layers.
Some providers do not support certain formats, but all can export to common formats that can later be transformed
by QGIS automatically. As in the case of input layers, if this conversion is needed, that might increase the
processing time.

20.9.3 Nota sulla selezione di layer vettore

External applications may also be made aware of the selections that exist in vector layers within QGIS. However,
that requires rewriting all input vector layers, just as if they were originally in a format not supported by the
external application. Only when no selection exists, or the Use only selected features option is not enabled in the
processing general configuration, can a layer be directly passed to an external application.

In altri casi, è necessaria l’esportazione delle sole caratteristiche selezionate, che comporta un allungamento dei
tempi di esecuzione

20.9.4 SAGA

SAGA algorithms can be run from QGIS if you have SAGA installed in your system and you configure the pro-
cessing framework properly so it can find SAGA executables. In particular, the SAGA command-line executable
is needed to run SAGA algorithms.

If you are running Windows, both the stand-alone installer and the OSGeo4W installer include SAGA along with
QGIS, and the path is automatically configured, so there is no need to do anything else.

If you have installed SAGA yourself and your QGIS installer did not include it, the path to the SAGA executable
must be configured. To do this, open the configuration dialog. In the SAGA block, you will find a setting named
SAGA Folder. Enter the path to the folder where SAGA is installed. Close the configuration dialog, and now you
are ready to run SAGA algorithms from QGIS.
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If you are running Linux, SAGA binaries are not included with Processing, so you have to download and install
the software yourself. Please check the SAGA website for more information.

In this case, there is no need to configure the path to the SAGA executable, and you will not see those folder entries.
Instead, you must make sure that SAGA is properly installed and its folder is added to the PATH environment
variable. Just open a console and type saga_cmd to check that the system can find where the SAGA binaries are
located.

Le limitazioni del sistema di griglia di SAGA

Most SAGA algorithms that require several input raster layers require them to have the same grid system. That is,
they must cover the same geographic area and have the same cell size, so their corresponding grids match. When
calling SAGA algorithms from QGIS, you can use any layer, regardless of its cell size and extent. When multiple
raster layers are used as input for a SAGA algorithm, QGIS resamples them to a common grid system and then
passes them to SAGA (unless the SAGA algorithm can operate with layers from different grid systems).

The definition of that common grid system is controlled by the user, and you will find several parameters in the
SAGA group of the settings window to do so. There are two ways of setting the target grid system:

• Setting it manually. You define the extent by setting the values of the following parameters:

– Resampling min X

– Resampling max X

– Resampling min Y

– Resampling max Y

– Resampling cellsize

Notice that QGIS will resample input layers to that extent, even if they do not overlap with it.

• Setting it automatically from input layers. To select this option, just check the Use min covering grid system
for resampling option. All the other settings will be ignored and the minimum extent that covers all the
input layers will be used. The cell size of the target layer is the maximum of all cell sizes of the input layers.

Per gli algoritmi che non operano su molteplici layers o che non necessitano di un’unica griglia, non verrà operato
alcun campionamento.

Limitazioni per i raster multi-banda

Unlike QGIS, SAGA has no support for multi-band layers. If you want to use a multiband layer (such as an RGB or
multispectral image), you first have to split it into single-banded images. To do so, you can use the ‘SAGA/Grid
- Tools/Split RGB image’ algorithm (which creates three images from an RGB image) or the ‘SAGA/Grid -
Tools/Extract band’ algorithm (to extract a single band).

Limitations in cell size

SAGA assumes that raster layers have the same cell size in the X and Y axis. If you are working with a layer with
different values for horizontal and vertical cell size, you might get unexpected results. In this case, a warning will
be added to the processing log, indicating that an input layer might not be suitable to be processed by SAGA.

Registrazioni di controllo

When QGIS calls SAGA, it does so using its command-line interface, thus passing a set of commands to perform
all the required operations. SAGA shows its progress by writing information to the console, which includes the
percentage of processing already done, along with additional content. This output is filtered and used to update
the progress bar while the algorithm is running.
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Both the commands sent by QGIS and the additional information printed by SAGA can be logged along with other
processing log messages, and you might find them useful to track in detail what is going on when QGIS runs a
SAGA algorithm. You will find two settings, namely Log console output and Log execution commands, to activate
that logging mechanism.

Molti altri fornitori di algoritmi che usano applicazioni esterne e le chiamano tramite la linea di comando hanno
simili opzioni, così che troverete esse anche in altri posizioni nella lista di impostazioni di processing.

20.9.5 R. Creating R scripts

L’integrazione R in QGIS è diversa da quella di SAGA in cui non esiste un insieme predefinito di algoritmi che
puoi eseguire (tranne alcuni esempi). Invece, dovresti scrivere i tuoi script e chiamare i comandi R, come faresti da
R, e in modo molto simile a come vedemmo nella sezione dedicata all’elaborazione degli script.. Questa sezione
ti mostra la sintassi da usare per chiamare quei comandi R da QGIS e come usare gli oggetti QGIS (layer, tabelle)
al loro interno.

La prima cosa che devi fare, come vedemmo con SAGA, è dire a QGIS dove sono i binari R. Puoi farlo usando
la voce cartella R nella finestra di dialogo della configuazione di Processing. Una volta che hai impostato tale
parametro, puoi avviare ed eseguire i tuoi script R.

Nota: per gli utenti Windows, generalmente l’eseguibile R è nellla cartella C:\Program Files\R\R-3.2.
Aggiungi la cartella e ** NON ** il binario!

Ancora una volta, la cosa è diversa in Linux e dovete solo assicurarvi che la cartella di R sia inclusa nella variabile
di ambiente PATH; se eseguendo il comando R in una console, R si avvia, allora siete pronti per partire.

To add a new algorithm that calls an R function (or a more complex R script that you have developed and you
would like to have available from QGIS), you have to create a script file that tells the processing framework how
to perform that operation and the corresponding R commands to do so.

R script files have the extension .rsx, and creating them is pretty easy if you just have a basic knowledge of R
syntax and R scripting. They should be stored in the R scripts folder. You can set this folder in the R settings group
(available from the processing settings dialog), just like you do with the folder for regular processing scripts.

Let’s have a look at a very simple script file, which calls the R method spsample to create a random grid within
the boundary of the polygons in a given polygon layer. This method belongs to the maptools package. Since
almost all the algorithms that you might like to incorporate into QGIS will use or generate spatial data, knowledge
of spatial packages like maptools and, especially, sp, is mandatory.

##polyg=vector
##numpoints=number 10
##output=output vector
##sp=group
pts=spsample(polyg,numpoints,type="random")
output=SpatialPointsDataFrame(pts, as.data.frame(pts))

The first lines, which start with a double Python comment sign (##), tell QGIS the inputs of the algorithm de-
scribed in the file and the outputs that it will generate. They work with exactly the same syntax as the Processing
scripts that we have already seen, so they will not be described here again.

Please have a look at the R Intro and the R Syntax Training Manual Chapters to have more information on how to
write your own R scripts-

When you declare an input parameter, QGIS uses that information for two things: creating the user interface to
ask the user for the value of that parameter and creating a corresponding R variable that can later be used as input
for R commands.

In the above example, we are declaring an input of type vector named polyg. When executing the algorithm,
QGIS will open in R the layer selected by the user and store it in a variable also named polyg. So, the name of
a parameter is also the name of the variable that we can use in R for accessing the value of that parameter (thus,
you should avoid using reserved R words as parameter names).
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Spatial elements such as vector and raster layers are read using the readOGR() and brick() commands (you
do not have to worry about adding those commands to your description file – QGIS will do it), and they are stored
as Spatial*DataFrame objects. Table fields are stored as strings containing the name of the selected field.

Tables are opened using the read.csv() command. If a table entered by the user is not in CSV format, it will
be converted prior to importing it into R.

Additionally, raster files can be read using the readGDAL() command instead of brick() by using the
##usereadgdal.

If you are an advanced user and do not want QGIS to create the object representing the layer, you can use the
##passfilenames tag to indicate that you prefer a string with the filename instead. In this case, it is up to you
to open the file before performing any operation on the data it contains.

Dalla precedente informazione, è possibile capire la prima riga del nostro primo file script di esempio (prima riga
che non inizia con un commento Python).

pts=spsample(polyg,numpoints,type="random")

La variabile polygon contiene un oggetto SpatialPolygonsDataFrame che può essere usato per chiamare
la funzione spsample o similmente la funzione numpoints che indica il numero di punti da aggiungere alla
griglia creata.

Since we have declared an output of type vector named out, we have to create a variable named out and store a
Spatial*DataFrame object in it (in this case, a SpatialPointsDataFrame). You can use any name for
your intermediate variables. Just make sure that the variable storing your final result has the same name that you
used to declare it, and that it contains a suitable value.

In this case, the result obtained from the spsample method has to be converted explicitly into a
SpatialPointsDataFrame object, since it is itself an object of class ppp, which is not a suitable class
to be returned to QGIS.

If your algorithm generates raster layers, the way they are saved will depend on whether or not you have used the
##dontuserasterpackage option. If you have used it, layers are saved using the writeGDAL() method.
If not, the writeRaster() method from the raster package will be used.

If you have used the ##passfilenames option, outputs are generated using the raster package (with
writeRaster()), even though it is not used for the inputs.

If your algorithm does not generate any layer, but rather a text result in the console instead, you have to indicate
that you want the console to be shown once the execution is finished. To do so, just start the command lines that
produce the results you want to print with the > (‘greater’) sign. The output of all other lines will not be shown.
For instance, here is the description file of an algorithm that performs a normality test on a given field (column) of
the attributes of a vector layer:

##layer=vector
##field=field layer
##nortest=group
library(nortest)
>lillie.test(layer[[field]])

The output of the last line is printed, but the output of the first is not (and neither are the outputs from other
command lines added automatically by QGIS).

Se il vostro algoritmo produce qualche tipo di risultato grafico (usando la funzione plot()) dovete aggiungere
la linea seguente:

##showplots

This will cause QGIS to redirect all R graphical outputs to a temporary file, which will be opened once R execution
has finished.

Sia i risultati grafici che quelli da console saranno mostrati nel gestore risultati di processing.

For more information, please check the script files provided with Processing. Most of them are rather simple and
will greatly help you understand how to create your own scripts.
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Nota: rgdal and raster libraries are loaded by default, so you do not have to add the corresponding
library() commands (you just have to make sure that those two packages are installed in your R dis-
tribution). However, other additional libraries that you might need have to be explicitly loaded by typing,
library(ggplot2). If the package is not already installed on your machine, Processing will download and
install it. In this way the package will be also available in R Standalone. Be aware that if the package has to be
downloaded, the first time you run the script it might take a long time.

20.9.6 GRASS

Configuring GRASS is not much different from configuring SAGA. First, the path to the GRASS folder has to be
defined, but only if you are running Windows. Additionally, a shell interpreter (usually msys.exe, which can be
found in most GRASS for Windows distributions) has to be defined and its path set up as well.

By default, the processing framework tries to configure its GRASS connector to use the GRASS distribution that
ships along with QGIS. This should work without problems in most systems, but if you experience problems, you
might have to configure the GRASS connector manually. Also, if you want to use a different GRASS installation,
you can change that setting and point to the folder where the other version is installed. GRASS 6.4 is needed for
algorithms to work correctly.

Se state usando Linux dovete solo assicurarvi che GRASS è correttamente installato e che può essere attivato
senza problemi da una console.

GRASS algorithms use a region for calculations. This region can be defined manually using values similar to
the ones found in the SAGA configuration, or automatically, taking the minimum extent that covers all the input
layers used to execute the algorithm each time. If the latter approach is the behavior you prefer, just check the Use
min covering region option in the GRASS configuration parameters.

20.9.7 GDAL

No additional configuration is needed to run GDAL algorithms. Since they are already incorporated into QGIS,
the algorithms can infer their configuration from it.

20.9.8 Orfeo Toolbox

Orfeo Toolbox (OTB) algorithms can be run from QGIS if you have OTB installed in your system and you have
configured QGIS properly, so it can find all necessary files (command-line tools and libraries).

As in the case of SAGA, OTB binaries are included in the stand-alone installer for Windows, but they are not
included if you are running Linux, so you have to download and install the software yourself. Please check the
OTB website for more information.

Once OTB is installed, start QGIS, open the processing configuration dialog and configure the OTB algorithm
provider. In the Orfeo Toolbox (image analysis) block, you will find all settings related to OTB. First, ensure that
algorithms are enabled.

Then, configure the path to the folder where OTB command-line tools and libraries are installed:

• Usually OTB applications folder points to /usr/lib/otb/applications and OTB command line
tools folder is /usr/bin.

• If you use any of the installers that include OTB, such as OSGeo4W, there is no need for further con-
figuration. Processing will detect the path automatically and will not show the corresponding configuration
entries. Otherwise, fill the OTB applications folder and OTB command line tools folder parameters with the
to the corresponding values for your installation.
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20.9.9 TauDEM

TauDEM (Terrain Analysis Using Digital Elevation Models) is a tools for the extraction and analysis of hydrolog-
ical information from Digital Elevation Models (DEM). TauDEM can be used from QGIS if you have it installed
in your system and configured QGIS properly, so it can find all necessary files.

There are two versions of TauDEM tools: singlefile (TauDEM 5.0.6 or 5.1.2) and multifile (TauDEM 5.2.0). The
difference between these versions in the supported inputs/outputs. Single files version accepts only single raster
file and write single file as output. Multifile version accepts a directory with rasters and writes directory with
rasters as output. Such directory should contain rasters that will be treated as a single DEM grid.

TauDEM Processing provider supports both single- and multifile versions of TauDEM and even allows to use them
simultaneously.

Nota: While TauDEM Processing provider supports TauDEM 5.0.6, 5.1.2 and 5.2.0 we recommend to use 5.1.2
and/or 5.2.0 as this versions have some new tools available, like Gage Watershed and TWI.

Installing TauDEM under Windows

Please visit the TauDEM homepage and download desired version of the precompiled binaries for your platform
(32-bit or 64-bit), usually this is “Command Line Executables”. Also you need to download Microsoft HPC Pack
2012 MS-MPI. First install Microsoft HPC Pack 2012 MS-MPI by runing mpi_x64.Msi for 64-bit platforms
and mpi_x86.Msi for 32-bit platforms.

Nota: If you want to use TauDEM 5.0.6

Installing TauDEM under Linux

Unfortunately there are no packages for most Linux distributions, so you should compile TauDEM by yourself.
As TauDEM uses MPI it is necessary to install first any MPI implementation e.g MPICH or OpenMPI. Use your
favorite package manager to install MPICH or OpenMPI.

Download TauDEM 5.2.0 source code package from GitHub repository and extract archive contents. Open termi-
nal and cd into src directory inside extracted folder. Create build directory and cd into it

mkdir build
cd build

Configure your build (change install prefix if necessary) and compile

CXX=mpicxx cmake -DCMAKE_INSTALL_PREFIX=/usr/local ..
make

When compilation finished install TauDEM tools by running

sudo make install

Nota: Executable files will be installed into bin subdirectory inside prefix you specified at the con-
figure stage. For example if you specified prefix /opt/taudem5.2 than binaries will be installed into
/opt/taudem5.2/bin.

To use singlefile version — download source package here and perform above mentioned steps to compile and
install it.

Old TauDEM 5.0.6 also available. But before compiling this version it is necessary to edit some source files.

Open the linearpart.h file, and after line

#include "mpi.h"
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add a new line with

#include <stdint.h>

so you’ll get

#include "mpi.h"
#include <stdint.h>

Save the changes and close the file. Now open tiffIO.h, find line #include "stdint.h" and replace
quotes ("") with <>, so you’ll get

#include <stdint.h>

Save the changes and close the file.

Now configure, compile and install TauDEM 5.0.6 using same commands as described above.

Configuring TauDEM provider

Once TauDEM is installed, start QGIS, open the Processing options dialog from Processing → Options... and
configure the TauDEM algorithm provider. In the Providers group find TauDEM (hydrologic analysis) block, and
expand it. Here you will see all settings related to TauDEM.

First, ensure that algorithms are enabled, and activate provider if necessary.

Next step is to configure MPI. The MPICH/OpenMPI bin directory setting used to define location of the mpiexec
program. In most Linux distributions you can safely leave this empty, as mpiexec available in your PATH.

The Number of MPI parallel processes to use is a second setting related to MPI. It defines number of processes
that will be used to execute TauDEM commands. If you don’t know which value to use, it is better to leave this
value unchanged.

Now we need to configure the path to the folder(s) where TauDEM command-line tools are installed. As we
already mention TauDEM provider supports both single- and multifile TauDEM, so there are two settings for
TauDEM folders:

• TauDEM command line tools folder used to set location of the singlefile tools

• TauDEM multifile command line tools folder used to set location of the multifile tools

If you have both TauDEM versions installed in different directories it is possible to specify both options.

The last step is to define which TauDEM version to use:

• with Enable multifile TauDEM tools option checked you will use multifile TauDEM tools from directory,
specified in the TauDEM multifile command line tools folder. Multifile tools have same name as singlefile
with “(multifile)” suffix added

• with Enable single TauDEM tools option checked you will use multifile TauDEM tools from directory,
specified in the TauDEM command line tools folder.

It is possible to enable both tools simultaneously. In this case you will have two instances of each tool in toolbox
and can use them in your analysis.

Nota: Be careful with developing Processing models using TauDEM!
As single- and multifile versions have different inputs, model created with singlefile algorithms will not work if
only multifile algorithms are available. If you plan to share your model please specify which TauDEM version
should be used or, better, provide two versions of your model: for single- and multifile TauDEM.
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20.10 La riga di comando

Processing comprende un strumento pratico che permette di eseguire gli algoritmi senza dover utilizzare la finestra
strumenti, ma semplicemente digitando il nome dell’algoritmo che si desidera eseguire.

Questo strumento è conosciuto come il Riga di comando, ed è solo una semplice riga di testo con completamento
automatico in cui puoi digitare il comando desiderato.

Figure 20.33: La riga di comando

La Riga di comando viene avviata dal menu Processing o più rapidamente premendo Shift + Ctrl + M
(puoi cambiare quella scorciatoia predefinita da tastiera nella configurazione di QGIS se preferisci una diversa).
Per chiuderla, basta premere ESC. Oltre all’esecuzione degli algoritmi di elaborazione, la Riga di comando ti dà
l’accesso alla maggior parte delle funzionalità di QGIS, il che significa che ti offre un modo pratico ed efficace
per eseguire attività QGIS e consente di controllare QGIS con un utilizzo ridotto di pulsanti e menu.

Inoltre, la Linea di comando è completamente configurabile, puoi infatti personalizzare i comandi in modo da
poterli eseguire con una breve sequenza di tasti, questo ti permette di avere uno strumento molto potente che
velocizzerà notevolmente il tuo lavoro con QGIS.

20.10.1 Comandi disponibili

I comandi disponibili nella Linea di comando ricadono nelle seguenti categorie:

• Algoritmi di Processing. Questi sono mostrati come: Processing algorithm: <name of the
algorithm>.

• Voci del menu. Queste sono mostrate come Menu item: <menu entry text>. Sono disponibili
tutte le voci di menu disponibili nell’interfaccia QGIS, anche se sono incluse in un sottomenu.

• Funzioni python. Puoi creare brevi funzioni python che verranno incluse nella lista dei comandi disponibili.
Verranno mostrare come Function: <function name>.

Per eseguire un comando qualsiasi elencato sopra, inizia inserendo il nome del comando e poi seleziona l’elemento
corrispondente dalla lista che mostrerà automaticamente i comandi filtrati con quello che hai inserito.

Se vuoi richiamare una funzione Python, puoi selezionare la voce nell’elenco, preimpostato da Function:
(ad esempio, Function: removeall) oppure digitare direttamente il nome della funzione (removeall
nell’esempio precedente). Non è necessario aggiungere parentesi dopo il nome della funzione.

20.10.2 Creare funzioni personalizzate

Le funzioni personalizzate vengono aggiunte inserendo il codice Python corrispondente nel file commands.py
che si trova nella directory .qgis2/processing/commander nella tua cartella utente. È solo un semplice
file Python in cui puoi aggiungere le funzioni di cui hai bisogno.
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Il file viene creato con alcune funzioni di esempio la prima volta che avvierai la linea di comando. Se non hai
ancora avviato la riga di comando puoi creare tu stesso il file. Per modificare il file usa un qualsiasi editor di testo.
Puoi anche usare un editor presente in QGIS richiamando il comando edit dalla riga di comando. In questo
modo si aprirà un editor con il file dei comandi e potrai modificarlo direttamente salvando tutti i cambiamenti.

Per esempio, puoi aggiungere la funzione seguente che rimuove tutti i layer:

from qgis.gui import *

def removeall():
mapreg = QgsMapLayerRegistry.instance()
mapreg.removeAllMapLayers()

Una volta che hai aggiunto la funzione, questa sarà disponibile nella linea di comando e la potrai richiamare con
il comando removeall. Non devi fare altro che scrivere la funzione.

Le funzioni possono avere parametri aggiuntivi. Aggiungi *args alla definizione della funzione in modo da
aggiungere parametri. Richiamando la funzione dalla linea di comando, i parametri devono essere separati da
spazi.

Qui un esempio di funzione che carica un layer e prende un parametro con il nome del file del layer da caricare.

import processing

def load(*args):
processing.load(args[0])

Se vuoi caricare il layer /home/myuser/points.shp, digita nella casella di testo di Commander:

load /home/myuser/points.shp
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CHAPTER 21

Plugin di QGIS

21.1 QGIS Python console

As you will see later in this chapter, QGIS has been designed with a plugin architecture. Plugins can be written in
Python, a very famous language in the geospatial world.

QGIS brings a Python API (see PyQGIS Developer Cookbook for some code sample) to let the user interact with
its objects (layers, feature or interface). QGIS also has a Python console.

The QGIS Python Console is an interactive shell for the python command executions. It also has a python file
editor that allows you to edit and save your python scripts. Both console and editor are based on PyQScintilla2
package. To open the console go to Plugins → Python Console (Ctrl+Alt+P).

21.1.1 The Interactive Console

The interactive console is composed of a toolbar, an input area and an output one.

Toolbar

The toolbar proposes the following tools:

• Clear console to wipe the output area;

• Import class: Processing, PyQt4.QtCore or PyQt4.QtGui class;

• Run command available in the input area: same as pressing Enter;

• Show editor: toggles The Code Editor visibility;

• Options...;

• Help....

Console

The console main features are:

• Code completion, highlighting syntax and calltips for the following APIs:

– Python

– PyQGIS

– PyQt4
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– QScintilla2

– osgeo-gdal-ogr

• Ctrl+Alt+Space to view the auto-completion list if enabled in the Options;

• Execute code snippets from the input area by typing and pressing Enter or Run Command;

• Execute code snippets from the output area using the Enter selected from the contextual menu or pressing
Ctrl+E;

• Browse the command history from the input area using the Up and Down arrow keys and execute the
command you want;

• Ctrl+Shift+Space to view the command history: double-clicking a row will execute the command.
The Command History dialog can also be accessed from context menu of input area;

• Save and clear the command history. The history will be saved into the file
~/.qgis2/console_history.txt;

• Open QGIS API documentation by typing _api;

• Open PyQGIS Cookbook by typing _pyqgis.

Suggerimento: Reuse executed commands from the output panel
You can execute code snippets from the output panel by selecting some text and pressing Ctrl+E. No matter if
selected text contains the interpreter prompt (>>>, ...).

Figure 21.1: The Python Console

21.1.2 The Code Editor

Use the Show editor button to enable the editor widget. It allows editing and saving Python files and offers
advanced functionalities to manage your code (comment and uncomment code, check syntax, share the code via
codepad.org and much more). Main features are:

• Code completion, highlighting syntax and calltips for the following APIs:

– Python

– PyQGIS

– PyQt4

– QScintilla2

– osgeo-gdal-ogr
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• Ctrl+Space to view the auto-completion list.

• Sharing code snippets via codepad.org.

• Ctrl+4 Syntax check.

• Search bar (open it with the default Desktop Environement shorcut, usually Ctrl+F):

– Use the default Desktop Environment shortcut to find next/previous (Ctrl+G and Shift+Ctrl+G);

– Automatically find first match when typing in find box;

– Set initial find string to selection when opening find;

– Pressing Esc closes the find bar.

• Object inspector: a class and function browser;

• Go to an object definition with a mouse click (from Object inspector);

• Execute code snippets with the Enter selected command;

• Execute the whole script with the Run script command (this creates a byte-compiled file with the extension
.pyc).

Nota: Running partially or totally a script from the Code Editor outputs the result in the Console output area.

Figure 21.2: The Python Console editor

21.1.3 Options

Accessible either from the Console toolbar or the contextual menu of Console output panel or Code Editor, this
adds further settings to manage and control the Python console behavior:

• Autocompletion: If checked the code completion is enabled. You can get autocompletion from current
document, from installed APIs and both from APIs and current document.

• Autocompletion threshold: Sets the threshold to display the autocompletion list (in chars typed).

• Automatic parentheses insertion: If checked enables the autoclosing for bracket.

• Auto-save script before running: Allows you to save automatically the script to be executed in order to
avoid to save it after any modification. This action will store a temporary file into the temporary system
directory that will be automatically deleted after running.
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• Using preloaded APIs file: You can choose whether use the preload APIs file or load some APIs files saved
on your system.

• Using prepared APIs file: If checked the *.pap file will be used for code completion. To generate a
prepared APIs file you have to load at least an *.api file and then compile it by clicking on [Compile
Apis...] button.

Suggerimento: Save the options
To save the state of console’s widgets you have to close the Python Console from the close button. This allows
you to save the geometry to be restored to the next start.

21.2 Plugin di QGIS

QGIS è stato progettato con un’architettura a plugin. Questo permette di poter aggiungere numerosi nuovi elementi
e funzioni all’applicazione. Molte delle funzioni di QGIS sono attualmente implementate come plugin.

21.2.1 Plugin di Base e Plugin Esterni

I plugins di QGIS sono implementati come Plugin di Base o come Plugin Esterni.

Core Plugins sono mantenuti dal team di sviluppo di QGIS e fanno automaticamente parte di ogni distribuzione
QGIS. Sono scritti in uno dei due seguenti linguaggi: C++ o Python.

Most of External Plugins are currently written in Python. They are stored either in the ‘Official’ QGIS Repository
at http://plugins.qgis.org/plugins/ or in external repositories and are maintained by the individual authors. Detailed
documentation about the usage, minimum QGIS version, home page, authors,and other important information
are provided for the plugins in the Official repository. For other external repositories, documentation might be
available with the external plugins themselves. External plugins documentation is not included in this manual.

To install or activate a plugin, go to Plugins → Manage and install plugins....

Installed external python plugins are placed under ~/.qgis2/python/plugins folder. Home directory (de-
noted by above ~) on Windows is usually something like C:\Documents and Settings\(user) (on
Windows XP or earlier) or C:\Users\(user). On some platforms (e.g., macOS), the .qgis2 folder is hid-
den by default.

Percorsi per librerie Personalizzate di plugin in C++ possono essere aggiunti in Impostazioni → Opzioni → Sis-
tema.

Nota: According to the plugin manager settings, QGIS main interface can display a blue link in the status bar to
inform you that there are updates for your installed plugins or new plugins available.

21.2.2 La finestra di dialogo Plugins

The menus in the Plugins dialog allow the user to install, uninstall and upgrade plugins in different ways. Each
plugin has some metadata displayed in the right panel:

• informazione se il plugin è in stato sperimentale

• descrizione

• voto(i) di valutazione (puoi valutare per il tuo plugin preferito!)

• etichette

• alcuni utili links come la home page, categoria e versione e repository in cui è disponibile

• autore(i)
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• versione disponibile

At the top of the dialog, a Search function helps you find any plugin using metadata information (author, name,

description...). It is available in nearly every menu (except Settings).

La scheda Tutti

In the All tab, all the available plugins are listed, including both core and external plugins. Use [Upgrade
all] to look for new versions of the plugins. Furthermore, you can use [Install plugin] if a plugin is listed but
not installed, [Uninstall plugin] as well as [Reinstall plugin] if a plugin is installed. An installed plugin can be
temporarily de/activated using the checkbox.

Figure 21.3: La scheda Tutto

La scheda Installati

In Installed tab, you can find only the installed plugins. The external plugins can be uninstalled and reinstalled
using the [Uninstall plugin] and [Reinstall plugin] buttons. You can [Upgrade all] here as well.

La scheda Non installati

The Not installed tab lists all plugins available that are not installed. You can use the [Install plugin] button
to implement a plugin into QGIS.

Le schede Aggiornabile e Nuovo

The Upgradeable and New tabs are enabled when new plugins are added to the repository or a new version

of an installed plugin is released. If you activated Show also experimental plugins in the Settings menu,
those also appear in the list giving you opportunity to early test upcoming tools.

Installation can be done with the [Install plugin], [Upgrade plugin] or [Upgrade all] buttons.

21.2. Plugin di QGIS 407



QGIS User Guide, Release 2.18

Figure 21.4: La scheda Installato

Figure 21.5: La scheda Non installato
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Figure 21.6: The Upgradeable tab

La scheda Non valido

The Invalid tab lists all installed plugins that are currently broken for any reason (missing dependency, errors
while loading, incompatible functions with QGIS version...). You can try the [Reinstall plugin] button to fix
an invalidated plugin but most of the times the fix will be elsewhere (install some libraries, look for another
compatible plugin or help to upgrade the broken one).

La scheda Impostazioni

In the Settings tab, you can use the following options:

• Controlla aggiornamenti all’avvio. Ogni qualvolta è disponibile un nuovo plugin o è aggiornato un
plugin, QGIS ti informa ‘ogni volta che QGIS parte’, ‘una volta al giorno’, ‘ogni 3 giorni’, ‘ogni settimana’,
‘ogni 2 settimane’ o ‘ogni mese’.

• Mostra anche plugins sperimentali. QGIS ti mostrerà i plugin in fase di sviluppo che generalmente non
sono adatti per un uso di produzione.

• Mostra anche plugins obsoleti. Poiché utilizzano funzioni che non sono più disponibili in QGIS, questi
plugin sono deprecati e generalmente non idonei per l’uso di produzione. Appaiono nell’elenco dei plugin
non validi.

To add external author repositories, click [Add...] in the Plugin repositories section. If you do not want one or
more of the added repositories, they can be disabled via the [Edit...] button, or completely removed with the
[Delete] button.

Il repository QGIS predefinito è un repository aperto e non è necessaria alcuna autenticazione per accedervi. Puoi
tuttavia accedere ad altri repository di plugin tramite eventuali richiedeste di autenticazione (autenticazione di
base, PKI). Puoi ottenere ulteriori informazioni sul supporto dell’autenticazione QGIS nel capitolo Autenticazione.
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Figure 21.7: La scheda Non valido

Figure 21.8: La scheda Impostazioni
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21.3 Uso dei plugin di base di QGIS

Icona Plugin Descrizione Riferimento guida

Cattura Coordinate Cattura le coordinate del mouse usando un SR diverso Plugin Cattura
Coordinate

DB Manager Gestire i DB all’interno di QGIS Plugin DB
Manager

DXF2Shape
Converter

Converts from DXF to SHP file format Plugin
Convertitore
DXF2Shape

eVis Uno strumento di visualizzazione di eventi. Visualizza
immagini associate agli elementi di un vettore

Plugin eVis

GDAL Tools GDAL raster functionality Plugin GDALTools

Geometry Checker Verifica e elimina errori in geometrie vettoriali Plugin Controllo
Geometria

Geometry Snapper Snap geometries to a reference layer Plugin Aggancia
Geometrie

Georeferenziatore
raster (GDAL)

Georeferenziare i raster con GDAL Plugin
Georeferenziatore

Strumenti GPS Strumenti per caricare e importare dati GPS Plugin GPS

GRASS Attiva i potenti strumenti di GRASS Integrazione con
GRASS GIS

Heatmap Create heatmap rasters from input vector points Plugin Mappa di
concentrazione

Interpolation
plugin

Interpolation on base of vertices of a vector layer Plugin
Interpolazione

Metasearch
Catalog Client

Interagisce con Catalog Service for the Web (CSW) Client Catalogo
MetaSearch

Offline Editing Consente l’editing offline e la sincronizzazione con il
database

Plugin Offline
Editing

Oracle Spatial
Georaster

Access Oracle Spatial GeoRasters Plugin Oracle
GeoRaster Spaziale

Gestore plugin Gestisci i plugin di base e quelli esterni La finestra di
dialogo Plugins

Ambiente
Processing di
QGIS

Interrogazioni spaziali su dati vettoriali ambiente
Processing di QGIS

Raster Terrain
Analysis

Compute geomorphological features from DEMs Plugin Analisi
geomorfologica

Road Graph plugin Shortest path analysis Plugin grafo strade

Spatial Query Spatial queries on vectors Plugin
Interrogazione
Spaziale

Verifica topologica
su vettori

Trova errori topologici nei layer vettoriali Validatore
topologico

Zonal Statistics Calculate raster statistics for vector polygons Plugin Statistica
zonale
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21.4 Plugin Cattura Coordinate

Il plugin Cattura Coordinate è facile da usare e ti permette di mostrare sulla mappa coordinate in due sistemi di
riferimento (SR) distinti.

Figure 21.9: Plugin Cattura Coordinate

1. Start QGIS, select Project Properties from the Settings (KDE, Windows) or File (Gnome, macOS) menu

and click on the Projection tab. As an alternative, you can also click on the CRS status icon in the lower
right-hand corner of the status bar.

2. Attiva Abilita la riproiezione al volo e seleziona un sistema di coordinate proiettate a scelta (vedi anche
Lavorare con le proiezioni).

3. Activate the coordinate capture plugin in the Plugin Manager (see La finestra di dialogo Plugins) and ensure

that the dialog is visible by going to View → Panels and ensuring that Coordinate Capture is enabled.
The coordinate capture dialog appears as shown in Figure figure_coordinate_capture. Alternatively, you can

also go to Vector → Coordinate Capture and see if Coordinate Capture is enabled.

4. Clicca su Clicca per selezionare il SR da usare per la visualizzazione delle coordinate e seleziona un SR diverso da quello
selezionato precedentemente.

5. To start capturing coordinates, click on [Start capture]. You can now click anywhere on the map canvas
and the plugin will show the coordinates for both of your selected CRS.

6. Per abilitare la tracciatura via mouse delle coordinate seleziona l’icona
Clicca per abilitare la tracciatura via mouse. Clicca sula mappa per terminare.

7. Puoi anche copiare le coordinate selezionate negli appunti.

21.5 Plugin DB Manager

Il plugin DB Manager è parte del core QGIS ed è destinato ad essere lo strumento principale per integrare e gestire
i formati di database spaziali supportati da QGIS (PostGIS, SpatiaLite, GeoPackage, Oracle Spatial, Virtual layer)

in un’unica interfaccia utente. Il Plugin DB Manager ha diverse funzionalità. Puoi trascinare i layer da QGIS
Browser direttamente in DB Manager e questo importerà i tuoi layer nel tuo database spaziale. Puoi spostare
tabelle fra diversi database spaziali e le stesse saranno importate.

Il menu Database ti permette di collegarti a un database esistente, di lanciare la finestra SQL e di uscire dal plugin
DB Manager. Una volta che ti sei connesso a un database esistente, vengono visualizzati anche i menu Schema e
Tabella.

Il menu Schema include gli strumenti per creare ed eliminare gli schemi (vuoti) e, se è disponibile la topologia (ad
esempio, PostGIS2) per avviare un TopoViewer.

Il menu Tabella ti consente di creare e modificare tabelle e di eliminare tabelle e viste. È inoltre possibile svuotare
le tabelle e spostare le tabelle da uno schema all’altro. Come ulteriore funzionalità, puoi eseguire un VACUUM
e quindi un’analisi per ciascuna tabella selezionata. Il normale VACUUM recupera semplicemente lo spazio e
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Figure 21.10: La finestra di dialogo DB Manager
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lo rende disponibile per il riutilizzo. ANALYZE aggiorna le statistiche per determinare il modo più efficace per
eseguire una query. Infine, puoi importare layer/files, se sono caricati in QGIS o esistono nel file system. E puoi
esportare le tabelle di database in shapefiles con la funzione di Esportazione File.

La finestra Plugin | tutto elenca tutti i database supportati da QGIS. Puoi collegarti al database con un doppio
click. Con il tasto destro del mouse puoi rinominare ed eliminare schemi e tabelle esistenti. Le tabelle possono
essere aggiunte nella mappa di QGIS anche dal menu contestuale.

Se si è connessi a un database, compaiono tre schede nella finestra principale di DB Manager. La scheda Infor-
mazioni fornisce informazioni sulla tabella e sulle geometrie, oltre a campi, vincoli e indici esistenti. Permette
inoltre di effettuare una “Vacuum Analyze” e di creare un indice spaziale, se non è presente, per la tabella selezion-
ata. La scheda Tabella mostra tutti gli attributi e la scheda Anteprima visualizza una anteprima delle geometrie.

21.5.1 Lavorare con la Finestra SQL

Puoi utilizzare il DB Manager anche per eseguire query SQL sul database spaziale e quindi visualizzare lo spazio
di output delle query aggiungendo i risultati a QGIS come un layer di query. È possibile evidenziare una parte
dello SQL e solo quella parte verrà eseguita quando premi F5 o fai click sul pulsante Execute (F5).

Figure 21.11: Eseguire SQL nella finestra di dialogo SQL DB Manager

Nota: La finestra SQL può anche essere utilizzata per creare Layers Virtuali. In questo caso, invece di selezionare
un database, seleziona QGIS Layers sotto Virtual Layers prima di aprire la finestra SQL. Per istruzioni sulla
sintassi SQL da utilizzare vedi Creating virtual layers.

21.6 Plugin Convertitore DXF2Shape

Il plugin Dxf2Sh Converter permette di convertire dati vettoriali dal formato DXF al formato shapele. Richiede
che vengano specificati i seguenti parametri prima dell’esecuzione:
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Figure 21.12: Plugin Convertitore DXF2Shape

• File DXF in ingesso: immetti il percorso del le DXF da convertire.

• File in uscita: definisci il nome dello shapele da generare

• Tipo di le in uscita: specifica il tipo di geometria dello shapefile in uscita. I tipi attualmente supportati sono
polilinea, poligono e punto.

• Esporta le etichette di testo: quando viene selezionata questa scelta, viene creato uno shapele di punti e la
tabella DBF associata conterrà informazioni circa i campi “TESTO” trovati nel le DXF e le stringhe di testo
stesse.

21.6.1 Utilizzo del plugin

1. Avvia QGIS, attivare il plugin Dxf2Shape in Plugin Manager (vedi La finestra di dialogo Plugins) e clicca

sull’icona Dxf2Shape Converter che compare nella barra degli strumenti di QGIS. La finestra di dialogo del
plugin Dxf2Shape appare come mostrato in Figure_dxf2shape.

2. Carica il le DXF da convertire, inserisci un nome e la tipologia per lo shapele in output.

3. Abilita la casella di controllo Esporta le etichetto di testo, se vuoi creare un layer addizionale di punti
con le etichette.

4. Clicca su [OK].

21.7 Plugin eVis

(This section is derived from Horning, N., K. Koy, P. Ersts. 2009. eVis (v1.1.0) User’s Guide.
American Museum of Natural History, Center for Biodiversity and Conservation. Available from
http://biodiversityinformatics.amnh.org/, and released under the GNU FDL.)

La Biodiversity Informatics Facility presso il Museo americano di storia naturale American Museum of Natural
History’s (AMNH) Center for Biodiversity and Conservation (CBC) ha sviluppato lo strumento Event Visual-
ization Tool (eVis), un altro strumento software aggiunto alla suite di strumenti di monitoraggio e di supporto
decisionale per la conservazione e guida dell’area protetta e del piano paesaggistico. Questo plugin consente agli
utenti di collegare facilmente dati geocodificati (ad esempio, con latitudine e longitudine o X e Y Coordinate)
quali fotografie e altri documenti di supporto ai dati vettoriali in QGIS.

eVis è ora automaticamente installato e abilitato nelle nuove versioni di QGIS, e come tutti i plugin, può essere
disattivato e abilitato utilizzando il Plugin Manager (Vedi La finestra di dialogo Plugins).

Il plugin consta di tre moduli: ‘Connessione Database’, ‘ID evento’, ‘Browser evento’. Questi funzionano insieme
per consentire la visualizzazione di fotografie geocodificate e altri documenti collegati a oggetti memorizzati file
vettoriali, database o fogli di calcolo.
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21.7.1 Browser evento

Il modulo ‘Sfoglia Evento’ fornisce la funzionalità per visualizzare le fotografie geocodificate collegate alle ge-
ometrie vettoriali visualizzate nella finestra della mappa di QGIS. I dati dei punti, ad esempio, possono provenire
da un file vettoriale che può essere inserito utilizzando QGIS o può derivare dal risultato di una query del database.
La geometria vettoriale deve contenere le informazioni sugli attributi per descrivere la posizione e il nome del file
contenente la fotografia e, facoltativamente, la direzione della bussola a cui è stata puntata la fotocamera quando è
stata acquisita l’immagine. Il tuo layer vettoriale deve essere caricato in QGIS prima di eseguire Sfoglia Evento.

Aprire il modulo Browser evento

To launch the Event Browser module, click on Database → eVis → eVis Event Browser. This will open the
Generic Event Browser window.

La finestra Browser evento ha tre schede visualizzate nella parte superiore della finestra. La scheda Visualizza è
usata per visualizzare la fotografia e i suoi dati di attributo associati. La scheda Opzioni fornisce un numero di
impostazioni che possono essere regolate per controllare il comportamento del plugin eVis. Infine, la scheda Con-
figura Applicazioni Esterne serve per mantenere una tabella delle estensioni dei file e le loro associate applicazioni
per consentire a eVis di visualizzare documenti diversi dalle immagini.

Scheda Visualizza

Per visualizzare la finestra Visualizza, fai click sulla scheda Visualizza nella finestra Browser Evento. La finestra
Visualizza è usata per visualizzare le fotografie geocodificate e i relativi dati attributo.

Figure 21.13: Visualizzare finestra di dialogo eVis

1. Area di visualizzazione dell’immagine: è il riquadro inferiore della scheda.
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2. Ingrandisci: ingrandisce l’immagine per avere più dettagli. Se l’immagine è troppo grande per l’area di
visualizzazione, compaiono delle barre di scorrimento.

3. Rimpicciolisci: rimpicciolisce per vedere più parti dell’immagine.

4. Zoom completo: visualizza tutta l’immagine.

5. Finestra degli attributi: qui vengono visualizzate tutte le informazioni sugli attributi per il punto associato
alla fotografia visualizzata. Se il tipo di file a cui si fa riferimento nel record visualizzato non è un’immagine
ma è di un tipo di file definito in Configura applicazioni esterne, facendo doppio clic sul valore del campo
contenente il percorso del file, verrà avviata l’applicazione per aprire il file da visualizzare o ascoltare il
contenuto del file. Se l’estensione del file viene riconosciuta, i dati dell’attributo verranno visualizzati in
verde.

6. Pulsanti per la navigazione: utilizzare i pulsanti Precedente e Successivo per caricare l’oggetto precedente
o successivo quando è selezionato più di un oggetto.

Scheda Opzioni

Figure 21.14: Opzioni finestra di dialogo eVis

1. Percorso file: elenco a discesa per specificare l’attributo campo contenente il percorso o l’URL della di-
rectory per le fotografie o altri documenti visualizzati. Se la posizione è un percorso relativo, la casella di
controllo deve essere attivata. Il percorso di base per un percorso relativo può essere immesso nella casella
di testo Percorso base sottostante. Informazioni sulle diverse opzioni per specificare la posizione del le sono
indicate in basso nella sezione Specificare la localizzazione ed il nome di una foto

2. Orientamento bussola: un elenco a discesa per specificare il campo dell’attributo che contiene
l’orientamento della bussola associato alla fotografia visualizzata. Se sono disponibili informazioni sulla
bussola, è necessario fare clic sulla casella di controllo sotto il titolo del menu a discesa.
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3. Offset bussola: gi offset della bussola possono essere utilizzati per compensare la declinazione (per regolare
l’orientamento magnetico all’orientamento del nord effettivo). Fai click sul pulsante radio Manuale
per immettere l’offset nella casella di testo o fai click sul pulsante radio Da Attributo per selezionare
il campo attributo contenente gli offset. Per entrambe queste opzioni, le declinazioni est devono essere
immesse usando valori positivi e le declinazioni ovest dovrebbero utilizzare valori negativi.

4. Percorso base della cartella: il percorso base su cui verrà associato il percorso relativo definito inFig-
ure_eVis_options (A).

5. Sostituisci percorso: se è selezionata questa casella di controllo, solo il nome di file in A verrà aggiunto al
percorso base.

6. Applica regola a tutti i documenti: se selezionato, le stesse regole di percorso definite per le fotografie
verranno utilizzate per documenti non di immagine, ad esempio filmati, documenti di testo e file audio. Se
non è selezionato, le regole del percorso si applicano solo alle fotografie e gli altri documenti ignoreranno
il parametro del percorso base.

7. Remember settings: If the checkbox is checked, the values for the associated parameters will be saved for
the next session when the window is closed or when the [Save] button below is pressed.

8. Ripristina: reimposta il campo al valore predefinito.

9. Restore defaults: This will reset all of the fields to their default settings. It has the same effect as clicking
all of the [Reset] buttons.

10. Salva: salva le impostazioni senza chiudere la scheda Opzioni.

Configura applicazioni esterne

Figure 21.15: La finestra Applicazioni Esterne di eVis

1. Tabella riferimento file: una tabella contenente i vari tipi di file utilizzati da eVis. Ogni tipo file necessita
di un’estensione e di un percorso all’applicazione in grado di gestirlo. Ciò permette di aprire diversi tipi di
file come filmati, suoni e documenti testuali, oltre che solo immagini.

2. Aggiungi nuovo tipo file: aggiunge un nuovo tipo di file (estensione ed applicazione).

3. Elimina riga corrente: elimina il tipo di file selezionato in tabella.

21.7.2 Specificare la localizzazione ed il nome di una foto

La posizione e il nome della fotografia possono essere memorizzati utilizzando un percorso assoluto o relativo, o
un URL se la fotografia è disponibile su un server web. Esempi dei diversi approcci sono elencati nella tabella
evis_examples.
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X Y FILE BEARING
780596 1784017 C:\Workshop\eVis_Data\groundphotos\DSC_0168.JPG 275
780596 1784017 /groundphotos/DSC_0169.JPG 80
780819 1784015 http://biodiversityinformatics.amnh.org/\

evis_testdata/DSC_0170.JPG 10
780596 1784017 pdf:http://www.testsite.com/attachments.php?\

attachment_id-12 76

21.7.3 Specificare la localizzazione ed il nome di altri documenti

Anche i documenti di supporto come documenti di testo, video e clip audio possono essere visualizzati o riprodotti
da eVis. Per fare ciò, è necessario aggiungere una voce nella tabella di riferimento dei file a cui è possibile accedere
dalla finestra Configura applicazioni esterne in Browser eventi generici che corrisponde all’estensione del file a
un’applicazione che può essere usato per aprire il file. È inoltre necessario avere il percorso o l’URL del file nella
tabella degli attributi per il layer vettoriale. Una regola aggiuntiva che può essere utilizzata per gli URL che non
contengono un’estensione di file per il documento che si desidera aprire è specificare l’estensione del file prima
dell’URL. Il formato è — file extension:URL. L’URL è preceduto dall’estensione del file e da due punti;
questo è particolarmente utile per accedere ai documenti da wiki e altri siti Web che utilizzano un database per
gestire le pagine Web (vedi Tabella evis_examples).

21.7.4 Usare Browser evento

Quando si apre la finestra Browser eventi’, una fotografia apparirà nella finestra di visualizzazione se il documento
a cui si fa riferimento nella tabella degli attributi del file vettoriale è un’immagine e se le informazioni sulla
posizione del file nella finestra :guilabel:‘Opzioni sono correttamente impostate. Se è prevista una fotografia e
non appare, sarà necessario regolare i parametri nella finestra Opzioni.

Se nella tabella degli attributi viene fatto riferimento a un documento (o a un’immagine che non ha un’estensione
di file riconosciuta da eVis), il campo contenente il percorso del file sarà evidenziato in verde nella finestra delle
informazioni sugli attributi se tale estensione di file è definita nel tabella di riferimento dei file situata nella finestra
Configura le applicazioni esterne. Per aprire il documento, fare doppio clic sulla linea evidenziata in verde nella
finestra delle informazioni sugli attributi. Se viene fatto riferimento a un documento nella finestra delle infor-
mazioni sugli attributi e il percorso del file non è evidenziato in verde, sarà necessario aggiungere una voce per
l’estensione del file nel file Configura le applicazioni esterne. Se il percorso del file è evidenziato in verde ma
non si apre quando si fa doppio clic, sarà necessario regolare i parametri nella finestra Opzioni in modo che il file
possa essere localizzato da eVis.

Se non si è specificato l’orientamento della fotocamera nella finestra Opzioni, compare un asterisco rosso sul
vettore associato alla fotografia. Se l’orientamento è specificato, allora comparirà una freccia che punterà nella
direzione indicata nella finestra Browser evento. La freccia sarà centrata sul punto associato con la fotografia o
con un altro documento.

To close the Event Browser window, click on the [Close] button from the Display window.

21.7.5 Strumento ID evento

Il modulo ‘ID evento’ ti permette di visualizzare una foto cliccando su un elemento nella vista mappa di QGIS.
L’elemento vettoriale deve avere associati le informazioni di attributo contenenti la localizzazione ed il nome del
le della foto e, eventualmente, la direzione della bussola della fotocamera quando l’immagine è stata acquisita.
Questo layer deve essere caricato in QGIS prima di aprire lo strumento ‘ID evento’.

Aprire ID Evento

Per avviare il modulo ‘ID evento’, fai click sull’icona ID evento o fai click su Database -> eVis -> Strumento ID
evento. Ciò farà sì che il cursore si trasformi in una freccia con una ‘i’ sopra di esso a significare che lo strumento
ID è attivo.
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To view the photographs linked to vector features in the active vector layer displayed in the QGIS map window,
move the Event ID cursor over the feature and then click the mouse. After clicking on the feature, the Event
Browser window is opened and the photographs on or near the clicked locality are available for display in the
browser. If more than one photograph is available, you can cycle through the different features using the [Previ-
ous] and [Next] buttons. The other controls are described in the Browser evento section of this guide.

21.7.6 Connessione database eVis

Il modulo ‘Connessione Database’ permette di connettersi ed interrogare un database o altre risorse ODBC, es. un
foglio di calcolo.

eVis può connettersi direttamente alle seguenti tipologie di database: PostgreSQL, MySQL, SQLITE; può leggere
dati da connessioni ODBC (ad esempio MS Access): in tal caso è necessario configurare il driver ODBC (come
ad esempio un foglio Excel) per il sistema operativo che stai usando.

Aprire Connessione Database

Per avviare il modulo ‘Connessione Database’, fai click sull’apposita icona Connessione a database eVis o fai clic su
Database -> eVis -> Connessione database. Questo lancerà la finestra Connessione Database. La finestra ha tre
schede: Query predefinite, Connessione Database e SQL Query. La finestra Console di output nella parte inferiore
della finestra mostra lo stato delle azioni avviate dalle diverse sezioni di questo modulo.

Connessione Database

Fai click sulla scheda Connessione Database per aprire l’interfaccia di connessione al database. Quindi, utilizza

Tipo database casella combinata per selezionare il tipo di database a cui ti vuoi connettere. Se è richiesta
una password o un nome utente, tali informazioni possono essere inserite nelle caselle di testo Nome utente e
Password.

Inserire il server del database in Host Database. Questa opzione non è disponibile se hai scelto ‘MSAccess’ come
tipo di database. Se il database si trova sul tuo desktop, allora dovrai inserire “localhost”.

Immetti il nome del database nella casella di testo Nome database. Se hai selezionato ‘ODBC’ come tipo di
database, devi specificare il nome dell’origine dati.

When all of the parameters are filled in, click on the [Connect] button. If the connection is successful, a message
will be written in the Output Console window stating that the connection was established. If a connection was not
established, you will need to check that the correct parameters were entered above.

1. Tipo di Database: una lista a discesa per specificare il tipo di database che sarà utilizzato.

2. Host Database: nome host del database.

3. Porta: il numero di porta se il tipo di database selezionato è MYSQL o PostgreSQL.

4. Nome Database: nome del database.

5. Connetti: un pulsante per connettersi al database utilizzando i parametri sopra definiti.

6. Console di Output: la finestra console dove vengono visualizzati i messaggi relativi alla connessione.

7. Nome utente: nome utente in caso di database protetto.

8. Password: password in caso di database protetto.

9. Query Predefinite: scheda “Query Predefinite”.

10. Connessione Database: scheda “Connessione Database”.

11. Query SQL: scheda “Query SQL”.

12. Help: mostra la guida in linea.

13. OK: chiude Connessione Database .
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Figure 21.16: La finestra connessione Database di eVis

Eseguire query SQL

SQL queries are used to extract information from a database or ODBC resource. In eVis, the output from these
queries is a vector layer added to the QGIS map window. Click on the SQL Query tab to display the SQL query
interface. SQL commands can be entered in this text window. A helpful tutorial on SQL commands is available at
http://www.w3schools.com/sql. For example, to extract all of the data from a worksheet in an Excel file, select
* from [sheet1$] where sheet1 is the name of the worksheet.

Click on the [Run Query] button to execute the command. If the query is successful, a Database File Selection
window will be displayed. If the query is not successful, an error message will appear in the Output Console
window.

Nella finestra Scegli file Database assegnare un nome al nuovo layer che sarà creato dai risultati della query.

1. Query SQL: è il riquadro per inserire le query SQL.

2. Esegui Query: pulsante per mandare in esecuzione una query.

3. Console di Output: mostra i messaggi relativi all’esecuzione delle query.

4. Help: mostra la guida in linea.

5. OK: chiude Connessione Database.

Use the X Coordinate and Y Coordinate combo boxes to select the fields from the database that
stores the X (or longitude) and Y (or latitude) coordinates. Clicking on the [OK] button causes the vector layer
created from the SQL query to be displayed in the QGIS map window.

Per salvare questo file vettoriale per uso futuro, puoi utilizzare il comando ‘Salva come ...’ di QGIS a cui si
accede facendo click con il tasto destro del mouse sul nome del layer nella legenda della mappa QGIS e quindi
selezionando ‘Salva come ...’

Suggerimento: Creare un layer vettoriale da un foglio di lavoro Microsoft Excel
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Figure 21.17: La scheda interrogazione SQL di eVis

Quando crei un layer vettoriale da un foglio di lavoro di Microsoft Excel, puoi vedere che sono stati inseriti
zeri indesiderati (“0”) nelle righe della tabella degli attributi al di sotto dei dati validi. Ciò può essere causato
dall’eliminazione dei valori per queste celle in Excel utilizzando la chiave Backspace. Per correggere questo
problema, devi aprire il file Excel (devi chiudere QGIS se sei connesso al file, per permetterti di modificare il
file) e quindi usare Modifica -> Elimina per rimuovere le righe vuote dal file. Per evitare questo problema, puoi
semplicemente cancellare diverse righe nel foglio di lavoro di Excel usando Modifica -> Elimina prima di salvare
il file.

Eseguire query predefinite

Con le query predefinite, puoi selezionare query scritte in precedenza memorizzate in formato XML in un file.
Ciò è particolarmente utile se non hai familiarità con i comandi SQL. Fai clic sulla scheda Query predefinite per
visualizzare l’interfaccia di query predefinita.

Per caricare una serie di query predefinite, fai click sull’icona Apri file. Si apre la finestra Apri file, che viene
utilizzata per individuare il file contenente le query SQL. Quando le query vengono caricate, i loro nomi come
definiti nel file XML appariranno nel menu a discesa situato proprio sotto l’icona Apri file. La descrizione
completa della query viene visualizzata nella finestra di testo sotto il menu a discesa.

Seleziona la query che vuoi eseguire dal menu a discesa e quindi fai click sulla scheda Query SQL per verificare
che la query sia stata caricata nella finestra della query. Se è la prima volta che sta eseguendo una query predefinita
o sta cambiando database, devi assicurarti di essere connesso al database.

Click on the [Run Query] button in the SQL Query tab to execute the command. If the query is successful, a
Database File Selection window will be displayed. If the query is not successful, an error message will appear in
the Output Console window.

1. Apri file: avvia il browser file “Apri file” per cercare il file XML che contiene le query predefinite.
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Figure 21.18: Scheda Query predefinite eVis

2. Query predefinite: un elenco a discesa con tutte le query definite dal file XML delle query predefinite.

3. Descrizione query: breve descrizione della query derivata dal file XML.

4. Console di Output: mostra i messaggi relativi all’esecuzione delle query.

5. Help: mostra la guida in linea.

6. OK: chiude Connessione Database .

Formato XML per le query predefinite di eVis

Tag XML letti da eVis
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Tag Descrizione
query Definisce l’inizio e la fine di una istruzione di query.
shortde-
scription

Una breve descrizione della query visualizzata nel menu a discesa eVis.

descrip-
tion

Descrizione più dettagliata che viene mostrata nella casella ’Descrizione query’ di eVis.

database-
type

Il tipo di database, definito nel menu a discesa Tipo database nella scheda Connessione database.

database-
port

La porta di connessione come definita nella casella di teso Porta nella scheda Connessione
Database.

database-
name

Il nome del database come definito nella casella di testo Nome nella scheda Connessione
Database.

databaseuser-
name

Il nome utente del database definito nella casella di testo Nome utente nella scheda Connessione
database.

databasep-
assword

La password del database come definita nella casella di testo Password nella scheda
Connessione database.

sqlstate-
ment

Il comando SQL.

autocon-
nect

Un flag (“true”o “false ”) per specificare se i tag precedenti devono essere utilizzati per
connettersi automaticamente al database senza eseguire la routine di connessione al database
nella scheda Connessione database.

Segue un esempio completo di file XML contenente tre query:

<?xml version="1.0"?>
<doc>
<query>
<shortdescription>Import all photograph points</shortdescription>
<description>This command will import all of the data in the SQLite database to QGIS

</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\textbackslash Workshop/textbackslash

eVis\_Data\textbackslash PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID</sqlstatement>
<autoconnect>false</autoconnect>

</query>
<query>
<shortdescription>Import photograph points "looking across Valley"</shortdescription>
<description>This command will import only points that have photographs "looking across

a valley" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS=’Looking across
valley’</sqlstatement>

<autoconnect>false</autoconnect>
</query>
<query>

<shortdescription>Import photograph points that mention "limestone"</shortdescription>
<description>This command will import only points that have photographs that mention

"limestone" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
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<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS like ’%limestone%’
</sqlstatement>

<autoconnect>false</autoconnect>
</query>

</doc>

21.8 Plugin GDALTools

21.8.1 Cosa sono gli strumenti GDAL?

Il plugin GDALTools fa da interfaccia grafica ad una collezione di strumenti GDAL (Geospatial Data Abstraction
Library), http://gdal.osgeo.org: es. strumenti per interrogare, riproiettare, unire raster in vari formati. Sono inclusi
strumenti per derivare da un DEM dati tipo curve di livello, pendenze, ombreggiature o anche per collegare in un
raster virtuale diversi file raster (Virtual Raster Tile in XML). Tutti questi strumenti sono disponibili quando il
plugin è installato e attivato.

La libreria GDAL

La libreria GDAL contiene un insieme di programmi da linea di comando, ognuno con una lunga lista di opzioni.
Gli utenti che non hanno difficoltà ad effettuare l’esecuzione di comandi da terminale hanno accesso al set com-
pleto delle opzioni presenti nella libreria. Il plugin GDAL Tools offre una semplice interfaccia per gli strumenti
esponendo però solo le opzioni più comuni.

21.8.2 Lista degli strumenti GDAL

Figure 21.19: La lista degli Strumenti GDAL
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Proiezioni

Riproiezione
Questa utility è un’utilità di mosaicatura, riproiezione e deformazione delle immagini. Il
programma può riproiettare a qualsiasi proiezione supportata, e può anche applicare GCPs
memorizzati con l’immagine se l’immagine è “Raw” con informazioni di controllo. Per
ulteriori informazioni, puoi consultare il sito web GDAL al seguente link:
http://www.gdal.org/gdalwarp.html

Assegna
proiezione

Questo strumento ti permette di assegnare la proiezione a raster già georeferenziati, ma che
non contengono informazioni sulla proiezione. Con il suo aiuto, è possibile anche modificare
le definizioni di proiezione esistenti. Sono supportati sia il singolo file che la modalità batch.
Per ulteriori informazioni, consultare il sito web GDAL al seguente link:
http://www.gdal.org/gdalwarp.html

Estrai
proiezione...

Questo strumento ti permette di estrarre le informazioni di proiezione da un file di input. Se
vuoi estrarre le informazioni di proiezione da un’intera cartella, puoi utilizzare la modalità
batch. Crea entrambi i file .prj e .wld files.

Conversione

Rasteriz-
zazione....

Questo strumento trasforma geometrie vettoriali (punti, righe e poligoni) nelle bande raster
di un’immagine raster. I vettori vengono letti da formati vettoriali supportati da OGR. Nota
che i dati vettoriali devono essere nello stesso sistema di coordinate dei dati raster; non è
prevista la riproiezione al volo. Per ulteriori informazioni vedi
http://www.gdal.org/gdal_rasterize.html

Poligoniz-
zazione...

Questo strumento crea poligoni vettoriali a partire da insiemi di pixel collegati che
condividono un valore di pixel comune nel raster. Ogni poligono viene creato con un
attributo che indica il valore di pixel di quel poligono. L’utility creerà il formato vettoriale di
output che, se non esiste già, per default è il formato ESRI shapefile. Vedi anche
http://www.gdal.org/gdal_polygonize.html

Conversione
formati...

Questo strumento può essere utilizzato per convertire i dati raster tra diversi formati,
operazioni potenzialmente eseguibili come processi di ridimensionamento,
ricampionamento e riconfigurazione di pixel. Per ulteriori informazioni puoi consultare
http://www.gdal.org/gdal_translate.html

Da RGB
a PCT...

Questo strumentoy calcola una tabella pseudo-colore ottimale per una data immagine RGB
utilizzando un algoritmo di taglio mediano su un istogramma RGB sottocampionato. Poi
converte l’ immagine in un’ immagine pseudo-colore utilizzando la tabella colori. Questa
conversione utilizza il dithering Floyd-Steinberg (diffusione dell’errore) per massimizzare la
qualità visiva dell’ immagine in uscita. Questo strumento è anche descritto in
http://www.gdal.org/rgb2pct.html

Da PCT
to RGB...

Questo strumento converte una banda pseudo-colore in un le RGB, in un formato a scelta.
Per ulteriori informazioni, vedi http://www.gdal.org/pct2rgb.html

Estrazione

Curve
di livello...

Questo programma genera un le vettoriale di curve di livello a partire da un modello di
elevazione raster (DEM). Puoi trovare ulteriori informazioni in
http://www.gdal.org/gdal_contour.html

Ritaglia...
Questo strumento ti permette di estrarre una porzione di un raster utilizzando una selezione o
una porzione ritagliata su un altro layer. Ulteriori informazioni possono essere trovate in
http://www.gdal.org/gdal_translate.html
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Analisi

Filtro... Questo strumento rimuove poligoni raster più piccoli di un dato valore soglia (in pixel)
e li sostituisce con il valore del pixel del poligono vicino più grande. Il risultato può
essere salvato nel raster esistente o in un nuovo le. Per ulteriori informazioni, vedi
http://www.gdal.org/gdal_sieve.html

Sposta al
nero...

Questo strumento scansiona un’immagine e cerca di impostare tutti i pixel sui bordi che
sono quasi neri (o quasi bianchi) in modo che siano del tutto neri (o bianchi). Spesso
viene utilizzato per “correggere” le foto aeree “lossy compressed” in modo che i pixel
colorati siano visti come trasparenti durante la mosaicatura. Vedi anche
http://www.gdal.org/nearblack.html

Riempi dati
nulli...

Questo strumento riempie la regione raster selezionata (generalmente con aree nodata)
con valori di pixel interpolati da aree vicino all’area. Puoi trovare maggiori
informazioni in http://www.gdal.org/gdal_fillnodata.html

Prossimità... Questo strumento genera una mappa di prossimità raster che indica la distanza dal
centro di ogni pixel al centro del pixel più vicino identificato come un pixel di
destinazione. I pixel di destinazione sono quelli del raster di origine per i quali il valore
del pixel raster è nel set dei valori dei pixel di destinazione. Per ulteriori informazioni,
vedi http://www.gdal.org/gdal_proximity.html

Grid
(Interpolazione...)

Questo strumento crea una griglia regolare (raster) da dati sparsi OGR. I dati di input
saranno interpolati per riempire i nodi della griglia raster: sono disponibili vari metodi
di interpolazione. Lo strumento è anche descritto sul sito web GDAL
http://www.gdal.org/gdal_grid.html

DEM (analisi
geomorfologica)...

Questo strumento permette operazioni di analisi e visualizzazione di DEM. Può
generare un rilievo ombreggiato, la pendenza, l’orientamento, oppure calcolare l’indice
di asperità del terreno e l’indice di posizione geografica per tutti i formati raster di
elevazione supportati da GDAL. Per ulteriori informazioni, vedi
http://www.gdal.org/gdaldem.html

Miscellanea

Crea Raster
Virtuale
(Catalogo)

Questo programma crea un VRT (Virtual Dataset) che è un mosaico dell’elenco dei set
di dati GDAL di input. Per ulteriori informazioni, consulta il sito web GDAL al
seguente link: http://www.gdal.org/gdalbuildvrt.html

Unione Questo programma mosaica un insieme di raster. Tutti i raster devono essere nello
stesso sistema di riferimento ed avere lo stesso numero di bande, anche se possono
parzialmente sovrapporsi ed essere a diversa risoluzione. Nelle aree di sovrapposizione,
l’ultima immagine sarà copiata sopra la precedente. Per ulteriori informazioni, consulta
il sito web GDAL al seguente link: http://www.gdal.org/gdal_merge.html

Informazioni Questo programma elenca una serie di informazioni su un raster supportato da GDAL.
Per ulteriori informazioni, consulta il sito web GDAL al seguente link:
http://www.gdal.org/gdalinfo.html

Crea
panoramiche

Il programma gdaladdo permette di creare o ridefinire anteteprime di immagini con
diversi metodi di ricampionamento. Per ulteriori informazioni, consulta il sito web
GDAL al seguente link: http://www.gdal.org/gdaladdo.html

Indice
mattonelle

Questo programma genera uno shapele con un record per ogni le raster in input, un
attributo contenente il nome del le e una geometria poligonale che inquadra il raster. Per
ulteriori informazioni, consulta il sito web GDAL al seguente link:
http://www.gdal.org/gdaltindex.html.
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Impostazioni GDAL Tools

Usa questa finestra di dialogo per impostare le tue variabili GDAL.

21.9 Plugin Controllo Geometria

Geometry Checker is a powerful core plugin to check and fix the geometry validity of a layer. The Geometry
Checker dialog show differents grouped settings in the first tab (Settings):

• Input vector layer: to select the layer to check. A Only selected features checkbox can filter the geometry
to the one selected.

• Geometry validity: give to the user the choice between Self intersections, Duplicate nodes, Polygon with
less than 3 nodes.

• Tipi di geometria consentiti: per consentire solo alcuni tipi di geometria come punto, punto multiplo, linea,
multilinea, poligono e multipoligono.

• Geometry properties displays Polygons and multipolygons may not contain any holes and Multipart
objects must consist of more than one part.

• Condizioni geometria: l’utente può aggiungere alcune condizioni per convalidare le geometrie con una
lunghezza minima del segmento, un angolo minimo tra segmenti, una zona poligonale minima e il rileva-
mento di poligoni sottili.

• Topology checks: checks for duplicates, for features within other features, overlaps smaller than a number,
for gaps smaller than a number.

• Tolerance: you can define here the tolerance for the check.

• Output vector layer gives the choice to the user how get the result between modifiy the current layer and
create a new layer.

After you are happy with the configuration, you can click on the [Run] button.

The results appear in the second tab and as an overview layer of the errors in the canvas (its name is checker). A
table list the geometry check result with one error by row: the first row is an ID, the second the reason of the error,
then the coordinates of the error, a value (depending on the type of the error) and finally the resolution column
which indicates the resolution of the error. At the bottom of this table, you can export the error into a shapefile.
At the left, you have the number of the errors and the fixed errors.

Il Plugin Controllo Geometria può trovare i seguenti errori:

• Self intersections: a polygon with a self intersection,

• Duplicate nodes: two duplicates nodes in a segment

• Holes: hole in a polygon,

• Segment length: a segment length lower than a threshold,

• Minimum angle: two segments with an angle lower than a threshold,

• Minimum area: polygon area lower than a treshold,

• Silver polygon: this error come from very small polygon (with small area) with a large perimeter,

• Duplicates features,

• Feature within feature,

• Overlaps: polygon overlapping,

• Gaps: gaps between polygons
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Figure 21.20: Il Plugin Controllo Geometria
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Figure 21.21: The Differents checks supported by the plugin
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La seguente figura mostra i diversi controlli effettuati dal plugin.

You can select a row to see the localisation of the error. You can change this behaviour by selecting another action

between error (default), Feature, Don’t move, and Highlight contour of selected features.

Below the zoom action when clicking on the table row, you can Show the selected features in attribute table, Fix
selected errors using default resolution and Fix selected errors, prompt for resolution method. In the latter, you
will see a window to choose the resolution’s method among which:

• Merge with neighboring polygon with longest shared edge,

• Merge with neighboring polygon with largest area,

• Merge with neighboring polygon identical attribute value,if any, or leave as it

• Delete feature

• No action

Suggerimento: Correzione errori multipli
Puoi correggere errori multipli selezionando più di una riga nella tabella con l’azione*CTRL + click*.

The default action could be changed with the last icon Error resolution settings. For some type of errors, you can
change the default action between some specific action or No action.

Infine, puoi scegliere quale Attributo da utilizzare quando si uniscono le geometrie per valore di attributo.

21.10 Plugin Aggancia Geometrie

Lo strumento Aggancia Geometrie consente di allineare automaticamente i bordi e i vertici di un layer vettoriale
ai bordi e ai vertici di un secondo layer utilizzando una tolleranza definita dall’utente.

L’interfaccia seguente mostra le impostazioni di questo plugin. L’utente deve scegliere il layer da modificare (vedi
Vettore in ingresso) e il Layer di riferimento su cui eseguire l’aggancio. La Distanza massima di aggancio (unità
mappa) consente di modificare la tolleranza di aggancio.

Puoi agganciare solo le(a) geometrie selezionate tramite la casella di controllo Solo le geometrie selezionate.

Vettore in uscita ti permette di scegliere tra:guilabel:Modifica vettore in ingresso’ o :guilabel:‘Crea un nuovo
layer.

Figure 21.22: Il Plugin Aggancia Geometrie

432 Chapter 21. Plugin di QGIS



QGIS User Guide, Release 2.18

21.11 Plugin Georeferenziatore

The Georeferencer Plugin is a tool for generating world files for rasters. It allows you to reference rasters to
geographic or projected coordinate systems by creating a new GeoTiff or by adding a world file to the existing
image. The basic approach to georeferencing a raster is to locate points on the raster for which you can accurately
determine coordinates.

Features
Icona Azione Icona Azione

Carica un raster Avvia la georeferenziazione

Genera uno script GDAL Carica punti GCP (Ground Control Point)

Salva punti GCP Imposta la trasformazione

Aggiunge un nuovo punto Elimina un punto

Sposta un punto GCP Sposta la vista

Ingrandisce la vista Rimpicciolisce la vista

Zoom sul layer Zoom precedente

Zoom successivo Collegare il georeferenziatore a QGIS

Collegare QGIS al georeferenziatore Stiramento completo dell’istogramma

Stiramento locale dell’istogramma

Tabella Georeferenziatore: Strumenti del Georeferenziatore

21.11.1 Utilizzo del plugin

Per le coordinate X e Y (espresse in gradi, primi e secondi DMS (dd mm ss.ss), in gradi decimali (DD (dd.dd) o le
coordinate proiettate (mmmm.mm) espresse in metri), che corrispondono ai punti selezionati sull’immagine, puoi
usare due procedure alternative:

• Alcune volte nei raster sono presenti punti con le coordinate scritte sull’immagine. In questo caso puoi
inserire manualmente le coordinate.

• Usando layer già georeferenziati. Può trattarsi di dati vettoriali o raster che contengono gli stessi
oggetti/geometrie presenti nell’immagine che si desidera georeferenziare e con la proiezione che vuoi per la
tua immagine. In questo caso, puoi inserire le coordinate facendo click sul set di dati di riferimento caricato
nell’area della mappa QGIS.

Una procedura meno usuale consiste nel selezionare più punti del raster, specificarne le coordinate e scegliere
un metodo di trasformazione. Sulla base dei parametri inseriti, il plugin calcola i parametri del world file. Più
coordinate vengono fornite, migliore sarà il risultato.

The first step is to start QGIS, load the Georeferencer Plugin (see La finestra di dialogo Plugins) and click on
Raster → Georeferencer , which appears in the QGIS menu bar. The Georeferencer Plugin dialog appears as
shown in figure_georeferencer_dialog.

For this example, we are using a topo sheet of South Dakota from SDGS. It can later be visualized to-
gether with the data from the GRASS spearfish60 location. You can download the topo sheet here:
http://grass.osgeo.org/sampledata/spearfish_toposheet.tar.gz.

Aggiungere punti GCP

1. Per iniziare la georeferenziazione di un raster non referenziato, dobbiamo caricarlo usando il pulsante .
Il raster verrà visualizzato nell’area di lavoro principale della finestra di dialogo. Una volta caricato il raster,
possiamo iniziare a inserire i punti di riferimento.
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Figure 21.23: Finestra di dialogo del Plugin Georeferenziatore

2. Utilizzando il pulsante Aggiungi punto, aggiungi punti all’interno dell’area di lavoro principale e insesci le
rispettive coordinate (vedi la figura figure_georeferencer_add_points). Per effettuare questa procedura, hai
tre opzioni:

• Cliccare su un punto del raster ed inserire le coordinate X/Y manualmente.

• Fai click su un punto nell’immagine raster ed usa il pulsante Dalla mappa per inserire le coordinate X
e Y con l’aiuto di una mappa georeferenziata già caricata nella vista mappa di QGIS.

• Utilizzando il pulsante , puoi spostare i GCPs in entrambe le finestre, nel caso in cui fossero
posizionati in maniera errata.

3. Continua a inserire punti. Dovresti inserire almeno 4 GCP: più punti vengono inseriti, migliore sarà il
risultato. Ci sono strumenti del plugin per spostarsi nell’area di lavoro.

Figure 21.24: Aggiungi punti all’immagine raster

I punti che sono stati aggiunti alla mappa verranno salvati in un le di testo separato ([filename].points) in
genere insieme all’immagine raster. Questo ti consente di aprire in un secondo momento il plugin Georeferenzi-
atore e aggiungere nuovi punti oppure cancellarne alcuni, in maniera da migliorare il risultato finale. Il file dei
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punti contiene i valori del modulo: mapX, mapY, pixelX, pixelY. Puoi usare i pulsanti Carica punti GCP

e Salva i punti GCP come per gestire i file.

Impostare una trasformazione

Una volta aggiunti i GCP, è necessario definire le impostazioni di trasformazione del processo di georeferenzi-
azione.

Figure 21.25: Definizione delle impostazioni di trasformazione del georeferenziatore

Algoritmi di trasformazione disponibili

Sono disponibili diversi algoritmi di trasformazione: la scelta dipende dal numero di GCP a disposizione, dal tipo
e dalla qualità dei dati di input e dall’entità di distorsione geometrica accettabile nel risultato finale.

Sono disponibili le seguenti tipologie di trasformazione:

• L’algoritmo di trasformazione lineare è utilizzato per generare un file di georeferenziazione o world file, ed
è differente rispetto agli altri algoritmi, in quanto attualmente non adatta deformandolo il raster originale.
Questo algoritmo in genere non è adatto nel caso in cui si lavori con immagini scannerizzate.

• La trasformazione di Helmert esegue una rototraslazione del raster con variazione di scala.

• Gli algoritmi Polinomiali di grado 1-3 sono i più utilizzati per garantire la maggior coerenza tra i punti
inseriti e quelli risultanti dopo la trasformazione. L’algoritmo polinomiale più utilizzato è la trasformazione
attraverso un polinomio di secondo grado, che permette alcune curvature. La trasformazione polinomiale
di primo grado (affine) permette di conservare la collinearità dei punti, e consente solamente di scalare,
traslare e ruotare l’immagine.
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• L’algoritmo di traformazione Thin Plate Spline (TPS) è un metodo di georeferenziazione recente, che
permette di introdurre delle deformazioni localizzate all’interno dei dati. Questo algoritmo risulta partico-
larmente efficace quando si vogliono georeferenziare immagini di scarsa qualità.

• La traformazione Proiettiva consiste in una rotazione ed in una traslazione delle coordinate.

Metodo di ricampionamento

La scelta del metodo di ricampionamento dipende dai dati in input e da alcuni requisiti utente. Se, ad esempio,
non si accettano modifiche alle statistiche dell’immagine, allora il metodo del vicino più prossimo sarà più adatto.
Se, invece, si richiede un risultato più ‘liscio’ (smoothed) si utilizzerà il metodo cubico.

Puoi scegliere tra cinque diversi metodi di ricampionamento:

1. Vicino più prossimo

2. Lineare

3. Cubico

4. Spline cubica

5. Lanczos

Altre impostazioni di trasformazione

Bisogna definire varie altre opzioni per l’output.

• La casella di controllo Crea il file di georeferenziazione è attiva solo se scegli la trasformazione lineare,
quando il raster non viene fisicamente deformato. in tal caso, quindi, la casella Raster in output non è attiva
perché viene creato solo un nuovo file world.

• Per tutti gli altri tipi di trasformazione devi defnire un Raster in output.Come modalità predefinita, viene
creato un nuovo file ([nomefile]_modificato) nella stessa cartella del raster di partenza.

• Devi poi scegliere il SR (Sistema di riferimento) (sezione Lavorare con le proiezioni) per il Raster georiferito
(vedi Lavorare con le proiezioni).

• Puoi creare delle mappe pdf e anche dei report pdf. Il report fornisce informazioni sui parametri di
informazione utilizzati, un immagine dei residui e una lista con tutti i punti GCP con i loro errori standard.

• Puoi attivare la casella di controllo imposta risoluzione finale che permette di definire la risoluzione del
raster di output. il valore predefinito è 1.

• Puoi attivare la casella di controllo Utilizzare 0 per la trasparenza dove necessario, i pixel con valore 0
saranno trasparenti.

• Infine la casella di controllo Carica in QGIS una volta eseguito carica automaticamente il raster di
output nella vista mappa di QGIS a trasformazione terminata.

Proprietà del raster

Cliccando sull’opzione Proprietà raster nel menu Impostazioni si apre la finestra di dialogo Layer properties del
file raster che si desidera georeferenziare.

Configurare il georeferenziatore

• Puoi definire se visualizzare le coordinate e/o gli IDs dei GCP.

• Imposta le unità dei residui, pixel e unità di mappa.
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• Per i report PDF puoi definire margini e pdimensione pagina

• Puoi attivare la casella di controllo Mostra la finestra del georeferenziatore agganciata.

Eseguire la trasformazione

After all GCPs have been collected and all transformation settings are defined, just press the Start georeferencing

button to create the new georeferenced raster.

21.12 Plugin Mappa di concentrazione

Il plugin Mappa di concentrazione utilizza la Kernel Density Estimation per creare un raster di densità (Mappa
di concentrazione) di un layer vettoriale puntuali in input.La densità viene calcolata in base al numero di punti in
una porzione di spazio, valori più alti sono anche in funzione del metodo di calcolo nel calcolare la densità per
unità di superficie impostata. Le mappe di concentrazione consentono una facile identificazione degli “hotspot” e
del raggruppamento di punti.

21.12.1 Attivare il plugin Mappa di concentrazione

Innanzitutto questo plugin di base deve essere attivato usando il Gestore Plugin (vedi La finestra di dialogo Plug-

ins). Dopo l’attivazione, l’icona della mappa di concentrazione può essere trovato nella barra degli strumenti
Raster e sotto il menu Raster → Mappa di concentrazione...

Seleziona il menu Visualizza -> Barre degli strumenti -> Raster per mostrare la Barra degli Strumenti Raster se
non è visibile.

21.12.2 Utilizzo del plugin

Facendo click sul pulsante Mappa di concentrazione si apre la finestra di dialogo del plugin mappa di con-
centrazione (vedi figure_heatmap_settings).

La finestra di dialogo ha le seguenti opzioni:

• Vettore punti in ingresso: elenca tutti i layer vettoriali puntuali del progetto corrente e viene utilizzato per
selezionare il layer da analizzare.

• Raster in uscita: ti permette di utilizzare il pulsante per selezionare la cartella e il nome del file per
l’output raster generato dal plugin Mappa di concentrazione. Non è richiesta un’estensione di file.

• Formato in uscita: Seleziona il formato di output. Sebbene possano essere scelti tutti i formati supportati
da GDAL, nella maggior parte dei casi GeoTIFF è il formato migliore da scegliere.

• Raggio: Viene utilizzato per specificare il raggio di ricerca della mappa di concentrazione (o larghezza di
banda del kernel) in metri o unità di mappa. Il raggio specifica la distanza attorno a un punto in cui verrà
percepita l’influenza del punto. Valori maggiori determinano una maggiore uniformità, ma valori più piccoli
possono mostrare dettagli più fini e variazioni della densità dei punti.

Quando la casella di controllo Avanzato è selezionata, saranno disponibili altre opzioni:

• Riga e Colonna: utilizzate per cambiare la dimensione del raster in output. Questi valori sono anche
collegati ai valori di Dimensione cella X e di Dimensione cella Y. Aumentando il numero di righe o
colonne diminuirà la dimensione della cella e aumenterà la dimensione del file di output. Anche i valori
in Righe e Colonne sono collegati, quindi raddoppiando il numero di righe raddoppierà automaticamente il
numero di colonne e anche le dimensioni delle celle saranno dimezzate. L’area geografica dell’output raster
rimarrà la stessa!
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• Dimensioni cella X e Dimensione cella Y: Controllano la dimensione geografica di ciascun pixel nel raster
di output. Cambiando questi valori cambieranno anche il numero di Righe e Colonne nel raster di output.

• Forma del Kernel: La forma del kernel controlla la velocità con cui l’influenza di un punto diminuisce
man mano che la distanza dal punto aumenta. Diversi kernel decadono a diverse velocità, quindi un ker-
nel tridimensionale offre maggiori peso per distanze più vicine al punto rispetto a quello che fa il kernel
Epanechnikov. Di conseguenza, il tridimensionale porta a hotspot “più nitidi”, e Epanechnikov produce hot
spot “più distribuiti”. In QGIS sono disponibili alcune funzionalità standard del kernel, descritte e illustrate
su Wikipedia.

• Tasso di decadimento: Può essere usato con Triangular kernels per controllare ulteriormente il modo in cui
la mappa di concentrazione di un fenomeno diminuisce con la distanza dal centro del fenomeno.

– Un valore 0 (=minimum) indica che la concentrazione è massima al centro di un dato raggio e scom-
pare completamente sui bordi.

– Un valore di 0,5 indica che i pixel sul bordo del raggio saranno distribuiti con concentrazione dimez-
zata di pixel al centro del raggio di ricerca

– Un valore pari a 1 significa che la concentrazione viene distribuita uniformemente sull’intero cerchio
del raggio di ricerca. (Questo è equivalente al kernel ‘Uniform’).

– Un valore più grande di 1 indica che la concentrazione è più alta ai bordi di un dato raggio piuttosto
che al centro.

Il layer puntuale di input può anche avere campi attributo che possono essere usati per creare una mappa di
concentrazione:

• Use il raggio del campo: imposta il raggio di ricerca per ogni geometria da un campo attributo nel layer di
input.

• Usa il peso dal campo: Ti permette di impostare il peso per le geometrie di input in base a un campo
attributo. Questo può essere usato per aumentare l’influenza che alcune geometrie hanno sulla mappa di
concentrazione risultante.

Una volta specificato il nome del file per il raster di output, può essere utilizzato il pulsante [OK] per creare la
mappa di concentrazione.

21.12.3 Tutorial: Creare una mappa di concentrazione

For the following example, we will use the airports vector point layer from the QGIS sample dataset (see
Sample Data). Another excellent QGIS tutorial on making heatmaps can be found at http://www.qgistutorials.com.

Nella figura Figure_Heatmap_data, sono visualizzati gli aeroporti dell’Alaska.

1. Seleziona il pulsante della barra degli strumenti Mappa di concentrazione per aprire la finestra di
dialogo Mappa di concentrazione (vedi Figure_Heatmap_settings).

2. Nel campo Vettore punti in ingresso , seleziona airports dalla lista di layer puntuali caricati nel
progetto corrente.

3. Specifica un nome file di output facendo clic sul pulsante accanto al campo: Output raster. Inserisci
il nome del file heatmap_airports (non è necessaria alcuna estensione di file).

4. Lascia il Formato di output al formato predefinito, GeoTIFF.

5. Cambia il Raggio a 1000000 metri.

6. Fai click su [OK] per creare e caricare la mappa di concentrazione degli aeroporti (vedi Fig-
ure_Heatmap_created).

QGIS genererà la mappa di concentrazione e aggiungerà i risultati alla finestra della tua mappa. Per impostazione
predefinita, la mappa di concentrazione è ombreggiata in scala di grigi, con aree più chiare che mostrano concen-
trazioni più elevate di aeroporti. La mappa di concentrazione può ora essere modificata negli stili in QGIS per
migliorarne l’aspetto.
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Figure 21.26: Aeroporti in Alaska

Figure 21.27: La finestra di dialogo Mappa di concentrazione
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Figure 21.28: La mappa di concentrazione dopo il caricamento appare come una superficie grigia

1. Apri la finestra di dialogo delle proprietà del layer heatmap_airports (seleziona il layer
heatmap_airports, apri il menu contestuale facendo click con il pulsante desto del mouse e scegli
Proprietà).

2. Seleziona la scheda Stile.

3. Cambia il: guilabel: Tipo visualizzazione in ‘Banda singola falso colore’.

4. Seleziona una adatta Scala colori , ad esempio YlOrRed‘.

5. Fai click sul pulsante [Carica] per ricavare i valori minimi e massimi dal raster, quindi fai click sul pulsante
[Classifica].

6. Premi [OK] per aggiornare il layer.

Il risultato finale è mostrato in Figure_Heatmap_styled.

21.13 Plugin Interpolazione

Il plugin di interpolazione permette di generare un TIN o un’interpolazione IDW a partire da un layer vettoriale di
punti. E’ molto semplice da usare e fornisce un’interfaccia utente grafica intuitiva per la creazione di layer raster
interpolati (vedi Figure_interpolation). Il plugin richiede di specificare prima dell’esecuzione l’impostazione dei
seguenti parametri:

• Ingresso Vettore: consente di specificare i layer vettoriali puntuali di input da un elenco di layer puntuali
caricati. Se vengono specificati più layer, vengono utilizzati per l’interpolazione i dati di tutti i layer. Nota: è
possibile inserire linee o poligoni come vincoli per la triangolazione, specificando “punti”, “linee struttura”

o “linee di interruzione” nella casella combinata Tipo .

• Attributo interpolazione: seleziona il campo attributo da utilizzare per l’interpolazione e abilita la casella

di controllo Usa la coordinata Z per l’interpolazione per utilizzare i valori Z del livello.
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Figure 21.29: Mappa di concentrazione aeroporti in Alaska

• Metodo di interpolazione: Seleziona il metodo di interpolazione. Questo può essere sia ‘Rete Irregolare
Triangolata (TIN)’ o ‘Distanza Inversa Ponderata (IDW)’. Con il metodo TIN puoi creare una superficie
formata da triangoli creati dai punti maggiormente vicini. Per fare questo, vengono creati cerchi circoscritti
a punti vicini che non intersecano altri punti e i triangoli derivati da questi costituiscono una rete di triangoli
non sovrapposti e il più possibile compatti. Le superfici risultanti non sono lisce. Quando si utilizza il
metodo IDW, i punti campione vengono ponderati durante l’interpolazione in modo tale che l’influenza di
un punto rispetto a un altro diminuisca con la distanza dal punto sconosciuto che si desidera creare. Anche
il metodo di interpolazione IDW presenta alcuni svantaggi: la qualità del risultato di interpolazione può
diminuire se la distribuzione dei punti di campionamento non è uniforme. Inoltre, i valori massimi e minimi
nella superficie interpolata possono verificarsi solo nei punti di campionamento. Ciò si traduce spesso in
piccoli picchi e buche attorno ai punti dei dati di esempio.

• Configurare il metodo di interpolazione: Configura il metodo di interpolazione che hai scelto. Per
il metodo TIN puoi scegliere tra metodi di interpolazione Lineare e Clough Toucher (cubico). Puoi anche
salvare la triangolazione in formato shapele. Per l’interpolazione IDW è possibile impostare il coefficiente
di distanza.

• Numero di colonne/righe: Specifica il numero di righe e colonne per il file di output raster.

• File di output: nome del raster di output.

• Aggiungi il risultato al progetto per caricare il risultato sulla mappa.

Nota che utilizzando le linee come vincoli per l’interpolazione del triangolazione (metodo TIN) puoi utilizzare
‘linee di struttura’ o ‘linee di rottura’. Quando utilizzi ‘linee di rottura’ produci forti interruzioni nella superficie
mentre se si utilizzi “linee di struttura” produci interruzioni continue. La triangolazione viene modificata da
entrambi i metodi in modo tale che nessun bordo attraversa una linea di rottura o di struttura.

21.13.1 Utilizzo del plugin

1. Avvia QGIS e carica un layer vettoriale di punti (ad esempio, elevp.csv).
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Figure 21.30: Plugin Interpolazione

2. Carica il plugin Interpolazione in Gestore Plugin (vedi manage_plugins) e fai click su Raster -> Interpo-

lazione -> menu Interpolazione, che appare nella barra dei menu di QGIS. La finestra di dialogo del
plugin appare come mostrato in Figure_interpolation.

3. Seleziona un layer in ingresso (ad esempio elevp ) e le colonne (ad esempio ELEV) per
l’interpolazione.

4. Seleziona un metodo di interpolazione (per esempio ‘Rete Irregolare Triangolata (TIN)’), e specifica la
dimensione delle celle a 5000 come il nome del raster output(per esempio elevation_tin).

5. Cliccare su [OK].

21.14 Client Catalogo MetaSearch

21.14.1 Introduzione

MetaSearch è un plugin di QGIS per interfacciarsi con i servizi di catalogazione metadati, supporto standard del
Catalogue Service for the Web (CSW) dell’OGC.

MetaSearch offre un approccio semplice ed intuitivo con un’interfaccia user-friendly per effettuare ricerche in
cataloghi di metadati all’interno di QGIS.

21.14.2 Installazione

MetaSearch è incluso per impostazione predefinita con QGIS 2.0 e versioni successive. Tutte le dipendenze sono
incluse in MetaSearch.

Install MetaSearch from the QGIS plugin manager, or manually from http://plugins.qgis.org/plugins/MetaSearch.

21.14.3 Lavorare con i cataloghi dei metadati in QGIS

CSW (Catalog Service for the Web)

CSW (Catalog Service for the Web) is an OGC (Open Geospatial Consortium) specification, that defines common
interfaces to discover, browse and query metadata about data, services, and other potential resources.
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Figure 21.31: Search and results of Services in Metasearch
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Avvio

To start MetaSearch, click icon or select Web → MetaSearch → MetaSearch via the QGIS main menu. The
MetaSearch dialog will appear. The main GUI consists of three tabs: Services, Search and Settings.

Managing Catalog Services

Figure 21.32: Managing Catalog Services

The Services tab allows the user to manage all available catalog services. MetaSearch provides a default list of
Catalog Services, which can be added by pressing [Add default services] button.

Per l’elenco di tutte le voci del Servizio catalogo, fai click sulla casella di selezione a discesa.

To add a Catalog Service entry, click the [New] button, and enter a Name for the service, as well as the URL
(endpoint). Note that only the base URL is required (not a full GetCapabilities URL). Clicking [OK] will add the
service to the list of entries.

To edit an existing Catalog Service entry, select the entry you would like to edit and click the [Edit] button, and
modify the Name or URL values, then click [OK].

To delete a Catalog Service entry, select the entry you would like to delete and click the [Delete] button. You will
be asked to confirm deleting the entry.

MetaSearch permette di caricare e salvare le connessioni usando un le XML. Questo è utile se devi condividere le
impostazioni tra più applicazioni. Segue un esempio di file in formato XML.

<?xml version="1.0" encoding="UTF-8"?>
<qgsCSWConnections version="1.0">

<csw name="Data.gov CSW" url="https://catalog.data.gov/csw-all"/>
<csw name="Geonorge - National CSW service for Norway" url="http://www.geonorge.no/geonetwork/srv/eng/csw"/>
<csw name="Geoportale Nazionale - Servizio di ricerca Italiano" url="http://www.pcn.minambiente.it/geoportal/csw"/>
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<csw name="LINZ Data Service" url="http://data.linz.govt.nz/feeds/csw"/>
<csw name="Nationaal Georegister (Nederland)" url="http://www.nationaalgeoregister.nl/geonetwork/srv/eng/csw"/>
<csw name="RNDT - Repertorio Nazionale dei Dati Territoriali - Servizio di ricerca" url="http://www.rndt.gov.it/RNDT/CSW"/>
<csw name="UK Location Catalogue Publishing Service" url="http://csw.data.gov.uk/geonetwork/srv/en/csw"/>
<csw name="UNEP/GRID-Geneva Metadata Catalog" url="http://metadata.grid.unep.ch:8080/geonetwork/srv/eng/csw"/>

</qgsCSWConnections>

To load a list of entries, click the [Load] button. A new window will appear; click the [Browse] button and
navigate to the XML file of entries you wish to load and click [Open]. The list of entries will be displayed. Select
the entries you wish to add from the list and click [Load].

Click the [Service info] button to displays information about the selected Catalog Service such as service iden-
tification, service provider and contact information. If you would like to view the raw XML response, click the
[GetCapabilities response] button. A separate window will open displaying Capabilities XML.

Searching Catalog Services

Figure 21.33: Searching catalog services

La scheda Cerca permette all’utente di interrogare i servizi di catalogazione per dati e servizi, impostare i parametri
di ricerca e visualizzare i risultati.

Sono disponibili i seguenti parametri di ricerca:

• Parole chiave: ricerca a testo libero sulle parole chiave;

• Da: il servizio di catalogazione su cui effettuare le interrogazioni;

• Bounding box: the spatial area of interest to filter on defined by Xmax, Xmin, Ymax, and Ymin. Click [Set
global] to do a global search, click [Map extent] to do a search on the visible area only or manually enter
custom values as desired.
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Clicking the [Search] button will search the selected Metadata Catalog. Search results are displayed in a list and
are sortable by clicking on the column title. You can navigate through search results with the directional buttons
below the search results. Clicking the [View search results as XML] button opens a window with the service
response in raw XML format.

Clicking a result will provides the following options:

• se il metadato ha una estensione geografica associata, ne verranno mostrati i limiti nella mappa;

• doppio click su un record ne mostra i metadati con ogni collegamento di accesso associato. Cliccando su un
link questo verrà aperto all’interno del browser

• if the record is an OGC web service (WMS/WMTS, WFS, WCS), the appropriate [Add to
WMS/WMTS|WFS|WCS] buttons will be enabled for the user to add to QGIS. When clicking this but-
ton, MetaSearch will verify if this is a valid OWS. The OWS will then be added to the appropriate QGIS
connection list, and the appropriate WMS/WMTS|WFS|WCS connection dialog will then appear.

Figure 21.34: Visualizzazione Metadati del record

Impostazioni

Puoi ottimizzare MetaSearch con le seguenti impostazioni: Impostazioni:

• Connection naming: when adding an OWS connection (WMS/WMTS|WFS|WCS), the connection is stored
with the various QGIS layer provider. Use this setting to set whether to use the name provided from
MetaSearch, whether to overwrite or to use a temporary name;

• Impaginazione dei risultati: il numero di risultati da visualizzare per pagina durante la ricerca nei cataloghi
di metadati. Il valore predefinito è 10 risultati per pagina.

• Timeout del server: il numero di secondi dopo il quale bloccare il tentativo di connessione al server per la
ricerca nei cataloghi di metadati. Il valore predefinito è 10 secondi;
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Figure 21.35: Metasearch setting

21.15 Plugin Offline Editing

In progetti di acquisizione dati è situazione comune trovarsi a lavorare sul campo con computer portatili e palmari:
i dati in tal modo acquisiti vanno, poi, sincronizzati con la banca dati principale, (ad esempio un database PostGIS).
Se più persone lavorano simultaneamente sullo stesso set di dati, risulta difficile aggiornare la banca dati principale
manualmente, anche se le persone non stanno aggiornando le stesse features.

Il plugin Editing Offline permette di automatizzare l’attività di sincronizzazione, copiando il contenuto della banca
dati principale (solitamente un database PostGIS o un WFS-T) in un database Spatialite e memorizzando le modi-
fiche non in linea in tabelle dedicate. Dopo essersi nuovamente connessi alla rete, è possibile applicare le modifiche
fatte in modalità offline alla banca dati.

21.15.1 Utilizzo del plugin

• Apri un progetto con alcuni layers vettoriali (ad esempio da PostGIS o da un WFS-T).

• Vai a Database → Editing Offline → Converti ad un progetto offline e seleziona i layers da salvare. Il
contenuto dei layers viene salvato in tabelle di SpatiaLite.

• Con Sincronizza solo le features selezionate se è attiva una selezione puoi controllare e salvare con
l’editig offline solo un sottoinsieme selezionato di dati. Può essere utile in caso di layers di grandi dimen-
sioni.

• Modificare il layer in modalità non in linea.

• Dopo essersi nuovamente connessi, carica le modifiche utilizzando Database → Editing Offline →
Sincronizza.
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Figure 21.36: Crea un progetto offline da PostGis o layer WFS

21.16 Plugin Oracle GeoRaster Spaziale

Nei database Oracle i dati raster possono essere gestiti come oggetti SDO_GEORASTER messi a disposizione

dall’estensione Oracle Spatial. In QGIS il plugin Aggiungi layer Oracle GeoRaster è supportato da GDAL e le sue fun-
zionalità dipendono dal database Oracle installato sulla tua macchina. Il software Oracle è proprietario, sebbene
il suo utilizzo sia libero per attività di sviluppo e test. Di seguito un semplice esempio di come caricare immagini
raster in GeoRaster:

$ gdal_translate -of georaster input_file.tif geor:scott/tiger@orcl

carica un raster nella tabella predefinita GDAL_IMPORT in una colonna con nome RASTER.

21.16.1 Gestire le connessioni

Innanzitutto, il plugin Oracle GeoRaster deve essere abilitato utilizzando il Gestore Plugin (vedi manage_plugins).
La prima volta che si carica un GeoRaster in QGIS, devi creare una connessione al database Oracle che contiene i

dati. Per fare ciò, inizia facendo clic sul pulsante della barra degli strumenti Aggiungi layer Oracle GeoRaster - questo
aprirà la finestra di dialogo Sceglo Oracle GeoRaster Spatial. Fai click su [Nuovo] per aprire la finestra di dialogo
e specifica i parametri di connessione (vedi Figure_oracle_raster_connection):

• Nome: Inserire un nome per la connessione al database.

• Istanza database: Inserire il nome del database al quale vuoi connetterti.

• Nome utente: Inserire il tuo nome utente che userai per accedere al database.

• Password: Inserire la password associata al tuo Nome utente che è richiesta per accedere al database.

Ora, torna alla finestra principale Scegli Oracle Spatial GeoRaster (vedi Figure_oracle_raster_selection), usa
l’elenco a discesa per scegliere una connessione e usa il pulsante [Connetti] per stabilire una connessione. Puoi
anche utilizzare [Modifica] per la connessione aprendo la finestra di dialogo precedente e apportando modifiche
alle informazioni di connessione, oppure utilizzare il pulsante [Elimina] per rimuovere la connessione dall’elenco
a discesa.
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Figure 21.37: Finestra di dialogo di creazione connessione Oracle

21.16.2 Selezionare un GeoRaster

Una volta stabilita una connessione, la finestra Sotto insieme di dati mostrerà i nomi di tutte le tabelle che con-
tengono colonne GeoRaster in quel database nel formato compatibile del sottoinsieme di dati con GDAL.

Selezionare una tabella con il mouse e cliccare su [Seleziona]: apparirà un nuovo elenco con i nomi delle colonne
GeoRaster della tabella selezionata. Di solito questo è un breve elenco, poiché la maggior parte degli utenti non
avrà più di una o due colonne GeoRaster sulla stessa tabella.

Fai click su uno dei sotto insiemi di dat elencati e quindi fai clic su [Seleziona] per scegliere una delle combi-
nazioni tabella/colonna. La finestra di dialogo mostrerà ora tutte le righe che contengono oggetti GeoRaster. Nota
che l’elenco dei sotto insiemi di dati ora mostrerà le coppie Tabella dati raster e ID raster.

In qualsiasi momento, la voce selezionata può essere modificata per andare direttamente a un GeoRaster noto o
per tornare all’inizio e selezionare un altro nome di tabella.

Figure 21.38: Finestra di dialogo di selezione GeoRaster Oracle

La voce di selezione dei dati può anche essere utilizzata per inserire una clausola WHERE alla fine della stringa
di identificazione (ad esempio, geor:scott/tiger@orcl,gdal_import,raster,geoid=). per mag-
giori informazioni vedi http://www.gdal.org/frmt_georaster.html.
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21.16.3 Visualizzare un GeoRaster

Infine, selezionando un GeoRaster dall’elenco di Tabelle dati raster e ID raster, l’immagine raster verrà caricata in
QGIS.

La finestra di dialogo Scegli Oracle Spatial GeoRaster può ora essere chiusa e alla prossima apertura, manterrà la
stessa connessione e mostrerà la stessa lista precedente di sotto insieme di dati, rendendo molto facile l’apertura
di un’altra immagine dalla stessa contesto.

Nota: I GeoRasters che contengono piramidi verranno visualizzati molto più velocemente, ma le piramidi devono
essere generate al di fuori di QGIS usando Oracle PL/SQL o gdaladdo.

Segue un esempio di utilizzo di gdaladdo:

$ gdaladdo georaster:scott/tiger@orcl,georaster\_table,georaster,georid=6 -r
nearest 2 4 6 8 16 32

Questo è, invece, un esempio con PL/SQL:

$ sqlplus scott/tiger
SQL> DECLARE
gr sdo_georaster;

BEGIN
SELECT image INTO gr FROM cities WHERE id = 1 FOR UPDATE;
sdo_geor.generatePyramid(gr, ’rLevel=5, resampling=NN’);
UPDATE cities SET image = gr WHERE id = 1;
COMMIT;

END;

21.17 Plugin Analisi geomorfologica

Il plugin Analisi geomorfologica può essere utilizzato per calcolare la pendenza, l’esposizione, l’indice di
asperità e la curvatura totale di modelli digitali del terreno (DEM). È molto semplice da usare grazie ed ha
un’interfaccia grafica intuitiva per creare nuovi layer raster (vedi Figure_raster_terrain).

Descrizione delle analisi:

• Pendenza: calcola l’angolo di pendenza per ogni cella espresso in gradi (basato sulla stima della prima
derivata).

• Esposizione: 0 gradi per nord e continuando in senso orario.

• Ombreggiatura: crea una mappa ombreggiata utilizzando luce e ombra per fornire un aspetto più tridimen-
sionale per una mappa in rilievo ombreggiata.. La mappa di uscita è in grigio a banda singola che riflette il
valore di grigio dei pixel.

• Indice di asperità: una misurazione quantitativa dell’eterogeneità del terreno descritta da Riley ed altri
(1999). Viene calcolato per ogni posizione calcolando la variazione di elevazione all’interno della griglia di
pixel 3x3.

• Rilievo: crea una mappa di ombreggiatura partendo da dati digitali di elevazione. E’ implementato un
metodo che permette di scegliere i colori dell’elevazione analizzando la distribuzione delle frequenze. La
mappa di uscita è colore multibanda con tre bande che riflettono i valori RGB del rilievo ombreggiato.

21.17.1 Usare il plugin

1. Avvia QGIS e carica il layer raster gtopo30 dalla location di GRASS.

2. Carica il plugin Analisi geomorfologica in Gestore Plugin Manager (vedi La finestra di dialogo Plugins).
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Figure 21.39: Plugin Analisi geomorfologica (calcolo pendenza)

3. Seleziona un metodo di analisi dal menu (ad esempio: Raster → Analisi terreno → Pendenza). Viene
visualizzata la finestra di dialogo Pendenza come mostrato in Figure_raster_terrain.

4. Specificare nome, percorso e formato del file di output.

5. Cliccare su [OK].

21.18 Plugin grafo strade

Il plugin Grafo Strade è un plugin scritto in C++ che calcola il percorso minimo tra due punti su una polilinea e
traccia tale percorso sul grafo delle strade.

Figure 21.40: Plugin grafo strade

Caratteristiche principali:

• Calcola il percorso, la sua lunghezza ed il tempo di percorrenza.
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• Ottimizza la lunghezza ed il tempo di percorrenza

• Esporta il percorso in un vettore.

• Evidenzia la direzione delle strade (questo è lento e usato principalmente per scopi di debug e per il test
delle impostazioni).

Come layer di strade puoi usare un layer vettoriale di polilinee in qualsiasi formato supportato da QGIS. Due linee
con un punto in comune vengono considerate connesse. Si noti che è richiesto di utilizzare il SR del layer come
layer di progetto mentre si gestiscono layer di strade. Ciò è dovuto al fatto che il ricalcolo delle coordinate tra
diversi CRS introduce alcuni errori che possono causare discontinuità, anche quando viene utilizzata la modalità
di ‘aggancio’.

Nella tabella degli attributi del layer si possono usare i seguenti campi:

• Velocità su sezione di strada (campo numerico).

• Direzione (qualsiasi tipo che può essere adeguato su stringa). Le direzioni di andata e ritorno corrispondono
a una strada a senso unico, entrambe le direzioni indicano una strada a doppio senso.

Se alcuni campi non hanno valori, o non esistono, vengono utilizzati dei valori predeniti. Puoi cambiare le im-
postazioni predefinite e alcune impostazioni nella finestra di dialogo delle impostazioni del plugin.

21.18.1 Utilizzo del plugin

Dopo l’attivazione del plugin, vedrai un pannello aggiuntivo alla sinistra della finestra principale di QGIS. Ora,
inserisci alcuni parametri nella finestra di dialogo impostazione nel menu Vettore → Grafo stradale (vedi fig-
ure_road_graph_settings).

Figure 21.41: Impostazioni del plugin Grafo strade

Dopo aver impostato Unità di tempo, Unità di distanza e Tolleranza della topologia, puoi scegliere il layer vet-
toriale nella scheda Layer trasporti. Qui puoi anche scegliere Campo per la direzione e Campo per la velocità.
Nella scheda Valori preimpostati, puoi impostare la Direzione per il calcolo.

Infine, nel pannello Percorso più breve, seleziona un punto di inizio e un punto di fine nel layer della rete stradale
e fai click su [Calcola].
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21.19 Plugin Interrogazione Spaziale

Il plugin Interrogazione Spaziale ti permette di creare una query spaziale (ovvero selezionare le caratteristiche) in un
layer di destinazione facendo riferimento a un altro layer. La funzionalità è basata sulla libreria GEOS e dipende
dal layer selezionato come sorgente.

Gli operatori spaziali sono:

• Contiene

• E’ uguale a

• Sovrappone

• Attraversa

• Interseca

• E’ disgiunto

• Tocca

• E’ contenuto

21.19.1 Come usare il plugin

Come esempio: trova le regioni dell’Alaska che contengono areoporti. Sono necessari i seguenti passaggi:

1. Avvia QGIS e carica i layer vettoriali regions.shp e airports.shp.

2. Carica il plugin Interrogazione nel Gestore Plugin (vedi manage_plugins) e fai click sull’icona
Interrogazione Spaziale, che appare nel menu della barra degli strumenti di QGIS. Viene visualizzata la finestra di
dialogo del plugin.

3. Seleziona il layer regions come layer principale airports come layer di riferimento.

4. Seleziona l’operatore ‘Contiene’e clicca [Applica].

A questo punto appare un riquadro che elenca gli ID degli elementi che soddisfano la query e hai diverse opzioni
come mostrato in figure_spatial_query.

• Clicca su Crea layer con lista di oggetti.

• Seleziona un elemento dalla lista e clicca su Crea layer con selezionato.

• Seleziona ‘Rimuovi dalla sessione corrente’ nel campo E usa il risultato per .

• Puoi fare Zoom all’oggetto o visualizzare Messaggi di log.

• Inoltre in ID geometria risultato con le opzioni ‘Origine non valida’ e ‘Riferimento non valido’ puoi dare
un’occhiata agli oggetti con errori di geometria. Queste geometrie non sono utilizzate per la query.

21.20 Validatore topologico

La topologia tratta le relazioni spaziali tra punti, linee e poligoni, che rappresentano le geometrie di una re-
gione geografica. Con il validatore topologico puoi verificare se i tuoi vettori rispettano le regole topologiche.
Queste regole verificano se le relazioni spaziale delle geometrie di un vettore sono ‘Uguali’, ‘Contiene’, ‘Sovrap-
pone’, ‘Sovraposta’, ‘Incrocia’, o se i vettori sono ‘Disgiunti’, ‘Intersecano’, Sovrastano’ o ‘Toccano’ altri vettori.
Dipende dalle tue richieste su quali regole di topologia applicherai per i vettori (ad esempio, normalmente non
accetterai superamento in vettori di linee se non nel caso di raffigurazione di strade senza uscita).
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Figure 21.42: Spatial Query analysis – Regioni con aeroporti

Figure 21.43: Il validatore topologico
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QGIS ha integrata una funzione di editing topologico molto utile per la creazione di nuove geometrie senza errori.
Ma gli errori di dati esistenti e gli errori degli utenti sono difficili da trovare. Questo plugin ti aiuta a trovare tali
errori attraverso un elenco di regole topologiche.

E’ molto semplice creare condizioni topologiche con il validatore topologico

Sui vettori di punti puoi utilizzare le seguenti condizioni:

• deve essere coperto da: puoi scegliere un vettore dal progetto. I punti che non sono coperti da un dato
vettore vengono messi nel campo ‘errore’.

• deve essere coperto dai punti terminali: puoi scegliere vettore di linee dal progetto.

• deve essere dentro: puoi scegliere un vettore poligono dal progetto. I punti devono essere all’interno di un
poligono. In caso contrario, segnala ‘Errore’ per il punto.

• non deve avere duplicati: ogni volta che un punto è rappresentato due o più volte, apparirà nel campo
‘Errore’.

• non deve avere geometrie non valide: verifica se le geometrie sono validi.

• non deve avere geometrie multi-part: tutti i punti multipli sono segnalati come ‘Errore’.

Sui vettori di linee hai a disposizione le seguenti regole topologiche:

• End points must be covered by: Here you can select a point layer from your project.

• non deve avere nodi sospesi: individuerà le eccedenze nel vettore di linee.

• non deve avere duplicati: ogni volta che una linea è rappresentata due o più volte, apparirà nel campo
‘Errore’.

• non deve avere geometrie non valide: verifica se le geometrie sono validi.

• non deve avere geometrie multi-part: alcune volte, una geometria è in realtà un insieme di geometrie sem-
plici (single-parte). Tale geometria è chiamato geometria multi-part. Se contiene anche un solo elemento
di geometria multi-part, noi lo chiamiamo punti multipli, linee-multiple o poligoni multipli. Tutte le linee
multiple sono segnalate come ‘Errore’.

• non deve avere pseudo: il punto terminale di una linea dovrebbe essere collegato ai punti finali di altre
due geometrie. Se il punto terminale è collegato al punto terminale di una sola altra geometria, il punto
terminale è chiamato un nodo pseudo.

Per i vettori poligono hai a disposizione le seguenti regole:

• deve contenere: il vettore poligono deve contenere almeno un punto della geometria dal secondo vettore.

• non deve avere duplicati: i poligoni dello stesso vettore non devono avere geometrie identiche. Ogni volta
che un poligono è rappresentato due o più volte aparirà nel campo ‘Errore’.

• non deve avere vuoti: poligoni adiacenti non devono formare spazi vuoti tra di loro. I confini amministrativi
potrebbero essere citati come esempio (poligoni stato degli Stati Uniti non hanno spazi vuoti tra di loro ...).

• non deve avere geometrie non valide: verifica se le geometrie sono validi. Alcune delle regole che definis-
cono una geometria validi sono:

– I poligoni anello devono essere chiusi.

– Anelli che definiscono i buchi devono essere all’interno anelli che definiscono i confini esterni.

– Gli anelli non possono auto-intersecarsi (non si possono né toccare né incrociare l’un l’altro).

– Gli anelli non tocchino altri anelli, tranne che in un punto.

• non deve avere geometrie multi-part: alcune volte, una geometria è in realtà un insieme di geometrie sem-
plici (single-parte). Tale geometria è chiamato geometria multi-part. Se contiene anche un solo elemento di
geometria multi-part, noi lo chiamiamo punti multipli, linee-multiple o poligoni multipli. Ad esempio, un
paese composto di una o più isole può essere rappresentato come un multi-poligono.

• non deve sovrapporsi: poligoni adiacenti non devono condividere un’area comune.
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• non deve sovrapporsi con: poligoni adiacenti da un vettore non devono condividere un’area comune con
poligoni di un altro vettore.

21.21 Plugin Statistica zonale

Con il plugin Statistica zonale puoi analizzare i risultati di una classificazione tematica. Il plugin per-
mette di calcolare diversi valori dei pixel di un raster con l’aiuto di un layer vettoriale poligonale (vedi fig-
ure_zonal_statistics). Scegliendo una banda di colore, il plugin genera colonne di output nel layer vettoriale
con un prefisso definito dall’utente e calcola per ogni poligono le statistiche sui pixel che si trovano all’interno.
Le statistiche disponibili sono:

• Conteggio: per contare il numero di pixel

• Somma: per avere la somma dei valori dei pixel

• Media: per ottenere la media dei valori dei pixel

• Mediana: per ottenere la mediana dei valori dei pixel

• Deviazione standard: per ottenere la deviazione standard dei valori dei pixel

• Minimo: per ottenere il valore minimo dei valori dei pixel

• Massimo: per ottenere il valore massimo dei valori dei pixel

• Intervallo: per ottenere l’intervallo (max-min) dei valori dei pixel

• Minoranza: per ottenere il valore meno rappresentato dei valori dei pixel

• Maggioranza: per ottenere il valore più rappresentato dei valori dei pixel

• Varietà: per contare il numero dei valori differenti tra i pixel presenti

Figure 21.44: Finestra di dialogo Statistiche Zonali
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CHAPTER 22

Aiuto e supporto

22.1 Le Mailing list

QGIS è in continuo sviluppo e, come tale, non funzionerà sempre come ci si aspetta. Il miglior modo di ottenere
aiuto è unirsi alla mailing list di qgis-users. Le vostre domande raggiungeranno una audience più ampia e le
risposte ottenute saranno anche a beneficio di altri.

22.1.1 QGIS Users

This mailing list is used for discussion of QGIS in general, as well as specific questions regarding its
installation and use. You can subscribe to the qgis-users mailing list by visiting the following URL:
http://lists.osgeo.org/mailman/listinfo/qgis-user

22.1.2 QGIS Developers

If you are a developer facing problems of a more technical nature, you may want to join the qgis-developer mailing
list. This list is also a place where people can chime in and collect and discuss QGIS related UX (User Experience)
/ usability issues. It’s here: http://lists.osgeo.org/mailman/listinfo/qgis-developer

22.1.3 QGIS Community Team

This list deals with topics like documentation, context help, user guide, web sites, blog, mailing lists, forums, and
translation efforts. If you would like to work on the user guide as well, this list is a good starting point to ask your
questions. You can subscribe to this list at: http://lists.osgeo.org/mailman/listinfo/qgis-community-team

22.1.4 QGIS Translations

This list deals with the translation efforts. If you like to work on the translation of the website, manuals or the
graphical user interface (GUI), this list is a good starting point to ask your questions. You can subscribe to this list
at: http://lists.osgeo.org/mailman/listinfo/qgis-tr

22.1.5 QGIS Project Steering Committee (PSC)

This list is used to discuss Steering Committee issues related to overall management and direction of QGIS. You
can subscribe to this list at: http://lists.osgeo.org/mailman/listinfo/qgis-psc
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22.1.6 QGIS User groups

In order to locally promote QGIS and contribute to its development, some QGIS communities are orga-
nized into QGIS User Groups. These groups are places to discuss local topics, organize regional or na-
tional user meetings, organize sponsoring of features... The list of current user groups is available at
http://qgis.org/en/site/forusers/usergroups.html

Sei invitato ad iscrivervi a una delle liste. Ricordati di contribuire alla lista rispondendo alle domande e condivi-
dendo le tue esperienze.

22.2 IRC

We also maintain a presence on IRC - visit us by joining the #qgis channel on irc.freenode.net. Please wait for a
response to your question, as many folks on the channel are doing other things and it may take a while for them to
notice your question. If you missed a discussion on IRC, not a problem! We log all discussion, so you can easily
catch up. Just go to http://qgis.org/irclogs and read the IRC-logs.

Commercial support for QGIS is also available. Check the website http://qgis.org/en/commercial-support.html for
more information.

22.3 BugTracker

While the qgis-users mailing list is useful for general ‘How do I do XYZ in QGIS?’-type questions, you
may wish to notify us about bugs in QGIS. You can submit bug reports using the QGIS bug tracker at
http://hub.qgis.org/projects/quantum-gis/issues. When creating a new ticket for a bug, please provide an email
address where we can contact you for additional information.

Ricordate che un bug da voi segnalato potrebbe ricevere una priorità diversa da quella che vi aspettereste (a seconda
della serietà del problema). Alcuni errori richiedono un significativo sforzo allo sviluppatore e non sempre ci sono
abbastanza risorse umane disponibili.

Le richieste per nuove caratteristiche possono essere sottoposte tramite lo stesso sistema di segnalazioni usato per
i bug. Assicuratevi di aver prima selezionato il tipo Feature.

If you have found a bug and fixed it yourself, you can submit either a Pull Request on the Github QGIS Project
(prefered) or a patch also. The lovely redmine ticketsystem at http://hub.qgis.org/projects/quantum-gis/issues has
this type as well. Check the Patch supplied checkbox and attach your patch before submitting your bug.
One of the developers will review it and apply it to QGIS. Please don’t be alarmed if your patch is not applied
straight away – developers may be tied up with other commitments.

Nota che se sottoponi una Pull Request, la tua modifica potrebbe essere integrata nel codice sorgente con maggiore
probabilità!

22.4 Blog

The QGIS community also runs a weblog at http://planet.qgis.org/planet/, which has some interesting articles for
users and developers as well provided by other blogs in the community. You are invited to contribute your own
QGIS blog!

22.5 Plugins

The website http://plugins.qgis.org provides the official QGIS plugins web portal. Here, you find a list of all stable
and experimental QGIS plugins available via the ‘Official QGIS Plugin Repository’.
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22.6 Wiki

Lastly, we maintain a WIKI web site at http://hub.qgis.org/projects/quantum-gis/wiki where you can find a variety
of useful information relating to QGIS development, release plans, links to download sites, message-translation
hints and more. Check it out, there are some goodies inside!
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CHAPTER 23

Hanno contribuito

QGIS is an open source project developed by a team of dedicated volunteers and organisations. We strive to be
a welcoming community for people of all race, creed, gender and walks of life. At any moment, you can get
involved.

23.1 Autori

Di seguito sono elencate le persone che dedicano il loro tempo e le loro energie a scrivere, rivedere e aggiornare
l’intera documentazione di QGIS.

Tara Athan Radim Blazek K. Koy Godofredo Contreras Martin Dobias
Peter Ersts Anne Ghisla Stephan Holl N. Horning Magnus Homann
Werner Macho Denis Rouzaud Tyler Mitchell Claudia A. Engel Lars Luthman
Otto Dassau Brendan Morely David Willis Jürgen E. Fischer Yoichi Kayama
Alex Bruy Anita Graser Victor Olaya Marco Hugentobler Gary E. Sherman
Tim Sutton Larissa Junek Raymond Nijssen Richard Duivenvoorde Andreas Neumann
Astrid Emde Yves Jacolin Alexandre Neto Alessandro Pasotti Hien Tran-Quang
Andy Schmid Arnaud Morvan Akgar Gumbira Giovanni Allegri Diethard Jansen
Andy Allan Matthias Kuhn Chris Berkhout Carson J.Q. Farmer Steven Cordwell
Eric Goddard Frank Sokolic Luca Casagrande Harrissou Sant-anna Saber Razmjooei
Ilkka Rinne Jacob Lanstorp Ujaval Gandhi Jean-Roc Morreale Salvatore Larosa
João Gaspar Joshua Arnott Thomas Gratier Marco Bernasocchi Marie Silvestre
Ko Nagase Larry Shaffer Luigi Pirelli Konstantinos Nikolaou Maning Sambale
Manel Clos Mattheo Ghetta Bernhard Ströbl Luca Manganelli Nathan Woodrow
Nick Bearman Paul Blottière Vincent Picavet Maximilian Krambach René-Luc D’Hont
Tom Chadwin Patrick Sunter Nyall Dawson Milo Van der Linden Paolo Cavallini
Paolo Corti Hugo Mercier Gavin Macaulay Stefan Blumentrath Nicholas Duggan
David Adler Vincent Mora Tudor Barascu QGIS Koran Translator Stéphane Brunner
Jaka Kranjc Tom Kralidis Zoltan Siki Sebastian Dietrich Uros Preloznik
Dick Groskamp Mezene Worku Alexandre Busquets Dominic Keller Andre Mano
ajazepk icephale Andrei GiordanoPezzola zstadler
Ramon embelding

23.2 Traduttori

QGIS is a multi-language application and as is, also publishes a documentation translated into several lan-
guages. Many other languages are being translated and would be released as soon as they reach a reason-
able percentage of translation. If you wish to help improving a language or request a new one, please see
http://qgis.org/en/site/getinvolved/index.html.

Le traduzioni attuali sono rese possibili grazie a:
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Lingua Hanno contribuito
Bahasa
Indonesia

Emir Hartato, I Made Anombawa, Januar V. Simarmata, Muhammad Iqnaul Haq Siregar, Trias
Aditya

Cinese
(Tradizionale)

Calvin Ngei, Zhang Jun, Richard Xie

Olandese Carlo van Rijswijk, Dick Groskamp, Diethard Jansen, Raymond Nijssen, Richard
Duivenvoorde, Willem Hoffman

Finlandese Matti Mäntynen, Kari Mikkonen
Francese Arnaud Morvan, Augustin Roche, Didier Vanden Berghe, Dofabien, Etienne Trimaille,

Harrissou Sant-anna, Jean-Roc Morreale, Jérémy Garniaux, Loïc Buscoz, Lsam, Marc-André
Saia, Marie Silvestre, Mathieu Bossaert, Mathieu Lattes, Mayeul Kauffmann, Médéric
Ribreux, Mehdi Semchaoui, Michael Douchin, Nicolas Boisteault, Nicolas Rochard, Pascal
Obstetar, Robin Prest, Rod Bera, Stéphane Henriod, Stéphane Possamai, sylther, Sylvain
Badey, Sylvain Maillard, Vincent Picavet, Xavier Tardieu, Yann Leveille-Menez, yoda89

Galiziano Xan Vieiro
Tedesco Jürgen E. Fischer, Otto Dassau, Stephan Holl, Werner Macho
Hindi Harish Kumar Solanki
Italiano Alessandro Fanna, Anne Ghisla, Flavio Rigolon, Giuliano Curti, Luca Casagrande, Luca

Delucchi, Marco Braida, Matteo Ghetta, Maurizio Napolitano, Michele Beneventi, Michele
Ferretti, Roberto Angeletti, Paolo Cavallini, Stefano Campus

Giapponese Baba Yoshihiko, Minoru Akagi, Norihiro Yamate, Takayuki Mizutani, Takayuki Nuimura,
Yoichi Kayama

Coreano OSGeo Korean Chapter
Polacco Andrzej Świąder, Borys Jurgiel, Ewelina Krawczak, Jakub Bobrowski, Mateusz Łoskot,

Michał Kułach, Michał Smoczyk, Milena Nowotarska, Radosław Pasiok, Robert Szczepanek,
Tomasz Paul

Portoghese Alexandre Neto, Duarte Carreira, Giovanni Manghi, João Gaspar, Joana Simões, Leandro
Infantini, Nelson Silva, Pedro Palheiro, Pedro Pereira, Ricardo Sena

Portoghese
(Brasile)

Arthur Nanni, Felipe Sodré Barros, Leônidas Descovi Filho, Marcelo Soares Souza, Narcélio
de Sá Pereira Filho, Sidney Schaberle Goveia

Rumeno Alex Bădescu, Bogdan Pacurar, Georgiana Ioanovici, Lonut Losifescu-Enescu, Sorin Călinică,
Tudor Bărăscu

Russo Alexander Bruy, Artem Popov
Spagnolo Carlos Dávila, Diana Galindo, Edwin Amado, Gabriela Awad, Javier César Aldariz, Mayeul

Kauffmann
Ucraino Alexander Bruy
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CHAPTER 24

Appendice

24.1 GNU General Public License

Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place - Suite 330, Boston, MA 02111-1307,
USA

Ognuno ha la possibilità di copiare e distribuire copie letterali di questo documento di licenza, i cambi non sono
permessi.

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast,
the GNU General Public License is intended to guarantee your freedom to share and change free software–to
make sure the software is free for all its users. This General Public License applies to most of the Free Software
Foundation’s software and to any other program whose authors commit to using it. (Some other Free Software
Foundation software is covered by the GNU Library General Public License instead.) You can apply it to your
programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed
to make sure that you have the freedom to distribute copies of free software (and charge for this service if you
wish), that you receive source code or can get it if you want it, that you can change the software or use pieces of
it in new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to
surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the
software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients
all the rights that you have. You must make sure that they, too, receive or can get the source code. And you must
show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you
legal permission to copy, distribute and/or modify the software.

Also, for each author’s protection and ours, we want to make certain that everyone understands that there is no
warranty for this free software. If the software is modified by someone else and passed on, we want its recipients
to know that what they have is not the original, so that any problems introduced by others will not reflect on the
original authors’ reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redis-
tributors of a free program will individually obtain patent licenses, in effect making the program proprietary. To
prevent this, we have made it clear that any patent must be licensed for everyone’s free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow. TERMS AND CONDITIONS
FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice placed by the copyright holder
saying it may be distributed under the terms of this General Public License. The “Program”, below, refers to
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any such program or work, and a “work based on the Program” means either the Program or any derivative
work under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim
or with modifications and/or translated into another language. (Hereinafter, translation is included without
limitation in the term “modification”.) Each licensee is addressed as “you”.

Activities other than copying, distribution and modification are not covered by this License; they are outside
its scope. The act of running the Program is not restricted, and the output from the Program is covered only
if its contents constitute a work based on the Program (independent of having been made by running the
Program). Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program’s source code as you receive it, in any medium,
provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice
and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any
warranty; and give any other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty
protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the
Program, and copy and distribute such modifications or work under the terms of Section 1 above, provided
that you also meet all of these conditions:

(a) You must cause the modified files to carry prominent notices stating that you changed the files and the
date of any change.

(b) You must cause any work that you distribute or publish, that in whole or in part contains or is derived
from the Program or any part thereof, to be licensed as a whole at no charge to all third parties under
the terms of this License.

(c) If the modified program normally reads commands interactively when run, you must cause it, when
started running for such interactive use in the most ordinary way, to print or display an announcement
including an appropriate copyright notice and a notice that there is no warranty (or else, saying that
you provide a warranty) and that users may redistribute the program under these conditions, and telling
the user how to view a copy of this License. (Exception: if the Program itself is interactive but does
not normally print such an announcement, your work based on the Program is not required to print an
announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not
derived from the Program, and can be reasonably considered independent and separate works in themselves,
then this License, and its terms, do not apply to those sections when you distribute them as separate works.
But when you distribute the same sections as part of a whole which is a work based on the Program, the
distribution of the whole must be on the terms of this License, whose permissions for other licensees extend
to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you;
rather, the intent is to exercise the right to control the distribution of derivative or collective works based on
the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a work
based on the Program) on a volume of a storage or distribution medium does not bring the other work under
the scope of this License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or exe-
cutable form under the terms of Sections 1 and 2 above provided that you also do one of the following:

(a) Accompany it with the complete corresponding machine-readable source code, which must be dis-
tributed under the terms of Sections 1 and 2 above on a medium customarily used for software inter-
change; or,

(b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no
more than your cost of physically performing source distribution, a complete machine-readable copy
of the corresponding source code, to be distributed under the terms of Sections 1 and 2 above on a
medium customarily used for software interchange; or,
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(c) Accompany it with the information you received as to the offer to distribute corresponding source
code. (This alternative is allowed only for noncommercial distribution and only if you received the
program in object code or executable form with such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to it. For an
executable work, complete source code means all the source code for all modules it contains, plus any
associated interface definition files, plus the scripts used to control compilation and installation of the ex-
ecutable. However, as a special exception, the source code distributed need not include anything that is
normally distributed (in either source or binary form) with the major components (compiler, kernel, and
so on) of the operating system on which the executable runs, unless that component itself accompanies the
executable.

If distribution of executable or object code is made by offering access to copy from a designated place, then
offering equivalent access to copy the source code from the same place counts as distribution of the source
code, even though third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this
License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will
automatically terminate your rights under this License. However, parties who have received copies, or
rights, from you under this License will not have their licenses terminated so long as such parties remain in
full compliance.

5. You are not required to accept this License, since you have not signed it. However, nothing else grants you
permission to modify or distribute the Program or its derivative works. These actions are prohibited by law
if you do not accept this License. Therefore, by modifying or distributing the Program (or any work based
on the Program), you indicate your acceptance of this License to do so, and all its terms and conditions for
copying, distributing or modifying the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically
receives a license from the original licensor to copy, distribute or modify the Program subject to these terms
and conditions. You may not impose any further restrictions on the recipients’ exercise of the rights granted
herein. You are not responsible for enforcing compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not
limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise)
that contradict the conditions of this License, they do not excuse you from the conditions of this License.
If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other
pertinent obligations, then as a consequence you may not distribute the Program at all. For example, if a
patent license would not permit royalty-free redistribution of the Program by all those who receive copies
directly or indirectly through you, then the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance
of the section is intended to apply and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or
to contest validity of any such claims; this section has the sole purpose of protecting the integrity of the
free software distribution system, which is implemented by public license practices. Many people have
made generous contributions to the wide range of software distributed through that system in reliance on
consistent application of that system; it is up to the author/donor to decide if he or she is willing to distribute
software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this
License.

8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copy-
righted interfaces, the original copyright holder who places the Program under this License may add an
explicit geographical distribution limitation excluding those countries, so that distribution is permitted only
in or among countries not thus excluded. In such case, this License incorporates the limitation as if written
in the body of this License.

9. The Free Software Foundation may publish revised and/or new versions of the General Public License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to
address new problems or concerns.
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Each version is given a distinguishing version number. If the Program specifies a version number of this
License which applies to it and “any later version”, you have the option of following the terms and conditions
either of that version or of any later version published by the Free Software Foundation. If the Program
does not specify a version number of this License, you may choose any version ever published by the Free
Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are
different, write to the author to ask for permission. For software which is copyrighted by the Free Software
Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our decision
will be guided by the two goals of preserving the free status of all derivatives of our free software and of
promoting the sharing and reuse of software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR
THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTH-
ERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE
THE PROGRAM “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IM-
PLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABIL-
ITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFEC-
TIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL
ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDIS-
TRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, IN-
CLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING
OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO
LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU
OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PRO-
GRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBIL-
ITY OF SUCH DAMAGES.

QGIS Qt exception for GPL

In addition, as a special exception, the QGIS Development Team gives permission to link the code of this program
with the Qt library, including but not limited to the following versions (both free and commercial): Qt/Non-
commerical Windows, Qt/Windows, Qt/X11, Qt/Mac, and Qt/Embedded (or with modified versions of Qt that use
the same license as Qt), and distribute linked combinations including the two. You must obey the GNU General
Public License in all respects for all of the code used other than Qt. If you modify this file, you may extend this
exception to your version of the file, but you are not obligated to do so. If you do not wish to do so, delete this
exception statement from your version.

24.2 GNU General Public License

Version 1.3, 3 November 2008

Copyright 2000, 2001, 2002, 2007, 2008 Free Software Foundation, Inc

http://fsf.org/

Ognuno ha la possibilità di copiare e distribuire copie letterali di questo documento di licenza, i cambi non sono
permessi.

Preamble

The purpose of this License is to make a manual, textbook, or other functional and useful document “free” in the
sense of freedom: to assure everyone the effective freedom to copy and redistribute it, with or without modifying
it, either commercially or noncommercially. Secondarily, this License preserves for the author and publisher a
way to get credit for their work, while not being considered responsible for modifications made by others.
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This License is a kind of “copyleft”, which means that derivative works of the document must themselves be free
in the same sense. It complements the GNU General Public License, which is a copyleft license designed for free
software.

We have designed this License in order to use it for manuals for free software, because free software needs free
documentation: a free program should come with manuals providing the same freedoms that the software does.
But this License is not limited to software manuals; it can be used for any textual work, regardless of subject
matter or whether it is published as a printed book. We recommend this License principally for works whose
purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS

This License applies to any manual or other work, in any medium, that contains a notice placed by the copyright
holder saying it can be distributed under the terms of this License. Such a notice grants a world-wide, royalty-free
license, unlimited in duration, to use that work under the conditions stated herein. The Document, below, refers
to any such manual or work. Any member of the public is a licensee, and is addressed as “you”. You accept the
license if you copy, modify or distribute the work in a way requiring permission under copyright law.

A “Modified Version” of the Document means any work containing the Document or a portion of it, either copied
verbatim, or with modifications and/or translated into another language.

A “Secondary Section” is a named appendix or a front-matter section of the Document that deals exclusively
with the relationship of the publishers or authors of the Document to the Document’s overall subject (or to related
matters) and contains nothing that could fall directly within that overall subject. (Thus, if the Document is in part
a textbook of mathematics, a Secondary Section may not explain any mathematics.) The relationship could be
a matter of historical connection with the subject or with related matters, or of legal, commercial, philosophical,
ethical or political position regarding them.

The “Invariant Sections” are certain Secondary Sections whose titles are designated, as being those of Invariant
Sections, in the notice that says that the Document is released under this License. If a section does not fit the
above definition of Secondary then it is not allowed to be designated as Invariant. The Document may contain
zero Invariant Sections. If the Document does not identify any Invariant Sections then there are none.

The “Cover Texts” are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover Texts, in
the notice that says that the Document is released under this License. A Front-Cover Text may be at most 5 words,
and a Back-Cover Text may be at most 25 words.

A “Transparent” copy of the Document means a machine-readable copy, represented in a format whose specifi-
cation is available to the general public, that is suitable for revising the document straightforwardly with generic
text editors or (for images composed of pixels) generic paint programs or (for drawings) some widely available
drawing editor, and that is suitable for input to text formatters or for automatic translation to a variety of formats
suitable for input to text formatters. A copy made in an otherwise Transparent file format whose markup, or ab-
sence of markup, has been arranged to thwart or discourage subsequent modification by readers is not Transparent.
An image format is not Transparent if used for any substantial amount of text. A copy that is not “Transparent” is
called Opaque.

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input format,
LaTeX input format, SGML or XML using a publicly available DTD, and standard-conforming simple HTML,
PostScript or PDF designed for human modification. Examples of transparent image formats include PNG, XCF
and JPG. Opaque formats include proprietary formats that can be read and edited only by proprietary word pro-
cessors, SGML or XML for which the DTD and/or processing tools are not generally available, and the machine-
generated HTML, PostScript or PDF produced by some word processors for output purposes only.

The “Title Page” means, for a printed book, the title page itself, plus such following pages as are needed to hold,
legibly, the material this License requires to appear in the title page. For works in formats which do not have any
title page as such, “Title Page” means the text near the most prominent appearance of the work’s title, preceding
the beginning of the body of the text.

The “publisher” means any person or entity that distributes copies of the Document to the public.

A section “Entitled XYZ” means a named subunit of the Document whose title either is precisely XYZ or contains
XYZ in parentheses following text that translates XYZ in another language. (Here XYZ stands for a specific
section name mentioned below, such as “Acknowledgements”, “Dedications”, “Endorsements”, or “History”.)
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To “Preserve the Title” of such a section when you modify the Document means that it remains a section “Entitled
XYZ” according to this definition.

The Document may include Warranty Disclaimers next to the notice which states that this License applies to the
Document. These Warranty Disclaimers are considered to be included by reference in this License, but only as
regards disclaiming warranties: any other implication that these Warranty Disclaimers may have is void and has
no effect on the meaning of this License.

2. VERBATIM COPYING

You may copy and distribute the Document in any medium, either commercially or noncommercially, provided
that this License, the copyright notices, and the license notice saying this License applies to the Document are
reproduced in all copies, and that you add no other conditions whatsoever to those of this License. You may not
use technical measures to obstruct or control the reading or further copying of the copies you make or distribute.
However, you may accept compensation in exchange for copies. If you distribute a large enough number of copies
you must also follow the conditions in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display copies.

3. COPYING IN QUANTITY

If you publish printed copies (or copies in media that commonly have printed covers) of the Document, numbering
more than 100, and the Document’s license notice requires Cover Texts, you must enclose the copies in covers
that carry, clearly and legibly, all these Cover Texts: Front-Cover Texts on the front cover, and Back-Cover Texts
on the back cover. Both covers must also clearly and legibly identify you as the publisher of these copies. The
front cover must present the full title with all words of the title equally prominent and visible. You may add other
material on the covers in addition. Copying with changes limited to the covers, as long as they preserve the title
of the Document and satisfy these conditions, can be treated as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed (as many
as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either include
a machine-readable Transparent copy along with each Opaque copy, or state in or with each Opaque copy a
computer-network location from which the general network-using public has access to download using public-
standard network protocols a complete Transparent copy of the Document, free of added material. If you use the
latter option, you must take reasonably prudent steps, when you begin distribution of Opaque copies in quantity, to
ensure that this Transparent copy will remain thus accessible at the stated location until at least one year after the
last time you distribute an Opaque copy (directly or through your agents or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before redistributing any large
number of copies, to give them a chance to provide you with an updated version of the Document.

4. MODIFICHE

You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and 3 above,
provided that you release the Modified Version under precisely this License, with the Modified Version filling the
role of the Document, thus licensing distribution and modification of the Modified Version to whoever possesses
a copy of it. In addition, you must do these things in the Modified Version:

1. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those of
previous versions (which should, if there were any, be listed in the History section of the Document). You
may use the same title as a previous version if the original publisher of that version gives permission.

2. List on the Title Page, as authors, one or more persons or entities responsible for authorship of the modifi-
cations in the Modified Version, together with at least five of the principal authors of the Document (all of
its principal authors, if it has fewer than five), unless they release you from this requirement.

3. State on the Title page the name of the publisher of the Modified Version, as the publisher.

4. Preserve all the copyright notices of the Document.

5. Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

6. Include, immediately after the copyright notices, a license notice giving the public permission to use the
Modified Version under the terms of this License, in the form shown in the Addendum below.
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7. Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given in the
Document’s license notice.

8. Include an unaltered copy of this License.

9. Preserve the section Entitled “History”, Preserve its Title, and add to it an item stating at least the title, year,
new authors, and publisher of the Modified Version as given on the Title Page. If there is no section Entitled
“History” in the Document, create one stating the title, year, authors, and publisher of the Document as
given on its Title Page, then add an item describing the Modified Version as stated in the previous sentence.

10. Preserve the network location, if any, given in the Document for public access to a Transparent copy of the
Document, and likewise the network locations given in the Document for previous versions it was based
on. These may be placed in the “History” section. You may omit a network location for a work that was
published at least four years before the Document itself, or if the original publisher of the version it refers
to gives permission.

11. For any section Entitled “Acknowledgements” or “Dedications”, Preserve the Title of the section, and pre-
serve in the section all the substance and tone of each of the contributor acknowledgements and/or dedica-
tions given therein.

12. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. Section
numbers or the equivalent are not considered part of the section titles.

13. Delete any section Entitled “Endorsements”. Such a section may not be included in the Modified Version.

14. Do not retitle any existing section to be Entitled “Endorsements” or to conflict in title with any Invariant
Section.

15. Preserve any Warranty Disclaimers.

If the Modified Version includes new front-matter sections or appendices that qualify as Secondary Sections and
contain no material copied from the Document, you may at your option designate some or all of these sections
as invariant. To do this, add their titles to the list of Invariant Sections in the Modified Version’s license notice.
These titles must be distinct from any other section titles.

You may add a section Entitled “Endorsements”, provided it contains nothing but endorsements of your Modified
Version by various parties—for example, statements of peer review or that the text has been approved by an
organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as a Back-Cover
Text, to the end of the list of Cover Texts in the Modified Version. Only one passage of Front-Cover Text and one
of Back-Cover Text may be added by (or through arrangements made by) any one entity. If the Document already
includes a cover text for the same cover, previously added by you or by arrangement made by the same entity you
are acting on behalf of, you may not add another; but you may replace the old one, on explicit permission from
the previous publisher that added the old one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their names for
publicity for or to assert or imply endorsement of any Modified Version.

5. COMBINING DOCUMENTS

You may combine the Document with other documents released under this License, under the terms defined in
section 4 above for modified versions, provided that you include in the combination all of the Invariant Sections
of all of the original documents, unmodified, and list them all as Invariant Sections of your combined work in its
license notice, and that you preserve all their Warranty Disclaimers.

The combined work need only contain one copy of this License, and multiple identical Invariant Sections may be
replaced with a single copy. If there are multiple Invariant Sections with the same name but different contents,
make the title of each such section unique by adding at the end of it, in parentheses, the name of the original author
or publisher of that section if known, or else a unique number. Make the same adjustment to the section titles in
the list of Invariant Sections in the license notice of the combined work.

In the combination, you must combine any sections Entitled “History” in the various original documents, forming
one section Entitled “History”; likewise combine any sections Entitled “Acknowledgements”, and any sections
Entitled “Dedications”. You must delete all sections Entitled “Endorsements”.

6. COLLECTIONS OF DOCUMENTS
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You may make a collection consisting of the Document and other documents released under this License, and
replace the individual copies of this License in the various documents with a single copy that is included in the
collection, provided that you follow the rules of this License for verbatim copying of each of the documents in all
other respects.

You may extract a single document from such a collection, and distribute it individually under this License,
provided you insert a copy of this License into the extracted document, and follow this License in all other respects
regarding verbatim copying of that document.

7. AGGREGATION WITH INDEPENDENT WORKS

A compilation of the Document or its derivatives with other separate and independent documents or works, in
or on a volume of a storage or distribution medium, is called an “aggregate” if the copyright resulting from the
compilation is not used to limit the legal rights of the compilation’s users beyond what the individual works permit.
When the Document is included in an aggregate, this License does not apply to the other works in the aggregate
which are not themselves derivative works of the Document.

If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the Document
is less than one half of the entire aggregate, the Document’s Cover Texts may be placed on covers that bracket
the Document within the aggregate, or the electronic equivalent of covers if the Document is in electronic form.
Otherwise they must appear on printed covers that bracket the whole aggregate.

8. TRANSLATION

Translation is considered a kind of modification, so you may distribute translations of the Document under the
terms of section 4. Replacing Invariant Sections with translations requires special permission from their copyright
holders, but you may include translations of some or all Invariant Sections in addition to the original versions of
these Invariant Sections. You may include a translation of this License, and all the license notices in the Document,
and any Warranty Disclaimers, provided that you also include the original English version of this License and the
original versions of those notices and disclaimers. In case of a disagreement between the translation and the
original version of this License or a notice or disclaimer, the original version will prevail.

If a section in the Document is Entitled “Acknowledgements”, “Dedications”, or “History”, the requirement (sec-
tion 4) to Preserve its Title (section 1) will typically require changing the actual title.

9. TERMINATION

You may not copy, modify, sublicense, or distribute the Document except as expressly provided under this License.
Any attempt otherwise to copy, modify, sublicense, or distribute it is void, and will automatically terminate your
rights under this License.

However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated
(a) provisionally, unless and until the copyright holder explicitly and finally terminates your license, and (b)
permanently, if the copyright holder fails to notify you of the violation by some reasonable means prior to 60 days
after the cessation.

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies
you of the violation by some reasonable means, this is the first time you have received notice of violation of this
License (for any work) from that copyright holder, and you cure the violation prior to 30 days after your receipt
of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have received copies
or rights from you under this License. If your rights have been terminated and not permanently reinstated, receipt
of a copy of some or all of the same material does not give you any rights to use it.

10. FUTURE REVISIONS OF THIS LICENSE

The Free Software Foundation may publish new, revised versions of the GNU Free Documentation License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address
new problems or concerns. See http://www.gnu.org/copyleft/.

Each version of the License is given a distinguishing version number. If the Document specifies that a particular
numbered version of this License “or any later version” applies to it, you have the option of following the terms
and conditions either of that specified version or of any later version that has been published (not as a draft) by the
Free Software Foundation. If the Document does not specify a version number of this License, you may choose
any version ever published (not as a draft) by the Free Software Foundation. If the Document specifies that a
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proxy can decide which future versions of this License can be used, that proxy’s public statement of acceptance
of a version permanently authorizes you to choose that version for the Document.

11. RELICENSING

“Massive Multiauthor Collaboration Site” (or “MMC Site”) means any World Wide Web server that publishes
copyrightable works and also provides prominent facilities for anybody to edit those works. A public wiki that
anybody can edit is an example of such a server. A “Massive Multiauthor Collaboration” (or “MMC”) contained
in the site means any set of copyrightable works thus published on the MMC site.

“CC-BY-SA” means the Creative Commons Attribution-Share Alike 3.0 license published by Creative Commons
Corporation, a not-for-profit corporation with a principal place of business in San Francisco, California, as well as
future copyleft versions of that license published by that same organization.

“Incorporate” means to publish or republish a Document, in whole or in part, as part of another Document.

An MMC is “eligible for relicensing” if it is licensed under this License, and if all works that were first published
under this License somewhere other than this MMC, and subsequently incorporated in whole or in part into the
MMC, (1) had no cover texts or invariant sections, and (2) were thus incorporated prior to November 1, 2008.

The operator of an MMC Site may republish an MMC contained in the site under CC-BY-SA on the same site at
any time before August 1, 2009, provided the MMC is eligible for relicensing.

ADDENDUM: How to use this License for your documents

To use this License in a document you have written, include a copy of the License in the document and put the
following copyright and license notices just after the title page:

Copyright © YEAR YOUR NAME.
Permission is granted to copy, distribute and/or modify this document
under the terms of the GNU Free Documentation License, Version 1.3
or any later version published by the Free Software Foundation;
with no Invariant Sections, no Front-Cover Texts, and no Back-Cover Texts.
A copy of the license is included in the section entitled "GNU
Free Documentation License".

If you have Invariant Sections, Front-Cover Texts and Back-Cover Texts, replace the “with ... Texts.” line with
this:

with the Invariant Sections being LIST THEIR TITLES, with the
Front-Cover Texts being LIST, and with the Back-Cover Texts being LIST.

If you have Invariant Sections without Cover Texts, or some other combination of the three, merge those two
alternatives to suit the situation.

If your document contains nontrivial examples of program code, we recommend releasing these examples in
parallel under your choice of free software license, such as the GNU General Public License, to permit their use
in free software.
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Avoid intersections, see Topology, 206
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Bookmarks, 57
Browse data, 85
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Catalog services, 442
CGI (Common Gateway Interface), 294
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Color map, 228
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Color brewer, 119
Color ramp, 119
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Gradient color ramp, 119

Columns
Attributes, 192

Comma Separated Values, see CSV, see CSV

Command line options, 14
Compose maps, 248
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Node-based shape, 277

Composer items, 248
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Create new layers, 99
Creating new layer, see GRASS
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CRS Selection, 81
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Data Management tools, 366
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Digitizing, see Attribute table, 206, 429
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Digitizing tools, 206
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Aggiungi buco, 213
Aggiungi Parte, 213
Annulla, 212
Automatic tracing, 217
Dividere elementi, 215
Elimina buco, 214
Elimina Parte, 213
Extend lines, 214
Fondi Elementi Selezionati, 216
GRASS, 349
Merge Attributes, 216
Offset dei simboli per i punti, 216
Reshape Feature, 214
Riempi buco, 214
Ripristina, 212
Rotate Feature, 212
Ruota Simboli del Punto, 216
Semplifica Elemento, 213
Spezza Elementi, 215
Spezza elemento, 215

Discrete, 228
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Displacement plugin, 136
documentation, 3
DXF, 85, 415
DXF Export, 105
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Editing, see GRASS
Embed layers and groups, 58
Embedded form, 201
Embedded widget, 174, 232
Environment

QGIS Server, 307
Environment variables, 64
EPSG (European Petroleum Search Group), 79
Equal Interval, 133
Erdas Imagine, 85
Errors, 429
Esportare in formato PDF, 278
Esportare in formato SVG, 278
Espressioni, 175

Named parameters, 176
ESRI, 108
Esri Personal Geodatabase, 87
eVis, 416
Export as image, 278
Expression

Labels, 152
Expressions, 61

FastCGI, 294

Feature form, 201
Feature simplification, 172
Field configuration, 157
Fields, 156
Fields constraints, 157
Fields edit, 197
Foreign key, 200
Form, 160
Format, 85
Formattazione condizionale, 193
Forms, 156
Functions, 176

Named parameters, 176

GDAL, 85, 426
Generalisation, 172
Geocoding photo, 416
GeoJSON, 210
Geometry, 432
Geometry validity, 429
Geometryless Data, 189
Geometryless feature, 208, 213
GeoPackage, 85
Georeferencing images, 432
GeoTIFF, 85
GeoTiff, 108
GML, 285
GNU General Public License, 463
GPS tracking, 315
GPX, 99
GRASS, 85, 342

Attribute linkage, 348
Attribute storage, 348
Customize toolbox, 357
Digitizing tools, 349
Display results, 352
Region, 350
Region editing, 351
Style, 350
Toolbox, 351

GRASS vector data model, 348
Gruppo, 35
Guide contestuali, 33
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Traduttori, 461

Heatmap, 137
Plugins, 437

Histogram, 133, 232
HTML frame, 273

Identify features, 53
IDW (Inverse Distance Weighted), 440
IGNF (Institut Geographique National de France), 79
Installation, 13
InteProxy, 292
Interpolation, 440
Items alignment, 251
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Join layers, 162
Jointure, 162

Keyword, 174

Labels
Custom placement, 155
Data-defined override, 155
Expression, 152

Layer, 35
Layer properties, 36, 225
Layers

Initial visibility, 41
Order, 36

Layout maps, 248
Legend, 33, 232
Legend composer, 259
Legenda, 174
License document, 463
Line to polygon, 209
Linked forms, 201
Loading raster, 87
Loading vector, 87
Log messages, 39
Logging

QGIS Server, 307

Magnification, 32
Main window, 21
Many-to-many relation

Relation, 203
Map

Overview, 39
Map grid, 254
Map layout, 236
Map legend, 259
Map navigation, 48
Map template, 239
Map Tips, 172
Map tools, 68
Map view, 30
Mapserver, 292
Measure

Angles, 49
Areas, 49
Distances, 49
Tools, 48

Menu, 21
Metadata, 174, 232, 442

WMS, 291
Modifica, see Digitizing
Modifiche in uso, 211
Modifiche topologiche, 205
Mouse wheel, 31
MSSQL Spatial, 93
Multi Band Raster, 226
Multi edit, 199
Multiline, 213
Multipoint, 213

Multipolygon, 213
Multivariate analysis, 134
MySQL, 87

Named parameters, 176
Natural Breaks (Jenks), 133
Nesting projects, 58
Network, 71
New GeoPackage layer, 100
New GPX layer, 101
New SpatiaLite layer, 100
New Temporary Scratch layer, 101
nginx, 295
Node tool, 208
Nodes, 208
Non Spatial Attribute Tables, 189
North arrow, 60

ODBC, 87
OGC (Open Geospatial Consortium), 285
OGDI, 87
OGR, 85, 108
ogr2ogr, 112
On-the-fly reprojection, 70
Opzioni dell’interfaccia grafica (GUI), 63
Oracle database, 447
OSM (OpenStreetMap), 92
Output

Save as image, 18
Output map, 236
Overwrite file, 104
Overwrite language, 71

Paint effects, 140
Pan, 31, 48
Pannelli, 29, 33

Layers, 33
Log messages, 39
Overview, 39
Redo, 39
Statistic, 37
Style, 36
Undo, 39

Personalizzazione, 76
pgsql2shp, 112
Picture database, 272
Plugins, 406

Geometry checker, 429
Geometry snapper, 432
Heatmap, 437
Metasearch, 442
Offline editing, 446
Plugin manager, 406
Road graph, 451
Spatial Georaster, 447
Spatial query, 452
Terrain analysis, 450
Topology Checker, 453
Zonal statistics, 456
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Polygon to line, 209
PostGIS, 85, 110

ogr2ogr, 112
shp2pgsql, 112
Spatial index, 113
ST_Shift_Longitude, 113

PostGreSQL, 85
PostgreSQL, 110
Preset visibility, 34
Pretty Breaks, 133
Print composer, 18

Tools, 242
Printing

Export map, 278
Progetto, 22
Proj.4, 81
Project

Properties, 73
Project properties, 73
Projections, 79
Projects, 17
Proportional symbol, 134
Proxy, 71, 287
Proxy server, 287
Pyramids, 231
Python, 403

QGIS Server, 294
Environment, 307
Logging, 307

QML, 42
QSpatiaLite, 114
Quantile, 133
Query builder, 128
Quick print, 18

Raggio di ricerca, 205
Raster, 85, 225

Align Raster, 235
Georeference, 432

Raster analysis, 234
Raster calculator, 234
Raster Statistics, 456
Rasterisation, 172
Redo, 39
Relations, 200
Renderer, 129
Rendering, 66
Rendering effects

Blending modes, 46
Rendering scale dependent, 41
Reticoli, 254
Reticolo, 59
Revert layout actions, 247
Rotated north arrow, 272
Rubber band, 207
Rule-based renderer

Create a rule, 135

Save layer, 101
Save properties, 42
Save style, 42
Scale, 41
Scale bar, 60
Scale calculate, 32
Scalebar

Map scalebar, 263
Secured OGC Authentication, 292
Select, see Selection tools

Deselect, 50
Selection

Attributes, 194
Selection tools

Invert selection, 50
Select all, 50
Select by expression, 50
Select by form, 50
Select by freehand, 50
Select by polygon, 50
Select by radius, 50
Select by rectangle, 50
Select by value, 51

Settings
Project, 73

Sfogliare i dati, 358
SFS, 285
Shapefile, 99, 108
Shared polygon boundaries, see Topology, 205
Shortest path, 451
shp2pgsql, 112
Simbologia, 129

2.5D renderer, 137
Categorized renderer, 131
Graduated renderer, 133
Heatmap renderer, 137
Inverted polygon renderer, 136
No symbols renderer, 130
Point displacement renderer, 136
Rule-based renderer, 135
Single symbol renderer, 130

Single Band Raster, 226
Size assistant, 134
SLD, 42, 294
SLD/SE, 294
Snapping, 204, 432
Snapping on intersections, 206
Sort columns, 192
Sort features, 139
Spatial bookmarks, see Bookmarks
Spatial index

GiST index, 113
SpatiaLite, 85, 99
Spatialite, 92, 114
Spatialite manager, 114
SQLite, 92, 114
SRS (Spatial Reference System), 289
Start QGIS, 14
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Statistic, 37
Stop QGIS, 14
Strumenti di Analisi, 363
Strumenti di Geometria, 365
Strumenti di Geoprocessing, 365
Strumenti di Ricerca, 364
Style, 36, 129
Style Manager, 117
Symbology, 226
Symbols levels, 140

Tab
Actions, 168

Tasti di scelta rapida, 77
Three Band Color Raster, 226
Tiger Format, 89
TIN (Triangulated Irregular Network), 440
Tolleranza di aggancio, 204
Tools

Georeferencer tools, 433
Measure, 48

Topology, 429, 432, 453
Transparency, 231

Ubuntu, 295
UK National Transfer Format, 89
Undo, 39
US Census Bureau, 89

Valori predefiniti, 157
Variables, 61, 73, 174
Vector, 85, 362
Vertex, 208
Vertex editor, 209
Vertices, 208
Virtual Fields, 197
Virtual layers, 105
Visualizzazione, 39, 250

Halting, 41
Options, 41
Quality, 42
Speed-up, 42
Suspending, 41

Visualizzazione del layer, 139

WCS, 285
WCS (Web Coverage Service), 293
WCS Server, 294
WFS, 285, 293
WFS Server, 294
WFS-T (WFS Transactional), 293
WKT, 79, 210
WMS, 285

Client, 285
Identify, 290
Layer transparency, 289
Metadata, 291
Properties, 291

WMS Server, 294

WMS tiles, 290
WMS-C, 290
WMTS, see WMS, 290
World file, 18

Z-level, 139
Zoom, 31, 48
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